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About this Document

 

1. Screen Captures

This document features screen captures of the Minimal Arkoon Configuration (minarkconf) application.

Screen content may vary slightly in appearance depending on which model of the Arkoon Fast360 UTM

appliance series you are configuring.

2. Appliance Models

This guide provides information on how to configure the complete range of Fast360 appliances.

3. Knowledge Base

Arkoon Knowledge Base is also available from the following address: http://client.arkoon.net. It provides

information on specific problems that cannot be handled in the current documentation.

http://client.arkoon.net
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Chapter 1. Security on Fast360 appliance

The following recommendations are designed to ensure maximum safety for you and your Fast360

appliance. Additional safety recommendations are also available in the First-Time Configuration Guide.

1.1. Security Instructions

Important

In case of a security issue, please contact Arkoon security center : http://www.arkoon.net/-

Security-center-.html

1.1.1. Fast360 Appliance Environment

Install your Fast360 appliance in a secure room with the following characteristics:

• the room access must be authenticated, logged and controlled by the administrator

• the room must be locked with a key, digocode, card, etc

• the room must be protected against intrusion (alarm, secured windows, etc.)

• the room must respect the security standards regarding the electrical installation (executed by a

competent electrician)

• the room must be protected against fires

• the room must be equipped with air conditioning ensuring acceptable operating temperatures for the

appliance (see specifications)

• the electrical power must be regulated to protect the appliance against lightning, tension variations

and power cuts

• the environment must be organised in such a way no physical element put the users in jeopardy:

• the machines must be in a stable position

• the cables must not be across the way

1.1.2. Electrical Security

Respect the following electrical security instructions when installing or manipulating the Fast360

appliance:

• always stop and disconnect the appliance before moving it. The power cable and the power plugs

must be easily accessible at all times

• only the power cable provided with the appliance must be used

• the Fast360 appliance has no spare parts. The maintenance or repairs must only be executed by

qualified people who know the risks related to manipulating computer and electronic hardware

http://www.arkoon.net/-Security-center-.html
http://www.arkoon.net/-Security-center-.html
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1.1.3. Physical Security

Respect the following physical safety practices regarding mechanical and physical aspects when

installing or manipulating the Fast360 appliance:

• to ensure its performance and integrity, the appliance must not be placed close to a source of heat or

into a humid environment and it shall be properly ventilated

• all the plugs of the connection cables must be screwed in or tightly fastened to the rack, under the

control of the Fast360 administrator

• the Fast360 appliance must be used in horizontal position

• the Fast360 appliance must not be used if the device has visible damage

Important

In this case, the Fast360 appliance must be unplugged and protected against any deliberate

action. The appliance must be left in an environment that is as safe as the operation

environment (physical access).

• all repairs must be executed only by the personnel authorized by Arkoon Network Security. In case of

problem or breakdown, contact your support reseller or Arkoon Technical Support if your maintenance

contract covers it.

• in case of technical failure, you must follow a customer service standard procedure by calling the

Arkoon Technical Support. The hardware will then be restored or replaced as per the terms of the

warranty.

1.2. Security Hypotheses

When using a Fast360 appliance, it is supposed the following security conditions are respected:

• the administrator can be trusted and he/she is a non hostile person trained to his tasks

• the Fast360 equipment as well as the supports containing the Fast360 parts must be in a secure room,

accessible only by the administrator

• the Fast360 environmnent must enable to authenticate the administrator for the appliance remote

accesses

• the administrator must regularly consult the audit logs generated by the firewall and he/she handles

the audits to avoid data loss

• the administrator must handle the alarms generated and sent by the firewall

• the administrator must regularly consult the audit logs generated by the VPN component and he/she

handles the audits to avoid data loss

• the administrator must control or regenerate the hardware and software firewall configuration

(services and goods) according to a reference state

• the administrator must control or regenerate the VPN component hardware and software

configuration (services and goods) according to a reference state

• the administrator must handle the alarms handled and sent by the VPN component

• the cryptographic keys generated outside the Fast360 appliance and uploaded into, must have been

generated according to the recommendations specified in the French Network and Information
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Security Agency (FNISA or ANSSI in French, standing for "Agence Nationale de la Sécurité des

Systèmes d’Information") reference documents for the standard resistance level

1.3. Security Rules

1.3.1. Password Security Rules

A safe password policy is required to ensure the security of your Fast360 appliance.

Passwords used on Fast360 devices must be at least 8 digits long and include at least three of the

following four different types of characters:

• lowercase characters [a-z]

• uppercase characters [A-Z]

• numbers [0–9]

• any special characters (@, #,$,...)

Important

Change the root password and the passwords of users with administrative rights frequently.

Keep passwords in memory or in a location with a level of security at least as high as the one for

the function for which they are intended (avoid post-its or saving them in an unsecured file).

Passwords used on Fast360 Appliance

Several password are used on the Fast360 appliance to protect or encypt accounts or files.

Root Password. The root password corresponds to the login for the root user, or superuser.

Warning

The root user, or superuser account is allowed to access and modify anything from the interface.

To avoid configuration damages as well as a weakness on the security level applied on Fast360

appliance, it is crucial to ensure only the authorized and reliable persons can get access.

PEM Phrase. Password that encrypts the private key of the Certification Authority (entity managing

the certificates). If this password is lost, a complete reset of the Certificate Authority (CA) is required.

A complete reset of the Certificate Authority (CA) impacts all devices or applications that request

certificates from the Fast360 appliance set as a Certificate Authority (CA). As a consequence, you will

have to create all the certificates again (appliance, administrator, VPN).

Note

If you initialize the Fast360 appliance using the desktop wizard, the PEM Phrase will be identical

to the root password.

Passwords for PKCS#12 files . Files containing PKCS#12 file passwords need to be stored in such a way

that only authorized users can access them. This applies to PKCS#12 files used in the following situations:

• authentication in administration with  Arkoon Manager  and  Arkoon Monitoring .

• authentication in flow rules

• authentication for VPN connections



Chapter 1. Security on Fast360 appliance

24 | Administration Console

• authentication of another Fast360 appliance

1.3.2. Administration Console

The remote administration console allows the authorized and authentified administrator to detect any

event related to the Fast360 appliance security and to consult the audit logs.

1.3.3. Admin from Console

The Admin from control option allows the administrator to define the IP address(es) allowed to remotely

manage the Fast360.

1.3.4. Access Information

The physical access to the Fast360 appliance shall be of a level of security superior or equivalent to the

level for access in the remote administration mode. To keep track of physical accesses to the Fast360

appliance, we recommend that you record all the characteristics of these manipulations in an installation

booklet.

1.3.5. Recommended initial configuration method

To guarantee the highest level of security, use the minarkconf (Minimal arkoon configuration) application.

For more details, refer to the First-Time Configuration Guide.

1.4. Cryptographic Mechanisms

The Fast360 product allows a large number of cryptographic algorithms and key sizes for compatibility

with existing products. However, it is strongly recommended that only the algorithms and key sizes

considered the most robust to date. We recommend you only use the following algorithms:

• AES in CBC mode with 256-bit keys

• RSA with 4096-bit keys as a minimum

• -Hellman with 2048-bit groups as a minimum

• HMAC SHA-2 or HMAC SHA-1

1.5.  Fast360 Appliance Security Services Overview

The Arkoon Fast360 UTM appliances provide a set of security services that together protect your network

infrastructure and the information communicated through your network from a number of different types

of threat. Fast360 appliances incorporate application level (layer 7) and layer 3/4 stateful firewalling,

dynamic routing, intrusion detection and prevention, email, web and FTP antivirus, antispam, URL filtering,

IPsec VPN (with optional IPsec acceleration on certain models) and bandwidth management.

The following table lists the services provided by the Fast360 appliance. Each of these services is

described in more details in the following sections of this chapter.
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Table 1.1.  Fast360 Appliance Services

Service Description

Network layer security: Network

Address Translation (NAT), Port Address

Translation (PAT)

Prevents IP addresses of devices on the internal network

from being visible externally, so that your network topology

and individual devices cannot be detected.

Filtering rules Sets rules for handling network traffic according parameters

including source and destination addresses, scheduling,

user IDs etc. Provides antispoofing.

FAST protocol analysis and filtering Checks compliance with protocol definitions and standards.

Protects against non-standard information hidden within

data communicated.

Intrusion detection and prevention (IDPS) Detects and neutralizes attacks based on application

vulnerabilities.

ICMP flow management Prevents the use of ICMP to detect information about your

network.

Proxy services Enable content filtering (antivirus, antispam, etc.) and

authentication for network traffic using various application-

level protocols.

DNS Blacklists Block communication with IP addresses known to be

sources of spam or other unwanted data.

User authentication Verify the identity of the source of a communication. Protects

against masquerading.

Bandwidth management Set limits on bandwidth that can be used by a data flow.

Protects against denial of service attacks by high volume.

Routing Provide IP routing services.

Virtual Private Networking (VPN) Use IPsec VPN tunnels for secure site-to-site or remote

connectivity.

Service updates Download updates for antivirus, blocked addresses,

intrusion detection services, and for the Fast360 system.
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Chapter 2. Using Arkoon Tools

 

2.1. Introduction to Arkoon Tools

Arkoon provides a suite of GUI-based software tools, Arkoon Tools, to facilitate management,

monitoring, and maintenance of Fast360 appliances. Arkoon Tools includes two programmes for Fast360

management:

Arkoon Manager Arkoon Manager  is the interface for Fast360 appliance configuration.

It also includes modules for managing administrative roles and

sessions.

Arkoon Monitoring Arkoon Monitoring  is the interface for day-to-day monitoring of

Fast360 activity, including logs and alerts and real-time appliance

status monitoring (load, performance, etc).

For more details on Arkoon Tools installation, see the First-Time Configuration Guide.

2.2. Arkoon Manager Workflow

2.2.1. Disconnected Mode

In disconnected mode, only the Session Manager and the Offline Security Policy Manager menus are

available.

Session Manager Session Manager menu provides access to the Session Manager.

From the Session Manager, a successful Connect action takes the

administrator to the Connected menu.

Offline Security Policy Manager A new configuration can be created or a local configuration loaded

using the Offline Security Policy Manager menu.

Note

A security policy which has been edited while disconnected can only be saved locally.



Chapter 2. Using Arkoon Tools

28 | Connected Mode

2.2.2. Connected Mode

In connected mode, the Online Security Policy Manager, Online Access Control Manager and

Certificate Authority Manager menus are available. The Session Manager is not available.

The administrator might not be authorized to access all applications depending upon their roles.

Online Security Policy Manager A security policy is loaded from the appliance/

AMC server. Only an authenticated Security Officer

can load a local security policy. Hence, only an

authentified Security Administrator will be able to

apply a configuration file stored locally.

Roles Manager The Roles Manager application is accessible only

if the authenticated administrator is a Security

Officer.

Certificate Authority Manager The Certificate Authority Manager application is

accessible only if the authenticated administrator

is a Security Officer or a Security Administrator.

For more details on roles and administration rights, see Section 3.2, “Managing Administrator Rights”.

2.3. Arkoon Manager GUI Principles

This section describes the features that are common to the four sub-applications (Sessions,

Configurations, Roles, and Certificate Authentication) which make up  Arkoon Manager .

2.3.1. Overview of the Interface

This section gives an overview of the interface, including:

Menus

Application Menu

From the menu bar, click Application. From this menu, you can access the commands described below:
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Command Description

New document This command is used to create a new configuration file. Click New document.

Note

When not connected to a Fast360 appliance or AMC server, this command can

be used to create a blank configuration file.

In connected mode, Arkoon Manager proposes to synchronize hardware and system

information available at the remote Fast360 appliance or AMC server. The following

parameters are synchronized:

• all known appliances, including appliances connected to the AMC server;

• for each appliance synchronized:

• the hardware characteristics: CPU, RAM, Hard disk size, Serial number, Ethernet

interfaces

• system parameters: hostname, version, license, X.509 certificate

• network parameters: IP addresses and static routes, DNS servers, authorized

administration IP sources

• internet Accesses

• the clustering mode: HA, HA Cluster, HP Cluster

• the list of known IP services

• the list of known FAST modules

• the list of known IDPS profiles and signatures

Unless you wish to start with a new empty configuration, it is advisable to work

with the current configuration which is automatically highlighted in the list of remote

configurations.

Save encrypted This command can be used to save a report of the current configuration encrypted by

a password. Click Save encrypted.

Import objects from

another configuration

This command can be used to import objects from one configuration to the other by drag

and dropping in the target configuration. It imports objects with several levels

Download In connected mode, this command is used to download a configuration file from the

firewall. Click Download.

Preferences This command takes the administrator to the Preferences option; for more details, see

Section 2.3.4, “Customizing the Interface”.
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Find Menu

The Find menu can be used to locate configuration objects. These features are described in detail in

Section 2.3.3, “Searching Configurations”.

Command Description

Find origin item This command is used to find where the configuration object belongs in the explorer view.

Find unused

items

This command is used to find unused items of a configuration.

Find

references

This command is used to locate where configuration objects are used in the configuration.

Find by IP/

Network

This command is used to search by IP address or by network.

Advanced

search

This command can be used to search by object type, name, description, etc.

Window Menu

The Window menu provides access to the different windows that make up the interface:

Workspace From the Workspace menu, you can restore the default layout or take

a screenshot.

Explorers From the Explorers menu, you can access all explorers, or

configuration tabs, of the application that you are working in.

Editors From the Editors menu, you can access the editors, or configuration

forms, of objects which are open for editing.

Tools From the Tools menu, you can access the window of any tools that are

open, e.g. the Check coherency window.

Actions Menu

The Actions menu features the following commands.
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Command Description

Check

configuration

This command is used to check that the configuration is coherent before

deploying it. If the configuration is coherent, the Configuration ok dialog

box is displayed. If the configuration is incoherent, the errors, warnings

and information messages are displayed in a new window at the bottom

of the screen.

Deploy

configuration

This command is used to deploy the configuration on the network.

Advanced

Administration

This menu provides access to eight advanced administration features; they

are described in detail in Section 2.4.3, “Maintaining Appliances”.

Tools Menu

The Tools menu contains four commands useful for working with your configuration.

Command Description

History of

modifications

This command is used to display the list of modifications to the

configuration. Click on History of modifications to view the operation, date

and time that it was performed.

Clipboard Click on Clipboard to view the configuration objects that have been placed

on the clipboard.

DNS resolution Click on DNS resolution to make direct and reverted DNS resolutions.

Configuration

Deployment

Status

Click on Configuration Deployment Status to display the deployment

progress bar for each appliance and the progress status.

Console Click on Console to view details of the latest configuration deployment.

Zones view Click on Zones view to view a graphical representation of the

configuration.

Arkoon Menu
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Command Description

Launch Arkoon

Monitoring

This command is used to launch the  Arkoon Monitoring  tool directly from

Arkoon Manager .

If you are in connected mode, the menu displays Open Arkoon Monitoring

by connecting to xxx.xxx.xxx.xxx. If you are not connected,  Arkoon

Monitoring  will be launched, but you must then connect to the required

IP address.

Note

To make this option available in the Actions menu, the  Arkoon

Monitoring  application executable file must be located in the

same directory as that of  Arkoon Manager .

Editing Configurations

Arkoon Manager  provides various ways of editing configurations. You can select the objects you want

to configure:

• in the explorer view

• from the Window menu using the Explorers option

• directly inside the main explorer by right-clicking on required object icon, select Open explorer here

from the drop-down menu. For example, in the Network objects explorer view, right-click on the Host

folder in the explorer view, select Open explorer here; an additional Hosts explorer view rooted at the

Host root folder appears, replacing the Network objects explorer view.

Note

Although a configuration is presented through multiple windows and forms, an open document

is constantly being edited. You do not need to validate or cancel editing actions that you have

performed. Actions can be undone/redone at will.

History of Modifications

The History of modifications option is used to display the list of modifications to the configuration. Click

on Tools > History of modifications; a new window appears to the right of the interface displaying the list

of operations and the corresponding date and time at which they were performed. In this window, you

can select the last valid operation, thus undoing/redoing operations following/preceding that operation.

2.3.2. Defining and Organizing Configurations

Object-based Configuration

Fast360 appliance configuration is object-based. Instead of entering a large number of parameters to

configure an appliance, you create objects which you drag-and-drop into the configuration.

For example, instead of entering the parameters for a DNS server directly into every Fast360 appliance

configuration, you create a “host” object with “DNS” capability, with its IP address, and with any other
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relevant parameters; you give this object an arbitrary name (chosen to be relevant to your network

configuration). This DNS object can now be added to the configuration of multiple appliances by a simple

drag-and-drop action.

Creating/Editing Objects

The  Arkoon Manager  interface provides several ways to create and edit configurable objects.

Creating an Object

There are four different methods of creating an object in  Arkoon Manager :

• Right-click on the folder for the object you want to create, select New > Object name. The configuration

tab for the newly created object appears on the right.

• Place the cursor on the folder for the object you want to create and press the Insert key. The

configuration tab for the newly created object appears on the right.

• Right-click in the blank field requiring a new object, select New > Object name from the drop-down

menu. The drop-down menu will list all relevant objects possibly required for that particular field; select

the required object from the list and its configuration tab appears instantaneously.

• Several rule objects can be created and directly assigned a priority in their corresponding rule table;

they are:

• filtering rules

• chaining rules

• HTTP rules

• SMTP anti-relaying rules

• SMTP applicative rules

To create a rule object directly in the descriptive view, right-click on an existing rule, select New before

> Rule or New after > Rule. The corresponding Rule configuration tab is displayed to the right; modify

the object's name and at least one of its settings.

Note

It is also possible to create an identical copy of an object; for more details on creating a duplicate

object, see the section called “Duplicating Objects”.

Editing an Object

There are three different methods of editing an object in  Arkoon Manager :

• In the descriptive view, right-click the object to be edited, select Edit from the displayed drop-down

menu. The configuration tab for the selected object appears on the right.

Note

The shortcut for this operation is Enter. You can also double-click on the object to be edited

to open it for editing.

• In the configuration tab, click on the up or down arrow in the top right edge to access the previous or

following object displayed in the descriptive view.

• Select Window > Editors and select the object you want to edit from the displayed drop-down list.
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Note

You can also change the name of a selected object in the descriptive view or directly in a field.

Right-click on the object, select Modify this from the drop-down menu and amend the name

in the field now available for modification. Alternatively, select the object and press F2. If you

want to automatically rename an object, please refer to the section called “Renaming objects

automatically”.

Duplicating Objects

Arkoon Manager  enables you to quickly add new objects which share many parameters with an existing

object: to create an identical copy, right-click on the object in the descriptive view, select Duplicate from

the drop-down menu. The duplicated object appears in the descriptive view. Modify the object's name

and at least one of its settings.

Renaming objects automatically

It is possible to rename automatically some objects according to the specific parameters of the object.

There are two different methods of renaming an object automatically in Arkoon Manager:

• In the descriptive view, right-click the object to be renamed and select Rename automatically from

the displayed drop-down menu.

• In the descriptive view, select the object to be renamed and press Alt-b.

Here are the objects for which automatic renaming is possible, and the naming convention for each

object:

Table 2.1. Automatic renaming of objects

Object Naming convention

Hosts IP address - [capacity1, capacity2, ...]

If there are more than two capacities for an host,

only the first two are displayed.

Networks IP address/mask

Services protocol/port - [FAST policy]

The port field is equal to the destination ports range.

Flow rules [source objects] –> [destination objects] -

'service1, service2' - Snat, Dnat'

If there are more than two source or destination

objects and services, only the first two are

displayed.

The Snat and/or Dnat fields are displayed only if

there is translation in the flow rule.

Users user ID

Certificates Certificate DN
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Object Naming convention

QoS rules criterion: interface/internet access - 'service1,

service2'

The criterion field corresponds to the class used for

a QoS egress rule and to the traffic conditionner for

a QoS ingress rule.

The Interface and internet access fields:

• are equal to all interfaces or all internet

accesses if the options All interfaces and All

internet accesses are activated in the Criteria

tab of the QoS rule.

• are empty if the options No interface and g are

activated.

• list the interfaces and internet accesses if

the options The following interfaces and The

following internet accesses are activated. If

there are more than two interfaces or internet

accesses configured, only the first two are

displayed.

If there are more than two services, only the first

two are displayed.

Schedules days : [interval1, interval2]

The days field is equal to:

• Every Day if the option Every Day is activated in

the General tab of the object Schedule.

• day if the option Day is activated.

• first day-last day if the option Days is activated.

The interval field is equal to start time-end time.

2.3.3. Searching Configurations
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Highlighting Objects

Explorer Search Bar

The explorer search bar can be used to perform a simple search using a simple string search. It is located

directly above the status bar at the bottom edge of the window. To display the explorer status bar:

• click on the light blue upward arrow directly above the status bar at the bottom edge of the window.

• alternatively, press Ctrl + F.

To perform a simple search using the explorer search bar:

1. Enter the search criterion in the free-text field.

2. Search through the configuration by selecting Find Next or Find Previous as required. Objects

matching the search criterion are highlighted in yellow.

3. Click Advanced search or By IP/Network to display the advanced search dialog box or the search by

IP/Network dialog box.

Find Origin Item

Arkoon Manager  enables you to localize an object in the configuration so that you can find which service

or element the object belongs to.

• in the explorer, the descriptive view or in a field, select the required object, select Find > Find origin

from the menu options; the explorer and descriptive view which the object belongs to appear on the

left of the window

• select the required object in the appropriate view or field and press Ctrl + Home; the explorer and

descriptive view which the object belongs to appear on the left of the window

Find by IP/Network

The Find by IP/Network feature can be used to search by IP address or by network. To perform a search

by IP/Network:

1. From the menu options, select Find > Find by IP/Network; the Find by IP/Network dialog box appears.

2. Select the search criteria as required from the drop-down lists and click Find.
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Advanced Search

The advanced search feature can be used to search by object type, name, description, etc. To perform

an advanced search:

1. From the menu options, select Find > Advanced search or click the Search button in the tools bar; the

Search dialog box appears.

2. Select the search criteria as required from the drop-down lists and click Find.

Smart Find Feature

When configuring objects, you can use the Smart Find feature to find objects that correspond to the item

that you are configuring. For example, if you are configuring a Fast360 appliance with a DNS server, if you

right-click in the blank DNS field, select Smart find, the object that you are looking for, and its location,

appears in the Smart Find pop-up window that appears.

Note

The Smart Find feature only works if the object has been previously configured with the relevant

capability.
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2.3.4. Customizing the Interface

In addition to the layout of the windows elements, other aspects of the  Arkoon Manager  interface can

be customized to your needs. To access the various options for customizing the interface, select the

Preferences option from the Application menu; the Preferences dialog box appears.

Appearance Preferences

The Appearance configuration form contains the parameters for setting the appearance of the interface

including:

• language selection

• label alignment

• icon size

Select from the options in the drop-down lists as required.

Note

When working with big configurations, selecting the small icon size option will improve

readability of the configuration.

Edition Preferences

The Edition configuration form contains the parameters for setting preferences for editing of new objects.

Select one of the three options for editing new objects as required:

• Select and Edit: newly created objects appear open for editing.

• Select and Rename: newly created objects appear in the descriptive view with the Name field open

for editing only.
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• Select Only: newly created objects appear only in the descriptive view and have to be manually opened

for editing.

Windows Preferences

The Window configuration form contains the parameters for setting the appearance of windows and

tabs in the interface. You can choose to dock/undock windows as well as their docked position in the

interface.

Messages Preferences

The Messages configuration form contains the parameters for displaying warning messages, tooltips,

and tip-of-the-day messages.
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Network Preferences

The Network configuration form contains the parameters for setting network connections.

1. In the Ping period field, set the interval (in seconds) from when the last ping is sent by  Arkoon Manager

to the server (and conversely) to check that the connection is still established. By default, this value

is 5 seconds.



Chapter 2. Using Arkoon Tools

Using Arkoon Manager | 41

2. In the Remote commands field, set the timeout value (in seconds) after which a command submitted

to a server (for example, for retrieving LDAP directories) is considered to have failed. By default, this

value is 300 seconds.

3. In the Connection to appliance field, set the timeout value (in seconds) after which the connection to

the appliance is considered to have failed. By default, this value is 3 seconds.

2.4. Using Arkoon Manager

When you open Arkoon Manager in not connected mode you will see the following screen:

From the not connected mode screen you can:

• create a new configuration offline and save it to a file

• load a configuration from a local file

• connect to a Fast360 appliance or  AMC  server

• complete a Quick Login with your last session parameters (if you have previously connected to an

appliance)

When you have connected to an appliance or  AMC  server you will see the following screen:
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• create a new configuration to retrieve the addressing network configured via Minimal Arkoon

Configuration or the Initialization Wizard

• configure a new, existing local or remote configuration

• manage Access Control configuration/Roles

• manage the Certificate Authority

This section explains the above operations in the order that they are performed by the administrator.

2.4.1. Managing Administration Sessions

Managing Sessions

To open, download or install a configuration on the Fast360 appliance or the  AMC  server, you need to

be connected to the appliance or to the  AMC  server; this is referred to as a session.

Caution

This is a secured connection (using the SSL v3 protocol). To connect to a Fast360 appliance or

to a AMC  server, you must fulfil the following requirements:

• The IP address of your administration machine must be authorized in the Admin from

parameter of the minarkconf program.

• You must know the IP address of the Fast360 interface or of the AMC  server interface to which

you want to connect.

• You must have a PKCS#12 administration certificate and know the password protecting it (this

password is required for each connection). For more details about certificates and passwords,

see the First-Time Configuration Guide.
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Caution

The PKCS#12 (Private Information Exchange Standard) management certificate provided to

Fast360 appliance administrators and users contains private information that is generated during

the creation of the certificate. Some of this information, such as the private key used for

authenticating and the negotiating SSL secured connections, is strictly confidential. Disclosing

such information to a third party will result in the certificate being revoked. The password

protecting the PKCS#12 file must be highly resistant and meet the password requirements of

minarkconf ; see the First-Time Configuration guide for more details. The file should be stored

in a location to which only the file owner has access. We generally name this file a PKCS#12

certificate.

Note

Two administrators cannot be connected concurrently to an appliance or AMC  server with write

rights. Write rights will be denied to administrators who connect after the first administrator (with

write rights) connected to the appliance or AMC  server.

Connecting to the Fast360  Appliance or to an  AMC  Server

There are two options for connecting to the Fast360 appliance or to an AMC  server:

• Select a session: select a session to connect to the appliance or to AMC  server.

• Quick Login: connect by reusing already defined connection settings from your last session.

The options are presented as shown below.

Connecting via a New Session

1. Double-click on the Select a session icon; the Sessions screen replaces the  Arkoon Manager  main

menu window.

2. In the Session explorer, right-click on the Sessions folder, select New > Session from the drop-down

menu. The Session configuration form appears on the right.
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3. Enter the name and a short description of this new session in the corresponding Name and Description

fields.

4. Enter the IP address of the Fast360 appliance or of the AMC  server in the IP address field

5. Enter the connection port in the Port field. By default, this value is set to 1750.

6. Enter the file path (access path and the name of the file) of the PKCS#12 certificate in the X.509

Certificate field. Alternatively, click on the folder icon to locate the certificate file location.

7. Click on the Login option in the Session toolbar; the Login dialog box appears.

8. Enter the certificate's password in the Password field and click on the Login button. The Connecting

dialog appears briefly.

• If your login is successful, the Connected mode screen will appear.
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• If your login fails, the error dialog box appears. Select Retry and amend the login details as advised

by this error message.

Multi-appliances Configuration Connections

In the case of a multi-appliances configuration, and when the appliance connects to the AMC server for

the first time, the administrator has the option of:

• creating an object from scratch for this new Fast360 appliance, or

• associating the newly detected appliance with a previously provisioned appliance object in the

configuration

Connecting Using an Existing Session

1. Double-click on the Quick login icon; the Login dialog box appears with your last session details in

the corresponding fields.

2. Check that the session parameters taken from your last session connection are correct.

3. Enter the PKCS#12 password in the Password field and click on the Login button. The Connecting

dialog appears briefly.

• If your login is successful, the Connected mode screen will appear.

• If your login fails, the error dialog box appears. Select Retry and amend the login details as advised

by this error message.

Note

When editing a configuration in connected mode, if the connection with the appliance has been

lost, it is possible to reconnect by clicking on the deconnection status icon.

Disconnecting from a Fast360 Appliance or from an AMC  Server Active Session

To disconnect from an active session:

• From the main Connected mode screen, click on the green arrow Back to main menu and disconnect

in the bottom left-hand corner of the screen.

Caution

For security reasons, do not leave an open connection unattended.
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Connected Mode Workflow

For a detailed explanation of what an administrator can do in connected mode, see Section 2.2.2,

“Connected Mode”.

2.4.2. Managing Security Policies

The Configure mode in  Arkoon Tools  is the key interface for managing network security policies and

configuring Fast360 appliances. The configuration interface has been designed around the use of objects,

individual configurable elements which can be copied and reused to build up a coherent network security

policy deployed across a network of Fast360 appliances.

Configuration Tabs

The configuration tabs lined up vertically on the left side of the default window configuration allow you

to access different groups or classes of configuration objects. Configuration objects are grouped and

tabbed as follows:

Network Objects This tab contains folders for the Fast360 appliances, host systems,

and networks in your deployment.

Services This tab includes configuration for the protocol services which

are used in traffic filtering rules.

Time management In this tab you define scheduling rules which are used in

configuring traffic filtering rules.

URL Filtering Categories This tab allows you to enter URLs or keywords for web filtering.

Authentication This tab allows you to define and configure the various

authentication methods used on your deployment. This includes
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X.509 certificate management, PKI configuration, and local user

login/password and/or certificate database management. See

Chapter 14, Users Authentication for more details on configuring

and managing authentication.

IDPS This tab provides for configuration and management of the

optional FAST IDPS (Intrusion Detection and Prevention System).

See Section 11.2, “IDPS” for more details on FAST IDPS.

VPNs This tab provides for configuring IPsec VPN tunnels on the Fast360

appliance. See Chapter 12, Configuring IPsec VPN Tunnels for

more details on VPN configuration.

IP Filtering Rules This tab allows you to create and manage traffic filtering rules.

QoS This tab includes folders for managing and configuring QoS

parameters. See Section 17.4, “Quality of Service (QoS)” for more

details on configuring QoS.

FAST Policies This tab includes folders for system-defined and user-defined

FAST policies

Policies This tab includes folders for defining various management

policies for the Fast360 appliances on the network: ICMP policies,

log policies, updating policies, and antispam policies.

Loading Security Policies

When you load a security policy in connected mode, the configuration is synchronized with the appliance

hardware configuration. Details of the synchronization can be viewed in the Hardware information dialog

box. For configurations with multiple Fast360 appliances, you can select the required appliance from the

Select this one drop-down list. In multi-appliances configurations, this dialog box can be used to check

that the appliances are connected to the AMC server.

Opening a Locally Saved Configuration

Opening a locally saved configuration involves loading this configuration file from the administration

station.

1. Double-click on the Load from file icon; the Download dialog box appears.

2. Select the configuration file to be downloaded and click on Download.

• The AMC server contains all the installed configuration versions.
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• The current configuration is automatically selected.

• On an appliance connected to an AMC server, only the last 3 configurations are saved.

• If the configuration history takes time to load, you must select to configurations to delete and click

on Delete.

Downloading a Configuration Saved on the Fast360 Appliance or  AMC  Server

Downloading a configuration involves opening a configuration saved on the  Fast360  appliance or  AMC

server.

1. In connected mode, double-click on the Remote configuration icon; the Download dialog box appears.

2. Select the configuration file to be downloaded and click on Download. The download box presents

all configurations stored with a different name and their ancestors.

Saving Security Policies

Saving a Configuration Locally

Saving a configuration locally involves saving it on the administration machine. Two options are available

to save a configuration locally:

Save

This option can be used to instantaneously save the modifications made on the current configuration.

1. From the Application menu, select Save. Alternatively, press Ctrl + S. The Save as dialog box appears.

2. Use the Look in: drop-down menu to select where the file is to be saved.

3. Enter the name of the file in the File name: field.

4. Select, if needed, the encryption mode using the Application menu. By default, the standard option

is enabled (no encryption). The two encryption options are 3DES and RSA. If one of these options is

selected, the Password dialog box appears. Enter and confirm a password and click OK.

5. Complete the operation by clicking OK.

Note

You can change the previously entered password by clicking Options.

Caution

For optimal security, you must encrypt configurations which are saved outside the Fast360

appliance. To encrypt the configuration you are saving locally: select Application > Save

encrypted; enter and confirm the password in the corresponding fields of the Password dialog

box and click OK to complete the operation.
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Save as

This option can be used to locally save the current configuration file in another directory and/or under

another name than the original and to encrypt it if required.

1. From the Application menu, select Save as.

2. Complete the operation following the procedure outlined in the section called “Save”.

Saving a Configuration on the Fast360 Appliance

Saving a configuration involves saving it on the Fast360 appliance to which you are connected.

1. From the Application menu, select Save as.

2. Complete the operation following the procedure outlined in the section called “Save”.

Note

Saving the configuration on the appliance does not mean that the Fast360 appliance takes it into

account. Indeed, the configuration must be deployed to be taken into account.

Auditing Security Policies

Checking the Coherency of a Configuration

It is essential to check the coherency of the configuration before deploying it.  Arkoon Manager

automatically checks for coherency errors before deploying any configuration.

Caution

Checking the coherency of a configuration guarantees that the Fast360 appliance understands

the configuration file. It detects most cases where:

• an undefined object is referenced by another object

• a field contains an incorrect or unacceptable value

• a functionality is defined in an incomplete or contradictory way

• the routing and addressing of the Fast360 appliance does not allow it to join all the referenced

objects

It does not detect:

• problems with the order of rules including filtering rules, antispam rules, applicative rules, QoS

rules

• general problems of addressing and routing logic

To check the coherency of a configuration:

• click the Check toolbar button in the toolbar directly beneath the menus

• from the menu, select Actions > Check configuration

• deploy the configuration to force an automatic coherency check

The result of this check can be viewed in the Check coherency window.
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This Check coherency window displays three different types of messages:

• errors

• warnings

• information messages

The explorer view of the Check coherency window summarizes how many different types of error

messages have been detected during the coherency check. To view the details of the messages, click on

the relevant message type icon in the explorer view; the details of the errors are displayed on the right.

• Errors (color-coded red): errors prevent you from successfully deploying the configuration on the

appliance. The error message indicates the name of the problematic object and provides a short

explanation. Right-clicking the error displays a shortcut to where in the configuration the errors need

be resolved.

• Warnings (color-coded orange): warnings do not prevent you from deploying the configuration but you

should take corrective action to resolve the issue. The warning message indicates the name of the

problematic object and provides a short explanation. Right-clicking the warning displays a shortcut to

where in the configuration the errors need be resolved.

• Information messages (color-coded blue): information messages provide useful information about the

configuration that you are about to deploy if relevant; they do not require you to take any action.

Caution

Only the presence of error messages in the coherency check will prevent you from deploying

the configuration.

Note

The coherency of your configuration is also checked when you attempt to delete an object to

prevent you from deleting an object that is linked to another object in the configuration. If the
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object is linked, a warning displays which other objects reference the object you are trying to

delete.

Deploying Security Policies

Deploying a Configuration

1. Connect to the required Fast360 appliance. For detailed information on how to connect to an appliance,

see the section called “Connecting to the Fast360  Appliance or to an  AMC  Server”.

2. Complete a coherency check of the configuration; for more details on checking the coherency of your

configuration, see the section called “Checking the Coherency of a Configuration”.

3. Click on the Deploy toolbar button directly beneath the menus. Alternatively, select Actions > Deploy

configuration. The Apply dialog box appears.

4. In the Apply dialog box, check that the configuration details are correct and click on Apply. The details

of the configuration deployment are displayed in the Console window at the bottom of the screen.

Deploying a Multi-Fast360 Appliance Configuration

There are several options available to you if you have a multi-Fast360 appliance configuration:

• to install a configuration on all Fast360 appliances in your configuration, select the corresponding

option

• to install the configuration only on certain Fast360 appliances:

1. Select the required Fast360 appliances from the list displayed in the dialog box.

2. Click on the Selective Install button.

2.4.3. Maintaining Appliances

Arkoon Manager  provides administrators with a set of features that facilitate appliance maintenance.

These features are available from the Actions menu when editing a security policy configuration in

connected mode.

Backing-up System Configuration

This feature allows administrators to backup configuration data stored in the appliance configuration

directory. Configuration data include minarkconf parameters such as Admin From, Certificate

Authority data, current Access Control and Security Policies. Backing-up the configuration

directory will help you to recover rapidly from a potential disaster.

1. In connected mode, open a Security Policy.

2. Select Actions > Advanced Administration >  Configuration card backup. The Select Fast360 to

backup configcard dialog box appears.

3. In the Select Fast360 to backup configcard dialog box:

a. Click on the Fast360 appliance object whose system configuration you want to back up.

b. Click on the Select button at the bottom of the dialog box.

4. Select where the backup configuration data file is to be stored.
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Caution

Backing-up the system configuration creates an archive that may contain confidential

information such as passwords, network topology, shared secrets, etc. This data should be

stored securely.

Obtaining Diagnostic Data

To quickly and easily obtain diagnostic data, complete the following procedure.

1. In connected mode, open a Security Policy.

2. Select Actions > Advanced Administration > Get diagnostic data. A Warning dialog box appears,

warning you that the script will collect information from your system and create a result archive

containing confidential information; click Continue if you agree. The Select Fast360 appliance to get

diagnostic data from dialog box appears.

3. In the Select Fast360 appliance to get diagnostic data from dialog box:

a. Click on the Fast360 appliance object that you want to get diagnostic data for.

b. Click on the Select button at the bottom of the dialog box.

4. Select where the diagnostic data file is to be stored.

Caution

Obtaining diagnostic data of the system configuration creates an archive that may contain

confidential information such as passwords, network topology, shared secrets, etc. This data

should be stored securely.

Note

The diagnostic data script can run for several minutes and can affect performance of the

appliance whilst retrieving data.

Installing Licenses

Requesting a license

1. In connected mode, open a Security Policy.

2. Select Actions > Advanced Administration > License request.

3. Select the Fast360 appliance for which you are requesting a license.

4. Enter a name and validate.

5. Select the folder in which the .akr file generated by the appliance will be saved.

Arkoon may ask the .akr file in order to generate a new license for the appliance.

Installing a License on a Fast360 Appliance

1. In connected mode, open a Security Policy.

2. Select Actions > Advanced Administration >  Install License.

3. Select the Fast360 appliance the license is to be installed on.

4. Select the file containing the license.

5. Consult the Console window for confirmation of license information.
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Deploying Certificate Revocation Lists

1. In connected mode, open a Security Policy.

2. Select Actions > Advanced Administration >  Install PEM Certificates Revocation List file.

Setting VPN certificate

This option allows you to install a certificate used to establish the appliance VPN tunnels.

1. In connected mode, go to Actions > Advanced Administration > Set VPN certificate

2. Select the certificate to import, and click on Open.

3. Close the configuration and re-open it.

4. Accept the synchronization information for the new certificate to be taken into account.

Obtaining network capture

This option allows you to obtain a network capture from an appliance with Arkoon Manager. The

capture is automatically saved on the administrator workstation in the specified folder. Before doing a

network capture, define the tool enabling to display the capture in the Software tab in Arkoon Manager's

Preferences.

1. In connected mode, go to Actions > Advanced Administration > Network capture.

2. Select the Fast360 appliance from which the capture will be perform. You cannot select more than

one appliance (or only one cluster node). If you select a cluster (instead of a node), the capture will

automatically apply to the active node. Click Select.

3. Select the folder to save the capture.

4. In the window Network capture, select the appliance interface on which the network capture will

be performed. By default, the capture is performed on all the interfaces (“any”), but it is possible to

select only one interface.

5. Define the filter. The filter syntax is the same than in the “tcpdump” tool. The default filter value

is “noadmin”. Refer to the information at the bottom of the window to see the details of the filter.

The “noadmin” filter enables to capture all network flows with the exception of administrative flows

authorized by the Admin from parameter in minarkconf (SSH, Arkoon Manager, Arkoon Monitoring)

and of cluster connection flows (VRRP). It is not possible to use the “noadmin” filter with another filter.

6. Click Capture.

7. Stop the capture when needed. It is then automatically displayed in the tool you defined in the Arkoon

Manager's Preferences.
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Resetting flow rules hit count

This option allows you to reset the flow rules hit count. This is the number of times a flow rule has been

used to filter the traffic. This information can be viewed in the Hit Count column in the Rules view. It is

possible to reset the hit count for one or more appliances. The appliances “system” counters are then

reset to zero.

1. In connected mode, go to Actions > Advanced Administration > Reset Flow Rules Hit Count.

2. Select the appliance for which the hit count must be reset. You can select several appliances at the

same time. If you select a cluster (instead of a node), the flow rules hit count is reset on both nodes.

3. Click Apply.

Note

The Hit Count column in the Rules view may not display zero after the hit count has been reset

on an appliance. This is because flow rules may have been used again between the reset and

the update of the hit count by Arkoon Manager (every 30 seconds). This may happen particularly

in a multi-appliances context with an AMC server.

For more information on the Hit Count column in the flow rules descriptive view, refer to Section 8.3.10,

“Estimating the Relevance of a Filtering Rule”.

2.5. Using Arkoon Monitoring

Arkoon Monitoring  is the interface for day-to-day monitoring of Fast360 activity, including logs and alerts

and real-time appliance status monitoring (load, performance, etc.). Note, access rights apply to the

Arkoon Monitoring  application.

Information on the  Arkoon Monitoring  application is provided in the relevant sections of this guide which

document the features where it is used; log management is documented in Section 16.6, “Managing Logs

and Alerts”.



Managing Authentication Certificates | 55

Chapter 3. Managing Authentication Certificates

and Administrator Rights

3.1. Managing Authentication Certificates

To access the Certification Authority Manager:

1. In connected mode, double-click on the Certificate Authority | Manage the Certificate Authority icon

in the Connected mode main screen.

2. The Retrieving certificate activity dialog box appears for short time followed by the Certification

authority window.

Note

If a cluster node possesses an Authentication Certificate (CA), this authority is not replicated to

the other cluster node. Only the node with the CA is able to manage the CA. If a CA is configured

on a cluster, it is recommended to put it on the master node.

The Certification authority folder contains three sub-folders:

• Valid certificates: lists all valid certificates owned by the CA.

• Expired certificates: lists all expired certificates owned by the CA.

• Revoked certificates: lists all revoked certificates owned by the CA.
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Basic details of the certificates (name, description, type and validity period) can be viewed in the

descriptive view. To view the details, click on the relevant folder in the explorer view; all the certificates

in that folder and their corresponding details are displayed in the descriptive view.

You can create new certificates (administrator certificates, certificates for appliances or end users for

VPN, IP filtering), send sign requests and export and revoke certificates.

Note

The CA’s password (which is used to protect access to the CA and is different from passwords

used to protect a given PKCS#12 file) is required for all CA operations.

Passwords used on Fast360 devices must be at least 6 digits long and include at least three of

the following four different types of characters:

• lowercase characters [a-z]

• uppercase characters [A-Z]

• numbers [0–9]

• any special characters (@, #,$,...)

Important

Change the root password and the passwords of users with administrative rights

frequently. Either memorize passwords or keep them in a location with a level of security

at least equivalent to the security level as for the function for which they are intended.

For more details on the password security policy, see the First-Time Configuration Guide.

3.1.1. Creating New Certificates

1. Create a new certificate by:

• right-clicking on Valid certificates folder in the explorer view

• right-clicking on the blank area in the descriptive view of the Valid certificates folder

• right-clicking on one of the certificates in the descriptive view

Select New certificate from the drop-down menu. The New certificate configuration form is displayed

on the right.

• clicking on the New Certificate icon in the Certification authority toolbar. The New certificate

configuration form is displayed on the right

Caution

The certificate generated is a PKCS#12 certificate file with ADMIN rights. A PKCS#12 file contains

more than just a certificate. It contains strictly personal data (among which the user private key).

A unique certificate should be created for each administrator and administrators should keep

that certificate in a place with a security level at least equivalent to the security level of the

certificate use.

3.1.2. Signing a CSR

A CSR (Certificate Signing Request) is a message sent from an applicant to the CA, requesting a digital

identity certificate.

1. Open the signing form by:

• right-clicking on one of the certificate folders in the explorer view
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• right-clicking on the blank area in the descriptive view of one of the certificates folder

• right-clicking on one of the certificates in the descriptive view

• rlicking on the Sign request icon in the Certification authority toolbar

The Sign request configuration form is displayed on the right.

• clicking on the Sign request icon in the Certification authority toolbar. The Sign request

configuration form is displayed on the right

2. Provide the following parameters:

a. the path to the CSR on the local machine

b. the type and validity period of the generated certificate

c. the output format (DER or PEM) and the path of the generated certificate on the local machine

3. Click on the Sign button and authenticate by providing the CA password.

A new certificate corresponding to the CSR is created. It is visible in the Valid certificates folder.

The certificate is exported to the local machine according to the parameters provided.

3.1.3. Exporting a Certificate

Exporting certificates applies to valid certificates as these are the certificates used by users to prove

their identity. Certificates can be exported in different ways:

• DER: data is encoded according to the Distinguished Encoding Rules method

• PEM: data is sent in the Privacy Enhanced Mail format

• Text: data is sent as a text file

In the descriptive view, right-click on the certificate that you want to export and select Export > Export

as , selecting the required export method from the drop-down list.

3.1.4. Revoking a Certificate

Certificates can be irreversibly revoked and placed on a Certificate Revocation List (CRL) if the user's

private key has been compromised or the CA's policy has been violated. A complete list of the reasons

for revoking a certificate can be found in the RFC 3280.

1. In the descriptive view, right-click on the certificate that you want to revoke and select Revoke from

the drop-down list. The Authenticate dialog box appears.

2. In the Authenticate dialog box, enter the CA password in the corresponding field and click on the

Proceed option. The Retrieving certificate activity dialog box appears.

3. The revoked certificate now appears in the Revoked certificates folder.

3.1.5. Updating the CRL on an appliance

The lifetime of the CRL of an appliance is 10 years by default. If the CRL is no longer valid, you cannot

connect to Arkoon Manager. The following error message displays: Your certificate is not valid yet or your

CRL is expired. To update your CRL, use minarkconf/Certificates/Update Certificate Revocation List (CRL).
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Each time a certificate is added or revoked, the period of 10 years starts again. It is also possible to

regenerate the CRL from minarkconf using the menu Certificates>Update Certificate Revocation List

(CRL):

1. Connect to the appliance in SSH.

2. Launch minarkconf.

3. In the menu Certificates, click Update Revocation List (CRL) and type the password of the Certification

Authority (CA).

3.2. Managing Administrator Rights

To access the Administrator Rights Manager:

1. In connected mode, double-click on the Administration rights | Manage administration rights icon in

the Connected mode main screen; the Download dialog box appears.

2. In the Download dialog box, select an access control policy from the list displayed in the Download

tab and click on the Download button.

3. The Downloading access control policy activity dialog box appears briefly followed by the

Administrator Rights screen.

Controlling access to administration features involves:

• authenticating users

• controlling access to administration features based on what authenticated users are authorized, or

not, to do

An administrator might not be authorized to access all the applications in  Arkoon Manager  depending

on their role(s). You need to be connected to a remote  AMC  platform or Fast360 appliance to manage

administrator rights.

Warning

When assigning a root account (or superuser), it is important to ensure security measures are

respected. For more information, refer to Section 1.3, “Security Rules”.

3.2.1. Configuring Administrator Rights

The Administrators folder in the Administrator rights folder contains the default administrator which is

generated on initialization of the appliance.

The default Administrator is pre-configured with the appropriate X.509 certificate and the default Role All

Permissions role. You need to complete the identification and contact details in the AdministratorData

and Contact configuration forms; for more details, see the section called “Adding New Administrators”.

Adding New Administrators

1. In the Administrator Rights explorer view, right-click on the Administrators folder, select New >

Administrator. The Administrator configuration form is displayed on the right.
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2. In the Properties configuration form, enter a name and short description of the administrator in the

corresponding fields.

3. In the Administrator Data configuration form, enter the full name and address of the administrator.

4. In the Contact configuration form, enter the email address and telephone number of the administrator

in the corresponding fields.

5. In the X.509 Certificate configuration form, import a X.509 certificate:

• To import the certificate from file, click on the Import from file option.

• To import the certificate from CA, click on the Import from CA option. The Retrieving certificate

dialog box appears followed by the Certification authority dialog box.

a. In the explorer view, click on the Valid certificates folder to display the certificates in the

descriptive view of the dialog box.

b. In the descriptive view, right-click on the required certificate, select Import. The selected

certificate is imported and its details are displayed in the X.509 Certificate field.

6. In the Roles configuration form, drag and drop the appropriate Role objects into the corresponding

field. For the complete list of the different administrator roles and responsibilities, see Table 3.1, “Role

Descriptions”.

Note

By default, the role All Permissions is assigned to newly created administrators.

3.2.2. Managing Administration Access Control Policies

Authorization is performed based on roles associated to administrators.

The Administrator rights folder contains two sub-folders:

• Administrators: lists all administrators including the default administrator.

• Roles: lists all administration roles; see Table 3.2, “Role Permissions” for the complete list of roles and

their corresponding responsibilities.

As an administrator may need to interact with CA, the Certificate Authority tab is visible in the top, right-

hand corner of the Roles/Administrator rights window.
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Warning

The default administrator account has all the administrator rights, in particular the right to

connect to the appliance. Keeping this account can make the roles management useless since

an account with all rights would remain active. Thus, it is recommended to deactivate the default

administrator account as soon as the appliance is put into production.

Note

Administration access control policies can only be edited remotely and not on the administration

workstation. The access control database is initialized from  minarkconf  administration interface

on the appliance.

3.2.3. Administration Roles

A security infrastructure can contain several Fast360 appliances which may require different

administrators, with different roles, to intervene on them. The Fast360 appliance's administration tools

enable a security officer to distribute administration responsibilities according to seven defined roles.

An administrator can combine several of these roles.

Table 3.1. Role Descriptions

Role Name Role Description

Security Officer This role is assigned to the person who creates

the other administrators. Consequently, the person

linked to this role has no administration or

supervision responsibilities but only linked SSL

certificates to one or several administration roles.

Network and System Administrator This role is assigned to the person in charge

of both the network and the system parameters.

This person is able to read the security policy

and manage the system logs. Responsible for

system management, the network and system

administrator can update the Fast360 software

version and licensing.

Network and System Supervisor This role is linked to a person who checks the

system status and the network events.

Security Administrator This role is assigned to the person in charge

of security. This person is able to define all the

configuration parameters related to the security

context and is also able to monitor the security logs.

Security Supervisor This role is linked to the person who follows

security events and checks/deletes the security

alerts.

Auditor Role Auditor.

Role All Permissions This role will be used in organizations where only

one person is in charge of the Fast360 appliance.

Warning

The role All Permissions must be used with caution because it allows total control over the

administration operations. As described in the table above, it is recommended to use this role

only if one administrator is in charge of the administration of the appliance.
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The following table summarizes the rights associated with the seven different roles.

Table 3.2. Role Permissions

Permissions / Roles Security

Officer

Network

and

System

Admin

Network

and

System

Supervisor

Security

Admin

Security

Supervisor

Auditor Role All

Permissions

CA Management  

Get a X.509 list of the Arkoon PKI X   X  X X

Revoke a certificate on the

Arkoon PKI

X   X   X

Get a X.509 certificate from the

Arkoon PKI

X   X  X X

Sign a Certificate Signing

Request (CSR) with the Arkoon

PKI Certificate Authority

X   X   X

Create a new certificate and

private key signed by the Arkoon

PKI Certificate Authority

X   X   X

Send and record a Certification

Revocation List

   X   X

Apply to the CRL to the Arkoon

PKI

   X   X

Access Control  

Get the list of role configuration

files recorded on the appliance

or the AMC server

X     X X

Get a defined role configuration

file recorded on the appliance

or the AMC server

X     X X

Get all the versions of a defined

role configuration file recorded

on the appliance or the AMC

server

X     X X

Get the current applied role

configuration file name

X     X X

Save (record) a role

configuration file

X      X

Apply a role configuration file X      X

Remove a configuration file X      X

Hardware System

Configuration File

 

Get the hardware system

configuration files list

 X  X X  X

 X  X X  X
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Permissions / Roles Security

Officer

Network

and

System

Admin

Network

and

System

Supervisor

Security

Admin

Security

Supervisor

Auditor Role All

Permissions

Get one hardware system

configuration file

Get the next hardware system

configuration file

 X  X X  X

Update the hardware system

file information

 X  X X X X

Fast360 Appliance

Configuration

 

Get the Fast360 appliance

configuration list

 X  X X X X

Get a defined Fast360 appliance

configuration

 X  X X X X

Get all the version of a file

defined by its name

 X  X X X X

Get a current version list of a

defined file

 X  X X X X

Save the configuration currently

in the editor on the appliance

   X   X

Apply a saved configuration to

the Fast360 appliance

   X   X

Apply a saved configuration to a

specific Fast360 appliance

   X   X

External User Management  

Get all groups from a LDAP or an

AD NTLM server

   X   X

Get all users' DN from a LDAP or

AD NTLM server

   X   X

IDPS Rules  

Get all IDPS rules    X X  X

Configuration Directory Back-

up

 

Start to build a configuration

directory snapshot.

 X  X  X X

Get the available configuration

snapshot

 X  X  X X

Get Diagnostic Data  

Start to build a Fast360

diagnostic snapshot.

 X  X X X X

Get Fast360 diagnostic

snapshot.

 X  X X X X
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Permissions / Roles Security

Officer

Network

and

System

Admin

Network

and

System

Supervisor

Security

Admin

Security

Supervisor

Auditor Role All

Permissions

License Management  

Start the process to get the

Fast360 appliance license.

 X     X

Get the Fast360 appliance

license request

 X     X

Send the license to the Fast360

appliance

 X     X

Install the sent license on the

Fast360 appliance

 X     X

Arkoon Monitoring

Permissions

 

Actions group related to

monitoring of the alerts (read

only)

X  X X X X X

Actions group related to the

supervision of the alerts (write)

    X  X

Actions group related to the

monitoring of the system and

database logs (read only)

 X X X X X X

Actions group related to the

supervision of the system and

database logs (write)

    X  X

Actions group related to the

monitoring of the HTTP events

(read only)

   X X X X

Actions group related to the

supervision of the HTTP events

(write)

    X  X

Actions group related to the

monitoring of the IDPS system

(read only)

 X X X X X X

Actions group related to the

supervision of the IDPS system

(write)

    X  X

Actions group related to the

monitoring of the Mail and

SMTP system (read only)

   X X X X

Actions group related to the

supervision of the Mail and

SMTP (write)

    X  X

Actions group related to the

monitoring of the Operating

 X X X X X X
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Permissions / Roles Security

Officer

Network

and

System

Admin

Network

and

System

Supervisor

Security

Admin

Security

Supervisor

Auditor Role All

Permissions

and Applications systems (read

only)

Actions group related to the

supervision of the Operating

and Application systems (write)

  X  X  X

Actions group related to the

network monitoring (read only)

 X X X X X X

Actions group related to the

network supervision

  X  X  X

Actions group related to

the Virtual Private Network

monitoring (read only)

 X X X X X X

Actions group related to

the Virtual Private Network

supervision (write)

  X  X  X

Actions group related to

the Authentication system

monitoring (read only)

   X X X X

Actions group related to

the Authentication system

supervision (write)

    X  X

Actions group related to Fast360

software updates

 X     X

3.2.4. Loading Administration Access Control Policies

1. Connect to  Arkoon Manager  following the procedure outline in the section called “Connecting to the

Fast360  Appliance or to an  AMC  Server”.

2. In the connected mode screen, double-click on the Administration rights | Manage administration

rights icon. The Downlaod dialog box appears.

3. In the Download tab, check that the details of the access control configuration file are correct and

click on the Download button. The Administrator Rights view is displayed.

3.2.5. Saving Administration Access Control Policies

Saving an administration access control policy involves uploading it to the Fast360 appliance to which

you are connected.

1. In the Administrator Rights window, select the Application > Upload. The Upload dialog box appears.

2. Check that the details in the Name and Description fields are correct and click on Upload.

3. The Upload successful dialog box appears to advise you that the “configuration access_control has

been correctly uploaded”. Click Continue to return to the Administrator Rights window.
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3.2.6. Deploying Administration Access Control Policies

1. In the Roles window, click on the Apply toolbar button. The Apply dialog box appears.

2. Check that the details in the Name and Description fields are correct and click on Apply. The Applying

roles_access_control activity dialog box appears.

3. To view details of the deployment, refer to the Console window now visible at the bottom of the window

which displays a text report of the deployment operation.

Note

On an AMC server, it is necessary an appliance to be already connected to the AMC server for

the Administration Access Control Policies deployment to be functional.
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Chapter 4. Fast360 Network Configuration

This chapter covers the network configuration of the appliance Fast360 and describes the steps to

obtain a consistent configuration.

4.1. Configuring Interfaces

The Interfaces folder contains all the physical interfaces detected in the published appliance (refer

to the First-Time Configuration Guide, section Configuring interfaces of the Fast360 appliance for more

details). This section describes the settings configuration of the most common interfaces to configure

the communication of the Fast360 appliance with the network.

4.1.1. Ethernet Interfaces

To create an Ethernet interface:

1. Select the Interface tab, then enable the interface, enter the network IP address and define the subnet

mask.

2. Select the Advanced tab, then check the options Ignore broadcast traffic and Ignore multicast traffic

are enabled.

• Ignore broadcast traffic prevents the broadcast traffic from LAN to be forwarded by the interface

(uncheck this interface when using the relay function or DHCP server).

• Ignore multicast traffic prevents the interface to listen to multicast traffic (uncheck this option if

this interface must listen to multicast traffic, for example for dynamic routing protocols).

3. If the topology exists, check the Custom MTU option and modify the MTU (1500 by default). The

MTU (Maximum Transmission Unit) is the size in bytes of the largest packet that a given layer of a

communications protocol can transmit.

Note

The Ethernet media field defines the type of media on which the Ethernet interface works. By

default it is set to Automatic. It is recommended to use this setting. It is also recommended that

the remote network equipment connected to the interface of the Fast360 uses this setting.
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4.1.2. VLAN Interfaces

A Virtual LAN (VLAN) is a method to create independent logical networks within a physical network.

Logical networks are identified by a unique ID between 0 and 4095 (included) called VLAN ID.

Note

It is recommended to use the IDs between 2 and 4095. IDs 0 and 1 are rarely used as recognized

by all the hardware, so do not use them.

To create a VLAN interface:

1. In the explorer view, right-click on the Interfaces folder.

2. Select Create  > VLAN Interface . A new tab to configure a VLAN interface is displayed on the right

side of the screen.

3. Select the Interface configuration form , then drag and drop the object of the corresponding Ethernet

interface (that will be used as a support for the virtual interface) in the Base interface field .

4. In the VLAN ID field, define the interface VLAN identifier.

5. Select the Advanced configuration form:

a. Do no uncheck the Ignore broadcast traffic option to avoid logging the broadcasts generated by

the machines connected to the Fast360 appliance.

b. Uncheck the Ignore multicast traffic option if this interface must listen to multicast traffic, for

example for dynamic routing protocols.

c. If the topology requires it, check the Custom MTU option and modify the MTU value (1500 by

default).

4.1.3. Bonding Interfaces

The bonding interface (also called aggregation of Ethernet links) consists in gathering together several

Ethernet interfaces.

The mechanism used on the Fast360 appliance to implement the functionality of interfaces aggregation

(bonding) is a "Round Robin" algorithm (equal load distribution over several links) It is not the 802.3ad

standard.

On Fast360 appliances, the bonding interface has an address randomly generated by the kernel. as a

MAC address.
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The settings usually available on an Ethernet interface can be configured globally for all aggregated

interfaces and then forwarded to all aggregated interfaces . Once the new bonding interface is

configured, the aggregated interfaces are no longer usable in the configuration (such as listening

interface relays).

To create a bonding interface:

1. In the explorer view, right-click on the Interfaces folder, then select Create > Bonding interface from

the menu.

A new Bonding interface configuration tab is displayed.

2. Click on the Interface tab and enter the IP address and the subnet mask in the corresponding field.

3. Drag and drop the Ethernet interfaces to aggregate them in the Bonded interfaces field: you must only

aggregate the Ethernet interfaces of the same type (for example: do not aggregate a 10/100 interface

with a Gigabit interface).

4. Select the Advanced tab and uncheck the Ignore multicast traffic option if the interface to create mus

listen to the multicast traffic, for example for dynamic routing protocols.

5. Do no uncheck the Ignore broadcast traffic option to avoid logging the broadcasts generated by the

machines connected to the Fast360 appliance.

6. If needed, check the Interface bandwith option and define (in Mb/s) the bandwidth of the flow passing

through the interface in Mbs/s using the drop-down menu (this interface can then be selected as QoS

filter at bandwidth window level).

4.1.4. Creating an Alias

Creating an alias allows an interface to have a different IP address.

Note

In the case of a cluster, it is not possible de create an alias for an ethernet interface but it is

possible de create a virtual IP address. To create a virtual IP address, refer to Section 13.3.1,

“Initializing a High Availability (HA) Cluster”. It is possible de create several virtual IP addresses

for the same interface but only the first one can be used to configure a VPN tunnel.

To create an alias:

1. Select the interface for which you want to create an alias, and then click on the Alias tab.

2. Right-click in the empty zone of the Alias table, then click on Create > Alias.
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An alias entry appears in the table.

3. To configure the alias, enter the name of the new alias in the Name field, then enter the network IP

address and the subnetwork mask in the IP address and Netmask fields.

Note

It is not possible to use an ethernet interface alias to create a VPN tunnel.

4.2. Main Internet Access - Default Gateway

4.2.1. Configuring the Internet Access

There are three ways to create an Internet access: by router, by ADSL interface or by cable interface.

Configuring an Internet access by routeur

To create an Internet access by routeur:

1. Create a host representing the default gateway by selecting the Hosts object, then right-click on

Create > New > Host.

2. Click on the Network tab, then enter the host IP address.

3. Click on the Services tab and activate its Router capacity.

4. In the tree of the Appliances object, create an Internet access by selecting Internet access, then

right-click and select Create > Internet access.

5. Click on the General tab, then drag and drop the host that represents the default gateway as a Router.
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Configuring an Internet access by ADSL interface

Two types of ADSL interface configuration are possible: PPTP (Point-to-Point Tunneling Protocol) or

PPPoE (Point-to-Point Protocol over Ethernet).

Note

These interfaces cannot be managed by a cluster solution.

1. In the explorer view, right-click the Interfaces folder.

2. From the displayed list, select New > External ADSL device. A new external ADSL interface

configuration tab is displayed on the right.

3. In the External ADSL device configuration tab, select the Interface configuration form:

a. Drag and drop a zone object into the Zone field.

b. Enter your network access name in the Login field.

c. Enter your network access password in the Password field and confirm it in the corresponding

field.

d. Check the Fixed IP address option and enter the public IP address, if you have one, which was

assigned to you by your provider in the corresponding field. If you do not have an IP address, leave

this field blank.
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e. Select the appropriate protocol for your connection:

• For a PPTP connection, check the PPTP option and then drag and drop the corresponding host

object (configured with PPTP modem capacity and the modem's IP address) into the Modem

field.

• For a PPPoE connection, check that option and then drag and drop the corresponding Ethernet

interface object (the Ethernet interface connected to the ADSL modem) into the Interface field.

Note

When configuring PPPoE, you do not need to assign an IP address to the Ethernet

interface connected to the modem. If the Ethernet interface has previously been

configured with an IP address, you must disconnect it.

f. If the topology requires, check the Custom MTU option and modify the MTU value.

4. In the tree of the Appliances object, create an Internet access by selecting Internet access, then

right-click and select Create > Internet access.

5. Click on the General tab, then drag and drop the external ADSL interface in ADSL modem.

Configuring an Internet access by cable interface (DHCP)

A cable interface is an interface which gets its IP address via DHCP.

To create a cable interface:

1. In the explorer view, right-click on Interfaces.

2. Select New > Cable modem interface from the drop-down menu. A new cable interface and its

settings are displayed in the Cable interface configuration form on the right side of the screen.

3. Select the Interface tab:

a. Drag and drop the interface object in the Base interface field.

b. If you have a public IP address, check the Fixed IP option and enter the public IP address your

provided sent you in the corresponding field.

4. In the tree of the Appliances object, create an Internet access by selecting Internet access, then

right-click and select Create > Internet access.
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5. Click on the General tab, then drag and drop the cable interface in Cable modem.

4.2.2. Configuring the Internet Access as Main Access

When multiple Internet accesses have been defined, it is possible to choose one to be used as the

primary/main connection (any connection to the Internet will then be operated by default from this

access).

A non-primary Internet access is not used by default and must be explicitly involved in a flow rule or a

VPN to be used (see Section 4.2.3, “Configuring the secondary/Backup Internet Access”).

To define the Internet access as main access:

1. Click on the Internet access object.

2. Select the Internet access object you created, then right-click and select Define as main.

The selected access is defined as main access and it can be seen in the Appliance object, Network

tab:
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4.2.3. Configuring the secondary/Backup Internet Access

A secondary (backup) Internet access is not used by default and must be explicitly involved in a flow

rule or VPN to be used. This feature must be configured with explicit flow rules to manage the various

Internet accesses.

To create a secondary/backup Internet access:

1. Create an Internet access (see Section 4.2.1, “Configuring the Internet Access”) and name it, for

example, Secondary access or Backup access.

2. Specify the secondary/backup access in a flow rule (object Flow rules > Create > Flow rule > tab

Action) and define the priority.

Important

The implicit flow rules use only the primary Internet access. To fully manage the backup/

secondary access, you must create flow rules to overload these implicit flows rules.

4.2.4. Rejecting Private IP Addresses

By default, the Deny private addresses option is enabled when creating a new Internet access from

Arkoon Manager. This improves the safety of traffic of IP addresses by checking the source addresses

in two ways:

• For packets with a private source IP address that should be hidden: if the Fast360 appliance has a

public IP address, this option ensures that no private address goes on the Internet and the routing of

the back flow can be made.

• For incoming packets from the Internet access, they must have an IP address from a public source

to prevent address spoofing.

Consequently, if the Fast360 appliances has no public IP address:

1. Select the Internet access object you already created (refer to Section 4.2.1, “Configuring the

Internet Access”).

2. Click on the Security tab and uncheck Deny private addresses.
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4.3. Adding Static Routes

The Static Routes folder contains all the static routes of the edited appliance. From this folder, you can

define the routes to the networks or hosts that cannot be seen directly by the appliance.

Warning

It is recommended not to set the default gateway with a static route to a network 0.0.0.0/0

but rather to define it as an Internet access (see Section 4.2.2, “Configuring the Internet Access

as Main Access”).

To add static routes:

1. Create a network representing the network you want to reach (right click on the object Networks

> Create > Network).

2. Click on the Network tab, then enter the IP address and subnet mask.

3. Then, create a host representing the gateway that provides access to the network (right click on

the object Hosts > Create > Host).

4. Click on the Network tab, then enter the host IP address and activate its IP router capacity from

the Services tab.
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5. Select the Appliances object.

6. Click on the Network tab and select Static routes.

7. Right-click on the empty part of the table and click on Create > Static route.

8. In the Destination field, drag and drop the network to reach.

9. From the Gateway field, drag and drop the gateway allowing to reach the network.

10. From the Metric field, remember to set the priority of the static route.
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4.4. Configuring DNS Servers used by the Appliance

The DNS folder contains all the DNS (Domain Name System) servers of the edited Fast360 appliance. In

this folder, you can choose the hosts that the appliance will query when sending its DNS requests. This

selection of hosts generates the creation of implicit rules allowing the Fast360 appliance to issue DNS

requests to these hosts and simplifies configuration.

To configure DNS servers:

1. Create hosts representing the DNS servers by selecting the Hosts object then right-clicking on

Create > Hôte.

2. Click on the Network tab, then enter the host IP address.

3. Click on the Services tab and enable its DNS server capacity.

4. Open the Appliance object, then click on the Network tab.

5. Click on DNS and drag and drop the hosts as DNS servers in the DNS servers zone.

Note

The system integrates a DNS cache service, which improves the performance of the

resolution that is perceptible at the HTTP, FTP and SMTP relays level.



Chapter 4. Fast360 Network Configuration

78 | Configuring NTP servers used by the appliance

The operation mode of the DNS resolution is the following:

1. Initial state (following the start of the service or appliance):

• The cache queries all the servers.

• The first server that responds is "elected" as the fastest.

• The answer is taken into account and provided to the service that queried the cache (e.g. HTTP

relay).

2. Normal operating state:

• The cache only queries the DNS server that has been elected as the fastest.

• It only takes into account the answers of this server.

3. Malfunction: If the cache does not receive a response from the "elected" server in the allotted time,

then it returns to the initial state (1) to query again all configured servers and determine again the

fastest.

4.5. Configuring NTP servers used by the appliance

The NTP folder contains all the NTP (Network Time Protocol) servers interrogated by the Fast360

appliance for time synchronization. In this folder, you can select the objects (hosts in this case) that will

be interrogated by the Fast360 appliance when performing NTP requests.

Note

Selecting hosts in the NTP folder generates implicit rules authorizing the Fast360 appliance to

broadcast NTP requests to these hosts. For more details, see Section 8.4, “Implicit Filtering

Rules”.

To configure NTP servers:

1. Create hosts representing the NTP servers by selecting the Hosts object then right-clicking on

Create > Host.

2. Click on the Network tab, then enter the host IP address.

3. Click on the Services tab and enable its NTP server capacity.
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4. Open the Appliance object, then click on the Network tab.

5. Click on NTP and drag and drop the hosts as NTP servers in the NTP servers zone.

4.6. Particular Cases

4.6.1. Defining the Level of Protection against Attacks to a DoS

To define the level of protection against attacks to a Dos:

1. Click on the Security tab of the Internet access object.

2. Check the Enable TCP SYN DoS prevention option and set the value of the maximum number of TCP-

SYN packets per second to limit the number of TCP connection requests received from the Internet

on the specified access.

3. Check the Enable ICMP SYN DoS prevention option and set the value of the maximum number of

ICMP packets per second to limit the number of ICMP packets received from the specified Internet

access.
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4.6.2. Monitoring the Internet Access by Ping

To monitor the Internet access by ping:

1. Create hosts representing the machines for which you need to ping.

2. Click on the Advanced tab of the Internet access object.

3. Check the Test connectivity option.

It is possible to generate regular pings destined for a machine on the Internet. When the appliance

does not receive response from these pings, it switches to the Internet access backup set in the

flow rules or the VPN.

4. Drag and drop hosts to respond to ping in the Test targets area .

Note

It is recommended to define at least three different hosts to avoid the verification is based only

on the remote host.

4.6.3. Activating Dynamic Routing

Fast360 appliances support dynamic routing in implementing IP routing protocols according to accepted

standards. The dynamic routing protocols detect changes in the network and react by changing their

routing tables without administrator intervention. In a network designed on the basis of a dynamic routing

protocol, each router broadcasts information about IP networks on which it is connected to its neighbors.

The choice of the best route through the networks is set according to an analysis of data defined by the

protocol.

For a detailed description of the major internet routing protocols (RIP, OSPF and BGP), refer to

Section 17.3, “Dynamic Routing”.

Dynamic routing must first be activated by the Arkoon Manager tool and configured with the minarkconf

tool:

1. Select the created Fast360 appliance and then the Network tab.

2. Select the Dynamic routing folder and open the tree.
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3. From the displayed list, select the required dynamic routing protocol (RIP, OSPF, or BGP). A new

window appears on the right. By selecting a protocol, you enable dynamic routing.

4. In the right window, check Enable dynamic routing corresponding to the protocol selected to activate

the window.

a. Select the Peering option corresponding to the protocol to enable or disable the peers filtering

(hosts, other appliances and Fast360 networks, etc) according to the needs.

b. Drag and drop the interface that will implement this dynamic routing protocol on your system in

the Interfaces field .

c. Drag and drop Fast360 appliances from which you will accept the dynamic routing that uses the

protocol in the VPN gateways field.

You must now configure dynamic routing:

5. Start minarkconf and go to the Dynamic routing menu via the following path: minarkconf >

Configuration > Dynamic routing to configure the routing. You can create a file containing all the

changes that can then be applied to the appliance in a single operation.

For the configuration of dynamic routing with minarkconf to be properly taken into account by the

Fast360 appliance, the Manager configuration must be reinstalled from Arkoon Manager, even if no

changes have occurred.

Important

Static routes must be configured in Arkoon Manager.

Important

You can also configure the dynamic routing with the following command line 6vty. If routing

changes are made outside minarkconf using the command line interface, they are automatically

detected by minarkconf suggesting to save a file.

Using the command line interface is recommended only for experienced network administrators.

If you do not have this skill, it is recommended to use the minarkconf tool.
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4.6.4. Ident protocol

The Ident protocol (Identification protocol) is used by different servers such as POP3, FTP, and by HTTP

in particular. When a client attempts to connect to the server, the server sends an Ident request to port

113 of the client machine requesting information about this client (OS, etc.). If the client does not reply,

the server will attempt to establish a connection three more times. If the timeout is exceeded, the server

replies to the initial request of the client (POP3, FTP, HTPP, etc.). The Fast360 appliance prevents sensitive

information from being transmitted from a client to a server. The Fast360 appliance submits an RST packet

to the server when it submits an Ident request. This behavior is dynamic: it only happens with the Fast360

appliance for configured protocols (indicated in the Ident table in the Security configuration form).

1. In the Network objects explorer view, double-click on the Fast360 appliance icon. The Fast360

appliance configuration form is displayed on the right.

2. Select the Security configuration form.

3. Select the Ident filtering option. The Ident filtering table is displayed on the right.

4. Right-click in the blank area of the table to enter the port(s) on which the Fast360 appliance will refuse

Ident requests.
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5.1. Hosts

The Hosts folder in the Network objects explorer view contains all the hosts created by the administrator.

This section describes how to create and configure a new host in your network.

5.1.1. Host services

A host can supply a Fast360 appliance with a number of services. These services are referred to as

capabilities. A host configured with a specific capability can then be used to configure the different

functionalities of a Fast360 appliance. Some services require the configuration of several parameters;

others simply require the service to be enabled by checking the corresponding capability. Capabilities

are configured in the Host Services configuration form of the Host configuration tab.

Host objects greatly simplify configuration of the Fast360 appliance. For example, instead of entering the

parameters for a DNS server directly into every Fast360 appliance configuration, you create a “Host”

object with “DNS” capability, with its IP address, and with any other relevant parameters; you give this

object an arbitrary name (chosen to be relevant to your network configuration). This DNS object can now

be added to the configuration of multiple appliances by a simple drag-and-drop action.

The following table lists the different types of host capabilities and indicates where they are used in the

various configuration tabs and forms of Arkoon Manager.

Table 5.1. Use of Host Capabilities in Arkoon Manager

Host capability Location of host in Arkoon Manager interface

LDAP Server Fast360 appliance/Web/HTTP/Authentication

Fast360 appliance/Web/FTP/Authentication

NT Server Fast360 appliance/Web/HTTP/Authentication

Fast360 appliance/Web/FTP/Authentication

RADIUS Server Fast360appliance/Web/HTTP/Authentication

Fast360 appliance/Web/FTP/Authentication

DNS Server Fast360 appliance/Network/DNS

Fast360 appliance/Network /DHCP Server/Pools

DHCP Server Fast360 appliance/Network/DHCP Relay/ Network

Fast360 appliance/Security/VPN

NTP Server Fast360 appliance/Network/NTP
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Host capability Location of host in Arkoon Manager interface

Fast360 appliance/Network /DHCP Server/Address

Pools

WinsServer Fast360 appliance/Network /DHCP Server/ Address

Pools

Update Server Policies/Update Policy/Update Server

Router Internet Access/General

Fast360 appliance/ Network/Static Routes

Syslog Server Policies/Log Policies/Log Policy

SNMP Server Policies/Log Policies/Log Policy

SMTP Server Fast360 appliance/Mail/SMTP/Mail routes/ Domain

Route

HTTP Proxy Fast360 appliance/Web/HTTP/Chaining

Fast360 appliance/Update

FTP Proxy Fast360 appliance/Web/FTP/Chaining

SpamAssassin Server Fast360 appliance/Mail/Antispam

Policies/ Antispam Policies/External Server

Antispam Policy/General

PPTP Modem Interface/External ADSL device/Interface

5.1.2. Creating a host

1. In the explorer view, right-click on the Hosts folder.

2. From the displayed list, select New > Host. A Host configuration tab is displayed on the right.

3. In the Properties configuration form, enter the name of the host and a short description in the

corresponding fields.

4. In the Network configuration form, indicate how the host is identified on the IP network:

IP adressing

To define the host addressing by a fixed IP address, enter the IP address in the IP address field.

• If you need this IP address to be assigned dynamically by a DHCP server, check the IP address is

assigned by DHCP option and enter the MAC address in the corresponding field.

• If you require Network Address Translation (NAT), check the Static NAT option.

a. Enter the host's public IP address in the Translated IP field.

b. Drag and drop the translating Fast360 appliance into the Translating appliance field.

For detailed information on NAT and other IP masquerading methods implemented by the Fast360

appliance, see Section 9.1, “Network Address Translation (NAT) and Port Address Translation

(PAT)”.
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Hostname

To define the host by its Fully Qualified Domain Name, enter the host name in the corresponding field.

Note

This feature is useful in the following two cases only:

• Definition of an update server

• Definition of a secure LDAP authentication server

Dynamic IP addressing

To use the host with a VPN tunnel and if the host IP is unknown or dynamic. A host object of nomad

type will only be selected into VPN tunnels groups, network VPN gateways and shared keys.

5. The VPN form is used to configure VPN tunnels, described in details in Chapter 12, Configuring IPsec

VPN Tunnels.

6. The Services form is used to configure the host with a specific capability. In this form, you select the

required capability and configure the corresponding parameters, if required. For example, to configure

a host as a DNS server, check DNS Server in the Services configuration form. The preconfigured host

object can then be included in the configuration of Fast360 appliances by a drag and drop action.

5.2. Networks

The Networks folder in the Network objects explorer view contains all the networks created by the

administrator. This section describes how to create and configure a new network.

5.2.1. Creating a network

1. In the explorer view, right-click on the Networks folder.

2. From the displayed list, select New > Network. A Network configuration tab is displayed on the right.

3. In the Properties configuration form, enter the name and a short description in the corresponding

fields.

4. Select the Network configuration form:

a. In the IP address field, enter the IP address of the network.

b. In the Netmask field, enter the subnet mask.

c. If you require Network-to-Network Translation:

i. Check the Enable static NAT option to activate this option.

ii. Drag and drop the Fast360 appliance handling the translation into the Translating appliance

field.

iii. Enter the translation address for the network in the Translated address field.

Note

The network IP address and the translation IP address share the same netmask.

d. Drag and drop a zone object into the Zone field.
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5. In the VPN form, drag and drop the VPN server which will encrypt and decrypt the flows for this

network into the VPN Gateway field.

5.3. Network object groups

Arkoon Manager allows you to group hosts, networks, or both, in order to obtain more readability in the

configuration, and particularly filtering rules. This folder contains all the host/network groups created by

the administrator. This section describes how to create a new group and how to group network objects

within it.

5.3.1. Creating a new group

1. In the Network objects explorer view, right-click on the Network objects groups icon and select New

> Network Object Group.

2. Expand the folder to view the new Network Object Group in the explorer view.

3. Drag and drop the objects (host or network) from their respective descriptive view into the Network

Object Group folder in the explorer view. To view all the grouped objects in the descriptive view, click

on the Network Object Group.

4. To identify the group of network objects, right-click on the Network Object Group folder in the explorer

view and select Edit. The Network Object Group configuration tab is displayed on the right.

a. Enter a name for the group of network objects in the Name field.

b. Enter a short description in the Description field.

5.4. Zones

Zone objects are used to show which part of the network a host, IP network or a Fast360 appliance

interface is connected to. Zone objects make it possible to visualize the complete network topology

to which the security policy is being applied. The zone parameter in a host, IP network or Fast360

appliance interface is optional. However, if this parameter is not completed, you will only have a partial

representation of the network's topology. All objects that belong to a zone have the same trust, or security,

level. Therefore, a flow going from one zone to another will be filtered by the Fast360 appliance.

The Zones folder in the Network objects explorer view contains all the zones created by the

administrator.

1. In the Network objects explorer view, right-click the Zones icon and select New > Zone. The Zone

configuration tab is displayed on the right.

2. Select the Properties configuration form:

a. Enter a name for the zone object in the Name field.

b. Enter a short description in the Description field.

The zone object name and description appear in the descriptive view.

3. Drag and drop the zone object from the descriptive view into the relevant host, IP network and Fast360

appliance interfaces.
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Important

To display the content of a zone, press F3 or right-click the zone and select Find references.

4. To view the network topology, highlight the zone object in the descriptive view and select Tools > Zones

view from the “Configure” Mode Menu. The Zone pop-up window displays the network topology and

where the zones feature in it.

5.5. IP addresses format

The possible IP addresses for the parameters below are:

• Networks: 0.0.0.0 up to 255.255.255.255.

• Hosts: 1.1.1.1 up to 255.255.255.255.

• Appliance interfaces: 0.0.0.1 up to 255.255.255.255.

• The relay servers for SMTP are considered as hosts (see above).

• The transmitting or recipient addresses for anti-spam rules can be hosts, networks or appliances (see

above).

• The transmitting or recipient addresses for SMTP relay applicative rules can be hosts, networks or

appliances (see above).
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Chapter 6. SmartSSL service configuration

Arkoon SmartSSL is a software client able to connect to a presentation server via the SSL protocol.

This server, hosted by the Cloud Datacenter Arkoon, then mounts a VPN IPSEC tunnel with the company

network where the accessed servers and applications are.

6.1. SmartSSL service configuration

The SmartSSL configuration form contains information to configure the authentication and access rights

of SmartSSL feature.

Important

Ensure with Arkoon you have the SmartSSL option.

1. Open the Appliance object, select the Smart tab and activate the SmartSSL option.

2. Enter the DNS SmartSSL name provided by Arkoon production service.

This name must be: identifier.smartssl.arkoon.net

3. The authentication base contains the identifiers/passwords of users using the service. You have two

types of authentication:

• For a local authentication, you must create users (with login and password), then users groups in

the Authentication part of Arkoon Manager.

• For a remote authentication, you must define a host with the NT server capacity (for example, an

Active directory server).

Note

The groups of users can be imported and then associated to applications (Web, remote

access) in the SmartSSL configuration portal which URL and identifier/password will be

provided when activating the service. In case of non import of these groups, all authentified

users of your authentication database will access the service(s) they need.

4. In Servers reachable via SmartSSL, create one or several access rules to allow the access to internal

servers.

• In Name: enter the access rule name.

• In Server: drag a single host.

• In Service: drag a unique service (http-factory for example).

Note

In an access rule, a server is associated to a unique server and vice versa.
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5. Log on the Web SmartSSL administration portal to end the publishing of your applications.

See SmartSSL Management Console administration guide to get more details on SmartSSL.
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Chapter 7. Configuring DHCP Server and Relay

DHCP (Dynamic Host Configuration Protocol) is a network protocol used to dynamically assign IP

addresses to clients on a LAN. The DHCP server hosts a list of predefined or dynamic IP addresses

configured by the administrator. This server then allocates these addresses to the machines connecting

to the LAN.

7.1. Configuring DHCP Server

To configure the DHCP server:

1. Open the Appliance object, then select the Network tab and activate the DHCP server.

2. Select the Listening interfaces folder, then drag and drop the interfaces that receive and respond

to DHCP requests.

3. In the interfaces defined as listening interfaces, make sure you disable the blocking of IP broadcast

by unchecking the Ignore IP broadcast traffic option in the Advanced tab.
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4. Create a DHCP pool by selecting DHCP pool then click on New > DHCP pool.

5. Drag and drop the network that includes the subnet including the IP addresses to distribute.

6. In the Addressable IP address ranges zone, right-click and select New > Addressable range then

enter the address range for distribution in the network.

7. In the Options zone, drop the gateway (usually the appliance to be assigned to DHCP clients) in

Default gateway .

8. Then specify the DNS servers to be assigned to DHCP clients (usually the same as those of the

appliance).
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7.2. Configuring DHCP Relay

A DHCP relay is a proxy that relays DHCP messages between DHCP clients and DHCP servers in different

IP networks. The DHCP relay listens for DHCP and BOOTP queries and responses. When a query is

received from a client, it is forwarded to the specified DHCP server(s). When a reply is received from a

server, it is forwarded to the client who made the initial request. DHCP servers and DHCP proxies cannot

run at the same time.

1. Open the Appliance object, select the Network tab and activate the DHCP Relay.

2. Select the level of logging for the DHCP relay from the options in the Log level drop-down list:

• Select Normal to log DHCP messages (DHCPDISCOVER, DHCPOFFER...) in system files /var/log/

messages and /var/log/debug. To view the system logs, you must login and enter the following

command: tail –f /var/log/messages.

• Select Full to log all requests and leases in the alerts log in Arkoon Monitoring.

3. Expand the DHCP Relay tree.

4. Select the Network folder.

a. Drag and drop the host objects that will serve as DHCP servers into the DHCP servers field; DHCP

requests will be sent to these addresses. Note, you should have already defined the hosts with the

DHCP server capability. For more detailed information on configuring hosts with capabilities, see

Section 5.1.1, “Host services”.

b. Drag and drop the interfaces to which clients are connected into the Listening interfaces field;

DHCP requests will be expected in these interfaces.

c. Drag and drop the hosts or network objects configured with the addresses from which DHCP

packets are accepted into the Allow queries from field.

Note

Packets sent with IP address 0.0.0.0/32 will always be accepted.

5. Select the Advanced folder.

6. Specify whether a reply that could not be matched to a known request is to be forwarded regardless

by checking the option Drop replies when Agent Id does not match.



Chapter 7. Configuring DHCP Server and Relay

94 | Chaining the DHCP Proxy

Chaining the DHCP Proxy

In network configurations where there are multiple DHCP proxy agents between DHCP clients and

servers, it can be useful to chain the proxies. Each of the proxy agents adds its own information, its Agent

Information Option to each DHCP request before forwarding it to the server.

1. Configure the DHCP proxy as described in the previous section.

2. Select the Advanced folder.

3. Select the way the proxy handles the “Agent Information Option” from the following options:

• Select Append relay agent-id to add the proxy's own Agent Information Option to the option list.

Select this option for standard proxy chaining.

• Select replace to replace all Agent Information Option with the proxy's own. Select this option if

you want to hide all previous DHCP proxies in a proxy chaining context.

• Select forward to forward incoming packets containing an Agent Information Option; the packets

will be forwarded unchanged. Select this option for transparent DHCP proxy chaining.

• Select discard to block incoming packets containing an Agent Information Option. Select this option

to forbid DHCP proxy chaining.

Note

The Agent Information Option must not be changed in DHCP over IPsec configurations.

4. Define the maximum size of the DHCP data when the proxy appends its own Agent Information Option

to the option list in the Maximum packet size field. The minimum value is 576 bytes of DHCP data;

the maximum is 1472. Note, if the DHCP message size is set in the incoming packet, it is ignored and

unchanged by the proxy, and it is not added.

Note

If an incoming packet already exceeds the value set in Maximum packet size, it will be

forwarded regardless (i.e. without the proxy's Agent Information Option).

7.3. Configuring an IP Address determined by the MAC

Address

To facilitate the administration of the network, you can define mappings between IP addresses and MAC

addresses. The MAC address always receives the IP address set while the remaining MAC addresses

never receive that IP address. This configuration allows the filtering of specific flows for a machine by

its IP address

1. Create hosts representing the IP addresses assigned by selecting the Hosts object and right-click

on Create > Host.
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2. Click on the Network tab and enter the host IP address and the MAC IP address.

Important

IP addresses must belong to an address range defined in a DHCP pool and should not have

been excluded from the range.
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Chapter 8. Basic Traffic Filtering Using Filtering

Rules

 This chapter looks at how to configure the Fast360 appliance to filter network traffic according to

defined filtering rules, how to create your own filtering rules, as well as how to manage ICMP traffic.

8.1. Filtering Rules Principles

The Fast360 appliance acts as a stateful inspection firewall, examining connections for each packet in

order to block abnormal behaviors. Incoming packets are checked against a state table and IP filtering

rules information in order to determine whether they are valid, as part of an existing, or a new connection.

The packet is then processed according to security policy defined by the filtering rule. The filtering rule

contains both the set of filtering attributes and the set of actions.

By default, the Fast360 appliance blocks all connections non explicitly authorized by a filtering rule. You

must thus create new filtering rules to precise network flows to be accepted.

8.2. Filtering Rules Types and Rule Reading Order

There are four main types of filtering rules. The analysis engine reads them in the following order:

1. Default implicit rules: they are automatically defined in the Fast360 appliance according to the

activated functionalities. They are used for antispoofing/admin from.

2. Explicit rules created in Arkoon Manager: you can create and configure specific filtering rules

according to your needs.

3. Various implicit rules: they are automatically created when you activate certain functionalities (relays,

DNS servers, VPN, update, etc.).This type of rule can be bypassed by explicit rules having the same

criteria which will be read before the implicit rules.

4. The implicit rule that blocks everything by default: this rule comes after all other filtering rules and

cannot be removed.

For the full list of implicit rules and their parameters, see Appendix E, Implicit Filtering Rules.

The first rule that matches the packet of a new connection is applied and the Fast360 appliance stops

reading the rules. Rules are read sequentially in the above-mentioned order. This is essential for correctly

applying the configured security policy.

Since antispoofing implicit rules are blocking rules, they are read first. Administration rules come before

those configured in Arkoon Manager. It is therefore impossible for an explicit filtering rule to invalidate

them, whether intentionally or not.

Since the implicit filtering rules created by the activation of functions in Arkoon Manager are read

after the explicit rules, you can customize them, if needed. To do so, define a rule in  Arkoon Manager
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containing the same filtering attributes as one of the implicit filtering rules and define the actions to be

applied on the flows (logging, FAST module options, etc.).

The last blocking rule enables the normal operation of a firewall: anything that is not explicitly authorized

is blocked.

As the last implicit rule blocks everything, the Fast360 appliance rejects any packet that is not explicitly

authorized. Explicit rules are read, from top to bottom, in the order displayed in the Arkoon Manager

window. Strictest rules must appear before more general rules.

Note

When creating a new configuration, a filtering rule blocking all flows from any source to any

destination appears in the Filtering rules folder. This rule reminds you that the default

behavior of the Fast360 appliance consists in blocking everything. This rule is not essential:

if removed, the default implicit rule appearing in the last position will block all non previously

authorized flows.

Example 8.1. Filtering Rules Order

In a standard topology, a station is dedicated to guests on the LAN. The guest station must have very

restricted rights. It must not be authorized to send emails via the mail server. Among other rules, the

following ones are installed:

Number Sources Destinations Services Action

1 LAN Mail server ping, SMTP,

POP3

Accept

2 Guest station DMZ SMTP, POP3 Block

Rules read in the above order enable the guest station to send SMTP and POP3 flows to the mail server.

To obtain the desired behavior and only authorize the ping from the guest station to the mail server, rule

2 must be moved to first position.

8.3. Creating a New Filtering Rule

The Rules folder is used to define the IP filtering rules which are essential elements to configure the

appliance. Filtering rules include different criteria: sources, destinations, users, schedules and validity

period, translations, encryption, Internet connection used, installation on the Fast360 appliance(s) and

advanced settings.

This section describes how to:

• define a new IP filtering rule;

• activate or deactivate a filtering rule;

• modify the priority order of the filtering rules;

• insert a new IP filtering rule;

• estimate the relevance of a filtering rule.
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Note

If you add your own rules for VoIP protocols, be aware that they are bi-directional. You must

configure filtering rules for each direction.

1. In the default layout, select the Rules navigation tab from the left hand side of the main window.

2. In the explorer view, create a new filtering rule by right-clicking on the Rules folder, select New >

Rule. The Rule configuration tab is displayed on the right.

8.3.1. Configuring Basic Settings

1. Select the Properties configuration form:

a. Enter the name of the filtering rule in the Name field.

b. Enter a comment in the Description field.

2. Select the General configuration form:

a. To temporarily deactivate the filtering rule (for example, when testing), unselect the Enable this

rule option.

Note

The filtering rule is activated by default.

b. In the Log drop-down list, select the level of detail of logs from the three options:

• Select Nothing if you do not want the Fast360 appliance to generate logs. This is the default

logging setting.

• Select Standard if you want the Fast360 appliance to generate logs only concerning IP packets

headers. These logs can subsequently be viewed in Arkoon Monitoring .

• Select Full if you want the Fast360 appliance to generate logs concerning both the header and

the packet payload. These logs can subsequently be viewed in Arkoon Monitoring .

8.3.2. Configuring Filtering Rules Criteria

Select the Criteria configuration form:

1. Drag and drop the source and destination objects into the Sources and Destinations fields.

The source or destination objects selected in the Rule configuration form can be firewalls, hosts,

networks, zones or interfaces.

Important

When selecting Arkoon objects, the Fast360 appliance must be explicitly selected for a

filtering rule to accept it as source or destination. For example, configuring a network of which

the Fast360 appliance belongs to as source or destination of a rule, is equivalent to selecting

all the network except the Fast360 appliance. This allows to limit the maximum number of

filtering rules opening access to the Fast360 appliance. Also, empty fields are equivalent to

All addresses, meaning all IP addresses except the Fast360 appliance.

Important

A zone can contain hosts, networks or interfaces. To display the content of a zone, press F3

or right-click the zone and select Find references.
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2. Drag and drop the services objects into the Services field. Protocol analysis is automatically

performed at levels 3 and 4. It will be carried out at the applicative level only if you select a service

implicating a FAST module.

8.3.3. Configuring Authentication in Filtering Rules

Select the Authentication configuration form. By default, authentication is disabled.

1. If you wish to use authentication in the rule, drag and drop local or remote users or users groups in

the Users/Users groups field (users have already been defined in the Authentication navigation tab).

Note

In the case of a transparent authentication or an authentication using Arkoon Authentication

Agent based on an Active Directory server, we recommend using users groups rather than

just users. This avoids importing or deleting users from the configuration and from the rules

each time the Active Directory is modified.

2. Choose the type of authentication:

• Transparent authentication (without agent): completely transparent authentication which

authenticates the user identified on the Windows client workstation which generates the flow.

• Authentication using IPSec ID: authentication using a user ID (certificate DN) or a user X-Auth

identifier for a flow coming from an IPSec VPN tunnel.

• Authentication using Arkoon Authentication Agent: authentication using parameters provided by

the Arkoon Authentication Agent installed on the client workstation which generates the flow.

For more information about the different types of authentication, refer to Chapter 14, Users

Authentication.

Rules with authentication are displayed with an icon next to their name in the rules list.

Note

If authentication is enabled in a rule but no users or groups of users is selected, or the

authentication type is not selected, a coherency error appears.

8.3.4. Configuring Time Management in Filtering Rules

Select the Time configuration form:

1. Drag and drop schedules during which the filtering rule is enabled in the Schedules field. Schedules

have already been defined in the Time management navigation tab.

Note

The schedule is checked based on the time of the Fast360 appliance. The schedule defined

in the rule is checked for each packet for which the rule applies or for each part of the

connection checked by this rule.

2. Drag and drop periods during which the rule is valid in the Validity period field. Validity periods have

already been defined in the Time management navigation tab. A validity period allows defining the

lifetime of a filtering rule.

In the Period configuration tab of the Time management navigation tab, you can define:
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• either a start date for the validity period.

• either an end date for the validity period.

• or a valid period range between a start date and an end date. You can also define a duration in days.

3. Select the behavior of the rule out of the validity period:

• Use the rule and raise an alert: the rule is used out of the validity period. This option allows avoiding

problems in case of sudden disconnection. Refer to the alerts in Arkoon Monitoring and delete the

rule if necessary.

• Ignore the rule and raise an alert: the rule is not used out of the validity period and the appliance

looks for another rule to apply on the flow.

If a rule is used out of the validity period, a high level alert (the rule has expired) or a low level alert

(the rule is not valid yet) displays in Arkoon Monitoring.

To check the validity period, the current time (local time) of the system on which Arkoon Manager runs is

taken into account. Make sure the time and date of the operating system are correct. Fast360 appliances

also need to know the local current date to check the validity of the rules and thus need to be properly

configured. We recommend you to configure an NTP server for the appliance to be sure the time is always

correct. If no NTP server is defined, a coherency information displays in the coherency check panel.

In the Rules descriptive view, the Period column displays the validity period. It displays start and end

dates and displays invalid dates in red. It allows quickly noticing invalid rules. It is possible to sort rules

by periods and thus gather rules not valid yet, valid rules or expired rules. Coherency checks display in

the coherency check panel.

8.3.5. Configuring Actions of Filtering Rules

1. Select the Action configuration form.

2. Select the type of action to be performed on the IP packets transmitted by the defined IP flow from

the three options:

• Check the Block option to make the Fast360 appliance block the IP flow.

• Check the Reject option to make the Fast360 appliance block the flow and send a packet to the

submitter to advise that the flow has been rejected (by default, this is a “destination unreachable

– communication administratively prohibited” ICMP packet).

• Check the Accept option to make the Fast360 appliance accept the IP flow.

Note

In the default configuration, the Block option is checked.

Configuring a Translation Rule

1. If you have chosen for the Fast360 appliance to accept the flow, create a translation rule by right-

clicking in the Rule translations blank table and select New > Translation Element. To configure the

translation element, right-click on a table entry and select Edit in the drop-down menu. A pop-up

window appears.

a. Drag and drop the Fast360 appliance to move the translation into the Translating appliance field.

b. Check the Source translation option to activate translation on the source IP address and choose

the type of translation:
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• Select Masquerading to enable the Fast360 appliance to replace the source IP address with the

address of the output interface used for this flow.

• Select IP address and then specify in the corresponding field which address the Fast360

appliance is to replace the source IP address of the packet with.

Note

The IP address may not be configured on the Fast360 appliance. In this case, it acts as

an ARP proxy to “retrieve” packets intended for this address. This address must not be

used by any other equipment.

c. Check the Destination translation option to activate translation on the destination IP address and

choose the type of translation:

• Check IP address translation for the selected appliance to implement port translation on the

selected port and IP address for the connections described by the filtering rule.

Note

The IP address may not be configured on the Fast360 appliance. In this case, it acts as

an ARP proxy to “retrieve” packets intended for this address. This address must not be

used by any other equipment.

• Check Interface translation and drag and drop an interface into the Interface field. This

translation type is similar to the port IP translation option except that it allows you to select an

interface rather than typing its IP address. For more information, refer to the section called “PAT

Configuration on an Interface”.

Note

Masquerading or port translations can only be applied on unidirectional filtering rules.

Caution

The port translation must specify only one service (UDP or TCP specifying one single port)

in the Services field. On the contrary, several hosts can be specified in the Destinations

field. The Load Balancing mechanism is then applied. For more information, refer to the

section called “PAT Configuration on Several IP Addresses”.

Configuring Internet Connection Rules

By default, the Fast360 appliance uses the Internet connection defined in the Internet Access

configuration folder. If you have multiple Internet connections available, this dialog box allows you to

configure service balancing or load balancing on the outgoing flows.

• Service balancing: the flow goes through an Internet access other than the main one; the access

defined with priority 1 has the most important priority.

• Load balancing: flows are alternatively sent on two Internet connections; both connections are defined

with priority 1.

1. Check the Accept option.

2. Check the Internet Access option.

3. Create a new Internet connection rule by right-clicking in the blank table and select New > Internet

Access with priority. To configure the Internet connection rule, right-click on the entry and select Edit

in the drop-down menu. A pop-up window appears.

4. Drag and drop an Internet access object for which you want to assign a priority number into the

Internet Access field.
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5. Define the selected object's priority number in the Priority field.

Configuring Encrypted Segments

The Encrypted segments table is used to associate the filtering rule with an already configured tunnels

group. By default, a Fast360 appliance tries to encrypt a given connection if VPN tunnels are available.

For more information, refer to Section 12.6, “Filtering Rules for VPN Tunnels”

1. If you have chosen for the Fast360 appliance to accept the flow, create an encryption rule by right-

clicking in the Encrypted segments blank table and select New > Encrypted Segment. To configure

the encrypted segment element, right-click on a table entry and select Edit in the drop-down menu.

A pop-up window appears.

2. Define the location of the encrypted segment:

• If the encrypted segment is located between the source and the Fast360 appliance, drag and drop

a source object into the Source field and the Fast360 appliance into the Destination field.

• If the encrypted segment is located between the Fast360 appliance and the destination, drag and

drop the Fast360 appliance into the Source field and a destination object into the Destination field.

Note

You must select at least one Fast360 appliance insofar as it is located at one of the

extremities of the encrypted segment.

Note

For a multi-appliances configuration, you can select a Fast360 object in both the Source

and Destination fields.

• It is also possible to select a folder of appliances or a group only containing appliances as a source

or destination of an encrypted segment . This eases the configuration of the inter-LAN flow rules

via VPNs.

Warning

It is possible to select a folder of appliances or a group as a source AND destination of the

same encrypted segment.

3. Select the encryption mode from Not encrypted, Encrypted through any defined tunnel, or Encrypted

through specified tunnels. VPN encryption is the most common choice of encryption mode.

• Not encrypted: explicitly requires that connections matching the filtering rule are not encrypted on

a given segment.

• Encrypted through any defined tunnel: encrypts connections matching the filtering rule on a given

segment, whatever the VPN tunnel used.

• Encrypted through specified tunnels: encrypts connections matching the filtering rule on a given

segment, using the specified VPN tunnel.

Configuring Advanced Settings

1. Check the Masquerade TCP sequence numbers option to enable the Fast360 appliance to generate

random sequence numbers for servers that do not have this facility.

2. Check the Maximum number of connections option and set the value in the corresponding field of the

maximum number of connections authorized on the same flow. This option is very useful to protect
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a specific server against certain attacks (such as Denial of Service attacks). You must then refer

to the server's characteristics to know how many connections it can support. When the number of

authorized connections has been reached, subsequent connection attempts are blocked and logged

by the Fast360 appliance.

3. Check the Maximum number of waiting connections option and set the value of the maximum number

of TCP pending connections to protect against SYN flood and similar attacks.

An established connection can be characterized as follows:

A: SYN to B

B: SYN ACK to A

A: ACK to B

If one (or both) of the last conditions described above are not fulfilled, the connection is pending.

Note

The value set here depends on the operating system of the servers you are trying to protect.

4. Check the Custom MSS option and set the value in the corresponding field of the maximum segment

size a machine can receive in one TCP-SYN packet. By reducing this default value (1500), it is possible

to skip MTU problems which occur when the ICMP Fragmentation Needed packets are blocked by

certain routers/firewalls.

8.3.6. Configuring Deployment of Filtering Rules

The Deployment configuration form is only used in the case of multi-appliances configurations.

By default, the Fast360 appliance determines whether it is affected by the rule or not and automatically

deploys the filtering rules in a multi-appliances configuration. However, you can force it as described

below.

1. Unselect the Automatic installation option.

2. Choose to either include or exclude Fast360 appliances from having the filtering rules installed on

them:

• To install the filtering rules, check Include these appliances and drag and drop the Fast360

appliances into the corresponding Included appliances field. The installation is displayed on the

appliances of the list, and the other appliances do not install the rule.

• To prevent the filtering rules from being installed, check Automatic installation and exclusion of the

following appliances and drag and drop the Fast360 appliances into the corresponding Excluded

appliances field. If needed, an arkoon_config key allows switching to the former mode.

8.3.7. Activating or Deactivating Filtering Rules

By default, a newly created IP filtering rule is enabled. However, when testing, temporarily deactivating

a filtering rule can be useful.

• To deactivate a filtering rule, unselect the Enabled check box for the desired filtering rule in the

descriptive view. The rule entry is greyed out. To activate the rule, check the Enabled option.
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• Alternatively, check the Enable this rule option in the General configuration form to activate the

filtering rule, and uncheck to disable the rule. Your selection is reflected in the descriptive view by a

ticked or empty Enabled check box.

8.3.8. Modifying the Priority Order of the IP Filtering Rules

In the Rules descriptive view, the order of priority is displayed from top to bottom. The first filtering rule in

the descriptive view is taken into account first, followed by the second rule in the list and so on. However,

you can modify the priority order of previously defined filtering rules.

1. In the Rules descriptive view, right-click on the filtering rule for which you want to change the priority

order.

2. From the displayed pop-up menu, select either Move > Up or Move > Down to assign to the filtering

rule a higher or lower priority number than its current one. This modification is immediately displayed

in the descriptive view.

Caution

The reading order of the filtering rules, that is to say the way the Fast360 appliance interprets

them, is a basic criterium regarding their use.

8.3.9. Inserting a New Filtering Rule

It is possible to define a new filtering rule in the descriptive view and assign it directly at the correct

position in the list, provided that there is at least one existing entry in the table.

1. In the Rules descriptive view, right-click on a filtering rule immediately preceding or following the rule

to be inserted.

2. From the displayed pop-up menu, select either New before > Rule or New after > Rule to insert the

new filtering rule before or after the selected entry.

3. To configure the rule, follow the procedure outlined in Section 8.3, “Creating a New Filtering Rule”.

8.3.10. Estimating the Relevance of a Filtering Rule

The Hit Count column in the Rules descriptive view indicates the number of times a filtering rule has

been used to filter the traffic (number of times a rule has matched a network flow). This data allows the

administrator to know whether the rules in the configuration are effective and defined in the relevant

order. For example, a rule which matches too many network flows is a rule with too many sources and/

or destinations defined.

The Hit Count column displays a vertical gauge with a number:

• The gauge shows the percentage of matches of one rule compared to the addition of all matches of

all rules defined with Arkoon Manager (implicit rules are not taken into account):

• empty gauge: 0%

• one cylinder: more than 0% and up to 2%

• two cylinders: more than 2% and up to 10%

• three cylinders: more than 10% and up to 40%
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• four cylinders: more than 40% and up to 100%

• four cylinders with a star: 100% of matches. The rule matches all network flows and the other rules

have 0% match.

• The number represents the “raw” number of matches of a rule, without unit. The number can be as

follows:

• from 0 to 999: simple number (example : 548)

• from 1000 to 999999: xxxK number format (example : 151K means 151000)

• from 1000000 to 999999999: xxxM number format (example : 25M means 25000000)

• from 1000000000 to 999999999999: xxxG number format (example: 874G means 874000000000)

• from 1000000000000 to 999999999999999: xxxT number format (example: 12T means 1200000000000)

The Hit Count column displays this information only if you are working on the current configuration of the

appliance. If you open a local configuration (in connected mode or not) or a distant configuration which

is not the current configuration, the hit count is not activated.

It is possible to reset the hit count on one or more appliances simultaneously with the menu Reset Flow

Rules Hit Count in the Advanced administration menu in Arkoon Manager. For more information, refer

to the section called “Resetting flow rules hit count”.

Note

It is the name of the rule which enables the appliance rules to match the rules defined in Arkoon

Manager. So if a rule is renamed, it is necessary to deploy the configuration again in order to

reset the hit count for this rule.

It is also possible to consult these data in Arkoon Monitoring. In the tab Diagnosis of the menu

Maintenance/Diagnosis, the diagnosis Affichage des statistiques des règles de flux displays the rules

which have been used and the number of matches (including implicit rules). The command used to get

these statistics is cat /proc/arkoon/akpf_stats. It is also possible to use this command when you

are connected to the appliance in SSH or through the serial port. The result looks like:

root@appliance:/root> cat /proc/arkoon/akpf_stats

Admin-From : 1

ping-server : 10

ssh-server : 3

8.4. Implicit Filtering Rules

Implicit filtering rules are rules automatically installed on the Fast360 appliance. In this section, they are

detailed according to the reading order of the analysis engine.
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8.4.1. Default Implicit Filtering Rules

Antispoofing Implicit Rules

IP address spoofing is a method used in many attacks. It consists in falsifying a packet having a different

source IP address to the issuing machine's. The source IP address chosen generally belongs to the

attacked network.

It is not possible to verify that a packet coming from the Internet originates from the IP address it claims

to have. However, the Fast360 appliance can carry out the two following types of checks:

• Antispoofing over the transmitted packets: given that an interface of the Fast360 appliance belongs

to a network x.x.x.x with the mask y.y.y.y, all packets with a source address belonging to the network

x.x.x.x with the mask y.y.y.y will be blocked if they come from a Fast360 appliance interface other than

the one belonging to the x.x.x.x network.

• Antispoofing over the packets intended for the Fast360 appliance: given an ethx interface, all packets

arriving by the ethx interface will be blocked if their destination is a Fast360 interface other than the

ethx interface. However, two exceptions apply:

• If the destination IP is used to carry out a PAT translation via IP (rather than via interface), then

antispoofing rules will accept the packet.

• If the destination IP is reached by a packet arriving from a VPN, then antispoofing rules will accept

the packet.

Within the framework of a standard topology, the few examples below illustrate the behavior of the

antispoofing rules:

Source IP

address

Input interface Destination IP

address

Action of antispoofing rules

10.0.0.1 eth2 194.2.0.20 blocked

10.0.0.1 eth3 194.2.0.20 not blocked

10.0.0.1 eth3 192.168.1.254 blocked

10.0.0.1 eth3 10.0.0.254 not blocked

Note

By default, antispoofing is activated. Antispoofing rules are automatically generated as soon as

the interfaces are configured (implicit rules); they are read first (before the filtering rules defined

in Arkoon Manager).

When antispoofing protection is enabled, it is possible to select which logs can be viewed in  Arkoon

Monitoring .

1. In the Network objects explorer view, double-click on the Fast360 appliance icon. The Appliance

configuration tab is displayed on the right.

2. Select the Security configuration form.

3. Select the Antispoofing option. Two options are displayed on the right.

• Enable the Log received traffic option to generate logs (and thus alerts and SNMP traps) that only

concern IP packets with the Fast360 appliance as their unique destination.
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• Enable the Log forwarded traffic option to generate logs (and thus alerts and SNMP traps) that only

concern IP packets with everything except the Fast360 appliance as their destination.

Note

When the antispoofing protection is enabled, you can choose either the first or second option

for creating logs, both or neither of them. By default, packets blocked by the antispoofing option

are logged.

For the full list of antispoofing rules and their parameters, see Section E.1, “Default Antispoofing Rules”.

Administration Implicit Rules

Administration implicit rules authorize the connections:

• intended for the Fast360 appliance for the administration tools:

• minarkconf

• Arkoon Manager

• Arkoon Monitoring

• between various Fast360 appliances for a multi-Fast360 solution.

For the full list of administration rules and their parameters, see Section E.2, “Default Administration

Rules”.

8.4.2. Various Implicit Filtering Rules

• Rules for DNS: when the administrator selects hosts from the DNS folder, he implicitly defines a rule

authorizing the Fast360 appliance to connect to the specified hosts with the DNS services (UDP 53

and TCP 53).

• Rules for NTP servers: when the administrator selects hosts from the NTP folder, he implicitly defines

a rule authorizing the Fast360 appliance to connect to the specified hosts with the NTP services (UDP

123).

• Rules for update:

• when the administrator configures the update, he implicitly defines a rule authorizing the Fast360

appliance to connect to the Internet with the akupdate service.

• if the Fast360 appliance is defined as proxy for updating other Fast360 appliances, an implicit rule

will be created to authorize these Fast360 appliances to connect to the main Fast360 appliance with

the akupdate service.

• Rules for HTTP/FTP proxy: when the administrator configures the HTTP/FTP proxy, he defines the

following implicit rules: from the Fast360 appliance to the Internet on ports FTP, HTTP, HTTPS and

Gopher specified in the General tab; from the hosts or selected networks (in Authorized networks) to

the Fast360 appliance on the port specified in the General tab.

• Rules for SMTP relay: when the administrator configures the SMTP relay, he defines the two following

implicit rules: from the Fast360 appliance to the Internet with the SMTP service; from the Internet to

the Fast360 appliance with the SMTP service.

• Rules for POP3: when the administrator activates the POP3 relay, he implicitly defines a rule authorizing

the Fast360 appliance to connect to the Internet with the POP3 service.

• Rules for VPNs:
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• when the administrator configures the authorized VPN servers of the VPN module, he defines the

following implicit rules: from the Fast360 appliance to the authorized VPN servers with the ESP

and ISAKMP servers; from the authorized VPN servers to the Fast360 appliance with the ESP and

ISAKMP services.

• if NAT-Traversal is activated, the UDP 4500 service will also be authorized in both rules.

• Rules for authentication servers: when the administrator selects authentication servers from the

Authentication folder, he implicitly defines a rule authorizing the Fast360 appliance to connect to the

LDAP, Radius, Kerberos or AD NTLM server defined as main PDC.

• Rules for authentication for filtering rules:

• a rule is automatically created to authorize the Fast360 appliance to send authentication requests

to the authentication agents with the UDP 9271 service.

• when the Fast360 appliance sends an authentication request to an agent, he dynamically adds an

implicit rule permitting the agent to send a TCP flow on the 1755 port; this rule disappears when the

timeout expires.

• Rules for High Availability: when the administrator configures a Fast360 appliance with HA

or HP clustering, he implicitly defines rules authorizing the flows UDP 1760 (connection state

synchronization), IP protocol 112 (VRRP), TCP 1756 and TCP 1759 (configuration management), UDP

123 (NTP).

8.5. ICMP Traffic Management

There are two types of ICMP messages:

• Information messages (echo request, echo reply, etc.), which are processed in the same way as

services, usable in the filtering rule;

• Error messages (destination unreachable, redirect, etc.), which are managed with the ICMP policy

defined on the Fast360 appliance.

Note

By default, ICMP information messages are not authorized. You must configure appropriate

filtering rules if you wish to authorize ICMP messages. ICMP error messages are handled

according to the options configured in the ICMP policy object.

8.5.1.  Information Message Management

Information message management is done through filtering rules. By default, no ICMP information

message is accepted. To authorize ICMP flows, you must create filtering rules corresponding to the

specific ICMP packets.

Information messages come in pairs: each question has an answer. Thus, the echo request, router

solicitation, timestamp request and  information request messages correspond to the echo

reply, router advertisement,  timestamp reply and information reply messages respectively.

Important

FAST analysis allows you to manage ICMP pseudo-connections. You can authorize the

“question” so that the “answer” is automatically matched to this pseudo-connection and,

therefore, accepted.
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If needed, define new services by selecting the ICMP protocol and entering in the port field the type of

the ICMP question message.

8.5.2.  Error Message Management

To manage ICMP error messages, the Fast360 appliance uses ICMP policy objects. There is a default

ICMP policy, used by the Fast360 appliance. With  Arkoon Manager , you can create customized ICMP

policy objects. These policies can be associated with Fast360 objects to replace the default policy.

Warning

The Fast360 appliance checks first that the ICMP message received corresponds to an active

connection. If the ICMP message refers to a connection that does not exist in the active

connection table, it is immediately rejected and logged.

The ICMP policy processes the packets differently according to their direction. So, the ICMP packets

going from an internal network to another internal network will generally be accepted while the messages

toward an external network will generally be rejected.

8.5.3. Managing ICMP Policies

To manage ICMP error messages, the Fast360 appliance uses ICMP policy objects. A default ICMP policy

is available and is used by default by the Fast360 appliance. From  Arkoon Manager , you can create

customized ICMP policy objects. These policies can be associated with Fast360 objects to replace the

default policy.

1. In the Network objects explorer view, double-click on the Fast360 appliance icon. The Fast360

appliance configuration tab is displayed on the right.

2. Select the Security configuration form.

3. Select the ICMP Filtering option. The ICMP policy options are displayed on the right.

4. Check the Custom IMCP policy option.

5. Drag and drop the ICMP policy object into the ICMP policy field.

Note

The Fast360 appliance first checks that the received ICMP message correspond to an active

connection. If the ICMP message refers to a connection which does not exist in the active

connections table, it is immediately rejected and logged.

The ICMP policy processes the packets differently according to their direction. So, the ICMP packets

going from an internal network to another internal network will generally be accepted while the messages

toward an external network will generally be rejected.

8.5.4. Creating a New ICMP Policy

1. In the default layout, select the Policies navigation tab from the left hand side of the main window.

2. In the explorer view, create a new ICMP policy by right-clicking on the ICMP Policies folder and select

New > ICMP Policy. The ICMP Policy configuration tab is displayed on the right.

3. In the Properties configuration form, enter a short description in the Description field.

4. Select the ICMP code you want to configure by clicking on the corresponding configuration form and

option within the form, if applicable. Select one of the following options.
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Note

“External network” refers to packets going through an interface on which an Internet access

has been defined.“Internal network” refers to interfaces on which there is no Internet access

defined and also includes the Fast360 appliance as source or destination.

• In to In: the ICMP message submitted from an internal network to an internal network is accepted.

• In to Out: the ICMP message submitted from an internal network to an external network is accepted.

• Out to In: the ICMP message submitted from an external network to an internal network is accepted.

• Log on Reject: the rejected ICMP message is logged.

• Log on Accept: the accepted ICMP message is logged.

• Custom ICMP connection timeout: the timeout for a TCP connection, associated with the ICMP

message, is set to 5 seconds. The timeouts of ICMP and UDP pseudo-connections are not modified

by the receipt of ICMP messages.

Note

The timeout value, set by default to 5 seconds, can be modified using the command line defined in

the /proc/sys/arkoon/timeout_icmp_unreach file. However, restarting the Fast360 appliance

will reinitialize this value.

ICMP messages coming from an external network and going to another external network are rare. They

are processed in the same way as messages coming from an external network and going to an internal

network.

Note

For the Fast360 appliance to apply the ICMP policy, you must associate it with the corresponding

Fast360 object. For more information, see Section 8.5.5, “Default ICMP Policy”.

8.5.5. Default ICMP Policy

A default ICMP policy is applied if you do not create a customized ICMP policy. When you create a new

ICMP policy object, the initial values of the object are those of the default ICMP policy.

This default policy rejects any message associated with a connection from an internal network to an

external network except the message type 3 code 4 : Destination unreachable – Fragmentation needed

and DF set. This message is required for the connection and does not allow you to filter sensitive

information.

You can display the parameters of the default ICMP policy in  Arkoon Manager . To create a default ICMP

policy, follow steps 1 to 3 of Section 8.5.4, “Creating a New ICMP Policy”.

To display the parameters of the default policy, click on the code folders within the different configuration

forms in the ICMP Policy configuration tab.
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8.5.6.  Practical Case

Example

In the following topology, a Fast360 appliance is connected to a LAN (LAN1) that has a router connected

to another LAN (LAN2).

Figure 8.1.  Fast360 Appliance Connected to a LAN with a Router Connected to Another

LAN

Here is the routing:

• The Fast360 appliance is the default gateway of the LAN's stations.

• The Fast360 appliance has a default route toward the Internet and a static route toward LAN2, with

the router as a gateway.

Problem Description

redirect logs show blocked ICMP messages.

This is a type 5 code 1 ICMP message (redirect for the host) sent by the Fast360 appliance to a

station of the LAN.

Explanation and Resolution

This message is generated after a packet has been sent from the station of LAN1 toward LAN2. The station

of LAN1 sends the packet to its default gateway, i.e. the Fast360 appliance, which will route the packet to

the router. Then, the Fast360 appliance sends a redirect for the host ICMP message to the station

of LAN1 to indicate that the shortest path to LAN2 consists in sending packets directly to the router.

The default ICMP policy of theFast360 appliance rejects all “redirect” packets. If you want the Fast360

appliance to send this type of message to internal networks, you must create a new ICMP policy to

authorize “redirect” packets from one internal network to another internal network.

Implementation of the New ICMP Policy

1. In the explorer view, create a new ICMP policy by right-clicking on the ICMP Policies folder and select

New > ICMP Policy. The ICMP Policy configuration tab is displayed on the right.

2. In the Properties configuration form, enter a short description in the Description field.
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3. Select the ICMP Type 5 configuration form.

a. Select the Type 5 — Redirect datagrams folder. The parameters to be configured are displayed

on the right.

b. Check the Log on Accept option to make sure the ICMP message is accepted, and so validate that

the policy is working properly.

4. To associate this new ICMP policy with the Fast360 object, double-click on the Fast360 appliance in

the Network objects explorer view. The Fast360 configuration tab is displayed.

a. In the Security configuration form, check the ICMP Filtering folder.

b. Drag and drop the previously created ICMP policy into the ICMP policy field.

Note

Once you have tested the new ICMP policy, you can modify it to stop logging the accepted

redirect messages. Once the new ICMP policy is implemented, if you see unsequenced packets

coming from the station of LAN1 , it means that the machine has not taken the redirect

messages into account. The best solution is to declare a static route toward LAN2 on the station

of LAN1.
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Chapter 9. Network Address Translation

9.1. Network Address Translation (NAT) and Port Address

Translation (PAT)

IP address translation makes it possible to hide the IP addresses of nodes on a private network from

public network hosts. The address of a private network host is called a private address. The translation

address is called a public address.

Fast360 appliances implement five types of IP translation:

• Static translation, also called static NAT (Network Address Translation)

• Masking

• N-1 translation

• Network-to-network translation

• PAT (Port Address Translation), also called redirection

In this section we will take a closer look at how and when to use the different types of address translation.

Static NAT is configured when configuring host objects in  Arkoon Manager . Masking, N-1 translation,

and PAT are configured as part of filtering rules, described in Chapter 8, Basic Traffic Filtering Using

Filtering Rules.

9.1.1. Static Translation (Static NAT)

Static NAT allows for external publication of a protected address outside of a system making it

correspond to an external address. It requires that a private address be replaced by a public address. The

static NAT function applies to inbound and outbound connections. This type of translation is 'symmetric'.

Example

On the local area network (192.168.1.0/24), the server 192.168.1.1 is published with the routable address

194.3.2.5. Any connection coming to the Fast360 appliance and intended for the address 194.3.2.5 is

forwarded toward the server 192.168.1.1, whichever port is contacted.

Figure 9.1. Static NAT

Thus, for an input connection, the Fast360 appliance makes the following modifications to the destination

addresses:
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Table 9.1. Packets Received

Source address Destination address Source port Destination port

All 194.3.2.5 All All

Table 9.2. Transmitted Packets

Source address Destination address Source port Destination port

All 192.168.1.1 All All

Advantages and Disadvantages

Static NAT works with the input connections as well as the output connections. It is used mainly with

input connections toward servers in DMZ.

It has two advantages over PAT in the case of an input connection:

• It simplifies the writing of the filtering rules if several services are activated on the server (with PAT,

you must write a filtering rule for each related services).

• It allows for translating applications that do not rely on TCP or UDP.

Nevertheless, it has an inconvenience: the destination port cannot be changed.

Configuration

The static NAT function is configured with  Arkoon Manager  when declaring a host. Note that the host's

IP address is its private address, and the translation address, its public address.

1. In the Network objects explorer, double-click on the desired network to open the configuration tab

on the right.

2. In the Network configuration tab, select the Enable static NAT option.

3. Enter the network translation address in the Translated address field.

4. Drag and drop the translation Fast360 appliance in the Translating appliance field.

5. In order to activate the static NAT, you must use this host in a filtering rule.

Note

The network IP address and the translation IP address share the same network mask.

Note

An object configured with the static NAT cannot be used in a filtering rule intended to the IP

address given in the IP address field of the object. To do so, it is necessary to create a second

IP address with no translation IP address.

Note

It is possible to assign several static translations on a machine, i.e. to create several host objects

with the same private IP address but with different public addresses. However, you must select

the appropriate host in the filtering rule.
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It is even possible to use the Fast360 appliance's public address as a static NAT address. This

allows the static NAT to be used even if you only have a single public address and it is assigned

to the Fast360 appliance.

9.1.2. Masking

Masking is an asymmetric translation technique in which internal (private) network addresses translate

to a single public IP address. Masking is typically used for client PCs initiating connections with external

servers (web browsing, for example, or thin client deployments). Masking does not permit incoming

connections to be established.

When a client on the private network opens an outbound connection, the source address of the outbound

packets is translated to the Fast360 appliance's output interface address. In order to reroute the return

packets towards the initiating private host, the Fast360 appliance translates the source port (UDP, TCP)

of the outbound packets and maintains a translation table that binds this port to the private host. This

translation requires a single public address for N private addresses. It allows the available IP addressing

space to be saved.

Note that in High Availability configurations the public address is the virtual address of the HA

deployment.

Example

On the local area network, two customers 192.168.1.1 and 192.168.1.2 wish to communicate with the same

public server 196.5.4.8 on the destination port TCP 80 (HTTP query) with the same source port TCP 1092.

Figure 9.2. Masking

The Fast360 appliance makes the following modifications to the source addresses and ports:
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Table 9.3. Packets Received

Source address Destination address Source port Destination port

192.168.1.1 196.5.4.8 1092 80

192.168.1.2 196.5.4.8 1092 80

Table 9.4. Transmitted Packets

Source address Destination address Source port Destination port

194.3.2.1 196.5.4.8 4378 80

194.3.2.1 196.5.4.8 4379 80

The table of active connections allows the return packets to be matched to the current connections and

to route them to the correct port:

1. The server returns packets intended for 194.3.2.1:4378

2. The Fast360 appliance translates them and routes them toward 192.168.1.1:1092

3. The packets arriving on port 4379 are rerouted toward 192.168.1.2:1092.

Configuring Masking

Masking is activated and configured in filtering rules. See Chapter 8, Basic Traffic Filtering Using Filtering

Rules for more information on configuring filtering rules.

Note

In a multi-appliances configuration, to mutualize the use of a flow rule on several appliances, it

is possible to apply a masking translation to a group/folder of appliances.

9.1.3. N-1 translation

N-1 translation is similar to masking, except that you can choose the IP address used to mask the source

address. This allows you to use a different translation address for a flow intended for a specific group of

servers, for example, if a partner asks you to connect to their server with a specific IP address.

Configuration

The N-1 masking function can be activated and parameterized flow by flow with  Arkoon Manager .

9.1.4. Network-to-Network Translation

Network-to-network translation provides similar functionality to static NAT, but applies to all hosts on the

defined network. It works by translating the network part of the IP address, while retaining the host part

of the address constant. Network-to-network translation requires that both the protected network and

the translation network have the same subnet mask.
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Example

The LAN to be protected has the IP address 192.168.0.0/24, and includes three nodes, 192.168.0.12,

192.168.0.29, and 192.168.0.121. The destination (translation) network is 2.21.0.0/24. The translated

addresses for the three nodes will be 2.21.0.12, 2.21.0.29, and 2.21.0.121.

9.1.5. Port Address Translation (PAT)

Port address translation (or redirection) allows a specific service (TCP/UDP port) to be published from

a server of the network that is otherwise to be protected on the unprotected domain. This translation

is asymmetric. It is applied to incoming connections only. The public destination address or port of the

incoming packets are then translated into the private destination address or port. The reverse translation

is applied to the source address or port of the output packets. This translation mode allows the public

network to be masked from the other ports of the private machine that can be open.

Example

A web server (192.168.1.10) is on the local area network (192.168.1.0/24). It can be accessed from the

outside on port TCP 80 (HTTP) with a filtering rule using PAT. For security reasons, the server listens to

a non-standard port TCP 8081.

Figure 9.3. PAT

The client (196.5.4.3) initiates a connection towards 194.3.2.1:80:
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Table 9.5. Packets Received

Source address Destination address Source port Destination port

196.5.4.3 194.3.2.1 1001 80

The Fast360 appliance makes the following modifications to the destination addresses and ports of the

IP header:

Table 9.6. Transmitted Packets

Source address Destination address Source port Destination port

196.5.4.3 192.168.1.10 1001 8081

A table of connections allows the return packets to be matched with the active connections and to route

them on the correct port:

• The server returns packets intended to 196.5.4.3:1001 with 192.168.1.10:8081 as a source.

• The Fast360 appliance routes them toward 196.5.4.3:1001 with 194.3.2.1:80 as a source.

Special Case

In the case of HA Fast360 appliance, the translation public address is the virtual address of the selected

interface.

Advantages and Disadvantages

PAT can be used with incoming connections only. Its main interest consists in allowing modification of

the destination port, which is impossible with static NAT.

PAT Configuration on an IP Address

The redirection function is activated with  Arkoon Manager . The filtering rule must be:

• Unidirectional

• Applied to a single service

To configure a filtering rule with PAT, refer to the section called “Configuring a Translation Rule”.

PAT Configuration on Several IP Addresses

The redirection function is activated with  Arkoon Manager  in the filtering rule. It is possible to define

several hosts as destination of the rule in order to balance the load. This is the mechanism of PAT with

Load Balancing.

In this case, a destination server is selected for a new connection and the following server is selected for

the following connection. Connections openings are thus uniformly distributed between all destination

servers.

To manage a possible failure of one or more servers, the system monitors the status of the machines. If

a problem occurs, it is able to redirect new connections in order to avoid a defective server which is no
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longer eligible for the Load Balancing mechanism. The current connections on the defective server are

lost. The client needs to send again the request which is distributed to another server.

On the contrary, when a disconnected server can be accessed again, it is available again in the

destination list for PAT mechanism.

A system monitoring (sysmon) monitors servers in filtering rules using PAT with Load Balancing. For more

details, refer to Section 16.1, “Machines monitoring”.

The filtering rule must be:

• Unidirectional

• Applied to a single service

To configure a filtering rule with PAT, refer to the section called “Configuring a Translation Rule”.

PAT Configuration on an Interface

It is also possible to configure PAT by choosing the interface on which the Fast360 appliance listens. This

configuration will have the same effect as configuring PAT by entering the IP address of the interface.

9.1.6. Special Cases

Translation Combinations

It is possible to combine translations in a same filtering rule as long as they are coherent. You can combine

a translation on the source with a translation on the destination.

Is possible to combine:

• Static NAT on the source and PAT

• Masquerading and static NAT on the destination.

• N-1 Translation and static NAT on the destination.

However you cannot combine static NAT on the destination and PAT: this information is either redundant

or contradictory.

Nevertheless, combining static NAT and masquerading is possible, as described below.

Static NAT on the Source and Masquerading

In case a filtering rule is configured with static NAT on a source host, as well as with masquerading or

N-1 translation, the static NAT has priority over masquerading and N-1 translation.

In such an example, the behavior could be:

• The source IP address of the FTP 1 server is replaced by the address of the output interface of the

Fast360 appliance.

• The source IP address of the FTP 2 server is replaced by the address 234.1.2.3, configured in the static

NAT.
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NAT in HP Clusters

To avoid addressing conflicts on the attached networks, only some Network Address Translation

mechanisms are implemented in this cluster mode, they are:

• Source translation: masquerading with interface virtual IP address

• Destination translation: Port Address Translation with interface virtual IP address

Note

On an active-active node, translation uses a masquerading address based on the node's

configured virtual IP addresses.

Translations and Transparent Proxies

It is possible to configure translation on the destination (Static NAT or PAT) on a filtering rule redirecting

toward a transparent relay (HTTP or POP3).

Example 9.1. Translations and Transparent Proxies

A mail server can be reached in POP3 from the outside via the public address of the Fast360 appliance.

To activate the transparent POP3 relay on this input flow, you must:

1. Write the following filtering rule (instead of static NAT, you can also choose PAT).

2. Activate the POP3.

9.1.7. Limitations of Various Transport or Inter-application Protocols

Various transport (level 4) or inter-application (level 7) protocols cannot work - or work in fail soft mode

- when address translation is used. In the case of inter-application protocols, secondary connections

often must be opened.

Inter-application Protocols with FAST (FTP, RTSP, H323, NetBios, etc.) Module

When a FAST module is available, it changes the addresses found in the bloc of inter-application data and

dynamically opens the secondary connections to optimize the passage of the protocol through address

translation. This is the case of the data connections of the FTP protocol (active or passive mode), for

instance.

Important

It is very important to specify the corresponding services in the filtering rule. If you do not specify

the service with the related FAST module, the flow will be considered a classic TCP or UDP

connection, and the inter-application protocol will not be analyzed.
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Inter-application Protocols with FAST Module

If no FAST module is available for an inter-application protocol, it may be impossible to optimize the

application transit. This is the case of PPTP, MSN Messenger, etc.

Network Protocols

TCP and UDP

FAST manages the TCP and UDP protocols entirely through all types of address translation.

ICMP

Furthermore, FAST manages various ICMP packets (ping in particular).

VPN (IPsec)

In the case of a VPN (IPsec), you have two possibilities:

• Apply a static translation of the ESP (or AH) protocol

• Use the NAT-Traversal functionality that encapsulates ESP packets in UDP packets, when the two ends

of the tunnel support it.

Others

For all other protocols, the only possibility is to use static translation: a private address related to a public

address.



Chapter 9. Network Address Translation

124 | Limitations of Various Transport or Inter-application Protocols



Web protection | 125

Chapter 10. Proxy servers configuration

This chapter explains how to configure proxy servers to provide antivirus checking of communications

before passing the data (email or files) to the user. The Fast360 appliance provides proxy servers for

traffic using the HTTP, FTP, SMTP, and POP3 protocols.

10.1. Web protection

10.1.1. HTTP Relay Configuration

To activate an HTTP relay, you must:

• Define the DNS of the Fast360 appliance so that it can send DNS requests.

• Set the relay characteristics (at least activate the relay and define the authorized networks and

interfaces).

The HTTP folder is also used to:

• Set the cache size;

• Activate the antivirus;

• Create applicative rules to filter pages requested by users and personalize the blocking page;

• Chain the Fast360 relay on to another relay;

• Set the HTTP relay to work in transparent mode.

Defining the characteristics of an HTTP relay is a multi-step procedure.

The following HTTP relay configuration parameters are described in detail in this section:

• Authorized ports

• Authorized networks

• Authentication

• Proxy chaining

• Blocking page

• Advanced parameters

• HTTP filtering rules

Configuring Authorized Ports

1. In the Network objects explorer view, double-click on the Fast360 appliance icon. The Fast360

appliance configuration tab is displayed on the right.

2. Select the Web configuration form.

3. Check the HTTP folder. In the Listening Port field now available on the right, define the port value (80

by default).
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4. Select the Authorized Ports option to define the possible authorized ports other than those authorized

by default. These authorized ports are defined according to the protocol type (FTP, HTTP, HTTPS and

Gopher).

5. To enter the port number in the appropriate protocol table, right-click in the blank table, select New

> Port. An entry is displayed in the relevant protocol table.

6. Enter the port number. Right-click the entry and select Modify Port if you need to modifiy it.

Note

Specifying an authorized port defines in itself an implicit rule authorizing the Fast360 appliance

to connect to the Internet using the defined port.

Configuring Authorized Networks

1. Select Authorized Networks in the HTTP tree. The fields to be configured are now available on the

right.

a. In the Interfaces  field, drag and drop the interfaces which the authorized machines will connect to.

Note

You must have already defined the interfaces in the Interfaces folder.

b. In the Networks field, drag and drop the network objects (representing networks, machines and

machines groups) authorized to use the proxies' functionality.

Note

You must have already defined the network objects in the Hosts folder (for machines), in

the Networks folder or in the Network objects group folder (for networks or groups of

machines).

Note

Specifying authorized networks and connection interfaces defines an implicit rule authorizing

the networks to access the Fast360 appliance on the port 80 (by default). This implicit rule is read

after the rules defined in  Arkoon Manager .

Configuring Authentication

1. Select the Authentication folder in the HTTP tree.

2. Check the Guarantee unique option to verify that a single user name is not used by two users at the

same time.

Note

In HP clusters, unique authentication is enforced per node, but not on the cluster as whole.

• For an NT-like server (Windows 2000 or NT), it is possible to configure NTLM (Windows NT

LAN Manager). NTLM technology secures the authentication and at the same time realizes it

transparently (users do not need to use their password).

• For a Kerberos-like server (Windows 2008 R2 or higher, Windows 2003 in “Integrated security”

mode), it is possible to configure a Kerberos-like authentication. The Kerberos technology secures

the authentication more safely than NTLM and at the same time realizes it transparently (users do

not need to use their password).

Note

The client stations must use Internet Explorer 7 or a higher version and have a Windows

version at least equal to Windows XP.
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Note

It can be necessary to reboot the Windows sessions after setting up the Kerberos

authentication or when changing a standalone appliance into a cluster so as the Kerberos

authentication works.

Seven modes are available:

• KERBEROS: this mode is the most secure and user-friendly for users who have Kerberos supporting

browsers.

• KERBEROS + Basic: this mode first proposes Kerberos and then displays a pop-up window for

Kerberos non-supporting browsers.

• BASIC: the passwords circulate transparently in the network and users must enter their password

in the displayed pop-up window.

• NTLM: this mode is more secure than the BASIC or LDAP modes.

• NTLM + Basic: this mode first proposes NTLM and then displays a pop-up window for NTLM non-

supporting browsers.

• LDAP: this is the protocol used between the appliance Fast360 and the authentication server,

either in transparent mode (port TCP/389), or in secure mode (LDAPS, port TCP/686). The password

circulate transparently between the browser and the appliance, as in BASIC mode. The users must

enter their password in the contextual window.

• RADIUS: this is the protocol used between the appliance Fast360 and the authentication server

(port UDP/1812). The password circulate transparently between the browser and the appliance, as

in BASIC mode. The users must enter their password in the contextual window. This RADIUS mode

is rarely used.

3. Check the Reverse proxy transparent authentication option to facilitate authentication for web clients

accessing a server protected by the Fast360 appliance in transparent reverse proxy configurations.

Note

A transparent reverse proxy configuration is not compatible with and not supported for

network clients on protected networks seeking to connect to Internet web servers.

4. Check the Use external authentication server option and then drag and drop the server object (host)

into the Authentication server field. Note, the host object should have been previously configured with

the corresponding server capability in its Host Services configuration form.

5. Select the type of authentication server from the Authentication type drop-down list. This choice must

match the server capability of the host selected in the Authentication server field.

Warning

When there are approval relationships between different Windows domains (dom1.local and

dom2.lab for example) the authentication through NT or LDAP is not possible.

Configuring Relay Chaining

Configuring relay chaining involves connecting proxy servers in a pyramid model so that they interrogate

each other in a hierarchical way when servicing requests from client workstations for Internet content.

Chained proxy servers interrogate the local proxy server's cache first. If the local server's cache does

not contain the information, the request is sent further up the chain, up to the master proxy server.

If the master proxy server does not contain the required information, it retrieves it from the Internet and

then sends the information back down the line. On the journey back down the chain, the information is
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written to each involved proxy server's cache for future use, before it is passed to the client workstation

that requested it.

1. Select the Chaining option in the HTTP tree. The chaining table is displayed on the right.

2. To define as a host the relay to be chained, right-click in the blank table.

3. From the displayed list, select New > HTTP Proxy Chaining. The HTTP Proxy Chaining dialog box

appears and the entry is displayed in the table.

a. Enter a name and short description for the HTTP relay in the corresponding fields.

b. In the Destination field, enter the URLs that must be redirected to this relay. To specify that all URLs

must be redirected to this relay, enter the * meta-character.

c. In the Chained HTTP Proxy field, drag and drop the host that must serve as relay. The host should

be configured as a HTTP relay service and the port on which the connection will be made (80 by

default) in the Services configuration form.

Note

Specifying the host serving as a relay defines an implicit rule authorizing the Fast360 appliance

to connect to this relay on the specified port. For more information on implicit rules, see

Section 8.4, “Implicit Filtering Rules”.

Modifying the Priority Order of Proxy Chains

In the chaining table, the order of priority is from top to bottom. For instance, the first relay chain defined,

#1, would be considered the highest priority rule, followed by the second rule, #2, and so on with more

rules. However, you can modify the priority order of previously defined relay chains.

1. In the Chaining table, right-click on the entry for the chain whose priority order you want to change.

2. From the displayed pop-up menu, select either Move > Up or Move > Down to assign to the chain

a priority number higher or lower than its current one. This modification is immediately displayed in

the chaining table.

Configuring the Blocking Page

The Blocking Page option in the HTTP tree enables you to personalize the blocking page which displays:

• when there is a connection problem with the relay server

• when the URL is blocked by HTTP filtering rules configured on your appliance

• when there is a problem with the authentication

• when a virus is detected on the URL or on the page

The page displays the main reason for blocking the URL and the detailed technical characteristics.

Note

Most Web browsers do not support customized blocking pages when an HTTPS connection is

blocked by an applicative rule.

1. Select Blocking Page. The options are displayed on the right.

2. If you do not want to use the default blocking page, you can choose between two customization modes:

• Check Customization of the blocking page to do a simplified customization of the page. You can

choose the French or English language, customize logos at the top of the page and type an email
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address or an url to contact your administrator and send the detailed technical characteristics of

the blocking.

• Check Redirection of the blocking page to do an advanced customization of the page. This option

enables to redirect the user to the blocking page of your organization, generated by the Information

and Technology service administrator. Enter the URL of the server you want in the Redirection URL

field. The following information are sent to the redirection URL via the HTTP protocol:

• the client IP address

• the date

• the blocking HTTP code

• the URL filtering category (if the URL is categorized)

• the URL requested by the client

• the login if the client is authenticated

Configuring Advanced Parameters

1. Select Advanced in the HTTP tree. The fields to be configured are now available to the right.

2. In the Cache capacity field, define the capacity of the cache (in Mbytes).

Note

It is recommended to configure the storage capacity of the cache to 0 Mbytes. Indeed, it is

always faster to search the web pages on the Internet than to look in the cache. It also relieves

the disk of the appliance that has not to cache and read the cache.

3. Check Maximum size for downloaded files to refuse downloading a file which size exceeds the

defined value. The maximum size is 16 Gb (16384 Mb).

4. In the Process management fields, define the processes used by the HTTP relay. These processes

are permanently available and are automatically enabled when the HTTP relay is in use. To improve

the access speed to the Internet, high values must be set, bearing in mind that the requirements of

the CPU resources will be higher.

a. In the Initial number of processes field, define the number of HTTP processes at the initialization

of the service.

b. In the Minimum number of waiting processes field, define the number of waiting processes at the

HTTP level.

c. In the Maximum number of waiting processes field, define the number of waiting processes at the

HTTP level. This parameter is directly linked to Minimum number of waiting processes and is an

auto-regulating parameter.

d. In the Maximum number of processes field define the maximum number of processes to be carried

out at the HTTP level.

Configuring HTTP Filtering Rules

Once you have defined the basic characteristics of the relay, you can add filtering functions by adding

applicative rules. These rules can be used to accept or block URLs according to the following criteria:

• Category

• User
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• Schedule

• HTTP client

Note

The default implicit rule authorizes all criteria/URLs. Rules are read in the order that they are

created and the first rule that corresponds to the request will be applied. The implicit rule

authorizing all criteria/URLs is always the last rule: if you want to force users to authenticate

themselves, you have to write a rule blocking all criteria/URLs at the end.

Creating an HTTP Filtering Rule

1. Select HTTP Filtering Rules in the HTTP tree. The HTTP filtering rules table is displayed on the right.

2. To create a new rule, right-click in the blank table. From the displayed list, select New > HTTP Rule.

The HTTP Rule dialog box appears and the entry is displayed in the table.

3. Enter a name and short description of the new rule in Properties tab.

Note

The name of the HTTP filtering rule appears also in the Rule name column in the HTTP relay

logs in Arkoon Monitoring.

4. In the Parameters tab, choose to enable the rule or not and check Log matching requests to create

logs tracing the requests (you can then visualize these logs using the Arkoon Monitoring tool).

5. In the Criteria tab, in the Clients field, drag and drop host(s) or network(s) objects to which the action

will be applied.

6. In the Categories field in the Criteria tab, drag and drop the possible categories to which the action

will be applied. There are four types of category:

• Arkoon categories

• Advanced URL categories (in Arkoon categories)

• SmartWeb categories (in Arkoon categories)

• Custom categories

These category types are defined in the Categories folder and are based on URLs and keywords.

There are also SmartWeb category groups. For more information, refer to Section 10.1.2, “URL filtering

categories configuration”.

7. In the Schedules field in the Criteria tab, drag and drop the schedule(s) during which the action will

be applied. Note, you must have already defined the schedules in the Schedules folder.

8. Check the Authenticate all users option in the Criteria tab to enable authentication on the entire user

base. This base can be located either locally or on an authentication server. Or, drag and drop the

user(s) who must be subjected to the action in the Authenticate users field. Note, you should have

already defined the users in the Users folder of the Authentication folder.

9. In the Action tab:

• Check the Reject option to prevent any packets from going through the relay.

• Check the Accept option to enable packets to go through the relay and choose the Web security

policy applicable to this rule:

• Check Use the default web security policy defined on the http relay to use the policy chosen in

the form Security / Antivirus in the HTTP relay. Refer to Section 10.1.3, “Antivirus analysis”.

• Choose another Web security policy, specific to the rule, by checking Use the following web

security policy for this rule and drag and drop the policy.
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For more information, refer to the section called “Web security policy configuration”.

Note

The SmartWeb antivirus analysis concerns URLs accessible via HTTP, HTTPS and FTP

protocols.

Modifying the Order of Applicative Rules

In the Rule table, the order of priority is from top to bottom. For instance, the first rule defined, #1, would be

considered the highest priority rule, followed by the second rule, #2, and so on with more rules. However,

you can modify the priority order of previously defined rules.

1. In the HTTP Filtering Rules table, right-click on the entry for the applicative rule whose priority order

you want to change.

2. From the displayed pop-up menu, select either Move > Up or Move > Down to assign to the rule a

priority number higher or lower than its current one. This modification is immediately displayed in the

rule table.

Inserting a New Applicative Rule

It is possible to define a new applicative rule in the rule table by assigning it directly a priority number

provided there is at least one existing rule in the table.

1. In the HTTP Filtering Rules table, right-click on an applicative rule with a priority number immediately

preceding or following that of the rule to be inserted.

2. From the displayed pop-up menu, select either New before > HTTP Rule or New after > HTTP Rule to

insert the new rule before or after the selected applicative rule.

Transparent HTTP Proxy Configuration

In “normal” proxying, the client web browser (Internet Explorer, Firefox, etc.) needs to be reconfigured

with the IP address and port number of the proxy server; all web requests then pass through the relay.

With transparent proxying on a Fast360 appliance, there is no need to reconfigure the browsers of all

your network users.

1. Configure the HTTP relay as described in the section called “Configuring Authorized Networks”.

2. In the default layout, select the Services navigation tab from the left hand side of the main window.

The Services tree is displayed.

3. In the explorer view, expand the Custom Services folder.

4. Create a new TCP service by right-clicking on the TCP services folder, select New > Custom TCP

Service. A new Custom TCP Service configuration tab is displayed on the right.

5. In the Properties configuration form, enter a name for the service and short description in the

corresponding fields.

6. Select the General form.

a. Set the From and To fields in the Destination ports section to 80.

b. Check the Redirect to option and select HTTP Proxy  from the drop-down list.
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7. Return to the default layout and select the Rules navigation tab from the left hand side of the main

window.

8. In the explorer view, create a new rule by right-clicking on the Rules folder, select New > Rule. A new

Rule configuration tab is displayed on the right.

9. In the Properties configuration form, enter an appropriate name for the rule and a short description

in the corresponding fields.

10. In the General form, select Nothing from the Log drop-down list (connections will be logged as part

of HTTP logging, so it is unnecessary to log the filtering rule).

11. In the Criteria form, drag and drop relevant client-side (protected) networks into the Sources field, and

add the TCP user service (previously created in step 4) into the Services field. Leave the Destinations

field empty.

Note

Do not configure authentication by the relay for transparent proxy configurations. Most browsers

do not accept HTTP response code 407 (relay authentication required) if they are not configured

to work in relay mode and so authentication will fail.

Transparent Reverse HTTP Proxy

The HTTP relay of a Fast360 appliance can be used in transparent reverse proxy mode. This configuration

is typically used to provide additional security for locally-hosted web servers accessed by external

clients. Configuration is similar to that of a transparent HTTP proxy, except that:

• The Sources field in the Criteria form of the Rule  configuration tab is left empty.

• The Destinations field in the Criteria form of the Rule  configuration tab contains a host object

corresponding to the HTTP server.

If you want users to be authenticated by the relay, not the server, select the Transparent option in the

Authentication folder of the HTTP relay configuration (as described in the section called “Configuring

Authorized Networks”). The HTTP relay then sends HTTP code 401 (server authentication required)

instead of 407 (relay authentication required), as if it was the server requiring authentication.

Note

This is a general configuration that changes the behavior for all the requests handled by the relay.

10.1.2. URL filtering categories configuration

Arkoon Manager  enables URLs and keywords (detected in the URLs) to be applied to the applicative

rules of the HTTP relay. Categories are used to define these URLs and keywords.You can use Arkoon

predefined categories or groups of categories or create your own categories.

Note

The number of categories is limited to 256 in the applicative rules.
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Creating a New Custom Category

1. In the default layout, select the URL Filtering Categories navigation tab from the left hand side of the

main window. The URL Filtering Categories tree is displayed.

2. In the explorer view, select the Custom Categories folder.

3. Create a new category by right-clicking on the folder, select New > Category. The Custom Category

configuration tab is displayed on the right.

4. In the Properties configuration form, enter a name and short description of the category in the

corresponding fields.

Note

The category name is limited to 42 characters.

5. Select the General configuration form.

6. Select the category type (URL or keyword) from the Type drop-down menu.

7. To create a new entry in the Keyword table, right-click in the blank table, select New > Keyword. A

keyword entry is displayed in the table. Enter the keywords or URLs for the category.

To deny or accept access to the whole domain of a site, type only the site name followed by the

domain classification. To accept or deny access to a specific page, enter the whole URL and path of

the specific page. To indicate all the sub-domains of a site, you can use the * meta-character, that

replaces any character; a “*” replaces any character present 0 or X times, a “?” replacing one and

only character. The * meta-character can be used only with the URL category type.

Important

The use of the * meta-character is very resource-consuming, its use must be limited. A

coherency check warning is systematically sent when the * meta-character is used. The

warning can be ignored depending on your specific needs.

8. To delete an URL or a keyword, select the object in the Keywords table and press Delete.

9. To modify an existing category, right-click the category to modify. Select Edit in the pop-up menu. The

Custom Category configuration tab is displayed on the right.

The following tables provide examples for URL and keywords categories.

URL categories:

URL category types enable to do a search on the URL domain.
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Need Detected (if not indicated in http,

https, ftp protocols)

Not detected

Accept/Block all web pages

from the domain my-site.com

Keyword: my-site.com

• sub-part.my-site.com

• sub-part.my-site.com/part1/my-

page.fr

• my-site.com/index.htm

• my-site.com:443 (https://my-

site.com)

• an-other-site.com/part1/my-

site.com

• my-site.com.

an-other-site.com

• fakemy-site.com/

Accept/Block the specific

domain www.my-site.fr

Keyword: www.my-site.fr

• www.my-site.fr

• www.my-site.fr/part1/my-

page.fr

• foo.www.my-site.fr

• www.my-site.fr:443/part1/my-

page.fr (https://www.my-site.fr/

part1/my-page.fr

• sub-part.my-site.fr

• sub-part.my-site.fr/part1/my-

page.fr

• www.my-site.fr.

an-other-site.fr

Accept/Block a part of a

specific domain my-site.fr/

part1

Keyword: my-site.fr/part1

• my-site.fr/part1

• my-site.fr/part1/photos

• my-site.fr/part1/blog/index.html

• sub-part.my-site.fr/part1/forum

• my-site.fr/:443/part1/blog/

index.html (https://my-site.fr/

part1/blog/index.html

• my-site.fr/part2

• an-other-site.fr/my-site.fr/part

Accept/Block all the web

pages for all domains of my-site

(my-site.fr, my-site.com, my-

site.eu, …)

Keyword: my-site.*

• my-site.com

• http://my-site.org

• http://my-site.fr/whatever

• http://my-site:443.org (https://

my-site.org)

• foo.my-site.com

• http://foo.my-site.com

• http://foo.my-site.com/

whatever

Accept/Block all the web

pages for all domains and sub-

domains of my-site (my-site.fr,

my-site.com, my-site.eu, …)

Keyword: *.my-site.*

• sub-part.my-site.fr

• sub-part.my-site.fr/root/part1/

my-page.fr

• sub-part.my-site.org/part1

• sub-part.my-site:443.fr (https://

sub-part.my-site.fr)

• an-other-site.fr/part1/my-site.fr

• fakemy-site.fr/root

• my-site.fr/part1

Accept/Block all the web

pages for all domains and sub-

domains of my-site (my-site.fr,

my-site.com, my-site.eu, …)

Keyword: *.my-site.*/root/*

• sub-part.my-site.fr/root/

index.htm

• sub-part.my-site.fr/root/partie1/

may-page.fr

• sub-part.my-site:443.fr/root/

partie1/may-page.fr (https://sub-

part.my-site.fr/root/partie1/may-

page.fr)

• an-other-site.fr/part1/my-site.fr

• fakemy-site.fr/root

• sub-part.my-site.root

• sub-part..my-site.fr/fake/root/

my-page.fr

• my-site.fr/part1

• ftp://my-site.fr • http://my-site.fr
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Accept/Block all the web

pages of a domain for a

particular protocol

Keyword: ftp://my-site.fr

• ftp://my-site.fr/part1/my-

page.html

• ftp://www.my-site.fr

Accept/Block a part of a

specific domain for a particular

protocol

Keyword: http://my-site.fr/

part1

• http://my-site.fr/part1

• http://my-site.fr/part1/my-

page.html

• ftp://my-site.fr/part1

• http://www.my-site.fr/part1

• http://www.my-site.fr/part1/

my-page.html

Accept/Block a domain in

HTTPS

Keyword: my-site.com:443

sub-part.my-site.com:443

https://my-site.com/part1/my-

page.html

http://my-site.com

https://foo.com/my-site.com

Keyword categories:

Keyword category types enable to search the keyword on the whole URL (including POST variables

passed in parameter in the URL). The search is not performed in the content of the Web page.

Need Detected (if not indicated in http,

https, ftp protocols)

Not detected

Accept/Block the URLs

containing the keyword key-

word

• key-word.fr/part1/mypage.fr

• www.an-other-site.fr/key-

wordhere/my-page.fr

• www.an-other-site.fr/part1/key-

wordhere.fr mykey-word.fr/

part1

• www.research.com/search?

q=key-wordhere

• www.research.com/key-word?

foo=bar

www.my-site.fr/key/word

Accept/Block the URLs

containing the keyword *key-

word*

• www.an-other-site.fr/*key-

word*/my-page.fr

• www.an-other-site.fr/part1/

*key-word*.fr

• key-word.fr/part1/mypage.fr

• www.an-other-site.fr/key-

word/my-page.fr

• www.an-other-site.fr/

part1/key-word.fr
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Arkoon, Advanced URL and SmartWeb categories and groups of categories

Arkoon categories are provided by default with the Fast360 appliance.

To use the Advanced URL and SmartWeb filtering categories, you need the corresponding license

options. If you install a configuration using one or several Advanced URL or SmartWeb categories in the

HTTP filtering rules without the corresponding license, a coherency error is sent. In case of expiration

of the license, an alert is sent.

The groups of categories group SmartWeb URL filtering categories together in eight thematic groups.

Refer to Appendix D, URL Filtering Categories to see a detailed description of the URL categories and the

section called “Creating an HTTP Filtering Rule” to use URL categories in HTTP filtering rules.

Note

It is recommended not to use SmartWeb categories and Arkoon or Advanced URL categories in

the same HTTP filtering rule.

Note

We recommend using SmartWeb categories rather than Advanced URL categories for

performance reasons as described in the section below. SmartWeb categories include all the

URL of Arkoon and Advanced URL categories as well as many other URL. They are updated daily

by Arkoon Network Security.

If you use Arkoon and Advanced URL categories in your applicative rules, we recommend

you to replace them by SmartWeb categories if you own the corresponding license. For help,

refer to Section D.5, “Correlation table between Arkoon/Advanced categories and SmartWeb

categories”.

SmartWeb URL filtering

SmartWeb URL database is located on one or more remote servers “in the cloud”. To filter URLs,

the Fast360 appliance checks the database thanks to the DNS protocol. This avoids overloading the

appliance and makes the database updates easier. URL prints (SHA-1) only are sent to the remote

DNS servers which guarantees Web requests done by customers are confidential for Arkoon Network

Security.

For statistical purposes and to continuously improve the service, not categorized URL are reported to

Arkoon Network Security in an anonymous way. This enables Arkoon Network Security to continuously

update the URL database. You can disable this option in the Maintenance menu in minarkconf.

The following figure explains how SmartWeb filtering works.
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Figure 10.1. SmartWeb filtering

10.1.3. Antivirus analysis

The Security / Antivirus option in the HTTP folder enables you to set parameters for antivirus analysis

of files transferred using HTTP.

1. In the Network objects explorer view, double-click on the Fast360 appliance icon. The Fast360

appliance configuration tab is displayed on the right.

2. Select the Web configuration form.

3. Check and expand the HTTP folder and select the Security /Antivirus option.

4. In the Default web policy for http relay zone, choose a Web security policy which will be the default

policy of the HTTP relay. You can associate a specific Web security policy to each HTTP filtering rule.

For more information, refer to page 130.

5. Choose the type of antivirus:

• SmartWeb Antivirus: the antivirus analysis is done “in the cloud”. The SmartWeb antivirus database

is located on remote servers. To perform the antivirus analysis, the Fast360 appliance checks

the database thanks to the DNS protocol. This avoids overloading the appliance and makes the

database updates easier.

When the SmartWeb antivirus is enabled via Arkoon Manager on the HTTP relay, the URL and then

the flows are analyzed as follows for the HTTP, HTTPS and FTP protocols:
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• If the URL is identified as malicious, then the client stops receiving data and a blocking page

displays details to the user.

• If no virus is detected when analyzing the URL, then the file is analyzed in synchronous mode.

The HTTP relay sends the data to the client as soon as it receives them from the Web server and

asks the SmartWeb servers an analysis on the fly. If the analysis indicates a “VIRUS” status, data

are no longer sent to the client.

Note

When a virus is detected by the SmartWeb antivirus, a system alert is sent and

the following information is displayed in the logs /var/log/httpd and /var/log/

messages:

• the virus name

• the URL which generated the error

• the URL to access the description of the virus

• the URL enabling the administrator to declare a false positive if any (false positives

are alerts mistakenly generated, blocking legitimate Web pages). When a virus is

mistakenly detected on a URL or a file, it is recommended to notify it via the URL

provided.

• Classic Antivirus: the antivirus filtering system uses an engine on the appliance and downloaded

local databases and implies a local asynchronous analysis on the whole file: the HTTP relay sends

the whole file to the client once the analysis is finished. An appliance with a hard drive is necessary

to use this antivirus because the file is stored on the appliance while being analyzed.

Important

You can disable the classic antivirus analysis for the files exceeding a specific size. The

file size limit with the classic antivirus on the SMALL, P-XS3 and P-S4 appliances is 10 Mb

and 2 Gb for the SMALL 250. If these limits are exceeded when installing the configuration,

the appliance only will generate an error.

Note

In the Advanced tab of the HTTP tree, it is possible to prohibit the download of a file with a

size superior to the defined value : the maximum value for this option is 2 Gb (2048 Mb) by

checking Maximum size for downloaded files.

6. To enable antivirus analysis of specified file types, check Enable restricted analysis.

a. In the Restriction drop-down list, select either To Analyze or Do not analyze to include or exclude

the file types defined in the MIME types  table.

b. To specify the file types, right-click in the blank area of the table and select New > MIME. A blank

entry appears in the MIME types table.

c. Type the entry in the accessible field.

Web security policy configuration

Web security policies are used in the HTTP relay (relay default policy) and in the configuration of HTTP

filtering rules (when you need to create a specific policy for a rule). They enable to set up specific

parameters when using the HTTP relay, in particular to activate or deactivate the antivirus analysis.

1. Select the Policies tab in the explorer view on the left-hand side of the main window. The Policies

tree view displays.
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2. In the explorer, select Web Security Policies.

3. Choose one of the three Arkoon Web security policies or create a custom policy by right-clicking on

Custom Web Security Policies.

4. In the Item tab, enter a name and short description for the security policy.

5. Check Enable the antivirus analysis in the Antivirus tab to enable the antivirus analysis on all files

going through the HTTP relay.

6. In the HTML tab, choose from the following options:

• Disable Java Applets, to allow packets through deactivated Java applets.

• Disable Javascripts, to allow packets through deactivated Javascript scripts.

• Disable ActiveX and Visual Basic Controls, to allow packets through deactivated ActiveX and VB

controls.

10.2. Mail servers protection

10.2.1. SMTP Relay Configuration

To set the SMTP relay, you must:

• Define the DNS of the Fast360 appliance so that it can send DNS requests. For more information, refer

to Section 4.4, “Configuring DNS Servers used by the Appliance”.

• Activate the relay.

• Configure domain routing.

• Configure the antirelaying rules.

This folder is also used to:

• Configure ID masquerading, antivirus and other characteristics.

• Create applicative rules to filter emails.

Configuring Basic Settings of the Proxy

1. In the Network objects explorer view, double-click the Fast360 appliance icon. The Fast360 appliance

configuration tab is displayed on the right.

2. Select the Mail configuration form.

3. Check the SMTP folder to activate the SMTP relay.

Note

Activating the SMTP relay defines two implicit rules: one authorizes the Fast360 appliance

to transmit a SMTP flow towards any machine; the other authorizes any machine to transmit

a SMTP flow to the Fast360 appliance. These broad rules are then limited by the anti-spam

rules. For more information on implicit rules, see Section 8.4, “Implicit Filtering Rules”.

In addition, the SMTP relay uses the default internet access to send emails. It is not possible

to change this behavior.

4. Check the Restrict email size option to limit the size of emails forwarded by the SMTP relay.
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a. Adjust the Maximum email size value to alter the maximum size allowed for an email.

b. To prevent the SMTP connection from being reset as soon as an incoming email passes the

specified size limit, check the Notify remote SMTP server if email exceeds maximum size option.

The email is then downloaded and dropped, and an error message is returned to the originating

server.

5. Check the Enable spam filtering option to enable the antispam analysis. You will also need to configure

detailed antispam analysis parameters in the Antispam folder of this Mail configuration form. See

Section 10.2.3, “Antispam Analysis” for more information.

Configuring Antirelaying Rules

Defining DNSBL domains

The DNSBL (DNS-based Blackhole List) are blacklists of IP addresses known for spreading spam. These

blacklists are queried using the DNS protocol. The SMTP relay queries the lists to accept or not a

message coming from this machine.

Note

The use of DNSBL is based on public servers. Consequently, it is your decision whether to use

them or not. Using DNSBL transfers a part of the email processing policy to an external entity.

1. Select the Antirelaying option from the SMTP tree.

2. Check Enable DNSBL filtering.

3. In the Blacklisting threshold field, define the threshold (minimum 1) from which the IP address is

considered as blacklisted, bearing in mind that using a high threshold lets all messages through while

monitoring suspicious IP addresses (as well as associated scores in SMTP logs in  Arkoon Monitoring

).

Note

When several DNSBL domains are used, this option can be used to match up information

across the lists and avoid false positives (false positives are alerts which are generated

mistakenly when the threshold is too sensitive and blocks legitimate messages).

4. Check the Test private addresses option to test using a private address, bearing in mind that they are

never defined on public DNSBL servers and that such a query could cause an information leak.

5. Check the Take multiple replies into account option so that each record increases the score if the

server sends back several records to test an IP address.

6. Right-click in the empty DNSBL domains table, select New > DNSBL Domains. The DNSBL Domains

dialog box appears and a new entry is displayed in the DNSBL domains table.

a. Enter the domain name in the DNSBL Domain field.

b. Enter a value in the Weight field to grade the importance of the domain relative to the other domains.

Note

The DNSBL domains must be used in antirelaying rules in order to be taken into account.

Typical Configuration of DNSBL Domains

A typical configuration of DNSBL domains defines several DNSBL domains to match up the replies. A

greater importance is given to the list.dsbl.org server.

The blacklisting threshold is set to 2 to prevent many false positives.



Chapter 10. Proxy servers configuration

SMTP Relay Configuration | 141

Caution

You must configure the antirelaying rules on the Fast360 appliance's relay so that it is not used

as a spam relay. This configuration is part of the security, so that there is a default implicit rule

which blocks everything.

Creating an Antirelaying Rule

1. Right-click in the blank Antirelaying rules table, select New > SMTP Antirelaying Rule. The

Antirelaying rules table dialog box appears and the entry is displayed in the table.

a. Enter the name and a short description of the antirelaying rule in the corresponding fields.

b. Drag and drop the host(s) and/or network(s) from which emails are sent, and to which the action

will be applied, into the Clients field. Select the type of source object from the corresponding drop-

down list from the following options:

• List

• Exclude

• DNSBL

c. In the From field, add possible addresses of submitter mails to which the action will be applied

by right-clicking in the blank table, select New > Email pattern type, and enter the email address.

Select the submitter type, Include or Exclude, from the corresponding drop-down list.

d. In the To field, add addresses of recipient mails to which the action will be applied. Right-click in

the blank table, select New > Email pattern type, and enter the email address. Select the recipient

type, Include or Exclude, from the corresponding drop-down list.

e. Select the behavior of the antirelaying rule from the Action drop-down menu from one of the three

options:

• Select Accept to accept emails.

• Select Deny to reject emails (a warning is sent to the email submitter).

• Select Deny without warning to reject emails (no message is sent to the email submitter).

Typical Case of Antirelaying Rule Configuration

This example assumes the framework of the typical topology of this manual. This architecture presents

the following characteristics:

• The mail server is hosted on the DMZ.

• The LAN machines are configured to send their emails to the mail server.

The actions which must be authorized by the antirelaying rules are:

• Authorizing the internal mail server to send emails with internal domains for submitter.

• Authorizing the internal mail server to send emails with <> empty fields for source.

• Blocking any email which does not come from an internal IP address with an internal domain for

source.

• Blocking anything from the LAN with a submitter which does not belong to the internal domain.

• Authorizing emails with internal domains for destination.

• Blocking all other actions.

Note

The implicit rule blocking everything remains the last rule in the table.
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For the typical case of DNSBL, see the section called “Using DNSBL in an Antirelaying Rule”.

Disabling/Activating an Antirelaying Rule

To disable an antirelaying rule, uncheck the General box in the corresponding entry of the Antirelaying

rules table. Alternatively, uncheck the Enable this rule option in the SMTP Antirelaying Rule dialog box.

Modifying the Order of Priority of Antirelaying Rules

In the Antirelaying rules table, the order of priority is from top to bottom. For instance, the first antirelaying

rule defined, #1, would be considered the highest priority rule, followed by the second rule, #2, and so on

with more rules. However, you can modify the priority order of previously defined antirelaying rules.

1. In the Antirelaying rules table, right-click on the entry for the rule whose priority order you want to

change.

2. From the displayed pop-up menu, select either Move > Up or Move > Down to assign to the rule a

priority number higher or lower than its current one. This modification is immediately displayed in the

antirelaying rule table.

Inserting a New Antirelaying Rule

It is possible to define a new antirelaying rule in the rule table and assign it directly a priority number

provided there is at least one existing rule in the table.

1. In the Antirelaying rules table, right-click on an antirelaying rule with a priority value immediately

preceding or following that of the rule to be inserted.

2. From the displayed pop-up menu, select either New before > SMTPAntirelaying Rule or New after >

SMTP Antirelaying Rule to insert the new rule before or after the selected antirelaying rule.

3. To edit the rule, follow the procedure outlined in the section called “Creating an Antirelaying Rule”.

Using DNSBL in an Antirelaying Rule

To activate an antirelaying behavior of the blacklisted IP addresses, the use of DNSBL must be configured

in the antirelaying rules. For this, a rule with DNSBL as source must be created.

1. Create an antirelaying rule following the procedure outlined in the section called “Creating an

Antirelaying Rule”.

2. Select DNSBL from the Type drop-down menu directly above the Clients field.

3. Drag and drop the host(s) and/or network(s) for which the DNSBL results will not be used.

4. Select Deny from the Action drop-down menu.

Note

Selecting the DNSBL option defines the use of DNSBL and also allows you to restrict their action

by selecting source IP addresses (for instance, a whitelist).

You can configure a whitelist group containing legitimate servers which are often blacklisted on DNSBL

servers. For example, this is the case of the following French providers:

• mx.laposte.net

• mail[1-3].caramail.com

• relay[1-4].clb.oleane.net

• smtp[1-6].wanadoo.fr
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Note

It is very important to position this antirelaying rule correctly. It must be positioned after the

rules concerning outgoing emails (there is no point in querying DNSBL for internal addresses)

and before those concerning incoming emails (as in the example below). See the section called

“Typical Case of Antirelaying Rule Configuration” for information on how to order antirelaying

rules.

Note

You can use  Arkoon Monitoring  to monitor (SMTP logs window) the working mode of the DNSBL

and modify its configuration in  Arkoon Manager  if needed.

Configuring Applicative Rules

Once you have set the SMTP relay, you can add filtering functions by adding applicative rules. These

rules can be used to accept or block emails according to the following criteria:

• Mail address of submitter

• Mail address of recipient

• Keywords present in subject or text

• MIME type of attached files

• File name of attached files

• File extension of attached files

• Size of attached files

Note

The default, implicit rule authorizes all emails. When adding rules, email must not be blocked by

any of them to be transmitted. When configuring several criteria in a rule, complete all of the

criteria so that the action selected in the rule is applied.

To translate an AND condition, the different criteria must be configured in a same rule. To translate an

OR condition, several rules must be configured.

1. If required, in the Disclaimer field enter the message to be added to every outgoing (or incoming)

email. This message will only be added to emails if this feature is enabled in the Applicative rule table

entry.

2. Right-click in the blank Applicative rule table, select New > SMTP Applicative Rule. The SMTP

Applicative Rule dialog box appears and a new entry is displayed in the Applicative rule table.

3. Enter the name of the applicative rule and a short description in the corresponding fields.

4. Select the filtering criteria against which the email will be examined.

• To filter the email according to the submitter's email address, enter the email pattern type in the

From table.

• To filter the email according to the recipient's email address, enter the email pattern type in the

To table.

• To filter the email according to the MIME type of attached files, enter the MIME file in the MIME

Types table.

• To filter the email according to keywords in its content or header, enter the keywords in the

Keywords table.

• Select the All option if the file type is not of importance.

• Select the By name option and enter one of several file names in the corresponding field.
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• Select the By type option and enter one of several file types in the corresponding field.

• To accept attached files until a certain size limit, check the Maximum file size option and enter this

size (in Kb) in the corresponding field.

5. Select the action to be performed on the emails from the Action options:

• Check Accept, to accept the attached file. Check the Append disclaimer to emails option if you

wish to add a disclaimer message; this message should be previously defined in the Disclaimer

field, see step 1 for details.

• Check the Reject option to reject the attached files. Check the Quarantine option to process the

file later.

Note

• Reject: the e-mail is blocked (not sent to the recipient) and it is deleted (alerts can be sent

to the recipient/submitter/postmaster according to the configuration defined in the Alerts

tab, to keep them informed about the reject.

• Quarantine: the email is blocked (not sent to the recipient) and put in quarantine (alerts

can be sent to the recipient/submitter/postmaster according to the configuration defined

in the Alerts tab, to keep them informed about the reject in quarantine.

Modifying the Order of Priority of the Applicative Rules

In the Applicative rule table, the order of priority is from top to bottom. For instance, the first applicative

rule defined, #1, would be considered the highest priority rule, followed by the second rule, #2, and so on

with more rules. However, you can modify the priority order of previously defined applicative rules.

1. In the Applicative rule table, right-click on the entry for the rule whose priority order you want to

change.

2. From the displayed pop-up menu, select either Move > Up or Move > Down to assign to the rule a

priority number higher or lower than its current one. This modification is immediately displayed in the

applicative rule table.

Inserting a New Applicative Rule

It is possible to define a new applicative rule in the rule table and assign it directly a priority number

provided there is at least one existing rule in the table.

1. In the Applicative rule table, right-click on an applicative rule with a priority value immediately

preceding or following that of the rule to be inserted.

2. From the displayed pop-up menu, select either New before > SMTP Applicative Rule or New after >

SMTP Applicative Rule to insert the new rule before or after the selected applicative rule.

3. To edit the rule, follow the procedures outlined in the section called “Configuring Applicative Rules”.

Configuring Alerts

1. Select the Alerts option. Options for setting the warning messages are displayed on the right.

2. Select the language of the warning message (independent from the interface language) from the

Language drop-down menu.

3. Select the recipients of the warning message by checking the desired options. By default, Notify

sender and Notify postmaster are checked.
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4. To customize the message that advises the sender, the postmaster or the recipient of either a non

conform email or that their email has been removed from quarantine, check the corresponding

Override system message option and type directly the text in the Subject or Message fields of the

appropriate warning message.

Note

A non conform email is:

• non analyzable ;

• with a virus

An encrypted email is considered as non conform and it is not analyzed with the antivirus.

If you do not customize the message, a default standard message is sent.

Configuring ID Masking

1. Select the Identity masking option.

2. To mask the IP address of the message's submitter (normally present in the SMTP packet), drag and

drop the hosts or networks into the Masked hosts field. The Fast360 appliance masks the IP address

by replacing the source IP address with x.x.x.x.

Note

The hosts and networks that you drag and drop into the Masked hosts field have been previously

defined in the Hosts and Networks  folders in the Network objects explorer view.

Configuring Advanced Parameters

1. Select the Advanced option.

2. Set the value for the number of mails that can be analyzed simultaneously in the Maximum number

of concurrent analysis field.

3. Select one of the three options for setting the Resubmit frequency of waiting emails:

• Every mn, for the frequency expressed in minutes

• Every h at th minute, for the frequency expressed in hours and minutes

• Check every day at, for a specific time expressed in hours and minutes within 24 hours

4. To generate a copy of quarantined files to be put in the code, check the Archive emails out of the

quarantine box in the Advanced option. This will copy the quarantined file to the following directory:

/var/mail/badmails.

Note

It is not possible to access this directory from  Arkoon Manager  or  Arkoon Monitoring .

Domain Routing for the SMTP Proxy

Certain network topologies may require you to specify domain routing rules for SMTP traffic. For example,

if your mail server is hosted by your ISP you will need to define a domain routing rule to ensure that the

SMTP relay forwards emails to the ISP-based server, rather than routing mails directly to their destination

domains.
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You can specify multiple routing rules to manage the routing of mail from different domains.

1. In the Mail configuration form, select the Mail routes folder.

2. Right-click in the blank SMTP routes table, select New > Domain route. The Domain route dialog box

appears and a new entry is displayed in the SMTP routes table.

a. Enter the name of the route and a short description in the corresponding fields.

b. Select the domain routing rule from the Domain options:

• Check Default route to route all mails (unless covered by another domain-specific routing rule)

to the server to be specified in the SMTP server field.

• Check the Custom domain option and enter the domain name to route mails for the specified

domain to the server specified in the SMTP server field. Enter the name in the form example.com.

To include all sub-domains (e.g. server1. example.com, server2. example.com, etc.) include a full

stop before the domain name: .example.com.

c. Select the server to which mail will be routed, using one of two methods:

• Check the SMTP server option and then drag and drop a host object into the corresponding field.

• Check the Hostname option and enter the full-qualified domain name of the server in the

corresponding field. If required by your network topology, check the Resolve using MX field

(Mail Exchange records).

Examples

1. You run an internal mail server at IP address 10.0.0.21, for your corporate domain “example.com” (e.g.

email for any.user@example.com). A single domain routing rule is needed:

• In the Custom domain field, enter “example.com” as the domain name.

• Select the SMTP server option and drag and drop a host object for your mail server at 10.0.21

The SMTP relay will transfer mail for example.com users to your mail server, and route all other

mail according to DNS lookup.

2. Your e-mail is hosted by your ISP at address 192.168.10.10, with SMTP relaying with hostname smtp.my-

isp.com. You want to route all mails from the relay through your ISP server. A single domain routing

rule is needed:

• Select the Default route domain routing option.

• Check the Hostname option and enter “smtp.my-isp.com” in the corresponding field.

10.2.2. Antivirus Analysis

Configuring Antivirus Analysis in the SMTP relay

1. In the Mail tab, select the Antivirus option in the SMTP tree. Options for setting email analysis are

displayed on the right.

2. Check the Enable antivirus analysis (classic antivirus) option to make the different settings available.

Note

The classic antivirus uses an engine on the appliance and downloaded local databases.
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3. From the Infected file or failed analysis options, select the process to be performed in the case of

an infected file:

• Correct infected file;

• Remove file;

• Reject email ;

• Activate Quarantine to process the file later. To correct the quarantined file later, check Repair

infected file.

4. From the Custom failed analysis options drop-down lists, select the action to be performed on:

• Encrypted file: any type of encrypted file.

• Non-analysable file: files that the antivirus could not analyze.

POP3 Proxy Configuration

This section describes the working mode of the transparent POP3 relay. This relay is used for antivirus

analysis of the POP3 flows on the fly. It exists only in transparent mode.

This section presents:

• The mechanisms of the POP3 relay

• The configuration parameters

• The information logged in  Arkoon Monitoring

Mechanisms of the POP3 Relay

Relay in Transparent Mode

The POP3 relay works in transparent mode. This means that the POP3 clients are configured to interrogate

the POP3 server. The Fast360 appliance, between the client and the server, intercepts these flows and

redirects them towards the POP3 relay that processes them. Thus, the POP3 relay interrogates the server

(and not the client). The relay transmits the answers to the POP3 client according to its configuration.

Synchronous, Asynchronous and Hybrid Modes

The POP3 relay can have several different behaviors in relation to the client:

• In synchronous mode, the relay submits the data to the client as soon as it receives it from the server;

it submits the final data only when it has confirmed that the message is not infected.

• In asynchronous mode, the relay completes the analysis first before submitting the entire message

to the client.

• In hybrid mode, the relay operates in asynchronous mode on messages smaller than a pre-set

threshold.

The following example shows a POP3 connection with an Outlook Express client.
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+OK POP3 server ready
USER test
+OK User name accepted, password please
PASS password
+OK Mailbox open, 2 messages
STAT
+OK 2 4428
LIST
+OK Mailbox scan listing follows
1 1476
2 1476
.
RETR 1
+OK 1476 octets
Return-path: <test@formation.arkoon.net>
[...]
.
RETR 2
+OK 1476 octets
Return-path: <test@formation.arkoon.net>
[...]
.
DELE 1
+OK Message deleted
DELE 2
+OK Message deleted
QUIT
+OK

The following sections detail the relay's behavior, in synchronous and in asynchronous mode, if a virus

is detected in the second downloaded mail.

Characteristics of the Synchronous Mode

If a virus is detected in the second mail and the Fast360 appliance has already begun to submit the data to

the client, the Fast360 appliance aborts the connection on the client side. Since the client only received

a part of the message, the virus is not effective. The relay also requests the server to delete the infected

mail (this corresponds to the Quarantine default option).

The following diagram shows the exchange of commands in synchronous mode.
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Figure 10.2. Exchange of Commands in Synchronous Mode

This mode has the following consequences:

• The POP3 relay cannot send the client a warning mail notifying the presence of a virus as the POP3

relay has already begun to send the data to the client; if a virus is detected, the only solution is to abort

the connection.

• With some mail clients, mails can be received twice. In the example above, mail #1 was received, but

the connection with the client was aborted before it submitted the DELE 1 suppression command. This

mail will thus be retrieved again at the next connection. This problem does not occur in the case of a

mail client which submits the  DELE command after each RETR command.

Characteristics of the Asynchronous Mode

In asynchronous mode, if a virus is detected in the second mail no mail data is sent to the client when

the antiviral analysis detects the presence of the virus. The POP3 relay submits a warning mail notifying

that the mail is infected. The connection continues normally.
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Figure 10.3. Exchange of Commands in Asynchronous Mode

The warning mail submitted by the relay has postmaster@domaine.fr as default submitter where

“domaine.fr” corresponds to the domain name indicated in the hostname of the Fast360 appliance (of

myArkoon.domain.fr  type).

Note

It is not possible to deactivate the submit of a warning mail to the client; The client expects to

receive a message after the submit of its RETR command.

Asynchronous mode is more manageable for the client than synchronous mode but can sometimes

timeout on the client side if the antiviral analysis of mail takes too long. The possibility of a timeout

depends on:

• The size of the mail to be analyzed

• The timeout value of the mail client

• The throughput of the connection available to the Fast360 appliance for downloading the mail from

the server
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Characteristics of Hybrid Mode

Hybrid mode combines the benefits of asynchronous and synchronous modes. In hybrid mode, you define

a hybrid mode threshold. This enables the POP3 relay to change its behavior depending on message size.

The POP3 relay starts out in asynchronous mode but switches to synchronous mode when it receives

messages larger than the threshold. This avoids some of the drawbacks linked to synchronous mode

(timeouts, duplicate mails, and so on).

Note

Most messages containing SPAM or viruses are small. In hybrid mode these messages are

blocked transparently, as they are below the threshold size, so the relay is operating in

asynchronous mode. However, there is no risk of losing larger mails – for example, mails with

attachments – as the relay switches to synchronous mode for these larger mails.

Cases of Typical Architectures

It is possible to implement the POP3 relay for output connections (from local network to the Internet

for instance) and for input connections (from the Internet to a hosted server for example). For an input

connection, the filtering rule used to implement the transparent POP3 relay can include a PAT- or Static

NAT-translation on a destination host.

Setting the POP3 Relay

As the relay works in transparent mode, you must write a filtering rule to intercept the POP3 flow sent to

the server and to redirect it towards the relay. In the filtering rule, select a POP3 service for which the

FAST module, and the redirection towards the transparent POP3 relay, have been activated.

Note

For an input flow, the filtering rule can also include a PAT- or Static NAT-translation on a

destination host. Selecting a masquerading translation has no effect on the way it works since

the relay of the Fast360 appliance initiates a new connection toward the POP3 server.

The following relay characteristics must be defined:

• Choice of mode (synchronous or asynchronous)

• Options for antiviral analysis (quarantining, etc.)

Configuring the antivirus POP3 relay is a multi-step procedure that includes the following steps:

• Defining an appropriate service

• Defining an appropriate flow filtering rule

• Activating and configuring the POP3 relay

Defining a Flow for the POP3 Connection

The first step in the configuration of the antivirus POP3 relay is to define a flow to intercept the flow sent

by the client to the POP3 server and redirect it to the POP3 relay.

1. In the default layout, select the Rules navigation tab from the left hand side of the main window.
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2. In the explorer view, create a new rule by right-clicking on the Rules folder, select New > Rule. The

Rule configuration tab is displayed on the right and the entry is displayed in the descriptive view.

3. In the Properties configuration form:

a. Enter the name of the rule (for example, POP3_in) in the Name field.

b. Enter a comment in the Description field.

4. In the Criteria configuration form:

• Drag and drop the destination LAN into the Sources field.

• Drag and drop the Internet object into the Destinations field.

• Drag and drop the POP3_with_proxy service previously created into the Services field.

Note

The Internet and LAN objects have been previously created in the Networks folder of the

Network objects folder.

5. In the Action configuration form:

a. Check the Accept option.

b. Right-click in the blank area of the Rule translations table, select New > Translation Element from

the drop-down menu. The Translation Element dialog box appears.

c. Check the Source translation and Masquerading options.

Note

It is not possible to place a rule authorizing the TCP protocol on the 110 port before the newly

created rule. For more detailed information on this topic, see Section 8.2, “Filtering Rules

Types and Rule Reading Order”.

Activating the Antivirus POP3 Relay

You must set the relay to work in either synchronous, hybrid or asynchronous mode, particularly if the

Fast360 appliance is located between the POP3 relay and the client.

Note

Activating the POP3 relay creates an implicit rule authorizing the Fast360 appliance to send a

POP3 flow to the Internet.

1. In the Mail configuration form, select the POP3 folder. The options to be configured are displayed on

the right.

• Check the Hybrid option to set the relay to work in hybrid mode. In hybrid mode the relay works first

in asynchronous mode (modifying the mail or returning an error) and then switches to synchronous

mode (avoiding timeout problems with large mail) as soon as the mail size is greater than the

threshold.

• Set the threshold in the Asynchronous until  field. The threshold value is defined in Kbytes.

• Check the Repair infected email option if required.

• Check the Enable spam filtering option to embed the POP3 relay with antispam filtering (to set

this antispam filtering, see Section 10.2.3, “Antispam Analysis”).

• Check the Synchronous option to set the relay to work in synchronous mode. Synchronous mode

allows the client to receive messages in real time (there is no need to wait until the Fast360

appliance has reassembled the IP packets). The drawback is the connection will be interrupted

every time an infected file is detected.
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• Check the Asynchronous option to set the relay to work in asynchronous mode. In this mode the

Fast360 appliance has to reassemble the IP packets before delivering the message to the client.

Thus, the message will be delivered to the client mail only if it is virus-free. Its drawback is that

the client mail does not receive any other data while the Fast360 appliance is recuperating the

message. Depending on the application used, the client mail generates a timeout if the message is

too big. If the message is rejected, the recipient receives a warning message.

• Check the Repair infected email option if required.

• Check the Enable spam filtering option to embed the POP3 relay with antispam filtering (to set

this antispam filtering, see Section 10.2.3, “Antispam Analysis”).

• Check the Quarantine option to quarantine the email.

• Check the Remove rejected emails from POP3 server option to completely remove (message and

possible attached file(s)) problematic emails (generally containing a virus). Because some packets

are already loaded by the client mail, corrective action cannot always be performed.

• Check Notify the postmaster to activate this option. The postmaster must be previously defined in

the Postmasters table in the General folder of the Mail configuration tab.

• Select the action you want the relay to perform on encrypted email from the options in the Allow

encrypted files drop-down list.

• Select the action you want the relay to perform on emails which cannot be analyzed from the options

in the Allow non-analyzable files drop-down list.

Note

Even when activated, the quarantine feature cannot perform corrections or automatic routing.

Therefore, the administrator must do it using the  Arkoon Monitoring  tool. Further, as it is often

not possible to open encrypted and non-analyzable files to check their content (as they are often

password protected), the administrator must choose how to treat them using  Arkoon Monitoring .

Antivirus POP3 Relay logging

Checking the Relay

There is no log for the POP3 relay. To check that the POP3 flow has been correctly redirected towards

the relay, see the IP logs to verify that the output interface of the POP3 relay is logged.

In Case of Virus

When a virus is detected, a Virus detected alert is created. If quarantining has been configured, and

provided it is not full, the mail appears in the Quarantine window of the  Arkoon Monitoring  tool.

10.2.3. Antispam Analysis
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Email Security Challenges

Network administrators face ever-increasing numbers of sophisticated email-borne threats to their

networks. Spam emails infiltrate your users' Inbox with unsolicited, often offensive mail, and in the

case of phishing messages are sent with the express intent to defraud. Spammers are more numerous,

more devious, and more malicious, constantly re-inventing ways to evade existing spam detection

systems. Spam outbreaks, whether for commercial or criminal purposes, are characterized by outbreaks

of extremely large amounts of mail messages, released within a short period of time from a network of

“zombie” machines.

The outbreak can contain different types of spam messages, as well as individual messages that combine

a number of anti-detection methods in the same message to complicate the detection process. Common

methods to evade content filters based on lexical analysis include masking the originator or sending

machine of the spammers, manipulating or hiding commercial URLs, use of non-English words and

phrases, use of images.

The Fast360 appliance provides real-time antispam analysis:

Real-time antispam analyzes emails for a unique value which identifies them as part of a spam outbreak.

This section will describe both methods, their relative advantages and disadvantages, and how to

configure the Fast360 appliance to perform these types of antispam analysis.

DNS Blacklists

This section describes the Fast360 DNSBL functionality (DNS-based Blacklists), its principles as well as

its implementation.

DNS blacklists are lists of IP addresses known for propagating spam. They can be queried using the DNS

protocol. The Fast360 SMTP relay can query the list as to whether it should accept or not a mail coming

from a given IP address.

DNSBL Operation

DNSBL Querying

DNSBL querying is done by a simple DNS query. If the address is blacklisted, the server will return as

many records as the number of reasons to blacklist this address: open SMTP relay, open HTTP relay, etc.

These records contain the reason the address has been blocked as well as a URL providing more details.

Example 10.1. DNSBL record

"Blacklisted by dnsbl-domain.zzz (OpenRelay)- http://..."
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DNSBL Servers

There are many DNSBL servers available on the Internet. They do not all have the same policy or the

same methods for adding or removing entries into the blacklist. Therefore, it is important to choose them

carefully.

Depending on the server, IP addresses can be blacklisted for the following reasons:

• Open Proxy Servers (HTTP, SOCKS, etc.)

• Open SMTP Relay

• DialUp Networks

• Vulnerable servers (WWW, RPC, etc.)

• Known spammers

Caution

It is essential that the anti-relaying rules of your Fast360 SMTP relay are well configured;

otherwise, there is a risk that it will be detected as an open relay by one of the servers and then

blacklisted.

Note

The use of the DNS blacklists is based on public servers. It is your decision whether to use them

or not, bearing in mind that a part of the mail processing policy is transferred to an external entity.

Use of DNS Blacklists by Fast360 Appliances

The use of DNSBL servers is integrated into the SMTP relay and makes it possible to block mails relayed

from a questionable origin (blacklisted IP address). This enables you to:

• Refrain from testing some IP addresses (internal servers, for instance)

• Add a whitelist system to avoid blocking legitimate servers that are regularly blacklisted

• Not use DNS blacklists for mails intended for some users

Behavior in the Case of a Blacklisted Address

If the Fast360 appliance denies relaying a mail because of an anti-relaying rule that forbids using

blacklisted addresses, it will generate an SMTP error.

Example 10.2. SMTP Error

220 arkoon hi there
HELO ml
250 arkoon pleased to meet you, ml
MAIL FROM:<user@domain1.com>
250 sender is <user@domain1.com>, sender OK
RCPT TO:<user@domain2.com>
550-Your IP (192.168.1.1) is blacklisted by DNSBL:
550- dnsbl1.zzz [Blacklisted by dnsbl1.zzz - http://...]
550- dnsbl2.zzz [Blacklisted by dnsbl2.zzz (Open Relay) - http://...]
550 Access Denied (mail from <user@domain1.com> to <user@domain2.com>)
QUIT
221 Closing connection

Normally, the transmitting server sends an error message to the mail transmitter indicating that the mail

was denied and gives the reason. This enables the transmitter to take the required measures so that the

IP address of its SMTP relay is no longer blacklisted.
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Example 10.3. SMTP Error Message

This message was created automatically by mail delivery software 
(Exim).
A message that you sent could not be delivered to one or more of its 
recipients.
This is a permanent error. The following address(es) failed:
user@domain2.com
SMTP error from remote mailer after RCPT TO:<user@domain2.com>:
host arkoon [192.168.100.10]: 550-Your IP (192.168.1.1) is blacklisted 
by DNSBL:
550- dnsbl1.zzz [Blacklisted by dnsbl1.zzz - http://...]
550- dnsbl2.zzz [Blacklisted by dnsbl2.zzz (Open Relay) - http://...]
550 Access Denied (mail from <user@domain1.com> to <user@domain2.com>)

Real-time Antispam Analysis

The Fast360 appliance also offers a real-time antispam engine to filter and block spam email. The engine

uses a central datacenter which collects and analyzes message patterns in email messages in order to

rate their “spam score”.

Real-time Antispam Technology

The Fast360 real-time antispam mechanism uses message patterns to detect mails belonging to part

of a spam outbreak. Although spammers use a combination of mails composed of different spamming

techniques to avoid content filters, all messages within the same spam attack share at least one unique

value that can be used to identify them as belonging to that outbreak. For example, different spam attacks

launched from the same network of zombie machines and phishing messages leading recipients to the

same faked URLs would be classified as recurring values, “message patterns” of typical outbreaks.

Fast360 Real-time Antispam Mechanism

The antispam engine extracts the message patterns from the message envelope, headers, and body. As

the mechanism does not rely on message content analysis, it can detect spam and phishing methods

in any language or format, including images, HTML etc. The antispam engine then classifies both

distribution patterns (way it is distributed to the recipients) and structure (volume of the distribution)

patterns to determine whether the message poses a threat or not. This information is stored in the

datacenter's repository of threat patterns. New messages arriving at the SMTP server are passed

to the antispam engine for analysis. The antispam engine sends a query containing a collection of

hash signatures representing patterns of the message to the datacenter. The datacenter classifies

the message patterns and sends this classification (“spam score”) back to the antispam engine. The

antispam engine applies predefined rules (tag, reject, quarantine) to the message according to its

classification:

• Confirmed Spam: spam messages from known spam sources, e.g. zombies.

• Bulk: spam messages from sources that are not confirmed spammers.

• Suspected Spam: legitimate messages that are sent to a slightly larger than average distribution or

are unidentified spam messages in the first few seconds of a massive spam outbreak.

• Unknown: messages for which the antispam engine does not have any incriminating information, and

are therefore assumed to represent legitimate correspondence.

• Non-Spam: messages that are confirmed, without doubt, as coming from trusted source. Note, this

classification is rarely used.

The antispam engine stores the information in a local detection cache which makes future local

classification more efficient and also can be used in case communication with the datacenter is

temporarily unavailable when incoming messages still need to be classified. Note, information from the
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messages handled by the antispam engine is not conveyed transparently between the Fast360 appliance

and the datacenter repository as the antispam engine only sends a hash of the message, from which the

actual information cannot be reconstructed.

Customer privacy is protected as the datacenter processes are fully automated, require no manual or

human intervention and do not hold or reuse any information from the message content to improve

its performance. For customers who wish an enhanced privacy solution, the antispam engine can be

configured to hash descriptive information about the message in the one-way hashing, MD5 algorithm.

Further, no data from the query is stored on any server or database at the datacenter unless explicitly

requested.

The following diagram illustrates a typical case of inbound email analysis by the antispam engine.

Figure 10.4. Inbound Email Analysis by the Antispam Engine

Note

The following information is added to any analyzed email in the form of SMTP headers:

• Version of the antispam engine, for example:
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X-F360-PVer: 0000001

• Spam classification result, for example:

X-F360-Spam: Confirmed

In case of classification error, the following X-F360-Spam header is used (the others remain

empty):

X-F360-Spam: Analysis Error

• Reference ID of the current spam analysis. This ID will be used if the email later requires

reclassification. For example:

X-F360_REFID: str=0001.0A090204.43D8B3EB.0038,ss=4,vl=2,fgs=0

Benefits of Real-time Antispam Technology

The immediate response of the real-time antispam engine means that it is very effective at limiting the

damage that spam attacks can cause as typically it is able to classify and block any messages before

they reach recipients within the first few minutes of the outbreak. As the mechanism does not analyze

the content of the message, the number of false positives is greatly reduced.

Using our real-time antispam technology, the Arkoon Fast360 appliance provides:

• High detection rates, due to the real-time database

• Effective protection against all types of spam, including HTML, UTF-16, Chinese characters, etc.

• Detection and protection against “image spam”.

Configuring the Real-time Antispam Engine

1. In the default layout, select the Policies navigation tab from the left hand side of the main window.

2. In the explorer view, create a new real-time antispam policy by right-clicking on the Antispam Policies

folder, New > Real-time antispam. Three levels of filtering are available, with pre-configured tagging,

reject and quarantine settings:

• Real-time antispam (Agressive)

• Tagging threshold is set to “suspected spam” by default.

• Reject threshold is set to “bulk” by default.

• Quarantine threshold is set to “bulk” by default.

• Real-time antispam (Normal)

• Tagging threshold is set to “bulk” by default.

• Reject threshold is set to “confirmed spam” by default.

• Quarantine threshold is set to “bulk” by default.

• Real-time antispam (Low)

• Tagging threshold is set to “confirmed spam” by default.

• Reject threshold is set to “confirmed spam” by default.

• Quarantine threshold is set to “bulk” by default.

3. In the Properties configuration form of the desired real-time antispam policy, enter an appropriate

name and short description in the corresponding fields.
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4. In the General configuration form:

a. Define the maximum size of the message analyzed by the antispam engine in the Email maximum

size field. Most spam is less than 64 kB (spam merchants do not want to overload their own servers

by sending out large files). Note, the setting of this threshold has a slight impact on the process

time of the antispam engine.

b. In the Threshold field, alter if required the default setting to tag mail according to the policy.

Any mail scoring less than this value is forwarded without any further treatment by the Fast360

appliance.

c. Check the Reject option to enable the Fast360 appliance to immediately reject the receipt of a mail

scoring above the reject threshold. If the email address is legitimate, the submitter will receive a

bounce message notification submitted by the mail gateway which attempted to submit the mail

(reject reason is notified: considered as spam). This option prevents abusive use of resources

(forwarding, antivirus analysis, submit of DNS if the recipient does not exist, etc.) when there is a

strong probability that the message is spam.

d. Check the Enable quarantine option:

i. In the Quarantine threshold field, specify the threshold above which mail is forwarded to the

quarantine mailbox instead of being forwarded to intended recipients. The quarantine threshold

must be equal or greater than the tagging threshold.

ii. Enter the quarantine mailbox address in the corresponding field.

Note

Mail is sent to the quarantine mailbox tagged as spam because the quarantine threshold

is equal or greater than the tagging threshold. The RCPT TO header is modified with the

address of the quarantine mailbox, and all the original recipients' addresses, including

“hidden” (i.e. cc, bcc) recipients are listed in a customer XSpamRcpt header.

5. In the Tagging configuration form:

a. Check the Add prefix to email subject option and select either the default text [SPAM] or add text

in the corresponding field to appear in the mail subject if desired.

b. Check the Encapsulate mail option to enable the antispam engine to rewrite messages considered

as spam and encapsulate the original message in an attached file. When a spam message is

encapsulated, a new multipart message is generated. Its subject is modified with a prefix if the

Add prefix to email subject option is enabled. The message contains a generic text (that can be

modified, see below). The multipart message is followed by a report detailing the technical rules

which deemed the message to be spam. The original message is appended as an attached file.

i. Check the Customize default report option and add the text in the corresponding field to

customize the standard explanation for mail encapsulation.

Note

Encapsulating spam increases security and protection against spam. By placing the

spam content in an attached file, images can only be seen if specifically desired.

External/attached HTML objects are not downloaded either.

6. Select the Proxy configuration form:

a. If desired, check the Use HTTP proxy option and drag and drop a host object to serve as a proxy to

contact the datacenter into the HTTP proxy field. Note, the HTTP proxy capacity must be configured

in the Services configuration form of the host serving as the proxy.

b. Check the Enable authentication option and enter the user's name, password and confirm the

password in the corresponding fields.

7. Select the Mail configuration form from the Fast360 appliance configuration tab.
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8. Select the Antispam folder.

9. Drag and drop the previously configured Real-time antispam policy from the descriptive view into the

Antispam policy field of the Antispam folder.

Configuring Email Clients to Manage Tagged Spam

The Fast360  antispam engine tags the subject line of suspect emails. This means that email clients can

identify and filter them automatically. The default tag is « [SPAM] » - you can change this using  Arkoon

Manager

Note

If you have users who do not want to use the antispam facility, do not set a message rejection

threshold for them, and do not configure their mail client to filter out potential spam. In this way,

your remaining users continue to benefit from antispam filtering.

It is easy to configure mail clients to move messages tagged as spam to a specified directory. Below are

two examples – most mail clients behave in a similar way.

Configuring a Thunderbird (V. 8.0) Message Client

1. Choose Message Filters from the Tools menu

2. Click New. Give your filter a name, for example « antispam filter ». Choose subject, contains from the

drop-down menus, and enter the appropriate tag in the next field.

3. Choose Copy to folder from the Perform these actions drop-down menu and select or create a

directory.

Configuring an Outlook ® 2003 Client

1. Choose Rules and Alerts from the Tools menu, then click on New rule.

2. Next choose Start creating a rule from a template and Move messages with specific words to a

folder. In the bottom pane, click on Specific words.

3. Enter the prefix you configured using the  Arkoon Manager  (for example [SPAM]) in the Specify words

or phrases to search for in the subject field of the Search text window.

4. Then specify the folder to move the mail to, for example Junk Email.

Note

Some mail clients have a built-in antispam capability. Trying to combine Fast360 antispam with a

mail client’s antispam can lead to confusion in filtering rules and is not recommended.

10.3. File transfer protection

10.3.1. FTP Relay Configuration

To activate an FTP relay, you must:

• Define the DNS of the Fast360 appliance so that it can send DNS requests.
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• Set the relay characteristics.

Setting the FTP Relay

Defining the characteristics of an FTP relay is a multi-step procedure.

The following FTP relay configuration parameters are described in detail in this section:

• Access port and connection values

• Authorized port

• Authorized networks/interfaces

• Relay chaining

• Authentication

Configuring Access Port and Connection Values

1. In the Network objects explorer view, double-click on the Fast360 appliance icon. The Fast360

appliance configuration tab is displayed on the right.

2. Select the Web configuration form.

3. Check the FTP folder. In the Listening Port field now available to the right, enter the port of the FTP

relay.

4. Expand the FTP tree and select the Advanced option. The fields to be configured are now available

on the right.

a. Set the command timeout in the corresponding field. This value is the time (in seconds) after which

a command submitted to a server is considered to have failed. By default, this value is 300 seconds.

b. Set the transfer timeout in the corresponding field. This value is the time (in seconds) after which

a transfer from a server is considered to have failed. By default, this value is 200 seconds.

Note

Both timeouts are also used if the FTP client or FTP server are inactive.

c. In the  Maximum number of processes field, specify the maximum number of simultaneous

connections on the FTP server.

Note

By default, port 21 is the only authorized port on the final FTP server. To define other ports,

see the section called “Configuring Authorized Port”.

d. Select the log level from the drop-down list.

Configuring Authorized Port

By default, port 21 is the only authorized port on the final FTP server. It is possible to specify other

authorized ports.

1. Select the Authorized Ports option.

2. To specify authorized ports other than port 21, check the Authorize customer FTP ports option.

3. Right-click in the empty Custom FTP ports table, select New > Port. A port entry is displayed in the

table.
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4. Right-click on the entry in the port column, select Modify Port and enter the port number.

Note

Specifying the authorized ports defines in itself an implicit rule authorizing the Fast360 appliance

to connect to the FTP server by the defined ports. For more information on implicit rules, see

Section 8.4, “Implicit Filtering Rules”.

Configuring Authorized Networks/Interfaces

1. Select the Authorized Networks option.

2. In the Interfaces  field, drag and drop the interfaces which the authorized machines will connect to.

Note, the interfaces have been previously configured in the Interfaces folder.

3. In the Networks field, drag and drop the network objects (representing networks, machines and

machines groups) authorized to use the relay's functionality. Note the network objects have been

previously defined in the Hosts folder (for machines), in the Networks folder or in the Network objects

groups folder (for networks or groups of machines).

Note

Specifying the authorized networks and connection interfaces defines an implicit rule authorizing

the networks to access the Fast360 appliance on port 2370 by default. This implicit rule is read

after rules defined in  Arkoon Manager . For more information on implicit rules, see Section 8.4,

“Implicit Filtering Rules”.

Configuring Relay Chaining

1. Select the Chaining option.

2. Check the FTP proxy chaining option.

3. In the Chained FTP proxy field, drag and drop the host that will serve as a relay.

4. Double-click on the host object. The Host configuration tab is displayed.

5. Select the Services configuration form.

6. Check the FTP Proxy option and select the port on which the connection is to be established.

Configuring Authentication

1. Select the Authentication option.

2. To activate authentication for the FTP relay, check the Enable Authentication option.

• To use a local server, check the Use local server option.

• To use a specific server:

a. Check the Use external authentication server option and then drag and drop the server object

(host) into the Authentication servers field. Note, the host object should have been previously

configured with the corresponding server capability in its Services configuration form.

b. Select the type of authentication server from the Authentication type drop-down list. This choice

must match the server capability of the host selected in the Authentication servers field.

Note

The authentication settings for the FTP relay are:

Login: server_user@firewall_user@serveur-ftp.com

Password: server_password@firewall_password
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10.3.2. Antivirus analysis

1. Select Antivirus in the FTP tree view.

2. To apply antivirus analysis of all files transferred via the FTP relay, check the Enable FTP antivirus

analysis (classic antivirus) option. The classic antivirus uses an engine on the appliance and

downloaded local databases.

3. To allow encrypted files through without antivirus checking, check Allow Encrypted Files options.
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Chapter 11. FAST and IDPS

 This chapter looks at how to configure the Fast360 appliance to provide advanced traffic filtering

using Fast Applicative Shield Technology for real-time contextual analysis of network traffic at the

application layer.

11.1. FAST Analysis

An Arkoon Fast360 appliance contains Fast Applicative Shield Technology (FAST) providing contextual

analysis of traffic at the application layer, in real time. FAST modules protect the security of your network

by providing three types of analysis:

• RFC conformance

Checks that traffic conforms with the relevant RFC; protects against threats using data that does not

conform, including redirection, call interception, denial of service on VOIP, and Trojan horse attacks

with binary data in HTTP headers.

• Normal use of protocol

Checks that traffic not only conforms to the RFC but also meets the normal usage patterns for the

protocol; protects against attacks or intrusive behaviors that do not violate RFCs. Such threats include

insertion of malicious data in URLs, masquerading through the use of hidden scripts in HTTP requests,

and abuse of encapsulated protocols.

• Additional rules on protocol

Checks traffic against a set of limits or rules, providing additional protection against attacks. You can

configure rules to ban or limit commands in a protocol, limit the size of commands or parameters, and

to filter downloaded files.

The analysis of a packet is done automatically up to layers 3 and 4, which form the Transport layer.

However, it is done at the application layer for the services on which a FAST module is selected.

Therefore, it is essential that the filtering rule acknowledging the packet specifies this service.

FAST modules are available for the following application layer protocols: DNS (TCP), DNS (UDP), FTP,

H323, HTTP, IMAP4, MGCP, Netbios Datagram Service (UDP), Netbios Name Service (UDP), Netbios

Session Service (TCP), NNTP, POP3, RTSP, SSL/TLS, SIP, SMTP, SNMP and SQL*NET/Net9.

The Fast360 appliance provides standard FAST modules to handle common protocols. They are listed in

the Arkoon FAST policies in the FAST policies navigation tab. You can also create your own FAST module,

as described in Section 11.1.1, “Creating a custom FAST module”.

See Section 11.1.2, “Standard FAST modules” for detailed information on the behavior of the standard

FAST modules and how to configure them.
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11.1.1. Creating a custom FAST module

This section describes the main four stages of the creation of a custom FAST module:

1. Creating a custom service.

2. Activating the FAST analysis in the custom service.

3. Creating a custom FAST policy and configuring the FAST reaction in case of protocol violation.

4. Configuring the FAST IDPS protection (optional). For more information, refer to Section 11.2, “IDPS”.

Creating a Custom Service

The Services navigation tab in Arkoon Manager is used to manage services. The services indicate

network/transport level (TCP, UDP, ICMP, etc.) or applicative (FTP, SMTP, etc.) protocols.

Many services are already configured on the Fast360 appliance, but you can also create new ones

according to your needs.

1. In the default layout in Arkoon Manager, select the Services navigation tab from the left hand side

of the main window.

2. In the explorer view, expand the Custom Services tree.

3. Create a new service by right-clicking on the desired transport protocol (TCP, UDP, ICMP) or Other

services, select New > Custom Protocol Name Service . The Custom Protocol Name Service

configuration tab is displayed on the right.

4. In the Properties configuration form, enter a name and a short description.

5. Configure the port for the service:

• For transport protocols TCP and UDP, select the General configuration form.

a. Enter the port number to attribute to the defined service in the From and To fields of the

Destination ports section. Enter the same value twice, or configure a ports range with two

different values.

b. Enter the ports' source number/range in the From and To fields of the Source ports section if you

need to force the source ports of certain specific applications.

c. If required for the TCP protocol, check the Redirect to option and select which relay to use in

transparent mode (HTTP, FTP or POP3).

• When configuring the ICMP service, select the ServiceIcmp configuration form, enter the type of

message and code in the corresponding fields. There is no value in creating services for ICMP error

messages as they are managed by the ICMP policy. For more information on the ICMP policy, refer

to Section 8.5.3, “Managing ICMP Policies”.

• If you are configuring a service other than TCP/UDP/ICMP, enter the protocol number in the

corresponding field of the Protocol configuration form.

6. Select the Security configuration form.

a. To disable the checksum, check the corresponding option.

Caution

Disabling the checksum reduces the security controls performed by the layer 4 protocol

analysis. This option must be enabled if requested by the Arkoon support in very specific

cases.
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b. To establish another active connection timeout than the default one, enable the Custom connection

timeout option and define its value in the corresponding field.

Note

By default, the connection closes if it inactive. Redefining the timeout allows you to reduce

or increase this value.

Configuring the FAST Analysis (TCP and UDP services only)

The FAST analysis is automatically done up to layers 3 and 4 (transport layer). It is carried out at the

applicative level only for the services for which a FAST module is selected.

The FAST modules are available for the following applicative protocols: DNS (TCP), DNS (UDP), FTP, H323,

HTTP, IMAP4, MGCP, Netbios Datagram Service (UDP), Netbios Name Service (UDP), Netbios Session

Service (TCP), NNTP, POP3, RTSP, SSL/TLS, SIP, SMTP, SNMP v1, v2c and v3 (UDP) and SQL*NET/Net9.

Note

In the default configuration, the protocols for which a FAST module exists are predefined with

the FAST module enabled.

Caution

The FAST analysis is performed up to the applicative level only if the filtering rule accepting the

packet specifies a service with a FAST module.

Each FAST module presents specific options which can be parameterized for two distinct purposes:

• To fit the behavior of the FAST analysis to drop an application (which does not respect the RFC

recommendations).

• To improve the FAST analysis to face specific vulnerabilities.

1. Select the FAST configuration form in the relevant TCP or UDP custom service.

2. Check the Enable FAST analysis option.

3. Drag and drop the FAST policy object into the FAST Policy field.

4. To modify the FAST policy, double-click its icon in the FAST Policy field. The  FAST Policy configuration

tab is displayed.

Creating a Custom FAST Policy and Configuring the FAST Reaction

1. In the default layout in Arkoon Manager, select the FAST Policies navigation tab from the left hand

side of the main window.

2. In the explorer view, expand the Custom FAST Policies tree.

3. Drag and drop the Arkoon FAST policy you want to customize in the folder Custom FAST Policies.

Double-click the policy to edit.

4. In the Properties configuration form, enter a name and short description in the corresponding fields.

This form also contains the FAST module type.

5. In the FAST Policy configuration form, configure the reaction implemented by the Fast360 appliance

in case of protocol violation. Select the reaction from the three options of the drop-down list:

• RESET (TCP protocol only): a TCP RST packet is sent to both the attacker and the target.
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The RESET response is recommended in the case of a safe connection. If a user has entered a

command not authorized in the RFCs, it is better to close the connection with an error message

than obtain a timeout. However, a RESET response may also alert the attacker to the presence of

the IDPS defence, allowing them to alter their attack. For more information about IDPS, refer to

Section 11.2, “IDPS”.

• DROP: the connection status becomes DROPPED on both attacker and attacked sides; packets sent

later that correspond to this connection are ignored.

If IDPS is used, the DROP response silently aborts the connection without betraying the IDPS

presence to the attacker. However, it does not free the resources associated with the connection

on the attacked machine's side (since the connection remains open).

Note

When a connection is in DROPPED status, it remains in this status for 60 minutes before

disappearing from the connections table.

• HALF-DROP (TCP protocol only): the connection status becomes DROPPED only on the attacker's

side; packets sent later by the attacker are ignored while a TCP RST packet is sent to the attacked.

If IDPS is used, the HALF-DROP reaction is a compromise between the two previous reactions. It

frees the resources of the attacked host without betraying the IDPS presence.

6. To modify a FAST option:

a. In the FAST Options table, right-click on the option that you want to modify, select Edit from the

drop-down menu. A pop-up window is displayed.

b. Modify the value in the Parameters field.

Configuring the FAST IDPS Protection

For information about IDPS, refer to Section 11.2, “IDPS”.

1. In the IDPS configuration form of the relevant FAST Policy object, check the IDPS option.

2. Drag and drop the IDPS profile into the Profiles field. The IDPS profile has been created previously in

the Profiles folder of the IDPS navigation tab.

3. To use the default IDPS mode, uncheck the IDPS Custom Mode option. To use a specific mode, check

this option:

• If you do not want alerts, check the Warn only option

• To receive alerts, check the Abort connection when threshold is reached option and define the

alert threshold in the corresponding Threshold field.

Note

The default mode has a threshold of 40 alerts.
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Grouping Services

Arkoon Manager  allows you to group services, for instance, you can group services used by the same

application.

1. In the Services explorer view, drag and drop the services to be grouped from the descriptive view

into the Services groups folder.

2. To view the grouped services, click on the Services groups folder in the explorer view; the group

services are displayed in the descriptive view.

11.1.2. Standard FAST modules

FAST DNS Module

General Behavior

The DNS protocol can be used on TCP and UDP protocols at the same time and always appears the same

way. The FAST module allows you to manage the DNS protocol on these two transport protocols.

Table 11.1. DNS Header

Identification Parameters

Number of Questions (Queries) Number of Answers

Number of Authorities Number of Additional pieces of

information

The DNS header analyzes the rest of the packet that contains the various Queries, Answers and

Additional pieces of information. The Identification field relates the answers to the queries.

The FAST module analyzes the header's validity as well as the DNS information and ensures that the

packet is coherent with the data that has already been transferred. In particular, it checks if an answer

corresponds to an emitted query . For the UDP protocol (not connected), the active connection is closed

as soon as the server has sent all the answers.

Example of Communication

Example 11.1. DNS Query for www.arkoon.net

Domain Name System (query)
Transaction ID: 0x0002
Flags: 0x0100 (Standard query)
0... .... .... .... = Response: Message is a query
.000 0... .... .... = Opcode: Standard query (0)
.... ..0. .... .... = Truncated: Message is not truncated
.... ...1 .... .... = Recursion desired: Do query recursively
.... .... ...0 .... = Non-authenticated data OK: Non-authenticated data
is unacceptable
Questions: 1
Answer RRs: 0
Authority RRs: 0
Additional RRs: 0
Queries
www.arkoon.net type A, class inet
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Example 11.2. DNS Answer for www.arkoon.net

Domain Name System (response)
Transaction ID: 0x0002
Flags: 0x8580 (Standard query)
1... .... .... .... = Response: Message is a query
.000 0... .... .... = Opcode: Standard query (0)
.... .1.. .... .... = Authoritative: Server is an authority for domain
.... ..0. .... .... = Truncated: Message is not truncated
.... ...1 .... .... = Recursion desired: Do query recursively
.... .... 1... .... = Recursion available: Server can do recursive 
queries
.... .... ..0. .... = Answer authenticated: Answer/authority portion
was not authenticated by the server
.... .... .... 0000 = Reply code: No error (0)
Questions: 1
Answer RRs: 2
Authority RRs: 3
Additional RRs: 3
Queries
www.arkoon.net type A, class inet
Answers
 www.arkoon.net type A, class inet, addr 195.167.226.90
 www.arkoon.net type A, class inet, addr 195.167.226.91
Authoritative nameservers
 arkoon.net: type NS, class inet, ns ns02.arkoon.net
 arkoon.net: type NS, class inet, ns ns03.arkoon.net
 arkoon.net: type NS, class inet, ns ns01.arkoon.net
Additional records
 ns ns02.arkoon.net: type A, class inet, addr 195.167.226.90
 ns ns03.arkoon.net: type A, class inet, addr 195.167.226.91
 ns ns01.arkoon.net: type A, class inet, addr 62.161.237.194

Specific Actions

Description of the Connection

The FAST module matches a description to an active connection. This description can be seen in the

Active connections window of  Arkoon Monitoring . The description used by the DNS module recalls the

information specific to the current query. It can evolve during the exchange and can have the following

format:

[DNS] Request type 1 for www.arkoon.net.
[DNS] Request type 12 for 1.0.168.192.in-addr.arpa.

Implicitly Authorized Types and Classes

The only types of queries that are implicitly authorized are those that are known and concerned by the

IANA (Internet Assigned Numbers Authority): from 1 to 42 and from 249 to 255.

Protocol Options

The protocol options (defined in  Arkoon Manager ) allow you to define the behavior of the module more

accurately. The following options can be used for the TCP version of the FAST DNS module:

• type_allow

Types of authorized queries in addition to default ones. type_only_allow and type_forbidden

options override type_allow.

Format: list of integers.

• type_only_allow

Only types of authorized queries. The others provoke an inter-application.

Format: list of integers.

• type_forbidden
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Types of forbidden queries. They provoke a protocol violation. type_forbidden option

overridestype_only_allow (a type defined in both options will be denied).

Format: list of integers.

• class_allow

Authorized classes in addition to default ones. class_only_allow and class_forbidden options

override class_allow.

Format: list of integers.

• class_only_allow

Only classes authorized. The others provoke a protocol violation when used.

Format: list of integers.

• class_forbidden

Forbidden classes. They provoke a protocol violation. class_forbidden option overrides

class_only_allow  (a class defined in both options will be denied).

Format: list of integers.

The following options can be used for the TCP version of the FAST DNS module:

• no-rand-snat-port

Used to disable the default behavior that randomizes the source port used to masquerade FAST DNS-

UDP connections for static translations when the source port is modified.

Format: Boolean

• rand-query-id

Used to replace each DNS request ID by a new and properly randomized ID. This option can be used

if clients or servers use weak DNS implementations which lead to predictable IDs. Option disabled

by default.

Format: Boolean

• max-subseq-unknown-id

Used to suppress all pending DNS requests in case too many unsolicited answers are received. This

option makes it possible to detect and block a cache poisoning attempt by cancelling all pending DNS

requests sharing the same connection parameters (IP/ports). Option disabled by default.

Format: String

Protocol Violations of the DNS Analysis

The FAST DNS module can cut the connection during the DNS analysis in the cases listed below. The

message(s) that will appear in the IP Logs Description column, as well as in the Alerts, are indicated in

parentheses.

• DNS header or content too short (DNS packet too short (xx bytes) / Bad DNS Packet – too short(xx) /

DNS message too short (xx bytes))
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• DNS packet (UDP) too long (DNS packet too long (xx bytes))

• Invalid DNS packet (decode_packet returned BAD Packet / Bad DNS packet)

• Answer without a query (DNS Packet response without any query [id=xx])

• Exchange invalid state (Wrong DNS packet [xxx] / Unknown DNS state: xx)

• Unknown type (Unknown type xx)

• Unknown class (Unknown class xx)

Violations of the Protocol Options

The FAST DNS module can cut the connection depending on the protocol options configured in the case

listed below. The messages that appear in the IP Logs Description column as well as in the Alerts are

indicated in parentheses.

• Packet denied by the protocol options (decode_packet returned denied by options / DNS packet denied

by options)

Example of Configuring the Protocol Options

In general, zone transfers should only be accepted once the DNS is authorized.

This way, you can create two dnstcp services:

• dnstcp with zone transfer: this is the standard FAST DNSTCP module

• dnstcp without zone transfer: the option type_forbidden is configured with the query number 252 (AXFR

type, which corresponds to a complete zone transfer).

The filtering rules will then have to specify the appropriate service depending on the specific source and

destinations.

Standards Documents

The DNS protocol is described in the following documents:

• RFC 1034 - Domain Names - Concept and facilities - November 1987

• RFC 1035 - Domain Names - Implementation and specification - November 1987

• RFC 2671 - Extension Mechanisms for DNS (EDNS0) - August 1999

FAST FTP Module

General Behavior
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Controls over the Client-to-Server Data

Each FTP command sent from the client to the server has the following format: command + optional

parameter (separated by a space) + CR + LF.

Example 11.3. Client-to-Server Data

HELP\r\n
USER anonymous\r\n
TYPE I\r\n

The FAST module executes the following controls over the Client-to-Server data:

1. Verify the general format of the command (command, arguments, CR+LF).

2. Verify if the command is authorized.

3. Verify the delimiter and the arguments used depending on the command.

The list of the implicitly authorized commands is extracted from the various RFCs and drafts:

• RFC 959: USER, PASS, ACCT, CWD, CDUP, SMNT, QUIT, REIN, PORT, PASV, TYPE, STRU, MODE, RETR, STOR,

STOU, APPE, ALLO, REST, RNFR, RNTO, ABOR, DELE, RMD, MKD, PWD, LIST, NLST, SITE, SYST, STAT, HELP

and NOOP

• RFC 765: XMKD, XRMD, XPWD and XCUP

• FTPEXT: MDTM, SIZE, FEAT, MLST, MLSD and OPTS

The commands specified for RFC 765 correspond to the commands eliminated in RFC 959 but that are still

used by some FTP clients. The list of authorized commands can be modified with the protocol options

cmd_allow, cmd_forbidden and cmd_refuse.

Verification of Server-to-Client Data

The answers sent by the server always have three digits, a space or a hyphen (-), text and CR+LF end-

of-line characters.

The text is intended for the user only and does not intervene in the protocol (except for the PASV

command). The hyphen allows the same answer to be sent on several lines (only the last one uses the

space character).

Example 11.4. Server-to-Client Data

220 ProFTPD Server [ftp.arkoon.net]\r\n
214-The following commands are recognized\r\n
214- USER PASS ACCT ...\r\n
214-[..snip..]\r\n
214 Direct comments to test@arkoon.net\r\n

The first digit of the answer (that must be between 1 and 5) identifies the answer.

1yz Preliminary positive answer

2yz Definitive positive answer

3yz Intermediate positive answer

4yz Temporary negative answer

5yz Definitive negative answer

Any command initiated by the client must finish with a type 2, 4 or 5 answer. This allows the exchange to

be tracked and to differentiate between successful and unsuccessful commands.
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Note

When connected, the server sends an answer in the form of a home banner.

Exchange Tracking

The exchange tracking (command/answer) executed by the FAST module adds a specific control on

various commands.

PORT

The PORT command is used to connect active data, i.e. the data connection is established by the server.

The command parameters contain the IP address and the port to which the server will connect. Even if

the client can (RFC765/957) indicate another IP address than its own, this is often used to launch "bounce"

attacks (RFC2577). Thus, the FAST module forbids the use of another IP address than the client's and the

use of a port below 1024.

In the case of a connection that translates the client's IP address or port, the FAST module modifies the

parameters of the PORT command so that the connection is established.

PASV

The PASV command is used to implement connection of passive data, i.e. the data connection is

established by the client. The IP address and the port are transmitted to the client in the answer to the

PASV command (this is the only case where the text of the answer intervenes with the protocol).

Example 11.5. PASV

227 Entering passive mode (10,10,1,40,4,41)

As for the PORT command, the FAST module forbids the use of another IP address than the server's and

the use of a port below 1024.

For a connection that translates the server's IP address or port, the FAST module modifies the parameters

of the PASV command so that the connection is established.

To avoid any data leak in the case where the client could desynchronize the server's answers

(possible with some implementations), the FAST module implicitly forbids (except when using the

option allow_everything_in_reply) a PASV-type answer in an answer that does not correspond to a

command PASV.

USER

The USER command, used to authenticate on the server, is analyzed when the protocol options

user_allow or user_refuse are used. If an unwanted user tries to authenticate, the FAST module

rejects the authentication attempt (500 user refused) without transmitting it to the server. This filters the

authorized users at the Fast360 level.
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RETR/STOR/STOU/APPE/LIST/NLST

These commands indicate a data transfer via a data connection established by the PORT or PASV

commands. Thus, the FAST module can match the data connection with the type (and eventually the file

name) of transiting data.

REIN

The REIN command resets the exchange. If the command is accepted, the FAST module cancels all the

current negotiations (user authenticated and data connection negotiated).

SYST

The answer of the SYST command can contain information on the nature of the server. If the option

hide_syst is used, the FAST module can replace the server's answer by one determined by the

Administrator.

Telnet Interruptions

The client can send Telnet interruption characters in the command connection instead of a command

(for instance, to order the server to interrupt a transfer). These Telnet interruption characters contain

two bytes, the first of which is 0xFF. The FAST module accepts these interruption characters and lets

them go through.

Example of Standard Connection

The example below illustrates the download of a file called README on the ftp server ftp2.proxad.net.

220 ProFTPD 1.2.1 Server (ProFTPD) [ftp2.proxad.net]
USER anonymous
331 Anonymous login ok, send your complete email address as your 
password.
PASS ftpvuser@unknown.com
230 Anonymous access granted, restrictions apply.
PWD
257 "/" is current directory.
TYPE I
200 Type set to I.
PORT 172,20,33,1,14,99
200 PORT command successful.
RETR README
150 Opening BINARY mode data connection for README (98 bytes).
226 Transfer complete.Received 98 bytes.
Transfer buffer size 5 120 bytes.
Transfer time: 00:00:04; 24,50bytes/sec
QUIT
221 Goodbye.

Specific Actions

Data Connections

The FAST module creates and closes the active transfer connections during the exchange. If a data

connection is not used while another is negotiated, the first is cut. When the command connection is

closed (by the client or during an protocol violation) any unused data connection is also cut.

In the case of the PORT command, the connection is created between the server's IP address + the client's

default port and IP address + the port specified as a parameter. The server's default port corresponds

to the one that is immediately below the command connection port (except when using the option

active_ftp_force_sport). The connection is created while the client sends a transfer command.
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In the case of the PASV command, the connection is created between the client's IP address and the

server's IP address + the port specified in the answer. The connection is created while the server sends

the answer to the PASV command.

Description of the Connection

The FAST module matches a description to an active connection. This description can be seen in

the Active connections window of the  Arkoon Monitoring . The description used by the FTP module

recalls the authentication information for the command connection and the transfer information for

the data connection. In the case of an anonymous connection (anonymous user or ftp), the password

(corresponding to the email address) appears.

Example 11.6. FTP Connection

[FTP] user test
[FTP] user anonymous [test@arkoon.net]
[FTP-DATA] LIST 
[FTP-DATA] RETR rfc-959.gz 
[FTP-DATA] STOR arkoon-3_0.tar.gz

Protocol Options

The protocol options (defined in  Arkoon Manager ) allow you to control the behavior of the module more

accurately. Here are the available options:

• cmd_allow

Additional commands to be authorized by the module. This option allows authorizing proprietary

commands used by some editors. The options cmd_only_allow and cmd_forbidden override

cmd_allow.

Format: list of character strings (commands).

• cmd_only_allow

Only commands authorized by the module. All the others are considered an protocol violation and the

connection will be cut.

Format: list of character strings (commands).

• cmd_forbidden

Commands (standard) that should not be used. The FAST FTP module considers the use of one of these

commands as an protocol violation and cuts the connection. The option cmd_forbidden overrides the

options cmd_only_allow (a command appearing in both will be forbidden) and cmd_refuse.

Format: list of character strings (commands)

• cmd_refuse

Commands that should not be transmitted to the server but that must not cut the connection. In such

a case, the FAST module sends a negative answer (500 command refused) to the client. No trace is

generated in this case.

Format: list of character strings (commands).

• user_allow
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List of the only users authorized to connect. Others are denied (500 user refused) by the FAST FTP

module.

Format: list of character strings (login names).

• user_refuse

List of the users unauthorized to connect. The FAST module sends a negative answer (500 user refused)

to the client. No trace is generated in this case.

Format: list of character strings (login names).

• hide_banner

Hides the home banner sent by the server via a string chosen by the Administrator.

Format: character string to be used as a banner.

• hide_syst

Hides the answer to the SYST command via a string chosen by the Administrator.

Format: character string (answer to the SYST command to be sent back)

• max_command_size

Maximum size authorized for a command and its parameters.

Format: integer (maximum size).

• allow_everything_in_reply

Deactivates the protection against information leak (PASV type) in an answer that does not correspond

to a PASV command.

Format: boolean.

• active_ftp_force_sport

Changes the default port used by the server in the case of the PORT command. If the 0 value is used,

all the source ports will be accepted.

Format: integer (source port to be used or 0 for all the ports)

Protocol Violations of the FTP Analysis

The FAST FTP module can cut the connection during the FTP analysis in the case listed below. The

messages that appear in the IP Logs Description column as well as in the Alerts are indicated in

parentheses.

• Invalid format of a command (can't find end of command (\r) / can't find end of command (\n-1))

• Impossible to find the command (can't find command (x char))

• Use of an unknown command (invalid command xxx)

• No space or end of line after a command (garbage behind command xxx)

• Use of parameters for a command that does not accept them (No params allowed for cmd xxx)

• No parameter for a command requiring one (Params needed for cmd xxx)
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• Invalid format of the PORT parameters (Invalid PORT param)

• Invalid IP address in the PORT command (Invalid PORT dest IP: xx.xx.xx.xx)

• Invalid port in the PORT command (Invalid PORT dest port: xx)

• Invalid format of the answer to the PASV command (Invalid PASV reply)

• Invalid IP address in the answer to the PASV command (Invalid PASV dest IP: xx.xx.xx.xx)

• Invalid port in the answer to the PASV command (Invalid PASV dest port: xx)

• Information leak detected ((xx,xx,xx,xx,xx,xx) detected in reply yyy). This verification can be

deactivated by using the option allow_everything_in_reply.

Violations of the Protocol Options

The FAST FTP module can cut the connection depending on the protocol options configured in the case

listed below. The messages that appear in the IP Logs Description column as well as in the Alerts are

indicated in parentheses.

• Use of a forbidden command (command xxx forbidden)

• Maximum size authorized (max_command_size) is reached (command line too long (xx bytes /

max:yy))

Example of Configuring the Protocol Options

This paragraph shows several examples of configuring protocol options of the FAST FTP module.

Defining protocol options allows you to:

• authorize an FTP application with proprietary commands;

• forbid potentially dangerous commands;

• limit the access to the server for "normal" use only;

• hide sensitive information.

In any case, you should create several FTP services to select, in the specific filtering rules, the service

with the adequate options.

Authorize Proprietary Commands

If you use a client or an FTP server using proprietary commands, you must add these commands in the

option cmd_allow.

For instance, the client NCFTP uses the command CLNT that you can authorize by entering 'CNLT' in the

option cmd_allow.
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Forbid Potentially Dangerous Commands

The SITE FTP command allows commands to be executed remotely. This mode of action is not safe.

Moreover, buffer overflows using the SITE command occur on some servers.

To forbid the command SITE, you must enter SITE in the option cmd_forbidden.

Limit the Access to the Server

As a preventive measure, you should limit the server access to a minimum. The limitations can be

specified at the server level, but it is recommended to specify them at the Fast360 level.

This way, you can:

• limit the authorized commands: you can refuse the suppression of files and directories by entering

DELE, RMD, XRMD in the option cmd_refuse;

• filter the users: to authorize only the users “ftp” and “anonymous”, enter “ftp, anonymous” in the option

user_allow.

Hide Sensitive Information

The default configuration of some servers leaves sensitive information unhidden, like the server's

software version or the operating system.

The Fast360 appliance can hide such sensitive information if you configure the corresponding options:

• in the option hide_banner, enter the new home banner label that should appear;

• in the option hide_syst, enter the new label that should appear for the operating system (for instance,

“Unknown”).

Standards Documents

The FTP protocol, its extensions and use are described in the following documents:

• RFC 765 - File Transfer Protocol (FTP) - June 1980

• RFC 959 - File Transfer Protocol (FTP) - October 1985

• RFC 2577 - FTP Security Considerations - May 1999

• draft-ietf-ftpext-mlst-xx.txt: Extensions to FTP

FAST HTTP Module

General Behavior

The HTTP protocol (all versions included) is validated by Fast360 appliance with a finite state automaton

having a state for each end of the connection: HTTPC_xx for the client side and HTTPS_xx for the server

side.

The methods accepted by the FAST module depend on the version of the HTTP protocol used by the

client. The authorized methods are the following:
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• HTTP/0.9: GET

• HTTP/1.0: GET, POST, HEAD and CONNECT

• HTTP/1.1: GET, POST, HEAD, CONNECT, OPTIONS, PUT, DELETE and TRACE.

Example 11.7. Standard Connection

The example below corresponds to the query for the page http://www.voila.fr.

GET http://www.voila.fr/ HTTP/1.0

Accept: image/gif, image/x-xbitmap, image/jpeg, image/pjpeg, 
application/vnd.ms-powerpoint, application/vnd.ms-excel,
application/msword, */*

Accept-Language: fr
Cookie: e=PcDbzqwWAW8AACIUYcg
User-Agent: Mozilla/4.0 (compatible; MSIE 6.0; Windows NT 5.0)
Host: www.voila.fr
Proxy-Connection: Keep-Alive

HTTP/1.1 200 OK
Date: Thu, 18 Sep 2003 08:27:16 GMT
Server: Apache/1.3.27 (Unix)
Content-Type: text/html
X-Cache: MISS from test.arkoon.net
Connection: close

<HTML>
<HEAD>
<TITLE>Welcome to Voila</TITLE>
[content of the HTML page]

Specific Actions

Description of the Connection

The FAST module can match a description with an active connection. This description can be seen in the

Active connections window of  Arkoon Monitoring . The description used by the HTTP module recalls

the information related to the method and the URI currently exchanged.

Example 11.8. HTTP Connections

[HTTP] GET http://www.arkoon.net/index.html
[HTTP] POST /formulaire.php
[HTTP] CONNECT support-https.arkoon.net

Protocol Options

The protocol options (defined in  Arkoon Manager ) allow a more accurate control of the module's

behavior.

Here are the available options:

• methods_allow

List of authorized methods in addition to default methods. The options methods_only_allow and

methods_forbidden override methods_allow.

Format: list of character strings (methods).

• methods_only_allow

List of the only authorized methods. The FAST HTTP module cuts the connection if the client uses

another one.
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Format: list of character strings (methods).

• methods_forbidden

List of forbidden methods. The FAST HTTP module cuts the connection if the client uses one. The option

methods_forbidden overrides the option methods_only_allow (a method appearing in both will be

denied).

Format: list of character strings (methods).

• methods_no_version_restrict

List of methods for which no check is done if the method corresponds to the version used.

Format: list of character strings (methods).

• maxsize_url

URL maximum size. The FAST HTTP module cuts the connection in case of overflow.

Format: integer (maximum size).

• words_forbidden

List of forbidden words in a URL. The FAST module cuts the connection if one of these words is present.

Format: list of character strings.

• cli_headers_allow

List of authorized parameters for the client. The FAST module cuts the connection if the client uses

another one.

Format: list of character strings (parameters).

• cli_headers_forbidden

List of forbidden parameters for the client. The FAST module cuts the connection if the client uses one.

Format: list of character strings (parameters).

• cli_headers_remove

List of parameters sent by the client to be removed. The FAST module deletes these parameters from

the exchange; the server will not see them.

Format: list of character strings (parameters).

• cli_hdrline_max

Maximum size for a parameter line (name + data) sent by the client. The FAST module cuts the

connection in case of overflow.

Format: integer (maximum size).

• srv_headers_allow

List of authorized parameters for the server. The FAST module cuts the connection if the server uses

another one.

Format: list of character strings (parameters).
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• srv_headers_forbidden

List of forbidden parameters for the server. The FAST HTTP module cuts the connection if the server

uses another one. The option srv_header_forbidden overrides the option srv_headers_allow (a

parameter appearing in both is denied).

Format: list of character strings (parameters).

• srv_headers_remove

List of parameters sent by the server to be removed. The FAST module deletes these parameters from

the exchange; the client will not see them.

Format: list of character strings (parameters).

• srv_hdrline_max

Maximum size for a parameter line (name + data) sent by the server. The FAST module cuts the

connection in case of overflow.

Format: integer (maximum size).

• enable-url-av-scan

The FAST module analyses URLs passing through FAST HTTP.

Format: boolean.

Note

This option can be used only if the WEB_AV option license is included in the license. If not,

a coherency error will be displayed.

This applicative option enables to activate the SmartWeb antivirus analysis on a flow rule via the FAST

HTTP module. To do so, create a new flow rule. In the Services field in the Criteria tab of the rule,

select the Arkoon TCP service http-antivirus-factory or select a user service configured with the

policy FAST policy - HTTP Antivirus. For more information, refer to Section 8.3, “Creating a New

Filtering Rule” and to Section 11.1.1, “Creating a custom FAST module”.

Protocol Violations of the HTTP Analysis

The FAST HTTP module can cut the connection during the HTTP analysis in the cases listed below. The

messages that appear in the IP Logs Description column or in the Alerts are indicated in parentheses.

• Size of the method too long (Method too long)

• Forbidden characters present in the method (Invalid method (invalid token))

• Unknown method (Unknown method: xxx)

• Method unauthorized in this version (method xxx not allowed in HTTP/x.y)

• No URI in the query (No URI after method)

• Invalid HTTP version (Bad HTTP Version: xxx / Invalid HTTP Server version / Incomplete HTTP Version)

• Wrong parameter in the header (Bad Header: xxx)

• Invalid status (HTTP Status-code too long: xx, HTTP Status-code too short: xx, Invalid HTTP Status-

code: xx)

• Invalid header for the chunked encoding (Invalid chunk (size too long / invalid size / no LF after size

+CR / no CRLF after chunk-data))
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• Invalid header for the multipart/byteranges (Invalid byteranges CRLF / Invalid byteranges boundary /

Invalid byteranges header / No Content-range in byteranges headers / Invalid byteranges Content-

range)

Violations of the Protocol Options

The FAST HTTP module can cut the connection depending on the protocol options configured in the case

listed below. The messages that appear in the IP Logs Description column or in the Alerts are indicated

in parentheses.

• Use of an unauthorized method by the option methods_allow (Method not allowed by options: xxx)

• Use of a forbidden method by the option methods_forbidden (Method forbidden by options: xxx)

• Size of the URL exceeds the limit of maxsize_url (URL too long (at least xx bytes, max=yy))

• Presence of a forbidden word in the URL (Word (xxx) forbidden in URL: yyyy)

• Size of the parameter too long for the options (Client header line too long: at least xx bytes, max xx

bytes / Server header line too long: at least xx bytes, max xx bytes)

• Unauthorized parameter (Client header not allowed by options: xx / Server header not allowed by

options: xx)

• Forbidden parameter (Client header forbidden by options: xx / Server header forbidden by options: xx)

Example of Configuring the Protocol Options

This paragraph shows several examples of configuring protocol options of the FAST HTTP module in

order to counter various attacks.

Code Red

CodeRed uses a buffer overflow (.ida) on some IIS servers. It is a query of the following type:

Example 11.9. CodeRed

GET /default.ida?NNNNNNNNNNNNN[...]

The most general protection consists in limiting the size of the URL. To counter Code Red, the size of the

URL must not be larger than 370 bytes. However, some attacks are sustained by buffer overflows whose

URLs are of a smaller size. We recommend that you limit the size of the URL to 200 bytes, provided that

your server does not use longer legitimate URLs.

Enter the chosen value in the option max_urlsize.

You can also block the keyword default.ida (if you do not use it). To do so, enter it in the option

words_forbidden.

Nimda

Nimda tries to exploit servers infected by Code Red by using root.exe and cmd.exe, with a command of

the following type:

GET /scripts/root.exe?/c+dir

You can block it by forbidding the keywords cmd.exe and root.exe in the URL: enter them in the option

words_forbidden.
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Apache Chunked-encoding

These write operations can be detected and stopped because they use very long headers. The attacks

are of the following type:

Example 11.10. Apache Chunked-encoding

GET / HTTP.1.1
[...]
X-CCCCCCC: AAAAAAAAAAAA[...][shellcode]
Transfer-Encoding: chunked

The protection consists in limiting the size of the headers emitted by the client to a “reasonable” size.

This can also constitute an additional protection against other attacks. We recommend that you limit

the maximum size of the headers emitted by the client to 1,200 bytes. Enter this value in the option

cli_hdrline_max.

Standards Documents

The different versions of the HTTP protocol are described in the following documents:

• RFC 1945 - Hypertext Transfer Protocol -- HTTP/1.0 - May 1996

• RFC 2068 - Hypertext Transfer Protocol -- HTTP/1.1 - January 1997

• RFC 2616 - Hypertext Transfer Protocol -- HTTP/1.1 - June 1999

FAST SMTP Module

General Behavior

Verification of Client-to-Server Data

Each SMTP command sent from the client to the server contains the same elements: command + optional

parameter + CR + LF. The delimiter between the command and its parameters is the space, except for

some commands for which it is the ':' character.

Example 11.11. Client-to-Server Data

HELP\r\n
HELO myarkoon.arkoon.net\r\n
MAIL FROM:<test@arkoon.net>\r\n

The FAST module executes the following controls over the Client-to-Server data:

1. Controlling the command's general format (command, arguments, CR+LF);

2. Controlling if the command is really authorized;

3. Controlling the delimiter and the arguments used depending on the command.

The list of implicitly authorized commands is the one extracted from the various RFCs, except for the TURN

command (implicitly denied):

• RFC 821: HELO, MAIL FROM, RCPT TO, DATA, RSET, SEND FROM, SOML FROM, SAML FROM, VRFY, EXPN,

NOOP, HELP and QUIT

• RFC 1869: EHLO

• RFC 1985: ETRN

• RFC 2487: STARTTLS
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• RFC 2554: AUTH

The SEND FROM, SOML FROM, SAML FROM and TURN commands are considered obsolete following RFC 2821.

The TURN command is implicitly denied because it is never used and it lowers the protocol's security by

allowing the exchange direction to be changed.

The list of authorized commands can be modified with the protocol options cmd_allow, cmd_forbidden

and cmd_refuse.

Verification of Server-to-Client Data

The answers sent by the server have three digits, a space or a hyphen (-), a text and CR+LF end-of-line

characters. The text is intended for the user only and does not intervene in the protocol. The hyphen

allows the answer to be sent on several lines (only the last one uses the space character).

Example 11.12. Server-to-Client Data

220 myarkoon.arkoon.net SMTP server ready.\r\n
214-This is sendmail version 8.12.0\r\n
214-Topics:\r\n
214- HELO EHLO MAIL RCPT\r\n 
214-[..snip..]\r\n
214 End of HELP info\r\n

The first digit of the answer (that must be between 1 and 5) identifies the result of the answer.

1yz Preliminary positive answer

2yz Definitive positive answer

3yz Intermediate positive answer

4yz Temporary negative answer

5yz Definitive negative answer

Any command initiated by the client must finish with a type 2, 4 or 5 answer. This allows the exchange to

be tracked and to differentiate between the successful and unsuccessful commands.

Note

When connecting, the server sends an answer in the form of a home banner.

Exchange Tracking

The exchange tracking (command/answer) executed by the FAST module a specific control to be imposed

on various commands.

HELO/EHLO

The HELO and EHLO commands are used at the beginning of the exchange and allow client identification.

The FAST module ensures that this command is emitted (and accepted by the server) before a mail is

sent. Otherwise, the connection is cut.
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MAIL/RCPT/SEND/SOML/SAML

These commands specify the transmitter or the recipient of a mail. The connection is cut if the format of

the transmitter is invalid. If the protocol option strict_path is activated, the address must be included

between the < and > characters otherwise the connection will be cut by an protocol violation error.

DATA

This command begins sending a mail. Once the server has sent an intermediate positive answer (3yz),

the client can send the mail. The end of the mail is detected by the presence of the CR+LF+.+CR+LF

characters. The DATA command can be used only if the server accepts the transmitter and at least one

recipient. Otherwise, the connection is cut.

AUTH

This command allows the use of a specific authentication mechanism. The client is authorized to send

its authentication data until the server answers. No control is done over these data because they are

specific to the mechanism used between the client and the server. As soon as the server sends its answer

(negative or positive), the authentication data exchange is finished.

STARTTLS

This command allows the continuation of the exchange in a TLS session (encrypted). If the server accepts

the command, the remainder of the exchange is not controlled. If TLS mode cannot be allowed, it is

possible to refuse the command using the protocol option cmd_refuse.

Example of Standard Connection

The example below corresponds to a mail sent from the “station” machine, using the  smtp.relay.fr

SMTP relay, intended to the  smtp.dest.fr  server SMTP, with test@arkoon.net as emitting address

and intended totest@dest.fr.

220 smtp.dest.fr ESMTP Postfix (Release 20010228) (Linux-Mandrake)
EHLO smtp.relay.fr
250-smtp.dest.fr
MAIL From:<test@arkoon.net> SIZE=2282
250 Ok
RCPT To:<test@arkoon.net>
250 Ok
DATA
354 End data with <CR><LF>.<CR><LF>
Received: (from uucp@localhost)
 by smtp.relay.fr (8.12.8p1/8.12.8) id h8ICTFhJ004514
 for <test@dest.fr>; Thu, 18 Sep 2003 14:29:15 +0200
Received: from UNKNOWN(172.16.33.1), claiming to be "station"
 via SMTP by smtp.relay.fr, id smtpdB9OQHo; Thu Sep 18 14:29:14 2003
Message-ID: <002001c37dde$f9dfa0a0$012114ac@station>
From: "Test Account" <test@arkoon.net>
To: <test@dest.fr>
Subject: Re: Test
Date: Thu, 18 Sep 2003 14:18:31 +0200
MIME-Version: 1.0
Content-Type: multipart/alternative;
 boundary="----=_NextPart_000_001D_01C37DEF.BCE07BF0"
X-Priority: 3
X-MSMail-Priority: Normal
X-Mailer: Microsoft Outlook Express 6.00.2600.0000
X-MimeOLE: Produced By Microsoft MimeOLE V6.00.2600.0000

This is a multi-part message in MIME format.
[mail data]
.
250 Ok: queued as F2ED55FEC3
QUIT
221 Bye
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Specific Actions

Description of the Connection

The FAST module can match a description with an active connection. This description can be seen in the

Active connections window of  Arkoon Monitoring . The description used by the SMTP module recalls the

information specific to the source and destination (email or TDM). It can evolve during the transmission

and can have the following format:

[SMTP] [] -> []
[SMTP] [] -> [smtp.domain.com]
[SMTP] [myarkoon.arkoon.net] -> [smtp.domain.com]
[SMTP] <test@arkoon.net> -> [smtp.domain.com]
[SMTP] <test@arkoon.net> -> <user@domain.com>
[SMTP] <test@arkoon.net> -> 2 recipients
[SMTP] <test@arkoon.net> -TLS-> 2 recipients

Protocol Options

The protocol options (defined in  Arkoon Manager ) allow you to control the behavior of the module more

accurately. Here are the available options:

• cmd_allow

Additional commands to be authorized by the module. This option authorizes some proprietary

commands used by various editors. The options cmd_only_allow and cmd_forbidden override

cmd_allow.

Format: list of character strings (commands).

• cmd_only_allow

Only commands authorized by the module. All the others are considered a protocol violation and the

connection is cut.

Format: list of character strings (commands).

• cmd_forbidden

Commands (standard) that should not be used. The FAST module will consider the use of one of these

commands as a protocol violation and will cut the connection. The option cmd_forbidden overrides

the options cmd_only_allow (a command appearing in both will be forbidden) and cmd_refuse.

Format: list of character strings (commands).

• cmd_refuse

Commands that should not be transmitted to the server but that must not cut the connection. In such

a case, the FAST module sends a negative answer (500 Syntax error, command unrecognized) to the

client. No trace is generated in this case.

Format: list of character strings (commands).

• strict_path

Cuts the connection if the client does not use the < > characters to begin and end the email address

when using the MAIL FROM and RCPT TO commands.

Format: boolean.



Chapter 11. FAST and IDPS

188 | Standard FAST modules

• hide_banner

Allows concealing the home banner sent by the server via a string chosen by the Administrator.

Format: list of character strings (banner to be used).

• max_command_size

Maximum size authorized for a command and its parameters.

Format: integer (maximum size).

Protocol Violations of the SMTP Analysis

The FAST SMTP module can cut the connection during the SMTP analysis in the case listed below. The

message(s) that appear in the IP Logs Description column, and the Alerts are indicated in parentheses.

• Invalid format of a command (can't find \r / can't find \n-1)

• Use of an unknown command (invalid command 'xxx')

• No space or end of line after a command (garbage behind command xxx)

• Use of parameters for a command that does not accept them (No params allowed for cmd xxx)

• No parameter for a command requiring one (Params needed for cmd xxx)

• Use of the TURN command (command TURN forbidden)

• Resending of the HELO/EHLO command (already got helo/ehlo)

• Begins the sending of a mail without having used HELO/EHLO (client has not said hello)

• Invalid transmitter/recipient (forward path invalid / reverse path invalid)

• Sending of a mail without transmitter (got no MAIL FROM)

• Sending of a mail without recipient (DATA without any recipient (RCPT TO))

• Sending of a mail without valid recipient (DATA without any valid recipient - xx invalid 'RCPT TO' seen)

• Invalid format of the answer (I was waiting a reply number: xyz / reply too short)

Violations of the Protocol Options

The FAST SMTP module can cut the connection depending on the protocol options configured in the

case listed below. The message(s) that will appear in the IP Logs Description column, and the Alerts are

indicated in parentheses.

• Use of a forbidden command (command xxx forbidden)

• Maximum size authorized (max_command_size) is reached (command too long (xx bytes))

• Invalid transmitter/recipient (forward path invalid / reverse path invalid) related to the option

strict_path.

Example of Configuring the Protocol Options

This paragraph shows several examples of configuring protocol options of the FAST SMTP module.

Defining protocol options can allow you to:

• forbid potentially dangerous commands;

• limit the access to the server for "normal" use only;

• hide sensitive information.
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Forbid Potentially Dangerous Commands

The EXPN and VRFY commands can be used to get information about the SMTP server. The HELP command

is not used by a standard SMTP client: it can reveal a user who sends commands to the server manually.

To refuse these commands, enter them separated by a comma in the option cmd_refuse.

Limit the Access to the Server

As a preventive measure, it is best to limit the access to the server to a minimum. The limitations can be

specified at the server level, but it is recommended to specify them at the Fast360 level.

Then, you can limit the authorized commands: you can forbid the SEND FROM, SOML FROM and SAML FROM

commands (obsolete commands that allow to directly send a mail on the user terminal) by entering them

in the option cmd_forbidden.

Hide Sensitive Information

The default configuration of some servers leaves sensitive information unhidden in the home banner.

The Fast360 appliance can hide such sensitive information: in the option hide_banner, enter the new

home banner label that should appear.

Standards Documents

The SMTP protocol and its extensions are described in the following documents:

• RFC 821 - Simple Mail Transfer Protocol - August 1982

• RFC 1869 - SMTP Service Extensions - November 1995

• RFC 1985 - SMTP Service Extensions - ETRN - August 1996

• RFC 2487 - SMTP Service Extensions for Secure SMTP over TLS - January 1999

• RFC 2554 - SMTP Service Extensions for Authentication - March 1999

• RFC 2821 - Simple Mail Transfer Protocol - April 2001

FAST SNMP module

The FAST SNMP module supports SNMPv1, SNMPv2c and SNMPv3 over UDP (but not over TCP).

General Behavior

The SNMP protocol allows commands of the types set and get to be issued, as well as SNMP traps. The

FAST SNMP module analyzes SNMP (versions 1, 2c and 3) traffic for violations of the protocol.

An SNMPv1 or SNMPv2c message contains:

• an SNMP protocol version number

• an SNMP community name

• a PDU (Protocol Data Unit)

An SNMPv3 message contains:

• an SNMP protocol version number

• a header
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• security parameters

• a PDU

The FAST SNMP module performs protocol checks in three stages:

1. ASN.1 checks

2. Version check

3. Content checks

These stages are described below.

ASN.1 Checks

The first level of checking looks at the requirements of ASN.1 parsing. Each UDP packet contains exactly

one SNMP message that is an ASN.1-SEQUENCE. The following rules are applied:

• If the payload of the UDP packet does not start with an ASN1-SEQUENCE message, the packet is

rejected and the following error message is displayed: SNMP packet is not encoded in an ASN.1

SEQUENCE.

• If the payload of the UDP packet does not contain enough data for the entire ASN.1-SEQUENCE object,

the packet is rejected and the following error message is displayed: Incomplete SNMP message in

UDP packet.

• If there is still data remaining after the ASN.1-SEQUENCE, the packet is rejected and the following

error message is displayed: Unexpected data after the SNMP message.

Version Check

• For an SNMP message to pass through the Fast360 firewall, the message must first correspond to one

of the SNMP protocol versions supported by the FAST module: SNMPv1, SNMPv2c or SNMPv3.

If the version number is not one of these, the message is rejected and an error message of the following

type is displayed: SNMP version (xx) unsupported.

Content Checks

Each protocol version supports its own set of PDUs (Protocol Data Units), detailed in the table below.

Only these PDUs are permitted by the FAST SNMP module. Checks are performed on these PDUs.

Table 11.2. Protocol Version and PDU

Protocol Version PDU

SNMPv1 SNMPv1-GetRequest-PDU

SNMPv1-GetNextRequest-PDU

SNMPv1-GetResponse-PDU

SNMPv1-SetRequest-PDU

SNMPv1-Trap-PDU

SNMPv2c SNMPv2c-GetRequest-PDU
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Protocol Version PDU

SNMPv2c-GetNextRequest-PDU

SNMPv2c-Response-PDU

SNMPv2c-SetRequest-PDU

SNMPv2c-GetBulkRequest-PDU

SNMPv2c-InformRequest-PDU

SNMPv2c-SNMPv2-Trap-PDU

SNMPv2c-Report-PDU

SNMPv3 SNMPv3-GetRequest-PDUSN

MPv3-GetNextRequest-PDUS

NMPv3-Response-PDU

SNMPv3-SetRequest-PDUSN

MPv3-GetBulkRequest-PDUS

NMPv3-InformRequest-PDUS

NMPv3-SNMPv2-Trap-PDUS

NMPv3-Report-PDU

Description of the Connection

The connection description must contain information on the:

• SNMP version

• current operation (if known)

• community/username (if known)

These are shown in the following examples:

Example 11.13. SNMP Connection

[SNMPv1] TRAP .1.3.6.1.4.1.8628.1.1 (public)
[SNMPv1] SET .1.3.6.1.2.1.1.5.0 (john-doh) 
[SNMPv2c] GET .1.3.6.1.2.1.1, .1.3.6.1.2.1.2 (admin)
[SNMPv3] GET .1.3.6.1.2.1.1 (billy-the-kid)
[SNMPv3] <encrypted-PDU> (admin)
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Parameters

The parameters that can be used to enforce or modify the FAST SNMP protocol checks are listed and

described in the table below.

Table 11.3. Parameters Used with FAST SNMP Protocol

Parameter Type Description

forbid-SNMP-v1 Boolean Forbids the transmission of SNMPv1 messages.

An SNMPv1 message is rejected and the

following error message is displayed: Forbidden

SNMPv1 message.

forbid-SNMP-v2c Boolean Forbids the transmission of SNMPv2c messages.

An SNMPv2c message is rejected and the

following error message is displayed: Forbidden

SNMPv2c message.

forbid-SNMP-v3 Boolean Forbids the transmission of SNMPv3 messages.

An SNMPv3 message is rejected and the

following error message is displayed: Forbidden

SNMPv3 message.

forbid-get-requests Boolean Forbids the transmission of get requests:

SNMPv1-GetRequest

SNMPv1-GetNextRequest

SNMPv2c-GetRequest

SNMPv2c-GetNextRequest

SNMPv2c-GetBulkRequest

SNMPv3-GetRequest

SNMPv3-GetNextRequest

SNMPv3-GetBulkRequest

SNMP messages which contain these PDUs

are rejected and an error message of the

following type is displayed: Forbidden SNMPxx-

XxxxxxRequest

(example: Forbidden SNMPv2c-GetRequest)

forbid-set-requests Boolean Forbids the transmission of  set  requests:
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Parameter Type Description

SNMPv1-SetRequest

SNMPv2c-SetRequest

SNMPv3-SetRequest

SNMP messages which contain these PDUs

are rejected and an error message of the

following type is displayed: Forbidden SNMPx-

SetRequest

forbid-info-

requests

Boolean Forbids the transmission of info requests:

SNMPv2c-InformRequest

SNMPv3-InformRequest

SNMP messages which contain this PDU

are rejected and an error message of the

following type is displayed: Forbidden SNMPvx-

InformRequest

forbid-traps Boolean Forbids the transmission of traps:

SNMPv1-Trap

SNMPv2c-Trap

SNMPv3-Trap

SNMP messages which contain these PDUs are

rejected and an error message of the following

type is displayed: Forbidden SNMPx-Trap

forbid-reports Boolean Forbids the transmission of reports (SNMPv2c-

Report). SNMP messages that contain these

PDUs are rejected and the following error

message is displayed: Forbidden SNMPx-

Report

forbid-community Strings list Forbids the transmission of an SNMP message

with a community name in the specified list.

These messages are rejected and an error

message of the following type is displayed:

Forbidden community xxxxx  (where xxxxx is

the community name)

An empty string (in the strings list) can be used to

forbid the use of an empty community.
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Parameter Type Description

forbid-empty-

community

Boolean Forbids the transmission of an SNMP message

with an empty community name. These

messages are rejected and the following error

message is displayed: Forbidden usage of an

empty community

only-allow-

community

Strings list Forbids the transmission of an SNMP message

with a community name not in the specified

list. These messages are rejected and an error

message of the following type is displayed:

Forbidden community xxxxx  (where xxxxx is

the community name)

forbid-objectid Strings list Forbids the transmission of an SNMP message

which is related to an Object-ID (or a subtree) in

the specified list. Each Object-ID in the list must

be a string representing the full object path in

terms of digits and dots.

Example: ".1.3.6.1.2.1.1" (system)

The Object-IDs that must be checked against

the specified list are all the Object-IDs that are

included in the variable lists of all PDUs and the

Enterprise-ObjectID in SNMPv1-Trap-PDU.

For SNMPv2c-Trap, SNMPv2c-InformRequest,

SNMPv3-Trap and SNMPv3-InformRequest,

the first two variables (sysUpTime.0 and

snmpTrapOID.0) must not be checked, but the

Object-ID in the value of snmp-TrapOID.0 must be

checked.

These messages are rejected and an error

message of the following type is displayed:

Forbidden Object-ID .x.x.x.x.x  (where

.x.x.x.x.x is the Object-ID requested)

only-allow-objectid Strings list Forbids the transmission of an SNMP message

which is related to an Object-ID (or a subtree)

that is not in the specified list. Each Object-ID in

the list must be a string which represents the full

object path in terms of digits and dots. Example:

".1.3.6.1.2.1.1" (system)

The Object-IDs which must be checked against

the list are the same as for the forbid-objectid

option.
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Parameter Type Description

These messages are rejected and an error

message of the following type is displayed:

Forbidden Object-ID.x.x.x.x.x  (where

.x.x.x.x.x is the Object-ID requested).

disable-nat-

handling

Boolean Disables NAT handling (i.e. does not modify an IP

address, if any, in the SNMP message).

Standards Documents

The above versions of the SNMP protocol and their extensions are described in the following documents:

SNMPv1

• RFC 1157 - A Simple Network Management Protocol (SNMP) - May 1990

SNMPv2c

RFC 1901 - Introduction to Community-based SNMPv2 - January 1996

RFC 1905 - Protocol Operations for Version 2 of the Simple Network Management Protocol (SNMPv2) -

January 1996

Other relevant documents (for both versions) are:

• RFC 3416 - Version 2 of the Protocol Operations for the Simple Network Management Protocol (SNMP)

- December 2002

• RFC 3584 - Coexistence between Version 1, Version 2, and Version 3 of the Internet-standard Network

Management Framework - August 2003

FAST SQLNET Module

The FAST SQLNET module is concerned with the following security functions applied to exchanges of

SQL requests and data (that use the SQL*NET/Net9 protocol) with an Oracle database:

• Protocol filtering

• Address translation

• Conformity checks with the SQL*NET/Net9 protocol rules

Note

The FAST SQLNET module only supports Oracle 10g.

General Behavior

Control over Client-to-Server Data

The first command sent from the SQL*NET/Net9 client to the server contains a data field which includes

the parameters needed to establish the connection.
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Example 11.14. Client-to-Server Data

(DESCRIPTION=
  (ADDRESS_LIST=
    (ADDRESS=(PROTOCOL=TCP)(HOST=database.corporate.com)(PORT=1521))
    (CONNECT_DATA=(SERVICE_NAME=o817)(CID=(PROGRAM=)(HOST=ora52)(USER=ora101))
  )
)

The FAST SQLNET module performs the following checks on the client-to-server data:

• Checks the general format of the command

• Checks that the command is properly authorized

• Checks the command’s parameters for establishing the connection

The FAST SQLNET module can only process a command concerned with establishing a connection. This

analysis allows the evolution of a dynamic connection to be followed. The server’s response will contain

information on any eventual change of port.

Control over Server-to-Client Data

The first server response to the client contains either the same data (as the client-to-server command)

together with a change of port or simply a positive response.

Exchange Tracking

The FAST module’s exchange tracking (command/response) mechanism allows checks that are specific

to establishing a dynamic connection to be performed. The monitored parameters are described below.

PORT Parameter

The PORT parameter is returned by the server in the case of a change of port and can be controlled by

the FAST SQLNET module. This parameter is used to authorize the next client-to-server connection on

the specified port, when the same protocol (TCP/UDP) is used.

USER Parameter

The USER parameter is used by the client to establish a connection with the server. This parameter

contains the session login information needed to access the database. This field is limited to 32

characters (maximum).

HOSTS Parameters

These two parameters contain the names of the client’s machine and the server. These names do not

need to be modified for address translation to work, since address translation is transparent for the

SQL*Net protocol (the connections are always established in the same direction and the IP address is

not checked by the server).
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Parameter SERVICE_NAME

The SERVICE_NAME parameter is used by the client to establish the connection with the server. The

parameter contains the name of the Oracle server as specified in the server’s configuration file

(listener.ora).

This field is limited to 128 characters (maximum).

Note

This parameter only exists for Oracle 8.1 and above. It is equivalent to the parameter SID in earlier

versions.

Specific Actions

Dynamic Connections

The FAST SQLNET module creates and closes dynamic connections throughout the exchange. When a

dynamic connection is set up, the initial connection is destroyed.

Description of Connection

The FAST SQLNET module processes all packets that are accepted by a filtering rule which incorporates

FAST SQL*NET/Net9 analysis. Where possible, the module reports the contents of the description field

of the active connection associated with the packet or packets being analyzed. This report includes

authentication information for the initial connection and transfer information for the dynamic connection.

Example 11.15. SQLNET Connection

[SQLNET] user ora101 SID o817

Protocol Options

The protocol options (defined in  Arkoon Manager ) allow more specific control of the module’s operation.

These options are included in the configuration file of the Fast360. When this file is installed, the

configuration generation tool gencfg analyzes these options and includes them as rules (in AKPF pseudo-

code) in the security filtering policy. When a new active connection is accepted by the AKPF filtering

engine, these FAST SQLNET options are associated with the connection.

The following options are available:

• user_allow

List of users authorized to be connected. All other users are rejected by the FAST SQLNET module.

Format: list of character strings (login names)

• user_refuse

List of users not authorized to be connected. For these users, the FAST SQLNET module sends a

negative response to the client, but no trace is generated.

Format: list of character strings (login names)

• sid_allow
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List of authorized database services. All other services are rejected by the FAST SQLNET module.

Format: list of character strings

• sid_refuse

List of non-authorized database services. For these services, the FAST SQLNET module sends a

negative response to the client, but no trace is generated.

Format: list of character strings

Example 11.16. Protocol Options

user_allow(ora101)

Protocol Violations (SQL*NET/Net9 analysis)

The FAST SQLNET module can cut the connection during SQL*NET/Net9 protocol analysis in the cases

listed below. For each case, the log message is shown (in brackets). These error messages can be found

in the IP logs or in the alerts.

• Command with invalid format (Invalid Command format)

• Response with invalid format (Invalid Response from server)

• PORT parameters with invalid format (Badly formatted PORT parameter in server response,

Too long PORT parameter in server response, Invalid character found in PORT parameter

in server response)

• USER parameters with invalid format (No USER parameter found in client request, Badly

formatted USER parameter in client request, Too long USER parameter in client request)

• SERVICE_NAME parameters with invalid format (No SERVICE_NAME nor SID parameter in client

request, Badly formatted SERVICE_NAME or SID parameter in client request, Too long

SERVICE_NAME or SID parameter in client request)

• Invalid port in PORT parameter (Bad PORT value in server response)

Protocol Violations (FAST options)

The FAST SQLNET module can cut the connection according to the FAST options used in the case shown

below. The log message is shown (in brackets). This error message can be found in the IP logs or in the

alerts.

• Maximum number of failed authentications reached (Max number of failed authentications

reached)
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Standards Documents

The FAST SQLNET module applies to security functions applied to exchanges of SQL requests that

conform to the SQL*NET/Net9 protocol.

FAST RTP/RTCP Module

General Behavior

The FAST RTP/RTCP module allows the RTP (Real Time Protocol) or RTCP (Real Time Control Protocol)

part of a VoIP call to be made secure. RTP/RTCP is used in the data transfer (audio/video) phase of a

VoIP call.

Important

The action of the module FAST RTP/RTCP is transparent to the users. RTP and RTCP protocols

are protected by the modules FAST SIP, FAST MGCP, FAST RTSP and FAST H323.

This module cannot be configured in Arkoon Manager. The configuration options are available

in the modules FAST SIP, FAST MGCP, FAST RTSP and FAST H323.

The main security threat during a VoIP call comes in the SIP/MGCP-based set-up and tear-down phases

of the call (protected by the FAST SIP or FAST MGCP module), but an attack can also be mounted using

covert RTP channels in the data transfer phase. The FAST RTP/RTCP module minimizes the risk of an

attack via such covert channels.

Specific Actions

The FAST RTP/RTCP module provides the functionality described below to counter attacks mounted

through RTP and RTCP.

Codec Check

When establishing a VoIP call, as well as negotiating an RTP/RTCP channel for data transfer, a set of

codecs is negotiated that could potentially be used for encoding and numbering the session. The list of

supported codecs is communicated to the FAST RTP/RTCP module. This allows the module to check that

the codec used for a received RTP/RTCP packet is a valid one; the codec used is identified in the packet

payload and compared with the list of supported codecs.

Format Checks

The FAST RTP/RTCP module performs a number of checks on RTP/RTCP packets received.

• RTP headers: The module checks that RTP packet headers are correctly formatted. Checks are

performed to ensure that:

• The packet header conforms to RFC 3550.

• The packet size does not exceed the specified maximum (in order to avoid buffer overflow).

• The packet payload is of an agreed and supported type.

• Timestamps are valid

• RTCP headers: The module checks that RTCP packet headers are correctly formatted. Checks are

performed to ensure that:

• The packet header conforms to RFC 3550.

• The packet size does not exceed the specified maximum (in order to avoid buffer overflow).



Chapter 11. FAST and IDPS

200 | Standard FAST modules

• RTCP commands (packet payloads) are valid.

The authorized commands are: PT=200 — Sender Report, PT=201 — Receiver Report, PT=202 —

Source Description, PT=203 — BYE.

The command PT=204 — APP is not authorized.

Configuration Options

The following configuration options are available among the configuration options of the modules FAST

SIP, FAST MGCP, FAST RTSP and FAST H323.

• allow_codecs

This option configures the module to accept unknown codecs; that is, codecs which are not in the list

of supported codecs. By default, such a codec is forbidden. Format: array of integers.

• allow_app_msg

This option authorizes RTCP messages of the type APP=204, which are forbidden by default. Format:

Boolean

• allow_rtcp_single_packet

This option authorizes single RTCP packets; that is, non-compound RTCP packets, such as those used

in H.263.

• allow_rtcp_pt

This option is used to authorize payload types; by default, 200, 201, 202 and 203 payloads are authorized.

Format: array of strings.

• QoS_value

This option allows the TOS field of RTP packets over VoIP to be set in a non-destructive way. This

modification is only applied if the TOS field is not already set. The setting is specified in decimal by the

administrator. The value is typically 46; that is, “Expedited Forwarding” (no jitter, no loss of packets).

Standards Documents

The RTP and RTCP protocols are defined in the following documents:

• RFC3550/STD0064 - RTP: A Transport Protocol for Real-Time Applications - July 2003

• RFC3611 - RTP Control Protocol Extended Reports (RTCP XR) - November 2003

FAST SIP Module



Chapter 11. FAST and IDPS

Standard FAST modules | 201

General Behavior

The FAST SIP module allows a VoIP network operating via SIP (Session Initiation Protocol) to be made

secure. SIP can be used for VoIP call set-up and tear-down. Between these phases, voice data is

exchanged via one or more RTP/RTCP flows (secured using the FAST RTP/RTCP module).

SIP System Architecture

A VoIP call established using SIP involves at least two User-Agent (UA) network objects; these

correspond to the calling party and called party. In the simplest call scenario, SIP messages are

exchanged directly between these two parties.

The call could alternatively be routed via a Proxy Server, which acts as an intermediary between the

UAs in establishing a VoIP call, relaying SIP messages between the calling and called parties. Thus, the

calling and called parties deal only with the Proxy Server during call set-up and tear-down. The Proxy

Server must therefore be able to act as a client, as well as a server.

Sometimes a Redirection Server may deal with the calls; for example, when redirecting the call towards

the Voicemail of the called party.

SIP Message Exchanges

A VoIP call that is set up using SIP always starts with a SIP INVITE message from the calling party to the

called party. The following is an example of the sequence of events to establish a call via a Proxy Server:

1. The caller sends an INVITE message to another user, the called party.

2. This request is intercepted by a SIP Proxy Server, which forwards the message to the SIP domain

server for the called party.

3. The SIP domain server contacts the computer of the called party.

4. The computer alerts the user (by “ringing” the telephone) and returns the message 180 RINGING to

the caller.

5. The called party answers the call, then the message 200 OK is returned and accepted by the caller.

6. An RTP communication is established between the two parties.

There are many more SIP messages and responses, in addition to those mentioned above.

SIP Security Issues

A VoIP call involves signaling and data exchanges between two parties, and is vulnerable to attacks;

for example:

• Eavesdropping

• Call hijacking

• Sniffing

• Call interruption

• Billing fraud

• Spam attacks

• Spoofing

• Harvesting
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Specific Actions

The FAST SIP module provides the functionality described below to counter attacks mounted through SIP.

Note

The FAST SIP module is able to deal with SIP messages transported on UDP only.

Header Checks

The module checks that SIP headers are correctly formatted and conform to RFC 3261.

The lengths of command lines in the SIP message can be limited to reduce the risk of buffer overflow. The

module can also check that the command line is correctly formatted and that all fields are correctly filled.

The sequence numbers of requests can be checked to detect unsolicited responses (to commands that

were not sent).

A check is made for format strings, to ensure that there are none present.

NAT

The module implements the same NAT functions as all other Fast360 modules. The module therefore

translates NAT addresses in the body of SIP messages.

The corresponding addresses for RTP/RTCP are translated in the same way.

Configuration Options

The following configuration options are available.

• deny_reinvite

This option refuses messages of the type re-INVITE.

• session_timeout

This option specifies the timeout period (in seconds) of a session. A 100 Trying request resets the

timeout counter to zero. A 180 Ringing or 200 OK response must then be received within the timeout

period. A response received after the timeout period will be refused by the FAST SIP module. Format:

integer (default value: 180).

• prack_with_auth

This option refuses a PRACK message if no header authentication is present.

• change_ua_with

This option modifies the User-Agent with the specified parameter value. Format: string.

• max_line_size

This option specifies the maximum permissible line length of a SIP message. By default, the maximum

authorized length of a line is 256 characters. Format: integer.

• allow_sip_header

This option allows a list of SIP headers to be specified that are to be supported in addition to those

currently recognized by the FAST SIP module. Format: array of strings.
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• allow_sip_verb

This option allows a list of non SIP verbs (INVITE, etc) to be specified that the FAST SIP module is to

accept. Format: array of strings.

• open_rtp_on_ok

In normal SIP behavior, the RTP flow only starts on receiving an ACK message. The RTP flow is sent

out on receiving a 200 OK response. This option allows the transfer of RTP packets before the ACK

message is received (and therefore violates the RFC).

• deny_custom_header

Certain implementations can use SIP headers that start with “X-”. This option forbids packets

containing this type of header.

• allow_any_via_ip

The first Via line must contain the address of the source of the packet. If the specified address is an

IP address and does not correspond to the source or destination of the packet, the packet is rejected.

This option allows a packet of this type to be accepted.

• allow_reply_codes

This option allows acceptable return codes to be added to the default list. Format: array of integers.

• deny_tel_uri

This option refuses URIs of the typetel:XYZ.

• deny_modem_uri

This option refuses URIs of the type modem:XYZ.

• deny_fax_uri

This option refuses URIs of the type fax:+331XYZ.

• user_agent_only_allow

This option allows a list of User-Agent header values to be specified that are to be accepted by

the module. If this option is present, all messages with User-Agents not specified in the list will be

refused. The search is done on a sub-string; thus, the value “Cisco” authorizes the User-Agents Cisco-

CP7940G/7.5, Cisco-MyCisco, etc. Format: array of strings.

• allow_unspecified_body

A message containing an unspecified body is normally forbidden. This option removes this restriction.

• allow_message_type

Normally in a packet of type MESSAGE, only text/cpim and text/plain are authorized. This option allows

this list to be extended. Format: array of strings.

• allow_parameter

In the headers Via, From and To, the list of parameters (for example, “;ttl”) is restricted. This option

allows this list of authorized parameters to be extended. Format: array of strings.

• allow_any_chars

By default, only certain characters are authorized. This option removes this restriction.

• skip_strict_header_check
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This option reduces the tests performed on headers. This is useful since certain softphones

systematically add headers that violate the RFC.

• deactivate_flooding_protection

Disables flood testing on packet reception.

• deactivate_sequence_check

Disable SIP message sequence checking

Note

Also refer to the RTP/RTCP options allow_codecs, allow_app_msg,

allow_rtcp_single_packet, allow_rtcp_pt, QoS_value described in the section called

“FAST RTP/RTCP Module”.

List of accepted audio codecs

The audio codecs accepted by default are as follows:

• Codec 00: "G.711 PCMU"

• Codec 01: "1016"

• Codec 02: "G721"

• Codec 03: "GSM"

• Codec 04: "G723"

• Codec 05: "DVI4"

• Codec 06: "DVI4"

• Codec 07: "LPC"

• Codec 08: "G.711 PCMA"

• Codec 09: "G722"

• Codec 10: "L16"

• Codec 11: "L16"

• Codec 12: "QCELP"

• Codec 13: "CN"

• Codec 14: "MPA"

• Codec 15: "G728"

• Codec 16: "DVI4"

• Codec 17: "DVI4"

• Codec 18: "G729"

• Codec 25: "CelB"

• Codec 26: "JPEG"

• Codec 28: "nv"

• Codec 31: "H261"

• Codec 32: "MPV"

• Codec 33: "MP2T"

• Codec 34: "H263"
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• Codec 96 : "dynamic"

• Codec 127: "dynamic"

SDP Options

The SDP options that can be used in SIP and MGCP are as follows:

• rtp_disable_fast

Secondary media connections are opened with a udp_generic module instead of a FAST module. This

gives an improved performance in the case where the FAST RTP module takes too much time, but the

QoS setting and codec control are no longer assured. This does not affect the RTCP channel.

Important

If the SIP negotiation does not open an RTCP channel to control the flow, on receiving a BYE

the FAST SIP module cannot find the RTP channel (since it does not exist) and refuses the BYE.

This problem does not occur for a negotiated RTCP channel.

• sdp_max_port_card

It is possible to open several pairs of ports in a single line m=. By default, this is limited to a maximum

of 10 pairs. This option modifies the maximum.

• force_rtp_path

This option allows an RTP flow to be forced to cross the Fast360 appliance, even if the flow could pass

alongside the firewall.

• allow_unassigned_profile

The list of IANA profiles leaves ranges of values free for the negotiation of “dynamic” codecs. This

option allows the use of codecs in these ranges (required for Cisco telephones).

• allow_any_attributes

The (a=) attributes are the norm in SDP but in certain cases it is possible to use other attributes. This

option removes this contraint.

• sdp_max_line_size

This option specifies the maximum size of an SDP line. By default, the lines are limited to 256 characters.

• sdp_odd_port

This option authorizes the negotiation of odd and even RTCP ports.

Standards Documents

The SIP protocol is defined in the following documents:

• RFC3261 - SIP: Session Initiation Protocol - June 2002

• RFC3265 - Session Initiation Protocol (SIP) - Specific Event Notification - June 2002

• RFC3853 - S/MIME Advanced Encryption Standard (AES) Requirement for the Session Initiation

Protocol (SIP) - July 2004

• RFC4320 - Actions Addressing Identified Issues with the Session Initiation Protocol's (SIP) Non-INVITE

Transaction - January 2006
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FAST MGCP Module

General Behavior

The FAST MGCP module allows VoIP communication which passes through media gateways to be made

secure; for example, VoIP calls that pass between two networks, such as a telephone network and IP

network.

Specific Actions

Header Checks

The module checks that MGCP headers are correctly formatted and conform to RFC 3435.

The lengths of command lines in the MGCP message can be limited to reduce the risk of buffer overflow.

The module can also check that the command line is correctly formatted and that all fields are correctly

filled.

The sequence numbers of requests can be checked to detect unsolicited responses (to commands that

were not sent).

A check is made for format strings, to ensure that there are none present.

Data Checks

The module first checks that the lines of SDP headers are correctly formatted and then checks that the

SDP data parameters are coherent with the configuration made by the firewall administrator. The module

will then be capable of producing trace information on the RTP flows between gateways.

Refer to the section called “FAST SIP Module” for a list of the available SDP options.

NAT

The module implements the same NAT functions as all other firewall modules. The module therefore

translates NAT addresses in the body of MGCP messages.

Call-Agent and Gateway Restrictions

The module can authorize or forbid a gateway or Call-Agent to communicate with it, according to the

standard filtering rules of the firewall. The ACLs required for system security are generated at IP level

and not at naming space level. In addition, gateways can be filtered according to IDPS rules.

Authorized and Forbidden RTP/RTCP Flows

The module can authorize or forbid RTP/RTCP flows across the firewalls. The FAST RTP/RTCP module is

associated with each RTP data flow.

Configuration Options

The following configuration options are available.

• packet_max_size

This option specifies the maximum permissible size of an MGCP packet transferred by the module. A

packet with a size that exceeds this limit is dropped.
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• line_max_size

This option specifies the maximum permissible size of a line sent by a gateway or Call-Agent (excluding

CR/LF). Format: integer.

• session_timeout

This option specifies the timeout period (in seconds) of a pseudo MGCP session. Format: integer

(default value: 180 seconds).

• allow_connection_mode

This option allows you to specify the connection methods to be accepted, in addition to the default

methods.

• allow_reply_codes

This option allows you to specify the return codes to be accepted, in addition to the default codes.

Format: array of integers.

• allow_mgcp_verbs

This option allows you to specify the MGCP verbs to be accepted, in addition to the default verbs.

Format: array of strings.

• allow_any_chars

Disables testing for special characters and format strings

• relax_domain_names

Allow less rigorous testing on end point domain names

Note

Also refer to the RTP/RTCP options allow_codecs, allow_app_msg,

allow_rtcp_single_packet, allow_rtcp_pt, QoS_value described in the section called

“FAST RTP/RTCP Module” and to the SDP options described in the section called “FAST SIP

Module”.

Standards Documents

The MGCP protocol is defined in the following documents:

• RFC3435 - Media Gateway Control Protocol (MGCP) Version 1.0 - January 2003

• RFC3661 - Media Gateway Control Protocol (MGCP) Return Code Usage - December 2003

FAST RTSP Module
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General Behavior

The FAST RTSP module allows for filtering of RTSP media and protocol parameters during connection

negotiation. It does not block RTSP negotiation, but prevents the negotiation of secondary connections

which do not respect the filtering rules.

Configuration Options

The following configuration options are available:

• no_tcp

This option prevents negotiating for media streaming over TCP.

• no_udp_rtp

This option prevents negotiation of media streaming connections using RTP over UDP.

• no_udp_rdt

This option prevents negotiation of media streaming connections using Real Networks RDT protocol

over UDP

Note

Also refer to the RTP/RTCP options allow_codecs, allow_app_msg,

allow_rtcp_single_packet, allow_rtcp_pt, QoS_value described in the section called

“FAST RTP/RTCP Module”.

FAST SSL/TLS Module

Overview

Secure Sockets Layer/Transport Layer Security Protocols

The Secure Sockets Layer (SSL) and Tranport Layer Security (TLS) protocols are two closely related

protocols designed to provide secure, authenticated communications channels over the Internet

between web clients and servers.

SSL was developed by Netscape Communications Corp. in the early 1990's and has been widely

implemented in web browsers since, becoming a de facto standard. In 1999 the IETF published RFC 2246

defining TLS 1.0, which builds on SSL 3.0 and is sometimes referred to as SSL 3.1. In April 2006 this

document was revised by RFC 4346, introducing TLS 1.1.

The FAST SSL/TLS module checks that SSL/TLS connections conform to the relevant protocols as defined

in the following standards:

• SSL 2.0: SSLv2 Protocol Draft Specification, Netscape Communications Corp, Feb 9th 1995 (http://

wp.netscape.com/eng/security/SSL_2.html).

• SSL 3.0: SSLv3 Protocol Draft Specification, Netscape Communications Corp., Nov. 18th, 1996 (http://

wp.netscape.com/eng/ssl3/draft302.txt).

• TLS 1.0: RFC 2246: The TLS Protocol Version 1.0 — January, 1999 (http://www.faqs.org/rfcs/

rfc2246.html)

• TLS 1.1: RFC 4346: The TLS Protocol Version 1.1 — April, 2006 (http://www.faqs.org/rfcs/rfc4346.html)
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It is important to note that the FAST SSL/TLS module only analyzes unencrypted protocol fields. Encrypted

communications are not decrypted and analyzed by the FAST module.

Note

In the default configuration the FAST SSL/TLS module will block connections with sites for which

it cannot validate X.509 certificates – see the section called “X.509 Certificate Validation” for

details. The FAST SSL/TLS module also blocks, by default, any traffic using an SSL port if the

traffic does not conform to SSL protocols. This will impact the following applications (amongst

others):

• Skype

• Google Talk (standalone client)

• Certain distributed workload clients (worldcommunitygrid.org, …)

X.509 Certificate Validation

The FAST SSL/TLS module uses the Fast360 appliance's authentication subsystem (described in

Chapter 14, Users Authentication) to validate X.509 certificates issued by clients and servers during

the SSL/TLS handshake. Certificates are validated against a preloaded database of trusted certificate

authorities and CRLs, regularly updated as part of the standard remote update processes of the Fast360

appliance.

This means certain sites will be unreachable, for example if they use self-signed certificates or the

certificate has expired. In addition to HTTPS connections, SMTP, POP3 and IMAP4 connections using TLS

and filtered by the corresponding FAST SMTP, POP3, or IMAP4 module will be impacted; connections are

automatically switched to the FAST SSL/TLS module for analysis if TLS negotiation is initiated. HTTP relay

traffic is also impacted, as the FAST HTTP module is enabled in an implicit filtering rule used by the relay.

If necessary you can import certificates for the Fast360 appliance configuration, to ensure they are

recognized as trusted certificates by the FAST SSL/TLS module. See Section 14.4, “Importing Certificates

for FAST SSL/TLS Authentication” for the procedure.

The FAST SSL/TLS module implements a number of options allowing you to override the appliance's

authentication subsystem for the specific needs of SSL/TLS connections. These options are detailed

below.

SSL 2.0 Handshake Analysis

Note

SSL 2.0 connections are blocked by default by the FAST SSL/TLS module. If you wish to allow

SSL 2.0 you must set the allow-SSL-2.0 option described below.

In SSL, all data sent is encapsulated in a record, an object which is composed of a header and some non-

zero amount of data. An SSL 2.0 Record is used for SSL 2.0 connections but can also be used by an SSL

3.0/TLS 1.x client with support for SSL 2.0, for backward compatibility.

During the handshake, SSL 2.0 records are sent in clear text and can be analyzed. The FAST SSL/TLS

module analyzes these exchanges and ensures they conform to standard behavior as defined in the

protocol and that they respect the configured options.

Handshake messages must strictly follow the expected order as described in the following figures. The

abbreviated handshake must be followed if the server has set the SESSION-ID-HIT value (non-zero) in

the SERVER_HELLO message. Otherwise the full handshake must be used.
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Client                                                      Server
CLIENT_HELLO                  -------->                           
                                                      SERVER_HELLO
                              <--------      [SESSION-ID-HIT == 0]
CLIENT_MASTER_KEY             -------->                           
                  { encrypted handshake records }                 

SSL 2.0 Full Handshake Sequence

Client                                                      Server
CLIENT_HELLO                  -------->                           
                                                      SERVER_HELLO
                              <--------      [SESSION-ID-HIT != 0]
                  { encrypted handshake records }                 

SSL 2.0 Abbreviated Handshake Sequence

When the clear-text handshakes have been completed, all records are encrypted with the negotiated

secret key. The FAST SSL/TLS module will then only be able to analyze record headers.

SSL 3.0 and TLS Handshake Analysis

In SSL 3.0 and TLS, only Handshake, ChangeCipherSpec and Alert messages are allowed until a

connection state has been fully negotiated. Handshake messages must strictly follow the expected order

as described in the figure below. The abbreviated handshake must be used if the client has specified a

Session-ID and the server has sent the same ID. Otherwise the full handshake must be used.

Client                                                      Server
CLIENT_HELLO                  -------->                           
                                                      SERVER_HELLO
                                                      Certificate*
                                                ServerKeyExchange*
                                               CertificateRequest*
                              <--------            ServerHelloDone
Certificate*        
ClientKeyExchange   
CertificateVerify*  
[ChangeCipherSpec]  
Finished                      -------->                           
                                                [ChangeCipherSpec]
                              <--------                   Finished

SSL 3.0/TLS 1.X Full Handshake Sequence. An “*” indicates optional or context-dependent messages

which are not always sent.

Client                                                      Server
CLIENT_HELLO                  -------->                           
                                                      SERVER_HELLO
                                                [ChangeCipherSpec]
                              <--------                   Finished
[ChangeCipherSpec] 
Finished                      -------->                           

SSL 3.0/TLS 1.X Abbreviated Handshake Sequence

Once the connection state has been negotiated, all records are encrypted with the negotiated connection

state. The FAST SSL/TLS module will then only be able to check record headers.
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FAST SSL/TLS Module Optional Parameters

The optional parameters supported by the FAST SSL/TLS module are divided into two groups. The first

group is principally concerned with restricting parameters negotiated during handshaking. The second

group concerns handling of X.509 certificates.

Handshake Negotiation Options

• allow-SSL-2.0

Allows SSL 2.0 connections (disabled by default). If this option is not set, SSL 2.0 connections are

blocked by the FAST module.

Note

This option has no impact on SSL 2.0 compatiblity mode connections in later SSL/TLS

protocols.

• forbid-SSL-3.0

Forbid the use of SSL 3.0. If this option is set, SSL 3.0 records are rejected with the error "Forbidden

SSL 3.0 record" and a fatal handshake_failure alert is sent to the sender.

• forbid-TLS-1.0

Forbid the use of TLS 1.0. If this option is set, TLS 1.0 records are rejected with the error "Forbidden

TLS 1.0 record" and a fatal insufficient_security alert is sent to the sender.

• forbid-TLS-1.1

Forbid the use of TLS 1.1. If this option is set, TLS 1.0 records are rejected with the error "Forbidden

TLS 1.1 record" and a fatal insufficient_security alert is sent to the sender.

• forbid-abbreviated-handshake

Prevent abbreviated handshaking. In SSL 2.0, if the server sends a SERVER_HELLO record with

the SESSION-ID-IT value set (non-zero), the packet is rejected with the error "Forbidden SSL 2.0

abbreviated handshake".In SSL 3.0/TLS 1.x, if the server sends a ServerHello record with the same

session-ID as the client, the packet is rejected with the error "Forbidden SSL/TLS abbreviated

handshake" and a fatal handshake_failure alert is sent to both peers.

• min-cipher-key-size

Sets a minimum length (number of bits) for the negotiated cipher. If the effective key size is lower than

the specified value, the packet is rejected with the error "Forbidden cipher key size of xxx bits" and a

fatal insufficient_security alert is sent to both peers.

Note

This option cannot be enforced with abbreviated handshake in SSL 2.0.

• forbid-cipher-algorithm

This option allows you to identify specific encryption algorithms that will not be allowed during

negotiation. The following algorithms are supported for this option:

• NULL

• RC4

• RC2



Chapter 11. FAST and IDPS

212 | Standard FAST modules

• DES

• 3DES

• IDEA

• AES

• CAMELLIA

• SEED

If a peer tries to negotiate a forbidden algorithm, the packet is rejected with the error "Forbidden cipher

algorithm XXX" and a fatal insufficient_security alert is sent to both peers.

Note

This option cannot be enforced with abbreviated handshake in SSL 2.0.

• only-allow-cipher-algorithm

This option allows you to identify specific encryption algorithms as the only algorithms allowed for

negotiation. See the option forbid-cipher-algorithm (above) for supported algorithms. If a peer tries

to negotiate an algorithm other than the allowed algorithms, the packet is rejected with the error

"Forbidden cipher algorithm XXX" and a fatal insufficient_security alert is sent to both peers.

Note

This option cannot be enforced with abbreviated handshake in SSL 2.0.

• forbid-hash-algorithm

Specify one or more hash algorithms as forbidden. Supported options are NULL, MD5, and SHA1. If a

peer attempts to negotiate a forbidden hash algorithm, the packet is rejected with the error Forbidden

hash algorithm XXX and a fatal insufficient_security alert is sent to both peers.

Note

This option cannot be enforced with abbreviated handshake in SSL 2.0.

• only-allow-hash-algorithm

Restrict hash algorithm negotiation so only algorithms specified in this list are permitted (supported

options are NULL, MD5, and SHA1). If a peer attempts to negotiate an unlisted hash algorithm, the

packet is rejected with the error Forbidden hash algorithm XXX and a fatal insufficient_security alert

is sent to both peers.

Note

This option cannot be enforced with abbreviated handshake in SSL 2.0.

• forbid-key-exchange-method

This option allows you to identify specific key exchange methods that will not be allowed during

negotiation. The following key exchange methods are supported for this options:

• NULL

• RSA

• DH_DSS

• DH_RSA

• DHE_DSS

• DHE_RSA



Chapter 11. FAST and IDPS

Standard FAST modules | 213

• DH_anon

• KRB5

• PSK

• DHE_PSK

• RSA_PSK

• ECDH_ECDSA

• ECDHE_ECDSA

• ECDH_RSA

• ECDHE_RSA

• ECDH_anon

If a peer tries to negotiate a forbidden key exchange method, the packet is rejected with the error

Forbidden key exchange method XXX and a fatal insufficient_security alert is sent to both peers.

Note

This option cannot be enforced with abbreviated handshake in SSL 2.0.

• only-allow-key-exchange-method

This option allows you to identify key exchange methods as the only methods allowed for negotiation.

See the option forbid-key-exchange-method (above) for supported algorithms. If a peer tries to

negotiate a key exchange method other than the allowed methods, the packet is rejected with the

error Forbidden key exchange method XXX and a fatal insufficient_security alert is sent to both peers.

Note

This option cannot be enforced with abbreviated handshake in SSL 2.0.

• forbid-export-cipher

Enable this option to prevent peers negotiating exportable encryption algorithms and/or key exchange

methods.

• forbid-client-anonymity

Enable this option to require clients to identify themselves with a certificate prior to the

ClientKeyExchange phase of the handshake.

Note

This option cannot be enforced with abbreviated handshake in SSL 3.0/TLS 1.x.

• forbid-server-anonymity

Enable this option to require servers to identify themselves with a certificate following the ServerHello

phase of the handshake.

Note

This option cannot be enforced with abbreviated handshake in SSL 3.0/TLS 1.x.

• allow-unknown-cipher

Use this option to allow unknown ciphersuites, which are blocked by default if an unknown ciphersuite

is chosen. If this option is enabled the following options are not enforceable:

• min-cipher-key-size
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• forbid-cipher-algorithm

• only-allow-cipher-algorithm

• forbid-hash-algorithm

• only-allow-hash-algorithm

• forbid-key-exchange-method

• only-allow-key-exchange-method

• forbid-export-cipher

X.509 Certificate Validation Options

• disable-x509-verification

This options disables verification of client or server X.509 certificates by the Fast360 appliance's PKI

module.

• forbid-x509-client-dn

This option allows you to enter a list of DNs which, if detected in client certificates, will result in a fatal

insufficient_security alert being sent to both parties.

Note

This option cannot be enforced with abbreviated handshake in SSL 2.0.

• forbid-x509-server-dn

This option allows you to enter a list of DNs which, if detected in server certificates, will result in a

fatal insufficient_security alert being sent to both parties.

• allow-x509-untrusted-client-cert

• allow-x509-untrusted-server-cert

• allow-x509-expired-client-cert

• allow-x509-expired-server-cert

• allow-x509-notyet-client-cert

• allow-x509-notyet-server-cert

These six options allow you to permit connections in certain situations in which the X.509 certificate

is not valid.

• forbid-x509-selfsigned-client-cert

Prevent clients using self-signed X.509 certificates. If a client tries to negotiate a connection using a

self-signed certificate, a fatal insufficient_security alert is sent to both parties.

Note

This option cannot be enforced with abbreviated handshake in SSL 2.0.

• forbid-x509-selfsigned-server-cert

Prevents servers using self-signed X.509 certificates. If a server tries to negotiate a connection using

a self-signed certificate, a fatal insufficient_security alert is sent to both parties.

• forbid-x509-expired-crl
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Prevents authentication when the certificate which has not been revoked is tested against an expired

certificate revocation list. A fatal insufficient_security alert is sent to both parties.

• forbid-mixed-hello-versions

Allows to check the SSL/TLS versions are identical in ClientHello and ServerHello packets.

FAST TFTP Module

TFTP protocol (Trivial File Transfer Protocol) is a simple protocol to transfer files.

It is based on UDP Internet protocol. It is designed to be simpler than the FTP protocol and easier to

implement. Therefore it lacks most of the features of the FTP protocol. TFTP only reads and writes files or

emails from or to a remote server. It cannot display directories and does not provide user authentication.

The FAST TFTP module allows in particular VoIP telephones to connect to their telephony server in order

to retrieve their configuration through the Fast360 appliance.

General behavior

FAST TFTP module enables to check a TFTP connection between a client and a server complies with the

RFC 1350 (with extension options: RFC 2347, 2348 and 2349).

A transfer is established by the following exchange:

• request emitted: WRQ request to write on a foreign file system or RRQ request to read a file.

• positive answer received: in the case of the WRQ request, acknowledgement of receipt received

allowing writing and in the case of the RRQ request, first packet to read sent.

FAST TFTP module checks the following points:

• an “acknowledgement of receipt” packet must contain the block number of the data packet which

must be acknowledged.

• a block number must be associated to each data packet. Block numbers must be consecutive and

start from 1.

• because the positive answer to a write request is an “acknowledgement of receipt” packet, in this

particular case the block number must be 0.

• usually, because an “acknowledgement of receipt” packet valids a data packet, the

“acknowledgement of receipt” packet must contain the block number of the packet to validate.

• if the answer is an “error” packet, the request must be rejected.

Example of connection establishment in order to write a file

1. The A machine sends a WRQ request to the B machine. The source is a A source port and the

destination is the port 69.

2. The B machine sends an ACK (block number = 0) to the A machine. The source is a new port and the

destination is the A source port.

3. The connection is established and the first data packet can be sent by the A machine with a sequence

number at 1.
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4. During the following steps, machines must check that the source port is the same than the port defined

during steps 1 and 2. If a packet comes from a different source port, an ERROR packet is sent to the

source of the packet but the transfer is not disturbed.

In this example, note that the source port of the answer packet is not the port 69. The interest of the FAST

TFTP module is to be able to associate the return packet (from the B machine) to the request packet sent

by the A machine.

Recognized packets

By default, the FAST TFTP module recognizes the five following types of packets (they are described in

the RFC 1350):

Operation code Operation

1 Read request (RRQ)

2 Write request (WRQ)

3 Data (DATA)

4 Acknowledgement (ACK)

5 Error (ERROR)

A TFTP packet header contains the operation code associated to the packet.

Protocol options

The protocol options (defined at the service object level in Arkoon Manager ) allow more specific control

of the module’s operation. The following options are available:

• tftp_disable_way_check

Allows you to disable the check of the origin of a packet

Format: boolean

• tftp_only_allow_opcode

Allows you to accept only packets including an operation code listed in this option

Format: list of integers separated by comas

• tftp_internal_log_level

Allows you to enable the debug mode of the FAST TFTP module (debug option)

Format: integer

0 = no debug

1 = only errors

2 = 1 + warnings

3 = 2 + notifications

4 = 3 + information
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5 = 4 + debug

6 = 5 + detailed debug

• tftp_keep_violation_state

Keeps rejecting messages after an applicative violation (debug option)

Format: boolean

Standards Documents

The TFTP protocol is described in the following document:

RFC 1350 - The TFTP protocol - July 1992

11.2. IDPS

11.2.1. Intrusion Detection and Prevention

IDPS is an extension of the FAST technology which detects and neutralizes application layer attacks with

or without protocol violation while taking the context of the analyzed active connections into account.

FAST analysis blocks attacks regardless of application layer protocols. This protection is enhanced with

ARKOON in line IDPS (based on a database of signatures of application layer attacks).

To implement an intrusion detection system, the following points need to be considered:

• How can the number of false positives (or false alerts) be limited?

• What is the appropriate response to a potential attack?

The FAST modules follow the application layer protocol status of each connection and provide the IDPS

with very accurate information helping to define the context of the connection. This limits false positives

(analysis is done in relation to the connection's applicative status) while focusing on detecting attacks in

relation to a limited and targeted signatures base (enabling a significant improvement in performance).

Mechanisms

FAST and IDPS

The IDPS functionality uses the information determined by the FAST applicative analysis. There are three

analysis stages:

• First stage: the IP packets are filtered by FAST at the application layer. FAST checks for protocol

conformity and tracks the status of active connections. If packets violate the protocol, the connection

is stopped. If the packets pass, they go through to the second analysis stage: IDPS.

• Second stage: the IDPS filters the packets authorized by FAST by searching signatures of application

layer attacks in the flow. For each analysis, only the relevant signatures in relation to the protocol

and the connection status associated with an active connection are searched. So the IDPS takes the

analysis context into account, which optimizes performance and filtering.
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• Third stage: If an attack is detected by FAST or by the IDPS (in the first or second stages), the third

stage consists of triggering which will block the attack (see the section called “Creating a Custom

FAST Policy and Configuring the FAST Reaction”).

WPM Technology

The WPM (Weighted Pattern Matching) technology limits false alerts because of its flexible behavior.

When an IP packet contains a recognized attack signature, the IDPS does not automatically trigger the

alert and the associated response because an attack often corresponds to a combination of actions,

which are not individually dangerous.

With the WPM technology, the IDPS behaves as follows:

• A score is assigned to each signature.

• For a given active connection, each time the IDPS detects an attack signature (match), the connection

alert level is implemented with the score assigned to the signature.

In this way, false positives are minimized, ensuring better network connectivity and performance for

users.

Note

If an internal server is attacked, it is considered more vulnerable. It is then called "Compromised

host" and the connections towards this server have a non-nil initial alert level (bonus taking its

liabilities into account). This behavior is detailed in the Compromised hosts section below.

"Warn only" Mode

In "Warn only" mode the IDPS analysis scores can be viewed in  Arkoon Monitoring  without triggering

alerts or responses. It corresponds to the "Active response" in common intrusion detection systems.

When working in "Warn only" mode, there is no alert threshold (dedicated to the “Abort” mode).

The “Warn only” and “Abort” modes are configured in the IDPS configuration form of the Custom FAST

policy object. For more information, refer to the section called “Configuring the FAST IDPS Protection”.

Note

Even in 'Warn only' mode, FAST checks the conformity of the applicative protocols. An active

connection which violates protocol rules is blocked.

Applicative Profiles

Attack signatures are grouped in applicative profiles, that are associated with a service which is then

implemented in filtering rules. This allows connections to be filtered in relation to an adapted context

by only selecting the appropriate profile for a given flow. In this way, the search operation done by the

IDPS is limited.

Compromised Hosts

An internal server is considered a compromised host if it has received packets which caused an IDPS

alert.
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A compromised host is considered more at risk of future attacks. Consequently, the connections towards

this host have a non-nil initial alert level. This initial alert level is a percentage of the global alert threshold

(configurable in  Arkoon Manager ).

A compromised host keeps this status for 12 hours. It remains "under monitoring".

The list of these compromised hosts can be viewed in  Arkoon Monitoring . The number of compromised

hosts stored in the list can be set by the administrator. If this number is exceeded (new compromised

host while the list is full), the new compromised host is not stored. Ensure that the number of possible

hosts is well sized.

Update

The IDPS update is performed in the same way as other updates. It includes the download of new IDPS

signatures and new applicative profiles. These are automatically taken into account when the download

has finished.

Note

To benefit from the IDPS updates, the Fast360 appliance must have the proper license and include

an IDPS update flag.

An appliance which does not have this flag cannot use the signatures and the profiles provided

by the Fast360 (although they are visible on the  Arkoon Manager  interface).

You can update signatures in disconnected mode. To do so, download the last IDPS update file from http://

client.arkoon.net, copy it to the Fast360 (in /tmp for instance): type the command /opt/arkoon/share/

arkupdate/IDPS_upgrade/tmp/IDPS_date.gz. This checks the file signature before installing it.

IDPS and Performance

The IDPS performance can be measured in two ways:

• filtering throughput

• limitation of false positives

The kernel mode, the use of applicative profiles for signatures bases and the FAST context analysis with

applicative status' follow-up optimizes the IDPS performance in terms of pure throughput as well as limit

false alerts.

The IDPS filtering performance increased since the IDPS configuration fits the context (use of applicative

profiles). The IDPS context analysis not only optimizes the filtering time but it also limits false positives.

Note

In any case, the activation of the IDPS technology has a very low impact on the FAST filtering

throughputs (20% maximum in the worst case).

11.2.2. Configuring in-line IDPS

IDPS configuration is done in  Arkoon Manager . The IDPS functionality comes into play as soon as a

filtering rule filters an applicative service for which the IDPS is configured.

Five stages must be followed for its configuration:

• The general settings of the IDPS

http://client.arkoon.net
http://client.arkoon.net
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• The configuration of the signatures management

• The applicative profiles configuration

• The IDPS setting in the applicative services

• The use of services configured in the filtering rules

General Settings of IDPS Use

The first stage of the IDPS configuration consists in defining its use settings for an Fast360. These settings

determine the parameters and the working mode chosen for a firewall in all the services using the IDPS.

Note

In multi-appliances mode, it is necessary to set the working mode of the AMC server and the one

of its appliances separately since they can be very different.

Signature Management

The IDPS is based on an attacks signature base provided by Arkoon Network Security. They can be

accessed in 'Read' mode in  Arkoon Manager . They are classified according to a logical tree-view, by

type of applicative protocol and then applicative status.

An attack signature is always linked with its applicative context. It is thus essential to an applicative

protocol and to an applicative status of this protocol.

A signature is defined by:

• Its name.

• The applicative protocol it is associated with.

• Its applicative status when searched.

• Its ID (signatures generated by the administrator have an ID #100 000).

• Its pattern (searched character string).

• The pattern type:

• CS = case sensitive, in pattern search, distinguish upper and lower cases.

• CI = case insensitive, in pattern search, not distinguish upper and lower cases.

• Joker = in the character string, the administrators enters one or several * . In search, these * can

be replaced by any other character. One * replaces a single character.

• The references, which are descriptions or links toward the signature's root, its explanation, etc.

• The score, which is defined according to the abort threshold in the IDPS configuration form of the FAST

policy object. For more information, refer to the section called “Configuring the FAST IDPS Protection”.

It is possible for the administrator to create customized applicative signatures to face attacks which

patterns are not already defined in the Arkoon IDPS signatures. To be able to define the pattern matching

an attack, it is recommended to capture your network traffic and to identify packets to block.

1. In the default layout of Arkoon Manager, select the IDPS navigation tab from the left hand side of the

main window.

2. In the explorer view, expand the Signatures tree and then the Custom IDPS Signatures tree.
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3. Select the applicative protocol.

4. Right-click the applicative status you want and select New > DefaultIdpsSignatureUser. The Custom

IDPS Signature configuration tab is displayed on the right.

5. In the Properties configuration form, enter a name and a short description.

6. In the General configuration form, select the Pattern Type as described above and enter the pattern.

Caution

It is important to write a pattern which precisely matches packets to block in order not to

disturb the legitimate traffic. If the packet to block is defined by binary data, enter the matching

hexadecimal values between vertical bars.

7. Select the score according to the abort threshold in the IDPS configuration form of the Custom FAST

policy object.

Note

It is not required to fill the references for a custom IDPS signature.

Applicative Profiles Management

In order to implement the context analysis, the signatures are grouped in applicative profiles. You can

view the applicative profiles from the Profiles subfolder of the IDPS navigation tab in  Arkoon Manager .

It is possible to manually create applicative profiles in addition to the ones created by Arkoon Network

Security:

1. In the Profiles tree, right-click the Custom IDPS Profiles folder and then select New >

DefaultIdpsProfileUser. The Custom IDPS Profile configuration tab is displayed on the right.

2. In the IDPS Signatures configuration form, select the appropriate objects. A profile can regroup

signatures and/or other profiles. This allows you to group the signatures which correspond to your

type of server and its applicative files.

Assigning Profiles to Applicative Services

In order to use applicative profiles in the IDPS filtering, it is necessary to assign profiles to services,

which are then implemented in filtering rules. To do so, follow the procedure described in the section

called “Configuring the FAST IDPS Protection”.

Overload on the IDPS Working Mode of the Fast360 Appliance

For each service, the Arkoon in line IDPS working mode can follow the working mode of the Fast360

appliance on which it is used or follow its own working mode (directly settable). This takes the mode

'Warn only or Active response' into account.

The IDPS Custom Mode option is in the IDPS configuration form of the object Custom FAST policy. Refer

to the section called “Configuring the FAST IDPS Protection”.

FAST Reactions in case of Protocol Violation

The Fast360 appliance reaction in case of protocol violation (see the section called “Creating a Custom

FAST Policy and Configuring the FAST Reaction” above) is configured at the FAST policy level.
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Important

Important: the configuration of a given reaction on a service will release this reaction if the

connection is blocked by the FAST analysis and if the total score of the connection releases an

IDPS alert (in 'Active response' mode).

11.3. Impact of packet loss on TCP flow throughput

For some reasons, packet losses or desequencing can be observed on a TCP connection between a

client and a server when the network connection is poor. This can slow down the TCP flow throughput.

Measuring the throughput of a TCP connection on an Ethernet link which loses packets highlights the

fact that the throughput drop is related to the quantity of TCP packets lost between two workstations.

The graph below shows that the slightest lost of packets on an Ethernet link has a noticeable effect on

the TCP connection throughput established between the client and the server. For example, for 0.01% of

lost packets, the throughput is divided by two and for 1% of lost packets, the throughput is devided by 15.

The akkernel akdev stats vrrpv2g2 command enables to measure the rate of TCP packets loss on

a given link. This feature is activated by default on TCP flows analyzed by a level 7 stateful analysis.

Connect to the appliance in SSH. The quality of the link displays as follows:

root@fast360:/root> akkernel akdev stats vrrpv2g2

tcp packets: 3345816

tcp lost packets: 20986 (0.63%)

A sysmon (Section 16.1, “Monitoring TCP packets loss on an interface”) enables to monitor the loss of

TCP packets on a specific interface and to send an alert if there are more than 1% of lost packets (default

value which can be modified).

The presence of a Fast360 appliance between the client and the server may emphasize the throughput

decrease. When the FAST stateful applicative analysis is activated on the appliance, this one needs to

receive TCP packets in the right order to be able to perform the analysis. If this is not the case, the

appliance needs to put them back in the right order before sending them to the client. This compulsory

step may slow down even more the throughput. However, the Fast360 appliance immediately warns that

some packet blocks have been received and other are missing. This is the “Selective Acknowledgement”

or SACK (RFC 2018). The answer of the flow source is thus quicker and packets already received by the
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appliance are not sent again. Only missing packet blocks are sent again by the source workstation. There

is then a smaller risk of reducing the throughput and a high level of security is kept without affecting

the user.

The following graphic describes the behavior of the client, the server and the Fast360 appliance when

SACK is activated. This behavior is integrated by default.
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Chapter 12. Configuring IPsec VPN Tunnels

 

12.1. Types of Tunnel

The configuration of a VPN tunnel depends on the topology to be installed. The VPN tunnel can only be

set up if both VPN devices (VPN gateway/client) agree on the topology. Not only are the VPN devices and

authentication type defined, but also the source and final destination objects which are to communicate

through the VPN.

Fast360 appliances can be configured as a VPN gateway for both conventional VPN topologies:

• LAN-to-LAN VPN for connecting two remote networks

• Host-to-LAN for connecting the network to a particular host

12.1.1. LAN-to-LAN Tunnel

This type of tunnel is used to connect two subnetworks securely. Here is a classic example of the use of

a VPN tunnel for protecting flows between a Head Office and branch office or partner LANs:

where the flows are encrypted between:

• The head office Fast360 appliance and the remote partner's VPN gateway for communication between

the head office LAN and the remote partner LAN

• Fast360 head office and Fast360 branch for communication between LAN head office and LAN branch

Note

In the  Arkoon Monitoring  VPN tunnel window and system logs, this topology will be represented

as:

Central LAN IP address === Fast360 IP address ... remote Fast360 IP address

=== remote LAN IP address

(see Chapter 16, Monitoring, Logging, Error Messages for more information on  Arkoon

Monitoring ).

The IPsec protocol is very strict and the endpoints which need to communicate via the VPN tunnel

must be specified precisely. When a VPN tunnel is defined, it is important to differentiate between the

VPN gateway (Fast360 appliance or other VPN gateways) and other devices which will have the right to

communicate through this VPN tunnel (LAN1 and LAN2).

If several LANs are protected by the Fast360 appliance – for example, LANs on multiple ports of the

appliance, or one LAN connected via a router to the LAN connected to the appliance – you need to

configure a VPN tunnel for each endpoint LAN pair, as shown in the following two examples:
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In this example, you need to configure one tunnel for communications between LAN1 and LAN3, and

another tunnel for communications between LAN2 and LAN3.

In this example, you need to configure one tunnel for communications between LAN3 and LAN2, and

another tunnel for communications between LAN1 and LAN2.

12.1.2. Host-to-LAN Tunnel

In the  Arkoon Monitoring  VPN tunnel window and system logs, this topology will be represented as:

Central LAN IP address === Fast360 IP address ... remote client IP address

(see Chapter 16, Monitoring, Logging, Error Messages for more information on  Arkoon Monitoring ).

12.2. Configuring a VPN Tunnel

12.2.1. Ports and Protocols

The following ports and protocols are used in setting up a VPN (IPsec) tunnel with a Fast360 appliance:

• UDP/500 port for negotiating the tunnel's session keys (IKE protocol)

• 50/IP protocol for encapsulating the encrypted flows (ESP protocol)

• UDP/4500 port if you use NAT Traversal mode negotiation (if at least one network device carries out IP

translation between the Fast360 appliance and the remote VPN gateway).

If you encounter problems in setting up a VPN tunnel or passing flows through an existing tunnel you may

need to ask your Internet Service Provider (ISP) if these ports and protocols are definitely accepted and

routed. Certain ISPs implement firewall services which may by default block these flows.
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12.2.2. Configuring Fast360 Objects for VPN Tunnels

Note

A VPN tunnel only works if it is based on an Internet access defined in the configuration and

related to the VPN tunnel configuration. Moreover, to configure a VPN tunnel on a LAN, it is

necessary to create a false Internet access in order to use the VPN tunnel on the LAN side.

Setting up IPsec VPN tunnels requires the following steps:

1. Define host and network objects corresponding to the gateways, hosts and networks entities which

will be involved in VPN communication. Additionally you may need to configure individual users

connecting as remote VPN clients.

2. Activate IPsec VPN and configure appliance specific parameters on every Fast360 appliance

implementing tunnels. VPN policy objects allow the administrator to share VPN parameters among

several Fast360 appliances.

3. Define simple, star or mesh VPN topologies and authentication mode using VPN communities objects.

4. Define VPN tunnels using VPN tunnel objects. VPN tunnel objects specify the connection mode,

topology, algorithms, backup and load balancing links, and advanced parameters for a tunnel.

5. Use the VPN tunnels inside filtering rules objects, specifying which IP connections should be secured

by VPN tunnels and how.

12.2.3. LAN-to-LAN Tunnel Configuration

Configuring VPN Gateway Entities

For LAN-to-LAN VPNs, remote VPN gateways need to be configured as host objects, if not Fast360 slaves

configuration appliances.

1. In the Network objects explorer view, create a host object by right-clicking on the Hosts folder, select

New > Host.

2. Select the Network configuration form.

• If the VPN client has a fixed IP address, check the IP address option and enter this address in the

corresponding field.

• If the VPN client does not have a fixed IP address, check the Dynamic IP addressing option.

3. Select the VPN configuration form.

• For authentication using an X.509 certificate, check the Use X.509 Certificate option and drag and

drop the appropriate certificate into the X.509 Certificate field. In this case, the IPsec ID used will

be the full DN of the certificate.

Note

You cannot use the same certificate to negotiate a VPN tunnel with a Fast360 appliance

from two remote gateways with different IP addresses at the same time.

For more details of importing and creating certificates, see Chapter 14, Users Authentication.

• For configurations requiring a specific IPsec ID, check the Custom IPsec ID option and enter the

ID in the corresponding field.
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• If you are using an RSA key, enter it in theRSA Key field. See Section 12.10.9, “RSA Key” in

Section 12.10, “Advanced VPN Topologies” for more details.

Configuring LAN Entities

In the configuration window of the LAN which is to communicate using VPN flows, the VPN gateway

used must be configured.

1. In the Network objects explorer view, create a network object by right-clicking on the Networks

folder, select New > Network. The Network configuration tab is displayed on the right.

2. Select the VPN configuration form.

• For a local LAN situated behind the Fast360 appliance, drag and drop a Fast360 appliance object

into the VPN Gateway field.

• For a remote LAN, select the host previously configured in the section called “Configuring VPN

Gateway Entities” as the VPN gateway by a drag-and-drop action into the VPN Gateway field.

• For a VPN tunnel defined between Fast360 appliances operating in multi-appliances mode, drag and

drop the Fast360 appliance object which directly protects the network into the VPN Gateway field.

12.2.4. Host-to-LAN Tunnel Configuration

There are three types of configurable object for identifying the VPN client:

• User

• User group

• Host

The following table shows the features available for each type of object:

IP Authentication

Fixed Dynamic Certificate RSA key DN

NT/LDAP

Import

Host Y Y Y Y   

User  Y Y  Y Y

User group  Y Y  Y Y

Note

Authentication by DN enables authentication by certificate to be implemented even if the

certificate of the client is not available on the Fast360 appliance. The following checks will be

carried out on the certificate presented by the VPN client:

• DN configured in the host object corresponds to the one in the certificate presented.

• The certificate presented is signed by a trusted CA.

• The certificate presented is not on a CRL (Certificate Revocation List).

You cannot use the same certificate to negotiate a VPN tunnel with a Fast360 appliance from 2

nomads with different IP addresses at the same time.
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Only one of these three objects will be required to set up a VPN tunnel with a VPN client.

To know how to use users and/or hosts defined for the configuration of a VPN tunnel, refer to

Section 12.4.5, “Configuring VPN Communities”.

Configuring Users and User Groups

For a new user, the authentication type must be either:

• A certificate

• A DN

Note

The user name is required but is not used in setting up the VPN tunnel. This identifier is used in

displaying the VPNs available in  Arkoon Monitoring   VPN Tunnels window. A user with password

authentication cannot be used to set up a nomad VPN tunnel. This type of user authentication is

used in other cases (HTTP relay, Fast360 appliance authentication, etc.).

When the certificate is presented by the VPN client, a request is sent to the authentication server to

check that the certificate presented belongs to the group authorized to set up the VPN tunnel. If the user

does not belong to this group, authorization to set up the VPN tunnel is rejected.

Configuring Users

1. In the Authentication explorer view, create a new user by right-clicking on the Users folder, select

New > User. The User configuration tab is displayed on the right.

2. In the Properties configuration form, enter a name and short description for the user in the

corresponding fields.

3. Select the General configuration form.

4. Enter a user name for the user in the Login field.

5. Select the authentication type from one of the three options in the Credentials type section:

• For authentication by a password, enter it in the Password field and confirm it in the corresponding

field.

• For authentication by certificate, check the X.509 certificate option and drag and drop the certificate

into the X.509 certificate field.

• For authentication by domain name, check the DN option and enter the name in the corresponding

field.

Configuring User Groups of Users

A group brings together a number of nomad VPN users. If several nomad users need to set up VPN tunnels

with the same topology, use of a user group can simplify configuration.

1. In the Authentication explorer view, create a new user group by right-clicking on the Group of Users

folder, select New > User Group. The User Group configuration tab is displayed on the right.

2. In the descriptive view, enter a name and short description for the user in the corresponding fields.

3. Drag and drop the users you want to group from the Authentication descriptive view into the User

Group folder in the explorer view.
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Importing Users/Groups of Users from an Authentication Server

No additional configuration is required for users/groups of users imported from an authentication server.

Note

For more details on importing and creating certificates, see Chapter 14, Users Authentication.

For groups of users imported from an authentication server, certificates and user accounts from this

group are not imported together.

Configuring Host Entities

For VPN clients with a fixed IP or with authentication by RSA key, a host object must be created.

1. In the Network objects explorer view, create a host object by right-clicking on the Hosts folder, select

New > Host.

2. Select the Network configuration form.

• If the VPN client has a fixed IP address, check the IP address option and enter this address in the

corresponding field.

• If the VPN client does not have a fixed IP address, check the Dynamic IP addressing option.

3. Select the VPN configuration form.

• For authentication using an X.509 certificate, check the Use X.509 Certificate option and drag and

drop the appropriate certificate into the X.509 Certificate field. In this case, the IPsec ID used will

be the full DN of the certificate.

Note

You cannot use the same certificate to negotiate a VPN tunnel with a Fast360 appliance

from two remote gateways with different IP addresses at the same time.

For more details of importing and creating certificates refer to Chapter 14, Users Authentication.

• For configurations requiring a specific IPsec ID, check the Custom IPsec ID option and enter the

ID in the corresponding field.

• If you are using an RSA key, enter it in the RSA Key field. See Section 12.10.9, “RSA Key” in

Section 12.10, “Advanced VPN Topologies” for more details.

Configuring LAN Entities

The nomad VPN client will set up a VPN tunnel in order to communicate with a specific LAN.

1. In the Network objects explorer view, create the specific network by right-clicking on the Networks

folder, select New > Network. The Network configuration tab is displayed on the right.

2. In the VPN configuration form, drag and drop the Fast360 appliance object which directly protects this

network into the VPN Gateway field.
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12.3. Configuring IPsec VPN Service on Fast360

Appliances

Parameters for IPsec VPN services in Fast360 appliance objects include:

• A VPN policy

• Interfaces/networks from which VPN access is allowed

• Authentication credentials (RSA/X.509)

The VPN policy is used to configure the parameters which will be applied to all VPN tunnels for the Fast360

appliance. This section explains first how to configure the VPN policy (including cross-references to

sections explaining the different mechanisms involved) and then how to configure IPsec VPN services

on the Fast360 appliance.

12.3.1. Properties of the VPN Policy

VPN policies enable the following parameters to be shared between Fast360 appliance objects:

• NAT traversal support

• DHCP virtual addressing support

• External PKI support

• Authorized/forbidden virtual IP addresses

NAT Traversal Support

NAT traversal is implemented according to RFCs 3947 (Negotiation of NAT-Traversal in the IKE ) and 3948

(UDP Encapsulation of IPsec ESP Packets).

The implementation also complies with the following drafts:

• draft-ietf-ipsec-nat-t-ike-00.txt

• draft-ietf-ipsec-nat-t-ike-01.txt

• draft-ietf-ipsec-nat-t-ike-02.txt

• draft-ietf-ipsec-nat-t-ike-03.txt

• draft-ietf-ipsec-udp-encaps-00.txt

• draft-ietf-ipsec-udp-encaps-01.txt

• draft-ietf-ipsec-udp-encaps-02.txt

• draft-ietf-ipsec-udp-encaps-03.txt

By default, an IPsec VPN uses the ESP protocol (protocol 50) over IP. This protocol does not have the

concept of “port”: it cannot therefore traverse a router carrying out port translation. One solution in this

case is to use NAT traversal. This mechanism consists of encapsulating the ESP flows in UDP 4500 or

UDP 500 packets.

To use NAT traversal, both VPN devices must have this feature enabled. Furthermore, NAT traversal will

only be used if necessary: if both VPN devices have the feature, they only use it if there is a device

between them (most often a router) carrying out port translation.
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The translating device redirects the UDP 500 and 4500 ports to the entity at the end of the VPN tunnel for

flows initiated by the Fast360 appliance.

The translating device carries out a masking-type translation on flows initiated by the entity at the end

of the VPN tunnel.

The operation in greater detail is as follows:

1. Negotiation of NAT traversal by the two VPN devices

2. Detection of a device carrying out the translation of addresses via the sending of NAT-D messages

(NAT Discovery)

3. If a change of IP address has been detected, the negotiation continues using the UDP 4500 port.

Note

The use of port 4500 port avoids an analysis of port 500 carried out by certain IPsec-

Passthrough devices which causes problems when using NAT traversal. The use of the draft-

ietf-ipsec-nat-t-ike-00/01 version which does not switch to port 4500 is supported by Fast360

appliances if the other end only supports this version.

4. The tunnel is then negotiated during phase 2. (Quick Mode). The ESP packets will be encapsulated in

UDP packets using the same ports as those used for ISAKMP negotiation (UDP 4500).

5. Periodically, “keep-alive” packets are sent to force the translation devices to preserve the translation

inputs (IP address of the port) of the UDP 4500 connection. These packets are not used and cannot

be used to test the operation of the tunnel.

Note

The correct operation of the tunnel can be tested by using the Dead-Peer-Detection feature

details of which are given in the rest of this section.

DHCP Virtual Addressing Support

See the section called “Allocating an Address via DHCP over IPsec” in Section 12.9, “Features Dependant

on the Type of Tunnel” for information on configuring DHCP virtual addresses.

External PKI Support

The PKI feature enables the Fast360 appliance to be integrated into an existing PKI architecture.

For more information on configuring an external PKI server see Section 12.10.4, “Managing VPN

Authentication and Permission with an External PKI”.

Roadwarriors security

See the section called “Allocating a Virtual IP Address” in Section 12.9, “Features Dependant on the Type

of Tunnel” for information on configuring authorized/forbidden virtual IP addresses.
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12.3.2. Configuring the VPN Policy

1. In the VPN explorer view, create a new VPN policy by right-clicking on the VPN Policies folder, select

New > VPN Policy. The VPN Policy configuration tab is displayed on the right.

2. In the Properties configuration form, enter a name and short description for the VPN policy in the

corresponding fields.

3. Select the Settings configuration form.

• Check the Enable NAT Traversal option if one of the VPNs managed by the Fast360 appliance has

to traverse devices carrying out port translation. If necessary, change the value of the Keepalive

timeout. This parameter may be required in the rare case of a VPN using a non-permanent Internet

connection, for example ISDN.

Note

If Keepalive timeout is not checked, the default timeout is applied (20 seconds).

• To allow a nomad to use an address assigned by a DHCP server situated on the LAN as a virtual

address, check the Enable DHCP option and drag and drop the corresponding host object into the

DHCP Server field.

Note

The host object should be previously configured with the DHCP server capability; for more

information on configuring hosts with capabilities.

• To authenticate using an external PKI server, check the Use External PKI and drag and drop the

PKI server object into the corresponding field.

4. In the Roadwarriors security configuration form:

a. Drag and drop the network objects configured with the IP address or the virtual LAN of nomad

clients allowed to set up a VPN tunnel into the Authorized virtual IP addresses field.

b. Drag and drop the network objects configured with IP addresses which are not allowed to be used

by nomad workstations or remote VPN gateways (typically internal networks protected by a Fast360

appliance) into the Forbidden virtual IP addresses field.

12.3.3. Configuring IPsec VPN Service on the Fast360 Appliance

1. In the Security configuration form of the Fast360 appliance configuration tab, select the VPN folder.

The parameters to be configured are displayed on the right.

2. Drag and drop the previously configured VPN policy into the VPN Policy field.

3. Drag and drop the listening interfaces which are to take encrypted flows into the Interfaces field in

the Authorized VPN gateways section.

Note

Specifying listening interfaces defines one implicit rule authorizing ISAKMP and ESP flows

from specified servers to Fast360 appliances. This implicit rule is read after the rules defined

in  Arkoon Manager .

Warning

The IPSec service must be restarted from Arkoon Monitoring (button Maintenance/

Diagnostis...) once the IP address of the cable interface obtained.
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4. Define the IP addresses of the VPN gateways and clients with which the Fast360 appliance is to

establish VPN tunnels by dragging and dropping the appropriate object into the Networks field in the

Authorized VPN gateways section. The object depends on the configuration scenario:

• In the conventional case, select the remote VPN device

• If the VPN gateway or remote nomads have a dynamic address, the Internet network must be

selected (0.0.0.0/0).

• In Fast360 multi-appliances configurations, select the corresponding Fast360 appliance object.

5. Define the authentication credentials in the RSA Policy section:

a. Enter either the RSA key or X.509 certificate in the corresponding field.

b. Enter the relevant IPsec ID in the corresponding field.

• If a RSA key has been used, enter its corresponding IPsec ID.

• If a X.509 certificate has been used, the DN of the certificate is the IPsec ID.

Configuring IPsec VPN Service on HA/HP Cluster Appliances

Configuring IPsec VPN Service in HA Clusters

In HA cluster mode, the IPsec VPN service is started only on the active node and the tunnels are

established using the virtual IP address(es). After failover, the new active node immediately starts the

VPN service and tries to establish all tunnels.

It is mandatory to use the same certificate for both nodes when using X.509 authentication in HA clusters

to avoid complications when configuring.

When the administrator requests one node to be passive, its IPsec VPN service must be turned off.

To create a certificate of FIREWALL type for IPsec VPN service via minarkconf tool:

1. For the active node, connect in SSH on the administration virtual IP that the node owns.

2. For the passive node, connect in SSH on the real IP corresponding on the administration connection.

3. Launch minarkconf and go to Certificates > Import external certificate for VPN, then provide the  .p12

file. This FIREWALL certificate will previously be generated by the cluster's CA or by an external PKI.

To create a certificate of FIREWALL type for IPsec VPN service via Arkoon Manager:

1. Connect on the active node.

2. Click on Actions > Advanced administration > Apply a VPN certificate.

3. Select the desired appliance and choose the certificate file to create.

4. Connect on the passive node and repeat steps 2 and 3.

This FIREWALL certificate will previously be generated by the cluster's CA or by an external PKI.

Configuring IPsec VPN Service in HP Clusters

In HP cluster mode, both modes are active and IPsec VPN service is started on each node. The tunnels

are established via the virtual IP addresses. It is mandatory to use the same certificate for both nodes

when using the X.509 authentication in order to avoid any configuration problem. Configuring IPsec VPN
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Service in HP Clusters is identical to HA clusters: refer to the section called “Configuring IPsec VPN

Service in HA Clusters”.

12.4. VPN Communities

Arkoon Manager lets you create three different types of VPN community. These communities enable

topologies from the simplest to the most complex to be put in place quickly.

12.4.1. Simple Tunnel

This conventional scenario consists of connecting two LANs together:

One VPN tunnel is defined on the Fast360 appliance:

LAN1 === Fast360_1 … Fast360_2 === LAN2

For a VPN client, there is a comparable topology – one VPN tunnel is defined on the Fast360 appliance:

LAN1 === Fast360_1 … remote client

12.4.2. Mesh Tunnel Community

The meshing tunnel is used if multiple entities need to communicate with each other in a “peer-to-peer”

topology. For example, to interconnect four LANs distributed over three sites as in this example, five VPN

tunnels are defined:

LAN1 === Fast360_Central … Fast360_Agency1 === LAN3

LAN1 === Fast360_Central … Fast360_Agency2 === LAN4

LAN2 === Fast360_Central … Fast360_Agency1 === LAN3

LAN2 === Fast360_Central … Fast360_Agency2 === LAN4
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LAN3 === Fast360_Agency1 … Fast360_Agency2 === LAN4

12.4.3. Star Tunnel Community

A star community is typically used for multiple remote connections to a central site, for example for

remote clients — though the remote connections could also be VPN gateways at remote offices or

partner sites.

In this example three remote clients form a star community:

Three tunnels are defined:

LAN === Fast360 … remote_client_1

LAN === Fast360 … remote_client_2

LAN === Fast360 … remote_client_3

12.4.4. End Entities of the Tunnel

For a LAN-to-LAN VPN, the two LANs must be selected from the list of network objects.

For a VPN with a nomad, a LAN must be selected on one side and the remote host(s) and/or user(s) and/

or user group(s) selected on the other.

If a company LAN needs to be accessed by a group of nomad users, you can create just one tunnel group

to include all the users concerned. A VPN tunnel will be created for each user.

For a simple topology, select the two entities of the simple tunnel.

For a star topology, select the central entity of the star in the Hub field; the other entities which will be

arranged around the central entity are in the Entity field.

For a mesh topology, select the various entities of the VPN mesh to be installed.

For more details on configuring end entities, see step 3 of Section 12.4.5, “Configuring VPN Communities”.

12.4.5. Configuring VPN Communities

1. In the VPN explorer view, create a new VPN community by right-clicking on the VPN Communities

folder, select New > VPN Community. The VPN Community configuration tab is displayed on the right.
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2. In the Properties configuration form, enter a name and short description for the VPN community in

the corresponding fields.

3. Select the Entities configuration form.

• Drag and drop the end entities of the tunnel into the Entities field.

• To configure a star tunnel community, check the Star community option and drag and drop the

central entity of the star community into the Hub entity field.

• It is also possible to configure a group of networks:

• as the central entity of the star community ;

• as the end entity of a VPN mesh community.

4. In the Authentication configuration form, select the authentication method for this VPN tunnel group.

Choose between a shared key (enter the key in the corresponding field), a X.509 certificate or a RSA

key.

5. If you need to configure X-Auth authentication for users, select the X-Auth configuration form. Drag

and drop users/groups of users authorized for this community. If users are defined on an external

authentication server, drag and drop the authentication server in the External authentication server

field. If not, choose the users among users locally defined in the configuration.

If you made mistakes in the configuration of the X-Auth authentication, coherency errors will display

during coherency check:

• if X-Auth authentication is enabled in the community but no users or groups of users is selected in

the relevant field.

• if the Use external authentication server is enabled, but no server is selected in the field.

• if local users are selected (or local groups with local users) and some users do not use password

authentication.

X-Auth authentication for users

X-Auth authentication allows adding a strong user authentication in addition to hardware entities

authentication. It is particularly useful for VPN tunnels established with mobile devices such as digital

tablets and smartphones (Host-to-LAN configuration). The X-Auth protocol allows identifying users

defined on an external authentication server or locally in the Arkoon Manager configuration.

If you use this type of authentication in a VPN community (refer to the procedure above), we recommend

you to select the authentication with shared key in the Authentication configuration form of the VPN

community configuration tab.

12.5. VPN Tunnel Groups
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12.5.1. Configuring VPN Tunnel Groups

The VPN Tunnels folder contains all the groups of VPN tunnels defined by the administrator. VPN tunnel

groups are used to define the characteristics of a VPN: algorithms, topology of the VPN, VPN tunnel for

mobile devices, etc.

A VPN tunnel group allows you to simply configure a collection of VPN topologies with identical

characteristics.

Configuring Basic Settings

In the General configuration form you define the topology of the VPN including the type of tunnel and

community the Fast360 appliance is to implement, the authentication mode to be used, and the end

entities which will communicate through this VPN tunnel.

1. In the VPN explorer view, create a new VPN tunnel by right-clicking on the VPN Tunnels folder, select

New > VPN Tunnel. The VPN Tunnel configuration tab is displayed on the right.

2. In the Properties configuration form, enter a name and short description for the VPN tunnel in the

corresponding fields.

3. In the General configuration form, select the operating mode of the tunnel group from the Type drop-

down list:

• Select the Permanent tunnel type if you want the Fast360 appliance to try continuously to contact

the end of the VPN tunnel. The remote VPN device must have a fixed IP.

• Select the On Demand tunnel type if you want the Fast360 appliance to listen for a connection

request from the remote VPN device.

4. Drag and drop the VPN community into the Communities field.

Configuring Algorithm Parameters

1. In the VPN Tunnel configuration tab, select the Algorithm configuration form.

2. If required by your VPN topology, define the lifetime of IPsec keys in the four associated fields.

a. Define the lifetime of IKE keys, in seconds, in the IKE Key lifetime field. IKE is a key negotiation

which uses its own key. IKE identifies the two machines using shared keys, RSA keys or X.509

certificates.

b. Define the lifetime of IPsec keys, in seconds, in the IPsec Key lifetime field.

c. Define the time, in seconds, before renegotiation in the Negotiation lifetime field. This time

corresponds to the time during which the keys will be regenerated. For example, if you set this time

to 540 seconds, i.e. 9 minutes, the keys will be regenerated during the last 9 minutes of their life.

d. Define the random renegotiation rate in the Random renegotiation field. This option is very useful

where there are a large number of connections as it enables key renegotiations to be shared.

The percentage defined refers to the time before renegotiation. If you set random renegotiation to

100%, the program will try to renegotiate the keys over a period of time equal to the time before

renegotiation.

Note

The default parameters may be kept in most cases. These parameters are explained in detail

in Section 12.10, “Advanced VPN Topologies”.
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3. Define the list of algorithms for the first VPN negotiation phase shown by the Fast360 appliance in the

IKE algorithms table.

Note

If you select no algorithm, the Fast360 appliance will suggest by default the encryption

algorithms 3DES and AES (128 bits) and the authentication algorithms MD5 and SHA1.

However, when using the Fast360 appliances in “integrated security” mode, you must specify

the algorithms used to AES (256 bits) and SHA-2 (256 bits). These two values are available

by default.

a. Create a new entry in the IKE algorithms table by right-clicking in the blank area of the table, select

New > VPN Phase. The VPN Phase dialog box appears.

b. In the Encryption drop-down menu, choose between the 3DES, AES and DES encryption modes.

c. In the Authentication drop-down menu, choose between the MD5 and SHA1 authentication modes.

Note

If a VPN tunnel is defined for managing nomad workstations, the encryption algorithms

proposed must be identical on the Fast360 appliance for all the VPN tunnels containing

nomads as well as for the nomad VPN clients.

4. Define the list of algorithms for the second VPN negotiation phase shown by the Fast360 appliance

in the ESP algorithms table.

Note

If you do not select an algorithm, the Fast360 appliance will give the 3DES and AES (128 bit)

encryption algorithms and the MD5 and SHA1 authentication algorithms as default options.

a. Create a new entry in the IKE Algorithm table by right-clicking in the blank area of the table, select

New > VPN Phase. The VPN Phase dialog box appears.

b. In the Encryption drop-down menu, choose between the 3DES, AES and DES encryption modes.

c. In the Authentication drop-down menu, choose between the MD5 and SHA1 authentication modes.

Configuring Tunnels Linking Multiple Fast360  Appliances

The VPN Links configuration form is used to configure the features of the backup and load balancing VPN

tunnel. For a detailed explanation of the parameters configured in this form, see Section 12.10, “Advanced

VPN Topologies”.

1. In the VPN Links configuration form, create a new entry in the VPN Links table by right-clicking in the

blank area of the table, select New > VPN Links. The VPN Links dialog box appears.

2. In the Gateway A field, drag and drop the appliance interface serving as the source gateway.

3. Select the destination gateway from the Gateway B options:

• To use the default destination gateway, check the Automatic option.

• To define a specific destination gateway, check the Gateway option and drag and drop the

appliance interface into the corresponding field.

• To use a host, check the Host option and drag and drop a host object into the corresponding field.

4. Set the priority of the links in the Priority field. Note, the highest priority is priority 1 (9 is the lowest

priority). The different VPN tunnels of links are established permanently both for backup and VPN load

balancing.

5. To keep the flow unencrypted, check the Unencrypted option.
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6. To keep the flow uncompressed, check the Uncompressed option.

Configuring Advanced Parameters

The Advanced configuration form contains five parameters for advanced VPN tunnel configurations.

They are:

• Enable Perfect Forward Secrecy (PFS)

• Enable compression

• Enable DHCP over IPsec

• Enable Dead Peer Protection

The Enable Perfect Forward Secrecy (PFS)  option is checked by default.

Perfect Forward Secrecy

The use of PFS (Perfect Forward Secrecy) mode makes the various keys of a VPN session independent

of one another.

To dissociate the various session keys from one another, check the Enable Perfect Forward Secrecy

(PFS). With this option enabled, even if a hacker breaks one session key, he will not be able to break the

other keys. DH2 and DH5 groups are used in PFS.

Note

Activating this encryption option uses a large proportion of the system resources for the machine

concerned. This option is checked by default.

Compression of Encrypted Flows

The operation of the Fast360 appliance meets the following standards:

• RFC 1951 - DEFLATE Compressed Data Format Specification version 1.3

• RFC 2393 - IP Payload Compression Protocol (IPComp)

• RFC 2394 - IP Payload Compression Using DEFLATE

Compression in an IPsec tunnel uses the Deflate algorithm with the IPComp protocol.

The tunnel negotiation initiator (Quick Mode) suggests the use of compression it is configured for. The

result of the negotiation depends on the configuration of the initiator and the respondent. The following

table lists the negotiation rules.

Initiator Respondent Result of the negotiation

COMP COMP Compression negotiated

COMP Negotiation fails. Message

"compression proposed by x.x.x.x,

but policy for "conn.xx" forbids it"

COMP No compression negotiated

No compression negotiated
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If the bandwidth between the VPN tunnels is too narrow, check the Enable compression (deflate) option

to compress the flows going through the VPN and so increase the bit rate, provided that the remote VPN

device supports compression mode

DHCP over IPsec

The Enable DHCP over IPsec option is described in detail in the section called “Allocating an Address

via DHCP over IPsec”.

Dead Peer Detection

The Enable Dead Peer Protection feature detects loss of a Security Association (SA) between two VPN

devices. The method used for the Fast360 appliance is based on the method described in RFC 3706

(formerly draft-ietf-ipsec-dpd-03).

It works as follows:

1. Negotiation and use of Dead-Peer-Detection by basing on a specific VID.

(AF-CA-D7-13-68-A1-F1-C9-6B-86-96-FC-77-57-01-00). Both VPN devices must therefore have the

feature enabled in order to detect the loss of SAs.

2. Each end periodically sends a ISAKMP R_U_THERE packet when the tunnel is not in use.

The other end responds with a ISAKMP R_U_THERE_ACK packet. The frequency with which these

packets are sent is set via the parameter dpd_delay which was previously negotiated.

3. If there is no response and no traffic in the tunnel for a certain period of time (set by the dpd_timeout

parameter), the tunnel is considered as dead. If the tunnel is permanent, it is automatically re-initiated.

You are advised to Enable Dead Peer Protection in all cases (except for an Internet connection of the

RNIS type):

• In the case of a “permanent” VPN, this enables the negotiation to be re-initiated automatically.

• For an “on demand” VPN, this enables, in particular, a new connection arriving with the same

certificate but from another IP address to be accepted. The Fast360 appliance does not accept VPN

connection requests from two VPNs with the same certificate but a different VPN address. In this case,

the Fast360 appliance rejects the second connection, hence the advantage in checking Enable Dead

Peer Protection so that you know when the first VPN connection has dropped out.

Two values may be configured when the Enable Dead Peer Protection option is enabled:

• Delay: this parameter defines the frequency with which Dead-Peer-Detection packets are sent; it must

be greater than or equal to 10 seconds. The default value is 30 seconds.

• Timeout: this parameter defines the timeout interval from which the tunnel is considered as dead. This

value must be greater than or equal to 30 seconds. The default value is 120 seconds.
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12.5.2. Configuring VPN tunnels for Mobile Devices

VPN tunnels with mobile devices may be hard to configure because these devices use parameters which

cannot be easily modified (without a specific application) and these parameters are not implicit.

For instance, the specific parameters used by a digital tablet are:

• the end entity protected by the Fast360 appliance is always the 0.0.0.0/0 network (this way, once the

tunnel is established, the mobile device has a new default route which passes through the Fast360

appliance).

• the IKE configuration mode (CFG IKE) is enabled. This way, the Fast360 appliance attributes a virtual

IP address to the mobile device (the mobile device does not attribute to itself a virtual IP address as

a classical IPSec VPN client may do).

• there is no PFS (Perfect Forward Secrecy).

• there is no DPD (Dead Peer Detection).

VPN tunnels for mobile devices make the administrator's tasks easier. Indeed, the parameters described

above are enabled by default when creating this type of tunnel. Two additional parameters have to be

configured:

1. In the VPN explorer view, create a new VPN tunnel for mobile devices by right-clicking on the VPN

Tunnels folder, select New > VPN Tunnel for mobile devices. The VPN Tunnel for mobile devices

configuration tab is displayed on the right.

2. In the General configuration form, drag and drop the desired VPN community in the Communities field.

According to the VPN topology, the 0.0.0.0/0 network must be configured as the end entity composing

the community in a mesh topology, or as the center in a star topology.

3. This VPN type must use an X-Auth-type user authentication. In the X-Auth configuration form, check

the Use X-Auth authentication for users box. Drag and drop mobile users in the Users / User groups

field.

4. In the IP allocation configuration form, add the network in which virtual addresses must be sent.

5. To configure the other parameters of the configuration tab, refer to the Section 12.5.1, “Configuring

VPN Tunnel Groups”.

If there are errors in the configuration, coherency errors will display:

• no network is defined for the distribution of virtual IP addresses.

• a network for the distribution of virtual IP addresses is defined but the mask is either /0, /31 or /32. This

type of network is forbidden for a virtual address in “IKE configuration mode”.

12.6. Filtering Rules for VPN Tunnels

This section explains how to configure filtering rules for VPN tunnels, specifically:

• Configuring the output flow

• Configuring the input flow
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• Configuring a bi-directional flow

For a more general description of filtering rules, see Chapter 8, Basic Traffic Filtering Using Filtering Rules.

You configure these flows in the Encrypted segments table in the Action configuration form of the Rule

configuration tab.

Note

You can access the Encrypted Segment dialog box of the Encrypted segments table only when

the Accept option has been checked.

A VPN tunnel is established between VPN devices independently of filtering rules. The VPN

tunnel is used to ensure confidentiality of data - the filtering rules filter this data.

By default, encryption is Not encrypted: this means that if a tunnel has been set up corresponding to the

other characteristics of the filtering rule, the flow will not be encrypted.

The encryption options are:

• Not encrypted: the packets accepted by this filtering rule may not be encrypted.

• Encrypted through any defined tunnel: packets accepted by this filtering rule must be encrypted

according to one of the available VPN tunnels; the Fast360 appliance automatically chooses the

appropriate tunnel.

• Encrypted through specified tunnels: the packets accepted by this filtering rule must be encrypted in

accordance with the selected VPN tunnel group.

In the Encrypted Segment dialog box, you must also select the encrypted segment. The Fast360 appliance

object must be defined as Source if it has to encrypt the input packet; it is defined as Destination if it

has to decrypt the input packet.

Note

When the Fast360 appliance is the start of the encrypted segment, the encryption constitutes

an action on the packet. When the Fast360 appliance is the end of the encrypted segment,

the encryption is a characteristic of the input packet: if the encryption of the packet does not

correspond to that of the filtering rule, this filtering rule is judged unsuitable and further flow

rules are read.

12.6.1. Configuring the Output Flow

1. In the Rules folder, create a new filtering rule for the LAN protected by the Fast360 appliance to

the remote network(s) or nomad(s) by selecting the desired services. For detailed information on

configuring a new rule, see Section 8.3, “Creating a New Filtering Rule”.

2. Select the Action configuration form.

3. Check the Accept option. The Encrypted segments rule table is now accessible.

4. Create an encryption rule by right-clicking in the Encrypted segments blank table, select New >

Encrypted Segment. The Encrypted Segment dialog box appears.

5. Define that the encrypted segment is located between the Fast360 appliance at the head office and

the destination:

a. Drag and drop the Fast360 appliance into the Source field.

b. Drag and drop a destination object into the Destination field.

c. Check the Encrypted through specified tunnels option.
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d. Drag and drop the VPN tunnel group for this filtering rule into the VPN Tunnels field.

Note

For a multi-appliances configuration, if the destination is protected by another Fast360 appliance,

the Fast360 appliance object concerned must be selected as destination.

12.6.2. Configuring the Input Flow

1. In the Rules folder, create a filtering rule for the LAN protected by the Fast360 appliance to the remote

LAN/nomad by selecting the desired services. For detailed information on configuring a new rule, see

Section 8.3, “Creating a New Filtering Rule”.

2. Select the Action configuration form.

3. Check the Accept option; the Encrypted segments rule table is now accessible.

4. Create an encryption rule by right-clicking in the Encrypted segments blank table, select New >

Encrypted Segment. The Encrypted Segment dialog box appears.

5. Define that the encrypted segment is located between the Fast360 appliance at the head office and

the destination:

a. Drag and drop a source object into the Source field.

b. Drag and drop the Fast360 appliance head office object into the Destination field.

c. Check the Encrypted through specified tunnels option.

d. Drag and drop the VPN tunnel group for this filtering rule into the VPN Tunnels field.

Note

For a multi-appliances configuration, if the source is protected by another Fast360 appliance, the

Fast360 appliance object concerned must be selected as source.

12.6.3. Configuring a Bi-directional Rule

1. In the Rules folder, create a new filtering rule with the LAN protected by the Fast360 appliance and

the remote LAN/nomad as source and destination by selecting the desired services. For detailed

information on configuring a new rule, see Section 8.3, “Creating a New Filtering Rule”.

2. Select the Action configuration form.

3. Check the Accept option. The Encrypted segments rule table is now accessible.

4. Create an encryption rule by right-clicking in the Encrypted segments blank table, select New >

Encrypted Segment. The Encrypted Segment dialog box appears.

5. Define that the encrypted segment is located between the Fast360 appliance and the object:

a. Drag and drop a Fast360 appliance object into the Source field.

b. Drag and drop a destination object into the Destination field.

c. Check the Encrypted through specified tunnels option.

d. Drag and drop the VPN tunnel group for this filtering rule into the VPN Tunnels field.

Note

For a multi-appliances configuration, if the destination is protected by another Fast360

appliance, the Fast360 appliance object concerned must be selected as destination.

6. Configure the VPN tunnel by double-clicking on the VPN Tunnel icon. The VPN Tunnel configuration

form appears.
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a. Drag and drop a source object into the Source field.

b. Drag and drop a Fast360 appliance object into the Destination field.

c. Check the Encrypted through specified tunnels option.

d. Drag and drop the VPN tunnel group for this filtering rule into the VPN Tunnels field.

Note

For a multi-appliances configuration, if the source is on another Fast360 appliance, the Fast360

appliance object concerned must be selected as source.

12.7. Revoking a VPN access

To delete a VPN access to a user (VPN Host-to-LAN) or a remote gateway (VPN LAN-to-LAN):

• in the case of a tunnel with an authentication with the X.509 certificate in the CA part, revoke the user

certificate or the remote gateway certificate

• in the configuration, delete the VPN tunnel and the community referencing the user, the remote

gateway or the network whose VPN gateway is the remote gateway.

In the case of a community that references more than two extreme entities, you must remove the

extreme entity referencing the user, the remote gateway or network with a VPN gateway is the remote

gateway.

12.8. Using a CRL with VPN Tunnels

12.8.1. Generating the CRLVPN

Within a VPN, the CRL is managed through the external PKI server and is provided to Fast360 appliances

by administrators via a HTTP URL or LDAP

12.8.2. Retrieving the CRL VPN with appliances

The CRL is retrieved from an external URL configured in Arkoon Manager (at a frequency which is also

configured) in the Certificate object representing the CA of the external PKI. This certificate is referenced

by the External PKI object, which is also referenced in the VPN policy of appliances.

12.8.3. Implementing grace periods for CRL VPN

You must provide the /config_card/etc/arkoon-config.local file with the following keys (the values

must be adjusted to the security policy):

# Propose a grace period before CRL really expires
ipsec.crl-grace-days = 7
# .. and impose expiration to become strict
ipsec.strictcrlpolicy = yes

Restart the IPSec service to take the settings into account.
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12.9. Features Dependant on the Type of Tunnel

12.9.1. LAN-to-LAN Tunnel

IP of VPN gateway masked by a router in multi-appliances architecture.

Defining the Authorized VPN Server

1. In the Network objects explorer view, create a new host object.

2. In the Network configuration form, enter the public IP of the router as the fixed IP address in the

corresponding field.

3. Go to the Security configuration form of the Fast360 appliance configuration tab.

4. Select the VPN folder. The parameters to be configured are displayed on the right.

5. Drag and drop the appropriate host masking the VPN gateway into the Networks field in the

Authorized networks section.

Specifying the Public IP Address

You also need to specify the public IP address of the Fast360 appliance which is hidden by a router.

1. In the Network objects explorer view, expand the Fast360 appliance folder. The Internet Access folder

is displayed in the explorer view.

2. In the Internet Access configuration form, select the Advanced configuration form.

3. Check the Configure public IP address and Fixed options and the public IP address of the router

masking the VPN gateway in the corresponding field.

12.9.2. Host-to-LAN Tunnel

Allocating a Virtual IP Address

The Fast360 appliance allows a virtual address to be assigned to a VPN client. This virtual address must

not belong to one of the internal networks known by the Fast360 appliance for routing reasons.

The assignment of a virtual IP address has the advantage of:

• Making the nomad visible on the internal network with a given IP address (in general private).

• Enabling specific filtering rules to be written for nomads by specifying their virtual address as source

or destination.
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• Identifying connections associated with each nomad in the IP logs even if it uses a different public

address each time.

When using a virtual IP, the Fast360 appliance acts as an ARP proxy for this address. In the case of the

DHCP-over-IPsec (or manual assignment of a LAN address), this mechanism makes the nomad visible

on the LAN.

1. In the Roadwarriors security configuration form of the VPN Policy configuration tab:

a. Drag and drop the network objects configured with the IP address or the virtual LAN of nomad

clients allowed to set up a VPN tunnel into the Authorized virtual IP addresses field.

b. Drag and drop the network objects configured with IP addresses which are not allowed to be used

by nomad workstations or remote VPN gateways (typically internal networks protected by a Fast360

appliance) into the Forbidden virtual IP addresses field.

Allocating an Address via DHCP over IPsec

The implementation uses the RFC 3546 (Dynamic Host Configuration Protocol (DHCPv4) - Configuration

of IPsec Tunnel Mode).

The 'DHCP-over-IPsec' feature enables a nomad to use an address assigned by a DHCP server situated

on the LAN as virtual address.

This works as follows:

1. The nomad negotiates a DHCP SA.

Note

In  Arkoon Monitoring , the DHCP SA appears in the VPN window and you will see a line of

the type:

Any :17/68=0.0.0.0/017/67

2. The nomad sends a DHCP request via the DHCP tunnel.

3. The Fast360 appliance modifies the request to set the Agent Circuit Id sub-option to the value 'ipsec'

then it sends it to the DHCP server.

4. The Fast360 appliance proxies the response from the DHCP server, containing among other things,

the IP address assigned.

5. The nomad negotiates the tunnel using the IP address assigned.

6. Subsequently, if its IP address is renewed, the nomad uses the tunnel already set up without creating

a new DHCP SA. The DHCP server must support the DHCP Relay Agent Information option to work

in this mode.

The DHCP server from the Internet Software Consortium (ISC) has been validated in this context.

The Agent Circuit Id sub-option can be used in the configuration of the server to define the address range.

IP assigned to the VPN nomads. This can be useful for restricting the virtual addresses authorized to this

range and to prevent a nomad from taking an address normally intended for a LAN.
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# vpn client class class "vpn-clients"
{match if option agent.circuit-id = "ipsec";}
subnet 192.168.0.0 netmask 255.255.254.0
    {[...]
     pool {
           deny members of "vpn-clients";
           range 192.168.0.100 192.168.0.254;
           [...]
           }
     pool {
           allow members of "vpn-clients";
           range 192.168.1.100 192.168.1.254;
           [...]
           }
    }

Defining the DHCP Server

To allow a nomad to use an address assigned by a DHCP server situated on the LAN as a virtual address,

complete the following procedure.

1. In the Network objects explorer view, create a new host object.

2. In the Network configuration form, enter the internal IP address to which the Fast360 appliance can

connect in the corresponding field.

3. In the Services configuration form, check the DHCP Server option to configure the host with the DHCP

server capability.

4. Select the VPN Policy configuration tab.

5. In the Settings configuration form:

a. Check the Enable DHCP option.

b. Drag and drop the host, previously configured with the DHCP capability, into the DHCP Server field.

6. In the Virtual IP addresses configuration form, drag and drop the network object configured with the

IP address range used by the DHCP server into the Authorized virtual IP addresses field.

To enable a remote client to use an address assigned by a DHCP server situated on the LAN as a virtual

address, check the Enable DHCP over IPsec option in the Advanced configuration form of the VPN Tunnel

configuration tab.

DHCP over IPsec Special Filtering Rule

The implementation of the DHCP over IPsec feature requires a special filtering rule authorizing DHCP

requests from the nomad destined for the DHCP server to be implemented.

1. In the Rules explorer view, create a new rule. For detailed information on configuring rules, see

Section 8.3, “Creating a New Filtering Rule”.

2. In the Rule configuration tab, select the Criteria configuration form.

3. Drag and drop a source object “Internet” network object configured with 0.0.0.0/0 as the IP address

into the Sources field.

4. Drag and drop the destination “DHCP server” host object with the IP address of the DHCP server into

the Destinations field.

5. Drag and drop the DHCP (service defined with UDP protocol, destination port 67 and source port 68)

service object into the Services field.

6. In the Action configuration form configure a segment encrypted from “source” to the Fast360

appliance, encrypted with a suitable VPN tunnel group. For detailed information, see the section called

“Configuring Encrypted Segments”.
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Authentication by an External PKI Architecture

Where the certificates of the external CA are stored on an LDAP server, it is extremely advantageous to

use the LDAP groups to manage the rights of the users of the VPN. Part of the management of the VPN

policy is therefore transferred to the LDAP server.

12.10. Advanced VPN Topologies

12.10.1. VPN Backup and Load Balancing

The backup and load balancing functionalities depend on the existence of multiple VPN tunnels between

peer gateways.

Each link corresponds to a different VPN topology. Thus, for each link, a VPN tunnel is set up when the

Fast360 appliance boots up.

A link is defined by the following items:

• A source gateway: a Fast360 appliance and its interface/Internet access

• A destination gateway (optional): A Fast360 appliance (multi-appliances configuration) or a remote

VPN gateway

• A priority

• Properties (encrypted link, compressed link, lifetime of link).

The VPN flow travels across a link according to the priority of this link and whether links with higher

priorities are operating properly or not.

The encryption and compression properties of the flow in the VPN Links table of the VPN Links

configuration form have priority over the properties entered in the Algorithms and Advanced

configuration forms of the VPN tunnel group.

The difference between the load balancing and backup VPN is in the priority of the links:

• If multiple links have the same priority, the network packets are sent equally on each link. This is “load

balancing”.

• If multiple links have different priorities, the link with the highest priority is used exclusively. When this

link goes down, the VPN will use the lowest priority link. This is “VPN backup”.

Note

The highest priority is priority 1 (9 is the lowest priority).

Backup VPN

You can define a main link used to set up the VPN tunnel and one or more backup links.

When the main link is detected to be unavailable (using the Enable Dead Peer Detection feature), the

secondary link is used. When the main VPN link becomes operational again, it is used once more, and

the secondary link is no longer in use.

If the backup link is a private line (specialized line or other), flows may not be encrypted.



Chapter 12. Configuring IPsec VPN Tunnels

250 | VPN Backup and Load Balancing

Load Balancing

VPN flows may be distributed between multiple VPN links. Thus packets to be transmitted are sent equally

between the various active VPN links. If a load balancing link becomes unavailable, the VPN flow is

distributed between the various remaining links. When the link becomes operational again, the VPN flow

once again uses all the VPN tunnels.

Note

In case of VPN backup or load balancing, the VPN topology prevents using more than one link

with a dynamic IP address.

Example Configuration

The Enable Dead Peer Detection option must be checked in the Advanced configuration form of the

VPN tunnel group. Other aspects of these features are configured in the VpnLink table of the ListLink

configuration form of the VPN tunnel group being configured.

Here is an example of the application of these features.

A company has two Internet access connections at its head office and at a branch office.

The head office and the branch are also connected via a leased line.

We shall only deal with the configuration of these links. They are configured in the Priority field in the VPN

Links table. This table is in the VPN Links configuration form of the VPN tunnel group being configured.

Here is an example of the application of these features.

LINK NO. VPN GATEWAY A VPN GATEWAY B PRIORITY OPTION

1 Fast360 HEAD

OFFICE / INTERNET

ACCESS 1

INTERNET ACCESS

1 /Fast360 BRANCH

1

2 Fast360 HEAD

OFFICE / INTERNET

ACCESS 2

INTERNET ACCESS

2 /Fast360 BRANCH

1

3 Fast360 HEAD

OFFICE / ETH3

ETH3/ Fast360

BRANCH

2 NON-ENCRYPTED

LINK

Once this configuration has been applied, we have the following behaviors:

• 3 VPN tunnels are set up (1 per link)

• Load balancing operates between links 1 and 2 as they have the same priority
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• Link no. 3 (the leased line) is not normally used as its priority is lower.

Example of Behavior

If Internet access 1 of the “Fast360 head office” is no longer operational, link no. 1 is no longer operational:

• All traffic moves to link 2.

• Link no. 3 is not used as its priority is lower.

If link 2 also became unavailable:

• Link 3 takes over

12.10.2. Setting up a VPN Tunnel to a Specific IP Destination on a

LAN

To set up a VPN tunnel to a specific and exclusive IP destination on a LAN protected by the Fast360

appliance, an object of type LAN must be created with the IP address of the host to be reached, a 32 bit

network mask and the Fast360 appliance object as VPN gateway.

This is represented by the following example topology:

Host_IP_address == Fast360_Central…..Fast360_remote === Remote_LAN_IP_address

In this case only the specified host IP can be contacted by devices on the remote LAN.
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12.10.3. Algorithm Parameters for a Tunnel Group

Algorithm parameters for the tunnel group are configured in the Algorithms configuration form of the

VPN Tunnel configuration tab.

This section explains the parameters in detail. To configure these parameters, see the section called

“Configuring Algorithm Parameters”.

IKE key lifetime: IKE is a key negotiation which uses its own key. IKE identifies the two machines using

shared keys, RSA keys or X.509 certificates. The IKE Key Lifetime is defined in seconds.

IPsec key lifetime: IPsec keys regenerate themselves automatically; Arkoon Manager lets you define

their lifetime (in seconds).

Negotiation lifetime: the time, in seconds, during which the keys will be regenerated. For example, if you

set this time to 540 seconds, i.e. 9 minutes, the keys will be regenerated during the last 9 minutes of their

life.

Random renegotiation: defined as a percentage, it refers to the time before renegotiation. If you set

random renegotiation to 100%, the program will try to renegotiate the keys over a period of time equal

to the time before renegotiation. This option is very useful where the are a large number of connections

as it enables key renegotiations to be shared.

12.10.4. Managing VPN Authentication and Permission with an

External PKI

The Private Key Infrastructure (PKI) feature enables Fast360 appliances to delegate VPN authentication

and permission to an existing PKI. It is also possible to use this feature to authenticate users flows.

To configure it:

1. From Authentication, right-click on the PKI folder, and then choose Create > PKI.

The PKI configuration tab is displayed.

2. Select the Properties configuration form.

a. Enter the server name in Name.

b. Enter any comment in Description.

3. From the Certificates form of the PKI object, create an X.509 certificate object and import the

certification authority certificate into PEM or DER format. This CA certificate will be considered as a

warrant of identity for the customers displaying a X.509 certificate it signed.

The CA maximal hierarchy level must be configured if the certification authority has several levels. It

defines the certification depth you want to accept.

For example:

• You have a certification authority with two levels, the root certification authority is named “Root CA”

and the intermediate certification authority is named “Delegate CA” and is signed by the “Root CA”.

• You import a trusted certificate (containing the “Root CA” certificate) into your PKI object.
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• You configure your “CA maximal hierarchy level” to 1. If a customer provides an X.509 certificate

signed by the “Delegate CA”, it will not be considered as trusted. However, if a client provides an

X.509 certificate signed by the “Root CA”, it will be considered as trusted.

• For a certificate signed by the “Delegate CA”, to be trustful, you must:

• configure the “CA maximal hierarchy level” to 2.

• configure the “CA maximal hierarchy level” to 1 but import both certification authority certificates

into the “trusted certificate” section of the PKI object, that is “Root CA” and “Delegate CA”.

4. If a CRL is available, select the CRL configuration form, then select the Periodically retrieve CRL box

and determine the number of minutes between two automatic retrievals.

5. You must define the location for these CRLs from the Certificate field representing the trusted

certificate previously created and selected:

• In the Certificate Revocation Lists tab, select Import from default sources in certificate to indicate

the sources specified in the X.509 certificate imported in the X.509 Certificate tab of the Certificate

object.

• Or indicate the sources by indicating the HTTP or LDAP URLs in the CRL Import Address field. For

both protocols, it is necessary to create a dedicated flow rule allowing the Fast360 appliance to

establish the connection necessary to retrieve the CRL.

Note

An LDAP URL can contain various and complete filtering parameters. Refer to RFC/2255 for

more details.

6. Drag and drop the external PKI server into the form:

• If integrating an external PKI for the VPN module: into a VPN policy which will be associated to

the appliance.

• If integrating an external PKI to authenticate the user's flows: into the Security > Authentication >

External PKI > PKI server of your Fast360 appliance.

12.10.5. Integrating a Fast360 appliance within an external PKI with

an LDAP server

If you want to delegate the authentication and permission management to an external PKI, it is necessary

to have an LDAP server associated with an external PKI.

Warning

It is recommended to know the functioning and configuration of the LDAP server, as well as own

an LDAP server to accurately access its content.

Within the LDAP infrastructure, you must:

• have one or several groups of users objects.

• a group of users references a bunch of users. For each user contained within this group, it is necessary

to have a “member” LDAP attribute which represents the LDAP DN representing the user.

• for example, onto an LDAP server, a group object which DN is CN = group2, DC = Arkoon,DC = Net

references two users. There will be two member attributes which value is:

• member = "CN = User 1, OU = Users, DC = Arkoon, DC = Net "
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• member = "CN = User 2, OU = Users, DC = Arkoon, DC = Net"

• Warning: within groups, it is essential to have the member attribute, which will reference the user's DN.

• This attribute is then named “member attribute”.

These objects representing the groups of users in the Arkoon Manager configuration, are named “VPN

groups”.

1. Find a unique and common identifier for certificates distributed by the PKI and objects representing

the users within the LDAP tree, among the following choices:

a. DN (Distinguished Name): the Distinguished Name included into the user's certificate must be

strictly identical to the user's DN within the LDAP database.

b. Certificate: within the objects representing the users in the LDAP tree, you must have an attribute

containing the exact replica of the certificate provided by the user.

c. RDN (Relative DN): this term defines the various fields contained within the user's certificate

DN. For example, the UID (user id), CN (Common Name) or E (Email) field. Within the objects

representing the users in the LDAP tree, you must have an LDAP attribute containing the exact

replica of the value contained in the field.

Note

This mode is the easiest and the most used.

2. Depending on the common attribute you previously chose, activate the retrieval of LDAP groups from

the LDAP groups form of the PKI object, and then select one choice: DN, Certificat or RDN.

Note

Regarding RDN, if the selected attribute contained within the certificate, is not named like the

attribute from the LDAP server, you must use the following syntax: <attribute name in the

certificate DN>/<attribute name in LDAP object>. For example: “CN/Uid” if the CN

field value in the certificate is systematically equal to the Uid attribute value representing the

user in the LDAP tree.

3. Create a host object with the LDAP server capacity and then:

• in User object Class, enter the “object class” corresponding to the objects representing your users

within your LDAP tree. In this case, the User ID LDAP atttribute field is not used.

• in Groups:

• in Group object Class , enter the “object class” corresponding to the objects representing your

group of users within your LDAP tree.

• fill in the Group ID LDAP atttribute field according to the LDAP attribute which will be used to

name VPN groups objects in the configuration.

• fill in the group member LDAP attribute  with the chosen “member attribute”.

4. Drag and drop the LDAP server into the LDAP groups  form of the PKI object as well as the Security

> Authentication > Authentication form of your Fast360 appliance.

5. Install the configuration and retrieve automatically the groups from the LDAP server object you

previously created. You must only retrieve the “VPN groups” created on your LDAP server.

6. It is necessary to create objects representing VPN users into the configuration. From now, to allow a

new user to negociate a VPN tunnel with the Fast360 appliance, you must:

a. provide the user with a certificate signed by the trusted CA specified within the PKI object.

b. within the LDAP server, reference the object representing the user in the VPN group object.
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c. configure the imported group of users into the appliance corresponding to the VPN group, as an

entity of the chosen VPN community object .

d. after the configuration installation, the user can negociate a VPN with the Fast360 appliance.

e. all the users which will be referenced later within the LDAP VPN group and with the correct

certificate, will be able to negociate a VPN tunnel with the appliance with no direct administration

action on the Fast360 appliance.

This configuration enables to move the VPN users authentication and permission to the external PKI.

There is no need to import certificates or users into Arkoon Manager configuration anymore.

When negociating a VPN tunnel, the debug logs can be accessed via the system logs file.

12.10.6. Integrating a Fast360 appliance within an external PKI

without an LDAP server

If you only want to delegate authentication management to the external PKI:

1. From the external PKI object, do not modify the LDAP groups configuration form.

2. Do not import the customers certificates into the configuration.

From now, to allow a user to authenticate onto the appliance, you must:

• provide the user with a certificate signed by the trusted CA specified within the PKI object.

• create a User object, and then within Parameters, select DN and complete the user's certificate

Distinguished Name.

• for VPN, select directly the user or via a group of users as an entity of the chosen VPN community

object.

• for flow authentication, select directly the user or via a group of users from the flow rule Users

section.

• after the configuration installation, this user will be able to authenticate onto the Fast360 appliance.

12.10.7. Using a Specific Certificate for Authenticating the Fast360

Appliance

By default the Fast360 appliance uses its own certificate (the same one that is used for administration

connections) to authenticate itself during the establishment of VPN tunnels.

However, you can configure the use of another certificate for establishing VPNs. This certificate must be

imported via  minarkconf (SSH connection, Certificates-Import-External certificate for VPN menu). The

certificate provided by the external CA must be in PKCS#12 format and contain the following items:

• Private key

• Certificate

• CA certificate

The Key Usage attribute of the certificate must include the following values: Digital Signature, Non

Repudiation, Key Encipherment.
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This feature is often used when user authentication is based on an external PKI.

12.10.8. PSK Shared Key

Configuring Authentication by Shared Key

1. In the VPN explorer view, create a new shared key object by right-clicking on the VPN Communities

folder, select New > VPN Community. The VPN Community configuration tab is displayed on the right.

2. In the Properties configuration form, enter a name and short description for the shared key in the

corresponding fields.

3. In the Entities configuration form, drag and drop the end entities of the tunnel into the Entities field.

4. In the Authentication configuration form, check the Shared key option and enter the authentication

code for the key in the corresponding field.

The authentication code is a series of characters which may be made up of letters, digits and symbols

according to the administrator's choice.

Note

The configuration of a VPN tunnel in shared key mode with a remote host whose IP address is

masked by another device is a special case explained in article KB 768 in our knowledge base

(http://client.arkoon.net)

Important

IKE protocol “Main” mode imposes a limitation on the use of shared keys. All VPN communities

of a same Fast360 appliance must use the same shared key.

12.10.9. RSA Key

Authentication by RSA key is only given for interoperability with systems which only offer this type of

authentication. In other cases the use of X.509 certificates is strongly recommended. The key to use is

determined according to the IPsec ID provided. This may be one of a number of types:

• ID IPV4 ADDR (192.168.10.5)

• ID FQDN (@arkoon-foo)

• ID USER FQDN (bob@arkoon.net)

• ID DER ASN1 DN (CN=..., O=..., C=...)

• ID KEY ID (@#xxxxxxxxxx)

Configuring Authentication by RSA Key

1. In the Network objects explorer view, create a host object.

2. Select the VPN configuration form.

3. Check the Custom IPsec ID option and enter the IPsec ID in the corresponding field.

4. Enter the RSA key in the corresponding field.

5. In the VPN Community configuration tab, select the Authentication configuration form.

http://client.arkoon.net
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6. Check the RSA key option to specify that the authentication used in the VPN community is based on

the RSA key.

12.11. Supported Protocols and Algorithms

12.11.1. IPsec Protocols

Negotiation of Session Keys

This is automatic and carried out using IKE protocol. The modes supported are “Main mode” and “Quick

mode”.

“Aggressive mode” is not supported.

IPsec Protocol

ESP — Provides a confidentiality and authentication feature (encryption).

Diffie-Hellman

• Group1 - MODP768b (only in DES mode)

• Group2 - MODP1024b

• Group5 - MODP1536b

• Group14 - MODP2048b

• Group15 - MODP3072b

• Group16 - MODP4096b

12.11.2. Authentication Methods

Implementing a VPN tunnel enables communications to be established securely. To achieve this, the

two entities which negotiate the VPN tunnel must firstly authenticate themselves. The authentication

methods available on the Fast360 appliance are given below.

X.509 Certificate

The use of X.509 certificates is the solution which gives the best level of security for establishing VPN

tunnels. The DN (Distinguished Name) of the certificate is then used as IPsec ID (ID DER ASN1 DN).

Warning

The robustness of this method of authentication relies in particular on the method used for

generating the X.509 certificate. When generating a certificate in PKCS#12 format, it is important

to choose a robust password for protecting the certificate. Indeed, certain information, such

as the private key used for authenticating and negotiating secure SSL connections, is strictly

confidential. If divulged to a third party, the certificate could be revoked. The password protecting

access to the PKCS#12 file must be suitably strong and follow the rules for constructing

passwords required by  minarkconf .
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Shared Key (PSK)

The use of a shared key (or shared secret) is the simplest authentication method to implement, but also

the least secure: an attack “by dictionary” is always possible. The IPsec ID used is the IP address of

the Fast360 appliance.

Warning

The robustness of the authentication method depends on:

• How strong the password is (strength against attack “by dictionary”).

• How safe the method for transferring the shared key is.

X-Auth Authentication

X-Auth authentication allows adding a strong user authentication in addition to hardware entities

authentication. It is particularly useful for VPN tunnels established with mobile devices such as digital

tablets and smartphones (Host-to-LAN configuration). The X-Auth protocol allows identifying users

defined on an external authentication server or locally in the Arkoon Manager configuration.

RSA Key

Authentication by RSA key is only given for interoperability with systems which only offer this type of

authentication. In other cases the use of X.509 certificates is strongly recommended. The key to use is

determined according to the IPsec ID provided. This may be one of a number of types:

• ID IPV4 ADDR (192.168.10.5)

• ID FQDN (@arkoon-foo)

• ID USER FQDN (bob@arkoon.net)

• ID DER ASN1 DN (CN=..., O=..., C=...)

• ID KEY ID (@#xxxxxxxxxx)

12.11.3. Authentication Algorithms

• HMAC MD5

• HMAC SHA1

• SHA256

12.11.4. Encryption Algorithms

• DES (56 bits)

• 3DES (168 bits)

• Blowfish (128 bits)

• AES (128, 192, 256 bits)
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Chapter 13. HA and HP Clustering

13.1. Introduction

Business-critical applications must be continuously available to an organization and secure at the same

time. Cluster implementations can be used to improve the availability of such services provided by the

network. Redundancy can be provided by different network configurations according to an organization

requirements.

The Fast360 appliance clustering feature provides two options for high availability of services.

• High availability (HA) mode:

One appliance is in active mode and the other is in passive mode, on standby to take over in case of

failure of the active node.

• High performance (HP) mode:

Both appliances are active at the same time, working in active/active mode. If one of the active Fast360

appliances fails, the other takes over to handle all of the network traffic.

Note

It is possible to use each of these modes if there are linked via the license used on each

appliance.

13.2. Clustering Principles

This section describes the concepts, terminology, and mechanisms involved in clustering Fast360

appliances.

Appliances can share logs or connection status, for example to restore services in case of dysfunction

of the appliance. A cluster is composed of two appliances named nodes.

Important

Clustering involves implementing two identical appliances (equipment and system version must

be identical). These appliances provide identical functional services and, to some extent, share

the same configuration.

The appliances may share such information as audit traces (i.e. logs) or connection states to recover

services in case of the failure of one node. A cluster is made of two appliances also called nodes.

Clustering can be configured in two different working modes: High Availability (HA) and High

Performance (HP).
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13.2.1. High Availability (HA)

In the High Availability mode, one node is active while the other one is passive, waiting to resume services

in case the first node fails. If performance was 100% of a single node before failure, it remains 100%

of a single node after failure. Failover, i.e. downtime, duration is a key performance indicator of a high

availability cluster. This mode is also referred to as Active/Passive mode.

The figure below illustrates active/passive mode. One Fast360 appliance acts as master and the other as

a backup of the master. The master propagates all its configurations, logs and current active connections

to the backup. If the active Fast360 appliance fails, the backup appliance is promoted to active, and takes

over the traffic processing.

Figure 13.1. Network Architecture for HA Mode

Active Passive

Master Slave

13.2.2. High Performance (HP)

In High Performance mode, both nodes of the cluster are active at the same time. This configuration

emulates a high performance appliance. In case of a node failure, the other node may recover the failed

node's serviced connections.

Important

High performance is not exactly high availability as service level is degraded to some extent

when a node fails. To increase the availability level fo a HP cluster, it is recommended to have

a spare appliance identical to the other two appliances. The administrator can manually insert

this appliance into the cluste in case of prolonged node failure.

The figure below illustrates active/active mode. Both Fast360 appliances are configured to be active.

Each Fast360 appliance is responsible for a part of the network traffic (distributed by an external load-

balancing device, for example). If one Fast360 appliance fails, the other one handles all the traffic.
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Figure 13.2. Network Architecture for HP Mode

Active Active Failure Active

Node 1 Node 2 Node 1 Node 2

Load Balancing for High Performance (HP) cluster

The Fast360 HP cluster solution does not implement itself load balancing between two nodes. This must

be implemented by the network administrator.

For more information about integrating an HP cluster, see Section 13.10.1, “Integrating a HP Cluster”.

13.2.3. Comparison of High Availability and High Performance

The following figure illustrates differences between high availability and high performance modes.

Figure 13.3. Comparison of High Availability and High Performance Modes
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13.2.4. IP Addressing

Real IP Addresses

Real IP addresses are IP addresses assigned to one specific cluster node. They are always active on this

node when the appliance works and they will never be assigned to the other node, even in case of failure.

Virtual IP Addresses

Virtual IP addresses are IP addresses used by the cluster to interoperate with other network devices and

services. These addresses can be active on any cluster node depending on the node state. Indeed, a

virtual IP address can be assigned to any node during the cluster's life. However, you will need to define

the node to which it will preferably be assigned: if both nodes are in a correct state, this assigned node

will receive the virtual IP address.

13.2.5. Cluster Master Node

The cluster master node is the cluster node that must be used when connecting to the cluster with

Arkoon Manager. This node is responsible for relaying management requests to the other node as well

as replication for configuration files.

In a master/slave architecture, the cluster master node is responsible for the cluster communication with

the other nodes of the architecture.

Note

It is recommended to use only the cluster master node to manage the cluster in order to avoid

the loss of administration data. A configuration installed on a non-master node is not replicated

on the master node.

Note

Each node in the cluster can be monitored individually using  Arkoon Monitoring connected on

real IP addresses.

13.2.6. Determining Cluster Master Node

In a configuration, the role of the cluster master node is attributed to the node with a particular virtual

IP address defined by the administrator. This IP address is named Cluster master node Address. In

normal functioning, the cluster master node will probably be the node on which the virtual IP address

is assigned.

If this virtual IP address goes to the other node, this node automatically becomes the new cluster master

node. You can see this Cluster Master Node status in the Cluster section into Arkoon Monitoring.

Important

The virtual IP address of the cluster master node must be a virtual IP address held by the

same cluster. This IP address must be held by an Ethernet interface (VLAN, bonding, or bridge

interfaces are not supported).

The node interface is then named Cluster master node interface.

This interface can be used to
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• replicate configuration files and roles database between both cluster nodes.

• synchronize audit traces (logs from different sources) between both cluster nodes

Note

The HA master node always try to be the master.

13.3. Implementing High Availability (HA) Clustering

13.3.1. Initializing a High Availability (HA) Cluster

Initializing a cluster involves five principal stages:

1. Initializing both appliances of a cluster.

2. Converting the first appliance into a cluster with one node.

3. Creating the second node in the configuration.

4. Publishing the second node.

5. Failover test for High Availability (HA). This step is optional.

Prerequisite

Arkoon Manager must be directly connected to the future cluster master node to implement the cluster.

It is not possible to initialize a cluster if Arkoon Manager is connected to an AMC server.

1st step: Initializing Both Appliances of a Cluster

The first appliance of the cluster (the future master node) must have been initialized to be administered :

IP address, CA, FIREWALL and ADMIN certificates, role base, license to activate the clustering.

It is also necessary to prepare the appliance which will be the second node of the cluster and to create

its PKCS#12 certificate.

1. Initialize the second appliance with minarkconf (refer to chapter 6 in the First-Time Configuration

Guide).

2. Configure a first interface with an IP address on the same IP network as the PC running Arkoon

Manager.

3. Create a new PKCS#12 FIREWALL certificate for the second node by using the same Certification

Authority as the one used to create the first node's certificate.

Caution

A PKCS#12 file contains more than just a certificate. It contains strictly confidential data

(among which the firewall private key). A unique certificate should be created for each

firewall. The certificate must only be stored onto the firewall or in a place with a security

level at least equivalent to the security level of the certificate use.

4. If you do not have it yet, retrieve the license for the second appliance on http://license.arkoon.net.

http://license.arkoon.net
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2nd step: Converting the First Appliance into a Cluster with one Node

The second stage of the implementation of a cluster involves converting the first appliance into a cluster

with one node.

1. Connect Arkoon Manager to the appliance.

2. Load the current remote configuration or create a new one (see Chapter 5 in the First-Time

Configuration Guide).

3. Right-click on the Appliance object and select Switch to cluster from the drop-down menu to

convert the appliance to a cluster.

After selected Switch to cluster, the cluster hostname must be changed in order to be different

from the node 1 hostname.

Note

It is recommended to rename this node to add clarity to the configuration, by selecting Edit

in the contextual menu. This name is not linked with the system hostname.

Note

Once the cluster is implemented, it is necessary to update the appliance admin from

if the interface name was precised. For example, replace 192.168.0.254 (ethX) by

192.168.0.254 (vrrpv2gY)

4. In the explorer view, select the Node object.

The IP addresses initially configured on the standalone Fast360 appliance are used as virtual IP

addresses. The node real IP addresses must be configured manually. Cluster mechanisms use

virtual interfaces and thus the alias previously configured are not kept.

The node real interfaces are displayed in the descriptive view for each interface to configure.

Double-click the node interface (or right-click > Edit) to open the Node Ethernet Interface

configuration form to the right.
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In this form:

a. Enter the node real IP address in the corresponding field.

b. Enter the netmask in the corresponding field.

Note

It is recommended you configure the real IP addresses of a cluster interface within the

same network addressing map than its virtual IP addresses.

5. If you want to modify the cluster virtual interfaces (activate a virtual interface, change a virtual IP

address, add an alias), follow the steps below:

In the explorer view, select the cluster Interfaces folder. The cluster virtual interfaces can be seen

in the configuration form.

In the descriptive view, double-click on the desired interface.

The Cluster Ethernet Interface configuration form opens on the right.

In the Cluster Ethernet Interface configuration form:

a. Check the Enable this interface box to enable the selected interface.

b. Double-click on the existing entry in the Virtual IP Addresses  table to open the Virtual IP

Address pop-up window.

c. Update the virtual IP address in the corresponding field.

Note

Different virtual IP addresses can be configured for the same interface. In this case,

only the first virtual IP address can be used to configure a VPN tunnel.

d. Update the netmask.

e. Into the Cluster Node field, drag and drop the node that this virtual address will be assigned

to. Considering that the first node is the one acting as the Certification Authority, it is strongly

advised to drag and drop the first node here. As a consequence, it will become the default

cluster master node.
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f. Repeat the two previous steps for each interface which must holds a virtual address, including

the interfaces used for data synchronization protocols.

The Advanced and Anti-spoofing tabs enable to configure the interfaces. These parameters will

apply in the same way to the cluster nodes interfaces.

6. To configure the cluster, double-click on the cluster object previously created to open the appliance

configuration form.

Select the Cluster tab and define the HA cluster parameters.

a. Select High Availability as the cluster mode in the Cluster drop-down list.

b. In the Cluster Master Node Address field, enter the management IP address with the same

value as defined for a virtual IP address.

7. Check that the configuration is coherent by clicking on the Check button on the toolbar.

• If the configuration is coherent, click the Deploy button to apply the configuration.

• If the configuration is not coherent, modify the parameters as indicated in the list of error

messages in the Check coherency window at the bottom of the screen and then repeat the

checking and configuration operation

The appliance to which Arkoon Manager is connected is now a cluster with one node.

3rd step: Creating the Second Node of the Cluster

1. Create the second node by right-clicking on Nodes > New > Node > Insert.

2. From the explorer view, select the Node object corresponding to the second node.

Note

It is recommended to rename this node to add clarity to the configuration, by selecting Edit

in the contextual menu. This name is not linked with the system hostname.

The node real interfaces are displayed in the descriptive view for each interface to configure.

3. Double-click the node interface (or right-click > Edit) to open the Node Ethernet Interface

configuration form to the right.
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In this form:

a. Enter the node real IP address in the corresponding field.

b. Enter the netmask in the corresponding field.

Note

It is recommended you configure the real IP addresses of a cluster interface within the

same network addressing map than its virtual IP addresses.

4. Check that the configuration is coherent by clicking on the Check button on the toolbar.

• If the configuration is coherent, click the Deploy button to apply the configuration.

• If the configuration is not coherent, modify the parameters as indicated in the list of error

messages in the Check coherency window at the bottom of the screen and then repeat the

checking and configuration operation

The appliance to which Arkoon Manager is connected is now able to communicate with the second node

(which is not connected yet).

4th step: Publishing the Second Node

You can now physically connect the second appliance to the first node and publish the second node.

Important

All the configured interfaces must be connected at both nodes level before this step.

Important

The Publish new node process will delete the second node certification authority and role

database, if they exist.

The administration console running Arkoon Manager must be authorized to connect to the second cluster

appliance using the SSH protocol on port 822.

1. From the explorer view, right-click on the second Node object, then select Publish this node from

the drop-down menu. The Publish new node dialog box is displayed.
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2. In the Login field, enter the system administrator's login: root.

3. Enter the system administrator's password for the second node in the Password field.

4. Enter the second node IP address in the corresponding field.

5. Enter the path of the newly created second node's PKCS#12 file including the FIREWALL certificate

if it is not already done.

6. Enter the password for the certificate.

7. Enter the path of the license file of the new node if you do not have installed the license yet.

8. Click Publish to validate. At the end of the publication, the dialog box “Publish new node done!”

displays if the publication has been successful. Click OK.

Note

If the publication has failed, an error message displays. Click OK. Check the console to see

when and why the publication failed.

9. The Hardware information dialog box automatically displays. Click Apply to synchronize the

configuration with the nodes' hardware configuration.

The cluster is now implemented and the configuration contains both nodes hardware data.

Note

The first hardware synchronization may take a while.

The cluster appears in the deployment window as only one entity but it is possible to distinguish the

connection status for each node. The status of each node is separated by the character /. It is the same

for configuration names, revisions and installation dates.

5th step: Failover Test for High Availability (optional)

The last step of the implementation is not mandatory. It enables to validate the second node does take in

charge all the clusters functionalities in case the first node is unavailable.

1. Connect on the first node with Arkoon Monitoring by using one virtual IP address.

2. Open the  Maintenance/Diagnosis window.

3. Click on the Stop icon. The appliance stops and you are not logged onto Arkoon Monitoring anymore.

4. Connect on the second node by using one virtual IP address.

5. Open the General information window, select Cluster, and then check the second node is Working.

6. Using the IP logs/HTTP relays/Alerts, check the flows are correctly handled while the first node is

stopped.
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7. Restart the first node to go back to normal.

13.3.2. Configuring Services on a High Availability (HA) Cluster

The following table lists the reference sections for the specific information to take into account when

configuring services on a High Availability (HA) cluster.

Table 13.1. Configuring Fast360 Appliance Services on a High Availability (HA) Cluster

Feature Reference Section

Authentication See the section called “Authentication in HA/HP

Cluster Configurations” and Section 14.2.2, “NTLM”

Master/Slave architecture See the section called “Multi-appliances

management in HA/HP cluster”.

Dynamic routing See Section 17.3.2, “Constraints Imposed by

Dynamic Routing”.

HTTP proxy See the section called “Configuring

Authentication”.

IPsec See the section called “Configuring IPsec VPN

Service on HA/HP Cluster Appliances”.

Note

It is necessary to import a certificate for

VPN.

SNMP See Section 16.7, “SNMP Agent”.

Update See Section 18.3.2, “Update planning”.

13.4. High Availability (HA) Audit

Managing a cluster involves configuring and monitoring state information and audit traces.

Each node has the following state information:

• Hardware information

• Configuration

• System monitoring state

• Node clustering state

There are 3 different clustering node states:

• Working — the node is running with virtual IP addresses and services up.

• Standby — the node is running, with no virtual IP address up. The node provides no service. This

state is the default state of the passive node in a High Availability (HA) cluster. It can also be triggered

by the administrator from  Arkoon Monitoring  or by the system monitoring feature.

• Disconnected — the node is faulty.
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The nodes states are replicated and stored on each appliance. Each node advertises its state to the other

one at a configurable interval. The state advertisement interval can be configured in  Arkoon Manager.

The default value is 1 second.

The cluster state is displayed in  Arkoon Monitoring.

When all the nodes in the cluster have been booted and are functioning correctly, the IP address of the

cluster is the one specified in the configuration

Audit traces are stored in a database on each appliance node. There are several types of logs:

• Alerts

• IP logs (IP logs in standard log policy)

• IDPS logs

• HTTP proxy logs

• SMTP proxy logs

In both cluster modes, each Working or Standby node exchanges its database logs with the other

Working or Standby node. The logs are exchanged via the interface marked as Cluster master node

address from the Cluster tab in the appliance configuration form. If a node is in the Disconnected state,

the other node stores its logs in a queue (on the hard disk). When the disconnected node returns to

Working or Standby state, the other node sends the queued logs to this node.

Audit traces are displayed in Arkoon Monitoring. Audit traces can be filtered to display only one node's

logs.

13.4.1. Failover Examples for High Availability (HA) Cluster

This section provides examples of how to manage traffic in a High Availability (HA) cluster, including

failover from the active to the passive node, recovery of traffic handling by the failed node, and manual

failover.

Example 13.1. Failover from Active Appliance 1 to Passive Appliance 2

The Standby node, referred to as appliance 2, is running normally but not handling traffic. The

Working node, appliance 1, is running and handles all the traffic. Both nodes are functional and data

synchronization is working properly.

1. Appliance 2 detects no activity from appliance 1 (electrical stop or disconnecting a cable on appliance

1).

2. Appliance 2 decides to take over appliance 1 traffic.

3. Appliance 2 starts the related services to handle the traffic.

After failover has occurred, appliance 2 handles the traffic.

Example 13.2. Appliance 1 Returns to Working State

Appliance 2 is running and handling all the traffic. Appliance 1 is out of order.

1. Appliance 1 returns to a Working state and broadcasts its availability (restarting appliance 1 or

replugging cable).

2. Appliance 2 detects that appliance 1 is available and decides to release traffic handling to appliance 1.
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3. Appliance 1 is responsible for handling traffic.

After recovery has occurred, appliance 1 handles all the traffic.

Example 13.3. Active Appliance 1 Set to Standby State

Appliance 2 is running but not handling traffic. Appliance 1 is running and handles all the traffic. Both

nodes have a coherent state and data synchronization is working properly.

1. The administrator manually sets appliance 1 to standby state from  Arkoon Monitoring.

2. Appliance 2 detects no activity from appliance 1.

3. Appliance 2 decides to take over appliance 1 traffic.

4. Appliance 1 starts the related services to handle the traffic.

After appliance 1 is set to standby, appliance 2 handles all the traffic.

Example 13.4. Standby Appliance 1 is set to Working

Appliance 1 is working and in Standby state and does not handle traffic.

Appliance 1 is cluster master appliance. Appliance 2 is working and handles traffic. Both nodes have a

coherent state and data synchronization is working correctly.

1. The administrator manually changes the state of appliance 1 from Standby to Working, clicking on

Reactivate from Arkoon Monitoring in Cluster window.

2. Appliance 1 starts the related services to take over traffic.

3. Appliance 2 detects appliance 1 is available and decides appliance 1 will handle traffic.

4. Appliance 1 is responsible for handling the traffic.

After reactivation, appliance 1 handles all the traffic.

13.4.2. Monitoring a High Availability (HA) Cluster

Arkoon Monitoring is used to monitor the cluster as a whole and its individual nodes. The Cluster window

in  Arkoon Monitoring  is accessible by:

• Clicking on General Information, then Cluster tab, or

• Going to the Arkoon tree view then right click on the Cluster object

The Cluster window in  Arkoon Monitoring  displays the following information:

• List of cluster nodes

• Cluster version

• For each node, the following information is displayed:

• Node Id : node system identifier

• State: Working or Standby or Disconnected

• Configured interfaces

For each configured interface:

• Real IP address
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• Current virtual IP address(es)

• Arkoon Monitoring indicates for each node the alerts found by VRRP (link failure, etc.)

In an AMC architecture, the cluster appliance is shown in the Arkoon Monitoring hierarchical view.

Nodes in the cluster are shown as children of the appliance with their GOR state (Green Orange Red).

Arkoon Monitoring can also be used to attribute nodes in standby mode.

Other logs are listed in /var/log/messages using syslog. These logs can be useful for advanced

administration or diagnosting needs.

For information on alerts generated by VRRP and synchronization protocols of the Fast360 appliance, see

Section 16.13, “Alerts”. These alerts are auditable via the Alerts window in Arkoon Monitoring.

13.5. Integrating High Availability (HA) Cluster into the

Network Environment

The Arkoon clustering solution can be deployed in different types of environment where the Active/

Passive solution is required.

Network management of an Active/Passive deployment is straightforward as all traffic is handled by

one node, while the other node is on standby.

Note

With VLAN interfaces, the corresponding circuits must be defined at the switch level. Moreover,

the untagged VLAN corresponding to the nodes primary interfaces (ethernet) must be activated

on the connected ports for VRRP exchanges to work.

Note

All the IP addresses of the cluster master node real interfaces automatically have a /32 netmask

(255.255.255.255). This type of mask does not support route configuration. As a consequence, a

request on this port systematically results in an ARP request. If the request succeeds, an answer

is sent. Otherwise, the sequence ends. Real IP addresses of a cluster master node are thus

reachable only if the source IP address of the flow belongs to the local network of the relevant

interface. To reach a real IP address of a master node from another network than the sub-network

of one of the interfaces, it is necessary to configure masking on the router establishing the link

to the cluster network.
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13.6. High Availability (HA) Synchronization Mechanisms

The clustering feature implements specific mechanisms to ensure proper collaboration of the cluster

nodes.

13.6.1. Active Connection Synchronization

Active connection synchronization secures and maintains the connection of network flows throughout

the appliance.

Operational Principle

Connection tables with applicative analysis data, including IDPS and Fast360 information, are

synchronized between the cluster nodes.

The active node continuously forwards TCP/FAST/IDPS status changes of affected active connections.

Thus, in case of failure of the active node, the connection table of the new active node is already up-to-

date. The latter immediately manages network packets of existing active connections.

This feature uses mechanisms and a proprietary protocol developed by Arkoon Network Security.

Synchronization is performed using the Unicast communication mode via TCP 1760 port of the interface

configured in Arkoon Manager. The synchronization mechanism can be encrypted and/or authenticated.

For security reasons, the synchronization protocol can be protected using a shared key that is set in

Arkoon Manager.

Flows with the cluster as source or destination are not synchronized (HTTP proxy, SMTP proxy, VPN,

administration connections, etc.).

Configuration

Synchronization can be enabled in the Cluster field of the appliance object. You must specify a flow

synchronization interface. We recommend that you dedicate a gigabit interface for this specific use.

By default, active connections of filtering rules using services with a disabled synchronization are not

synchronized. All other flows are. For some connections, you may disable synchronization in network

service settings. This reduces the network load and optimizes synchronization of critical flows.

Note

By default, synchronization is disabled for a new user service. It is also disabled for Arkoon

services identified as non-critical.
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Recommendations

To optimize the appliance performances, you must use this feature only for critical flows having a long

lifetime (higher than 1 minute: Citrix, TSE, business flows). Synchronizing short flows (DNS, NTP) is

resource-consuming and is not beneficial to the user. This type of synchronization must be banned.

We recommend to configure filtering rules without active connection synchronization for non-critical

services. Thus, if a flow rule does not specify any service, all flows using this rule are synchronized.

You must take special care with this type of rule. You may create specific rules aiming at deactivating

synchronization for non-critical flows.

Statistics

The system command cat/proc/arkoon/cluster allows to view counts and low-level system

information concerning active connection synchronization statistics. The proper operation of

synchronization can be estimated with the following values:

• The Packet handled field indicates the number of network packets managed by active connection

synchronization.

• The Sync-messages generated field indicates the number of synchronization messages sent to the

other node in order to keep active connection information up-to-date.

13.6.2. Time Synchronization

All the cluster nodes are time-synchronized so that audit traces can be sorted correctly. This is done

using the NTP standard protocol. By default, the cluster master node is the time reference for the other

node. For the HA cluster, the time reference will be the node in Working  (active) state. For the HP cluster ,

the time reference will be the master node (with the IP address referenced in the Cluster tab. This cannot

be configured.

13.6.3. Unsynchronized Data

The state of proxies are not synchronized between the nodes of a cluster. Each proxy on a node performs

independently. In case of failure of a node, no proxy state is recovered.

If configured on one of the nodes, the Certification Authority is not synchronized with the other node. It

is then recommended to backup the configuration map after each modification (adding or revocating a

certification).

13.7. High Availability (HA) Failover Mechanisms

This section describes the failover mechanisms required for the successful operation of a cluster.

The failover process can be described as the whole process whereby one node goes from the working

state to the standby or disconnected state and the other node takes over the first node's services.

When a node failure is detected, the remaining node handles the traffic initially going through the failed

node. In order to do this, all the virtual IP addresses of the failed node are taken over by the remaining
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node, as well as the VRRP MAC addresses.The change of MAC addresses related to a virtual IP address

is communicated to the active elements connected via a “free” ARP announcement.

13.7.1. Failover on Node Loss

When the node A is stopped, the node B retrieves its virtual IP addresses. This functioning is normal

and expected from the cluster. This behavior cannot be deactivated. When the primary appliance is

reconnected, the virtual IP addresses are then retrieved.

When the node B is off, no failover occurs. When the node B is reconnected, no failover occurs as the

node A keeps the virtual IP addresses.

13.7.2. Manual Failover

Arkoon Monitoring enables to launch a manual failover to migrate the virtual IP addresses of the node

A towards the node B. After this failover, it is possible to return to the initial state by using Arkoon

Monitoring.

It is recommended not to let the node A “waiting” for long periods of time. Indeed, since this node A is

still waiting, a malfunctioning on the node B will make the cluster unstable. This “waiting” functioning

must only be used for maintenance tasks on the node A or for failover tests.
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13.7.3. Failover on Link Loss

The VRRP protocol enables to failover the virtual addresses of the node A to the node B when the node

A detects a link loss on one physical interface.

This behavior can be deactivated interface after interface:

1. Go to the Arkoon Manager configuration, in Cluster, and then on virtual interfaces.

2. Select the Advanced tab and then unselect Include monitoring on this link (VRRP) in cluster state

calculation.

13.7.4. VRRP Internal Functioning

The following section details the VRRP functioning and is for expert administrators who want to know

the details of VRRP functioning as it was implemented by Fast360 appliance.

VRRP

VRRP (Virtual Router Redundancy Protocol) is a routing protocol defined by RFC 3768 policy and created

to increase the availability of routing gateways. This high availability is based on two different physical

routers sharing a “virtual” router. This virtual router has a floating virtual IP address between the two

physical routers, as well as a virtual MAC address. The MAC address is always 00-00-5E-00-01-XX,

the last octet is the VRID (VRID: Virtual Router Identifier, coded in hexadecimal). On a network segment,

a unique VRID must exist.

Each router which participates to the VRRP group has a priority configured from 1 to 254. An election

determines which router has the highest priority to define it as the one holding the virtual IP address.

Messages are exchanged on the 224.0.0.18 multicast address with the IP 112 protocol number and are

emitted at a regular interval (by default, every other second).
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The group's routers monitor these messages, check the incoming messages are arriving regularly and

also that the master priority is always superior to theirs. Since the preemption option is configured, a

backup router becomes a master. If there is no other master router in the subnetwork sending a message

after 6.6 seconds by default, a backup router becomes master. If the preemption option is configured, a

backup router becomes master if the master's priority decreases under its own priority.

VRRP Implementation with Arkoon Network Scurity

Arkoon Network Security has been implementing VRRP version 2 since NPA appliances version 5.0.

Cluster States

There can be 3 cluster states in a VRRP interface:

• Master: the physical interface owns the virtual IP address.

• Backup: the physical interface has a priority lower than the other node and then, it does not own the

virtual IP address.

• Fault: there is a link present.

The global state of the node is based on the three previous states, and then takes the two following states:

• Working: it is the node owning all the virtual IP addresses from the VRRP group.

• Standby: it is the node owning the virtual IP addresses from the VRRP group.

To avoid instabilities, it is impossible to have two VRRP equipments with the same VRID identifier on the

same network segment. With this type of topology, it is necessary to configure a different VRID for each

equipment. As previously indicated, the VRIDs are numbered in an incremental way, starting from 1, as

vrrpv2g1 in this example. If VRID 1 is associated to the first interface, the baseid by default is 0. If the

baseid is 100, VRID 101 is associated to the first interface.

Modifying a VRID on a Fast360 Appliance

It is impossible to modify the interface VRID but only all the VRIDs from a node. This operation must be

done on both nodes.

To change this numbering behavior, you must modify a key in the /config_card/etc/arkoon-

config.local file. This key modifies the baseid. This baseid must be comprised between 1 and 65535.

The command is:

echo "cluster.vrrp.baseid = [your_baseid]" >> /config_card/etc/arkoon-config.local

Each appliance needs to be rebooted.

Note

On a master/slave architecture, if the cluster.vrrp.baseid key is used by one appliance

at least, all appliances can take this baseid value as the reference value when the master

node checks the global configuration. In some cases, the configuration can thus be wrongly

considered as not valid and generate an error message such as * Error: Created VRID for -"Num

VLAN " is > 255. In order to avoid this configuration error, add the following configuration keys to

the master node. This deactivates the configuration global check:

• arkoon-amc.akslave.disable-global-verif = yes

• arkoon-amc.akha.disable-global-verif = yes
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Naming Conventions for Interfaces

The names for Fast360 appliances real interfaces always begin with eth. VRRP interfaces always begin

with vrrpv2g. v2 means VRRP version 2. The next number is the VRID identifier and it is incremented,

starting from 1. There must be no link between the real interface number and the virtual group number.

Protocol Extension

VRRP as defined above only defines a virtual IP address for a pair of real IP addresses. Since a router has

several interfaces (like a Fast360 appliance), Arkoon Network Security uses several virtual IP addresses:

one per pair of real IP addresses related to appliances. They are referred to as a group of virtual IP

addresses. The failover for a VRRP virtual address creates the failover for the whole group from a node

to the other.

Also, to address a limitation to 255 of the number of interfaces possible for a cluster, Arkoon Network

Security proposes a VRRP protocol extension :

• The MAC address 00-00-5E-00-01-XX is used if the interface's VRID is lower than 255.

• The MAC address 00-00-5E-YY-81-ZZ is used if the interface's VRID is higher than 255. Keeping two

hexadecimal blocks in the address allows using 65535 possible values.

A Fast360 cluster can then have a very large number of network interfaces (300 VLAN for example). To

manage VRID higher than 255, it is necessary to reserve a VRID (lower than 255) which must not be used

by other machines on the network. By default, it is the VRID 0 (out of the frame of the RFC). This specific

VRID does not have any effect on the virtual MAC address, it is transported in the VRRP segment (layer

on top of the IP layer).

It is possible to change it thanks to a configuration key. Its value must be between 0 and 255: echo

"cluster.vrrp.ak-reserved-vrid = [your_id]" >> /config_card/etc/arkoonconfig. local

The value of the baseid key must be between 1 and 65535 (as said above) and has effects on the cluster's

virtual MAC address.

Example 13.5.

The network includes a VRRP switch managing 90 VLAN, a Fast360 cluster (CArk1) managing 150 VLAN

and a second Fast360 cluster (CArk2) managing 100 VLAN. These active elements are located on common

networks.

• The switch uses the baseid 10 and the MAC addresses of the 90 VLAN it manages look like

00-00-5E-00-01-XX where XX vary between 11 and 100,

• The CArk1 uses the baseid key 100 and the MAC addresses of the 150 VLAN it manages look like

00-00-5E-00-01-XX where XX vary between 101 and 250.

Enter the following command on both nodes of the cluster:

echo "cluster.vrrp.baseid = 100" >> /config_card/etc/arkoon-config.local

• The CArk2 uses the baseid key 1000 and the MAC addresses of the 100 VLAN it manages look like

00-00-5E-XX-81-YY where XXYY vary between 1001 and 1101.

Enter the following command on both nodes of the cluster:

echo "cluster.vrrp.baseid = 1000" >> /config_card/etc/arkoon-config.local
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For example, the VRID 1034 must be written as follows:

1034 in decimal format = 00000100 000001010 in binary format = 04 0A in hexadecimal format

The corresponding MAC address is: 00-00-5E-04-81-0A.

Basic Commands

The basic commands are the akutils vrrp commands.

The list of existing commands is executed with the -h switch:

root@clusterNode1:/root> akutils vrrp -h
usage: vrrp <-s|-g|-h|-a|-p|-m|-b|-w>;
  -s : show VRRP state details
  -g : show VRRP groups
  -a : show all my active addresses
  -p : show all peer active addresses
  -m : show my arkoon state
  -b : show peer arkoon state
  -c : show cluster state
  -w : show cluster warnings
  -d : show DO action
  -t : show tracking state
  -h : help
root@clusterNode1:/root>

• The group is indicated by akutils vrrp -g command :

root@clusterNode1:/root> akutils vrrp -g
VRRP Group = mygroup
   Virtual Routers in Group:
      vrrpv2g1
      vrrpv2g2
      vrrpv2g3
      vrrpv2g4
      vrrpv2g5
   Synchronize fault? no
   Notify Master state? no
   Notify Backup state? no
   Support inter-switch failure? yes
   Read timeout = no
   State = MASTER
root@clusterNode1:/root>

A vrrpv2g2 failover leads to a failover for vrrpv2g1, vrrpv2g3, vrrpv2g4 and vrrpv2g5 interfaces.

This behavior is still not configurable and the failover is global to the group.

• The status provided by -s enables to have information regarding VRRP status:

root@clusterNode1:/root> akutils vrrp -s
  (...snip...)
VRRP Instance = vrrpv2g5                 (1)
   State = MASTER                        (2) 
   Master is 172.16.3.252 (local)        (3)
   Running on device = eth4              (4)
   Virtual Router ID = 5                 (5)
   Base priority = 254                   (6)
   Priority = 254                        (6)  
   Advert interval = 1 seconds           (7)
   Preempt = enabled                     (7)
   Preempt delay = 3 seconds             (7)
   Gratuitous ARP delay = 5 seconds      (7) 
   Read timeout = yes                    (8)  
root@clusterNode1:/root>

1. This status is for vrrpv2g5 interface.

2. The state is MASTER, that is to say the virtual interface is on the node on which we connected

in SSH.

3. The node with 172.16.3.252 IP address is the cluster master node.
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4. The virtual address replies on eth4 physical interface.

5. The VRID is 5 (information already provided with the interface name).

6. Its initial priority is equal to the actual priority: 254, which is the highest (this explains why it is

the master).

7. These parameters correspond to what was configured into Arkoon Manager.

8. Read Timeout indicates the real interface is expecting to receive VRRP messages from the second

node.

• The akutils vrrp -a command enables to know the virtual IP addresses held by the node on which

the command was launched:

root@clusterNode1:/root> akutils vrrp -a
<dynamicip>172.16.0.254</dynamicip>
<dynamicip>172.16.1.254</dynamicip>
<dynamicip>88.161.162.229</dynamicip>
<dynamicip>172.16.2.254</dynamicip>
<dynamicip>172.16.3.254</dynamicip>
root@clusterNode1:/root>

• The akutils vrrp -p command enables to know the virtual IP addresses held by the second node.

In the example, the virtual IP address is not held by the slave node:

root@clusterNode1:/root> akutils vrrp -p
root@clusterNode1:/root>

13.8. Implementing High Performance (HP) Clustering

13.8.1. Initializing a High Performance (HP) Cluster

Initializing a HP cluster follows a similar procedure to initializing a HA cluster, except:

• One virtual IP address must be configured for each enabled interface of each node of the cluster.

• High Performance cluster mode must be selected in the appliance Cluster tab.

For example, if the IP address 10.1.1.1 is configured to be a virtual IP for interface eth0 on node 1,

another IP address (IP 10.1.1.2 for example) must be configured to be a virtual IP of interface eth0

on node 2.

The virtual addresses are configured in the Virtual IP Addresses table in the Interface configuration form

of the cluster interface object (eth0 in this example).

Note

A series of checks can be carried out in  Arkoon Monitoring to ensure that everything is working

correctly after the initialization of the cluster configuration.
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13.8.2. Configuring Services on a High Performance (HP) Cluster

The following table lists the reference sections for specific information to take into account when

configuring services on a High Performance (HP) cluster.

Table 13.2. Configuring Fast360 Appliance Services on a High Performance (HP) Cluster

Feature Reference Section

Authentication See the section called “Authentication in HA/HP Cluster

Configurations” and Section 14.2.2, “NTLM”.

Master/Slave architecture See the section called “Multi-appliances management in HA/

HP cluster”.

Dynamic routing See Section 17.3.2, “Constraints Imposed by Dynamic Routing”.

HTTP proxy See the section called “Configuring Authentication”.

IPsec See the section called “Configuring IPsec VPN Service on HA/

HP Cluster Appliances”.

Note

It is necessary to import a certificate for VPN.

NAT See the section called “NAT in HP Clusters”.

SNMP See Section 16.7, “SNMP Agent”.

Update See Section 18.3.2, “Update planning”.

13.9. High Performance (HP) Audit

Managing a cluster involves configuring and monitoring state information and audit traces.

Each node has the following state information:

• Hardware information

• Configuration

• System monitoring state

• Node clustering state

There are 3 different clustering node states:

• Working — the node is running with virtual IP addresses and services up.

• Standby — the node is running, with no virtual IP address up. The node provides no service. This

state is the default state of the passive node in a High Availability (HA) cluster. It can also be triggered

by the administrator from  Arkoon Monitoring  or by the system monitoring feature.

• Disconnected or failed — the node is faulty.

The nodes states are replicated and stored on each appliance. Each node advertises its state to the other

one at a configurable interval. The state advertisement interval can be configured in  Arkoon Manager.

The default value is 1 second.
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The cluster state is displayed in  Arkoon Monitoring.

When all the nodes in the cluster have been booted and are functioning correctly, the IP address of the

cluster is the one specified in the configuration

Audit traces are stored in a database on each appliance node. There are several types of logs:

• Alerts

• IP logs (IP logs in standard log policy)

• IDPS logs

• HTTP proxy logs

• SMTP proxy logs

In both cluster modes, each working or standby node exchanges its database logs with the other working

or standby node. The logs are exchanged via the interface marked as Cluster master node address from

the Cluster tab in the appliance configuration form. If a node is in the disconnected state, the other node

stores its logs in a queue (on the hard disk). When the disconnected node returns to working or standby

state, the other node sends the queued logs to this node.

13.9.1. Failover Examples for a High Performance (HP) Cluster

This section provides examples of how to manage traffic in a HP cluster, including failover from the first

active to the second active node, recovery of traffic handling by the failed node, and manual failover.

Example 13.6. Failover from Active Appliance 1 to Active Appliance 2

Both appliances 1 and 2 are running normally and handling traffic. Both have a coherent state and data

synchronization is working properly.

1. Appliance 2 detects no activity from appliance 1.

2. Appliance 2 decides to take over appliance 1 traffic.

3. Appliance 2 starts the related services to handle the traffic.

After failover has occurred, appliance 2 handles both appliance 1 and appliance 2 traffic.

Example 13.7. Failed Appliance 1 Returns to Working (active) State

Appliance 2 is running and handles both appliance 1 and appliance 2 traffic. Appliance 2 has a coherent

state. Appliance 1 is out of service.

1. Appliance 1 returns to a healthy state and broadcasts its availability.

2. Appliance 2 detects that appliance 1 is available and decides to release traffic handling to appliance 1.

3. Appliance 1 is again responsible for handling its own traffic.

After recovery has occurred, both appliance 1 and appliance 2 handle their respective traffic.

Example 13.8. Appliance 2 Set to Standby State

Both appliances 1 and 2 are running normally and handling traffic. Both have a coherent state and data

synchronization is working properly.
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1. The administrator manually sets appliance 2 to standby state in  Arkoon Monitoring.

2. Appliance 1 detects no activity from appliance 2.

3. Appliance 1 decides to take over appliance 2 traffic.

4. Appliance 1 starts the related services to handle the traffic.

After appliance 2 is set to standby, appliance 1 handles both appliance 1 and appliance 2 traffic.

Example 13.9. Appliance 2 in Standby is set to Working (active) state

Appliance 2 is set to Standby mode.

Appliance 2 is working and is in Standby state and does not handle traffic. Appliance 1 handles its traffic

and appliance 2 traffic.

1. The administrator manually changes appliance 1 state from Standby to Working clicking on Reactivate

from Arkoon Monitoring in the Cluster window.

2. Appliance 2 detects appliance 1 is available and decides to give traffic handling to appliance 1.

3. Appliance 1 handles again its own traffic.

After reactivation, appliance 1 and 2 handle their own traffic.

13.9.2. Monitoring a High Performance (HP) Cluster

Arkoon Monitoring is used to monitor the cluster as a whole and its individual nodes. The Cluster window

in  Arkoon Monitoring  is accessible by:

• Clicking on General Information, then Cluster tab, or

• Going to the Arkoon tree view then right click on the Cluster object

The Cluster window in  Arkoon Monitoring  displays the following information:

• List of cluster nodes

• Cluster version

• For each node, the following information is displayed:

• Node Id : node system identifier

• State: Working or Standby or Disconnected

• Configured interfaces

For each configured interface:

• Real IP address

• Current virtual IP address(es)

• Arkoon Monitoring indicates for each node the alerts found by VRRP (link failure, etc.)

In an AMC architecture, the cluster appliance is shown in the  Arkoon Monitoring  hierarchical view.

Nodes in the cluster are shown as children of the appliance with their GOR state (Green Orange Red).

Arkoon Monitoring  can also be used to attribute nodes in standby mode.
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Other logs are listed in /var/log/messages using syslog. These logs can be useful for advanced

administration or diagnosting needs.

For information on alerts generated by VRRP and synchronization protocols of the Fast360 appliance, see

Section 16.13, “Alerts”. These alerts are auditable via the Alerts window in Arkoon Monitoring.

13.10. Integrating High Performance (HP) Cluster into the

Network Environment

This section provides several use cases describing how to deploy the Fast360 cluster solution in HP mode.

Note

With VLAN interfaces, the corresponding circuits must be defined at switch level. Moreover, the

non-tagged VLAN corresponding to the nodes primary interfaces (ethernet) must be activated

onto the connected ports for the VRRP exchanges to establish.

13.10.1. Integrating a HP Cluster

In a network architecture implementing a HP cluster, the network administrator must ensure that, for a

given IP connection, client-to-server packets and server-to-client packets are routed through the same

appliance.

To ensure traffic is handled correctly by the cluster nodes, either a technical or network environment

solution must be implemented.

Table 13.3. Technical Solutions for Integrating a HP Cluster

Objective Solution

Route and

load-balancing

connection

answers

Implement source translation using masquerading with interface virtual IP

address.

Route and load-

balancing incoming

connections

Implement destination translation using Port Address Translation by interface

virtual address.
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Table 13.4. Environment Solutions for Integrating a HP Cluster

Device Description

Router with

connection

tracking/Switch

Level 4

Device able to memorize an incoming packet and route the corresponding

response accordingly (on the same node).

Load balancer Implementation of the solution above and load balancing (a new connection is

routed on the less loaded node).

The administrator has several solutions for balancing traffic load between the cluster nodes; for more

information, see the section called “Load Balancing for High Performance (HP) cluster”.

13.11. High Performance (HP) Synchronization

Mechanisms

13.11.1. Connection Data Synchronization

Connection tables with applicative analysis data, including IDPS information, are synchronized between

the cluster nodes. Synchronization is performed using the unicast communication mode via TCP 1760

port. This is not configurable. All synchronization parameters can be customized in  Arkoon Manager.

All the applicative analysis modules are supported by the synchronization mechanism. This mechanism

can be encrypted and/or authenticated. For security, the synchronization protocol can be protected using

a shared key that is set in  Arkoon Manager.

Although protocol states are synchronized, nodes of a cluster do not operate in synchronous mode. In

other words, once a network session has been established through a node of the cluster, the whole

session must be routed through this node, unless the node fails.

It is possible to deactivate the replication of some connections configuring the appropriate option in

service parameters (TCP/UDP). This will allow to reduce the network load related to the replication and

then to optimise synchronization for critical flows.

13.11.2. Unsynchronized Data

The state of proxies are not synchronized between the nodes of a cluster. Each proxy on a node performs

independently. In case of failure of a node, no proxy state is recovered. If configured on one of the nodes,

the Certification Authority is not synchronized with the other node. It is then recommended to backup the

configuration map after each modification (adding or revocating a certification).
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13.11.3. Mail Synchronization

There is no mail synchronization implemented between cluster nodes.

In Active/Passive mode, the Standby node sends its mail queue to the Working node so that mails are

not stuck and can be processed by the Working node.

13.12. High Performance (HP) Failover Mechanisms

To know HP failover mechanisms, see Section 13.7, “High Availability (HA) Failover Mechanisms”.

13.13. Implicit Rules for Cluster Protocols

Implicit rules are automatically created to authorize state protocols, management protocols, and

synchronization protocols.

• Name of the rule, as it is shown in the IP logs of  Arkoon Monitoring

• Source IP address

• Destination IP address

• Source port

• Destination port

Table 13.5. Filtering Rules for Connection Data Synchronization Protocol

Rule name Source IP address Destination IP

address

Source port Destination port

Sync Protocol

Unicast In

Real IP of another

Fast360 appliance

declared in the

interface

My real IP

declared in this

interface

ALL UDP 1760

Sync Protocol

Unicast Out

Real IP declared in

this interface

Real IP of another

Fast360 appliance

declared in the

interface

ALL UDP 1760

Table 13.6. Filtering Rules for State Protocol (VRRP)

Rule name Source IP address Destination IP

address

Source port Destination port

VRRP In All 224.0.0.18 Protocol IP 112 Protocol IP 112

VRRP Out Local IP 224.0.0.18 Protocol IP 112 Protocol IP 112
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Table 13.7. Filtering Rules for Management Data Synchronization Protocol

Rule name Source IP address Destination IP

address

Source port Destination port

Akha Input rule Network of the

master node

interface

Master node IP

address

ALL TCP 1756

Akha Output rule Local IP Real IP address of

the 'admin-sync-

address' interface.

ALL TCP 1756

Table 13.8. Filtering Rules for Inter-Nodes Update Protocol

Rule name Source IP address Destination IP

address

Source port Destination port

Arkupdate Input

rule

Network of the

master node

interface

Master node IP

address

ALL TCP 1752

Arkupdate Output

rule

Local IP All adddresses. ALL TCP 1752

Table 13.9. Filtering Rules for Logs Exchange Protocol

Rule name Source IP address Destination IP

address

Source port Destination port

Akserver Input rule Network of the

master node

interface

Master node IP

address

ALL TCP 1759

Akserver Output

rule

Local IP Real IP address of

the 'admin-sync-

address' interface

ALL TCP 1759

13.14. Cluster GOR state

The cluster GOR (Green Orange Red) state depends on the following cases:

• Connected/connected case:

If the two nodes are detected as connected/connected, the worst GOR state is displayed.

• Example 1 : if Node1=Green and Node2=Orange, Orange is displayed.

• Example 2 : if Node1=Red and Node2=Orange, Red is displayed.

• Connected/disconnected case:
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If the cluster master node is connected but the cluster slave node is disconnected (connected/

disconnected), the cluster master node is displayed (this state will at least be Orange because it

detects the slave node loss).

• Disconnected/[disconnected|connected] case

If the cluster master node is disconnected and no matters what the slave node connection state is

(disconnected/[disconnected|connected]): a “grayed” state is displayed to indicate there is a serious

problem with the cluster.

13.15. Terminology

Administration data synchronization

protocol

This protocol deploys administration and monitoring data used

to configure and monitor the nodes composing the cluster.

Monitoring data includes information about the cluster states and

all security logs generated by the nodes composing the cluster.

The protocol is encapsulated in an SSL connection on TCP port

1756. The master node of the cluster listens to connections from

the second node.

Connection data synchronization

protocol

This protocol allows the two cluster nodes to share connection

states via the master node interface, including the applicative

state when available. This protocol uses UDP port 1760. These

states are used to recover connections if a node happens to fail.

Cluster A cluster of Fast360 appliances is a collection of two Fast360

nodes, interconnected by the network, and managed by a

dedicated Arkoon daemon.

Failover Process from one node going from the working state to the

standby or disconnected state and the other node taking over the

first node's services.

High Availability (HA) One appliance is in active mode and the other is in passive mode,

on standby to take over in case of failure of the active node.

High Performance (HP) Both appliances are active at the same time, working in active/

active mode. If one of the active Fast360 appliances fails, the other

takes over to handle all of the network traffic.

IP real address IP address allocated to a specific cluster node.

IP virtual address IP address used by the cluster to interoperate with other network

equipment and services.

Master node The cluster master node is the cluster node that must be used

when connecting to the cluster with Arkoon Manager. This node is

responsible for relaying management requests to the other node

as well as replication for configuration files.

Node A Fast360 appliance in a cluster.

Node state protocol This protocol manages the state of the cluster nodes (starting,

active, passive, failing over). It is also responsible for switching

services from one (potentially failing) Fast360 appliance to

another (correctly functioning) one based on an administrator's
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request or a node state threshold. This protocol relies on the

underlying VRRP protocol.

VRRP Virtual Router Redundancy Protocol. Routing protocol defined by

RFC 3768 policy and created to increase the availability of routing

gateways.

VRID Virtual Router IDentifier. Sets for each virtual interface on a

network.
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Chapter 14. Users Authentication

 Authentication is used to filter the output flows per user. After creating users or groups of users in

the Authentication navigation tab in Arkoon Manager, authentication is configured with filtering rules.

Several authentication types are available and detailed in this chapter. For more information on how to

configure authentication in filtering rules, refer to Section 8.3.3, “Configuring Authentication in Filtering

Rules”.

14.1. Authentication types

The Fast360 appliance supports four different types of authentication. It is possible to select more than

one type in the same filtering rule. In this case, each type is checked in the following order:

• authentication with the Arkoon Authentication agent

• authentication using IPSec ID

• transparent authentication

Refer to the following sections for details on each type of authentication.

14.1.1. Authentication with Arkoon Authentication Agent

This functionality requires an authentication agent (Arkoon Authentication) to be installed on users

workstations.

This type of authentication really authenticate the connected user. It can be used on a trusted network

and on the Internet.

Note

This authentication type works with Windows client workstations (in an Active Directory domain

or not) and with Linux workstations.

Note

If a firewall is enabled on the Windows client workstation, you need to open the port UDP/9271

to be able to use the Arkoon Authentication agent.

This section describes:

• The principle of the authentication with the Arkoon Authentication agent

• The implication of users authentication in the filtering

• The mechanisms implied to ensure security

• The configuration of the agent on users workstations

Principle

Fast360 appliances support two modes to authenticate a user:
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• Low authentication with login/password

Login/password authentication is based on:

• Users locally defined on the Fast360 appliance

• Users defined on an authentication server, such as LDAP, Windows NT, Kerberos or Radius. Detailed

information on how to configure these different types of authentication server can be found

in Section 14.2.1, “LDAP”, Section 14.2.2, “NTLM”, Section 14.2.3, “Radius” and Section 14.2.4,

“Kerberos”.

After configuring the server, it is necessary to import users from the authentication server in the

configuration. Refer to Section 14.3, “Importing users or groups of users from an authentication

server” to know how to import users.

• Authentication with X.509 certificate.

Authentication with a certificate requires interaction with a Certification Authority, and can be split

into two sub-modes according to the type of key storage used:

• Storage on hard disk: the keys are stored in a PKCS#12 file located on the hard disk of the workstation

or on an external mobile device for example. This file, protected by a password, contains the private

key of the user, the corresponding certificate signed by the Certification Authority of the Fast360

appliance and the autosigned certificate of the Certification Authority of the Fast360 appliance.

• Storage on a strong authentication solution: the keys are stored on a USB token or on a chip

card with PKCS#11 interface. The autosigned certificate of the Certification Authority of the Fast360

appliance is stored on the workstation, outside the token or the card.

To know which authentication mode to choose with Arkoon Authentication agent, refer to the section

called “Configuring the Arkoon Authentication agent on users workstations”.

Implementing the authentication with agent in filtering rules

The authentication with agent of users on output flows is activated on the Fast360 appliance with the

option Authentication using Arkoon Authentication Agent in the filtering rule.

For more information on how to configure a rule, refer to Section 8.3, “Creating a New Filtering Rule”.

Two cases can occur when a flow, requiring authentication, is initiated through the Fast360 appliance:

1. Non-existing authentication: the couple (IP address and MAC address sources of the flow) is not

yet associated with an authenticated user, or the authentication expired, for example because the

workstation has been put in standby mode or because a network failure occurred.

2. Authentication in validity: an association (IP address and MAC address flow sources)/authenticated

user is still valid.

The mechanisms implemented in both cases are presented below.
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Non-existing Authentication

If the Fast360 appliance has not yet associated the couple (IP address and MAC address sources of the

flow) with an authenticated user, the mechanism is the following:

1. The Fast360 appliance initiates a UDP request on the port 9271 toward the source IP address of the

flow and the rule is ignored for this packet;

2. The authentication agent must be operational to receive the request: the user must be authenticated;

3. The agent sends the authentication information to the Fast360 appliance which checks they are

correct and request the Active Directory server to know the groups of the user;

4. If the authentication is successful, the Fast360 appliance saves the source IP address, the MAC

address, the user name as well as its possible membership groups in the authentication table. The

filtering rules authenticated with the IP and MAC addresses are now usable;

5. If the authentication fails, the filtering engine analyzes the next rule.

Authentication in Validity

An entry of the authentication table associates the couple (IP address and MAC address sources of the

flow) with an authenticated user. On the Fast360 appliance, these entries have a timeout set to 5 minutes.

When filtering a new flow, the Fast360 appliance uses the identity and the groups of membership of the

associated user to meet the decision of filtering, if there is an authentication in validity for the couple (IP

address and MAC address sources of the flow).

Authentication Management

When the Arkoon Authentication agent starts on the user workstation, connection identifiers are

immediately prompted.

When the timeout value of the authentication table entry is reached, the Fast360 appliance ends an

authentication request to the client, in order to protect against an usurpation of rights by another user. To

limit the latent period, this request is sent as soon as a new authenticated connection is received, during

the 40 seconds preceding the timeout of the entry in the table.

When the client receives an authentication request, it automatically sends the parameters previously

entered by the user, if the last authentication (explicit or transparent) has been realized within the

preceding 30 minutes. This authentication is thus transparent for a legitimate user.

Thus, during the filtering of a new flow requiring an authentication, the authentication requests are

realized as follows:

Age (A) of association

(IP,MAC)/authentication

on the Fast360

appliance

Age of last explicit

transparent

authentication on

client

Action on the Fast360

appliance

Action on the client

No association < 30 mn Authentication request Implicit authentication

No association > 30 mn Authentication request Explicit authentication
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Age (A) of association

(IP,MAC)/authentication

on the Fast360

appliance

Age of last explicit

transparent

authentication on

client

Action on the Fast360

appliance

Action on the client

(A) < 4 mn 20 s — No authentication request;

Decision of filtering

immediate

—

4 min 20 s < (A) < 5 mn — Authentication request;

Decision of filtering

immediate

Implicit authentication

The graphic below illustrates these mechanisms:

Figure 14.1. Authentications Flows
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Security of the Client / Fast360 Appliance Communication

Authentication of the Communication Flows

Each party (the Fast360 appliance and the client) has mechanisms allowing authentication of remote

entities.

Authentication of the Fast360 Appliance by the Client

To be sure that the authentication agent communicates with the Fast360 appliance and not with another

machine, the authentication agent has, in its configuration, the certificate of the Certification Authority

(CA), which delivered a certificate to the Fast360 appliance. It checks that the CA transmitted the

certificate of the remote machine.

Authentication of the Client by the Fast360 Appliance

Authentication by Login/Password

The user enters a login/password couple, which is transmitted encrypted to the Fast360 appliance via

the SSL connection. The client does not submit a certificate to the Fast360 appliance of which the SSL

authentication mechanisms cannot be used for the client.

Note

To ensure a reliable authentication, the login/password couple must strictly remain individual for

each user. The user must take the necessary measures to ensure that this password is secret

and must not be possible to guess or reproduce.

Authentication by Certificate

Note

The client must use a certificate transmitted by the CA of the Fast360 appliance with USER rights.

In this case, the SSL v3 authentication mechanisms are used to authenticate the user using its certificate.

Note

The file under PKCS#12 format (Private Information Exchange Standard), which is given

to Fast360 administrators and users, contains private information that is generated during

certificate creation. Some of this information, like the private key used for the authentication

and the negotiation of the SSL secured connections, is strictly confidential. The disclosure of

such information to a third party shall require the revocation of the certificate. The password

protecting the PKCS#12 file must be highly resistant and meet the password generation

requirements of  minarkconf  (see the First-Time Configuration guide for more details).

Prevention of Usurpation of the Acquired Privileges

Different mechanisms are implemented to prevent a third party from usurping the privileges acquired by

the authenticated user:

• For 30 minutes following authentication (explicit or transparent), the agent replies to any request of

the Fast360 appliance by sending transparently for the user the authentication parameters.

• After 30 minutes without connection, the user must explicitly request authentication.
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• During each passing in a filtering rule with authentication, the Fast360 appliance verifies that the

source MAC address of the packet corresponds to the MAC address present in the authentication

table for the concerned IP address.

Prevention of “Brute Force” Attacks

When keys and certificates are stored on a hard disk, the number of access attempts to the certificate

protected by a password is unlimited. This working mode can thus be vulnerable to a "brute force"–type

attack (search by dictionary, …).

In case of storage via a PKCS#11 interface (USB token or chip card), the number of successive

unsuccessful access attempts to the certificate can be limited. If this number is exceeded, a

reinitialization of the strong authentication mechanism will be necessary. This authentication mode thus

constitutes an efficient protection against "brute force" attacks.

Authentication in HA/HP Cluster Configurations

Important

Authentication status is not replicated between the nodes of a cluster.

If traffic through the cluster is handled by load-balancers, users may have to authenticate twice, i.e. once

on each node of the cluster, depending on how the load-balancing algorithm behaves.

Configuring the Arkoon Authentication agent on users workstations

The Arkoon Authentication agent allows to authenticate users on given flows. For this:

• the agent must be installed and configured on the client workstation;

• the filtering rules defined thanks to Arkoon Manager must include the users.

Three authentication methods can be used:

• authentication with login and password;

• authentication with PKCS#12 certificate;

• authentication with USB token (PKCS#11).

Before configuring the authentication agent, it is necessary to create specific objects in Arkoon

Manager. So, you previously must:

• create a user (possibly with login and password if this authentication mode is selected);

• create a USER certificate under PKCS#12 format if this authentication mode is selected;

• retrieve the certificate of the CA (Certification Authority) if the selected authentication mode uses a

token (PKCS#11) or a login and password;

• create a filtering rule including the previously defined user.

For more information on how to create and retrieve certificates with Arkoon Manager, refer to Chapter 3,

Managing Authentication Certificates and Administrator Rights.

After having created the required objects, you must then configure the connection on the agent

depending on the authentication mode chosen on the user workstation.
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Authentication with login and password

1. Right-click the Arkoon Authentication icon located on the right of the task bar of your Windows

operating system. Select Configuration from the displayed menu. The ARKOON Authentication -

Configuration dialog box displays.

2. In the IP address field, enter the IP address of the firewall to which you want to connect.

3. Select the Login/Password authentication option.

4. Select the CA certificate (under .pem format) which is previously retrieved thanks to Arkoon Manager.

Click the icon located on the right of the CA certificate (.pem) field. The Select your CA certificate

(*.pem) dialog box displays.

5. Select the desired CA certificate and click Open.

6. In the User field, enter the name of the user who is selected in a permissive rule.

7. Click Validate.

The configuration stage is now complete.

When the agent starts, the ARKOON Authentication - Login/password dialog box displays. If the user

does not send flows during 30 minutes, he/she must authenticate again.

Note

Once the authentication is done, you can view it:

• on the client workstation, in the Authenticated connections panel of the ARKOON

Authentification - Configurationdialog box.

• in Arkoon Monitoring, in the Authenticated machines window.

Authentication with PKCS#12 certificate

In this authentication mode, the keys are stored in a PKCS#12 file on the workstation or on a mobile

storage device for instance. The file contains the user's private key, the corresponding certificate signed

by the Fast360 appliance's CA (Certification Authority) and the autosigned certificate of the Fast360

appliance's CA.

1. Right-click the Arkoon Authentication icon located on the right of the task bar of your Windows

operating system. Select Configuration from the displayed menu. The ARKOON Authentication -

Configuration dialog box displays.

2. In the IP address field, enter the IP address of the firewall to which you want to connect.

3. Select the PKCS#12 certificate authentication option.

4. Select the PKCS#12 certificate (under .p12 format) previously created thanks to Arkoon Manager. Click

the icon located on the right of the PKCS#12 certificate field. The Selection of PKCS#12 certificate

(*.p12) dialog box displays.

5. Select the desired certificate and click Open.

6. Click Validate.

The configuration stage is now complete.

When the agent starts, the Entry of PKCS#12 password dialog box displays. If the user does not send

flows during 30 minutes, he/she must authenticate again.

Note

Once the authentication is done, you can view it:
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• on the client workstation, in the Authenticated connections panel of the ARKOON

Authentification - Configurationdialog box.

• in Arkoon Monitoring, in the Authenticated machines window.

Authentication with token (PKCS#11)

In this authentication mode, the keys are stored via a strong authentication solution like USB Token or

Chip card with PKCS#11 interface. The autosigned certificate of the Fast360 appliance's Certification

Authority is stored on the workstation outside the Token or the card.

1. Right-click the Arkoon Authentication icon located on the right of the task bar of your Windows

operating system. Select Configuration from the displayed menu. The ARKOON Authentication -

Configuration dialog box displays.

2. In the IP address field, enter the IP address of the firewall to which you want to connect.

3. Select the PKCS#11 authentication (Token) option.

4. Select the CA certificate (under .pem format) which is previously retrieved thanks to Arkoon Manager.

Click the icon located on the right of the CA certificate (.pem) field. The Selection of CA certificate

(*.pem) dialog box displays.

5. Select the desired certificate and click Open.

6. Click Validate.

The configuration stage is now complete.

Before opening the flow, it is previously necessary to:

• put the connection PKCS#11 certificate on the USB key (Token);

• by using Arkoon Manager, create a USER certificate object containing the same certificate than the

one you put on the key;

• associate this newly created certificate to the user selected in the filtering rule by using Arkoon

Manager.

When the agent starts, the ARKOON authentication - Token dialog box displays. If the user does not send

flows during 30 minutes, he/she must authenticate again.

Note

Once the authentication is done, you can view it:

• on the client workstation, in the Authenticated connections panel of the ARKOON

Authentification - Configurationdialog box.

• in Arkoon Monitoring, in the Authenticated machines window.

14.1.2. Authentication using IPSec ID

This type of authentication uses the ID (DN), the IP address or the X-Auth identifier of the user of a

flow coming from an IPSec VPN tunnel. When a flow comes from a VPN tunnel, the Fast360 appliance

associates an identifier called IPSec ID to the flow.

Note

This authentication type works with Windows client workstations (in an Active Directory domain

or not) and with Linux workstations.
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The IPSec ID is different if the VPN client uses an X509 certificate or a shared key (PSK) to mount the

tunnel:

• In the case of a tunnel established by the client with an X509 certificate, the IPSec ID is the certificate

DN (Distinguish Name).

• In the case of a tunnel established by the client with an X509 certificate and which uses an X-Auth

user authentication, the IPSec ID is also the certificate DN (Distinguish Name).

• In the case of a tunnel established by the client with a shared key (PSK), the IPSec ID is the IP address

of the remote terminal.

• In the case of a tunnel established by the client with a shared key (PSK) and which uses an X-Auth

user authentication, the IPSec ID is the X-Auth ID.

In the third case, the IP address is not a reliable ID. This IPSec ID cannot be used to filter users in filtering

rules.

Configuring authentication using IPSec ID in filtering rules

To configure authentication using IPSec ID based on the DN of an X509 certificate in a rule:

• Mount a VPN tunnel which end entity is:

• either an host with an X509 certificate

• either a user with an X509 certificate

• or an LDAP group (if you are using an external PKI. Refer to Section 12.10.5, “Integrating a Fast360

appliance within an external PKI with an LDAP server”).

Note

We recommend you to use a user with an X509 certificate rather than an host with an X509

certificate.

For more information on how to configure a VPN tunnel, refer to Chapter 12, Configuring IPsec VPN

Tunnels.

• In the Authentication configuration form in the filtering rule:

• Select the option Authentication using IPSec ID (DN from VPN user).

• Drag and drop users (and/or groups of users) which have a DN (the same DN than the DN used

to mount the VPN tunnel) or an associated certificate (which DN is the same than the DN used to

mount the VPN tunnel).

For more information on how to configure a rule, refer to Section 8.3, “Creating a New Filtering Rule”.

• Once the VPN tunnel is mounted and when a flow passes through the tunnel, the Fast360 appliance

retrieves the IPSec ID (the DN of the X509 certificate) and checks if the IPSec ID matches one of the

users or groups DN in the rule.

To configure authentication using IPSec ID based on the X-Auth identifier in a rule:

• Mount a VPN tunnel which end entity is:

• either an host with a shared key (PSK). No other end entity is allowed.

• either a user with an X-Auth identifier.

For more information on how to configure a VPN tunnel, refer to ???and for information about X-Auth,

refer to Section 12.4.5, “Configuring VPN Communities”.
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• In the Authentication configuration form in the filtering rule:

• Select the option Authentication using IPSec ID (DN from VPN user).

• drag and drop the same users (and/or groups of users) which have been defined in the X-Auth

authentication.

For more information on how to configure a rule, refer to Section 8.3, “Creating a New Filtering Rule”.

• Once the VPN tunnel is mounted and when a flow passes through the tunnel, the Fast360 appliance

retrieves the IPSec ID (the X-Auth identifier of the user used to mount the VPN tunnel) and checks if

the IPSec ID matches one of the users or groups ID in the rule.

Limitations of the IPSec ID filtering

When you configure an authentication using the IPSec ID, the following cases are not allowed:

• NTLM and Kerberos users or groups of users. Even if they are used for the X-Auth authentication in

one of your VPN communities. A coherency error indicates this case is not allowed.

• The use of VPN communities with an authentication with X509 certificates associated to the definition

of users with no DN or certificate in the filtering rule. A coherency error indicates this case is not

allowed.

• If the X-Auth authentication is not used in the VPN community: the use of VPN communities with a

shared key authentication associated to the definition of users with no DN or certificate in the filtering

rule.

• If the X-Auth authentication is used in the VPN community: the use of VPN communities with a shared

key authentication associated to the definition of users with no DN or certificate in the filtering rule

and who are not in the X-Auth community.

14.1.3. Transparent authentication

This type of authentication is completely transparent and determines the user authenticated on the

Windows client workstation which generates the flow. This mode without agent is simple to implement

and can be used on a trusted network (not on the Internet).

Note

Transparent authentication only works on Windows client workstations which are in the same

Active Directory domain than the Fast360 appliance. In addition, the WMI service must be

enabled on the Windows firewall on client workstations.

To enable transparent authentication on output flows, select the option Transparent authentication

(without agent) in the filtering rule.

For more information on how to configure a rule, refer to Section 8.3, “Creating a New Filtering Rule”.
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Authentication flows communication

• A Windows workstation sends a request (for example HTTP) to a machine (for example a server)

located after the Fast360 appliance.

• The Fast360 appliance receives the SYN packet.

• The filtering engine analyzes the filtering rules until it finds the rule which characteristics are

matched by the packet (source, destination, service, authentication, time management). The rule with

transparent authentication matches the packet.

• The filtering engine checks the user who generates the flow has been selected in the filtering rule.

• A WMI request is sent to the Windows client workstation which generated the flow.

Note

In the case of a rule with transparent authentication, the WMI request to the Windows client

workstation can cause a short latency. We recommend you to place rules with transparent

authentication last in the filtering rules list.

• The Windows workstation answers giving the identifier (as defined in the Active Directory) of

connected users (generally only one user).

• If several users' identifiers are sent: for security reasons, the authentication automatically fails

because the Fast360 appliance cannot know which user sent the request. The filtering engine then

keeps analyzing the rules.

• If the client workstation does not answer the WMI request (for example because it is a Linux

workstation or because it is after a router), the authentication automatically fails. The filtering engine

then keeps analyzing the rules.

• If the identifier sent by the workstation does not belong to the same Active Directory domain than the

appliance, the authentication automatically fails. The filtering engine then keeps analyzing the rules.

• Now, the filtering engine knows the identifier of the user who generated the flow. It then requests the

Active Directory server to know the user's groups.

• The filtering engine now knows the identifier of the user and the user's groups. It can compare these

data with the rule's characteristics and decide if it definitively applies the rule or not.

This authentication type does not really authenticate the connected user (no password or certificate

are requested): it is more an identification. Only the fact of retrieving the user's groups from the Active

Directory enables to check the user really belongs to the domain.

For each new connection emitted by the client workstation, the Fast360 appliance first checks the

authentication is recorded in memory. The authentication is recorded during five minutes:

• If the workstation IP address is still recorded, the Fast360 appliance does not send again a WMI

request.

• If the workstation IP address is no longer in memory (after five minutes), the Fast360 appliance sends

another WMI request.

Windows Configuration

The following procedure applies to Windows Server 2008, 2008 R2, 2012 and 2012 R2. It may slightly vary

depending on your version of Windows Server.
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Automatic configuration of Windows firewall settings with group policy

To automatically configure the Windows firewall, create a new group policy object:

1. Go to Start > All programs > Administrative Tools > Group Policy Management.

2. In the console tree, right-click your domain and select Create a GPO in this domain, and link it here.

3. Enter a GPO object name and click OK.

4. Right-click the newly created group policy object and select Modify.

5. Under Computer Configuration, expand Policies > Windows Settings > Security Settings > Windows

Firewall with Advanced Security > Inbound connections.

6. Right-click and select New Rule with Predefined option and select Windows Management

Instrumentation (WMI).

7. Check Windows Management Instrumentation (WMI-In).

8. Select Allow the connection and click Finish.

9. Edit the properties of the newly created rule: in the Advanced tab, uncheck the Private and Public

boxes. Only domain hosts will be able to generate WMI requests on the client workstations.

The group policy must only apply to Windows 7, Windows 8, Windows 2008 and Windows 2012

workstations. To do so, create a new WMI filter in Group Policy Management which will then be

associated with the group policy:

1. Right-click the WMI filters folder and select New.

2. Click Add.

3. Keep the suggested namespace and enter the following request:

select * from Win32_OperatingSystem where Version like "6.%"

4. Click OK and Save.

Note

In some rare cases, WMI may not work properly on the affected client workstation. It is

impossible to repair it with a group policy due to the following reasons:

• no parameter of the WMI type can be configured in group policies.

• a repair script cannot be considered because it would require administrator rights (the script

would contain the administrator login and password of the domain, using a run as command,

which is prohibited in terms of security).

Manual configuration on a client workstation

Windows firewall manual configuration

Go to Control Panel > Windows Firewall > Advanced Settings > Inbound rules. Two rules related to

incoming WMI requests are preconfigured and defined by default on Block.

1. Select the Windows Management Instrumentation (WMI-In) rule about the Domain profile.
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2. In the Enabled column, select Yes.

3. In the Action column, select Allow.

Verification of WMI operation

1. In Start > Computer, right-click Computer Management and expand Services and Applications.

2. Right-click WMI Control and select Properties. The obtained window must mention: Successfully

Connected to: <local computer>.

If you do not obtain this message, transparent authentication from a Fast360 appliance will fail. The event

viewer displays an error message when the WMI service cannot be reached. In this case, follow the

WMI manual repair procedure.

WMI manual repair

1. Go to Start > All Programs > Accessories.

2. Right-click Command Prompt and select Run as Administrator.

3. Enter the following commands, one after the other:

• cd /d %windir%\system32\wbem

• net stop ccmexec /y

This service may not be installed or launched on your workstation. In this case, ignore the error

message and enter the next command.

• net stop sharedaccess /y

This service may not be installed or launched on your workstation. In this case, ignore the error

message and enter the next command.

• net stop winmgmt /y

• rd /S /Q repository

• net start winmgmt

• net start ccmexec

• net start sharedaccess

• winmgmt /salvagerepository

4. Restart your workstation for the repair to be effective.

It is also possible to run a .bat script (as an administrator).
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14.2. Authentication servers

Note

If there are several controllers on the same domain, you must declare all the controllers in Arkoon

Manager configuration: you must all create and place them into the Auhentication servers zone

in the Authentication menu of the Security tab on an appliance.

14.2.1. LDAP

This section explains how to configure the Fast360 appliance to authenticate users by connecting to an

LDAP authentication server. After these steps, you need to import users defined on the LDAP server in

the Arkoon Manager configuration following the procedure described in Section 14.3, “Importing users

or groups of users from an authentication server”.

1. In the Network objects explorer view, create a new host object by right-clicking on theHosts folder,

select New > Host. The Host configuration tab is displayed on the right.

2. Select the Properties configuration form.

a. Enter the name of the LDAP server in the Name field.

b. Enter a comment in the Description field.

3. In the Network configuration form, enter the IP address of the server in the IP address field.

4. Select the Services configuration form and check the LDAP Server option. The parameters to be

configured are displayed on the right.

5. Define how long the authentication is kept in the cache in the Cache lifetime field.

6. Define how long the connection will be maintained in case of inactivity in the Timeout field.

7. Select the connection mode from:

• Standard mode: by default, the connection is made on port 389.

• Secure mode: the information exchanged between the Fast360 appliance and the LDAP server is

encrypted in SSL.

a. The default port for SSL is 636.

b. Enter the domain name in the Server name field.

8. Define the communication method between the LDAP server and the client (the Fast360 appliance) in

the LDAP Protocol field. It is recommended to use the default value, 2.

9. Specify to what level the search must be done among the objects under the search base in the Scope

field:

• To search among all the objects located under the search base, select subtree.

• To search among the objects located on the first level under the search base, select one-level.

10.Define the tree's element, its Distinguished Name (DN) from which the search must begin in the Search

Base field.

11.Check the Use custom user account option to deactivate the default connection (connection with the

LDAP server is established in anonymous mode) if the access rights of this mode are inadequate for

accessing users and groups. The Fast360 appliance will use the whole DN of the user to establish a

connection with the LDAP server.
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• It is strongly recommended that you create a specific administrator account with the required

access rights. In the Login and Password fields, enter the account details required by the Fast360

appliance to connect to the LDAP server.

12.Configure the users queries in the Users fields:

a. Define the object class characterizing users on the LDAP server in the Users Object Class field.

b. Define the attribute containing the user's login in a user object in the User Login Attribute field.

c. Define the Relative Distinguished Name (such as common name/cn) used to retrieve a user's main

name in the Users RDN field.

13.Define the groups queries in the Groups fields:

a. Define the object class characterizing groups on the LDAP server in the Groups Object Class field.

b. Define the attribute containing the group's ID in a group object in the Group ID attribute field.

c. Define the attribute containing the group's member list in a group object in the Group Member

Attribute field.

d. Define the Relative Distinguished Name (such as common name/cn) used to retrieve a group's

main name in the RDN field.

14.Check the Retrieve user password option to enable the password to be returned encrypted to the

Fast360 appliance.

Note

Only iplanet (Netscape), IBM Directory Server and Open LDAP servers are allowed to return

the value of the userPassword attribute.

15.Check the UTF8 encoding option to allow the use of special characters, e.g. characters with accents,

in any data exchange.

14.2.2. NTLM

This section explains how to configure the Fast360 appliance to authenticate users by connecting

to a Windows authentication server. After these steps, you need to import users defined on the

Windows server in the Arkoon Manager configuration following the procedure described in Section 14.3,

“Importing users or groups of users from an authentication server”.

Prerequisites

The use of the authentication functionality with an NTLM server requires the following prerequisite:

The appliance must exclusively use the DNS server of the concerned domain. To ensure an optimal

operation, you must define a host name for the Fast360 appliance with a suffix identical to the

domain DNS. For example, if the domain is named arkoon.net, the appliance host name must be

fast360.arkoon.net

Note

On a cluster with two nodes, the host name used for binding to the NTLM server must be defined

in the Hostname field of the Properties configuration form of the cluster object.

1. In the Network objects explorer view, create a new host object by right-clicking on the Hosts folder,

select New > Host. The Host configuration tab is displayed on the right.
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2. Select the Properties configuration form.

a. Enter the name of the AD NTLM server in the Name field.

b. Enter a comment in the Description field.

3. In the Network configuration form, enter the IP address of the server in the IP address field.

4. Select the Services configuration form and check the AD NTLM Server option. The parameters to be

configured are displayed on the right.

5. Define how long the authentication is kept in the cache in the Cache lifetime field.

6. Define how long the connection will be maintained in case of inactivity in the Timeout field.

7. Enter the domain name of the authentication server in Netbios format in the Domain field (example:

“arkoon” for “arkoon.net”).

8. Enter the Netbios name of the server in the Computer field.

9. In Approved domain management, if you select Accept authentication requests from all approved

domains and if your NTLM server is defined as main PDC in the Security configuration form of the

Fast360 appliance, a user will be able to authenticate on all domains which AD servers are listed in

the Authentication servers field.

10.Define the user account and password in the corresponding fields of the Binding the domain  section

if you want to use the domain bind mode. If you do not configure the computer account, the default

anonymous bind mode will be used.

For a Active Directory server whose version is under Windows 2008 (Windows 2000 Server,

Windows 2003 Server), to bind a machine to a domain, a user must be part of the Domain

administrators group.

For a Active Directory server whose version is above or equal to Windows 2008, there are two

solutions:

• Solution 1: in order to bind a machine to a domain, a user must be part of the Domain administrators

group.

• Solution 2: in order to bind a machine to a domain, a user must own an administration delegation

on the specified Organization Unit (OU).

11.Define the user account and password to be used to retrieve users and groups of the domain from the

authentication server in the corresponding fields of the Retrieving users and groups section.

Note

On the server, you must define a computer account with the host name of the Fast360 appliance

(as defined in  minarkconf ). You do not need to do this if you have configured the Binding the

domain and Retrieving users and groups options.

• For a Windows 2000 server, you must re-initialize the computer account created for the Fast360

appliance once you have created it.

• For an AD NTLM server, the host name of the Fast360 appliance (as defined in  minarkconf ) must reflect

the NT domain, for example, arkoon.NT_DOMAIN

Note

In HA and HP cluster modes, each node must have its own host name which is used to identify

it when communicating with the NT authentication server. There is no relationship between the

nodes' authentication status.
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14.2.3. Radius

This section explains how to configure the Fast360 appliance to authenticate users by connecting to a

Radius authentication server.

1. In the Network objects explorer view, create a new host object by right-clicking on theHosts folder,

select New > Host. The Host configuration tab is displayed on the right.

2. Select the Properties configuration form.

a. Enter the name of the Radius authentication server in the Name field.

b. Enter a comment in the Description field.

3. In the Network configuration form, enter the IP address of the server in the IP address field.

4. Select the Services configuration form and check the RADIUS Server option. The parameters to be

configured are displayed on the right.

5. Define how long the authentication is kept in the cache in the Cache lifetime field.

6. Define how long the connection will be maintained in case of inactivity in the Timeout field.

7. Define the port to be used in the Port field. Note, there is no standard port for a Radius authentication

server.

8. Enter the access key defined on the Radius server in the Shared secret field.

Note

The access key defined on the Radius server is communicated by the administrator who has

its responsibility.

14.2.4. Kerberos

This section describes how to configure the Fast360 appliance to authenticate users by connecting

to a Kerberos authentication server. After these steps, you need to import users defined on the

Kerberos server in the Arkoon Manager configuration following the procedure described in Section 14.3,

“Importing users or groups of users from an authentication server”.

Prerequisites

The use of the authentication functionality with a Kerberos server requires the following prerequisites:

• The appliance must exclusively use the DNS server of the concerned domain. To ensure an optimal

operation, you must define a host name for the Fast360 appliance with a suffix identical to the

domain DNS. For example, if the domain is named arkoon.net, the appliance host name must be

fast360.arkoon.net

Note

On a cluster with two nodes, the host name used for binding to the Kerberos server must be

defined in the Hostname field of the Properties configuration form of the cluster object.

• The Active Directory server version must be Windows 2003 R2 or higher;

Important

The time on the Fast360 appliance and the time on the Kerberos server must not have more than 5

minutes of difference. We recommend using the NTP protocol on the appliance and on the server.
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1. In the Network objects explorer view, create a new host object by right-clicking the Hosts folder and

select New > Host. The Host configuration tab is displayed on the right.

2. Select the Properties configuration form.

a. Enter the name of the AD Kerberos authentication server in the Name field.

b. Enter a comment in the Description field.

3. In the Network configuration form, enter the IP address of the server in the IP address field.

4. Select the Services form and check the AD Kerberos Server box. The parameters to be configured

are displayed on the right.

5. Enter the domain name of the authentication server in the Domain field.

Important

The domain name must be in NETBIOS format. Communications are case-sensitive.

6. Enter the server name in the Computer field. Only enter the prefix of its DNS. For example, if the server

is named serv-ad.arkoon.net, enter serv-ad.

Note

If the Kerberos computer name is updated, it is necessary to restart the winbindd service

after installing the configuration to take the new name into account.

7. In Realm Kerberos, enter the Kerberos domain name, also named “Realm”, in capitals. For example,

if the DNS domain name is arkoon.net, the name of the Kerberos realm must be ARKOON.NET.

8. In DNS Domain, enter the entire DNS domain name of the Kerberos server. For example: arkoon.net.

9. In Approved domain management, if you select Accept authentication requests from all approved

domains and if your Kerberos server is defined as main PDC in the Security configuration form of the

Fast360 appliance, a user will be able to authenticate on all domains which AD servers are listed in

the Authentication servers field.

10.Determine the account and the user password in the corresponding fields of Binding the domain

section if you want to use domain junction. You can also manually create the computer account of the

appliance on the Active Directory (the host name corresponds to the appliance name for a standalone

appliance or to the cluster object host name for a cluster object). If you do not configure the computer

account, the anonymous junction mode will be used.

For an Active Directory server with a version under Windows 2008 (Windows 2003 Server), a user

must be part of Domain admin group to reach a workstation in a domain.

For an Active Directory server with a version higher or equal to Windows 2008, there are two

solutions:

• Solution 1: a user must be part of Domain admin group to reach a workstation in a domain.

• Solution 2: to reach a workstation in a domain, a user must have an administration delegation on

the specified OU (Organization Unit).

11. In the fields of Retrieving users and groups section, determine the account and the user password to

use to retrieve the users and domain groups from the authentication server.

Note

The DNS server(s) of the appliance and internal client workstations are also Kerberos servers,

that is why it is often necessary to add a filtering rule allowing these servers to access public

DNS servers.
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Note

In Kerberos mode, the DNS is very important. Network parameters of web clients (Firefox and

Internet explorer for example) have to be configured by defining the proxy DNS name, not the

IP address.

12. It is possible to customize how long the authentication is kept in the cache in the Cache lifetime field.

13. It is possible to customize how long the connection will be maintained in case of inactivity in the

Timeout field.

Kerberos configuration example

14.3. Importing users or groups of users from an

authentication server

After creating the hosts with the LDAP Server, AD NTLM Server or AD Kerberos Server services in the

folder Hosts of the Network objects explorer as described in the previous sections, it is necessary to

install the configuration and then to import the users and groups defined on your authentication server:

1. In the Authentication folder in the explorer, right-click on Users or Groups of users, and select Import.

2. Select the type of the authentication server from which you want to import users. The Select Server

window opens.
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3. In the tree view, for one authentication server, select the Fast360 appliance which is going to query

the authentication server.

In the case of a multi-appliances configuration, you have to be connected to the AMC server to import

users or groups. In the tree view, you can see all the configured authentication servers as well as all the

appliances administered by the AMC server and able to communicate with each authentication server.

Note

If you are directly connected to a Fast360 appliance, you can only import users through this

appliance although all the appliances are visible in the tree view.

Note

It is not necessary to import users from a Radius authentication server.

14.4. Importing Certificates for FAST SSL/TLS

Authentication

The default configuration of the FAST SSL/TLS module, described in the section called “FAST SSL/TLS

Module”, blocks SSL/TLS connections with sites which have non-verifiable certificates. This means

certain sites will become unreachable, for example if they use self-signed certificates or the certificate

has expired or if the certificate is signed by a subordinate Certificate Authority of which the root Authority

is unknown. If necessary you can resolve problems this may cause by importing trusted certificates into

the Fast360 configuration using the following procedure.

1. Acquire the certificate

Before you can import a trusted certificate, you need to acquire it by asking the administrator of the

relevant service to supply it in PEM format, or by exporting from a browser such as Internet Explorer

or Mozilla Firefox (with the Cert Viewer Plus extension).

Note

In Internet Explorer, export the certificate as X.509, base 64 format, and save the file with a

.pem extension (not .cer)

2. Import the certificate

With the certificate file copied to the management PC, it can be imported into the Fast360 appliance

configuration.

Warning

These steps are to be applied in the configuration of the appliance and not in the configuration

of the certification authority.

a. In the Authentication explorer view, right-click on the Certificates folder, select New > Certificate.

The Certificate configuration tab is displayed on the right.

b. Select the Properties configuration form and enter a name for the certificate, for example “intranet-

ssl”, and a short description in the corresponding fields.

c. Select the X.509 Certificate configuration form and load the certificate by clicking on Import from

file and entering the file location.

3. Create a certificate store for FAST SSL/TLS certificates
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The certificate store for FAST SSL/TLS trusted certificates is created as an “External PKI Server” (the

appliance itself is the server in this case).

a. In the Authentication explorer view, right-click on the PKI folder, select New > PKI . The PKI

configuration tab is displayed on the right.

b. Select the Properties configuration form and enter a name for the certificate bank, for example

“fast-ssl-tls”, and a short description, for example, Fast360  Internal PKI, in the corresponding

fields.

Note

You must use the name fast-ssl-tls for this configuration, to allow the FAST SSL/TLS

module to authenticate using these certificates.

c. Select the X.509 Certificate configuration form and drag and drop the trusted certificates from the

Certificates descriptive view into the X.509 Certificate field.

d. Define the hierarchy depth in the Maximum depth field. This field is not taken into account in the

case of an external PKI.

14.5. Authentication and Multi-appliances Configuration

In multi-appliances configuration with an AMC server, some types of authentication described in

this chapter may not work when flows have to pass through several Fast360 appliances. Indeed,

authenticating a user is sometimes only possible for the first Fast360 appliance of the chain. For example,

it is always the case with the IPSec ID authentication.

To avoid this phenomenon, it is possible to trust the authentication performed by another Fast360

appliance. The first appliance normally sends the authentication request as defined in the filtering rule,

and then the other appliances trust the first one and let the flow pass through without requesting the

authentication of the flow source. This allows an identified flow to pass through several appliances but

the trust is possible only with some configurations. The configuration must comply with the following

conditions:

• All the Fast360 appliances must be part of the same AMC configuration.

• Flows with authentication must pass through VPN tunnels between the Fast360 appliances. The

administrator must ensure this is the case. This restriction guarantees two conditions necessary for

the security: the flow really comes from another Fast360 appliance and it has not been altered.

The Trust authentication established by other appliances option in the Security configuration form of the

Fast360 appliance, in the Authentication tab, enables to choose this trust mode. The option is selected

by default.

When selecting this option, an implicit filtering rule is automatically created. Such a rule is added for all

the explicit rules created in Arkoon Manager which meet the following conditions:

• the action of the rule is to accept flows.

• at least one type of authentication is used in the rule.

The implicit rule is added just before each explicit rule which meets the conditions above.

For more information about implicit and explicit rules, refer to Chapter 8, Basic Traffic Filtering Using

Filtering Rules.
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For example, for a A rule with authentication, the implicit rule is placed just before the A rule and displays

the following characteristics:

• Name: “[Name of the A rule]”

• Source: same sources than in the A rule

• Destination: same destinations than in the A rule

• Service: same services than in the A rule

• Schedule: same schedule than in the A rule

• Log: same than in the A rule

• Authentication: authentication using IPSec ID enabled

• Users: list of all the users of all the Fast360 appliances in the configuration (identified thanks to their

VPN certificate).

• Installation: same options than in the A rule except for the appliances for which the Trust

authentication established by other appliances option is disabled.

• Action: Accept

This rule allows thus a flow coming from another appliance which matches the characteristics of the A

rule. It does not check the authentication of the client workstation source of the flow but only checks

that the flow comes from a VPN tunnel between two Fast360 appliances.

14.5.1. Example of configuration

This is an example of configuration working with this trust mode.

In this case, the configuration of both Fast360 appliances is managed by the AMC server. A VPN tunnel

is mounted between LAN 2 and the servers network. To allow the client to access the web server and to

authenticate this flow, the following rule must be defined:

• Name: “LAN 2 toward web server”

• Source: LAN 2

• Destination: web server

• Service: HTTP

• Log: standard

• Authentication: transparent
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• Users: R&D (NTLM group)

• Action: Accept

If the trust mode is enabled, the flow coming from the client is authenticated by the Fast 2 appliance

(transparent request to the client workstation). If the user belongs to the R&D group, the flow is accepted

and sent to the server passing though the VPN. The Fast 1 appliance checks the source of the flow.

The flow comes from a VPN tunnel between two Fast360 appliances, thus the trust implicit rule can be

used. The flow is accepted and no additionnal transparent authentication request is needed. In Arkoon

Monitoring, two logs display:

• A log from the Fast 2 appliance indicating that the flow has been accepted by the rule “LAN 2 toward

web server (agentless)”

• A log from the Fast 1 appliance indicating that the flow has been accepted by the rule “LAN 2 toward

web server (trust authentication) (ipsec-id)”

14.5.2. Trust and customized installation of filtering rules

The trust mode implies that the authentication is correctly performed by the first Fast360 appliance

of the chain. If the user is not valid, the flow is rejected by the appliance. It is thus important all

the Fast360 appliances have a consistent configuration. It may not be the case if, for instance, a

rule with authentication is not automatically installed (Automatic installation option in the Deployment

configuration form in the filtering rule) but only installed on a list of appliances defined by the user. In

this case, a coherency warning displays.
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Chapter 15. Multi-Fast360 Appliances

 This section introduces the Multi-Fast360 appliances principle and a guide for this type of

installation.

15.1. Introduction

15.1.1. Purpose of the Multi-Fast360 Appliance

The principle consists in centralizing the administration of a set of Fast360 appliances: the AMC server

centralizes the configurations management.

There are three independent functionalities:

• AMC server: you connect to the AMC server to manage the configuration of all the Fast360 appliances

connected to the AMC server.

• Primary Fast360 appliance: its license possesses the options that can be activated on all the boxes. The

protected IP addresses are counted globally by the primary instead of on every site by each Fast360

appliance. The other Fast360 appliances are secondary.

• CA Arkoon (Certification Authority): the AMC server hosts a CA that will create and manage all the

certificates. The Fast360 appliances are said to be non-CA.

15.1.2. Format of this Section

This section introduces:

• The multi-appliances and CA/non-CA mechanisms.

• The procedure for implementing a multi-appliances architecture.

• The particularities of managing a multi-appliances configuration with  Arkoon Manager .

15.2. Operation of Multi-Fast360 Appliances

15.2.1. AMC server/Appliances

Connections

The appliances must be permanently connected to the AMC server, by an SSL connection on port 1754.

This has several consequences:

• The AMC server and its appliances must have a permanent Internet connection.

• The AMC server must be accessible on a permanent public address: either the Fast360 appliance has

a public address, or the Internet access router makes a translation to reroute port 1754 on the Fast360

appliance.
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Mechanisms

You connect to the AMC server with  Arkoon Manager . When you install a configuration, the AMC server

broadcasts it to all its appliances.

You can connect to an appliance with  Arkoon Manager , but the modifications you make will be

overwritten at the next configuration broadcast from the AMC server, if the appliance is still connected

to it.

Caution

It is not possible to configure the same addressing plan on several sites.

It is possible to configure the uploading of the logs from the appliances toward the AMC server. However,

this can impact the AMC server's disk space and bandwidth if you have many appliances.

You can connect to the appliances with  Arkoon Monitoring  to view what is not specific to the logs (VPN,

bandwidth, system logs, etc.).

Configuration

The implementation of the multi-appliances mechanism is done in  minarkconf . The steps are described

in the rest of this document. It consists in specifying on the appliances their "slave" role and the AMC

server's IP address (you can indicate several addresses if the server has several Internet accesses).

For more details about the manipulations related to  minarkconf , refer to the First-Time Configuration

Guide.

For more information about the configuration of the AMC server, refer to the AMC Server Administration

Guide.

Multi-appliances management in HA/HP cluster

For a cluster in an AMC architecture, the cluster master node:

• synchronizes management data with the AMC server;

• sends logs to the AMC server.

15.2.2. CA/non-CA

Connections

There is no connection for the CA. You take control in terminal mode (screen/keyboard, SSH connection,

connection via the serial port) to manage the certificates.

Mechanisms

The AMC server/appliances connection is authenticated by certificates generated by the same

Certification Authority. Thus, you create the certificates (with Firewall rights) of all the Fast360 appliances

on this Certification Authority (with  minarkconf  or  Arkoon Manager ). The certificates are generated in

the PKCS#12 format. Import then these files on the corresponding Fast360 appliance using the  minarkconf

tool.
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15.3. Topology of a Multi-Fast360 Appliances

Architecture

The most common case is a AMC server called “central-arkoon”, that acts as the CA, and a Fast360

appliance called “agency-arkoon”, that is non-CA.

It is recommended to configure in the following order:

• The CA Fast360 appliance before the non-CA Fast360 appliances.

• The AMC server before the Fast360 appliances.

15.4. Implementing a Multi-Fast360 Appliances

Architecture

15.4.1. Configuration of the AMC Server

For more information about the configuration of the AMC server, refer to the AMC Server Administration

Guide.

15.4.2. Configuration of the Non-CA Fast360 Appliance

If the Fast360 appliance was CA, it is recommended to delete the CA (Certificate and Delete Certificate

Authority menus).

Enter the Certificates menu of the “agency-arkoon”, then select Import  Fast360  certificate. Then specify

the .p12 certificate with FIREWALL rights previously created on the CA (please refer to “Configuration

of the CA” above).

┌──────────────── Certificates ─────────────────┐
│                                               │
│ ┌───────────────────────────────────────────┐ │
│ │ a Initialize a Certificate Authority (CA) │ │
│ │ b Import new Arkoon certificate           │ │
│ │ c View Arkoon certificate                 │ │
│ │ d Back                                    │ │
│ └───────────────────────────────────────────┘ │
│                                               │
├───────────────────────────────────────────────┤
│                 <OK>  <Cancel>                │
└───────────────────────────────────────────────┘
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15.4.3. Configuration of Appliances Connected to the AMC Server

Migration of a Fast360 appliance to an AMC server

Enter the Configuration menu, then select Master/Slave (Config). Check Slave and specify the public

address (or addresses) of the AMC server.

1. ┌───── Master/Slave (Config) ─────┐
│ ┌─────────────────────────────┐ │
│ │        ( ) 1 Master         │ │
│ │        (X) 2 Slave          │ │
│ │        ( ) 3 None           │ │
│ └─────────────(+)─────────────┘ │
├─────────────────────────────────┤
│          <OK>  <Cancel>         │
└─────────────────────────────────┘

2. ┌───── Master IP ─────┐
│ ┌─────────────────┐ │
│ │                 │ │
│ └─────────────────┘ │
├─────────────────────┤
│   <OK>  <Cancel>    │
└─────────────────────┘

Insert spaces between IP addresses.

3. ┌───── Master Signal Ports ─────┐
│ ┌─────────────────┐ │
│ │                 │ │
│ └─────────────────┘ │
├─────────────────────┤
│   <OK>  <Cancel>    │
└─────────────────────┘

4. ┌───── Master Data Port ─────┐
│ ┌─────────────────┐ │
│ │                 │ │
│ └─────────────────┘ │
├─────────────────────┤
│   <OK>  <Cancel>    │
└─────────────────────┘

Once validated, IP addresses are tested one after the other in order to display a report indicating if:

• it has been possible to connect to the AMC server on all its addresses;

• it has been possible to connect to the AMC server on some addresses only;

• it has not been possible to connect to the AMC server;

If the connection is OK, the appliance looks for the roles base and the CRL on the AMC server.

Configuration of a new Fast360 appliance directly in the AMC configuration

1. First, you must generate a FIREWALL certificate on the AMC or on the certification authority for the

new appliance to install and then prepare its license file. To generate the certificate, refer to the

section called “Mechanisms”.

2. Configure the new appliance with minarkconf. Refer to the First-Time Configuration Guide for more

information about the procedure. Be careful to follow the order of the steps described below in order

to get the hardsyscfg and hardsyscfgxml configuration files at the end of the procedure. They will

be sent to the AMC server at the first connection:

1. Configure the appliance IP addresses.
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2. Configure the Internet access.

Caution

The default Internet access creates an object named “Internet access” with the

“Internet Router” object as the LS/Routeur gateway. When the new appliance is added

to the AMC configuration, both objects are created if they do not already exist in the

configuration. Then, they will be used by default by the next appliances added to the

configuration (even if addresses do not match).

3. Define the AMC network's IP address as the “Admin from” address (IP address allowed to

remotely manage the Fast360 appliance).

4. Copy and install the appliance's certificate generated during the first step.

5. Copy and intall the appliance's license.

6. In the Configuration menu in minarkconf, select Master/Slave (Config) to configure the new

appliance as “slave” of the AMC server. Check Slave and specify the public address (or

addresses) of the AMC server, as well as ports 1754 and 1759.

Caution

It is important that step 6 be the last step. After this step, the appliance's hardsyscfg

and hardsyscfgxml configuration files are issued and sent to the AMC server. During

this step also, the CRL is updated and the role base is initialized on the new appliance

(the base of the AMC is copied).

3. Finally connect Arkoon Manager to the AMC server and load the remote configuration. The AMC

server reports the presence of a new appliance and ask to add it to the configuration as new

hardware. Accept the request and check the information about the new appliance, in particular the

configuration of the Internet access.

4. Deploy the configuration the first time without modifying it. The new appliance receives then the

AMC server's XML configuration file.

15.4.4. Multi-Fast360 Communication

The following step consists in establishing a communication link between the AMC server and its

appliances.

Communication Check

To make sure the appliance is successfully connected to the AMC server, type the following command

on the AMC server:

akserv "MGT:MSG STATUS SLAVE-STATUS"

If the appliance is connected, its IP address and ID appear after those of the AMC server.
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Troubleshooting

You must identify the communication problem. Does the appliance not query the correct IP address?

Does the AMC server accept the appliance connections from this address? Do the appliance's packets

reach the AMC server?

15.4.5. Addition of a cluster connected to the AMC server

This section explains how to add a cluster in an AMC architecture.

Prerequisite

On the AMC server's CA:

1. Generate two FIREWALL type .p12 certificates. For more information about certificate generation, refer

to Chapter 3, Managing Authentication Certificates and Administrator Rights.

2. Export the administrator's certificate in PEM format.

1st step: Preparation of the Cluster

To implement the cluster, Arkoon Manager must be directly connected to the future master node.

1. Initialize the cluster using the certificates generated at the previous stage. You must initialize the

roles base with the administrator's certificate exported in PEM format. For more information, refer

to Section 13.3.1, “Initializing a High Availability (HA) Cluster” or Section 13.8.1, “Initializing a High

Performance (HP) Cluster”.

2. Configure the cluster:

• Configure at least one interface.

• Define the master node's address.

• Correct the hosts' names.

• Activate network communication between the cluster and the AMC server.

• Make sure that no error appears when deploying the configuration via Arkoon Manager.

For more information, refer to Section 13.3.2, “Configuring Services on a High Availability (HA) Cluster”

or Section 13.8.2, “Configuring Services on a High Performance (HP) Cluster”.

2nd step: Connection of the Cluster to the AMC Server

To connect the cluster to the AMC server, refer to Section 15.4.3, “Configuration of Appliances Connected

to the AMC Server”. Perform this operation via SSH or in console mode on both nodes of the cluster. A

confirmation message indicates that the master node is connected to the AMC server. On the slave node,

a message indicates that the node will only connect to the AMC server when it will become master node.
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3rd step: Synchronization of the Cluster by the AMC Server

This stage consists in loading the remote configuration by connecting to the AMC server from Arkoon

Manager. When loading, Arkoon Manager indicates that an information update has been detected and

a new cluster has been discovered. Validate the addition of the cluster to make it operational and allow

the AMC server to configure it. Deploy the configuration at least once from the AMC server.

15.5. Configuration of the AMC Server and its Appliances

with  Arkoon Manager

Once you checked the communication link between the AMC server and its appliances, connect with the

Manager to continue with the configuration.

A "central-arkoon" object and an "agency-arkoon" object should appear in  Arkoon Manager .

Each Fast360 appliance now has its own properties (interfaces, routes, proxies, etc.) whereas the rest

of the configuration is common to all the Fast360 appliances: definition of the hosts, networks, filtering

rules, VPN, etc.

15.5.1. Installation of the Filtering Rules on each Fast360 Appliance

The same configuration file is installed on the AMC server and the appliance. Using the "arkoon ID",

mentioned in the configuration, each Fast360 appliance knows what its properties are. It can then deduct

which filtering rules it must implement according to its interfaces and routes addresses.

However, you can force a Fast360 appliance into installing or not a filtering rule with the rule's Installation

tab.

Important

In the case of Fast360 appliances without an Internet access, it becomes very important to use

the Installation tab. The rule installation will not be possible if one of the connected Fast360

appliances does not know all of the objects implied in the rule. You then have to either add a

static route, or add an Internet access, or specify on which Fast360 appliance to install the rule.

15.5.2. VPN Implementation

The configuration of LAN-to-LAN VPN is made easier by a multi-appliances architecture. Since there is

no need to exchange the certificates, you just have to configure the VPN module, networks' VPN gateway,

tunnel group and filtering rule.

Example 15.1. Authorizing Pings in VPN

Authorizing the ping of LAN-agency to LAN-central using the VPN: you only have to create a single rule

encrypting from “agency-arkoon” to “central-arkoon”.

For more details, see Chapter 12, Configuring IPsec VPN Tunnels.

Caution

The "agency-arkoon" is not CA; therefore, if you want to implement a nomad VPN on the "agency-

arkoon", you must create a certificate (or sign the request) on the CA, i.e. the "central-arkoon".
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15.6. Managing the CRL in an AMC context

When a new appliance connects to the AMC instance for the first time, it tries to retrieve automatically

the AMC CRL:

• If the CRL comes from an Arkoon Certification Authority directly managed by the AMC instance, once

the configuration of the appliance is finished (via minarkconf, Master/Slave menu), the appliance

directly retrieves the CRL from the instance. There is nothing more to do.

• If the CRL comes from a Certification Authority managed by an external PKI:

• If the key arkoon-config : arkoon-amc.certificate.crl-trust-master = yes is defined on

the AMC server (default value), the AMC instance is allowed to send its CRL to the appliance, even

if the instance is not a Certification Authority.

• If the key arkoon-config : arkoon-amc.certificate.crl-trust-master = no is defined, the

AMC instance does not send its CRL because it is reckoned that it is not a Certification Authority

and that it does not have to provide a CRL it cannot manage. As a consequence, you must install

manually the CRL on the appliance via the menu Advanced administration>Install PEM Certificate

Revocation List file... in Arkoon Manager.

If the CRL is updated (a certificate has been added, deleted, revoked), in the case of an Arkoon

Certification Authority, it is automatically sent to all the appliances of the instance. If an appliance is not

connected, the deployment of the CRL is delayed and the CRL will be installed the next time the appliance

will connect.

In the case of an external PKI, the updated CRL is automatically sent to the appliances if the arkoon-

config key mentioned above is set to Yes. If the key is set to No, the update must be done manually via

the menu Advanced administration>Install PEM Certificate Revocation List file... in Arkoon Manager.

15.7. Deleting permanently an appliance in a multi-

appliance configuration on an AMC

The AMC server keeps all the appliances already logged and cannot determine automatically that an

appliance Fast360 does not exist any longer (in case of replacement or reinitialization of an appliance or

when deleting a site for example).

To delete permanently an appliance:

1. Select the appliance to delete.

2. Right-click on the appliance and select Delete permanently.

All the references to the appliance on the AMC are deleted and the appliance does not display

system information.
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16.1. Monitoring an Appliance

System monitoring (sysmon) enables to configure the monitoring of different system elements. According

to the status of the element monitored, monitoring alerts can display a red, orange or green level in the

Alerts window in Arkoon Monitoring (System monitoring alert type). Modifying the status of these system

elements will generate alerts.

arkoon-config keys enable to customize the system monitoring configuration in the configuration file.

When connected to an appliance, use the sysmon client LIST command to display all system

monitoring options.

Note

No action is required to activate system monitoring. It is integrated by default in the basic

configuration of Arkoon Manager. Only system monitoring of types Interfaces, Internet access

and HTTP proxy are configured in Arkoon Manager.

Monitoring HTTP proxy, interfaces and internet access

Warning

System monitoring of type Interfaces and Internet access are not taken into account when

working out of the priority of a cluster node and then do not affect the status of a cluster.

The status of the interfaces and Internet access is checked by sending a ping to a host configured in the

system monitoring. The status of the HTTP/FTP proxy is checked by submitting a request.

1. In the Network objects explorer view, double-click the Fast360 appliance icon. The Fast360 appliance

configuration tab is displayed on the right.

2. Select the Audit configuration form.

3. Select the System Monitoring option.

4. To create a new entry, right-click in the blank System Monitoring table, select New > System

Monitoring . The System Monitoring dialog box is displayed.

5. Enter the name of the system monitoring and a short description in the corresponding fields.

6. Select the type of network object to which the system monitoring will be applied from one of the three

options:

• To monitor an interface, check the Interface monitoring option.

a. Drag and drop the interface to be monitored into the Interface field.

b. Drag and drop the hosts to be pinged into the Tested Hosts field.

• To monitor an Internet access, check the  Internet Access monitoring option.

a. Drag and drop the Internet access to be monitored into the Internet Access field.

b. Drag and drop the hosts to be pinged into the Tested Hosts field.
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Note

It is recommended to define several tested hosts in order to avoid false positives.

Detailed characteristics of interfaces and Internet access monitoring:

System name aknetmon

System generic type OUTCONN-PING

Available on platforms P, XLARGE, NPA, VE

Orange level reached if at least one host to be pinged is considered as

unreachable

Red level reached if all hosts to be pinged are considered as

unreachable

• To monitor the HTTP proxy, check the HTTP Proxy monitoring option.

Detailed characteristics of the HTTP proxy monitoring:

System name akhttpmon

System generic type HTTP-PROXY

Available on platforms P, XLARGE, NPA, VE

Orange level reached not used

Red level reached as soon as the waiting period for one request has

ended

7. In the Time between two tests field, define the time interval between two tests. By default this value

is 3 seconds.

8. In the Test timeout field, define the delay after which no reply from the monitored element will be

considered as a failure. The default value is 5 seconds.

Note

The values in the Time between two tests and Test timeout fields must be coherent to prevent

ill-founded alerts. When testing interfaces or Internet access, the Test timeout value must be

reasonable.

Monitoring MySQL database size

Enables to monitor regularly the size of the MySQL database on the hard disk.
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Common name logs size

System name logs

System generic type LOGS-SIZE

Available on platforms Small, P-XS3, P-S4

Orange level reached • if the size of the MySQL base is more than 75%

of the size of the 'max-db-size' key (550 Mb by

default);

• if the size of one of the MySQL base tables is

more than 75% of the size of the 'max-table-size'

key (180 Mb by default).

Red level reached • if the size cannot be calculated for any reason;

• if the tables of the base cannot be listed for any

reason;

• if the size of the MySQL base is more than 90%

of the size of the 'max-db-size' key (550 Mb by

default);

• if the size of one of the MySQL base tables is

more than 90% of the size of the 'max-table-size'

key (180 Mb by default).

Interrogation frequency every hours

arkoon-config customizable keys (displayed here with their default value in the configuration):

• sysmon.alerts.config-X.orange-action = "/opt/arkoon/bin/akdbpurge -f"

Action to trigger if the orange level is reached.

• sysmon.alerts.config-X.orange-action-dsc = "Force akdbpurge operation."

Description of the action above.

• sysmon.alerts.config-X.red-action = "/etc/init.d/mysqld flush"

Action to trigger if the red level is reached.

• sysmon.alerts.config-X.red-action-dsc = "Force flush of mysql database."

Description of the action above.

Example 16.1. Example of use of the configuration keys for the logs size system

monitoring

sysmon.alerts.config-14.name = "logs size"
sysmon.alerts.config-14.period = 3600
sysmon.alerts.config-14.orange-level = 75
sysmon.alerts.config-14.orange-action = "/opt/arkoon/bin/akdbpurge -f"
sysmon.alerts.config-14.orange-action-dsc = "Force akdbpurge operation."
sysmon.alerts.config-14.red-level = 90
sysmon.alerts.config-14.red-action = "/etc/init.d/mysqld flush"
sysmon.alerts.config-14.red-action-dsc = "Force flush of mysql database."
sysmon.alerts.config-14.max-table-size = 180
sysmon.alerts.config-14.max-db-size = 550

• The sizes are in Mb. sysmon.alerts.config-14.max-table-size = 180 and

sysmon.alerts.config-14.max-db-size = 550 keys indicate the maximal size for a table and the

maximal size for the complete database. The limit is by table and by complete database.
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• The orange level (75% reached) is a akdbpurge -f where -f forcing the flush for a configuration

which backups MySQL logs after 7 days (text format) and deletes these logs from the database. It also

deletes backups which are kept for more time than the duration defined by the administrator in the

Alerts tab of the log policy. The red level is reached at 90% and the complete database is flushed.

• When a SMALL appliance starts, if /var available space is less than the value stored in the

hardware.free-space-limits.var key (by default, this key is at 400 Mb), the tar.gz SOPHOS

and ADVANCED_URL archives stored in /var/arkupdate as well as cteng*.dat, ngs*, av_check_*,

pop3_mail*, rak_pop3av*.mm, rak_*.mm, *.*AV and *.*-$ temporary files stored in /var/tmp are

deleted.

Monitoring the MySQL database status

Enables to check that the database is working properly.

Common name logs db

System name logs

System generic type LOGS-MEDIA

Available on platforms P, XLARGE, NPA, VE

Orange level reached if the status of the database is:

• getting fixed;

• updating (when the base format changes

between two versions);

• does not work (not available).

Red level reached not used

Interrogation frequency every 30 seconds

Monitoring CPU load

Enables to check the average load over the five last minutes.

Common name CPU load

System name cpuload

System generic type CPU-LOAD

Available on platforms P, XLARGE, NPA, VE

Orange level reached from 75 % of load

Red level reached from 90 % of load

Interrogation frequency every 30 seconds

arkoon-config customizable key (displayed here with the default value in the configuration):

• sysmon.alerts.config-X.sampling = 300

Sampling frequency (300 seconds = 5 minutes), it means that the CPU load is calculated over the five

last minutes.
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Monitoring RAM occupancy

Enables to check the percentage of occupancy of the RAM.

Common name memory usage

System name memusage

System generic type MEM-USAGE

Available on platforms P, XLARGE, NPA, VE

Orange level reached from 75% of occupancy

Red level reached from 90% of occupancy

Interrogation frequency every 30 seconds

Monitoring occupancy of hard disk partitions

Enables to check the percentage of occupancy of the different partitions on the hard disk (/var, /

configcard and /tmp).

Common name /var usage, /config_card usage or /tmp usage

System name diskmon

System generic type DISK-USAGE

Available on platforms P, XLARGE, NPA, VE

Orange level reached from 75% of occupancy

Red level reached from 90% of occupancy

Interrogation frequency every 30 seconds

arkoon-config customizable keys (displayed here with their default value in the configuration):

• sysmon.alerts.config-3.akalert.low-level = 75

Occupancy percentage from which a low level alert is reported in the alerts table.

• sysmon.alerts.config-3.akalert.med-level = 90

Occupancy percentage from which a medium level alert is reported in the alerts table.

• sysmon.alerts.config-3.akalert.high-level = 95

Occupancy percentage from which a high level alert is reported in the alerts table.

• sysmon.alerts.config-3.akalert.alert-kernel = yes

Boolean which indicates if a message must be sent to the kernel in order to report that the partition

on which logs are stored (/var most of the time) is complete. This can block network traffic under

saturation. For more information, refer to the section called “Recommended configuration for an

optimal protection against attacks of the type logs saturation”.

Monitoring user license validity

Enables to check the user license is not expiring or already expired.
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Common name license

System name license

System generic type LICENSE

Available on platforms P, XLARGE, NPA, VE

Orange level reached when there are less than 240 hours (10 days)

remaining before the expiration

Red level reached if the license is expired or when there are less than

144 hours (6 days) remaining before the expiration

Interrogation frequency every 30 seconds

Monitoring logs queue

Enables to check the status of logs queues.

Common name log queues

System name logs

System generic type LOGS-QUEUE

Available on platforms P, XLARGE, NPA, VE

Orange level reached if logs queues are:

• complete at the user level;

• complete at the kernel level;

• complete at the user and kernel levels.

Red level reached not used

Interrogation frequency every 30 seconds

Monitoring the roles database of cluster nodes

Enables to check if the current roles database is the same between both nodes of a cluster.

Common name cluster role

System name cluster_version

System generic type CLUSTER-ROLE

Available on platforms P (in cluster mode), NPA (in cluster mode),

VE (in cluster mode). For each platforms, this

system monitoring is activated only on the passive

appliance.

Orange level reached if the current roles database is different between

both nodes

Red level reached not used

Interrogation frequency every 30 seconds

arkoon-config customizable key (displayed here with the default value in the configuration):



Chapter 16. Monitoring, Logging, Error Messages

Monitoring the system version of cluster nodes | 329

• sysmon.alerts.gencfg-X.ha-active-disable = yes

Indicates that this system monitoring is deactivated on the active node.

Monitoring the system version of cluster nodes

Enables to check the version is the same between both nodes of a cluster.

Common name cluster version

System name cluster_version

System generic type CLUSTER-SYSTEM

Available on platforms P (in cluster mode), NPA (in cluster mode),

VE (in cluster mode). For each platforms, this

system monitoring is activated only on the passive

appliance.

Orange level reached if the version is different between both nodes

Red level reached not used

Interrogation frequency every 30 seconds

arkoon-config customizable key (displayed here with the default value in the configuration):

• sysmon.alerts.gencfg-X.ha-active-disable = yes

Indicates that this system monitoring is deactivated on the active node.

Monitoring the configuration of cluster nodes

Enables to check the current configuration is the same between both nodes of a cluster.

Common name cluster conf

System name cluster_version

System generic type CLUSTER-CONF

Available on platforms P (in cluster mode), NPA (in cluster mode),

VE (in cluster mode). For each platforms, this

system monitoring is activated only on the passive

appliance.

Orange level reached if the current configuration is different between

both nodes

Red level reached not used

Interrogation frequency every 30 seconds

arkoon-config customizable key (displayed here with the default value in the configuration):

• sysmon.alerts.gencfg-X.ha-active-disable = yes

Indicates that this system monitoring is deactivated on the active node.

Monitoring appliance services status

Enables to check that all the services of an appliance work properly.
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Common name services

System name servmon

System generic type SERV

Available on platforms P, XLARGE, NPA, VE

Orange level reached not used

Red level reached if at least one service no longer works

Interrogation frequency every 30 seconds

Monitoring the status of the declared external PKI

If using an external PKI, it enables to monitor different elements such as the validity of X509 certificates

and the CRL.

Common name pki

System name pki

System generic type PKI-CRL

Available on platforms P, XLARGE, NPA, VE

Orange level reached • if the CRL is about to expire;

• if the CRL is about to expire and there are more

than four CRL updates which have not been

applied properly;

• if there are more than four CRL updates which

have not been applied properly;

• if the CRL has expired and there are more than

four CRL updates which have not been applied

properly but the grace period has not ended.

Red level reached • if the CRL file of the PKI has not been found

on the appliance (because it has never been

downloaded for example);

• if the CRL is corrupted;

• if the CRL has expired;

• if the CRL has expired and there are more than

four CRL updates which have not been applied

properly;

• if the CRL has expired and the grace period has

ended;

• if the CRL has expired and there are more than

four CRL updates which have not been applied

properly and the grace period has ended.

Interrogation frequency every 30 seconds

arkoon-config customizable keys (displayed here with their default value in the configuration):

• sysmon.alerts.config-X.cert-name

Name of the trusted certificate, as defined in the Arkoon Manager configuration.
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• sysmon.alerts.config-X.file

Name of the system file which includes the CRL for the concerned PKI.

• sysmon.alerts.config-X.warn-before-expiration

Period remaining before the CRL expires: 120 minutes by default.

• sysmon.alerts.config-X.warn-too-old-update

Number of failed CRL updates before the change of status.

• sysmon.alerts.config-X.crl-grace-days

Grace period after the expiration of the CRL (0 days by default).

Monitoring hard disk(s)

Enables to monitor some parameters of the hard disk(s) (temperature, number of hours of use, etc.)

Common name disk0, disk1, etc.

System name harddrive

System generic type DISKS

Available on platforms P, XLARGE, NPA, VE

Orange level reached • if the number of hours of use of the disk exceeds

30000 hours (configured in the power.orange-

level key);

• if the disk temperature exceeds 50 degrees

celsius.

Red level reached • if the surface of the hard disk is damaged

(defective clusters or sectors for example);

• if the disk read heads are defective;

• if the disk has a mechanical problem;

• if the disk temperature exceeds 55 degrees

celsius.

Interrogation frequency every 30 seconds

arkoon-config customizable keys (displayed here with their default value in the configuration):

• sysmon.alerts.config-X.temperature.orange-level = 50

Maximum temperature to trigger the orange level.

• sysmon.alerts.config-10.temperature.red-level = 55

Maximum temperature to trigger the red level.

• sysmon.alerts.config-10.power.orange-level = 30000

Maximum number of hours of use to trigger the orange level.

• sysmon.alerts.config-10.scsi.noncorrectable.red-level = 0

Maximum number of errors before considering that a SCSI hard disk has a problem and that a red alert

must be reported.

Monitoring bandwidth

For each QoS rule in the Arkoon Manager configuration, enables to check QoS values are not exceeded,

which may mean there is bandwidth problem.
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Common name name of the class or of the TRTCM used in the

Arkoon Manager configuration

System name qos

System generic type QOS

Available on platforms P, XLARGE, NPA, VE

Orange level reached • if packets have been rejected by a QoS rule;

• if queues exceed thresholds configured in the

Arkoon Manager configuration.

Red level reached not used

Interrogation frequency every 30 seconds

Monitoring the network link on an interface

Enables to check network link works properly on an interface.

Common name link:eth0, link:eth1, etc.

System name link

System generic type LINK

Available on platforms P, XLARGE, NPA, VE

Orange level reached • if the link is UP but not RUNNING;

• if the link is RUNNING but not UP.

Red level reached • if the link is neither UP, nor RUNNING (that is to

say “link down”);

• if the link is active but the interface has been

deactivated ('ifconfig ethX down' for example).

Interrogation frequency every 30 seconds

Monitoring the VRRP status of a cluster node

Enables to display the VRRP status of a cluster node.

Common name cluster

System name cluster_state

System generic type CLUSTER-STATE

Available on platforms P (in cluster mode), NPA (in cluster mode), VE (in

cluster mode)

Orange level reached not used

Red level reached not used

Interrogation frequency every 10 seconds

Monitoring DNS latency for URL filtering

Enables to check and display DNS latency for the SmartWeb functionality (“in the cloud” URL filtering).
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Common name Smart URL latency

System name dsnurl

System generic type DSN-URL

Available on platforms P, XLARGE, NPA, VE

Orange level reached from more than 30 milliseconds of DNS latency

Red level reached from more than 50 milliseconds of DNS latency

Interrogation frequency every 300 seconds (5 minutes)

Monitoring RAID status

Enables to monitor the RAID status (Redundant Array of Independent Disks).

Common name raid1 (/tmp), raid2 (swap), etc. (as many as there are

partitions on the appliance)

System name softraid

System generic type SOFT-RAID

Available on platforms P

Orange level reached • when a disk is reconstructing;

• if the synchronization of disks/partitions of the

RAID is reported (for any reason).

Red level reached • if the RAID has disappeared from the partitions

(for any reason);

• if the RAID is not working;

• if one disk/partition of the RAID has a problem.

Interrogation frequency every 600 seconds (10 minutes)

Monitoring TCP packets loss on an interface

Enables to display the percentage of TCP packets loss on a specific interface.

Common name pktloss:eth0, pktloss:eth1, pktloss:vrrpv2g231, etc.

(as many as there are interfaces on the appliance).

The following interfaces only can be monitored by

this sysmon: Ethernet (ethX), adsl/pppoe (adslX),

VLAN (ethX-YYY), Bonding (ethgrpX).

The following interfaces cannot be monitored

by this sysmon: bridge interfaces (brX), bonding

interfaces, bridged Ethernet interfaces, bridged

VLAN interfaces, IPSec interfaces (ipsecX) and the

“loopback” interface.

System name pktloss

System generic type PKTLOSS

Available on platforms P, XLARGE, NPA, VE
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Orange level reached not used

Red level reached if the rate of lost TCP packets is more than 1%

Interrogation frequency every 60 seconds

arkoon-config customizable keys (displayed here with their default value in the configuration):

• sysmon.alerts.gencfg-X.interface = "eth0"

Enables to specify the interface on which the loss of TCP packets is worked out.

• sysmon.alerts.gencfg-X.max-loss-percent = "1.0"

Enables to define the maximum rate of TCP lost packets to reach the red level. This number must be

a chain of characters representing a floating-point number.

• sysmon.enable_tcp_pktloss_monitoring = yes

Enables to activate or deactivate system monitoring of type pktloss on all the interfaces of the

appliance.

Machines monitoring

Enables to monitor destination servers used in filtering rules using port translation (PAT) and load

balancing.

Common name HostMon

System name HostMon

System generic type HOSTMON

Available on platforms P, XLARGE, NPA

Orange level reached if at least one of the monitored server no longer

answers to an ICMP request

Red level reached if all servers no longer answer to an ICMP request

Interrogation frequency every 5 seconds

arkoon-config customizable keys (displayed here with their default value in the configuration):

• sysmon.alerts.gencfg-X.host.Y.ip = "xxx.xxx.xxx.xxx"

Enables to add the IP address of a server to monitor.

• sysmon.alerts.gencfg-X.host.Y.service = "PING"

Enables to define the monitoring service to use (PING service only).

16.2. Displaying Logs and Alerts

Arkoon Monitoring tool allows to display 5 types of logs:

• IP logs (see Section 16.2.1, “Displaying IP Logs”).

• Alerts (see Section 16.2.2, “Displaying Alerts”).
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• IDPS logs (see Section 16.2.3, “Displaying IDPS Logs”).

• HTTP logs (see Section 16.2.4, “Displaying HTTP Proxy Logs”).

• SMTP logs (see Section 16.2.5, “Displaying SMTP Relay Logs”).

To execute Arkoon Monitoring:

1. Double-click on Arkoon Monitoring icon.

The Arkoon Monitoring interface is displayed.

2. When the Arkoon Monitoring window is opened, click on  from the toolbar to connect to a firewall.

Once the connection is established, you have access to the following menus of the interface:

3. Select the type of logs you want to display.

Each log window has the same toolbar  as well as arrows to move within the

logs or tools to select what must be displayed.

16.2.1. Displaying IP Logs

The IP logs window allows to view the information which relates to the packets accepted, blocked or

denied when their logging is set in the security policy installed on the Fast360 appliance.



Chapter 16. Monitoring, Logging, Error Messages

336 | Displaying IP Logs

Levels of IP packets logging

Three logging levels exist:

• No logging.

• Standard logging: display of main header fields, of flow rule processing the packet, etc.

• Full logging: display of packet's content (hexadecimal format and ASCII format) added to information

of standard logging.

The logging level of a packet depends from the flow rule which takes it into account:

• Explicit rules: the logging level is defined in the flow rule (see Chapter 8, Basic Traffic Filtering Using

Filtering Rules).

• Implicit rules: all the rules do not log packets (see Chapter 8, Basic Traffic Filtering Using Filtering

Rules).

Note

Regarding a rule logging and accepting the flow, only the first packet of a new connection will be

logged. Regarding a rule blocking or denying, all the packets blocked or denied will be logged.

An ICMP error message is logged according to the ICMP policy applied by the appliance. For

more details about the ICMP policy, seeSection 8.5.3, “Managing ICMP Policies”.

Detail of logged information

IP logs allow to display the following information:

• Date: date and time of the appliance at the moment where the packets arrives

• Arkoon: name of the appliance logging the packet.

• Source: source IP address.

• Destination: adresse IP destination.

• Service: service name and associated destination port.

Note

The name of the indicated service corresponds to the name of the destination port in the

services file of the administration station. For a Linux station, it is the /etc/services file. For

a Windows station, it is the C:\WINNT\system32\drivers\etc\services file.

• User: name of the appliance user.

• Action: action done on the packet (this field can be: Accepted, Blocked, or Denied).

Note

The color of the line depends on the action done on the packet: if the packet is accepted, the

line is green. If the packet is blocked or denied, the line is red.

• Protocol: name of protocol.

• Interface in: name of input interface.

• Interface out: name of output interface.

Note

In case of a VPN encrypted connection, the name of the interface is preceded by ipsec/. This

allows you to verify that a flow actually goes through a VPN.

• Flags (TCP): packet's flag, in case of TCP flow.
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• Reason: in case of packet's deny, this column gives the cause.

• Description: this column provides details about the reason reported in the previous column.

• Rule name: name of flow which processes the packet.

• Translation: indicates the type of translation realized, if there is one.

• Source IP NAT: indicates the translated IP source address, if needed.

• Source Port NAT: indicates the translated source port, if needed.

• Destination IP NAT: indicates the translated destination IP address, if needed.

• Destination port NAT: indicates the translated destination port, if needed.

• Length: packet's length (in bytes).

• Nb octets C->S: number of bytes sent by the client to the server.

Note

This value is defined when the active connection is suppressed from the table of active

connections.

• Nb octets S->C: number of bytes sent by the server to the client.

Note

This value is defined when the active connection is suppressed from the table of active

connections.

• TCP Seq: sequence number, in case of TCP flow.

• TCP Ack: acknowledgement number, in case of TCP flow.

• Source status: supposed status of the connection for the source.

• Destination status: supposed status of the connection for the destination.

• Src isn: initial sequence number of the source.

• Dst isn: initial sequence number of the destination.

• Source window: size of window for the source.

• Destination window: size of window for the destination.

• Expected NoSeq: expected sequence number.

• Expected NoAck: expected acknowledgment number.

• Date end of con: date and time of the appliance at the connection closing.

• Reason end of con: conditions in which the connection has been closed.

• IDPS Score.

• User: name of user if authenticated on flow rule.

• IDPS profile name

• IDPS profile description

• Compromised host: machine which already received IDPS matches.

• Log ID: unique identifier.

Note

The IDPS activity is viewed. Nevertheless, it is possible to choose to only view the IDPS activity

by enabling the IDPS only option. In this case, only the IDPS connections with non nil score

appear. In both cases, IDPS connections appear in bold.

You can view the detail of the matches associated with the connection as well as the detail of

corresponding signatures. Right-click the desired line and select Show IDPS matches details from the

displayed menu. The corresponding dialog box displays:
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This window permits to directly access a web page with explanations of the attack. For this, just click

the blue link in the References zone. For more details, see Section 11.2, “IDPS” and Section 16.6.9,

“Configuring IDPS Alerts”.

Besides, it is possible to view the content of a blocked packet by double-clicking it. The corresponding

window displays:
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It is possible to do a DNS resolution on the source or destination IP address. This functionality is

particularly interesting when the IP address is public.

1. Right-click the public IP address.

2. Click IP address resolution in the displayed menu.

The IP lookup window appears. It contains the name of the host corresponding to the public IP

address.

16.2.2. Displaying Alerts

The Alerts window allows to display the messages generated by some events ranging from an

administration connection to a protocol violation. Each message is associated with a gravity level.

From the Display menu, select Windows and then Alerts from the displayed submenu. The Alerts dialog

box displays.

Detail of logged information for each alert

This window allows to view the following information for each alert generated:

• Date: date and time of the appliance at the moment where the alert has been generated.

• Arkoon: name of the appliance concerned by this alert (this information is useful with a multi-

appliances architecture where the appliances notify these alerts to the AMC server).

• Type: the alerts are classified in categories (see the section called “Alerts meaning”).

• Level: the level indicates the gravity of the alert.

• Description: this column provides accurate information about the event corresponding to the alert.

• Administrator: this column indicates the certificate (case of Arkoon Manager or Arkoon Monitoring) or

the login (case of a connection in console mode) used by the administrator used by the administrator

to do the action which generated this alert.

A gravity level is associated with each alert . See the section called “Alerts meaning”.

Alerts meaning

The existing alerts levels are: None, Low, Medium, High:

• None: this is a simple information, there is no abnormal behavior.

• Low: this is an information which relates to an event that can have an impact on security.

• Medium: the alert indicates an event deserving to be analyzed by the administrator.

• High: the alert notifies a problem deserving to be quickly diagnosed (a corrective action must probably

be done by the administrator).

Note

In case you notify the alerts by e-mail, we advise you to select the only High alerts.

The alerts are divided as follows between the different levels:
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None:

• Internet access UP: the Internet access is operational.

• IKE alert: the VPN is established.

• Arkoon DOWN: the appliance has been switched off by one of the following means: stopping or

restarting by Arkoon Monitoring, stopping or restating in command line, stopping or restarting by short

pressure on the Power button of the case.

• Arkoon UP: the appliance has been electrically switched on (manually or after a voluntary restarting).

• Configuration installed: configuration installed via Arkoon Manager or in command line.

• Administration connection: administration connection successful.

• Creation of a new certificate: a new certificate has been created from Arkoon Manager or minarkconf.

• Date/time modified: the date and/or the time of the Arkoon has been modified from Arkoon Monitoring

or minarkconf.

• Interface DOWN: the Ethernet interface is down.

• Interface UP: the Ethernet interface is connected again.

• Interface disconnected: the ADSL (PPPoA) or ISDN interface is down.

• Interface reconnected: the ADSL (PPPoA) or ISDN is connected again.

• Database has been flushed: a log has manually been flushed with Arkoon Monitoring.

• Automatic flush and backup (table full): when the database's volume reaches 95 % of the available

space, 7 % of the database is automatically flushed.

• Admin from value modification

• Upgrade: download or upgrade correctly done.

• Certificate revoked: a certificate has been revoked via Arkoon Manager or minarkconf.

• Automatic flush and backup: backup and database flush were correct.

• Service started: one of the aklogd or mysqld services has been started.

• Service stopped: one of the aklogd or mysqld services has been stopped.

• User added or removed with minarkconf

Low:

• Encrypted file in mail

• Bad SPI: the SPI (Security Parameter Index) ID of the encrypted packet is not correct.

• New mail in quarantine

• Error while analyzing mail: the antiviral analysis did not work well.

Medium:

• IKE alert: problem while negotiating VPN tunnel.

• Authentication failure: a user failed to authenticate on a flow rule.

• Database flushed: a problem occurred during the manual flush of a log from Arkoon Monitoring.
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• Automatic flush and backup (table full): when the database's volume reaches 95 % of the available

space, 7 % of the database is automatically flushed. There was a problem during flush.

• Mail denied by applicative rule: a mail has been denied by a SMTP applicative rule.

• Packet blocked by filter: the packet has been blocked by a flow rule.

• Unsequenced packet:the packet sequence number is not correct.

• Automatic flush and backup: a problem occurred during backup or database flush.

• Application protocol violation

High:

• Internet access DOWN: the Internet access is not available.

• IKE alert: authentication failure during VPN negotiation.

• Arkoon UP: unwished restarting of Fast360 appliance.

• Administration connection: failure of administration connection (password, certificate, ...).

• HA host active: the HA appliance, previously passive, has become active

• HA host inactive: the HA appliance, previously active, has become passive.

• HA link DOWN: the link between both HA cases has been disconnected.

• HA link UP: the link between both HA cases has been connected.

• Bad packet: the packet has been blocked by a 3 or 4 level-control.

• Upgrade: problem during download or upgrade.

• Arkoon OS patch: system updated by administrator.

• Quarantine full

• Portscan

• Service restarted

• License violation

• Virus detected: virus detected by HTTP, SMTP or POP3 proxy.

Display colors for alerts

The display color of the alerts within the dialog box corresponds to the filtering level:

• Black corresponds to None level.

• Brown corresponds to Low level.

• Purple corresponds to Medium level.

• Red corresponds to High level.

Opening the IP log corresponding to the date of an alert

From the Alerts window, it is possible to open the IP log corresponding to the date of an alert.
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In the Alerts window, right-click the desired alert.

Select Go to the IP logs to the date of this alert from the displayed pop-up menu:

• If the IP log is not already open, it gets open to the date of the alert.

• If the IP log is already open, it gets positioned to the date of the alert.

16.2.3. Displaying IDPS Logs

The IDPS logs window allows to view the main characteristics of the connection which released the

IDPS alert.

Filtering of connections

First select the IDPS profile which will abort a connection by using the IDPS profile drop-down menu. If

needed, define then the minimal score of the connection. For this, enable the Score min option and enter

then the score in the corresponding field.

For details, see Section 16.6.9, “Configuring IDPS Alerts”.

Details of logged information

IDPS logs allow to view following information:

• Date: date and time of the appliance when the connection aborted.

• Source: source IP address of aborted connection.

• Destination: destination IP address of aborted connection.

• Protocol: name of protocol.

• Source port

• Destination port

• IDPS profile name

• IDPS profile description

• Score end of con: score at the end of connection.

• Reaction: reaction implemented by the appliance

•

Note

IDPS logs regarding connections toward compromised hosts are displayed in purple.
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Viewing of matches associated with connection

To view the details of matches associated with the connection as well as the details of the corresponding

signatures, double-click the concerned line. The corresponding details window then displays on the

screen.

Note

This window permits to directly access a web page with explanations of the attack. For this, just

click the blue link in the References zone.

16.2.4. Displaying HTTP Proxy Logs

The HTTP proxy logs allow to display the details of HTTP, FTP, HTTPS and Gopher requests which are

relayed by the HTTP proxy.

Details of logged information

• Date: date and time of the appliance when the request arrives.

• Arkoon: name of the appliance logging the packet.

• Client IP: source IP of the client submitting the request.

• User: name of user if authenticated.

• Request: content of request.

• Result Code: result code of request.

• Reference: content of Referer header of HTTP packet.

• Browser: browser used by the client, as specified in the User-Agent header of HTTP packet.

• Nb bytes: size of received data in reply to the request in bytes.

• Category: category of the URL if the request object has been categorized.

• Rule name: applicative rule used if the request object is managed by a rule. If no rule matches the

request, default rule displays.
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16.2.5. Displaying SMTP Relay Logs

The SMTP relay logs allow to display the detail of mails relayed by the SMTP relay.

Details of logged information

• Date: date and time of the appliance when the request arrives.

• Arkoon: name of the appliance logging the packet.

• Mail ID: identifier associated with the mail (randomly generated).

• Client IP:IP address of the SMTP client who submitted the mail.

• Origin: submitter's mail address.

• Recipients: email address(es) of the recipient(s).

• Subject: mail's object

• Nb bytes: mail's size in bytes

• Result: result of mail's processing.

This message can have the following values:

• Receipt OK (message in blue): the mail has been fully received and successfully matched the anti-

relaying rules (so is it in the first mail queue);

• Content OK (message in green): the mail successfully went through the applicative rules and the

antivirus analysis (it arrived in the second mail queue);

• Relay denied (message in red): the mail has been denied by an anti-relaying rule.

• Virus detected in message: the mail is infected.

• Message denied by rule: the message has been denied by an applicative rule.

• Message denied: a problem occurred during the analysis.

• File corrected: the infected file has been repaired.

• File removed: the problematic file has been removed.

• File encrypted

• Bad file accepted

• Message size exceeds fixed limit.

• Message quarantined

• Message sent without anti-virus analysis

• Error while opening file : the message could not be analyzed.

The color of the line corresponds to the result of mail processing:

• Blue: receipt OK.

• Green: content OK.

• Black: erroneous file accepted.

• Red: all the other messages are in red because it is a question of problems or facts which must

be noticed by the administrator.

• Reason: size of received data in reply to the request in bytes.

• Rule name
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Case of an anti-relaying rule including use of DNSBL

If the mail has been processed by an anti-relaying rule including the use of DNSBL and if the address is

blacklisted, the result will appear in the Reason field of the SMTP relay logs.

The line is red and the result is Relay denied if the obtained score is greater than or equal to the configured

threshold.

The line is blue and the result is Receipt OK if the obtained score is lower than the configured threshold.

This permits to monitor the DSNBL working mode and to adjust the configuration if needed by using

Arkoon Manager.

16.3. Displaying System Logs

The Messages logs window allows to edit the last lines of the system logs and to view in real time the

new informations logged.

• messages: main system logs.

• jftpgw.log: FTP proxy logs.

• jftpgw.commandlog: detail of FTP sessions going through the FTP proxy.

• dmesg: kernel system logs.

• http: system logs of HTTP proxy.

• mysqld.log: system logs of audit database.

• vpn.log: system logs of VPNs.

• cron.log: system logs of the CRON.

16.3.1. Interrupting/Starting again the Log Edition

You can interrupt the log edition for a while. This allows you to have a look at a particular line of the log.

• Interrupting the log edition: click the  icon. The icon changes into , confirming that the log edition

has been interrupted.

Note

Interrupting the log edition does not interrupt the generation of the log and thus only concerns

the display.

• Starting again the log edition click the  icon. The icon changes into , confirming that the log

edition has been started again.

16.3.2. Clearing the Log Content

To clear the content of the system log, click the  icon.
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16.4. Displaying Active Connections

The Active connections window allows to view the table of active connections.

• ID: identifier.

• Parent ID: parent identifier (this column is only filled in if there is a secondary connection).

• Creation date: appliance time and date during the active connection creation.

• Protocol: protocol name.

• Source IP: source IP address of the connection.

• Source port: source port of the connection.

• Destination IP: destination IP address of the connection.

• Destination port: destination port of the connection.

• Source NAT: translated source address and port.

• Destination NAT: translated destination address and port.

• Translation type: type of translation realized for this translation (the possible values are described

below).

• 1: masquerading by choosing the IP address which replaces the source IP address.

• 2: masquerading by using the IP address of the output interface to replace the source IP address.

• 4: static NAT.

• 32: static port translation (PAT).

• 256: local redirection (used for the transparent proxy).

• Client status: status of connection on client side.

• Server status: status of connection on server side.

• Internet access: number of Internet access used by the active connection.

• IPSec tunnel C->S: VPN tunnel number when the connection is encrypted between the client and the

appliance.

• IPSec tunnel S->C: VPN tunnel number when the connection is encrypted between the server and the

appliance.

• Nb bytes C->S: number of bytes sent by the client to the server.

• Nb bytes S->C: number of bytes sent by the server to the client.

• Nb packets C->S: number of packets sent by the client to the server.

• Nb packets S->C: number of packets sent by the server to the client.

• Delay: timeout associated with the connection.

• User name (relay): user name if the connection goes through the HTTP/FTP proxy and that

authentication is requested.

• User name (rules): user name if the connection goes through a flow rule which requires authentication.

• User name (VPN): user name with which the VPN connection is associated (in Arkoon Manager, it is

the user login with which the certificate is associated).

• Description: status of connection at the applicative level.

• HA status: status of connection for an appliance. This parameter can have the following values:

• 1: active (the connection is active on this appliance).
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• 2: private (the connection is local and will not be repeated when switching).

• 3: passive (the connection is passive on this appliance).

• 4: repeat (the connection has been created on the other HA appliance and has been repeated after

switching).

• IDPS Score: connection final score.

• IDPS profile name: IDPS profile name related to connection.

• Description : applicative profile name related to connection.

16.4.1. Hiding non established connections

When the table includes a huge number of active connections, it can be used to hide non established

TCP connections for more clarity. For this, activate the Hide non established connections option.

16.4.2. Delete a connection

1. From the Active connections window, select the connection to deactivate.

2.
Click on .

A message displays asking you to confirm the suppression of the connection.

3. Click on Yes to confirm.

16.5. Displaying Fast360 Appliance State

16.5.1. Displaying CPU Load

To display the CPU load level, click on , then on the CPU tab.

The graph allows to view the evolution of the CPU load during the last three minutes.
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If the CPU load is greater than 85%, there probably is a process abnormally using resources.

If it is greater than 95%, it urges to find the cause of this abnormal behavior.

16.5.2. Displaying Disk Space Use

To display the disk space use, click on , then on the Disk tab .

The graphs allow to view the detail the occupation of the hard disk for the partitions /tmp, /config and

/var.

16.5.3. Displaying Memory Use

To display the memory use, click on , then on Memory tab.

The graphs allow to view the detail of memory occupation (RAM, swap and total).

If the use of memory is greater than 85%, there probably is a process abnormally using resources.

If it is greater than 95%, it urges to find the cause of this abnormal behavior.
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16.5.4. Displaying Appliance Time and Date

To display time and date, click on , then on the Time tab.

You can view the date and time of both local machines, that is to say the administration station (in the

Local machine zone) and the appliance (in the Arkoon zone).

To modify time and date:

1. Click on the Time tab.

2. Click Change Arkoon time. (or press Alt + O).

The Arkoon time dialog box displays. You can either enter the new time and date or activate the Set

to local time option, which sets the appliance to the same time and date than the administration

station.

3. After you modified the time and/or date, click on Validate or press on Alt + V.

16.6. Managing Logs and Alerts

This section explains how to manage logs generated by the Fast360 appliance. There are types of different

logs (alerts, IP logs, SMTP proxy logs, HTTP proxy logs), which are implicitly managed with a database.

This configuration can be modified to allow transmission to a syslog server.

The Fast360 appliance also generates system logs. These are not managed by a database, so the same

filtering and selection options available for the different logs mentioned above are not possible. However,

the system logs can be sent to a syslog server.

The following table shows the different types of logs generated by the Fast360 appliance and their

corresponding storage media.

Table 16.1. Logs Generated by the Fast360 Appliance and their Storage Media

Alerts IP and

IDPS logs

HTTP

proxy logs

SMTP

relay logs

System logs

Database

• Archiving

• Flushing logs

X X X X  

Syslogs X X X X X

Mail X     

SNMP traps X     

Forward to

AMC server

X X X X  

This section covers:
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• Accessing the database

• Managing controls on the database

• Storing logs in the database and/or a syslog server

• Exporting logs

• Flushing the database

• Configuring alerts

• Configuring IP, SMTP proxy, and HTTP proxy logs

• Configuring system logs

• Configuring IDPS logs

16.6.1.  Accessing the Database

The database engine is configured to only accept queries from local processes. Queries emitted from

another network station are systematically denied. The only interface conceived for accessing and

managing the database is  Arkoon Monitoring .

16.6.2.  Managing Controls on the Database

Integrity Control

When starting the appliance, the Fast360 appliance checks the integrity of the database.

If the base was abruptly powered down, there is a risk that it may be damaged. In such a case, the Fast360

appliance starts with the option delay_db, that triggers the following behavior:

• The Fast360 appliance starts normally so that it does not affect the operation of the network.

• Once the startup is finished, the database repair begins; during this process, no information is logged.

• The logging resumes as soon as the base is repaired; a Service started (Service started) alert is

generated for the mysqld service.

The option delay_db as well as the option  flush_db can be chosen at startup of the Fast360 appliance.

Press the Ctrl key until the following menu is displayed:

┌──────────────────────────────────────────────────────────────────┐
│ GRUB version 0.93 (639K lower / 64512K upper memory)             │
│ ┌──────────────────────────────────────────────────────────────┐ │
│ │ arkoon                                                       │ │
│ │ arkoon flush_db                                              │ │
│ │ arkoon rescue                                                │ │
│ │ arkoon-undo                                                  │ │
│ │ arkoon init                                                  │ │
│ │ arkoon preinit                                               │ │
│ │ memtest                                                      │ │
│ │ arkoon delay_db                                              │ │
│ └──────────────────────────────────────────────────────────────┘ │
├──────────────────────────────────────────────────────────────────┤
│    Use the ^ and v keys to select which entry is highlighted.    │
│    Press enter to boot the selected OS, 'e' to edit the          │
│    command before booting, or 'c' for a command-line.            │
└──────────────────────────────────────────────────────────────────┘

The option flush_db allows you to flush the entire database.
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Database Protection

As described in the section called “Protection against the Loss of Security Audit Trails”, alerts are

generated to flag an overload of the /var partition which stores the database containing the Fast360

appliance's logs. These alerts, of a progressively low, intermediate or high level depending on the

threshold reached, allow you to take the required actions early enough to prevent saturation of this

partition. See Section 16.13, “Alerts” for more information.

Note

This protection is not activated on Fast360 appliances without a hard disk as its logs are managed

by other mechanisms. The two logs generated by Fast360 appliance without a hard disk (IP logs

and alerts) are flushed at 75% when the occupation rate of the /var partition reaches 93%. The

rate of deletion can be configured in the System configuration form of a log policy in  Arkoon

Manager .

16.6.3.  Managing and Storing Fast360 Appliance Alerts and Logs

Log policies can be used to:

• Configure the Fast360 appliance to prevent the loss of security audit trails

• Define where the alerts and the generated logs will be sent (to syslogs servers and/or into the SQL

base)

Protection against the Loss of Security Audit Trails

To prevent the loss of security audit trails, the Fast360 appliance can block non-administrative events

when it is overloaded for one of the following reasons:

• The /var is 95% full.

• The logs queue is 95% busy.

• The kernel queue is overloaded.

Note

This protection is not activated on a Fast360 appliance without a hard disk because its logs are

flushed as soon as they reach 93% of the /var partition.

In these risk cases, the Fast360 appliance blocks all network flows except for the administrative flows

authorized by the  Admin from parameter of  minarkconf  until the situation is resolved. Therefore, the

users' actions are interrupted as long as they cannot be logged. Administrative tasks can still be carried

out from the administrator's workstation or the Fast360 terminal.

Caution

In the default configuration, this option is not activated. For optimal security, it must be activated.
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Storing Logs

The logs are implicitly sent to the SQL database, which allows them to be viewed with  Arkoon Monitoring

. It is also possible to send them to a syslog server. Syslog server logs are sent in an Arkoon format

compatible with WELF (Webtrends Enhanced Log Format).

1. In the Policies explorer view, select the Log Policies folder.

2. To create a new log policy, right-click on the Log Policies folder, select New > Log Policy. The Log

Policy configuration tab is displayed on the right.

3. Select the Properties configuration form and enter a name and short description of the policy in the

corresponding fields.

4. Follow the procedure for configuring the flushing and archiving options as outlined in the section

called “Daily Flushing and Archiving”.

5. Select the Alerts configuration form:

• To send logs to the database, check the To Database option. By default, this option is checked. For

more information on configuring IP, SMTP, and HTTP logs, see Section 16.6.7, “Configuring IP, SMTP

and HTTP Logs”; for IDPS logs, see Section 16.6.9, “Configuring IDPS Alerts”.

• To send logs to a syslog server, check the To Syslog option and drag and drop the host object

corresponding to the syslog server into the Syslog servers field.

Caution

Specifying syslog servers defines an implicit rule authorizing the Fast360 appliance to send

a UDP 514 syslog flow to the selected syslog server. For more information on implicit rules,

see Section 8.4, “Implicit Filtering Rules”.

6. If the Fast360 appliance is working in multi-appliances mode, check the To Master option and select

the logs to be sent to the AMC server.

Note

You can choose to select one, several or all the different types of logs but you should take into

account the flow involved; this is particularly important in configurations with many Fast360

appliances depending on the same AMC server.

Recommended configuration for an optimal protection against attacks of the

type logs saturation

To guarantee the maximum security in case of attacks by saturation of audit trails logs, we recommend

you to configure the Fast360 appliance as follows:

• activate the option allowing the blocking of non-administrative flows;

• set up the log policy to send logs to a syslog server.

16.6.4. Exporting Logs

Logs can be exported in two different formats:

• Text format

• WELF format (Webtrends Enhanced Log Format)
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You can use the logs in WELF format using the “Firewall Sequence” module of Webtrends, from version

5.0 and up.

Manual Export

You can export some of the logs manually using  Arkoon Monitoring  by opening the concerned log and

clicking the icon.

Note

It is recommended that you limit the quantity of stored logs to 1 Gb on the Fast360 appliance.

Beyond that, the client can face overload problems. To limit the quantity of stored log, set

automatic and regular exports and flushing of the logs in  Arkoon Manager . You can also limit

the logs to the “professional” flows.

16.6.5. Flushing the Database

There are several mechanisms to flush the database:

• Manual flush at startup of the Fast360 appliance.

• Manual flush via  Arkoon Monitoring

• Daily flushing and archiving

Manual Flush at Startup of the Fast360 Appliance

To flush the entire database at startup of the Fast360 appliance, hold down the Ctrl key until the following

menu is displayed:

┌──────────────────────────────────────────────────────────────────┐
│ GRUB version 0.93 (639K lower / 64512K upper memory)             │
│ ┌──────────────────────────────────────────────────────────────┐ │
│ │ arkoon                                                       │ │
│ │ arkoon flush_db                                              │ │
│ │ arkoon rescue                                                │ │
│ │ arkoon-undo                                                  │ │
│ │ arkoon init                                                  │ │
│ │ arkoon preinit                                               │ │
│ │ memtest                                                      │ │
│ │ arkoon delay_db                                              │ │
│ └──────────────────────────────────────────────────────────────┘ │
├──────────────────────────────────────────────────────────────────┤
│    Use the ^ and v keys to select which entry is highlighted.    │
│    Press enter to boot the selected OS, 'e' to edit the          │
│    command before booting, or 'c' for a command-line.            │
└──────────────────────────────────────────────────────────────────┘

Then, enter “arkoon flush_db”

Note

The keyboard is still in “qwerty” mode.
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Manual Flush Using  Arkoon Monitoring

Arkoon Monitoring  allows you to flush a log completely or partially by deleting the exported data.

To completely flush a log, open this log then click on the icon.

To flush the exported data, check the Delete exported data from the Fast360 appliance option.

1. To archive flushed data, check the Enable archiving of deleted logs option in the Storage folder of the

Alerts configuration form of the log policy being configured.

2. Select the export format from the Format drop-down list.

3. Enter the number of days the archived flushed data will be kept in  Arkoon Monitoring  in the Keep

logs in database for field.

4. To compress the archived data, check the Enable compression option. The archive can be accessed

from  Arkoon Monitoring  (General information window).

Daily Flushing and Archiving

In  Arkoon Manager , you can configure daily flushing and archiving of the database towards archive files

located on the Fast360 appliance. The logs' most recent entries remain accessible in  Arkoon Monitoring

. The default configuration does not activate archiving and defines the daily flushing of data older than

30 days.

The archived data is accessible via  Arkoon Monitoring , in the General information window. There is

one file per day. The window allows you to select and save the logs.

Note

It is recommended that you limit the quantity of stored logs to 1 Gb on the Fast360 appliance.

Beyond that, the client can face overload problems. To limit the quantity of stored logs, set

automatic and regular exports and flushing of the logs in  Arkoon Manager . You can also limit

the logs to the “professional” flows.

1. In the General configuration form of the Log Policy configuration tab:

a. Check the Block non-administrative flows in case of a log storage failure option to limit the logs

to “professional”, non-administrative flows to prevent overloading of stored logs.

Note

Alerts are implicitly generated to flag an overload of the /var partition or the logs queues.

These alerts, of a progressively low, intermediate or high level depending on the threshold

reached, allow you to act quickly to avoid losing security audit trails or blocking the traffic.

See Section 16.13, “Alerts” for more details.

b. In the Archiving frequency section, define at what time the alerts and the logs will be archived.

Two configuration modes are possible:

• Check the Daily at option and enter the values in the corresponding fields for the archive to start

every day at a specific hour. For example, every day at 4 AM.

• Check the Every option and enter the values in the corresponding fields to set the archive at a more

frequent interval. For example, every 6 hours and 35 minutes.

For more information on configuring IP, SMTP, and HTTP logs, see Section 16.6.7, “Configuring IP, SMTP

and HTTP Logs”; for IDPS logs, see Section 16.6.9, “Configuring IDPS Alerts”.
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16.6.6. Sending Alerts by Email or to an SNMP Server

Configuring alerts follows a similar procedure to configuring logs; however, the alerts viewed in  Arkoon

Monitoring  can be sent to a certain number of recipients by email or as SNMP traps to one or several

SNMP server(s).

1. In the Alerts configuration form of the log policy being configured, select whether to send the alerts

to the database or a syslog server following step 5 of the procedure outlined in the section called

“Storing Logs”.

2. If the Fast360 appliance is working in multi-appliances mode, check the To Master option and select

the logs to be sent to the AMC server.

Note

You can choose to select one, several or all the different types of logs but you should take into

account the flow involved; this is particularly important in configurations with many Fast360

appliances depending on the same AMC server.

3. To send alerts viewed in  Arkoon Monitoring  to a certain number of recipients by email, check the

To Email option.

a. Check the Handle slave alerts option to enable email recipients to receive alerts from "slaves" if

there is an AMC server.

b. To create a new recipient address in the Recipients table, right-click in the blank table, select New

> Email address. A new entry appears in the table.

c. To enter the recipient's address in the table, right-click in the Email address column, select Modify

Email address and enter the email address in the available field.

d. Define in minutes the minimum amount of time between two emails in the Minimum time interval

field.

e. You can configure the source email address of these emails in the Mail tab of the appliance Fast360

by checking the Local postmaster option.

Note

This source address will also be the one used by the SMTP proxy to send notification

messages such as detection of a virus or when an email is quarantined.

f. Select the alert levels you want to notify and enter the maximum duration (in minutes) before alerts

are submitted in the Information level fields. The alert level of the Information level fields are in

ascending order.

Note

We advise you to only notify the high level alerts and to regularly connect to the Fast360

appliance via  Arkoon Monitoring  to view the other alerts. This way, only information

essential for security is sent.

4. To send alerts viewed in  Arkoon Monitoring  as SNMP traps to one or several SNMP server(s), check

the To SNMP option.

a. To configure SNMP v3 traps sending (v3 is the recommended version of the SNMP protocol. Check

first the SNMP supervision console supports this version):

i. Select SNMP v3.

ii. Create one host or more representing the SNMP supervision console(s). To create an host, refer

to Section 5.1.2, “Creating a host”. For each host:
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A. In the Network tab, enter the IP address.

B. In the Services tab, check SNMP server and SNMP v3.

C. Enter the Engine ID of the corresponding SNMP supervision console. See the supervision

console(s) administrator to get this information and the following.

D. Enter the user name.

E. It is recommended to configure authentication and ciphering. To do so, check the Use

authentication and ciphering option:

I. Enter the authentication password and algorithm (SHA recommended).

II. Enter the privacy password and algorithm (AES recommended).

iii. Drag and drop the host(s) into the SNMP v3 Servers field in the Alerts tab of the log policy.

b. To configure SNMP v1 or v2 traps sending:

i. Select SNMP v2/v1.

ii. In the Community field, enter the category ID.

iii. Create one host or more representing the SNMP supervision console(s). To create an host, refer

to Section 5.1.2, “Creating a host”. For each host:

A. In the Network tab, enter the IP address.

B. In the Services tab, check SNMP server and SNMP v2/v1.

iv. Drag and drop the host(s) into the SNMP v1 Servers or SNMP v2 Servers field in the Alerts tab

of the log policy, according to the needed protocole and the configured services.

Note

You can find the Arkoon MIBs ARKOON-MIB-v1.txt and ARKOON-MIB-v2.txt required

for the configuration of your SNMP server in the /usr/share/snmp/mibs folder of the

Fast360 appliance.

Caution

Selecting destination hosts defines an implicit rule authorizing the Fast360 appliance

to send an SNMP flow to these servers. For more information on implicit rules, see

Section 8.4, “Implicit Filtering Rules”.

5. To define the frequency with which the data should be flushed, select the Storage folder, check the

Keep logs in database for option and then enter an appropriate value in the corresponding field.

6. To archive flushed data, check the Enable archiving of deleted logs option:

a. Select the export format from the Format drop-down list.

b. Enter the number of days the archived flushed data will be kept in  Arkoon Monitoring  in the Keep

for field.

c. To compress the archived data, check the Enable compression option. The archive can be

accessed from  Arkoon Monitoring  (General information window).
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16.6.7. Configuring IP, SMTP and HTTP Logs

Configuration of IP, SMTP and HTTP logs follows a similar procedure.

1. Select either the IP, SMTP or HTTP configuration form.

2. Select whether to send the logs to the database or a syslog server following step 5 of the procedure

outlined in the section called “Storing Logs”.

3. If the Fast360 appliance is working in multi-appliances mode, check the To Master option and select

the logs to be sent to the AMC server.

Note

You can choose to select one, several or all the different types of logs but you should take into

account the flow involved; this is particularly important in configurations with many Fast360

appliances depending on the same AMC server.

4. To define the frequency with which the data should be flushed, check the Purge option and then enter

an appropriate value in the Keep logs in database for field.

5. To archive flushed data, check the Enable archiving of deleted logs option:

a. Select the export format from the Format drop-down list.

b. Enter the number of days the archived flushed data will be kept in  Arkoon Monitoring  in the Keep

for field.

Note

If the Keep logs in database for field contains the value 0, only events starting after

midnight on the day of the purge are kept into the database.

c. To compress the archived data, check the enable compression option. The archive can be

accessed from  Arkoon Monitoring  (General information window).

d. For IP logs, it is possible to archive and compress the IP packets; to do this, check the Archive

logged IPpPackets and Compress archived packets options in the IP Logs folder.

16.6.8. Configuring System Logs

As system logs are not managed by a database, the same filtering and selection options available for the

other types of logs are not possible. Instead, the system logs are sent to a syslog server in an Arkoon

format compatible with WELF (Webtrends Enhanced Log Format).

1. Select the System configuration form.

2. Check the Issue the system logs with Syslog option and drag and drop the host object corresponding

to the syslog server into the Syslog servers field. For more information on configuring hosts.

Caution

Specifying syslog servers defines an implicit rule authorizing the Fast360 appliance to send a

UDP 514 syslog flow to the selected syslog server. For more information on implicit rules, see

Section 8.4, “Implicit Filtering Rules”.

3. Enter the suppression rate of system logs in the Suppression threshold field.
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16.6.9. Configuring IDPS Alerts

Intrusion Detection and Prevention System (IDPS) detects and neutralizes application layer attacks. For

more detailed information on the Fast360 appliance's IDPS, see Section 11.2.1, “Intrusion Detection and

Prevention”.

1. Select the IP configuration form.

2. To define the frequency with which the IDPS alerts should be flushed, check the IDPS Alerts option

and enter an appropriate value in the Keep logs in database for field.

3. To archive flushed IDPS alerts, check the Enable archiving of deleted logs option:

a. Select the export format from the Format drop-down list.

b. Enter the number of days the archived flushed data will be kept in  Arkoon Monitoring  in the Keep

for field.

c. To compress the archived data, check the Enable compression option. The archive can be

accessed from  Arkoon Monitoring  (General information window).

4. To define the frequency with which the IDPS alerts for matches (IDPS has detected an attack

signature) should be flushed, check the IDPS Matches option enter an appropriate value in the

corresponding field to the right.

5. To archive the flushed IDPS alerts for matches, check the corresponding Enable archiving of deleted

logs option:

a. Select the export format from the Format drop-down list.

b. Enter the number of days the archived flushed data will be kept in  Arkoon Monitoring  in the Keep

for field.

c. To compress the archived data, check the Enable compression option. The archive can be

accessed from  Arkoon Monitoring  (General information window).

16.7. SNMP Agent

16.7.1. Introduction

Fast360 appliances include an SNMP agent providing:

• industry-standard networking and system MIBs.

• support for the protocols:

• SNMP v3 enabling authentication and ciphering of the SNMP dialog.

• SNMP v2c and SNMP v1.

This allows Fast360 appliances to be monitored by most SNMP supervision consoles.

Note that the FAST SNMP module can be used to filter the Fast360 appliance's own SNMP traffic.
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16.7.2. Enabling the SNMP Agent

The SNMP agent does not run by default on the Fast360 appliance; you must explicitly enable it.

1. In the Audit configuration form of the Fast360 appliance, check the SNMP Agent folder. The

parameters to be configured are displayed on the right.

2. Choose the protocol version: SNMP v2/v1 or SNMP v3. If the supervision console supports SNMP v3,

it is recommended to use this protocol with authentication and ciphering for more security.

To configure the SNMP v3 protocol with authentication and ciphering:

a. Select SNMP v3.

b. Enter the user name.

c. Check Use authentication and ciphering.

d. Enter the authentication password and algorithm (SHA recommended).

e. Enter the ciphering password and algorithm (AES recommended).

To configure the SNMP v2/v1 protocol:

a. Select SNMP v2/v1.

b. Expand the SNMP Agent tree and select the MIBs folder. In the Community name field, enter the

name of the SNMP community. If this field is empty, the MIB will not be accessible. The name is

used by network management tools to communicate with the SNMP agent of the Fast360 appliance.

Note

The Community name field is not taken into account with the SNMP v3 protocol.

Note

In all cases, you must configure the same parameters on the SNMP supervision console.

3. If needed, fill the System identification fields: Name, Description, Contact and Location. These

fields correspond to the OIDs SNMPv2-MIB::sysName.0, SNMPv2-MIB::sysDescr.0, SNMPv2-

MIB::sysContact.0 and SNMPv2-MIB::sysLocation.0. For more information on MIBs, refer to Table 16.2,

“Supported MIBs”.

4. Expand the SNMP Agent tree and select the Listening Interfaces folder. Drag and drop the authorized

interfaces for the listening agent into the Interface field.

5. Select the MIBs folder and drag and drop the objects corresponding to the networks and hosts to be

authorized into the Authorized networks field.

Note

In High Availability configurations, the SNMP agent does not support the use of the virtual

IP address of a listening interface. SNMP network management platforms must use the

real IP address. This allows for non-ambiguous monitoring of both devices, active and/or

passive, making up the HA configuration. For more information about cluster configurations,

see Chapter 13, HA and HP Clustering.

6. To deactivate the access to some views, uncheck the appropriate options in Enable MIBs. The views

are described in Table 16.2, “Supported MIBs”.

7. In the Average Loads section, specify the load levels for the three periods: One minute, Five

minutes and Fifteen minutes. In each case, the OIDs UCD-SNMP-MIB::laErrorFlag[1], UCD-SNMP-

MIB::laErrorFlag[2] and UCDSNMP- MIB::laErrorFlag[3] switch to 1 if the average load level for the

given period is at, or above, the specified value.
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Note

The load levels default settings are high and are suitable for most systems.

Note

The SNMP agent on the Fast360 appliance is read-only; it only accepts GET and GET-NEXT

commands (so, for example, SET requests are rejected).

Table 16.2. Supported MIBs

View Reference OID Description

system RFC 1213 .1.3.6.1.2.1.1 Describes the system,

including hardware and

software types, where it

is located, the services

it provides, how long it

has been running, and

contact information for

the system manager.

ifaces RFC 1213

RFC 2863

.1.3.6.1.2.1.2

.1.3.6.1.2.1.31

A table containing

information on the

network interfaces.

The OID .1.3.6.1.2.1.31

includes information on

64-bit interfaces (RFC

2863) between other

things.

ips RFC 1213 .1.3.6.1.2.1.3 Contains information

relating to IP transfers,

including counters to

follow IP datagram

exchanges.

tcp RFC 1213 .1.3.6.1.2.1.6 Contains information

relating to TCP

connections, including

imposed limits and

connection status.

udp RFC 1213 .1.3.6.1.2.1.7 Contains information

relating to UDP transfers,

including counters to

follow UDP datagram

exchanges.

snmp RFC 1213 .1.3.6.1.2.1.11 Contains information and

statistics relating to

SNMP traffic.

mem UCD-SNMP-MIB .1.3.6.1.4.1.2021.4 Contains objects that

carry out memory usage

monitoring.

proc UCD-SNMP-MIB .1.3.6.1.4.1.2021.2 A table containing

information on running
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View Reference OID Description

programs/daemons

configured for

monitoring in the

snmpd.conf file of

the agent. Processes

violating the number

of running processes

required by the agent's

configuration file are

flagged with numerical

and textual errors.

disk UCD-SNMP-MIB .1.3.6.1.4.1.2021.9 Disk watching

information. Partions

to be watched are

configured in the

snmpd.conf file of the

agent.

load UCD-SNMP-MIB .1.3.6.1.4.1.2021.10 Average load

information.

sysstats UCD-SNMP-MIB .1.3.6.1.4.1.2021.11 Statistics relating to the

different parts of the

system, such as memory,

CPU usage and block

devices.

perf RFC 1514 .1.3.6.1.2.1.25.4

.1.3.6.1.2.1.25.5

Performance metrics for

each distinct piece of

software that is running

or loaded into physical

or virtual memory in

preparation for running.

This includes the host's

operating system, device

drivers and applications.

16.8. Reading the Logs

16.8.1. IP
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Introduction

Objective

This section introduces the IP log messages that flag problems. The information provided by  Arkoon

Monitoring  is located in the Reason and Description columns.

Format of this Section

This section lists, in alphabetical order, the statements that can appear in the Reason column and, for

each, provides the possible descriptions.

The situations in which these messages appear and/or the actions required to solve the problems are

described.

Message Description

LAND Attack

The blocked packet corresponds to a LAND attack: the source IP address is identical to the destination

IP address, and this is not one of Fast360's addresses.

Blocked by the Inter-application Control

The reason “Blocked by the inter-application control” means that the packet was blocked by a FAST

module. The Description column provides more details on the cause.

You will find below the list of the possible Description messages for the DNS, FTP, HTTP and SMTP

modules. In some cases, it is advisable to change the behavior of the FAST modules by re-configuring

their options (for instance, to accept a proprietary command).

FAST DNS module:

• Bad DNS packet: invalid packet

• Bad DNS Packet – too short (xx): packet too short

• DNS message too short (xx bytes): packet too short

• DNS packet denied by options: packet denied by the inter-application options

• DNS packet response without any query [id=xx]: answer without corresponding query

• DNS packet too long (xx bytes): packet too long, in the case of a UDP packet

• DNS packet too short (xx bytes): packet too short

• Decode_packet returned BAD Packet: invalid packet

• Decode_packet returned denied by options: packet denied by the inter-application options

• Wrong DNS packet [xxx]: state of the exchange invalid; this state is specified in brackets

FAST FTP module:

• (xx,xx,xx,xx,xx,xx) detected in yyy reply: information leak detected

• Can’t find command (x char): impossible to find the command
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• Can’t find end of command (\n): invalid command format

• Can’t find end of command (\r): invalid command format

• Command line too long (xx bytes / max: yy): authorized maximum size reached

• Command xxx forbidden: use of a forbidden command

• Garbage behind command xxx: no space or end of line after a command

• Invalid PASV dest IP: xx.xx.xx.xx): invalid IP address in the answer to the PASV command

• Invalid PASV dest port: xx: invalid port in the answer to the PASV command

• Invalid PASV reply: the answer to the PASV command has an invalid format

• Invalid PORT dest IP: xx.xx.xx.xx: Invalid IP address in the PORT command

• Invalid PORT dest port: xx: invalid port in the PORT command

• Invalid PORT param: invalid format of the PORT parameters

• Invalid command xxx: use of an unknown command

• No params allowed for cmd xxx: use of parameters for a command that does not accept any

parameters

• Params needed for cmd xxx: no parameter for a command requiring one

FAST HTTP module:

• Bad HTTP Version xxx: invalid HTTP version

• Bad Header xxx: wrong parameter in the header

• Client header forbidden by options: xx: forbidden parameter

• Client header line too long: at least xx bytes, max xx bytes: parameter size too long for the options

• Client header not allowed by options: xx: unauthorized parameter

• HTTP status-code too long: xx: invalid status

• Incomplete HTTP version: invalid HTTP version

• Invalid HTTP Server version: invalid HTTP version presented by the server

• Invalid method (invalid token): presence of forbidden characters in the method

• Method forbidden by options xxx: use of a method forbidden by the option methods_forbidden

• Method not allowed by options xxx: use of a method that is not authorized by the option methods_allow

• Method too long: method size too long

• Server header forbidden by options: xx: forbidden parameter

• Server header line too long: at least xx bytes, max xx bytes: size of the parameter too long for the

options

• Server header line too long: at least xx bytes, max xx bytes: unauthorized parameter

• URL too long (at least xx bytes, max=yy): URL size exceeds the limit maxsize_url

• Word (xxx) forbidden in URL: yyy: forbidden word in the URL

FAST SMTP module:

• Already got helo/ehlo: HELO/EHLO command resent

• Can’t find end of command (\n): invalid command format
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• Can’t find end of command (\r): invalid command format

• Client has not said hello: begins sending an email without having used HELO/EHLO

• Command TURN forbidden: use of the TURN command

• Command line too long (xx bytes / max: yy): authorized maximum size reached

• Command xxx forbidden: use of a forbidden command

• Forward path invalid: invalid recipient

• Garbage behind command xxx: no space or end of line after a command

• Got no MAIL FROM: email sent without transmitter

• Got no RCPT TO: email sent without recipient

• I was waiting for a reply number: xyz: answer has invalid format

• Invalid command xxx: use of an unknown command

• No params allowed for cmd xxx: use of parameters for a command that does not accept any

• Params needed for cmd xxx: no parameter for a command requiring one

• Reply too short: invalid format of the answer

• Reverse path invalid: invalid transmitter

Blocked by the Filter

If no message appears in the Description column, this means that the packet has been blocked by a

filtering rule or the ICMP policy. If the packet is blocked or rejected by a filtering rule, you see the name of

this rule in the Name column. The possible messages shown in the Description column are listed below.

Dst addr received from Internet is private

The specific packet is intended for a private address different from the Fast360's, and the option Deny

private addresses was activated on the Internet access through which the packet arrives.

Dst addr to be sent to Internet is private

The packet has a private destination address which is different from that of the Fast360 and its gateway.

The packet must go out via an Internet access on which the option Deny private addresses is activated.

ICMP not related to any connection

This is an ICMP error message that could not be related to a connection.

IP options not allowed in config

This message means that the packet has IP options but the Fast360 has been configured to block and

log packets with IP options.

Please note that the default behavior of the Fast360 removes the IP options. This operating mode can

be modified via the pseudo-file /proc/sys/arkoon/drop_ip_options. The possible values are the

following:

• DROP_FLAG_NO (0): no action is taken on a packet with IP options;

• DROP_FLAG_RAZ (1): if the packet has IP options, they are removed (default value);
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• DROP_FLAG_YES (2): if the packet has IP options, it is blocked and logged.

Null SPI

The Fast360 blocks the ESP and AH packets having a null SPI field (Security Parameter Index). These

packets do not correspond to a “normal” flow.

Packet outside allowed time frame

The specific packet is related to a connection with a time limitation. The date and time of the packet are

not included in the authorized time frame.

Src addr received from Internet is private

The packet has a private source address and is intended for a private address different from that of the

Fast360, but the option Deny private addresses has been activated on the Internet access through

which the packet arrives.

Src addr to be sent to Internet is private

The packet has a private source address, is not masked with the Fast360's address and must go out via

an Internet access on which the option "Deny private addresses" has been activated.

Wrong Flags

This message appears when the TCP flags do not correspond to the current state of the active

connection.

Wrong Packet

The possible messages shown in the Description column are listed below.

Bad IP options

This message appears when the packet contains IP options with invalid values. The Fast360 checks the

validity of the size and parameters, depending on the option.

Bad TCP flags:

This message appears if the behavior of the Fast360 was modified in relation to the ECE and CRW flags.

The flags used to manage the ECN (Explicit Congestion Notification), namely ECE and CRW, are deleted.

This operating mode can be modified via the pseudo-file /proc/sys/arkoon/drop_tcp_ecncrw. The

possible values are the following:

• DROP_FLAG_NO (0): no action is taken;

• DROP_FLAG_RAZ (1): if the packet contains the ECE or CRW flags, they are removed (default value);

• DROP_FLAG_YES (2): if the packet contains the ECE or CRW flags, it is blocked and logged.

Bad TCP flags: Null TCP packet

The Fast360 blocks packets with no flag.

Bad TCP flags: Reserved flags set

The Fast360 blocks packets in which the Reserved field is used.
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Bad TCP flags: Xmas packet

The Fast360 blocks packets containing the URG, PSH and END flags.

Bad TCP header: Offset too high

This message means that the value of the data offset field is greater than the size of the TCP header.

Bad TCP header: Stealth FIN

The Fast360 blocks packets having an END flag but no ACK flag.

No connection found for TCP packet

The packet could not be related to an active TCP connection.

Undersized packet

The packet was blocked because the size of the IP packet data is less than the size of the header of the

level-4 encapsulated protocol (20 bytes for TCP, 8 bytes for ICMP, etc.).

Wrong License

The possible messages shown in the Description column are listed below.

No license

The Fast360's license is invalid and blocks the packet. In this case, please note that the Fast360 does not

block the following flows, nevertheless:

• flows intended for the Fast360

• SNMP traps emitted by the Fast360

• connections initiated by the Fast360 for an ADSL PPTP connection, a multi-appliances connection or

a high-availability connection.

Too many IPs used

The number of IP addresses protected by the Fast360 exceeds the number of addresses authorized by

the license. Please note that the packets are accepted. You can view the IP addresses protected by the

Fast360, as well as the associated timeout, in the List of the IP addresses tab of the General Infos window.

Maximum Number of Pending Connections Reached

The packet is related to a rule on which the maximum number of pending TCP connections has been

configured. The number of pending TCP connections related to this rule has already been reached.

• To change the maximum number of pending TCP connections, please refer to Section 8.3, “Creating

a New Filtering Rule”.

Maximum Number of Established Connections Reached

The packet is related to a rule on which the maximum number of established connections has been

configured. The number of established connections related to this rule has already been reached.
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• To change the maximum number of established connections, please refer to Section 8.3, “Creating a

New Filtering Rule”.

Unsequenced Packet

The sequence number of the packet is invalid: it is not between the last acknowledged sequence number

and this value increased by the size of the TCP window.

• Check the TCP Seq, NoSeq attendu (NoSeq awaited) and Fenêtre Src (Src window) columns of the IP

logs of  Arkoon Monitoring  for more details on this problem.

Unsequenced ACK Packet

The acknowledgement number of the packet is invalid: it is not between the last acknowledged sequence

number and the next awaited sequence number.

• Check the TCP Ack, NoAck attendu (NoSeq awaited) and NoSeq columns of the IP logs of  Arkoon

Monitoring  for more details on this problem.

Encryption Problem for the Destination

The possible messages shown in the Description column are listed below.

No ipsec route available

There is no tunnel which allows the encryption of this packet.

• Check the configuration of the VPN with  Arkoon Manager .

No tunnel available

There is no mounted tunnel with characteristics that allow the encryption of this packet.

• In the VPN tunnels window of  Arkoon Monitoring , make sure that there is a tunnel with a topology

that corresponds to this packet and that it is correctly mounted.

Tunnel not in allowed list

There is a tunnel with characteristics that correspond to the received packet, but the filtering rule

accepting the packet does not authorize the use of this tunnel.

• Review the Encryption tab of the filtering rule accepting the packet. The selected group of tunnels is

probably not the correct one.

Encryption Problem for the Source

The possible messages shown in the Description column are listed below. All these messages are related

to packets that are associated with an active connection but do not have encryption corresponding to that

of the active connection. Please note that these messages do not appear in case of a new connection:

if the encryption of the packet does not correspond to that of the filtering rule, the rule is not applied and

rules monitoring continues.
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Should be encrypted

The received packet is not encrypted but is related to an active connection that includes encryption.

Should not be encrypted

The received packet is encrypted but is related to an active connection without encryption.

Wrong encryption

The encryption of the received packet does not correspond to that of the active connection to which it

is related.

16.8.2. IDPS

Use of Services in the Filtering Rules

The last stage of the IDPS configuration is the implementation of filtering rules using the services

embedded with applicative profiles.

Visible IDPS Information Types in  Arkoon Monitoring

Alerts Window

An IDPS type alert (high level) is generated as soon as the alert's threshold is reached when "Warn only"

mode is not configured.

IP Logs Window

The IP logs window displays the following information: applicative profile's name, profile's description,

IDPS score.

You can view the IDPS activity by activating the IDPS only option. This displays only the connections

with a non-nil score and the ones towards a compromised.

The connections in bold have a non-nil score. An IDPS match is always displayed in bold. If the match's

score is not enough, the line is displayed in green (since the session is not down as long as the threshold

is not exceeded).

As soon as the alert threshold is exceeded, the connection is down (a line in red shows that the

connection is stopped).

Note

In the case of an attacked connection the following is displayed: a first line in green and bold

(showing that the active connection has encountered a signature) and an identical second line

in red and bold (showing that the match released the active response).

Right-clicking a connection in bold lists the associated matches with the details of the corresponding

signatures (see the section called “Detail of IDPS Alerts”).

Note

The IDPS score and the associated matches are displayed in the IP logs window only when the

connection is down.
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IDPS Logs Window

Note

This window only lists the connections which are down because of the IDPS. This window allows

you to follow the IDPS activity in "Active response" mode.

Each time a connection is down, you know its main characteristics: source and destination IP addresses,

source and destination ports. Double-click the line to view the matches associated with the connection

as well as the detail of the corresponding signatures (see the section called “Detail of IDPS Alerts”).

IDPS logs toward compromised hosts are displayed in purple.

Active Connections Window

The Active connections window lists the current IDPS score of the connections, as well as the name

and the description of the associated applicative profile. The connections with a non-nil IDPS score are

displayed in red.

Detail of IDPS Alerts

Double-clicking an IDPS alert (red or purple line in the IDPS logs window) displays a window detailing

its characteristics and particularly its associated matches.

The first section of the detail window contains a description of the alert in which the connection final

score is displayed among others.

Note

In the case of a compromised host, the connection end's score makes the initial score (bonus)

appear in parenthesis. For example, a 40 initial level compromised host for which the connection

is down because of a match on a signature of 50 score will have a 90 final score displayed as

follows: 50 (+40).

The following sections describe the matches associated with the alert. The source and the destination,

the time and the date of the match are indicated as well as the detail of the detected signature.

Note

In an IDPS alerts detail window, the connection's source and destination are distinguished from

the match's source and destination. Actually, a connection can be initiated by a host, then victim

of an attack from the server to which it connects. In this case, the attacked host is the source

of the connection and the destination of the match.

List of Compromised Hosts Diagnostic

This diagnostic lists the compromised hosts, as well as the last connection during which they have this

status.
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IDPS Alert Release

Visualization of IDPS Matches

The detail of the IDPS matches can be viewed in the IDPS logs window. See the section called “Detail

of IDPS Alerts” for more details.

Submit of IDPS Alerts

An IDPS alert is a high level alert. Like other high level alerts, it can be sent to mail addresses configured

in  Arkoon Manager  or it can be submitted as SNMP trap to the configured SNMP server.

For more details, see Section 16.6, “Managing Logs and Alerts”.

In Case of Compromised Host

As soon as an IDPS alert is generated, the destination server of the connection is considered

compromised host.

The IP address of the compromised host is listed in the title of the high level alert. You can then check

the IDPS alerts window for the matches corresponding to the attack.

You can then identify the traffic to this host since the IDPS logs to the compromised hosts appear in purple.

In 'Warn only' Mode

When the "Warn only" mode is configured, no IDPS alert is generated (no trace in the IDPS logs window).

No information is sent by mail or by SNMP trap.

Nevertheless, you can follow up the IDPS activity as described below:

• In the IP logs, view the IDPS score associated with the connection; you can filter them by activating

the IDPS only option; the associated matches can be viewed by right-clicking the line;

• In the active connections window, the lines with a non-nil IDPS score appear in red.

16.8.3. VPN

VPN Tunnels

This window lists the VPN tunnels defined on the Fast360 with their characteristics (topology, algorithms,

etc…) and their status (DOWN, UP, TRYING). It also allows to make a VPN tunnel down, as well as restarting

its negotiation.
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IP Logs

When a flow is encrypted, the interface receiving the flow is named [name of the interface]/ipsec,

like eth0/ipsec for the eth0 interface.

System Logs

The system logs allow you to view the messages emitted by the 'pluto' daemon at the moment of the

VPN negotiation. Arkoon support website (https://support-https.arkoon.net/index.php?lang=en) the most

common error messages.

Alerts

The alerts of IKE type allow you to view the events relative to the establishing of a tunnel. The low level

IKE alert indicates that a VPN is established; the Description column shows the IP address of the remote

VPN server as well as the name given to the VPN tunnels group in the configuration of the Fast360.

16.8.4. DNSBL

If the mail was processed by an anti-relaying rule including the use of the DNSBLs, and if the address is

blacklisted, the result appears in the Raison (Reason) field of the SMTP logs.

The line is red and the result is Relaying denied if the score obtained is superior or equal to the

configured threshold.

The line is blue and the result is Received OK if the score obtained is inferior to the configured threshold.

This allows you to watch the operation of the DNSBLs and to adjust the configuration if needed.

16.9. Arkoon Manager Error Messages

The error messages generated by Arkoon Manager can be of three different types:

• Information messages: a simple informational message that does not involve security or require

corrective action.

• Warnings: an indication that signals a potential problem to the Administrator.

• Errors: a serious problem that prevents the configuration from being deployed successfully on the

appliance.

https://support-https.arkoon.net/index.php?lang=en
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16.9.1. Information Messages

"Connection warning"
"Read only authorized connection"

This message appears when another administration session is already active on the appliance.

Therefore, only read-only operations are authorized to avoid administration conflicts.

• If you need write access, check who is currently connected to the appliance and determine with that

person which administration task should take place first.

"Upload successful"
"The configuration '�s' has been correctly uploaded"

This message indicates the successful completion of a configuration transfer from  Arkoon Manager  to

a connected appliance.

"Action interrupted"
"Action interrupted by user"

This message indicates that an action was interrupted upon administrator request.

"Action successful"
"The configuration '�s' has been correctly applied"

This message indicates the successful completion of a configuration installation.

"Download successful"
"The configuration '�s' has been correctly downloaded"

This message indicates the successful download of a configuration from a connected appliance to

Arkoon Manager .

"Hardware synchronization"
"Configuration has been synchronized with hardware"

This message indicates the successful synchronization of remote hardware configuration into the

currently opened security policy in  Arkoon Manager .

"Information"
"You are now disconnected"

This message indicates the end of a connected session between  Arkoon Manager  and an appliance.

"License"
"The new license has been installed"

This message indicates the successful completion of a license installation.

"License"
"License request has been done"

This message indicates the successful completion of a license request.

"Information"
"Certificates Revocation List has been sent"

This message indicates the successful completion of the CRL distribution.

"Information"
"Snapshot report has been done"

This message indicates the successful completion of a Snapshot report request.

"Information"
"Config card has been done"
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This message indicates the successful completion of a configuration card backup request.

"Coherency OK"
"The configuration is coherent and can be deployed"

This message indicates the successful completion of a configuration coherency check. The configuration

is ready to be applied on the appliances.

"Information"
"Closing this window will close all child windows"

This message indicates to the administrator that the window about to be closed has one or more children

windows open. For instance, the administrator closes a Fast360 item window while there is still a HTTP

rule item open.

• Click Cancel to keep the window and all its children open or click Close and Continue to close all the

concerned windows.

16.9.2. Warning Messages

"Confirmation"
"This file already exist: �s. Do you really want to overwrite it?"

This message indicates that the administrator is trying to save a configuration and that this operation

will overwrite an existing file.

• Check whether you want to overwrite the existing file. Click Cancel to choose another file destination.

"Delete �s"
“You can’t delete �s. The following items are still referencing it:”

To be deleted from a configuration, an item must have no other item still referencing it. In other words,

it must not be used anywhere in the configuration.

• Use the provided list of referencing items to inspect them and remove any dependency with the item

to be removed.

"Delete �s"
"You're trying to delete this item(s) while editing it(them):"

This message indicates that the administrator is trying to delete an item from the configuration while an

edit window is still open for this item.

• Click Cancel if you want to resume editing the open item or click Close and Continue to close the open

item and delete it.

"Warning"
"You are about to download a configuration that is in old version. 
Do you want to convert this file to the current application version?" 

This message indicates the downloaded configuration must be converted to be processed by the current

Arkoon Manager  version.

• Click Cancel if you want the configuration to be converted.

"Undo/redo conflict"
"You are trying to undo the creation of ‘�s’ while editing it" 

Some undo/redo operations may conflict with currently opened items. For example, an undo/redo

operation cancels the creation of a Fast360 object while the object is open for edition.
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• Click Cancel if you do not want to close the open object, or click Continue to close the open object

and perform the undo/redo operation.

"Confirmation"
"The document '�s' is not saved! Close document and lose your 
modifications?" 

This message indicates the administrator is closing an unsaved configuration.

• Click Cancel to keep the document opened, or click Continue to close the document and lose

modifications.

16.9.3. Error Messages

"File error"
"This file cannot be saved �s"

This message indicates an error has occurred while saving a configuration file. This can be caused by

a hardware problem, missing disk space, etc.

• Check the destination disk or try to save to another location.

"Fail to process coherency checks"
"A critical exception occurs during coherency checks."

A software error occurred while checking the configuration coherency.

• Please provide Arkoon Support with a report of the failure and, if possible, the faulty configuration.

"Error"
"Can't get users list"

This message indicates a list of users could not be retrieved from an authentication server.

• Check the authentication server definition in the configuration.

• Check that the authentication server has been correctly associated to the appliance you are

connected to.

• Check that the configuration with the authentication server has been applied so that implicit rules

authorizing connections between the appliance and the authentication server are properly activated.

"Authentication failed"
"The CA password you provided is not correct"

This message indicates that the administrator entered an incorrect password to access the Certificate

Authority.

• Enter the correct password.

"Certificate creation failed"
"The certificate's password you provided is too simple"

This message indicates that the administrator did not follow the Password Security Policy while creating

a new certificate.

• Please refer to the Password Security Policy presented in the First-Time Configuration guide.

"Signature request failed"
"The signature request file you provided has been refused by the CA"
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This message indicates the Certificate Authority encountered a problem while handling a certificate

signature request.

• Check the request parameters or provide a new request.

"Signature request failed"
"The signature request file you provided cannot be read."

This message indicates that  Arkoon Manager  encountered a problem while loading a certificate signing

request.

• Check the provided file name and location.

"Certificate error"
"This certificate cannot be imported: �s"

This message indicates that  Arkoon Manager  encountered a problem while importing a certificate.

• Check the provided file name and location for the certificate.

"File error"
"This file cannot be read: �s"

This message indicates that  Arkoon Manager  encountered a problem while loading a file.

• Check the provided file name and location.

"Error"
"Can't launch Arkoon Monitoring tool"

This message indicates  Arkoon Manager  encountered a problem while launching  Arkoon Monitoring .

• Check  Arkoon Monitoring  path and connection parameters.

"Upload error"
"The configuration '�s' was NOT uploaded"

This message indicates  Arkoon Manager  encountered a problem while uploading a configuration from

the connected appliance.

• Check  Arkoon Manager  is correctly connected to the appliance.

"Connection error"
"You are NOT currently connected"

This message indicates  Arkoon Manager  encountered a connection problem.

• Check the session parameters

• Check all network cables are properly plugged

• Check the appliance is reachable

"Apply error"
"The configuration '�s' was NOT applied"

This message indicates  Arkoon Manager  encountered a problem while applying a configuration. Lack

of disk space and undetected local coherency error are potential causes of such problem.

• Check there is sufficient free disk space available on the connected appliance.

• Check the console logs for detailed error descriptions.

"Document corrupted"
"The access control document '�s' is broken. Please Reset this file 
from Minarkconf using the Access Control Menu."
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This message indicates  Arkoon Manager  encountered a problem while loading an Access Control policy

configuration.

• Check for other corruption errors indicating a potential hardware problem on the appliance.

• Please provide Arkoon Support with a report of the failure and, if possible, the faulty configuration.

• Load instead a backup configuration or reset the current one as documented in the First-Time

Configuration guide.

"Document corrupted"
"The access control document '�s' is broken. Please load on another 
backup file or create a new one."

This message indicates  Arkoon Manager  encountered a problem while loading a Security Policy

configuration.

• Check for other corruption errors indicating a potential hardware problem on the appliance.

• Please provide Arkoon Support with a report of the failure and, if possible, the faulty configuration.

• Load instead a backup configuration or create a new one using  Arkoon Manager .

"Download failed"
"The configuration '�s' could not be downloaded"

This message indicates  Arkoon Manager  encountered a problem while downloading a configuration.

• Check network connectivity between the administration station and the appliance.

"Error"
"Cannot load file �s"

This message indicates  Arkoon Manager  encountered a problem while loading a configuration stored

locally on the administration station.

• Check the provided file name and location.

• Check that the provided file is a Fast360 appliance configuration.

"Error"
"Can't decrypt file �s. Check password."

This message indicates  Arkoon Manager  encountered a problem while loading an encrypted file stored

locally on the administration station.

• Check the provided file name and location.

• Check that the provided file is a Fast360 appliance configuration.

• Check the password you provided to  Arkoon Manager  to load the encrypted configuration.

"File Error"
"Can't read file license."

This message indicates  Arkoon Manager  encountered a problem while loading a license file provided

by the administrator.

• Check the provided file name and location.

"Error"
"The license installation has failed."

This message indicates that a license installation failed.
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• Check the console window for further information.

• Check the license is properly defined for the target appliance.

"Error"
"Could not save the CRL file"

This message indicates that  Arkoon Manager  encountered a problem while saving the CRL on the

administration station.

• Check sufficient free disk space is available on the administration station.

• Try to save the CRL to another location.

"Error"
"Could not get the Certificate Revocation List file"

This message indicates that  Arkoon Manager  encountered a problem while downloading the CRL from

the appliance’s certificate authority.

• Check the appliance’s certificate authority is properly configured using  minarkconf .

"Error"
"Could not read PEM file"

This message indicates that  Arkoon Manager  failed to read and open a PEM file.

• Check the PEM file is not corrupted.

"Error"
"Can't send Certificates Revocation List"

This message indicates that  Arkoon Manager  failed to distribute the CRL.

• Check the console window for further information about the failure.

• Check sufficient free disk space is available on the concerned appliance and the administration

station.

"Error"
"Support snapshot has failed"

This message indicates that  Arkoon Manager  could not complete a Support Snapshot request.

• Check the console window for further information about the failure.

• Check sufficient free disk space is available on the concerned appliance and the administration

station.

"Error"
"Configuration card backup has failed"

This message indicates that  Arkoon Manager  could not complete a configuration card backup request.

• Check the console window for further information about the failure.

• Check sufficient free disk space is available on the concerned appliance and the administration

station.

"Coherency error"
"The configuration is NOT coherent."

This message indicates that  Arkoon Manager  detected some coherency errors in the current

configuration.
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• Use the Coherency Check window to fix remaining errors in the configuration.

"Build error"
"The configuration has errors, please fix them before deployment."

This message indicates that  Arkoon Manager  detected some configuration coherency errors while

preparing the configuration for deployment.

• Use the Coherency Check window to fix remaining errors in the configuration.

"Access control error"
"You currently have no administration rights. Please, make sure your 
X.509 certificate has roles associated to it in the Access Control 
database."

This message indicates that the Access Control server could not find any administration right associated

to the X.509 certificate you provided to authenticate with the remote appliance.

• Check, or have a Security Officer check the rights defined for you as a Fast360 appliance administrator

in the Access Control database.

"Access Control Error"
"Arkoon Manager could not retrieve your administrator rights from the 
server."

This message indicates  Arkoon Manager  encountered a problem while checking your administrator

rights with the server.

• Check, or have a Security Officer check that your administrator rights are properly defined in the

Access Control database.

• Check that the Access Control server is running on the remote appliance or  AMC  platform.

"Error"
"Communication initialization failure. Please check connection 
parameters"

This message indicates  Arkoon Manager  encountered a problem while initializing communication with

a remote appliance.

• Check network connectivity.

• Check connection parameters in the Session object used to initialize communication.

16.10. Arkoon Authentication Error Messages

16.10.1. Introduction

Objective

This section introduces the messages that can appear in a pop-up window in  Arkoon Authentication .

Format of this Section

This section lists the messages in alphabetical order. Messages that can appear during connection to the

Fast360 appliance are described in detail in Section 16.11, “Error Messages During Connection” because
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they are common to  Arkoon Manager ,  Arkoon Monitoring , and  Arkoon Authentication . For each, the

meaning of the message, the conditions in which it appears, and the action to be taken in order to solve

the problem are listed.

16.10.2. Message Description

An error occurred during data submit to the Arkoon; 'sslcom_error'

This type of message is detailed in Section 16.11, “Error Messages During Connection”.

An error occurred during the data receipt from Arkoon: 'sslcom_error'

This type of message is detailed in Section 16.11, “Error Messages During Connection”.

Authentication failure

The authentication parameters sent to the Fast360  appliance do not correspond to a user known by the

Fast360 appliance.

• Check the parameters set in  Arkoon Authentication  and the user definition.

Impossible to connect to the Arkoon: 'sslcom_error'

This type of message is detailed in Section 16.11, “Error Messages During Connection”.

No CA certificate configured

The selected authentication mode is "Login/password authentication" or "PKCS#11 authentication

(Token)" but the CA certificate is not configured.

• Import the CA certificate or select another authentication mode.

No certificate usable on Token

The PKCS#11 certificate authentication mode has been chosen but there is no certificate available on

the token.

• Check that the certificate is present on the token or select another authentication mode.

No user certificate configured

The PKCS#12 certificate authentication mode has been selected but no user certificate is configured.

• Import the user certificate or selects another authentication mode.
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16.11. Error Messages During Connection

16.11.1. Introduction

Objective

This section introduces the error messages that can appear while connecting to  Arkoon Monitoring .

Format of this Section

This section lists the messages in alphabetical order.

For each, the meaning of the message, the conditions in which it appears and the action to be taken in

order to solve the problem, is described.

Indications

In this section, you will be instructed to create a new administration certificate. To achieve this, you

will have to use the  minarkconf  program. For more information on the use of this program, refer to the

Commissioning Guide.

Also, you could be recommended to consult the Fast360's system logs to get more information. In these

cases, the problem is related to the SSL communication: if you do not have a screen and a keyboard

available on the Fast360, it is possible for you to connect in SSH. To view the system logs, you must login

and enter the following command: tail –f /var/log/messages.

16.11.2. Message Description

Can’t open PKCS#12 file ‘xxx’

The .p12 file could not be open.

• It is possible that the .p12 file was damaged. Retrieve it again. Otherwise, generate an administration

certificate using the  minarkconf  program.

Certificate refused: bad certificate

This message usually indicates that the administration certificate is not valid yet. In the Fast360

appliance's system logs, you must view the Verification failed: certificate is not yet valid

message.

• Check the Fast360 appliance's date. If needed, generate a new certificate with the help of the

minarkconf  program.

Certificate refused: bad permissions

The PKCS#12 certificate does not have the adequate rights: to connect to the Fast360 appliance, you must

have a certificate with ADMIN rights. You can view the rights of the certificate that you use in the lower

part of the connection window.

• Generate a new administration certificate using the  minarkconf  program.
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Certificate refused: certificate has expired

The administration certificate that you use has expired.

• Generate a new certificate using the  minarkconf  program.

Certificate refused: certificate has been revoked

The administration certificate that you use has been revoked.

• Generate a new certificate using the  minarkconf  menu.

Connection aborted

The connection initialization could not be done.

• Try to connect again. In case of failure, consult the system logs for more information.

Connection refused (‘xxx :yyy’)

The port ‘yyy’ of the machine ‘xxx’ is not open. This machine cannot be the Fast360 appliance: the Fast360

appliance does not deny the connection if its port is not open, it does not answer and then you get this

message: Connection timed out.

• Make sure that you have specified the correct IP address.

Connection timed out

The connection is timed out; the remote host does not answer.

• Make sure that you have specified the correct IP address.

• Make sure that the Admin from parameter of  minarkconf  is correct, i.e. that the authorized IP

addresses are correct and the 1750 and 1751 ports are authorized (for  Arkoon Manager  and  Arkoon

Monitoring  respectively).

Host ‘xxx’ unreachable

The Fast360 appliance is not reachable for routing reasons.

• Make sure that your administrator's workstation disposes of the required routes to reach the IP

address that you have specified.

• Make sure that the network connection of your station is correct and that the Fast360 appliance's

specific interface is correctly mounted.

Host not found ‘xxx’

The name resolution is impossible for the name that you have entered in the IP address field.

• Check the name that you have entered or specify the Fast360 appliance's IP address.

Invalid PKCS#12 file ‘xxx’

The PKCS#12 certificate that is specified is incorrect.

• It is possible that the .p12 file was damaged. Retrieve it again. Otherwise, generate an administration

certificate again on the Fast360 appliance's CA.

Verification failed: peer CA is not trusted
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This message indicates that the CA that transmitted the administration certificate is not the same as the

one that emitted the Fast360 appliance's certificate.

• Use an administration certificate that was emitted by the same CA as the Fast360 appliance.

Wrong password for PKCS#12 file ‘xxx’

The password that you have entered is incorrect. Re-enter the certificate password.

16.12. Coherency Check

16.12.1. Introduction

Objective

This section presents messages that are generated while checking the coherency of the configuration.

These messages can be seen in the three following cases:

• You launch the coherency check from  Arkoon Manager .

• You launch the deployment of the configuration from  Arkoon Manager  and a coherency check is

automatically launched.

• You launch the configuration deployment from  minarkconf  (Load a configuration file menu).

Purpose of the Coherency Check

The coherency check detects most cases where:

• An object is referenced by another but has not been defined.

• A field contains an incorrect or unacceptable value.

• A functionality is defined in an incomplete or contradictory way.

• The Fast360 appliance's routing and addressing does not allow it to reach all the referenced objects.

It does not detect:

• Problems with the order of rules, including filtering rules, anti-relaying rules, applicative rules, QoS

rules.

• General problems of addressing and routing logic.

Message Types

The generated messages can be of three different types:

• Errors: a serious problem that prevents the configuration from being deployed successfully on the

appliance.

• Warnings: an indication that signals a potential problem to the Administrator.

• Information messages: a simple informational message that does not involve security or require

corrective action.
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Note

Only error messages prevent the successful deployment of the configuration.

Format of the Messages

The coherency check presents the messages in the following format:

• In the Coherency check window of  Arkoon Manager .

• In the Coherency check window of  Arkoon Manager  when you attempt to deploy a configuration

without checking its coherency first.

• In  minarkconf :

WAR-000000004118 <arkoon:Arkoon update>
* You provided an internet name for the update server.
* Please provide its IP address instead, or configure at least one DNS 
Server.

Each message contains:

• An unique identifier: three letters (INF, WAR or ERR) followed by 10 digits.

• The name of the object to which the message applies; if this is an object belonging to a Fast360

appliance (for instance, its Internet access), the specific Fast360 appliance is specified.

• A short description of the message.

• A longer description, in some cases, which usually indicates how to solve the problem.

Format of this Section

This section introduces all the non-obsolete messages, classified by type and number. Each message is

listed with an explanation of its meaning as well as the action to ensure that it is not generated again.

The description of the action does not give the steps to be executed in detail.

The icon indicates that the error does not occur if the configurations management has always been done

with  Arkoon Manager  or  minarkconf . If you did not respect Fast360 appliance's normal configuration,

you should reload a valid configuration. Otherwise, please contact Arkoon support.

In case of errors followed by this icon, no other specific action is recommended.

The characters 'xxx', 'yyy' and 'zzz' designate a variable specific to the message's context.

16.12.2. Error Messages

ERR-0000000000
Unknown errror’

ERR-0000000001
Error: �s

This error occurs in specific and punctual cases. The statement ‘%s’ clearly explains the nature of the

problem.

ERR-0000000002
Cannot open the file 'xxx' (yyy)

The gencfg program cannot open the file 'xxx' with the access rights 'yyy' to achieve its task. It can be

a disk problem (full disk or damaged sectors).
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• In  Arkoon Monitoring , check the occupation of the disk with the State of the Fast360 appliance

window.

• Look in the system logs if there are error messages about the disk.

• Otherwise, contact Arkoon support.

ERR-0000000003
Cannot find the host '�s' (or it hasn't got any IP address)

The host '%s' is referenced but is not declared as a host in the configuration.

ERR-0000000004
'�s' needs at least one DNS server to activate the proxy

No DNS server is configured on an appliance which has its HTTP proxy or SMTP proxy activated.

ERR-0000000005
You can't activate both 'Correct file' and 'Remove file"

ERR-0000000006
The object '�s' is not unique

Two objects share the same name in the configuration.

ERR-0000000007
Object '�1$s' is implicitly used but not allowed in a list of networks
or hosts.

ERR-0000000008
Invalid value '�s'='�d'

ERR-0000000009
Invalid value '�s'='�s'

ERR-0000000010
Invalid values for processes: �d,�d,�d,�d

There are inconsistencies in the configuration related to the minimum number of pending processes,

the default number, the maximum number pending, and the maximum number of processes of the HTTP

proxy. Indeed, the minimum number of pending processes must be less than or equal to the number of

processes at the beginning, this value must be in turn inferior or equal to the maximum number of pending

processes, and this value must be in turn less than or equal to the maximum number of processes.

• Edit the properties of the HTTP proxy and change the values related to the number of processes.

ERR-0000000011
Cannot find interface '�s'

The interface '%s' is referenced but is not declared as an interface in the configuration.

ERR-0000000012
Interface '�1$s' is not enabled.

The interface '%s' is referenced but not enabled in the configuration.

ERR-0000000013
Interface '�s' has no IP address

An interface with a permanent IP address does not have a configured IP address.

ERR-0000000014
Can't find user '�s'

The user '%s' is referenced but is not declared as a user in the configuration file.

• Review the definition of the user ‘%s’.
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ERR-0000000015
Cannot find the schedule '�s'

The schedule '%s' is referenced but is not declared as a schedule in the configuration.

ERR-0000000016
Time '�s' is invalid (reason)

The schedule '%s' contains invalid days or time intervals.

ERR-0000000017
Group '�s' is not a valid type (type)

An object references a group '%s' that is not of the correct type (Hosts/Networks/Appliances, Users,

Services, etc.).

• Review the definition of the group ‘%s’.

ERR-0000000018
Cannot find any preshared key in '�s'

No shared key was configured for a VPN with a shared key.

• Define a shared key and select the hosts that can use it.

ERR-0000000019
Cannot find host or appliance '�s'

An object references a host or an appliance '%s' that is not declared in the configuration.

ERR-0000000020
Can't find  host/network/appliance/user '�s'

An object references host '%s', network, Fast360 appliance or user that is not declared in the

configuration.

ERR-0000000021
Network '�s' has no VPN gateway

A network is used to define a VPN tunnel, but no VPN gateway is defined for this network.

• Define the VPN gateway of the network ‘%s’: this is the host or the Fast360 appliance that will be the

VPN server for the targeted VPN.

ERR-0000000022
Both sides ('xxx' and 'yyy') are local for appliance 'zzz'

Both tunnel-end network objects, 'xxx' and 'yyy', are local networks for appliance 'zzz'. Defining a tunnel

in this case is meaningless (it would be encrypted from appliance 'zzz' to itself).

• Review the definition of the group of VPN tunnels and the VPN gateways of the selected networks.

ERR-0000000023
Appliance '�1$s' has no RSA key

A tunnel with RSA authentication is configured, but appliance '%1$s' ' has no RSA key defined.

• Enter the appliance's RSA key in the VPN form.

ERR-0000000024
Appliance '�s' has no X.509 certificate

A tunnel with X.509 certificate authentication is configured, but the appliance '%s' has no X.509 certificate

defined.
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ERR-0000000025
Invalid X.509 certificate: �s

An X.509 certificate's string found in the configuration is invalid or incomplete. Information %s might be

missing (Subject, Public key, etc.).

• Import the X.509 certificate again.

ERR-0000000026
Interface '�s' can't have any alias

An alias was configured on an interface '%s' which is of type ADSL or Cable.

ERR-0000000027
Can't find interface or host '�s' (or host hasn't got any IP address)

ERR-0000000028
Gateway '�s' is unreachable

The gateway '%s', defined for an appliance's Internet Access, cannot be reached from the appliance.

No corresponding network is configured on the appliance.

• Check the definition of the interfaces and the Internet Access: the gateway selected for the Internet

access must be in the same addressing plan as the appliance.

ERR-0000000029
No user/password specified for the interface '�s'

No user/password is specified for the ADSL interface '%s'.

• Edit the characteristics of the interface, and enter the user name and the password.

ERR-0000000030
Bad system name for interface '�1$s' (�2$s expected)

The name of the interface '%1$s' is not consistent with its type. It should be in the format '%2$s'.

ERR-0000000031
No  modem specified for the interface '�1$s'

ADSL interface '%1$s' is configured without modem information: in in PPPoE, the interface related to the

modem must be provided; in .

• PPTP: the IP address of the modem must be provided;

• PPPoE: the interface related to the modem must be provided;

• PPPoA: the VPI and VCI parameters must be specified

• Specify the required information for the ADSL interface '%1$s'.

ERR-0000000032
Interface '�s' mustn't be enabled to use the modem

Interface '%s' specified for a Cable interface is activated whereas it should not.

ERR-0000000033
Choose between PPPoE or PPTP for ADSL modem

ERR-0000000034
Can't reach modem '�1$s'

IP address '%1$s'' of the ADSL modem does not belong to any of the appliance's configured networks.

• Change the address of the modem specified in the ADSL interface in PPTP or the address of the

interface linked to the modem, so that both these addresses are on the same network.
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ERR-0000000035
Remote phone number missing

ERR-0000000036
Maximum number of IPsec interfaces (�d) reached

The IPsec object has more configured interfaces than allowed.

• There cannot be more than 4 interfaces that manage a VPN end.

ERR-0000000037
Interface name is too long (maximum length is �d)

ERR-0000000038
Can't find  network '�s'

An object references network '%s' that is not defined in the configuration.

ERR-0000000039
Connected network '�s' is invalid on this interface

Network 0.0.0.0/0 was specified as a network connected to this interface. This is not compatible with the

generation of the antispoofing rules.

• Delete network 0.0.0.0/0 from the list of networks connected to the interface.

ERR-0000000040
Roadwarriors can't have static NAT enabled

ERR-0000000041
Can't find the appliance performing static NAT

ERR-0000000042
Static NAT IP address (�s) is already used by one of the appliance's 
interfaces 
(�s:�s)

ERR-0000000043
The IP address �s, defined in static NAT or Port Translation, 
is not defined on the appliance's interfaces

ERR-0000000044
Port translation interface xxx:yyy is not valid (not found or not 
enabled)

A filtering rule contains a port translation by interface. The interface 'yyy' is not configured correctly or

does not belong to appliance 'xxx'.

• Edit the characteristics of the interface or include the interface object in the appropriate field of the

configuration.

ERR-0000000045
Service '�s' used in rule '�s' for Port Translation is invalid 
(only TCP or UDP allowed)

A port translation cannot be performed with a protocol that is neither TCP nor UDP.

• Use static NAT to translate non-TCP/UDP traffic.

ERR-0000000046
Too many NAT entries for '�1$s' in rule '�2$s'

A filtering rule requires several port or masking translations on the same appliance.

ERR-0000000047
Can't find host/network/appliance '�s'

An object references host, network or appliance '%s' that is not defined in the configuration.
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ERR-0000000048
Encryption entry contains '�s' in source AND destination

A filtering rule is configured with appliance '%s' as both source and destination of an encryption rule. An

appliance cannot be the start and the end of a VPN tunnel at the same time.

ERR-0000000049
Too many encryption entries with '�s' in source

A filtering rule is configured in which appliance '%s' is defined as the source of several encrypted

segments. This is not possible.

• Modify the encrypted segments table of the filtering rule so that the appliance is the beginning of a

single tunnel.

ERR-0000000050
Too many encryption entries with '�s' as destination

A filtering rule is configured in which appliance '%s' is defined as the destination of several encrypted

segments. This is not possible.

• Modify the encrypted segments table of the filtering rule so that the appliance is the end of a single

tunnel.

ERR-0000000051
Host '�1$s' with no static IP address is not allowed in rule '�2$s'

A host with no static IP address defined was selected in a filtering rule as a source or destination. This

is not allowed.

ERR-0000000052
Host 'yyy' (xxx) unreachable by 'zzz'

Object 'yyy' IP address 'xxx' cannot be reached by appliance 'zzz'. No suitable interface was found.

• Check the definition of the appliance's interfaces, routes and Internet Access.

ERR-0000000053
Network '�s' (�s/�d) unreachable by '�s'

ERR-0000000054
Can't find service '�s'

Service '%s' is referenced by an object of the configuration but it is not defined.

ERR-0000000055
Can't find Internet Access '�s'

Internet Access '%s' is referenced by an object of the configuration but it is not defined.

ERR-0000000056
Port translation incompatible with static NAT (host �s)

ERR-0000000057
Rule '�s' with port translation requires a destination

A filtering rule with port translation requires a unique service defined with a unique port and a unique

destination.

• Specify a host in the destination of the filtering rule.

ERR-0000000058
Rule '�s' with port translation requires a service

A filtering rule with port translation requires a unique service defined with a unique port and a unique

destination.
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• Specify a service in the filtering rule. This service must rely on TCP or UDP protocol and use a single

port.

ERR-0000000059
Rule '�s' with port translation requires a service with no port range

A filtering rule with port translation requires a unique service defined with a unique port and a unique

destination.

• Choose another service or change the definition of the selected service.

ERR-0000000060
Can't find IPsce VPN connection '�s'

A filtering rule references a group of VPN tunnels that does not exist.

ERR-0000000061
Static NAT IP address (�s) is already used (by static NAT or port 
translation)

ERR-0000000062
Port translation with no IP address or interface on '�s'

ERR-0000000063
Unable to handle an appliance other than myself (stranger appliance is 
'�s')

ERR-0000000064
Invalid frequency: �s

The frequency of a task (updates, mails retransmission, etc.) is invalid. '%s' indicates which field is invalid.

ERR-0000000065
Interface netmask can't be 0.0.0.0

A null netmask was specified for an interface subnetwork.

• Specify a non-null netmask for the interface subnetwork.

ERR-0000000066
Keyword(s) missing

Information is missing to correctly generate the configuration of the HTTP proxy.

ERR-0000000067
Unknown authentication server type for '�s'

An appliance's authentication server has an unknown type. Known types are: "ntlm", "Kerberos", "ldap"

and "radius".

ERR-0000000068
Can't find  gateway '�s'

An Internet Access object or a Route object references a gateway host that is not defined.

ERR-0000000069
Roadwarrior '�s' not allowed in a route

A route to a nomad '%s' was configured. This is not allowed.

• Create an Internet access to define access to an unknown address.

ERR-0000000070
Internet Access '�s' has no gateway

An Internet Access of type LS/router was configured without a gateway. Specify a gateway.
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ERR-0000000071
Roadwarrior ''�s' ' not allowed as gateway

A nomad ''%s' ' without known address cannot be declared as the gateway of an Internet Access or a

static route.

ERR-0000000072
Invalid Internet access '�1$s'

• Check the Internet access parameters.

ERR-0000000073
The appliance has no main Internet access

ERR-0000000074
Interface '�1$s:�2$s' must be an IPSec interface to be used with '�3$s'

A group of VPN tunnels requires interface '%2$s' of appliance '%1$s' to be an IPsec monitoring interface.

• Select interface ‘%2$’ in the monitoring interfaces of the VPN form of the appliance ‘%1$s’.

ERR-0000000075
Can't find the host/appliance/user '�s'

An object (probably a shared key) references a Fast360 appliance, a host or a user which is not defined.

ERR-0000000076
Host '�1$s' has no RSA key

VPN server ‘%1$s' has no RSA key defined but is configured in a tunnel with RSA authentication.

• Change the authentication type in the group of VPN tunnels or enter the RSA key for the host.

ERR-0000000077
Host '�s' has no X.509 certificate

VPN server '%s' has no X.509 certificate defined but is configured in a tunnel with X.509 certificate

authentication.

• Change the authentication type of the group of VPN tunnels or define an X.509 certificate for the host.

ERR-0000000078
Can't use IP address for the certificate ID if there is no IP address 
in host '�s'

The Custom IPsec ID option was enabled on a host defined as a nomad station.

• Uncheck the option or assign an IP address to this host.

ERR-0000000079
IPsec VPN not enabled on '�s'

An IPsec tunnel is configured from appliance '%s' but '%s'’s VPN module is not enabled.

• Enable '%s'’s VPN module.

ERR-0000000080
Roadwarrior '�s' not allowed in the "allow from" rule

It is not possible to select a nomad host in the authorized VPN servers list.

• Select a 0.0.0.0/0 network object instead of the nomad in the authorized VPN servers list.

ERR-0000000081
Appliance '�s' not allowed in "allow from" rule (it's me!!!)
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An appliance was selected in the VPN servers list of its own VPN module, which triggers the creation of

an implicit rule from the appliance to itself. This is not allowed.

ERR-0000000082
User '�s' has no X.509 certificate

User '%s' has no X.509 certificate defined but is configured in a tunnel with X.509 certificate

authentication.

• Import a X.509 certificate and associate it with user ‘%s’.

ERR-0000000083
Service '�s' can't be used in bandwidth limitation because it uses a 
port range

ERR-0000000084
Can't find  Internet access '�s:�s'

An Internet Access was selected in a filtering or bandwidth rule but it is not defined.

ERR-0000000085
Couldn't create directory '�s'

ERR-0000000086
Couldn't remove directory '�s'

ERR-0000000087
Couldn't erase table '�s' from the database

ERR-0000000088
Couldn't initialize database '�s'

ERR-0000000089
Couldn't connect to database '�s'

ERR-0000000090
Bad category name '�s'; only [a-z] [A-Z] [0-9] '_' characters are 
allowed

Category name '%s' does not comply with known syntactic rules.

ERR-0000000091
Object 'xxx' unreachable by 'yyy'

Object 'xxx' is not reachable from appliance 'yyy'.

• Review the definitions of interfaces and routes on appliance ‘yyy’. It is likely that an Internet access

is missing.

ERR-0000000092
Invalid RSA key '�s'

The format of a VPN server’s authentication RSA key is invalid: odd length, key too short, invalid format.

• Import the RSA key of the VPN server again.

ERR-0000000093
Rule '�s': can't find group '�s'

ERR-0000000094
Can't find rule '�s'

ERR-0000000095
Appliance '�s' unreachable by '�s'

ERR-0000000098
Your license doesn't allow you to enable '�s' (flag '�s')

You must have a suitable license in order to activate some functions.
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ERR-0000000099
FAST policy must be POP3.

A service object is configured with a redirection to the POP3 proxy but selected FAST policy is not POP3.

ERR-0000000100
Proxy POP3 AV must be enabled on at least one appliance -- rule 'xxx', 
service 'yyy'

Filtering rule ‘xxx’ specifies a service ‘yyy’ using a redirection to the POP3 proxy, whereas no POP3 proxy

is enabled.

• Enable and configure a POP3 proxy or delete the redirection to the proxy in the POP3 service.

ERR-0000000101
Provide only file types to be analyzed or only file types that should 
not be analyzed

ERR-0000000102
'�1$s' is not an NT Domain server

Authentication server '%1$s' specified as a PDC for the appliance is not declared as an NT authentication

server.

ERR-0000000103
No Primary Domain Controller defined. Choose the Primary Domain 
Controller of the NT Domain the appliance should join.

If NT authentication servers are selected for an appliance, a main PDC must be selected from these

servers.

ERR-0000000104
Authentication server �s not found.

The authentication server '%s' is configured as a PDC for an appliance but it is not defined in the

configuration.

ERR-0000000105
Encryption and Internet Access are not compatible on the same 
appliance (�s)

ERR-0000000106
POP3 proxy can't correct bad files when it is configured in 
synchronous mode

ERR-0000000107
Quarantine option must be enabled to create rule �s

Applicative rule '%s' on the appliance's SMTP proxy requires email quarantining although quarantining

is not activated on the proxy.

ERR-0000000108
You cannot activate both quarantining and the 'remove_file' option

ERR-0000000109
The pre-shared key of community '�s' contains invalid characters 
(double-quote character not allowed)

A shared key contains the invalid character " (quotation mark).

• Use characters other than " as a shared secret.

ERR-0000000110
ICMP policy not found

The object specified as the appliance's global ICMP policy is not defined in the configuration.

ERR-0000000111
Rule '�s' with port translation enabled requires a unique destination
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A filtering rule with port translation requires a unique service defined with a unique port and a unique

destination.

• Specify a single host as the destination filtering attribute.

ERR-00000000112
Rule '�s' with port translation enabled requires a unique service

A filtering rule with port translation requires a unique service defined with a unique port and a unique

destination.

• Specify a single service as the service filtering attribute.

ERR-0000000113
Lifetime of �s keys is too big is '�s'. Current �d, maximum �d.

The lifetime defined for the IKE or IPsec keys of a VPN tunnel is too long. Maximum value is 28,800 s.

ERR-0000000114
Lifetime of �s keys is too small (according to rekeymargin and 
rekeyfuzz).
Current �d, minimum �d.

The lifetime defined for the IKE or IPsec keys of a VPN tunnel is too short. Minimum value depends on

the time interval before renegotiating and the stochastic negotiating range: Min = Time interval before

Renegotiating * (100 + Range) / 100.

ERR-0000000115
No default message provided to redirect HTTP error codes

Error codes redirection on an appliance's HTTP proxy uses a default message that is not defined in the

configuration.

ERR-0000000116
Maximum bandwidth is greater than 100�

The maximum bandwidth configured in a bandwidth rule exceeds 100%.

ERR-0000000117
Bandwidth reservation is greater than bandwidth limitation

In a bandwidth reservation rule, the minimum bandwidth configured exceeds the maximum configured.

• Change the bandwidth limitation/reservation parameters so that the minimum is less than the

maximum.

ERR-0000000118
Remove < and > characters in anti-spam rule "�s", address:"�s"

Email addresses in the SMTP proxy's anti-relaying rules must not be defined between the characters

'<' and '>'.

• Correct the email addresses definitions.

ERR-0000000119
Domain name for LDAP server '�s' is required in secure mode.

ERR-0000000120
HTTP proxy must be enabled -- rule '�s', service '�s'

ERR-0000000121
Interface '�1$s:�2$s' must be an IPSec interface to be used with 
roadwarrior '�3$s'

ERR-0000000122
The anti-relaying rule '�s' uses DNSBL but this feature has not been 
enabled
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You must configure the DNSBL functionality to use it in the anti-relaying rules.

ERR-0000000123 
Unknown system alert type for '�s'

Defined system monitoring types are "Internet access", "Interfaces" and "HTTP proxy".

ERR-0000000124 
HTTP proxy is not available on appliances without hard disk

HTTP proxy is enabled on an appliance without hard disk. This is not supported.

ERR-0000000125 
SMTP relay is not available on appliances without hard disk

SMTP relay is enabled on an appliance without hard disk. This is not supported.

ERR-0000000126 
POP3 relay is not available on appliances without hard disk

POP3 proxy is enabled on an appliance without hard disk. This is not supported.

ERR-0000000127 
Bad VLAN interface name, should be '�1$s' instead of '�2$s'

The name of the VLAN interface must be of the format ethx.y, where x is the name of the interface and

y is the VLAN ID.

ERR-0000000128 
Bad VLAN ID. ID must be between 0 and 4095

The VLAN ID must be between 0 and 4095 inclusive.

ERR-0000000129 
No '�s' interface found

The ‘%s’ interface is bridged but has not been defined.

ERR-0000000130 
Bad '�s' interface type

It is not possible to bridge interfaces which are not of the Ethernet type.

ERR-0000000131 
'�s' interface is not a bridged interface

The ‘%s’ interface is bridged but does not show the corresponding characteristics.

ERR-0000000132 
Only one bridge can be configured

It is not possible to define several bridge interfaces on an appliance.

ERR-0000000133 
Cannot use bridged interface '�s'

A module cannot use an interface included in a bridge interface.

ERR-0000000134 
A bridge requires at least 2 interfaces

ERR-0000000135 
When using a shadow bridge, a route to the bridged networks via �s 
must be created

In the case of a bridge interface in furtive mode, it is necessary to create a static route to route the

addresses of the bridged networks to the br0 bridge interface. This route permits an appliance to manage

fragmented packets or to submit TCP RST packets in the case of protocol violation.
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ERR-0000000136 
Speed can't be specified for interface '�s' (�d)

It is not possible to select a speed on this type of interface.

ERR-0000000137 
Unknown interface speed: '�s'

The defined interface speed is unknown.

ERR-0000000138 
User '�1$s' has no X.509 certificate or no DN configured

The user selected in the VPN tunnel has no means of authentication.

• Associate a certificate or a DN with the user.

ERR-0000000139 
Group '�1$s' used in IPsec VPN rule has no DN

The ‘%1$s’ user group selected in the group of VPN tunnels has no specified DN.

• Specify the DN of the ‘%1$s’ user group.

ERR-0000000140 
Can’t find certificate ‘�s’ 

The certificate object cannot be found in the configuration.

ERR-0000000141 
No cRLDistributionsPoints extension found in certificate ‘�s’

Certificate '%s' does not contain the X.509v3 cRLDistributionPoint field. This field is required to configure

the retrieval of the CRL.

ERR-0000000142 
LDAP groups in IPsec VPN requires a LDAP server as authentication 
server 

If you select an LDAP group in the group of VPN tunnels, you must select the “Authentication Server”

object representing the LDAP server in the Authentication form in the Security configuration form of the

appliance.

ERR-0000000143 
DHCP-over-IPsec selected but no DHCP server has been set

The group of VPN tunnels specifies the Enable DHCP over IPsec option but no DHCP server is specified

in the VPN configuration form of the appliance.

• Select the VPN Policy object configured with a DHCP server (in the Settings configuration form) in the

VPN Policy field of the VPN form of the appliance.

ERR-0000000144 
Interfaces '�1$s' and '�2$s' belong to the same IP network 

Two different interfaces cannot have an IP address on the same logical subnetwork.

• Modify the addressing and/or the mask of one of the interfaces, or configure a bridge interface.

ERR-0000000145 
Parse error in local IDPS database

One of the IDPS custom signatures causes an internal syntax error in the IDPS signatures database.

• Check the conformity of your custom IDPS signatures and profiles.
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ERR-0000000146 
Parse error in IDPS database

ERR-0000000147 
Error while parsing hardware and system configuration

ERR-0000000148 
Signature �s uses an applicative state not implemented on this 
appliance (�s)

One of the IDPS signatures uses a protocol state which is not implemented.

• You probably have appliances of different versions and are using an IDPS base which is too recent

an appliance's version.

ERR-0000000149 
Authentication server �s is defined by name but you didn't specify any 
DNS server

LDAP server ‘%s’ is identified by a DNS name, but no DNS server is configured on the appliance.

ERR-0000000150 
Bonded interface '�s' is already in use. It should be disabled before 
being bonded.

Interface %s is configured, and the administrator attempts to aggregate it.

ERR-0000000151 
Interface �s is bonded twice or more

An interface cannot be aggregated several times.

ERR-0000000152 
Bad type of VLAN primary interface: �s

The primary interface of a VLAN interface is not of the Ethernet or Bonding types.

ERR-0000000153 
Can't find VLAN primary interface for '�s'

The primary interface of the configured VLAN interface cannot be found.

ERR-0000000154 
VLAN ID �d is already in use

A VLAN ID is used several times for the same interface.

ERR-0000000155 
Bad primary interface '�s' type for bridged VLAN interface '�s'

The primary interface of a bridged VLAN interface is a bonding interface.

ERR-0000000156 
No bonded interface

A configured bonding interface has no aggregated interface.

ERR-0000000157 
Profile '�s' does not exist

Authentication profile ‘%s’ is not defined in the configuration although it is referenced by another object.

ERR-0000000158 
Server �s not found

An authentication profile refers to server %s which is not defined in the configuration.

ERR-0000000159 
Rule �s not found
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An authentication profile refers to rule %s which is not defined in the configuration.

ERR-0000000160 
FTP proxy is not available on appliances without hard disk

FTP proxy is enabled on an appliance without hard disk. This is not supported.

ERR-0000000161 
'�1$s' is a bridged VLAN primary interface

The primary interface of a VLAN interface should not be bridged.

ERR-0000000162 
'�1$s' is a bonded VLAN primary interface

The primary interface of a VLAN interface should not be bound.

ERR-0000000163 
Bad interface '�s' type.

Only Ethernet interfaces can be bound.

ERR-0000000165 
The interface name must be shorter than 16 characters. 
Please choose a lower VLAN ID, or delete aliases 

The interface name has more than 16 characters (version 3.1/1 and above only).

ERR-0000000166 
Antispam filtering has been enabled on the SMTP proxy but no antispam 
configuration has been defined for '�s'

You need to configure antispam before it is enabled.

ERR-0000000167 
Antispam filtering has been enabled on the POP3 proxy but no antispam 
configuration has been defined for '�s'

You need to configure antispam before it is enabled.

ERR-0000000168 
Antispam filtering can't be enabled on the POP3 proxy configured in 
synchronous mode for '�s'

Antispam cannot be used on POP3 proxies in synchronous mode. Configure the proxy to operate in

asynchronous or hybrid mode.

ERR-0000000169 
Bandwidth management can only be applied on Ethernet and Bonding 
interfaces

Other interface types do not allow bandwidth management.

ERR-0000000170 
'�s' doesn't have nominal bandwidth

For filtering rules to operate correctly on an Ethernet interface or an Internet access point, you need to

assign a nominal bandwidth to the access or interface.

ERR-0000000171 
An appliance requires at least one DNS server to enable DNS-based 
antispam filtering

Configure at least one DNS server for use by the appliance.

ERR-0000000172 
Object '�s' used as remote entity is local for '�s' (star center)

Objects that are local to the hub of a VPN star topology cannot be defined as remote objects.
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ERR-0000000173
Cannot use bonded interface �s

ERR-0000000174
SAt least one host must be selected in '�s'

You must select at least one host in an interface or Internet Access system monitoring object.

ERR-0000000175
Dynamic routing is enabled, static routes must be set up with Quagga

When dynamic routing is enabled, static routes must be configured through Quagga rather than  Arkoon

Manager .

ERR-0000000176
RIP routing protocol cannot be enabled on appliances in a HA cluster

ERR-0000000177
Multicast must be enabled on a listening RIP or OSPF interface �s

When a dynamic routing protocol is used, multicast must be authorized on the RIP and OSPF listening

interfaces.

ERR-0000000178
A disclaimer must be defined in the SMTP relay properties to be used 
in the SMTP applicative rule '�s'

A protocol rule requires a disclaimer to be added, while the latter is not configured in the SMTP relay

properties.

ERR-0000000179 
The specific IP address (�s/�d) set on interface '�s' is not in the 
same subnet as the primary IP address

Specific IP addresses assigned by appliance ID must be in the same subnet as the primary IP address.

ERR-0000000180 
HA real interface �s and virtual interface �s have the same IP address

ERR-0000000181 
LDAP groups handling in PKI requires an LDAP server in PKI object or 
as authentication server

ERR-0000000182 
�s proxy can't have a listening ADSL interface

ERR-0000000186 
No HA real interface found

ERR-0000000187 
No defined key in preshared key object

ERR-0000000188 
Can't find interface or Internet Access '�1$s'

ERR-0000000189 
External antispam quarantine is enabled, but no mailbox address is set

ERR-0000000190 
Aliases '�1$s' and '�2$s' have identical IP address

ERR-0000000191 
Interface '�1$s' and alias '�2$s' have identical IP address

ERR-0000000192 
No Internet Access defined in system monitoring '�s'

ERR-0000000193 
No interface defined in system monitoring '�s'

ERR-0000000194 
Host '�1$s' does not have DNS capability enabled
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ERR-0000000195 
Host '�1$s' does not have NTP capability enabled

ERR-0000000196 
RSA key string has odd size in object '�s'

ERR-0000000197 
RSA key is too short in object '�s'

ERR-0000000198 
RSA key must be in hexadecimal in object '�s'

ERR-0000000199 
Interface '�s' is already used by a bridge interface.

ERR-0000000200 
No appliance defined in NAT entry for rule '�s'

ERR-0000000206
No network object is defined for SNMP manager

ERR-0000000207
Cannot use a SNMP listening ADSL or Bridge interface '�s' on HA node

ERR-0000000208
Host '�1$s' does not have SNMP �2$s capability enabled

ERR-0000000209
IPsec VPN is enabled but no policy is defined for '�s'

ERR-0000000210
No community defined for IPsec VPN tunnel '�s'

ERR-0000000211
No update server

ERR-0000000212
Host '�1$s' has no Update server capability

ERR-0000000213
Update server is configured to use a HTTP proxy but no proxy is defined

ERR-0000000214
Update is enabled but no policy is defined for '�s'

ERR-0000000215
External PKI is enabled but no PKI is defined

ERR-0000000216
No gateway is defined for this static route '�s'

ERR-0000000217
No destination is defined for this static route '�s'

ERR-0000000218
Host '�1$s' does not have Syslog capability enabled

ERR-0000000219
Host '�1$s' does not have FTP proxy capability enabled

ERR-0000000220
No server defined for FTP authentication in '�1$s'

ERR-0000000221
Host '�1$s' does not have HTTP proxy capability enabled

ERR-0000000222
Filtering is enabled on '�1$s' but no server is defined

ERR-0000000223
Proxy chaining does not have any proxy defined

ERR-0000000224
Proxy chaining does not have any destination defined.

ERR-0000000225
No object defined for route with domain '�s'
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ERR-0000000226
Rejecting mails with maximum file size criteria is not allowed in rule 
'�s'

ERR-0000000227
Cannot use keywords in accept rule '�s'

ERR-0000000228
Antispam is enabled but no policy is defined for '�s'

ERR-0000000229
Host '�1$s' does not have spamd server capability enabled

ERR-0000000230
'�1$s' (0.0.0.0/0) not allowed in antispam black/white list for 
appliance '�2$s'

ERR-0000000231
No spamd server defined for '�s'

ERR-0000000232
No certificate defined in spamd configuration for '�s'

ERR-0000000233
Host '�1$s' has no router capability enabled

ERR-0000000235
Host '�1$s' has no LDAP server capability enabled

ERR-0000000236
Host '�1$s' has no NT server capability enabled

ERR-0000000237
Host '�1$s' has no RADIUS server capability enabled

ERR-0000000238
Network interface '�s' does not belong to appliance '�s'

ERR-0000000239
Internet Access '�s' does not belong to appliance '�s'

ERR-0000000240
No appliance defined for static NAT in object '�1$s'

ERR-0000000241
IDPS profile '�1$s' is empty

ERR-0000000242
IDPS profile '�1$s' references itself

ERR-0000000243
IDPS profile '�1$s' seems to have an inclusion loop

ERR-0000000244
IDPS profile '�1$s' uses an empty profile ('�2$s')

ERR-0000000245
Host '�1$s' has no PPTP modem capability enabled

ERR-0000000246
Host '�1$s' with '�2$s' capability must be statically addressed

ERR-0000000247
Host '�1$s' with '�2$s' capability must be identified by a FQDN

ERR-0000000248
Host '�1$s' with '�2$s' capability must be identified by an IP address 
or a FQDN

ERR-0000000249
No appliance defined for static NAT in network '�1$s'

ERR-0000000250
Missing MAC address for host '�1$s'

ERR-0000000251
DHCP server and relay cannot be both active at the same time on 
appliance '�1$s'
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ERR-0000000252
DHCP server is enabled on appliance '�1$s', and it uses a VPN policy 
in which DHCP is enabled

ERR-0000000253
Incorrect global DHCP server lease settings

ERR-0000000254
Incorrect lease settings in DHCP server pool '�1$s'

ERR-0000000255
The host '�1$s' must be either defined as a static host or excluded 
from pool '�2$s', as it is configured as a DNS server in that pool

ERR-0000000256
The host '�1$s' must be either defined as a static host or excluded 
from pool '�2$s', as it is configured as an NTP server in that pool

ERR-0000000257
The host '�1$s' must be either defined as a static host or excluded 
from pool '�2$s', as it is configured as a WINS server in that pool

ERR-0000000258
The host '�1$s' must be either defined as a static host or excluded 
from pool '�2$s', as it is configured as the default gateway in that 
pool

ERR-0000000259
No interface is configured within the subnet of DHCP server pool '�1$s'

ERR-0000000260
The range of IP addresses '�1$s'-'�2$s' defined for DHCP server pool 
'�3$s' is invalid

ERR-0000000261
The range of allocatable IP addresses '�1$s'-'�2$s' is not included in 
the subnet of DHCP server pool '�3$s'

ERR-0000000262
No client interface is configured for DHCP server '�1$s'

ERR-0000000263
The subnets defined for DHCP server pools '�1$s' and '�2$s' overlap.

ERR-0000000264
The ranges of allocatable addresses in DHCP server pool '�s' overlap

ERR-0000000265
No subnet is configured for pool '�1$s'

ERR-0000000266
Host '�1$s' is defined as a DNS server for pool '�2$s', yet it has no 
DNS server capability enabled

ERR-0000000267
Host '�1$s' is defined as a NTP server for pool '�2$s', yet it has no 
NTP server capability enabled

ERR-0000000268
Host '�1$s' is defined as a WINS server for pool '�2$s', yet it has no 
WINS server capability enabled

ERR-0000000269
The 'ignore-broadcast' option on interface '�1$s' of DHCP server '�2$s' 
should be removed

ERR-0000000270
DHCP relay is enabled on '�1$s', but no client interface is configured

ERR-0000000271
DHCP relay is enabled on '�1$s', but no DHCP server is configured

ERR-0000000272
DHCP relay is enabled on '�1$s', but no authorized network is configured

ERR-0000000273
DHCP server '�1$s' is not reachable from DHCP relay '�2$s'
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ERR-0000000274
DHCP server '�1$s' configured in DHCP relay '�2$s' is behind 
client-interface '�3$s'

ERR-0000000275
DHCP server '�1$s' cannot be the local appliance

ERR-0000000276
The 'ignore-broadcast' option on interface '�1$s' should be disabled 
as broadcast is used by DHCP relay '�2$s'

ERR-0000000277
DHCP relays '�1$s' cannot use bridge or bridged interfaces

ERR-0000000278
DHCP relay '�1$s' cannot use bridge or bridged interfaces

ERR-0000000279
Host '�1$s' is defined as a DHCP server for DHCP relay '�2$s', yet it 
has no DHCP server capability enabled

ERR-0000000280
Main PDC '�1$s' for appliance '�2$s' does not belong to the 
authentication server list

ERR-0000000281
The appliance needs at least one DNS server to have antispam filtering 
enabled

ERR-0000000282
A relay is activated, but no host is configured

ERR-0000000283
Maximum rate must be greater than commited rate in '�1$s'

ERR-0000000284
Commited rate must be lower than commited depth in '�1$s'

ERR-0000000285
Peak rate must be lower than peak depth in '�1$s'

ERR-0000000286
Committed rate must be lower than peak rate in '�1$s'

ERR-0000000287
Committed depth must be lower than peak depth in '�1$s'

ERR-0000000288
A DSCP mark must be specified as green action is to mark packets 
('�1$s')

ERR-0000000289
A DSCP mark must be specified as yellow/red action is to mark packets 
('�1$s')

ERR-0000000290
Borrowing must be activated also for the root class ('�1$s')

ERR-0000000291
A parent class of traffic must be specified ('�1$s')

ERR-0000000292
Children of '�1$s' request more than 100� of the bandwidth

ERR-0000000293
The HTB tree of '�1$s' must have a root HTB class on top of it

ERR-0000000294
A traffic conditioner must be specified in the Ingress rule '�1$s'

ERR-0000000295
Interface or Internet Access must be specified in the Ingress rule 
'�1$s'

ERR-0000000296
A class of traffic must be specified in the Egress rule '�1$s'

ERR-0000000297
Interface or Internet Access must be specified in the Egress rule '�1$s'
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ERR-0000000298
Host '�1$s' has no SMTP server capability enabled

ERR-0000000299
Host '�1$s' has no DHCP server capability enabled

ERR-0000000300
IP address �1$s for host '�2$s' is not a valid one

ERR-0000000301
Only one internal ADSL interface is allowed for '�1$s'

ERR-0000000302
HTTP proxy on '�1$s' is used by '�2$s' but not enabled

ERR-0000000303
Only one type of traffic conditioner is allowed for interface '�1$s'

ERR-0000000304
Only one scheduler type is allowed for interface '�1$s'

ERR-0000000305
Local postmaster is enabled on '�1$s', but value is empty

ERR-0000000306
Heartbeat HA interface '�1$s' must accept broadcast packets

ERR-0000000307
Domain name for host '�1$s' is not a valid one

ERR-0000000308
FTP proxy on '�1$s' is used by '�2$s' but not enabled

ERR-0000000309
Appliance '�1$s' is present in the SMTP Id List

ERR-0000000310
The delay value '�1$s' for Dead Peer Detection in VPN '�2$s' is too 
small

ERR-0000000311
The timeout value '�1$s' for Dead Peer Detection in VPN '�2$s' is too 
small

ERR-0000000312
Appliance '�1$s' is mentioned in the authorized virtual IP addresses 
for a VPN policy. 
Only networks are allowed.

ERR-0000000313
Appliance '�1$s' is mentioned in the forbidden virtual IP addresses 
for a VPN policy. 
Only networks are allowed.

ERR-0000000314
The gateway host in VPN tunnel '�1$s' has no VPN gateway capability 
enabled

ERR-0000000315
The gateway host for network '�1$s' has no VPN gateway capability 
enabled

ERR-0000000317
External antispam quarantine email must not be empty

ERR-0000000318
Signature '�1$s' is deprecated

ERR-0000000319
Interface '�1$s' with QoS for VPN capability is not an IPsec interface.

ERR-0000000320
Host '�1$s' with no static IP address belongs to the SMTP Id list

ERR-0000000321
Host '�1$s' with no static IP address is used in an anti relay rule.

ERR-0000000322
Host '�1$s' with no static IP address can't be a VPN gateway.
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ERR-0000000323
Too many translations for '�1$s' in rule '�2$s'

ERR-0000000324
No translation for '�1$s' in rule '�2$s'

ERR-0000000325
'�1$s' in the anti-spoofing list of interface '�2$s' is not a network.

ERR-0000000326
Host '�1$s' with no static IP address can't be configure as a source 
in Ingress rule '�2$s'

ERR-0000000327
Host '�1$s' with no static IP address can't be configured as a 
destination in Ingress rule '�2$s'

ERR-0000000328
Host '�1$s' with no static IP address can't be configured as a 
source in Egress rule '�2$s'

ERR-0000000329
Host '�1$s' with no static IP address can't be configured as a 
destination in Egress rule '�2$s'

ERR-0000000330
Host '�1$s' with no static IP address can't be configured as a RIP 
peer for appliance '�2$s'

ERR-0000000331
Host '�1$s' with no static IP address can't be configured as an OSPF 
peer for appliance '�2$s'

ERR-0000000332
Host '�1$s' with no static IP address can't be configured as a BGP 
peer for appliance '�2$s'

ERR-0000000333
Host '�1$s' with no static IP address can't be present in a DHCP pool's 
list of excluded IP addresses on appliance '�2$s'

ERR-0000000334
Host '�1$s' with no static IP address can't be present in the DHCP 
relay's list of authorized clients for appliance '�2$s'

ERR-0000000335
Host '�1$s' with no static IP address can't be configured as an 
authorized client of the HTTP proxy on appliance '�2$s'

ERR-0000000336
Host '�1$s' with no static IP address can't be configured as a source 
of a HTTP rule '�2$s'

ERR-0000000337
Host '�1$s' with no static IP address can't be configured as an 
authorized client of the FTP proxy on appliance '�2$s'

ERR-0000000338
Host '�1$s' with no static IP address can't be configured as an 
authorized reporting client on appliance '�2$s'

ERR-0000000339
Host '�1$s' with no static IP address can't be configured as an SNMP 
client on appliance '�2$s'

ERR-0000000340
VLAN interface '�1$s' can't have a higher MTU(�2$s) than its primary 
interface '�3$s' (�4$s)

ERR-0000000341
Host '�1$s' with no static IP address can't be configured as an update 
client on appliance '�2$s'

ERR-0000000342
DHCP server '�1$s' cannot be a network

ERR-0000000343
Appliance '�1$s' is defined as a DHCP server for DHCP relay '�2$s', 
yet it has no DHCP server capability enabled
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ERR-0000000344
Host '�1$s' is identified by a FQDN. Therefore it can't be configured 
as an entity of VPN community '�2$s'

ERR-0000000345
HTTP proxy is used by '�1$s' but not defined

ERR-0000000346
Host '�1$s' is identified by a FQDN. Therefore it can't be the hub 
center of VPN community '�2$s'

ERR-0000000347
Network '�1$s' is not allowed in the authentication server list

ERR-0000000348
Appliance '�1$s' is not allowed in the authentication server list

ERR-0000000349
Appliance '�1$s', whose SMTP relay is disabled, is included in the 
SMTP server list of appliance '�2$s'

ERR-0000000350
Host '�1$s' with no static IP address can't be included in the 
blacklist of policy '�2$s'

ERR-0000000351
Host '�1$s' with no static IP address can't be included in the 
whitelist of policy '�2$s'

ERR-0000000352
Host '�1$s' is present in the VPN policy's list of authorized virtual 
IP addresses. 
Only networks are allowed.

ERR-0000000353
Host '�1$s' is present in the VPN policy's list of forbidden virtual 
IP addresses. 
Only networks are allowed.

ERR-0000000354
The tagging prefix must not be empty

ERR-0000000355
The group or folder '�1$s' is used although it is empty.

ERR-0000000356
Users �1$s have the same login '�2$s'.

ERR-0000000357
DHCP relay is enabled on '�1$s', but the client interface is not 
enabled '�2$s'

ERR-0000000358
DHCP relay is enabled on '�1$s', but the client interface '�2$s' is 
not owned by this fast

ERR-0000000359
DHCP server is enabled on '�1$s', but the client interface is not 
enabled '�2$s'

ERR-0000000360
DHCP server is enabled on '�1$s', but the client interface '�2$s' is 
not owned by this fast

ERR-0000000361
The network '�1$s' is not allowed in the sysmon internet access tested 
hosts list

ERR-0000000362
The appliance '�1$s' is not allowed in the sysmon internet access 
tested hosts list

ERR-0000000363
The host '�1$s' with no static ip can't be present in the internet 
access host list of the sysmon '�2$s'

ERR-0000000364
The network '�1$s' is not allowed in the sysmon tested interface 
monitoring hosts list
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ERR-0000000365
The appliance '�1$s' is not allowed in the sysmon tested interface 
monitoring hosts list

ERR-0000000366
The host '�1$s' with no static ip can't be present in the interface 
monitoring host list of the sysmon '�2$s'

ERR-0000000367
External authentication is enabled but no server is defined

ERR-0000000368
DHCP server '�1$s' for DHCP-over-IPSec feature of VPN Policy '�2$s' is 
not reachable by appliance '�3$s'

ERR-0000000369
The host '�1$s' with no static ip can't be present in the SNMP V1 
server list of the log policy '�2$s'

ERR-0000000370
The host '�1$s' with no static ip can't be present in the SNMP V2 
server list of the log policy '�2$s'

ERR-0000000371
SNMP v1 server '�1$s' cannot be a network

ERR-0000000372
SNMP v1 server '�1$s' cannot be an appliance

ERR-0000000373
SNMP v2 server '�1$s' cannot be a network

ERR-0000000374
SNMP v2 server '�1$s' cannot be an appliance

ERR-0000000375
The host '�1$s' with no static ip can't be present in the Syslog 
server list of the log policy '�2$s'

ERR-0000000376
Syslog server '�1$s' cannot be a network

ERR-0000000377
Syslog server '�1$s' cannot be an appliance

ERR-0000000378
Host '�1$s' with '�2$s' capacity must be addressed by ip or Nomad

ERR-0000000379
'vrrp-preempt-timer' must be greater than 'vrrp-advertise-timer'

The preemptive timer must be greater than the advertisement timer.

ERR-0000000380
'admin-sync-address' must be one of the 'vrrp-IP' address 
(associated to an interface)

The cluster master node address must be one of the virtual addresses.

ERR-0000000381
For a cluster, 'static-IP' and 'vrrp-IP' must be unique.

For a cluster, 'real address' and virtual address must be unique.

ERR-0000000382
'vrrp-IP' must be associated to a node

A virtual address must be associated to a node.

ERR-0000000383
There is no IP address for the node '�1$s'

There is no real IP address for the node '%1$s'.
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ERR-0000000384
There is no mask IP address for the node '�1$s'

There is no real IP address mask for the node '%1$s'.

ERR-0000000385
'send-delay' must be lower than 2x'delay'

ERR-0000000386
Cluster node number must be smaller than 2

The maximum cluster node number must be 2.

ERR-0000000387
Ip dynamic number must be at least equals to the number of node

The number of virtual IP must be at least equals to the number of node.

ERR-0000000388
Interface needs at least one Ip dynamic

Interface needs at least one virtual IP configured.

ERR-0000000389
Ip dynamic must specified a node.

An virtual IP must specified a node.

ERR-0000000390
DHCP protocol and ignore broadcast option on the same interface,'�1$s', 
are incompatible

ERR-0000000391
VPN PSK contains invalid character in fast360 '�s' (cannot contains '"')

ERR-0000000392
In High Availability cluster mode all the virtual addresses must be set on the 
same node

ERR-0000000393
Data synchronization interface is disabled

ERR-0000000394
The Cluster functionality is not available on this type of appliance: '�s'

ERR-0000000395
Administration interface (interface of master node address) can't be disabled, 
bridged or bonded

ERR-0000000396
Administration interface (interface of master node address) must be an ethernet 
interface

ERR-0000000397
Data synchronization interface is missing

ERR-0000000398
The cluster master node address must be the first virtual address associated to 
 given node, for a given interface

ERR-0000000399
Http cache is not available on Arkoon SMALL series

ERR-0000000400
Rule '�s': destination must be an Host or an Appliance when destination 
translation is enabled, but '�s' is a Network

ERR-0000000401
The link monitoring (VRRP protocol) can't be disabled on all available cluster 
'�1$s' interfaces

ERR-0000000402
Option 'Apply to all the following interfaces' is selected in QoS rule '�1s', but 
no interface is referenced
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ERR-0000000403
Option 'Apply to the following internet accesses' is selected in QoS rule '�1s', 
but no internet access is referenced

ERR-0000000404
Option 'Authenticate the following users' is selected in applicative rule '�1s', 
but no user is referenced

ERR-0000000405
�1$s' Cluster Master Node Interface '�2$s:�3$s', '�4$s/�5$s' is unreachable by 
interface '�6$s:�7$s', '�8$s/�9$s'

ERR-0000000406
Cluster '�1s' can't use bridge interface '�2s' because link monitoring (VRRP) is 
disabled on all available cluster interfaces

ERR-0000000407
In static route '�1s', the network corresponding to gateway '�2s' equals destination 
network '�3s'. Please remove this useless static route

ERR-0000000408
In static route '�1s', the network corresponding to gateway '�2s' equals destination 
network '�3s'. Please remove this useless static route

ERR-0000000409
In static route '�1s', the network corresponding to the interface '�2s' reaching gateway 
'�3s' equals destination network '�4s'. Please remove this useless static route

ERR-0000000410
It is not allowed to apply QoS Rule '�1$s' to internet access '�2$s' when parameter 
Enable QoS On Vpn' is enabled on the interface '�3$s' used by this internet access ('�2$s')

ERR-0000000411
It is not allowed to apply QoS Rule '�1$s' to internet access '�2$s' when parameter 
Enable QoS On Vpn' is enabled on the interface '�3$s' used by this internet access 
'�2$s'), and when traffic conditionner is not of type 'Token Bucket Arkoon'

ERR-0000000412
VPN tunnel '�1$s': impossible to establish a tunnel between  '�2$s' and '�3$s' 
since appliance '�4$s' does not support 'SHA256' hash algorithm during (IKE/ESP)
VPN negociation phases

ERR-0000000413
QoS Ingress rule '�1$s' uses an 'Arkoon Token Bucket' traffic conditionner. 
this rule is applied to interface '�2$s'. Since interface '�2$s' is used by 
internet access '�3$s', this rule will not be functional. Please apply the QoS Rule 
to internet access '�3$s' instead, or use a 'TRTCM' traffic conditionner

ERR-0000000414
The name length of '�1$s' authentication server has exceeded the allowed limit of �2$s characters

ERR-0000000415
The maximum size for downloading a file in the '�s' appliance HTTP relay, 
cannot be inferior to the maximum size of the antivirus analysis

ERR-0000000416
The total number of URL filtering categories used by the '�s' appliance (�s) 
exceeds the maximum allowed value (�s)

ERR-0000000417
The flow rule '�s' cannot be installed both on Virtual Edition Web & Mail 
appliances and on other types of appliances

ERR-0000000418
The maximum number of '�1s' flow rules for the '�2s' Virtual Edition Web & Mail 
appliance has been exceeded

ERR-0000000419
In flow rule '�1$s', the selective installation is enabled but no appliance is specified

ERR-0000000420
In the FAST policy '�1$s', the IDPS analysis is enabled but no IDPS policy is specified

ERR-0000000421
In an encrypted segment, the source must contain only appliances, but 'MyObject'
is not of the right type

ERR-0000000422
In an encrypted segment, the destination must contain only appliances, but 'MyObject' 
is not of the right type
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ERR-0000000423
When the source of an encrypted segment contains more than one appliance, its destination 
must be empty (all gateway appliances of the rule's destination network are then selected 
as destination)

ERR-0000000424
When the destination of an encrypted segment contains more than one appliance, its 
destination must be empty (all gateway appliances of the rule's source networks are 
then selected as source)

ERR-0000000425
The VPN community '�s' must  contain at least two end entities

ERR-0000000426
In flow rule '�1$s', the destination translation (PAT) is selected, but more than one 
translating appliance is specified. Please specify only one appliance

ERR-0000000427
In flow rule '�1$s', the source translation (NAT by IP) is selected, but more than 
one translating appliance is specified. Please specify only one appliance

ERR-0000000428
It is not possible to use in the list of authentication servers, both a server with the 
AD NTLM server" capacity, and another one with the "AD Kerberos server" capacity

ERR-0000000429
Host '�1$s' has no 'AD Kerberos server' capability enabled

ERR-0000000430
For the appliance "�1$s", it is not possible to use a server with "AD Kerberos Server" 
capacity for global authentication and a server with "AD NTLM Server" capacity for 
HTTP relay authentication

ERR-0000000431
For the appliance "�1$s", it is not possible to use a server with "AD NTLM Server" capacity 
or global authentication and a server with "AD Kerberos Server" capacity for HTTP relay authentication

ERR-0000000432
For the HTTP relay, it is not possible to use an external NTLM or Kerberos authentication 
server if no external authentication is enabled on the appliance

ERR-0000000433
For the HTTP relay, the external authentication is enabled, but there is no authentication 
server selected

ERR-0000000434
For the host "�1$s", it is not possible to jointly use the "AD Kerberos server" and 
AD NTLM Server" capacities. You must disable one of these two capacities

ERR-0000000435
The host '�1$s' has neither the "AD NTLM server" nor "AD Kerberos server" capacity enabled

ERR-0000000436
The hostname of cluster '�1$s' is identical to the hostname of node '�2$s'

ERR-0000000437
For domain route '�1$s', the authentication is enabled but no username is defined

ERR-0000000438
For domain route '�1$s', the authentication is not compatible with the MX name resolving

ERR-0000000439
The SmartSSL feature is not available on the XPA appliances

ERR-0000000440
The SmartSSL feature requires a main Internet Access

ERR-0000000441
Remote authentication of the SmartSSL feature si selected, but no authentication server 
is specified

ERR-0000000442
The SmartSSL feature requires a DNS server

ERR-0000000443
The list of servers reachable via the ClousSSL Service is empty

ERR-0000000444
The server '�1$s' is unreachable by the appliance '�2$s'
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ERR-0000000445
Access Rules should have a server defined

ERR-0000000446
Access Rules should have a service defined

ERR-0000000447
The Authentication server for SmartSSL should be the same as main Primary Domain Controller

ERR-0000000448
The Authentication server for SmartSSL must have AD NTLM Server or AD Kerberos Server capacity

ERR-0000000449
Http relay need a web policy

ERR-0000000450
The http rule : '�1$s' need a web policy

ERR-0000000451
In flow rule : '�1$s' you can't enable '�2$s' without the license option SMART_AV

ERR-0000000452
SNMP v3 protocol activated on agent, but no username is defined

ERR-0000000453
SNMP v3 authentication activated on agent, but no authentication password is defined

ERR-0000000454
SNMP v3 authentication activated on agent, but no privacy password is defined

ERR-0000000455
SNMP v3 capacity activated on '�1$s', but no username is defined

ERR-0000000456
SNMP v3 capacity activated on '�1$s', but no engine ID is defined

ERR-0000000457
SNMP v3 authentication activated on '�1$s', but no authentication password is defined

ERR-0000000458
SNMP v3 authentication activated on '�1$s', but no privacy password is defined

ERR-0000000459
SNMP v2/v1 protocol is activated, but no community is defined

ERR-0000000460
SNMP alert traps activated, but no SNMP server listed

ERR-0000000461
The engine ID size of host '�1$s' must be included between 5 and 32 bytes

ERR-0000000462
Host '�1$s' engine ID must be hexadecimal [0-9][a-f]

ERR-0000000463
SNMP v3 authentication password on '�1$s' is too small. It must have at least 8 characters

ERR-0000000464
SNMP v3 privacy password on '�1$s' is too small. It must have at least 8 characters

ERR-0000000465
Too many SNMP servers defined. Maximum authorized servers number is 4

ERR-0000000466
Agents' SNMP v3 authentication password is too small. It must have at least 8 characters

ERR-0000000467
Agents' SNMP v3 privacy password is too small. It must have at least 8 characters

ERR-0000000468
The antivirus cannot be activated by the applicative rule '�s' if it is 
deactivated by default in the HTTP proxy configuration

ERR-0000000469
In flow rule '�1$s', authentication has been selected but no user or group is defined

ERR-0000000470
In flow rule '�1$s', authentication has been selected but no authentication type is choosen
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ERR-0000000471
In flow rule '�1$s', IPSec-ID authentication has been selected but user '�2$s' has no DN and 
no certificate

ERR-0000000472
It's not possible to use NTLM group '�1$s' in flow rule '�2$s' using only IPSec-ID authentication

ERR-0000000473
In flow rule '�1$s', IPSec-ID authentication has been selected, but no VPN Tunnel has been configured

ERR-0000000474
It's not possible to use LDAP user '�1$s' in flow rule '�2$s' using only Agentless authentication

ERR-0000000475
It's not possible to use LDAP group '�1$s' in flow rule '�2$s' using only Agentless authentication

ERR-0000000476
In VPN community '�1$s', X-Auth authentication has been selected but no user or group is defined

ERR-0000000477
In VPN community '�1$s', an external server for X-Auth authentication has been selected but 
no server is defined

ERR-0000000478
In VPN community '�1$s', for X-Auth authentication, the local user '�2$s' has no password

ERR-0000000479
In VPN tunnel for mobile devices '�1$s', no network is defined for virtual IP (Mode CFG IKE)

ERR-0000000480
In VPN tunnel for mobile devices '�1$s', network for virtual IP '�2$s' must not have a network mask 
in /0 or /31 or /32

XML Error Messages

XML-0000000000
Error : �s

XML-0000000001
The number provided is greater than the allowed limit

XML-0000000002
The number provided is greater than the allowed limit

XML-0000000003
The number provided is smaller than the allowed limit

XML-0000000004
The number provided is smaller than the allowed limit

XML-0000000005
This string is longer than the allowed size

XML-0000000006
This string is shorter than the allowed size

XML-0000000007
The current string doesn't match the expected pattern

XML-0000000008
The number provided doesn't match digit number restriction

XML-0000000009
This list must contain more elements

XML-0000000010
The string length is invalid

Field Type Error Messages

TYPE-0000000000
'from' value (�d) can't be greater than 'to' value (�d)
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TYPE-0000000001
a name cannot be left empty

TYPE-0000000002
the name '�s' is used by several objects

TYPE-0000000003
the current object's name contains invalid characters

TYPE-0000000004
The current object's name starts or ends with spaces

TYPE-0000000005
Password is invalid

TYPE-0000000006
FAST option is invalid

TYPE-0000000007
An hour can't be greater than 24h00

TYPE-0000000008
Password must have at least 8 characters

TYPE-0000000009
Password must include characters from at least 3 of the following sets: lower case alphabetics, upper case 
alphabetics, digits 0 thru 9, others (punctuation marks, ...)

TYPE-0000000010
Email in the antispam blacklist must not be empty

TYPE-0000000011
Email in the antispam whitelist must not be empty

TYPE-0000000012
A custom ICMP policy must specified

TYPE-0000000013
The start hour can't be later than the end hour

TYPE-0000000014
An unqualified error has occurred

TYPE-0000000015
DN '�s' is used by several administrators

TYPE-0000000016
The Arkoon identifier '�s' is used by several appliance

TYPE-0000000017
The min heap size must not be greater or equal to the max heap size

16.12.3. Warning Messages

WAR-0000004096
Warning: �s
Select interfaces from which the appliance will handle requests

WAR-0000004097
HTTP proxy enabled but no listening interface specified - no one will 
be able to access it.
Specify networks/hosts from which the appliance will handle requests

WAR-0000004098
HTTP proxy enabled but no authorized network specified - no one will 
be able to access it.

WAR-0000004099
IPSec is enabled but no access for IKE has been defined

WAR-0000004100
Update Proxy has been enabled but no allow_from specified

The appliance is configured as an update proxy server (antivirus, blacklists, system), but no authorized

client was configured.
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• Open the Update configuration form of the appliance configuration tab and configure the authorized

sources in the Source field.

WAR-0000004101
TCP desequencing enabled with a service which is not TCP - Ignoring

The desequencing option of TCP traffic was configured for a filtering rule specifying at least one service

that is not TCP based. The option is ignored.

WAR-0000004102
TCP maximum number of waiting connections specified with a service 
which is not TCP - Ignoring

The TCP maximum number of pending connections was configured for a filtering rule specifying at least

one service that is not TCP based. The option is ignored.

WAR-0000004103
Appliance '�s' has no IPsec ID although it uses RSA keys.

An IPsec tunnel with RSA authentication is configured with an appliance that does not have any defined

IPsec identifier.

• Configure the appliance's IPsec identifier in the IPsec ID  field in the VPN form of the Security

configuration form.

WAR-0000004104
Host '�s' has no IPsec ID although it uses RSA keys.

An IPsec tunnel with RSA authentication is configured with a host that does not have an IPsec identifier

defined.

• Configure this host's IPsec identifier by editing its characteristics.

WAR-0000004105
Use Internet Access rather than route '�1$s' to 0.0.0.0/0.

A default static route was defined. It is recommended to use an Internet Access that brings additional

functionalities: bandwidth management, anti-DoS controls, etc.

• Replace the route to 0.0.0.0/0 by a LS/router-type Internet access.

WAR-0000004106
The appliance has an Internet Access defined but no main 
Internet Access.

WAR-0000004107
Couldn't scan directory '�s', probably missing.

WAR-0000004108
Couldn't delete table '�s' from database.

WAR-0000004109
Bad category name "�s", only characters [a-z] [A-Z] [0-9] '_' are 
allowed

The name of a URL or keywords category contains unauthorized characters.

• Change the name of this category.

WAR-0000004110
Accept rule without any service selected

WAR-0000004111
Object 'xxx' defined in OtherValid for 'yyy' seems to come from 'zzz'. 
If it is the case, this will deny all trafic from 'zzz'
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If a host 'xxx' or network is directly accessible via an interface 'yyy', it must not be listed in the networks

connected to another interface ‘zzz’. Otherwise, the antispoofing rules will block all the packets emitted

by this host or network.

• Unselect object 'xxx' from the connected networks list on interface 'zzz'.

WAR-0000004112
IPsec ID '�1$s' doesn't start with '@' - it is usually a bad idea

It is recommended that the IPsec ID of a VPN server begins by the '@' character. Otherwise, the IPsec

ID must have a standard format (IP address, email address, machine name).

• Change the IPsec ID of the specific object by editing the host object or the properties of the VPN form.

WAR-0000004113
Strange RSA key size (�d bits) in object '�s'

The size of an RSA key differs from standard values: 512, 1024, 2048 bits.

• Make sure that the RSA key of the specific object is correct by editing the host object or the properties

of the VPN form.

WAR-0000004114
Rule has not been installed on any appliance

A rule is installed on an appliance if, according to its interfaces and routes, it is located between the

source and the destination or it is itself a source or destination. In such a case, no appliance was found

to apply the specified rule.

• Review the rule to make sure that this message is normal.

WAR-0000004115
Appliances '�s' and '�s' in parallel - this is not supported

WAR-0000004116
No interface...

An appliance has no interface defined.

• Configure at least one interface.

WAR-0000004117
Monitoring ISDN Internet Access will force ISDN to dial for every 
ping
Please provide an IP address instead, or configure at least one 
DNS Server.

WAR-0000004118
You provided an Internet name for the update server and no DNS server 
is defined.

An appliance's update server is configured with its name and no DNS server is specified.

WAR-0000004119
Object '�s' is local (detected on �s) but you defined an Internet 
Access to use.

WAR-0000004120
N-1 translation address �s does not belong to any known appliance's 
subnet.

A masking address is specified in the configuration of a filtering rule, but no corresponding network is

defined on the appliance. Take special care of the routing configuration on the other machines of the

network so that the return packets of this masked packet can reach the appliance.

• If needed, change the address used to translate the traffic.
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WAR-0000004121
N-1 translation and more than one Internet Access selected in rule '�s'.

In the case of an N-1 translation, you define the address that must replace the source IP address. Of

course, a similar address cannot be used if the packet has to exit via two different Internet Accesses.

• If you wish to define several Internet Accesses for this flow, you must choose Masking to automatically

use the IP address of the output interface.

WAR-0000004122
Domain name for LDAP server '�s' required in secure mode.

An LDAP authentication server using the SSL secured mode must have its domain name specified in the

configuration.

• When configuring an LDAP server, check the Secure Mode option and enter the domain name in the

corresponding Server field.

WAR-0000004123
Two bandwidth reservations/limitations are defined for the ESP 
protocol. 
Only the first one will be used.

WAR-0000004124
Can't find file '�s' on the appliance.

The customized error file '%s' of the HTTP proxy could not be found on the appliance.

• Make sure that a file with this name is present on the appliance, in the /var/http/ErrorDocument

directory.

WAR-0000004125
Reserved bandwidth is greater than 100�� for '�s'

The sum of the reserved bandwidth for an Internet access exceeds 100%, all bandwidth rules being

considered.

• If competition of several flows is a problem, review these specific bandwidth rules and lower the sum

to less than 100%.

WAR-0000004126
User password attribute missing for authentication server '�s'

An LDAP authentication server is configured so that the Fast360 appliance retrieves a signature of the

password on the server during an authentication. No LDAP attribute name was specified to find this

information in a User object.

• Edit the characteristics of this LDAP server. Specify an Object Class and Login Attribute in the Users

section of the LDAP Server configuration form.

WAR-0000004127
Limitation is lower than MTU, rule �s may block flow

WAR-0000004128
Update server type has been set to 'Appliance with same CA' but 
hostname is still support.arkoon.net

WAR-0000004129
Appliance '�s' is selected as a potential source in a rule with 
authentication. 
It will never match this rule

WAR-0000004130
Proxy POP3 disabled on 'xxx' but used in service 'yyy', check this 
isn't an error -- rule 'zzz'
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Rule 'zzz' specifies a service 'yyy' in which the redirection toward the POP3 proxy is configured, whereas

the POP3 proxy of appliance 'xxx' is not activated.

• Activate the appliance's POP3 proxy and configure its properties.

WAR-0000004131
HTTP proxy disabled on appliance '�s' but used in service '�s', check 
this isn't an error -- rule '�s'

Rule 'zzz' specifies a service 'yyy' in which the redirection toward the HTTP proxy is configured, whereas

the HTTP proxy of appliance 'xxx' is not activated.

• Activate the appliance's HTTP proxy and configure its properties.

WAR-0000004132
DNSBL feature has been enabled but no domain defined

You checked Enable Anti-relaying in the SMTP AntiRelaying configuration form in the Mail configuration

form of the appliance's configuration tab but you did not add any DNSBL domain.

• Configure at least one DNSBL domain as well as the weight that must be associated to it in the Domain

table of the AntiRelaying configuration form.

WAR-0000004133
The anti-relaying rule '�s' accepts mails from blacklisted sources

There is an anti-relaying rule calling the DNSBLs, and its action is to Accept. This is probably an error.

• Make sure that you want the rule to be permissive.

WAR-0000004134
There is no IP address to ping

The system monitoring rules for interfaces and Internet Accesses must define at least one host on which

the ping test is performed.

• Select at least one host in the corresponding table in the System Monitoring configuration form.

WAR-0000004135
HTTP proxy disabled on '�s', but monitored by Sysmon rule '�s'

The system monitoring is enabled on a disabled HTTP proxy. This is probably a mistake.

• Remove system monitoring on the HTTP proxy if the HTTP proxy is not active.

WAR-0000004136
Bad Sysmon port (�d) for HTTP proxy monitoring. Must be �d.

The HTTP proxy is configured on a port different than the port configured in the system monitoring.

WAR-0000004137
Object '�s' is reachable by '�s', but sysmon alert is not an '�s' alert

This warning corresponds to one of the following cases:

• You have defined system monitoring on the Internet Access but you have selected a host located

behind another interface than the one used by this Internet access;

• You have defined system monitoring on an Ethernet interface but you have selected a host located

behind the Internet access.

• Check the system monitoring to make sure it is coherent.
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WAR-0000004138
An '�s' interface monitoring is going to ping object '�s' reachable by 
'�s'

You have defined a system monitoring on an Ethernet interface but you have selected a host located

behind another Ethernet interface (which is not used for another Internet access).

• Check that the selected host can be reached by the monitored interface.

WAR-0000004139
VLAN ID is lower than 2. Be careful with other VLAN equipments 
administrative IDs

The VLAN 0 and 1 ID are not supported by some hardware.

• Check that the VLAN hardware used on this network supports ID 0 and 1.

WAR-0000004140
Bridged interface has non zero IP address

The address of the bridged Ethernet interface has not been forced to 0.0.0.0/0.

WAR-0000004141
'�1$s' has a non null IP address and is the primary interface of a 
bridged VLAN interface. 
Possible problems

It is recommended to configure the 0.0.0.0/0 address on the primary Ethernet interface on which is

configured a bridged VLAN interface. Otherwise, some hardware devices can refuse the appliance’s

ARP requests in specific cases.

• Configure the 0.0.0.0/0 address on the ‘%1$s’ interface.

WAR-0000004142
Port xx is defined for yy and zz

Port xx is used for different protocols in the HTTP proxy authorized destination port lists.This can cause

problems, particularly for the FTP and HTTP protocols with a FAST module.

• Check authorized destination ports on the HTTP proxy.

WAR-0000004143
Bad MIME type: "�s", all characters after ';' will be ignored

The quoted MIME type includes a semi-colon. It will be truncated; only the first part, semi-colon included,

will be taken into account.

WAR-0000004145
No anti-relaying rule allowing incoming or outgoing mails

There is no anti-relaying rule configured. No mail can then be transmitted by the appliance.

• Create rules to authorize submit and/or receipt of mails. Caution! These rules are essential to the

security of the SMTP relay.

WAR-0000004146
No mail address provided for postmaster

Alerts have been configured to be sent to the address of the postmaster which is not defined.

• Configure the postmaster's address in the General configuration form in the Mail configuration form

of the appliance's configuration tab.

WAR-0000004147
Proxy POP3 enabled on '�s' but never used in flow rules
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POP3 proxy is enabled but no filtering rule uses it.

• Configure a filtering rule that uses the POP3 proxy or disable it.

WAR-0000004148
No mail address found to send alerts

Mail alerts are configured but no destination mail address is defined.

• Add at least one mail address in the To Email Address Type table in the Alert configuration form of the

log policy being configured.

WAR-0000004149
No DNS server found to send alert mails

Mail alerts are configured but no DNS server has been defined: the appliance cannot submit mails.

• Configure at least one DNS server in the DNS form in the Network configuration form of the appliance.

WAR-0000004150
Using invalid signature �1$s: �2$s

The configuration uses a signature marked as invalid because of reason ‘%2$s’ in the IDPS signatures

base. Use this signature at your own risk: it is not supported on the appliance.

WAR-0000004151
FTP proxy enabled but no listening interface specified - no one will 
be able to access it
Select interfaces from which the appliance will handle requests

The FTP proxy is activated, but no listening interface has been specified. The FTP proxy service cannot

be used, the corresponding network port will not be reachable.

WAR-0000004152
FTP proxy enabled but no authorized network specified - no one will be 
able to access it
Specify networks/hosts from which the appliance will handle requests

The FTP proxy is activated, but no address has been authorized to access it. No implicit rule will be

created to authorize proxy access.

WAR-0000004153
On appliance '�s', FTP Proxy runs on privileged port

The FTP proxy has been activated, but it is configured to work on a privileged port (<1024). This forces it

to give it super-user rights and impacts partitioning on the appliance.

WAR-0000004154
NAT-static and PAT cannot be used simultaneously. Will use PAT only

Only the PAT functionality will work.

WAR-0000004155
https:// should not be used in category �s, use your_url:443 instead

You should put the port used after the URL, rather than specifying https.

WAR-0000004156
Speed �s won't be applied on interface

The requested speed cannot be applied to the specified interface since it is a VLAN interface.

WAR-0000004157
Domain xxx matches the hostname of this appliance -- mail to yyy won't 
be routed
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Domain routing for xxx domain has been configured, but appliance yyy is generating a conflict.

WAR-0000004158
An antispam configuration has been defined for '�s' but not enabled 
neither on SMTP relay, nor on POP3 proxy

Antispam must be activated on the relay before the configuration can be used.

WAR-0000004159
Hybrid mode threshold (�d kB) on POP3 proxy is lower than maximum size 
(�d kB) in antispam configuration. Mails with size bigger than hybrid 
mode threshold will not be handled by the antispam engine.

In hybrid mode, only messages smaller than the configured threshold are analyzed by the Antispam

engine – even if the analysis threshold (part of the Antispam configuration) is set to a larger value.

Increase the value of the hybrid mode threshold.

WAR-0000004160
Using bandwidth management on '�s' and '�s' is not recommended

If an Internet Access is defined on an interface with bandwidth management then the bandwidth

management will be applied to the Internet Access but not to the interface itself.

WAR-0000004161
Both days_bd and hours_bd parameters set for table �s

It is not possible to set the time interval between log purges in both days and hours; these two parameters

are mutually exclusive.

WWAR-0000004162
Object '�s' (�s/�d) used in whitelist or blacklist contains a private 
IP address which will be ignored

In order to ignore internal emails, you must enable the relevant option and not pass via a white list.

WAR-0000004163
Search base DN missing for LDAP server �s

The configuration object LDAP Server requires the parameter Search Base to be configured.

WAR-0000004164
Computer (NetBIOS) name missing for NT server �1$s

WAR-0000004165
Appliance '�s' has specific IP addresses on interface '�s' but is seen 
by '�s' with its primary IP address (�s) with its primary IP address
(�s)

An appliance with specific IP addresses per appliance ID in a multi-appliance system is seen by other

appliances only with its primary IP address. For example, if an appliance masks a flow, other appliances

will use the principal IP address as the source.

WAR-0000004166
�s IP address is the network broadcast address

WAR-0000004167
Object '�1$s' can be located on several interfaces (at least �2$s and 
�3$s)
Select the interfaces from which your appliance will handle requests

WAR-0000004168
SNMP agent enabled but no listening interface specified - no one will 
be able to access it

WAR-0000004169
Internal ADSL PCI configuration seems to be external

WAR-0000004171
Appliance needs at least one syslog server to enable �s log storage in 
syslog
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WAR-0000004172
FTP proxy disabled on appliance '�1$s' but used in service '�2$s', 
check this isn't an error -- rule '�3$s'

WAR-0000004173
VPN tunnel '�1$s' has multiple links with the same gateways. 
DPD is highly recommended in that case to quickly detect dead links

WAR-0000004174
Roadwarriors do not share the same IKE algorithms (at least between 
'�1$s' and '�2$s')

WAR-0000004175
At least one of the extremities ('�1$s' and '�2$s') should be an 
appliance

WAR-0000004176
At least one of the entities of the mesh should be an appliance in 
community '�1$s'

WAR-0000004177
Interfaces '�1$s' and '�2$s' are on the same IP network

WAR-0000004178
ISDN interfaces are no longer supported

WAR-0000004179
Token Ring interfaces are no longer supported

WAR-0000004180
No filters defined in '�s', rule will reject all authenticated users

WAR-0000004181
Object '�1$s' has no IPsec ID although it uses RSA keys

WAR-0000004182
There is no NT server using defined main PDC '�1$s' on appliance '�2$s'

WAR-0000004183
A relay with authentication is set in policy '�1$s', but no user login 
is set

WAR-0000004184
A relay with authentication is set in policy '�1$s', but no password 
is set

WAR-0000004185
A tagging threshold is set in policy '�1$s', but antispam quarantine 
is always called before tagging. 
The threshold value is useless.

WAR-0000004186
A quarantine threshold is set in policy '�1$s', but reject always 
occurs before quarantine. 
The threshold value is useless.

WAR-0000004187
A tagging threshold is set in policy '�1$s', but reject always occurs 
before tagging. 
The threshold value is useless.

WAR-0000004188
The host '�1$s' is static and also excluded from pool '�2$s'

WAR-0000004189
The host '�1$s' has the 'assign by DHCP' option on, but is not 
included in any DHCP pool

WAR-0000004190
The host '�1$s' has an IP address within the allocable range of the 
pool '�2$s' of the DHCP server, but is neither excluded from it, 
not configured as a static host.

WAR-0000004191
Host '�1$s' is excluded from DHCP server pool '�2$s', 
but is not included in allocable range of addresses of that pool.

WAR-0000004192
DHCP server is enabled, but no DHCP pool is configured
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WAR-0000004193
Ranges of available addresses in DHCP server pool '�1$s' only contain 
excluded addresses and static hosts.

WAR-0000004194
Interface '�1$s' has addresses included in more than one DHCP server 
pool

WAR-0000004195
With DHCP over IPsec enabled, agent-option should be set to 'append'

WAR-0000004196
Using furtive mode instead of IP 0.0.0.0/0 is more suitable for 
interface '�1$s'

WAR-0000004197
System syslog is not available on appliance with hard disk '�1$s'

WAR-0000004198
If drop action is selected for Yellow traffic then Red traffic should 
have a drop action selected too in '�1$s'

WAR-0000004199
External ADSL interface should not be named 'adsl0' ('adsl1'-'adsl-9')

WAR-0000004200
The object '�1$s' is reachable by '�2$s', but the connection ping test 
used by the Internet Access '�3$s' can't reach this object by the 
interface '�4$s'

WAR-0000004201
The fast policy '�1$s' will be not used because checksum verification 
is disabled

WAR-0000004202
Rule '�1$s' : source translation using IP address is not recommended 
n a cluster in High Performance mode ('�2$s')

WAR-0000004203
Rule '�1$s' : source translation using IP address is not recommended 
n a cluster in High Performance mode ('�2$s')

WAR-0000004204
Rule '�1$s' : destination translation using IP address is not recommended 
n a cluster in High Performance mode ('�2$s')

WAR-0000004205
"Host '�1$s' : static NAT is not recommended on a cluster in high 
erformance mode ('�2$s')

WAR-0000004206
"Network '�1$s' : static NAT is not recommended on a cluster in high 
erformance mode ('�2$s')

WAR-0000004207
System Monitoring cluster state change is activated but no system 
onitoring is configured

WAR-0000004208
It is recommended not to have a Cluster : '�1$s' and a network 0.0.0.0/0 : '�2$s' 
s extreme entities of the same VPN tunnel

WAR-0000004209
It is recommended to use a Dead Peer Detection delay value upper than 10 sec for VPN '�2$s'

WAR-0000004210
It is recommended to use a Dead Peer Detection timeout value upper than 30 sec for VPN '�2$s'

WAR-0000004211
�1$s' Interface '�2$s:�3$s', '�4$s/�5$s' is unreachable by Interface '�6$s:�7$s', '�8$s/�9$s'

WAR-0000004212
Using a traffic conditionner of type 'Arkoon token Bucket' on QoS Rule '�1$s' 
pplied to internet access '�2$s' means that this rule will not be applied to 
ngress traffic from VPN, although parameter 'Enable QoS on VPN is enabled on 
he interface used by this internet access ('�3$s')

WAR-0000004213
The '�s' category must have at least one keyword.
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WAR-0000004214
The use of the * joker is very resource-consuming. You can replace the keyword 
�1$s' with '�2$s'. We recommend you check the section about categories in the 
dministration Guide if the use of a joker is necessary.

WAR-0000004215
The SmartSSL DNS name '�s' seems to be incorrect: it should end with 
.smartssl.arkoon.net". Please specify the name provided with SmartSSL activation information.

WAR-0000004216
SmartSSL is set to use local authentication but no users are defined.

WAR-0000004217
Your configuration has some invalid references, please use previous configuration.

WAR-0000004218
In flow rule '�1$s', IPSec-ID authentication has been selected but user '�2$s' 
has no DN and no certificate.

WAR-0000004219
In flow rule '�1$s', IPSec-ID authentication has been selected but NTLM group '�2$s' 
will not be used because it has no DN.

WAR-0000004220
In applicative rule, category 'DEPRECATED_SMART_WEB_name' is deprecated and should not be used.

WAR-0000004221
The flow rule '�1$s' is expired.

WAR-0000004222
The flow rule '�1$s' has authentication but is not installed automatically which can lead to security 
issues with authentication trust between appliances.

16.12.4. Information Messages

INF-0000008192
Info: �s

INF-0000008193
VPN type has been changed to OnDemand between xxx and RoadWarrior yyy

A permanent-type tunnel, defined between appliance 'xxx' and a nomad 'yyy', was changed for an on-

request tunnel. Indeed, only the “on-request” type is possible in this case. An appliance cannot initiate

a VPN negotiation with a remote IP address it does not know.

INF-0000008194
Signature �1$s is disabled (null score), it won't be loaded

A local IDPS signature %1$s with a zero score will not be loaded.

INF-0000008195
Local signature �1$s is disabled (null score), it won't be loaded

A local IDPS signature %1$s with a zero score will not be loaded.

INF-0000008196
Radius authentication in Challenge/Response mode may be problematic 
with some browsers

RADIUS authentication is enabled on the HTTP proxy and is known not to work with some browsers.

INF-0000008197
Four bonding interfaces are enabled on appliance by default.

By default, an appliance has 4 bonding interfaces. To increase this number, you must modify the

parameter max_bonds in the file /etc/modules.conf

INF-0000008198 
Dynamic routing interfaces must accept multicast packets
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If the configuration requires dynamic routing to be enabled, the interfaces on which OSPF and RIP will

be used must authorize multicast traffic.

INF-0000008199
Heartbeat HA interfaces must accept broadcast packets

INF-0000008200
The appliance �1$s contains Arkoon identifier not initialised

INF-0000008201
The flow rules to use external PKI are not automatically created, you 
have to do this

INF-0000008202
A good practice consists in setting 'vrrp-advertise-timer' between 1 
and 5

INF-0000008203
A good practice consists in setting 'vrrp-preempt-timer' between 1 
and 10

INF-0000008204
A good practice consists in setting 'vrrp-timer-gndp' between 1 
and 10

INF-0000008205
The node '�1$s' contains Node identifier not initialised

INF-0000008206
The link monitoring protocol VRRP is disabled on interface '�1$s' (�2$s)

INF-0000008207
All addresses' network default values have been modified

INF-0000008208
The flow rule '�s' will allow akauth connections (TCP/1755) for everyone

INF-0000008209
The flow rule '�s' is not yet valid

INF-0000008210
The appliance '�s' uses schedules or periods in flow rules but has no NTP server specified.

16.12.5. Appliance Synchronization Messages

These messages are displayed after a configuration has been compared with its appliance’s embedded

parameters and before these parameters are synchronized into the configuration.

HWD-0000065536
Information: �s

HWD-0000065537
The IDPS database will be imported into your configuration

HWD-0000065538
The IDPS database will be updated from your appliances

HWD-0000065539
A new appliance (�s) will be added

HWD-0000065540
An appliance (�s) will be updated

HWD-0000065541
Factory categories will be updated

HWD-0000065542
The services database will be updated from your appliances

HWD-0000065543
The FAST policies database will be updated from your appliances
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16.13. Alerts

16.13.1.  Introduction

Objective

This section introduces the alerts generated by the Fast360 appliance. These alerts can be broadcast

in four different ways:

• In the Alerts window of  Arkoon Monitoring  (default configuration).

• By syslog (if configured in the Alert configuration form of a log policy in  Arkoon Manager ).

• By email (if configured in the Alert configuration form of a log policy in  Arkoon Manager ).

• By SNMP traps (if configured in the Alert configuration form of a log policy in  Arkoon Manager ).

Alerts Levels

Each alert has an associated level that corresponds to its severity.

There are four alert levels:

• None level: This level is simply for information purposes and does not imply any abnormal behavior.

• Low level: This level corresponds to events that may possibly affect security.

• Intermediate level: This level corresponds to events that warrant closer inspection by the

administrator.

• High level: This level corresponds to problems that need to be quickly diagnosed; administrator action

will probably be required.

Format of this Section

This section lists the alerts, classified by level. For each alert, you will find:

• Its name, as specified in  Arkoon Manager

• Its meaning

• The action to take, if required

16.13.2.  Alert Description

None Level

Internet Access up

The Internet access is operational. The Description column indicates the specific Internet access and

specifies the interface used for this access or the IP address of the gateway.
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 IKE Alert

The none-level IKE alert indicates that a VPN link is mounted. The Description column indicates the IP

address of the remote VPN server as well as the name given to the group of VPN tunnels in the Fast360

appliance's configuration.

Arkoon down

The Fast360 appliance has been switched off by one of the following means:

• A stop or restart via  Arkoon Monitoring

• A stop or restart via the command line

• A stop through a short press on the appliance’s Power key

Arkoon up

The Fast360 appliance has been powered up (manually or following a voluntary restart).

Configuration installed

This message indicates that a new configuration is installed. The Description column indicates the

name of the installed configuration as well as the backup file name where the configuration is

copied. All subsequently installed configurations are copied into the /var/config.backup directory.

The Administrator column contains the certificate or the login of the Administrator who installed the

configuration. In the case of a multi-appliances topology, you see the AMC server's certificate.

Administration connection

This indicates a successful administration connection. The Description column specifies the type of

administration connection (SSH, Monitoring or multi-appliances), the IP address and the source port of

the Administrator's workstation. The Administrator column indicates the login used (in the case of an

SSH connection) or the certificate used (in the case of the Monitoring).

New certificate created

A new certificate has been created. The Description column indicates the name of the new certificate.

The Administrator column specifies the certificate (modified via  Arkoon Monitoring ) or the login

(modified in terminal mode) of the Administrator who performed the operation.

Date/time changed

The Fast360 appliance's date has been modified. The Administrator column specifies the certificate

(modified via  Arkoon Monitoring ) or the login (modified in terminal mode) of the Administrator who made

the modification.

Denial of service detected

This alert is generated when the previously detected denial of service (high-level “Denial of service

detected” alert) is finished. The Description column indicates the name of the specific Internet access,

the specific type of packets (ICMP or TCP-SYN) and the number of denied packets during the attack.

New IPsec tunnel established

This alert indicates that a new IPsec tunnel has been established. The alert is raised when a tunnel is

first negotiated (re-negotiation without collapse of the tunnel generates a separate alert). The networks

negotiated in the tunnel appear in the description and allow the use of virtual IP addresses obtained

through DHCP. The particular case of a tunnel established for DHCPover-IPsec negotiation is specifically
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identified. The description of the group of VPN tunnels given in the alert corresponds to the object

description in the configuration or, by default, to its name. The algorithms negotiated by the IPsec SA are

also present. The use of a port allows NAT-Traversal to be detected.

Network traffic unblocked

The network traffic was previously blocked for one of the following reasons: logs queue overloaded,

kernel queue overloaded or disk full. The situation has returned to normal and the network traffic is no

longer blocked.

Interface down

The Ethernet interface has been disconnected. This operation could have been automatic (installation of

a configuration modifying the interfaces), manual (via the  Arkoon Monitoring  Interfaces window or on

the command line) or caused by the Fast360 appliance being stopped.

Interface up

The Ethernet interface has been connected. This operation could have been automatic (installation of a

configuration modifying the interfaces), manual (via the  Arkoon Monitoring  Interfaces window or on the

command line) or caused by the Fast360 appliance being started.

Interface disconnected

The interface (ADSL in PPPoA) has been disconnected. The Description column gives the name of the

specific interface, the IP address of this interface and the gateway IP address at the ISP.

Interface reconnected

The interface (ADSL in PPPoA) has been (re)connected. The Description column gives the name of the

specific interface, the IP address of this interface and the gateway IP address at the ISP.

“Admin from” has changed

The Admin from parameter has been changed via the Configuration menu of the  minarkconf  program.

The Description column indicates the new value of this parameter. The Administrator column specifies

the login of the Administrator who made the change.

Upgrade

This alert is concerned with the download of updates (antivirus, blacklists, system patches). The

Description column indicates the specific module by update (SOPHOS, BLACKLISTS or ARK-PATCHES).

A first alert indicates that the download was successful; a second alert indicates that the updates were

taken into account.

IPsec SA successfully negotiated

This alert indicates that an IPsec SA has been successfully negotiated. The description of the group of

VPN tunnels given in the alert corresponds to the object description in the configuration or, by default, to

its name. The field username gives the login of the user object, as indicated in the configuration (which

therefore requires a tunnel that uses objects of the type user).

Log flush via Arkoon Monitoring

This alert is generated when one of the logs is manually flushed via  Arkoon Monitoring . The Description

column indicates the name of the specific database. The Administrator column specifies the certificate of

the Administrator who performed the operation. This alert indicates that the flush was correctly executed.

Log flush on reached threshold
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This alert is only relevant to the case of a Fast360 appliance without a hard disk. When the logs take up

to 93% of the disk space, 75% of them are flushed (percentage configurable in  Arkoon Manager ). This

alert indicates that the flush was successful and the Description column contains the name of the log

that was flushed.

Already established IPSec tunnel re-negotiated

This alert indicates that an already established IPsec tunnel has been re-negotiated. This alert is only

raised when a tunnel is re-negotiated (the initial negotiation generates a separate alert). The alert carries

the same information as the alert raised when a new IPsec tunnel is established.

Certificate revoked

A certificate was revoked. The Description column contains the name of the certificate. The

Administrator column specifies the certificate (modified via  Arkoon Monitoring ) or the login (modified

in terminal mode) of the Administrator who performed the operation.

Scheduled log flush

The automatic backup and flush of the database were successful. They were compliant with the visible

configuration in the Alerts and logs Archiving folder of  Arkoon Manager . The Description column

contains the names of the logs referred to by this alert.

• If the backup was configured, you will be able to download the files from  Arkoon Monitoring : they are

available from the Logs Backup Infos tab of the General Info window.

Service started

One of the aklogd or mysqld services has been started. The Description column indicates the particular

service.

Service stopped

One of the aklogd or mysqld services has been stopped. The Description column indicates the particular

service.

An IPsec tunnel has collapsed

This alert is raised when an IPsec tunnel collapses. It is not raised when an IPsec SA is removed

or expires and another SA corresponding to the same tunnel is negotiated. The alert takes the same

information as for the establishment of a new IPsec tunnel. The level of the alert depends on the reason

for the alert, which can be any of the following:

• Latest IPsec SA has expired (Intermediate)

• Considered as dead by 'Dead Peer Detection' (Intermediate)

• Delete notification received (Information)

• IPsec service is stopped (Information)

• Terminated by administrator (Information)

• Peer now uses another IP address (Information)

• Removed by administrator (Information)

user added or removed with minarkconf

A user has been created or removed via the Users menu of the  minarkconf  program. The Description

column contains the user's name, as well as their login in the case of user creation. The Administrator

column contains the login of the Administrator who performed the operation.
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Low Level

Warning on log queue

The logs queue is 50% busy.

• Consult the IP Logs to find out which flows are generating so many logs. Consequently, modify the

logging filtering rules or the anti-DoS configuration.

Warning on  /var

The /var partition is 75% busy.

• Consult the Disk tab of the State of the Fast360 appliance window to view the general and detailed

occupancy of the /var partition. If the database takes a lot of space, export or delete all or part of

the logs.

Warning on /config_card

The /config_card partition is 75% busy.

• Consult the Disk tab of the State of the Fast360 appliance window to view the occupancy of the /

config_ card partition.

Encrypted file in mail

The email contains an encrypted file, and therefore cannot be analyzed by the antivirus mechanism.

The email will be processed according to the options configured in the Arkoon Manager :

• If the options EncryptedFile and Accept are checked, the email will be transmitted.

• If the options EncryptedFile and Quarantine are checked, the email will be quarantined.

• If the options EncryptedFile and Reject and RemoveDeniedFromServer are checked, the email will be

deleted.

Note

If the mail was quarantined, open the Quarantine window of  Arkoon Monitoring  in order to

choose how to process the email.

Bad SPI

The packet contains a bad SPI (Security Parameters Index). This means that the packet does not go

through the correct VPN tunnel, but goes through a VPN when it should not (or the opposite case).

• Check the cause of the blocking in the Reason and IP Logs Description columns. Please refer to

Section 16.8.1, “IP” for more details.

• There are two possible cases: either the tunnel is not mounted, or the filtering rule that takes the packet

into account does not make it go through this tunnel. Look in the VPN window to determine whether

the tunnel is mounted.

• If the tunnel is not mounted, open the System logs to determine why the tunnel is not mounting.

• If the tunnel is mounted, open  Arkoon Manager  and check the configuration:

• Either the packet has not been taken into account by the correct rule; in such a case, review the

order of the rules and/or their definition.

• Or the packet follows the rule created for this purpose, but the encryption was incorrectly

configured.
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New mail in quarantine

A new email has been quarantined.

• Open the Quarantine window in  Arkoon Monitoring  to see this particular email and the reason for

the quarantine.

Analyze error in mail

The antivirus analysis could not be applied. The email will be processed according to the options

configured in the  Arkoon Manager :

• If the options NonAnalysableFile and Accept are checked, the email will be transmitted.

• If the options NonAnalysableFile and Quarantine are checked, the email will be quarantined.

• If the options EncryptedFile and Reject and RemoveDeniedFromServer are checked, the email will be

deleted.

• If the email has been quarantined, open the Quarantine window of  Arkoon Monitoring  in order to

choose how to process the email.

DHCP Lease renewed for < IP @> : < MAC @>

This alert is generate every time a lease is renewed.

DHCP Lease assigned to < IP @> : < MAC @>

This alert is generated for every lease ACKed.

DHCP Request from < IP @> : < MAC @>

Logs every DHCP request, with source IP (if any)/MAC address

DHCP Offer to < IP @> : < MAC @>

Logs every DHCP offer from the server, with offered IP/MAC address.

Intermediate Level

IKE alert

The intermediate-level IKE alert indicates a problem during VPN negotiation. The Description column

provides details on the nature of this problem.

• For more details on VPN negotiation, open the system logs and read the messages of the pluto daemon.

Warning on log queue

The logs queue is 75% busy.

• Consult the IP Logs to find out which flows are generating so many logs. Modify consequently the

logging filtering rules or the anti-DoS configuration.

Warning on /var

The /var partition is 90% busy.

• Consult the Disk tab of the State of the Fast360 appliance window to view the general and detailed

occupancy of the /var partition. If the database takes a lot of space, export or delete all or part of the

logs.
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Warning on /config_card

The /config_card partition is 90% busy.

• Consult the Disk tab of the State of the Fast360 appliance window to view the occupancy of the /

config_card partition.

Authentication failure

A user's authentication failed during authentication on a filtering rule. The Description column provides

the name of the particular user.

Failure in negotiating on ISAKMP/IPsec SA

This alert indicates an error in negotiating an ISAKMP or IPsec SA. The error codes in the Description

column correspond to the standard notification types defined in RFC2408;

Example 16.2. RFC2408 Error Codes

NO_PROPOSAL_CHOSEN
INVALID_KEY_INFORMATION
BAD_PROPOSAL_SYNTAX

Database purged

There was a problem during the manual flush of one of the logs via  Arkoon Monitoring . The Description

column indicates the name of the particular database. The Administrator column specifies the certificate

of the Administrator who performed the operation.

• Open the System logs for the details of this problem.

Mail denied by applicative rule

An email has been denied by an SMTP inter-application rule requesting a quarantine.

• Open the Logs of the SMTP relay; the Reason column provides the name of the inter-application rule

that blocked the email.

Packet blocked by filter

The packet has been rejected by a filtering rule.

• Please refer to the IP logs to find out which filtering rule blocked or rejected the packet. If you do not

see any log corresponding to the blocked packet, this means that the packet was processed by a rule

that rejects but does not log. This can be:

• A specific rule written by the Administrator

• An implicit filtering rule generated by the option Ignore broadcast traffic.

• An implicit filtering rule generated if, in the antispoofing protection, you uncheck Log Input (logs

the packets intended for the Fast360 appliance) or Log Forward (logs the packets going through the

Fast360 appliance).

• An ICMP policy that does not log this code nor this type of ICMP message.

Unsequenced packet

An unsequenced TCP packet has been received.

• Please refer to the IP logs for details of the sequence numbers: check the TCP Seq and NoSeq awaited

columns, in particular. There was probably a routing problem: the up flow goes through the Fast360

appliance but not the down flow (or the opposite case).
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Log flush on reached threshold

This alert is only relevant to the case of a Fast360 appliance without a hard disk. When the logs take up

to 93% of the disk space, 75% of them are flushed (percentage configurable in  Arkoon Manager ). This

alert indicates that the flush was unsuccessful and the Description column provides the name of the log

that should be flushed.

• Please refer to the system logs for more information on this problem.

  Scheduled log flush 

The automatic backup and flush of the database were unsuccessful. The Description column provides

the name of the specific logs.

• Open the System logs for more information on this problem.

Attempt to establish on unknown IPsec SA

This alert indicates that an attempt has been made to establish an unknown IPsec SA. The IPsec SA

cannot be established since there is no corresponding tunnel (in terms of IP, mask and ultimately protocol/

port). The field phase2-requested-tunnel shows the requested tunnel in the same format as the topology

of a VPN tunnel (that can be viewed through  Arkoon Monitoring , for example).

An IPsec tunnel has collapsed

This alert is raised when an IPsec tunnel collapses. It is not raised when an IPsec SA is removed

or expires and another SA corresponding to the same tunnel is negotiated. The alert takes the same

information as for the establishment of a new IPsec tunnel.

The level of the alert depends on the reason for the alert, which can be any of the following:

• Latest IPsec SA has expired (Intermediate)

• Considered as dead by 'Dead Peer Detection' (Intermediate)

• Delete notification received (Information)

• IPsec service is stopped (Information)

• Terminated by administrator (Information)

• Peer now uses another IP address (Information)

• Removed by administrator (Information)

Unauthorized IPsec ID used

This alert indicates that an unauthorized IPsec ID has been used. The ISAKMP SA cannot be established

since there is no defined tunnel which corresponds to the IPsec ID used by the remote machine. In the

case in which LDAP groups are used, this is because the DN of the certificate does not correspond to

any defined group. This alert is also raised when an IP user attempts to connect using either a shared

secret or a certificate for which no connection is defined.

Application protocol violation

A FAST module detected a protocol violation.

• Please refer to the IP Logs Description column for more details on the protocol violation. If the flow is

blocked because of a specific command, you can add it in the FAST module's options for this service.

"traffic conditioner name" on "interface name" interface 
is dropping packets
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This alert is generated for TRTCM traffic conditioners on packet dropping.

"traffic conditioner name" on "interface name" interface 
is queuing packets

This alert is generated for TC (Arkoon) traffic conditioners on packet queuing.

"traffic conditioner name" on "interface name" interface 
is dropping packets

This alert is generated for TC (Arkoon) traffic conditioners on packet dropping.

"class name" on "interface name" interface is borrowing 
bandwidth from "borrowed class name"

This alert is generated for taildropped HTB or CBQ classes on class borrowing.

"class name" on "interface name" interface is dropping 
packets

This alert is generated for taildropped HTB or CBQ classes on class dropping.

"class name" on "interface name" interface is borrowing 
bandwidth to "borrowed class name"

This alert is generated for RED dropped HTB or CBQ classes on class borrowing.

"class name" on "interface name" interface is probably 
dropping packets at "probability" �

This alert is generated for RED dropped HTB or CBQ classes on class probably dropping.

"class name" on "interface name" interface is dropping 
packets

This alert is generated for RED dropped HTB or CBQ classes on class dropping.

Static host < MAC @> requested another IP address 
< IP @> 

This alert is generated when a static hosts requests an address different from the configured one.

High Level

Internet access down

Internet access is not available. The Description column indicates the specific Internet access that

provides the interface used for this access.

• For more information on the nature of the problem, open the System logs window.

IKE alert

The high-level IKE alert indicates an authentication failure during VPN negotiation. The Description

column provides details of the nature of this problem.

• For more details on VPN negotiation, open the system logs and read the messages of the pluto daemon.

System monitoring alert

This alert indicates that the level of a system monitoring criterion has been modified. The Description

column provides the criterion name, as defined in  Arkoon Manager , and indicates the modification of

its state. The value 0 indicates that the monitored element is failing and the value 1 indicates normal

operation.
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Arkoon up

The Fast360 appliance underwent an undesired restart.

• Open the System logs to get information on the cause of this undesired restart.

Warning on log queue

The logs queue is 95% busy. All subsequent flows are blocked, except the administration flows. Action

must be taken so that the logs queue is no longer overloaded and standard traffic is reinstated.

• Consult the IP Logs to find out which flows are generating so many logs. Consequently, modify the

logging filtering rules or the anti-DoS configuration. Contact Arkoon support, if needed.

Warning on /var

The /var partition is 95% busy. All subsequent flows are blocked, except the administration flows. An

action must be taken so that the /var partition is no longer overloaded and standard traffic is reinstated.

• Consult the Disk tab of the State of the Fast360 appliance window to view the general and detailed

occupancy of the /var partition. If the database takes a lot of space, export or delete all or part of the

logs. For other cases, please contact Arkoon support.

Warning on /config_card

The /config_card partition is 99% busy.

• Consult the Disk tab of the State of the Fast360 appliance window to view the general and detailed

occupancy of the /config_card partition. Please contact Arkoon support.

Network traffic blocked due to Aklogd

All flows are blocked, except the administration flows, due to one of the following reasons: disk full (the

/var partition is more than 95% busy), logs queue overloaded (more than 95% used) or kernel queue

overloaded. The Description field shows which of these three reasons is responsible for blocking the

traffic.

• In the case where the blocking is related to disk space use, consult the Disk tab of the State of the

Fast360 appliance window to view the general and detailed occupancy of the /var partition. If the

database takes a lot of space, export or delete all or part of the logs. For other cases, please contact

Arkoon support

Administration connection

An administration connection attempt failed. The Description column specifies the type of administration

connection (SSH, Manager, Monitoring or akslave), the source IP address and the source port, as well

as the cause of the failure.

Example 16.3. Administration Connection Attempt Failed

SSH:     1.1.1.1 :1024 - Authentication failed (root)
Manager: 1.1.1.1 :1025 - Certificate refused : bad certificate

Denial of service detected

This alert is generated when a denial of service is detected. This happens when the protection against

denials of service is activated on an Internet access and the maximum number of TCP-SYN packets or

maximum number of ICMP packets is exceeded. A none-level  Denial of service detected  alert

is generated when the attack comes to an end.
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HA host active

A host swap has occurred: the HA Fast360 appliance that was passive has become active. The

Description column indicates the complete name (host name) of this HA Fast360 appliance.

HA host inactive

A host swap has occurred: the HA Fast360 appliance that was active has become passive. The

Description column indicates the complete name (host name) of this HA Fast360 appliance.

Interface up

The Ethernet interface could not be connected. The Description column provides the name of the

interface and describes the problem.

• Open the System logs for more details.

HA link down

One of the links which maintains communication between the two HA Fast360 appliances (called the

heartbeat) has been disconnected. The Description column provides the name of the particular interface

(Ethernet interface or serial port).

HA link up

One of the links which maintains communication between the two HA Fast360 appliances (called the

heartbeat) has been connected. The Description column provides the name of the particular interface

(Ethernet interface or serial port).

Bad packet

The received packet is faulty: a problem was detected at level 3 or level 4. It can be a Land attack or an

ICMP packet that cannot be related to a connection.

• Please refer to the IP logs to find out why the packet was rejected. Look in the Description column,

in particular.

Upgrade

There was a problem while downloading updates (antivirus, blacklists, system patches).

The Description column may provide more information on the nature of this problem:

• - SSLConnecte(support.arkoon.net, 1752) failed: connection timed out can indicate an

Internet access problem

• SSLConnecte(support.arkoon.net, 1752) failed: gethostbyname() error  means there was

a problem accessing the DNS

Note

If needed, consult the system logs to get additional information. If this is a problem accessing

Internet or the DNS, make sure that the access is operational again. In any cases, relaunch the

update manually from the Update window of  Arkoon Monitoring .

Arkoon OS patch

A system patch has been installed or uninstalled. The Description column indicates the former version

as well as the new version.

Shared secret authentication problem
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This alert indicates that there was a problem decoding an ISAKMP packet encoded using a shared secret.

Bad use of a shared secret is the most probable explanation, but there are other possible causes (such

as corruption of the packet) which cannot be determined.

Quarantine full

The space dedicated to quarantine and its archives are full. New files that must be quarantined will not

be stored and will be deleted.

• Delete some quarantined messages via  Arkoon Monitoring . You can also flush the archives via  Arkoon

Monitoring  or delete a part of the archives on the command line. Finally, you can change the amount

of space allocated to quarantine and the archives in the Mail configuration form General option of the

Fast360 appliance's configuration tab in  Arkoon Manager .

Portscan detected

A portscan attempt has been detected. The portscan detection is based on the following conditions:

• At least three packets were rejected and logged (the packets rejected by non-logging rules will not

generate any alerts)

• The packets were received in a time interval shorter than five minutes

• They came from the same IP source

• They were intended for at least three different pairs (IP, port)

The alert frequency for the same IP source is limited to one every five minutes. After this time, any new

packet coming from the IP source generates an alert. This is repeated every five minutes.

• The Description column shows the source IP address that triggered the portscan. Please refer to the

IP logs to find out which packets caused this alert.

Service restarted

A service has been restarted for no apparent reason. The Description column indicates the cause of this

restart.

Rejected certificate used

This alert indicates that the ISAKMP SA cannot be established because the certificate used has been

rejected (based on information from the CRL). The rejection of a certificate prevents it from being used to

establish or re-negotiate a VPN tunnel, but does not cause a previously established tunnel to be removed.

License violation

The Fast360 appliance does not have a license which allows it to let this packet through. In most cases,

the license has not been installed, the primary license has not been retrieved by the secondary or the

license has expired.

• Connect in terminal mode and launch  minarkconf .

• If you did not install a license, please refer to the Commissioning Guide to generate a license request

and install the license.

• If you have installed a license, select View license in the License menu to make sure that it is installed.

If it is not installed, redo the installation.

• If this is a secondary Fast360 appliance, make sure that it retrieved the license of the primary by typing

the command /usr/akgetlicense/algetlicense infos. If this is not the case, restart the service
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'akgetlicense' (via  Arkoon Monitoring ) so that it tries to reconnect to the primary. Consult the system

logs for more details, if required.

Virus detected

A virus has been detected by one of the Fast360 appliance's proxies (HTTP, SMTP or transparent POP3

proxy). The Description column provides details: name of the proxy that detected the virus, name of

the virus, possible details about the connection. The processing of the infected data is executed in

compliance with the Fast360 appliance's configuration.

• In the case of the HTTP proxy, its logs show the query with the infected data: this is the one with result

code 494.

• In the case of the SMTP or POP3 proxy, the infected messages are shown in the quarantine part of

Arkoon Monitoring , if quarantine was configured.

No more IP address available

A client requests an IP address but all available addresses are currently being used.

Malformed DHCP request

Unsuitable DHCP request received.

Received unmatched DHCP reply

When a reply received from the server does not match any previously sent request.

Malformed DHCP request

Unsuitable DHCP request received.

Malformed DHCP reply

Unsuitable DHCP reply received.

Node state change from �s to �s

Indicates a node state change. State can be “Working”, “Standby”, “Disconnected”.

Data synchronisation failed

Data synchronisation lost between two nodes.

16.13.3. Appendix

This table lists the alerts names in English and French.
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Table 16.3. Alerts names (English-French )

French name in Arkoon

Monitoring

English name in Arkoon

Monitoring

SNMP trap name

Accès Internet désactivé Internet Access down akOutconnDown

Accès Internet activé Accès Internet up akOutconnUp

Alerte IKE IKE alert akIkeAlert

Arkoon down Arkoon down akArkoon Down

Alerte de surveillance

système

System monitoring alert akSysmon

Arkoon up Arkoon up akArkoon Up

Avertissement sur/

config_card

Warning on /config_card akConfigWarning

Avertissement sur/var Warning on /var akVarWarning

Avertissement sur la file

d’attente des journaux

Warning on log queue akAklogWarning

Blocage du trafic réseau

sur Aklogd

Network trafic blocked

due to Aklogd

akAklogTrafficBlocked

Configuration installée Configuration installed akConfigInstalled

Connexion

d’administration

Administration

connection

akAdminConnection

Définition d’un nouveau

certificat

New certificate created akNewCert

Date/heure modifiée Date/time changed akDateHourChanged

Déni de service détecté Denial of service

detected

akDosDetection

Echec d’authentification Authentication failure akAuthenticationFailed

Echec de négociation

d'une SA ISAKMP/IPsec

Failure in negotiating an

ISAKMP/IPsec SA

xxx

Etablissement d'un

nouveau tunnel IPsec

New IPsec tunnel

established

xxx

Fichier chiffré dans le

mail

Encrypted file in mail akEncryptedMail

Fin de blocage du trafic

réseau

Network traffic

unblocked

akAklogTrafficUnblocked

Hôte HA actif HA host active akHaActive

Hôte HA inactif HA host inactive akHaPassive

Interface down Interface down akIfDown

Interface up Interface up akIfUp

Interface déconnectée Interface disconnected akIfDisconnected

Interface reconnectée Interface reconnected akIfReconnected

akMailDeniedByRule
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French name in Arkoon

Monitoring

English name in Arkoon

Monitoring

SNMP trap name

La règle applicative a

refusé le mail

Mail denied by

applicative rule

Le paramètre « Admin

from » a été modifié

"dmin from" has changed akAdminFromChanged

Lien HA down HA link down akHaIfDown

Lien HA up HA link up akHaIfUp

Mauvais SPI Bad SPI akBadSPI

Mauvais paquet Bad packet akBadPacket

Mise à jour Upgrade akUpgrade

Négociation réussie

d'une SA IPsec

IPsec SA successfully

negotiated

xxx

Nouveau mail dans la

quarantaine

New mail in quarantine akMailInQuarantine

Paquet bloqué par le filtre Packet blocked by filter akPortAttack

Paquet déséquencé Unsequenced packet akUnseqPacket

Correctif (patch) du

système Arkoon

Arkoon OS patch akKernelPatch

Problème

d'authentification par

secret partagé

Shared secret

authentication problem

xxx

Problème lors de

l’analyse du mail

Analyze error in mail akMailAnalyzeError

Quarantaine pleine Quarantine full akQuarantineFull

Renégociation d'un

tunnel IPsec établi

Already established

IPsec tunnel re-

negotiated

xxx

Révocation d’un certificat Certificate revoked akRevokeCert

Purge d’un journal via

Arkoon Monitoring

Log flush via Arkoon

Monitoring

akTableFlushed

Purge des journaux sur

seuil atteint

Log flush on reached

threshold

akDbClear

Purge planifiée des

journaux

Scheduled log flush akDbPurge

Scan de port Portscan detected akPortScan

Service démarré Service started akServiceStarted

Service redémarré Service restarted akServiceRestarted

Service arrêté Service stopped akServiceStopped

Tentative d'établissement

d'une SA IPsec inconnue

Attempt to establish an

unknown IPsec SA

xxx

Tombé d'un tunnel IPsec An IPsec tunnel has

collapsed

xxx
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French name in Arkoon

Monitoring

English name in Arkoon

Monitoring

SNMP trap name

Un utilisateur a été

créé ou supprimé avec

minarkconf

User added or removed

with  minarkconf

akUserAddedRemoved

Utilisation d'un certificat

révoqué

Rejected certificate used xxx

Utilisation d'un ID IPsec

non autorisé

Unauthorized IPsec ID

used

xxx

Violation de licence License violation akNoLicense

Violation de protocole

applicatif

Application protocol

violation

akAppViolation

Virus détecté Virus detected akVirus
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Chapter 17. Advanced Network Topologies

 This chapter describes how to configure the Fast360 appliance for advanced network topologies

including operating in bridge mode, in VLAN architectures, as an IP router, and managing bandwidth

and so Quality of Service.

17.1. Bridge Mode Configuration

This section describes how to configure the Fast360 appliance for bridge mode operation. It covers:

• The mechanisms and characteristics of the bridge mode on the Fast360 appliance ;

• The differences between “furtive” and “non-furtive” modes ;

• Configuring bridge mode on the Fast360 appliance.

17.1.1. Why Use Bridge Mode?

Using a Fast360 appliance in bridge mode facilitates integration of the appliance into existing network

architectures. In bridge mode, the Fast360 interfaces which have been configured for bridging are seen

as layer 2 bridge interfaces by network traffic. Pre-existing IP network and subnet configurations on

network devices need not be changed even if communications pass through the Fast360 appliance.

This approach can be useful in simple installations where the Fast360 appliance is installed on a LAN

between client devices and an Internet router. Using bridge mode, there is no need to modify the IP

configuration of the clients or the router.

Note

It is not possible to route packets coming from an interface not configured for bridging toward

a bridge interface.

Figure 17.1. Simple LAN with Fast360 Appliance

Bridge mode may also be used to analyze and control traffic between LAN segments, once again without

the need to modify IP addressing.

17.1.2. The Bridge Interface

To configure bridge mode on the Fast360 appliance, configure a bridge interface as one of the interfaces

of the device, then add physical interfaces (eth0, eth1, etc.) to the bridge interface. You can also configure

VLANs as part of the bridge (see Section 17.2, “VLAN Topologies” for VLAN bridging).

As far as network traffic is concerned, the Fast360 appliance is merely a layer 2 bridge. Internally,

however, the bridge interface transparently bridges all traffic into the Fast360 appliance for filtering and

analysis.
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There are two types of bridge interface, furtive and non-furtive. In furtive mode the bridge interface has

no IP address, making it essentially invisible to other network devices, but restricting its functionality.

In non-furtive mode most of the security features of the Fast360 appliance are supported. The following

sections detail supported features and how to configure furtive and non-furtive bridge mode operation.

Note

Multicast traffic can pass through a furtive bridge and though a non-furtive bridge.

Important

If an ethX interface is in bridge mode, it is no longer possible to modify any parameter of the ethX

interface in Arkoon Manager (unless you remove the interface from the bridge). We recommend

thus to configure advanced parameters before associating the interface to the bridge.

17.1.3. Bridge Interface - Furtive Mode

In furtive mode, the bridge interface does not have an IP address. While this makes the device essentially

invisible to devices connected to the bridged interfaces, it has some restrictions:

• Because there is no IP address, devices connected to networks which form part of the bridge cannot

communicate with the appliance. In particular, this means that management consoles cannot be

placed on bridged networks and you must insure that at least one physical interface is not bridged,

for management connections.

• Proxies, transparent or not, are not supported. This means traffic over the bridge cannot be analyzed

by Fast360 content analysis features (antivirus, antispam, web/URL filtering, etc.)

• VPNs are not supported.

• Interface-based port address translation and IP masquerading with no IP address is not supported.

Note

The Fast360 appliance in furtive bridge mode, while invisible to IP and higher level protocols,

can still be detected by the MAC addresses of the bridged interfaces in a layer 2 analysis of the

network.

17.1.4. Configuring Furtive Bridging

1. In the Network objects explorer view, expand the Fast360 appliance tree and right-click on the

Interfaces folder.

2. From the displayed menu, select New > Bridge Interface. The bridge interface configuration tab is

displayed on the right.

3. Select the Interface configuration form and then in the Bridged interfaces field, drag and drop the

interfaces that are to be bridged together.

Note

Bridged interfaces do not have an IP address. If you add an interface for which an IP address

has been configured, the address will be deleted from its configuration.

4. Select the Advanced form:

Note

Ignore broadcast traffic and Ignore multicast traffic options are activated by default during

the configuration of a new interface.

a. Leave the Ignore broadcast traffic option checked to prevent broadcast traffic from the

local network being forwarded by this interface.
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b. Leave the Ignore multicast traffic checked to prevent this interface from listening for

multicast traffic. Unselect this option if this interface needs to listen for multicast traffic

(for example, for dynamic routing protocols) and add a corresponding filtering rule. To add

a filtering rule, refer to Chapter 8, Basic Traffic Filtering Using Filtering Rules.

c. If the topology requires, check the Custom MTU option modify the MTU value (1500 by

default).

Routing Traffic to Furtive Bridged Networks

As the bridge interface in furtive bridging does not have an IP address, you need to configure a static

route between the bridged network and the bridge interface. This will allow the Fast360 appliance to

manage fragmented packets and to forward TCP RST commands when necessary.

To configure a static route on the bridge interface:

1. In the Network objects explorer view, double-click on the Fast360 appliance icon. The Fast360

appliance configuration tab is displayed on the right.

2. Select the Network configuration form.

3. Select the Static Routes option. The Static Routes table is displayed on the right.

4. Right-click in the blank section of the table.

5. From the displayed menu, select New > Static Route. The Static Route dialog box is displayed and

the entry is displayed in the table.

6. Enter a name and short description of the route in the corresponding fields.

7. In the Destination field, drag and drop the destination bridged host or network.

8. In the Gateway field, drag and drop the bridge interface.

17.1.5. Bridge Interface - Non-furtive Mode

A bridge interface in non-furtive mode has its own IP address and supports most of the functions available

on non-bridged interfaces. However, antispoofing is not supported on the bridge interface (furtive or non-

furtive).

Management Connections and Bridged Interfaces

While it is possible to open administrative connections to the Fast360 appliance from the management

console on a non-furtive bridge interface, this is not recommended as a mis-configuration of the bridge

may result in the management connection being dropped.

17.1.6. Configuring Non-Furtive Bridging

1. In the Network objects explorer view, right-click on the Interfaces folder.

2. From the displayed menu, select New > Bridge Interface. The bridge interface configuration tab is

displayed on the right.

3. Select the Interface configuration form:

a. Check the Enable this interface option.

b. Enter the IP address and subnet mask for the Bridge interface in the corresponding fields. The IP

address must be in the same network and use the same subnet mask as the hosts connected to

the bridge interfaces.
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c. In the Bridged interfaces field, drag and drop the interfaces that are to be bridged together.

Note

Bridged interfaces do not have an IP address. If you add an interface for which an IP

address has been configured, the address will be deleted from its configuration.

d. Select the Advanced form:

Note

Ignore broadcast traffic and Ignore multicast traffic options are activated by default during

the configuration of a new interface.

i. Leave the Ignore broadcast traffic option checked to prevent broadcast traffic from the

local network being forwarded by this interface.

ii. Leave the Ignore multicast traffic checked to prevent this interface from listening for

multicast traffic. Unselect this option if this interface needs to listen for multicast traffic

(for example, for dynamic routing protocols) and add a corresponding filtering rule. To

add a filtering rule, refer to Chapter 8, Basic Traffic Filtering Using Filtering Rules.

iii. If the topology requires, check the Custom MTU option modify the MTU value (1500 by

default).

17.1.7. Managing Security in Bridge Mode

Antispoofing and Bridging

Because bridged interfaces are part of the same IP subnet, it is not possible for  Arkoon Manager  to

automatically generate implicit antispoofing filtering rules (either in furtive or non-furtive mode). You can

implement antispoofing on bridged interfaces by creating filtering rules as follows:

1. For each bridged interface, configure a group including all the hosts on the network connected to

that interface.

2. Then create filtering rules to block traffic when source and destination addresses are in the same

group. Place these rules at the top of your list of filtering rules.

Table 17.1. Filtering Rules for Protection for Antispoofing

N° Source Destination Service Action

1 bridged eth0 group bridged eth0 group * Block

2 bridged eth1 group bridged eth1 group * Block

Configuring Filtering Rules for Bridged Interfaces

Because bridged interfaces are part of the same IP subnet, when you configure filtering rules you cannot

use the LAN address to filter traffic between interfaces. To filter traffic on a bridged interface, you have to

first create a group of hosts including all the host devices connected to the interface, then use that group

in your filtering rules. For example, in the rule below, setting the LAN as “Source” instead of the group of

hosts would allow somebody who had control of the router to access hosts on the eth0 interface.
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Table 17.2.  Filtering Rules for Bridged Interfaces

N° Source Destination Service Action

1 bridged eth0 group Internet * accept

DHCP and Bridge Mode

To enable DHCP exchanges between clients and a server through furtive or non-furtive bridged

interfaces, you will need to proceed as follows:

1. Unselect IgnoreBroadcast in the bridge interface configuration, and in the configuration of interfaces

included in the bridge.

2. Create a filtering rule for the DHCP traffic:

a. Create the following objects:

• A LAN object representing the LAN on which the DHCP server is located;

• A “DHCP Server” host object, with the IP address of the DHCP server ;

• A “DHCP Source” network object with an IP address of 0.0.0.0 and a subnet mask of

255.255.255.255;

• A “DHCP Destination” network object with an IP address of 255.255.255.255 and a subnet mask

of 255.255.255.255;

• A “DHCP” UDP service object, destination port 67, source port 68.

b. Define the following filtering rule:

• Source: “LAN”, “DHCP Source”;

• Destination: “Fast360”, “DHCP Server”, “DHCP Destination”;

• Service: “DHCP”;

• Action: “Accept”.

Using an HTTP Proxy in Bridge Mode

Non-furtive bridge mode supports the use of the Fast360 HTTP proxy (in standard or transparent proxy

configuration). In the HTTP proxy configuration, add the bridge interface (br0) to the proxy’s configuration

by a drag-and-drop action into the Interfaces field.

Note

The proxy is accessible from all bridged interfaces. You can use the Authorized Networks folder

of HTTP/FTP proxy configuration to restrict access to a specified group of hosts if necessary.

The HTTP proxy is not supported by furtive bridge interface configurations.

17.1.8. Bridging and Multi-Fast360 Configurations

In multi-appliances deployments, filtering rules defined as Automatic will always be installed on

appliances with a furtive bridge interface configured. For more information about multi-appliances

configurations, see Chapter 13, HA and HP Clustering and Chapter 15, Multi-Fast360 Appliances.
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17.1.9. Bridging and High Availability Configurations

In high availability configurations, “real” addresses must not be configured on the interfaces to be

bridged. The bridge interface is only started on the active node, which means that the passive node

cannot be managed using the bridge interface. The configuration in  Arkoon Manager  is identical to the

standard case.

Note

In high availability configurations, you must create a virtual IP address for each IP performing a

translation (static translation or port translation) on the interface concerned.

17.1.10. Bridging and Transparent Proxy

It is not possible to configure transparent proxy (HTTP or POP3) on a bridge interface.

17.2. VLAN Topologies

This section describes how the Fast360 appliance can be integrated into a VLAN architecture to improve

its security.

It details:

• The main integration cases of an Fast360 appliance into a VLAN architecture;

• The configuration of a VLAN on the Fast360 appliance;

• The specific cases of VLAN configuration.

Integrating an Fast360 appliance into a VLAN architecture enables filtering between the VLANs.

Among the existing VLAN standards, the Fast360 appliance implements the most common norm called

802.1q. VLANs can be define by subnetworks, by MAC address or by port. The Fast360 appliance only fits

into VLAN architectures defined by subnetworks. In such architectures, inter-switch communication is

set using tags specifying the VLAN to which it belongs.

The Fast360 appliance can be used for inter-VLAN filtering and inter-switch filtering. It acts as a simple

"filtering" gateway between the networks composed by the VLANs.

17.2.1. Architectures
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Inter-VLAN Filtering on Distinct Subnetworks

The Fast360 appliance can fit into a VLAN architecture as illustrated in the diagram below. The "trunk"

shows that the Fast360 appliance belongs to the VLANs 4, 5 and 6 on one of its interfaces.

Figure 17.2. Filtering on Distinct Subnetworks

In this case, the Fast360 appliance must be explicitly defined as the inter-VLANs routing gateway. This

architecture allows the traffic to be filtered between the VLANs.

Note

If the VLANs do not have distinct addressing, you must define a bridge interface on the Fast360

appliance. For more information on this topic, see the section called “Inter-VLAN Filtering on

Common Subnetworks”.

Particular Case of Inter-switch Filtering

If the architecture has several VLAN switches, the Fast360 appliance can be included as illustrated below.

In this case, the Fast360 appliance must be explicitly defined as the inter-VLANs routing gateway.

Figure 17.3. Inter-switch Filtering
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Inter-VLAN Filtering on Common Subnetworks

If VLANs share the same addressing, you need to define a bridge interface between all corresponding

VLANs on the Fast360 appliance. This bridge interface can be in furtive mode or in non-furtive mode. It

can bridge more than two interfaces.

Caution

This configuration allows inter-VLAN filtering to the detriment of the level 2 partitioning of the

bridged VLANs.

Note

It is not possible to define several bridge interfaces on the Fast360 appliance. Each VLAN sharing

a subnetwork with another VLAN must thus be integrated into the same bridge interface.

17.2.2. Configuring a VLAN

Configuring a VLAN Interface

Before configuring the VLANs, you must first activate the physical Ethernet interfaces over which the

VLANs will be running. To do this, you need to define an IP address for the physical interface (eth0, eth1

etc). You should use an address which is not part of other address ranges on your network.

For example, if your VLANs are 192.168.1.x, 192.168.2.x, and 192.168.3.x, you can use 192.168.254.x for

physical interfaces on the Fast360 appliances.

Then create a VLAN interface and define:

• The associated Ethernet interface (eth0 in our example)

• The VLAN ID

• The IP addressing

• The possible specific parameters (specific MTU, no logging of IP broadcasts)

The name of the VLAN interface includes the name of the associated Ethernet interface and the VLAN

ID: for instance, a VLAN with 4 as ID on the eth0 interface will be automatically labelled as the eth0.4

interface.

Note

The VLAN ID value is between 0 and 4095 inclusive. The 0 and 1 IDs are rarely used as they are

not recognized by all equipments.
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Configuring Filtering Rules

Flow rules can be used to configure inter-VLAN filtering by IP address.

Note

It is not possible to filter by VLAN ID.

17.2.3. Specific Configurations

HA and VLAN Configuration

In the case of High Availability, the configuration of a VLAN interface is similar to that of a standard

Ethernet interface. You must then configure a real address and a virtual address for each interface (in

our example: eth0, eth0.4, eth0.5 and eth0.6).

Note

The real addresses and the virtual address of eth0 are only used to activate the interfaces: it

has no effect on the routing. In the example, the addresses of the  192.168.254.0/24 is a

subnetwork, which is not used in the network.

On the other hand, it can be useful to choose "significant" addresses for the real addresses of the VLAN

interfaces: if you choose a real address belonging to VLAN 4 for the eth0.4 interface, this will allow you

to administrate the Fast360 appliance from VLAN 4. The graphic below illustrates this situation: the VLAN

real addresses belong to the addressing of the corresponding VLANs.

Figure 17.4. VLAN Real Addresses
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Configuring the Bridged VLANs

The configuration is similar to that of a standard bridge interface.

You must first configure the primary Ethernet interface (eth0 in our example) with the 0.0.0.0/0 address.

You can then define the VLAN interfaces which will belong to the bridge interface by assigning them the

0.0.0.0/0 IP address. Finally, create the bridge interface and select the bridged VLANs.

Figure 17.5. Bridged VLANs

Configuring HA and Bridged VLANs

This configuration is similar to the HA configuration of the bridge interface: no real address must be

configured on the interfaces to be bridged.

In our example, we want to bridge the eth0.5 and eth0.6 VLAN interfaces. You must:

• Configure a false address for the eth0.5 and eth0.6.

• Choose the 0.0.0.0/0 address when configuring the virtual addresses of eth0.5 and eth0.6 in  Arkoon

Manager .

• Create the bridge interface by selecting the eth0.5 and eth0.6 VLAN interfaces.

• Assign a non nul address to the bridge interface if it is not in furtive mode.

The example below also includes a VLAN interface which is not bridged (eth0.4). The configuration of

this interface follows the principles presented in the section called “HA and VLAN Configuration”.
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Figure 17.6. HA and Bridged VLANs

17.3. Dynamic Routing

A Fast360 appliance can act as an IP router and offers dynamic routing based on industry-standard

routing protocols.

17.3.1. Routing Methods and Protocols

As an IP network element, the Fast360 appliance can be configured to route IP packets but does not

necessarily have a complete knowledge of the possible paths through the network.

Two types of routing are generally available:

• Static routing: This routing method is based on manually created routing tables (which detail

the possible network paths from source to destination). As such, it is difficult to maintain by the

administrator and is only suitable for small networks.

• Dynamic routing: This routing method is based on automatically updated routing tables. The dynamic

routing mechanism in a router detects changes in the network, automatically updates its routing

table and broadcasts the updated information to its neighbouring routers. As such, it is a very

practical solution in large networks for which routing tables are difficult to manually maintain by the

administrator.

Dynamic routing is implemented in Fast360 appliances from release 3.3 onwards. The three major Internet

routing protocols are supported and described below.
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RIP (Routing Information Protocol)

RIP is a distance vector dynamic routing protocol. Its only criterion for determining the optimum path

through a network is the number of hops to the destination (where a hop is the transfer of information

from one router to the next one in the network). A maximum of 15 hops are allowed.

RIP also exists in an enhanced version, RIPv2, which adds to the functionality of the distance vector

protocol. In addition to the normal periodic broadcasts for routing table updates, RIPv2 also allows routing

table updates to be broadcast as soon as they occur.

RIP and RIPv2 are only suitable for small networks or point-to-point links.

Note

Both RIP and RIPv2 are supported by Fast360 appliance. However, you are recommended to use

RIPv2 rather than RIP. If you wish to use RIP, you must add filtering rules to accept broadcast

flows.

OSPF (Open Shortest Path First)

OSPF is a link-state dynamic routing protocol, developed for Internet IPv4 routing. Its criteria for finding

the optimum path through the network are as follows:

• The costs of the different paths;

• The sum of the available bandwidths between the source and destination points;

In an OSPF environment, a segment hub must be defined which acts as the origin of the network and

to which all other regions of the network are connected. All traffic routed between these other regions

must pass through the segment hub. The routers situated between the different regions are referred to

as Area Border Routers.

OSPF is suitable for large networks which are subject to change and expansion.

BGP (Border Gateway Protocol)

BGP is a link-state dynamic routing protocol which uses TCP transport and is the Internet standard for

connections between operators. Since this protocol is used with external operators, it is not possible

to determine the optimum path to take to the destination. Instead, the aim is to prevent the routers from

using undesirable routes. In doing so, BGP takes the following factors into account:

• The cost involved in paying suppliers for information on external routes;

• The relationship and charging agreements between pairs of operators (i.e. whether money needs to

be exchanged).

17.3.2. Constraints Imposed by Dynamic Routing

The following constraints are imposed on an Fast360 appliance when dynamic routing has been activated:

• In a system with multiple appliances, during configuration it is difficult to determine which routes will

be configured on each Fast360 appliance. To avoid ambiguity, all rules are configured on all appliances

which have dynamic routing enabled.
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• For appliances with dynamic routing enabled, it is not possible to perform the usual coherence checks

on the Fast360 configuration (for example, to check that filtering rules and any VPNs are correctly

configured for the network topology).

• Static routes must be configured in the normal way in Arkoon Manager on Fast360 appliances with

dynamic routing enabled.

Note

In high availability Fast360 configurations, the way dynamic routing is implemented depends on

the protocol used.

• OSPF and BGP protocols run on a working node;

• OSPF runs on the standby node, but BGP does not;

• On a state change, the OSPF protocol configuration is updated, but the service is not restarted.

Important

RIP is not supported on cluster appliances.

17.4. Quality of Service (QoS)

The Fast360 appliance implements the IETF Diffserv model to provide IP Quality of Service. Administrators

can configure the Fast360 appliance to prioritize network services, monitor network performance and

manage congestion in IP-based networks.

17.4.1. QoS Overview

Standard IP-based networks deliver traffic on a “best-effort” basis and do not differentiate traffic

according to the type of flow. When traffic demands exceed the network's available bandwidth, the

service is degraded. Quality of Service (QoS) enables a network element (e.g. an application, host or

router) to have some level of assurance that its traffic and service requirements will be satisfied. QoS

enables certain flows to be guaranteed a better service than other flows. This is done by either raising

the priority of a flow or limiting the priority of another flow. Implementing QoS requires the cooperation

of all network layers as well as every network element.

The Fast360 appliance implements the IETF Differentiated Services (Diffserv) model to provide IP Quality

of Service.

Important

Until now, the ingoing and outgoing QoS could only be configured in OR out of VPN tunnels. It

can now be done simultaneously in AND out of VPN tunnels in NPA appliances. To do so, you

need to select Enable QoS for VPN, from the Interface/Advanded tab of the interface used to

implement the QoS. Moreover, any QoS rule in a VPN tunnel must be configured by interface and

not by Internet access.

Diffserv Model

The Diffserv model [RFC2474, RFC2475] contains the modules that are used to implement IP QoS. They are:

• Rate limiters;

• Markers;
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• Classifiers;

• Shapers.

Rate Limiters

Rate limiters evaluate whether the incoming flow conforms to its rate in the defined profile. The Fast360

appliance uses the Token Bucket and Two-Rate Three Color traffic conditioners as rate limiters. For more

detailed information, see the section called “Traffic Conditioning”.

Markers

Markers mark the DS field of the packet header with a value, called the Differentiated Services codepoint

(DSCP), that indicates how to forward the packet to the network. A Diffserv-aware router can then use

the DS codepoint to apply the appropriate forwarding behavior, known as the per-hop behavior (PHB)

to the packet.

The packet marking in the DSCP field complies with the IETF standards for Assured Forwarding (AF)

and Expedited Forwarding (EF) PHBs. Refer to DiffServ QoS standards [RFC2474, RFC2475] for detailed

information.

The 101110 (0x2E) pattern is reserved for the EF class. The EF class ensures highest priority treatment

and traffic marked with an EF DSCP is not queued. For this reason, EF class is used typically for real-time

applications as it provides the highest level of QoS, low latency and minimizes jitter.

The following tables summarize the DSCP codepoints for AF classes. The AF classes are defined by the

3 Most Significant Bits of the DSCP. The 3 Least Significant Bits are the drop precedence bits; they are

defined by the drop precedence of the flow command.

Table 17.3. DSCP Codepoints for IETF AF Classes

AF1 class AF2 class AF3 class AF4 class

Low drop

precedence

001010 (0xA) 010010 (0x12) 011010 (0x1A) 100010 (0x22)

Medium drop

precedence

001100 (0xC) 010100 (0x14) 011100 (0x1C) 100100 (0x24)

High drop

precedence

001110 (0xE) 010110 90x16) 011110 (0x1E) 100110 (0x26)

Table 17.4. DSCP Codepoints for Cisco QoS Marks

Cisco class Value

CS1 class 001000 (0x08)

CS2 class 010000 (0x10)

CS3 class 011000 (0x18)

CS4 class 100000 (0x20)

CS5 class 101000 (0x28)

CS6 class 110000 (0x30)

CS7 class 111000 (0x38)
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Classifiers

Classification of packets is essential for implementing QoS. Packet classification can be based on various

fields in the IP headers (e.g. source/destination addresses, protocol type) and higher layer protocol

headers (e.g. source/destination port numbers for TCP or UDP). The main use cases are based on a 5-

tuple classifier. Inside the Fast360 appliance packet classification is carried out by the Arkoon Packet

Filter, in accordance with FAST module analysis. Secondary connections (such as a FTP DATA connection

used by a FTP session) will be handled within the same classifier.

Shapers

Classes are used to discriminate packets. There may be several classes on outgoing interfaces, including

at least the best-effort class. They are filled by the outgoing classifier and emptied by the scheduler.

The scheduling algorithms determine which packets to send next on the network according to the QoS

class in which they are stored. Class scheduling mechanisms manage the sharing of bandwidth among

outgoing flows and forward the packets according to their classification and conditioning. For more

detailed information, see the section called “Scheduling”.

Note

In a multi-appliances environment, if you create classes or traffic conditioners, even if there is no

QoS rules for an appliance, it is possible to view the bandwith for these classes or conditioners

(by connecting directly) on an appliance where thre is no QoS rule. By default, these classes and

traffic conditioners are installed on all nodes of the multi-appliances architecture.

QoS Implementation Principles

1. Inbound packets arriving at different input interfaces are checked against defined QoS ingress rules.

Packets that match the filtering criteria in the ingress rules are sent to the different traffic conditioners

that have been declared.

2. Traffic conditioners either limit the rate of packets per seconds or mark and forward packets if they

are within the defined profile.

3. Packets are then sent to upper layer stacks. Once upper layer processing is done, packets are filtered

by the QoS egress rules.

4. If the packets match the egress rules, they are sent into the different classes, which have their own

queuing, dropping and dequeuing algorithms. These classifiers are grouped by interfaces or outgoing

connection.

5. If the queue is full, dropping algorithms determine whether to queue a packet or to drop it.

6. When a link is available, the scheduler of the interface chooses the packet that should be dequeued

according to the dequeuing algorithm.

Note

It is not possible to use QoS on traffic coming from a VLAN interface.

17.4.2. Ingress Traffic

Ingress traffic refers to incoming flows that originate from outside the network's routers and are destined

for inside the LAN. The Fast360 appliance can use traffic conditioners to control ingress traffic. Incoming
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traffic can be processed differently by the traffic conditioners according to the following criteria defined

in the ingress rule:

• Source (host or network);

• Destination (host or network);

• Service;

• Users;

• Date and time;

• Internet access (incoming router);

• Interface.

The different actions that can be applied to a specific flow are:

• Place the packet inside a Token Bucket or Two-Rate Three Color traffic conditioner to ensure that the

specified flow will use a maximum bandwidth.

• Reserve the bandwidth for the specified flow using a dedicated input queuing mechanism.

• Monitor the bandwidth for the specified flow.

Traffic Conditioning

A traffic conditioner performs a control process on incoming packets that meters, marks or drops

incoming packets according to the algorithm selected.

The algorithms can be used to control incoming traffic by either:

• Limiting the rate of incoming packets per second (token bucket mechanism)

• Marking the packet (token bucket and TRTCM algorithm)

The packets may be deleted or marked and then forwarded if the traffic is within the defined profile. Each

traffic conditioner is bound to one incoming interface at any time. Traffic conditioning is used to reduce

the burstiness of a traffic stream.

Token Bucket

The token bucket algorithm is a classless queuing mechanism that can be used to transmit inbound

packets on an interface if the fixed rate is not exceeded. The token bucket accumulates tokens at a given

fixed rate. When a packet arrives on the input interface, the traffic conditioner verifies if the size of the

packet is less than the number of tokens.

• If the condition is true, the packet is in profile and the number of tokens is removed from the bucket;

• If the condition is not verified, the packet is out of profile and it will be queued.

With the token bucket mechanism, the Fast360 appliance provides a non-dropping mechanism with

bandwidth reservation for ingress flows. It can be used to police flows, without loosing packets.

Note

The Arkoon token bucket mechanism can be used in the same way for QoS and traffic

management as the Bandwidth Reservation mechanism available in previous releases 3.0 and

4.0 of the Fast360 appliance.
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Configuring Token Buckets

1. In the default layout, select the QoS navigation tab from the left hand side of the main window.

2. In the explorer view, expand the Ingress tree and create a new Token Bucket by right-clicking

on the Traffic Conditioners folder, select New > Arkoon Token Bucket. The Arkoon Token Bucket

configuration tab is displayed on the right.

3. In the Properties configuration form, enter the name and a short description in the corresponding

fields.

4. Select the Rates configuration form:

a. Set the value for the committed rate in the Percentage of available bandwidth field. The committed

rate is the guaranteed amount of bandwidth available for the specific flow. The actual transmission

rate of the incoming flow is measured against this configured rate to determine whether it conforms

to the rate defined for its class.

b. Set the value for the maximum rate of bandwidth available for the specific flow in the corresponding

field.

c. Set the queue limit in the corresponding field. This value is the maximum number of packets allowed

to accumulate in the queue for the class.

d. Check the Monitor this conditioner option to monitor the bandwidth of the ingress flow.

5. In the Action configuration form, select the action to be performed on the packets:

• To allow through packets that are in profile, check the Pass packet option in the Packets below

maximum rate section.

• To allow through and mark the DS field of packets that are in profile, check the Pass packet and

mark it option and drag and drop the appropriate DSCP marker into the DSCP Marker field. The

DSCP marker determines the priority and drop precedence of the flow.

• To allow through packets that are out of profile, check the Pass packet option in the Packets above

maximum size section.

• To allow through and mark the DS field of packets that are out of profile, check the yellow/red Pass

packet and mark it option and drag and drop the appropriate DSCP marker into the DSCP Marker

field.

Two-Rate Three Color Marker

The Two-Rate Three Color Marker [RFC2698] is made up of two token buckets. One token bucket is used

for incoming packets that are in the committed profile; the green action is applied to these packets. The

other token bucket is used for packets that are in the peak profile; the yellow action is applied to these

packets. When a packet does not conform to either of these profiles, the red action is applied.

Configuring Two-Rate Three Color Marker

1. In the QoS explorer view, create a new Two-Rate Three Color Marker (TRTCM) by right-clicking on

the Traffic Conditioners folder, select New > TRTCM. The TRTCM configuration tab is displayed on

the right.

2. In the Properties configuration form, enter the name and a short description in the corresponding

fields.

3. Select the Rates configuration form:

a. Set the value for the committed rate in the Committed rate field. The committed rate is the token

rate for the committed profile.
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b. Set the value for the bucket depth for the committed profile in the Committed depth field.

c. Check the Monitor this TRTCM option to monitor the committed rate of incoming traffic.

4. Select the Peaks configuration form:

a. Set the value for the peak rate in the Peak rate field. The peak rate is the token rate for the peak

profile.

b. Set the value for the bucket depth for the peak profile in the Peak depth field.

5. In the Action configuration form, select the action to be performed on the packets:

• To allow through packets that are in the committed profile (rate and depth), check the green Pass

packet option.

• To allow through and mark the DS field of packets that are in the committed profile, check the green

Pass packet and mark it option and drag and drop the appropriate DSCP marker into the DSCP

Marker field. The DSCP marker determines the priority and drop precedence of the flow.

• To allow through packets that are in the peak profile (rate and depth), check the yellow Pass packet

option.

• To allow through and mark the DS field of packets that are in the peak profile, check the yellow

Pass packet and mark it option and drag and drop the appropriate DSCP marker into the DSCP

Marker field.

• To drop packets that are in the peak profile (rate and depth), check the yellow Drop packet option.

• To allow through packets that are not in the committed or the peak profile (rate and depth), check

the red Pass packet option.

• To allow through and mark the DS field of packets that are in neither profile, check the red Pass

packet and mark it option and drag and drop the appropriate DSCP marker into the DSCP Marker

field.

• To drop packets that are in neither profile, check the red Drop packet option.

Configuring Ingress Rules

1. In the QoS explorer view, expand the Ingress tree.

2. Create a new ingress rule by right-clicking on the QoS Ingress rules folder, select New > QoS Ingress

rule. The QoS Ingress rules configuration tab is displayed on the right.

3. In the Properties configuration form, enter the name of the new ingress rule and a short description

in the corresponding fields.

4. In the Criteria configuration form, select the criteria according to which packets of the incoming flow

will be filtered:

a. Drag and drop the source object into the Sources field.

b. Drag and drop the destination objects into the Destinations field.

Note

If you are using Port Address Translation, the QoS rule must be defined using the Fast360

appliance object as destination.

Note

When selecting Arkoon objects, the Fast360 appliance must be explicitly selected for an

ingress rule to accept it as source or destination.
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c. Drag and drop the service objects into the Services field.

d. Drag and drop the user objects into the Users field.

A QoS rule including a selection of users and groups will be used only if the user has been

previously authenticated by a filtering rule. The user authentication mode(s) used in the QoS rule

are the ones configured in the filtering rule. To systematically track the bandwidth used by the

user on a given service, you need to create an authenticated filtering rule corresponding to the

authenticated bandwidth rule.

e. Drag and drop the schedule objects into the Schedules field.

Note

The selected schedule is checked against the Fast360 clock.

Note

If you do not complete the fields with a specific, configured object, any object of the field

type may be taken into account. For example, neglecting to complete the Sources field is

equivalent to accepting any source IP address.

f. To specify an incoming router, check the Internet Access option and drag and drop the Internet

access object into the corresponding field.

g. To specify an interface, check the Interfaces option and drag and drop the interface object into

the corresponding field.

5. In the Action configuration form, drag and drop the appropriate traffic conditioner object into the

Traffic conditioner field. The selected traffic conditioner acts on the packets that have been filtered

according to the previously defined criteria.

Note

As rules regarding Internet access are applied first, and those regarding interfaces are applied

subsequently, we recommend that you split ingress rules and use only one of these two criterion

in a single rule, that's to say, do not mix Internet Access and Interfaces in the same rule.

17.4.3. Egress Traffic

Egress traffic refers to outgoing flows that originate from inside the network's routers and are destined

for outside the LAN. The Fast360 appliance uses queuing and scheduling algorithms to control egress

traffic, manage congestion and treat traffic according to its priority.

Queuing

Queuing algorithms are used to manage congestion before the packet is sent on the network. Queuing

algorithms determine how packets are dropped when congestion occurs in a router, i.e. when a queue

is full. The Fast360 appliance uses the traditional tail drop mechanism and Random Early Detection, RED

[RFC2309], an active queue management algorithm.
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Tail Drop

The tail drop algorithm is a FIFO (First In, First Out) queue. When the maximum length of the queue is

reached, subsequent incoming packets are dropped until the length of the queue decreases (because

packets have been transmitted). Tail drop is the default dropping algorithm.

RED

The Random Early Detection (RED) drop policy randomly drops or marks incoming packets when the

average queue length exceeds a minimum threshold (qmin). The drop probability increases with the

average queue length, up to a maximum dropping probability (pmax).

When the average queue length reaches an upper threshold (qmax), all packets are dropped. The

average queue length is calculated with an Exponential Weighted Moving Average (EWMA), defined with

the averaging parameter P.

This can be summarized in the following formula: Qt = Qt-1 + P (Mt - Qt-1) where:

• Mt is the measured queue length at time t

• Qt is the average queue length at time t

• P is the averaging parameter

Configuring RED Parameters

The RED algorithm parameters are configured in the Dropper configuration form of the appropriate traffic

scheduler, i.e. the CBQ or HTB class.

1. In the Maximum queue size field, set the limit of the queue size. This value is not an average and is

set in packets. Beyond this limit, all packets are dropped. This value should be set higher than the

minimum threshold added to the maximum threshold. It is advisable to set this value a few times higher

than the maximum threshold.

2. In the Drop probability field, set the probability with which a packet will be dropped when the queue

reaches the maximum threshold. Drop probability increases as the estimated average queue size

grows. It is specified in percent.

3. In the Maximum threshold field, set the average queue size above which all packets will be dropped.

This value is set in packets.

4. In the Minimum threshold field, set the average queue size at which dropping packets becomes a

possibility. Thus, below this value, no packets will be dropped. This value is set in packets.

5. In the Maximum burst field, set the maximum burst size used to determine how fast the average queue

size is influenced by the real queue size.

Experiments support the following guideline: (2 * min threshold + max threshold) / 3 (value in packets)
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Scheduling

Scheduling algorithms are used to determine which packets to send next on the network according to the

QoS class in which they are stored. Scheduling mechanisms manage the sharing of bandwidth among

outgoing flows and forward the packets according to their classification and conditioning. A scheduler

(and only one) is declared on each interface where QoS is activated on outgoing traffic.

To respond to the QoS needs of different connections, nodes need to have priority and scheduling

mechanisms. The priority feature typically refers to the capability of providing different delay treatments,

e.g., higher priority packets are always served before lower priority ones, both in the context of packet

processing and transmission on outbound links. Nodes also implement different loss priority treatment,

i.e. higher loss priority packets are lost less often than lower loss priority ones. Nodes also need to have

the closely related scheduling mechanisms, to ensure that different connections obtain their promised

share of resources (i.e. processing and link bandwidth). This mechanism also ensures that any spare

capacity is distributed in a fair manner.

Classes

Classes are used to discriminate packets. There may be several classes on outgoing interfaces, including

at least the best-effort class. They are filled by the outgoing classifier and emptied by the scheduler.

In the basic case, classes share the bandwidth in a rather fair way. In a more complex case, classes

can be organized in a hierarchical way, for a more flexible bandwidth sharing. You can create as many

classes as you want. A parent class must be defined, derived from the predefined root class. The default

(root/parent) class can always borrow bandwidth from its children class as long as excess bandwidth

is available. A child class can borrow bandwidth from its parent class as long as excess bandwidth is

available if borrowing is enabled. By default, borrowing is disabled.

The Fast360 appliance supports the Class Based Queuing (CBQ) and Hierarchical Token Bucket (HTB)

scheduling mechanisms.

Class Based Queuing

CBQ (Class Based Queuing) achieves both partitioning and sharing of bandwidth by hierarchically

structured classes. Each class using CBQ has its own queue and is assigned its share of bandwidth. A

CBQ class can only be linked with a CBQ root class.

Configuring Class Based Queuing Root Class

1. In the QoS explorer view, create a new CBQ Root Class by right-clicking on the CBQ folder, select New

> Root CBQ Class. The Root CBQ Class configuration tab is displayed on the right.

2. In the Properties configuration form, enter the name of the root class and a short description in the

corresponding fields.

3. Select the Parameters configuration form:

a. Set the absolute value for the bandwidth to be assigned to the root class in the Available bandwidth

field. The bandwidth assigned to the class is the guaranteed bandwidth delivered to the class

during congestion, this is typically the bandwidth of the Internet access or of the interface.

Note

To obtain greater precision using the CBQ mechanism, set the CBQ root bandwidth value

close to that of the interface speed value.

b. Check the Enable children class to borrow bandwidth option to enable the child class to borrow

bandwidth from this parent class.
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c. Check the Enable class monitoring option to monitor the dequeuing rate.

4. To configure advanced root class parameters, select the Advanced configuration form and check the

Customize advanced parameters option:

a. Set the maximum allowed number of packets per burst in the Maximum burst field. By default, this

value is set to 50 packets per burst.

b. Set the minimum required number of packets per burst in the Minimum burst field. By default, this

is set to 0 packets per burst.

c. Set the maximum packet size in the Maximum packet size field. By default, this value is set to 1518

bytes.

d. Define the average packet size to use to convert packets to byte size (to use for limit computations)

in the corresponding field. By default, this is set to 512 bytes.

Configuring Class Based Queuing

1. In the QoS explorer view, create a new CBQ Class scheduler by right-clicking on the CBQ folder, select

New > CBQ Class. The  CBQ Class configuration tab is displayed on the right.

2. In the Properties configuration form, enter the name of the class and a short description in the

corresponding fields.

3. Select the Paramaters configuration form:

a. Set the value for the bandwidth to be assigned to the class in the Bandwidth fields. You can

set either an absolute value or percentage value for bandwidth in the corresponding field. The

bandwidth assigned to the class is the guaranteed bandwidth delivered to the class during

congestion, this is typically the bandwidth of the Internet access or of the interface.

b. Check the Enable class monitoring option to monitor the dequeuing rate.

c. Check the Marker option to mark the packet header and drag and drop the appropriate DSCP

marker into the DSCP marker field.

d. Drag and drop a root/parent class into the Parent class field.

4. Select the Borrowing configuration form and check the Enable borrowing/sharing of bandwidth

between classes option to enable the sharing of bandwidth between classes. By default, borrowing is

disabled. If borrowing is activated in the child class, it also needs to be enabled in the root class. Note

also that the total bandwidth for all child classes must not be greater than the bandwidth of the parent.

5. Select the Dropper configuration form:

• Leave the Taildrop option checked to use the tail drop algorithm to determine how packets are

dropped. Tail drop is the default dropping mechanism.

• Check the RED (Random Early Detection) option and set the corresponding parameters as

described in the section called “Configuring RED Parameters” to use the RED algorithm to

determine how packets are dropped.

6. To configure advanced class parameters, select the Advanced configuration form and check the

Customize advanced parameters option:

a. Set the maximum allowed number of packets per burst in the Maximum burst field. By default, this

value is set to 50 packets per burst.

b. Set the minimum required number of packets per burst in the Minimum burst field. By default, this

is set to 0 packets per burst.

c. Set the maximum packet size in the Maximum packet size field. By default, this value is set to 1518

bytes.
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d. Define the average packet size to use to convert packets to byte size (to use for limit computations)

in the corresponding field. By default, this is set to 512 bytes.

e. Set the hard priority in the corresponding field. This value is the priority of the leaf class (a leaf

class is a terminal class thus it never contains a child class); lower priority leaf classes are served

first. By default, this value is set to 4.

Hierarchical Token Bucket

Hierarchical Token Bucket (HTB) is based on a structure of class traffic which is hierarchical. A HTB

class can be linked with a root class or another HTB class.

Configuring Hierarchical Token Bucket Root Class

1. In the QoS explorer view, create a new HTB Root Class by right-clicking on the HTB folder, select New

>  Root HTB Class. The  Root HTB Class configuration tab is displayed on the right.

2. In the Properties configuration form, enter the name of the root class and a short description in the

corresponding fields.

3. Select the Parameters configuration form:

a. Set the absolute value for the bandwidth to be assigned to the root class in the Available bandwidth

field. The bandwidth assigned to the class is the guaranteed bandwidth delivered to the root class

during congestion, this is typically the bandwidth of the DSL or of the interface.

b. Check the Enable children classes to borrow bandwidth option to enable the child class to borrow

bandwidth from this parent class.

c. Check the Enable class monitoring option to monitor the dequeuing rate.

Configuring Hierarchical Token Bucket

1. In the QoS explorer view, create a new HTB Class scheduler by right-clicking on the HTB folder, select

New >  HTB Class. The  HTB Class configuration tab is displayed on the right.

2. In the Properties configuration form, enter the name of the class and a short description in the

corresponding fields.

3. Select the Parameters configuration form:

a. Set the value for the bandwidth to be assigned to the class in the Bandwidth fields. You can

set either an absolute value or percentage value for bandwidth in the corresponding field. The

bandwidth assigned to the class is the guaranteed bandwidth delivered to the class during

congestion, this is typically the bandwidth of the DSL or of the interface.

• The absolute value is the rate allowed for the class.

• The percentage value is the percentage allowed of the parent class.

b. Check the Enable class monitoring option to monitor the dequeuing rate.

c. Check the Marker option to mark the packet header and drag and drop the appropriate DSCP

marker into the DSCP Marker field.

d. Drag and drop a root/parent class into the Parent Class field.

4. Select the Borrowing configuration form:

a. Check the Enable bandwidth borrowed option to enable the borrowing/sharing of bandwidth

between classes. By default, borrowing is disabled. If borrowing is activated in the child class, it
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also needs to be enabled in the root class. Note also that the total bandwidth for all child classes

must not be greater than the bandwidth of the parent.

b. From the Maximum bandwidth borrowed options, select either an absolute or percentage value

and enter the maximum bandwidth the class can borrow in the corresponding field. This bandwidth

must be greater than the nominal bandwidth defined in the class.

5. Select the Dropper configuration form:

• Leave the Taildrop option checked to use the tail drop algorithm to determine how packets are

dropped. Tail drop is the default dropping mechanism.

• Check the RED (Random Early Detection option and set the corresponding parameters as described

in the section called “Configuring RED Parameters” to use the RED algorithm to determine how

packets are dropped.

6. To configure advanced class parameters, select the Advanced configuration form and check the

Override custom parameters option:

a. Set the maximum allowed number of packets per burst in the Maximum burst field. By default, this

value is set to 50 packets.

b. Set the amount of bandwidth that can be borrowed in case of bursty flows in the Minimum burst

field. By default, this is set to 0 packets.

c. Set the maximum packet size in the Maximum packet size field. By default, this value is set to 1518

bytes.

d. Set the minimum packet size in the Minimum packet size field. By default, this value is set to 64

bytes.

e. Define the overhead packet size in the Average overhead per packet field. The overhead packet

size can be defined as the average size of data per packet utilized by non applicative network

layers. By default, this is set to 38 bytes: Ethernet media layer header size (8 bytes) + IP network

layer header size (20 bytes) + TCP transport layer header size (10 bytes).

f. Set the hard priority in the Hard Priority field. This value is the priority of the leaf class (a leaf class

is a terminal class thus it never contains a child class); lower priority leaf classes are served first.

By default, this value is set to 4.

Note

The Hard Priority parameter can be useful when defining low latency queueing for VoIP

flows.

Note

Only attempt to modify HTB advanced parameters if you are a confident and experienced QoS

administrator; otherwise, leave the default values.

Configuring Egress Rules

1. In the QoS explorer view, expand the Egress tree.

2. Create a new egress rule by right-clicking on the QoS Egress rules folder, select New > QoS Egress

rule. The QoS Egress rule configuration tab is displayed on the right.

3. In the Properties configuration form, enter the name of the new egress rule and a short description

in the corresponding fields.

4. In the Criteria configuration form, select the criteria according to which packets of the outgoing flow

will be controlled:

a. Drag and drop the source object into the Sources field.
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b. Drag and drop the destination objects into the Destinations field.

Note

If you are using Port Address Translation, the QoS rule must be defined using the Fast360

appliance object as destination.

Note

When selecting Arkoon objects, the Fast360 appliance must be explicitly selected for an

egress rule to accept it as source or destination.

c. Drag and drop the service objects into the Services field.

d. Drag and drop the user objects into the Users field.

A QoS rule including a selection of users and groups will be used only if the user has been

previously authenticated by a filtering rule. The user authentication mode(s) used in the QoS rule

are the ones configured in the filtering rule. To systematically track the bandwidth used by the

user on a given service, you need to create an authenticated filtering rule corresponding to the

authenticated bandwidth rule.

e. Drag and drop the schedule objects into the Schedules field.

Note

The selected schedule is checked against the Fast360 clock.

Note

If you do not complete the fields with a specific, configured object, any object of the field

type may be taken into account. For example, leaving the Sources field blank is equivalent

to accepting any source IP address.

f. To specify an outgoing router, check the  Internet Access option and drag and drop the Internet

access object into the corresponding field.

g. To specify an interface, check the Interfaces option and drag and drop the interface object into

the corresponding field.

5. In the Action configuration form, drag and drop the appropriate traffic scheduler object into the Traffic

class field. The selected queuing mechanism schedules outgoing packets according to the QoS class

in which they are stored.

17.4.4. Use Case

The majority of Internet applications, such as email, FTP, etc., function reasonably well during delays and/

or variations in packet delivery caused by traffic bursts. Real-time applications such as VoIP, however,

are noticeably affected by latency and jitter which results in a “choppy” conversation punctuated with

echoes. The Fast360 appliance can be configured to prioritize the real-time flows over the lower priority

data flows.
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Real-time Flows vs. Non-urgent Traffic

A customer with a 8Mb ADSL line needs to manage real-time Voice over IP (VoIP) traffic and data traffic

in the network.

Figure 17.7. Real-time Flows vs. Non-urgent Traffic

To do this, the network administrator needs to configure the ingress and egress rules for the VoIP and

data flows to:

• Prevent bursts of data traffic from downgrading VoIP latency

• Optimize the ADSL bandwidth

The administrator needs to configure the ingress rules as follows:

1. Configure ingress rule for data flows from LAN to Internet with the TRTCM, mark packets “DSCP Best

Effort” for yellow packets and drop red packets. This will prevent bursts of data from affecting the

VoIP traffic as the data packets are forwarded only when there is bandwidth available.

2. Configure ingress rule for real-time flows from VoIP LAN with a TRTCM with a high limit value and

mark with EF marker. This will ensure that VoIP flows are given the highest priority and are not queued,

and so provides low loss, latency and jitter for the voice connection.

The egress rules need to be configured so that a part of the bandwidth is reserved for VoIP flows and

data flows are restricted:

1. Configure egress rule from the VoIP LAN with EF DSCP marker or CBQ class unit 6Mb reserve without

borrowing.

2. Configure egress rule from data LAN with CBQ mechanism and the RED dropping algorithm. This will

smooth/slow down the TCP/data flow.
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Chapter 18. Updating Fast360 Appliances

 

18.1. Overview

To maintain your Fast360 appliance in a state-of-the-art operational state, several updates are available

automatically or manually on Arkoon update servers.

All Fast360 appliances with a valid license can download the updates.

This section presents:

• The system updates. Depending on their type they can contain functional patches, security fixes and

new product features.

• Optional modules updates (antivirus, IDPS, URL categories, etc.).

• Specific update topologies in connected mode.

18.2. Update principles

A system update consists of installing a completely new version of the whole system (distribution and

kernel) instead of the currently running version of the system. This is done using Arkoon Monitoring.

The Fast360 appliance is first and foremost a security gateway, its system update procedures are thus

paramount to ensuring the security of the whole infrastructure. The key to a successful update can be

described in three words:

Reliability No matter what happens, the appliance's system is left in a consistent state

after the update. In case of error, the old system remains untouched. This is

primarily achieved by ensuring all update steps are carried out appropriately, and

implementing rollback strategies where needed. However it is good practice to

backup all configurations and log files before updating the appliance’s system.

Integrity The installed system is guaranteed to be identical to the image distributed by

Arkoon. In case of error, the running system still satisfies all integrity checks.

Accountability Like all operations involving the security of the system running on the Fast360

appliance, system updates leave a complete audit trail visible in Arkoon alerts.

All steps of the update process are logged and any failures properly reported.
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18.3. System Updates

18.3.1. Types of Fast360 Releases

Arkoon Network Security offers two types of releases, major and intermediate, corresponding to different

user requirements.

Major Releases

A major release – 5.0, 6.0 – is maintained for an extended life cycle, with security corrections and bug

fixes as necessary but with no additional features introduced. A major release is the optimum platform

choice for installations where long-term stability is important, and where the new features introduced

by intermediate releases are not required.

Each new major release “rolls up” new features introduced by the intermediate releases on the previous

major release – for example, major release 6.0 includes the new features introduced by intermediate

releases 5.1, 5.2 etc.

A major release is identified by the .0 version number (currently 6.0), followed by a revision level, for

example 6.0/3 for the third revision (security patches or fixes) for major release 6.0.

Intermediate Releases

An intermediate release adds new features to a major release. We recommend upgrading to an

intermediate release only if you need the new functionality delivered by that release.

Intermediate releases are cumulative; that is, each new intermediate release builds on and adds to the

previous intermediate release. Support for an intermediate release ends with the introduction of the

subsequent intermediate release, or a new major release. This means that when you choose to upgrade

to an intermediate release, you are also committing to more frequent upgrade cycles for your Fast360

appliances.

An intermediate release is identified by a non-zero decimal: 6.1, 6.2, etc., followed by a revision number:

6.2/1, for example.

An intermediate release allows to use new features before the next major release is introduced.

Important

Before installing intermediate releases, you must know the following:

• An intermediate version is no longer supported when the next intermediate version is released.

For instance, 6.1 version is no longer supported if 6.2 version has been released and so on until

the release of the next major version.

• A configuration installed with an intermediate release is not reusable with the major release

from which it comes. This is the same for configuration cards backup.
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18.3.2. Update planning

1. Refer to the Release Notes of the version you are going to install. You will find a table of the step

versions in the case of an update different from “n+1”. You can download them from the Arkoon

Customer area.

2. Save the configuration card as well as the appliance configuration history (and the configuration

history of the secondary node in the case of a High Availability cluster).

3. Download and install the update in connected or disconnected mode.

Particular cases

If the version you need to update is previous to 5.0/1, please refer to the Update and Migration Help on

the Arkoon Customer area.

In the case of a multi-appliances configuration, it is recommended you first update the Fast360 appliances

connected to the AMC server and then update the AMC server. Refer to the AMC server Administration

guide for more information.

In the case of a cluster configuration, it is recommended you first update the non-master node and then

update the master node. The non-master node connects to the master node in order to download the

update files. If the master node has already perform an update, then it already has the files to transmit

to the non-master node (in /var/arkupdate). Otherwise it downloads the files from the update server

and transmit them to the non-master node.

Updating a High Availability (HA) cluster leads to 2 failovers:

• Non-master node 2 update: failover.

• Master node 1 update: 2 failovers.

• When master node 1 applies the update, it restarts and delegates its services: first failover for node

1 to node 2.

• When node 1 has restarted, it becomes master again and handles services: second failover for node

2 to master node 1.

Updating a High Performance (HP) cluster leads to 4 failovers:

• Non-master node 2 update: 2 failovers.

• When non-master node 2 applies the update, it restarts and delegates its services: first failover.

• When node 2 has restarted, it handles its services: second failover.

• Master node 1 update: 2 failovers.

• When master node 1 applies the update, it restarts and delegates its services: first failover.

• When node 1 has restarted, it becomes master again and handles its services: second failover.
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Configuration card backup

In the Actions > Advanced Administration menu in Arkoon Manager, select Configuration card backup

and follow the steps.

Downloading updates

Connected mode

Connect to the Fast360 appliance with Arkoon Monitoring and open the update window by clicking the

update icon.

Note

If no version displays, launch a modules update in order to display the last system versions

available.

Select the correct version. Select Check and if the version is valid, apply it. The Fast360 appliance

downloads the version. Once it is installed, the appliance restarts to start with the new version.

If you have a specific topology, refer to Section 18.5, “Specific update topologies in connected mode”.

Disconnected mode

Go to the Downloads page on the Arkoon Customer area. Select the correct system version and your

appliance type.

Download the “Disconnected update” file and copy it into the /var/tmp directory of the appliance, using

a copy tool relying on the SSH protocol (WinScp for example).

Important

The initial name of the downloaded files must be kept. Verify that your browser did not truncate

the name of the files while downloading them. If they are truncated, rename the files according

to the names of the links visible on the customer space.

To apply the update, connect to the appliance via SSH or in console mode and enter the following

commands:

• cd /var/tmp

• /opt/arkoon/share/distrib/arkoon-install install <sysupdate filename>

This command installs the chosen update file and reboots the Fast360 appliance into the new system

automatically.
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18.3.3. Reinstalling the Previous System Version

When you launch a system update, the Fast360 appliance copies the current version of its system into

the dedicated directory /os.backup.

This copy of the former system allows to:

• automatically come back to the previous version if a problem occurs during the installation of the new

patch;

• manually start the reinstallation of the previous version if necessary (for example, for tests).

Note

Seeing that it is possible to install several patches at the same time, "reinstalling the previous

version" does not mean "removing a patch" but coming back to the version previously installed

on the system.

There are three ways to reinstall the previous system version. In all cases, first restore the configuration

card backup of the previous version:

• From  Arkoon Monitoring : in the Updates window, click the Undo version, check it and install it.

• At boot time, select 3. Switch system version and select the correct version. The factory version

is the version which was installed on the appliance at delivery.

• Use the following command:

/opt/arkoon/share/distrib/arkoon-install install UNDO

18.4. Modules Updates

18.4.1. Downloading Modules in Connected Mode

The antivirus, certificates store, URL categories and IDPS signatures updates are automatically taken

into account as soon as they are downloaded.

Note

When updating the list of Advanced URL categories, the list of categories and the list of the

associated domains are downloaded.

When updating the list of SmartWeb URL categories, three files are downloaded: the list of

categories, the list of category groups and a file including the encryption key allowing the use of

SmartWeb URL categories. The encryption key remains valid during one month.

With Arkoon Small S90 and S150, P-XS3 and P-S4 appliances with no hard drive or low-capacity hard

drive, antivirus and ADVANCED_URL categories updates are not automatically downloaded if these

functionalities are not used in your configuration. In some cases, it can be useful to force the download of

all modules (for example, in cases of off-network use or when preparing appliances ready to use although

they do not have configuration or license file).

To force the update of all modules, add the following line to the file /config_card/etc/arkoon-

config.local:
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arkupdate.heavy-downloads.enable=true

The behavior on other types of appliances keeps unchanged. It is nevertheless possible to make them

apply this behavior via the configuration key above by changing its value.

18.4.2. Downloading Modules in Disconnected Mode

Standard Procedure

The standard procedure only requires the arkupdate_MODULE_YYYYMMDD_HHMM.tar.gz file which

contains all updates.

Note

The files in this archive are also available for administrators who want to avoid downloading the

same data several times. For this, refer to the section called “Advanced Procedure”.

Once the file is available on the Fast360 appliance, you only need to uncompress the file (by positioning

yourself at the root of the system) and to launch the second step of arkupdate (installation of the available

updates).

Example 18.1. SOPHOS_RTV2 Module (Standard Procedure)

[root@mon_FAST360 /root]# cd /
[root@mon_FAST360 /]# tar xzvf tmp/arkupdate_SOPHOS_RTV2_20020930_1759.tar.gz
var/arkupdate/SOPHOS_RTV2/index
var/arkupdate/SOPHOS_RTV2/SOPHOS_RTV2_3.62.tar.gz
var/arkupdate/SOPHOS_RTV2/SOPHOS_RTV2_3.62_0001.tar.gz
var/arkupdate/SOPHOS_RTV2/SOPHOS_RTV2_3.62_0002.tar.gz
var/arkupdate/SOPHOS_RTV2/SOPHOS_RTV2_3.62_0003.tar.gz
[root@mon_FAST360 SOPHOS_RTV2]# /opt/arkoon/bin/arkupdate upgrade SOPHOS_RTV2
Upgrading module SOPHOS_RTV2 [(null)/0] -> [3.62/2]...
  [(null)/0] -> [3.62/0] using SOPHOS_RTV2_3.62.tar.gz
SOPHOS_RTV2: [/0] -> [3.62/0]
  [3.62/0] -> [3.62/1] using SOPHOS_RTV2_3.62_0001.tar.gz
SOPHOS_RTV2: [3.62/0] -> [3.62/1]
  [3.62/1] -> [3.62/2] using SOPHOS_RTV2_3.62_0002.tar.gz
SOPHOS_RTV2: [3.62/1] -> [3.62/2]

Note

When updating the list of Advanced URL categories, the list of categories and the list of the

associated domains are downloaded.

When updating the list of SmartWeb URL categories, three files are downloaded: the list of

categories, the list of category groups and a file including the encryption key allowing the use of

SmartWeb URL categories. The encryption key remains valid during one month.

Advanced Procedure

The advanced procedure allows you to avoid downloading all updates each time. Only use this procedure

if you are comfortable with the update process. Otherwise, use the standard procedure.

With the advanced procedure, you can download only the files still missing on the Fast360 appliance.

After download, it is necessary to put them in their respective directories (/var/arkupdate/<MODULE>).

It is then necessary to update the index file/var/arkupdate/<MODULE>/index which contains all

information concerning the updates. There are two possibilities:

• Retrieve the index file from the HTTPS site each time;

• Complete the index file by adding the description of the new downloaded files.



Chapter 18. Updating Fast360 Appliances

Specific update topologies in connected mode | 473

Once all the files are present on the Fast360 appliance and the index file is updated, you can launch the

second step of arkupdate.

Example 18.2. SOPHOS_RTV2 Module (Advanced Procedure)

[root@mon_FAST360 /root]# cd /var/arkupdate/SOPHOS_RTV2
[root@mon_FAST360 SOPHOS_RTV2]# 
echo "3.62 0003 D SOPHOS_RTV2_3.62_0003.tar.gz" >>index
[root@mon_FAST360 SOPHOS_RTV2]# 
echo "3.62 0004 D SOPHOS_RTV2_3.62_0004.tar.gz" >>index
[root@mon_FAST360 SOPHOS_RTV2]# /opt/arkoon/bin/arkupdate upgrade SOPHOS_RTV2
Upgrading module SOPHOS_RTV2 [3.62/2] -> [3.62/4]...
  [3.62/2] -> [3.62/3] using SOPHOS_RTV2_3.62_0003.tar.gz
SOPHOS_NSV: [3.62/2] -> [3.62/3]
  [3.62/3] -> [3.62/4] using SOPHOS_RTV2_3.62_0004.tar.gz
SOPHOS_NSV: [3.62/3] -> [3.62/4]

Installing IDPS Updates

You can update signatures in disconnected mode. For this, you need to download the last IDPS update file

from http://client.arkoon.net, copy it to the Fast360 appliance (in /tmp for instance) and type the following

command: /usr/arkupdate/IDPS_upgrade /tmp/IDPS_date.gz. This checks the file signature before

installing it. For more information about IDPS, refer to Section 11.2, “IDPS”.

18.5. Specific update topologies in connected mode

18.5.1. Connection settings

Default configuration: the Fast360 appliance is configured to update from support.arkoon.net via an

SSL connection on the TCP 1752 port. This update mechanism is used when the Fast360 appliance has

unrestricted access to the Internet.

Important

Port 443 can be used for updates but it is necessary to create a flow rule. Select the Fast360

appliance as source, the update servers as destination and the TCP 443 service without the FAST

analysis.

The update servers are:

• ArkoonUpdate-1 195.167.226.86

• ArkoonUpdate-2 195.167.226.87

• ArkoonUpdate-3 195.167.226.88

• ArkoonUpdate-4 195.167.226.89

Without this rule, the update flow would be blocked by the FAST analysis because the certificate

used to be identified on the server is self-signed.

http://client.arkoon.net
support.arkoon.net
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18.5.2. Unrestricted Internet Access

Conditions: the Fast360 appliance can connect to Internet servers on the TCP 1752 and UDP 53 ports.

On the Fast360 appliance, you must:

• Indicate at least one DNS server in the Fast360 appliance configuration.

• Keep the default update configuration.

1. In the Network objects explorer view, double-click on the Fast360 appliance icon. The Fast360

appliance configuration tab is displayed on the right.

2. Select the Update configuration form.

3. Drag and drop a default update policy into the Update policy field.

4. To view the properties of the default update policy, double-click on its icon. A new configuration form,

labeled Update policy is displayed.

5. In the Update server field, double-click on the Arkoon Update icon to view its properties. A new tab,

labeled Arkoon Update is displayed.

6. Select the Services form.

• Check that Update Server is selected.

• Check the DNS Server option.

18.5.3. Access via a HTTP Proxy

Conditions: the Fast360 appliance can connect to Internet via an HTTP proxy. You must know the port

on which this HTTP proxy is accessible, as well as a user name and a password if the proxy requires

authentication. This HTTP proxy must connect to Internet servers on port 1752 or 443 (standard HTTPS

port).

On the Fast360 appliance, you must:

• Indicate port 443 instead of port 1752, if the HTTP proxy cannot open connections to the port 1752.

• Create a host with an IP address of the HTTP proxy.

• Define the proxy access settings in the update configuration.

1. Select the Update configuration form.

2. Drag and drop a default update policy into the Update policy field.

3. To view the properties of the default update policy, double-click on its icon. A new configuration form,

labeled Update policy is displayed.

4. In the Update server field, double-click on the Arkoon Update icon to view its properties. A new tab,

labeled Arkoon Update is displayed.

5. Select the Services form.

• Check that Update Server is selected.

• Select the HTTP Proxy option and indicate the connection port.

6. Return to the Update Policy configuration form and select the Update Proxy form.
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• Check the Use proxy option and then drag and drop the host representing the HTTP proxy into the

Update proxy field.

• Check the Enable authentication option and complete the Username Password and Confirmation

fields, if required.

18.5.4. Access via an Update Relay Fast360 Appliance

Conditions: the Fast360 appliance being configured must be able to connect to a Fast360 appliance which

can receive updates. Both these Fast360 appliances must have certificates signed by the same CA.

The update proxy Fast360 appliance must be configured as follows:

• The Serve as update proxy option must be enabled and the hosts corresponding to the internal Fast360

appliances must be specified.

• A DNS server must be specified in the Fast360 appliance configuration.

1. Select the Update configuration form.

2. Drag and drop a default update policy into the Update policy field.

3. To view the properties of the default update policy, double-click on its icon. The Update Policy

configuration form is displayed.

4. In the Update server field, double-click on the Arkoon Update icon to view its properties. A new tab,

labeled Arkoon Update is displayed.

5. Select the Services form.

• Check that UpdateServer is selected.

6. Return to the Update configuration form in the Fast360 appliance configuration tab.

7. Check the Serve as update proxy option.

8. Drag and drop hosts corresponding to the internal Fast360 appliances into the Authorized clients field.

Note

Using the update mechanisms implies you trust the security of the Arkoon server. This

mechanism creates an implicit filtering rule from the Fast360 appliance to the update server.

Note

A Fast360 appliance without a hard disk cannot serve as update relay for another Fast360

appliance.

Note

A Fast360 appliance cannot serve as system update relay (patch or system image) for another

Fast360 appliance with a different distribution base (for instance a Fast360 5.0SMP appliance

cannot serve as update relay for Fast360 5.0EMB appliances).

On the Fast360 appliance which will connect to the update relay Fast360 appliance, you must:

• Indicate the IP address and the port on which to connect to the relay Fast360 appliance.

• Select Arkoon  in the Certificate Authority field in the Update Server configuration form of the Update

Policy configuration tab.



Chapter 18. Updating Fast360 Appliances

476 | Access via an Update Relay Fast360 Appliance



Restoring a configuration on a USB key | 477

Chapter 19. Replacing and Reinitializing Fast360

Appliances

19.1. Restoring a configuration on a USB key

The following procedure describes the restoration of a configuration (config_card) for Performance

and NPA appliances only, using a USB key.

Important

This mode is supported only on Performance and NPA Small S90/S150 appliances. For other types

of appliance, follow the procedure described in Section 19.2, “Redeploying a Fast360 Appliance”.

1. To retrieve the configuration of the appliance to update, refer to the procedure described in

Section 19.2.1, “Saving the Configuration”

2. Rename the configuration archive in config_card.tgz and copy it to the root of the USB key (the key

must be formated in FAT16 or FAT32).

3. If available, name the license file of the replacement appliance in license.akl and copy it to the root

of the USB key.

4. Plug the USB key to the appliance on which you wish to restore the config_card (as well as the

license if it is available).

5. Reboot the appliance (or switch it on if it is off).

When booting, the appliance detects the connected USB devices and searches for the config_card.tgz

file.

The following operations are automatically launched:

• check the compliance of the archive format: the structure of files contained in the archive is checked

• backup the current config_card and create a log file on the USB key or hard drive in the /var/

config_card.backup/ folder

Note

If the backup of the current config_card is impossible on the USB key (not enough space,

key in read-mode), the procedure still continues but if the backup on the hard drive fails, the

procedure stops and the appliance starts a usual.

• restore the current config_card on the USB key. In case of error, the boot is blocked, and you must

retrieve the USB and reboot the appliance

• restore the license file if it is present.

If successful: on a Performance appliance (P, P-XL or P-S), the status is displayed on the LCD screen

and the start-up goes on. On an NPA Small or Performance P-XS appliance, the “status” led blinks

three times and the start-up goes on. It is then essential to retrieve the USB key once the config_card

is restored.
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If failure: n a Performance appliance (P, P-XL or P-S), the status is displayed on the LCD screen and

the start-up is blocked. On an NPA Small or Performance P-XS appliance, the “status” led blinks three

times and the start-up blocked. It is then essential to retrieve the USB key and restart the appliance.

Important

Only the presence of files is checked but not their content. Make sure you do not deploy an

archive originally for another appliance.

19.2. Redeploying a Fast360 Appliance

All the Fast360 appliances have /config_card partition gathering all the elements of the Fast360

appliance's configuration (parameters set by  minarkconf  – CA definition, root password, HA

configuration, … - and configuration files created with  Arkoon Manager ).

The configuration histories that are necessary to redeploy an appliance are stored in the directory /var/

akserver/mgt/conf for the configuration and /var/akserver/mgt/role for the roles database.

These directories must be retrieved in order to create the backup of a Fast360 appliance.

The procedure includes the following steps:

• Retrieval of the /config_card partition and the /var/akserver/mgt/conf and /var/akserver/mgt/

role directories of the former Fast360 appliance.

• Update of the new appliance with the type of version (major/intermediate) of the former appliance.

• Installation on the new Fast360 appliance of the saved /config_card partition and the /var/

akserver/mgt/conf and /var/akserver/mgt/role directories.

• Installation of the license corresponding to the new Fast360 appliance.

• Restarting of the appliance for taking into account of the new configuration.

Note

Refer to the Update and Migration Help on the Arkoon Customer Area to obtain the complete

procedure.

19.2.1. Saving the Configuration

Via  Arkoon Manager :

The Actions / Advanced Administration / Configuration card backup menu in  Arkoon Manager  allows

you to save all the data necessary to redeploy an Arkoon appliance.

In console mode:

1. Connect via an SSH connection.

2. Open a session as root.

Note

By default, the console automatically disconnects after 30 seconds (timeout). To avoid being

disconnected, it is possible to deactivate the TMOUT environment variable with the unset

TMOUT command.
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Note

By default, command history is not backed up. To activate the automatic backup, create the

file /tmp/root-bash-history with the touch /tmp/ root-bash-history command.

3. Type the following command: configcard-backup.

4. Then retrieve the created file (e.g. /tmp/configcard-appliance-2011-05-12-122103.tgz)

located in the /tmp directory using an SSH connection on port 822.

In both cases, save this file in a reliable and secure location.

Note

You should save this backup as soon as the Fast360 appliance is installed. If there are no changes

other than modifications of the configuration file, save each new configuration version using the

administration workstation via  Arkoon Manager .

Note

The following command alllows to backup the configuration history:

configcard-backup - - history

19.2.2. Restoring the Configuration

Prerequisite: the spare appliance must be initialized with the minimum parameters so that you can

connect to it via SSH from the administration workstation.

The appliance must be in the same version (major or intermediate) as the appliance where the

configuration backup comes from.

You must first copy the backup configuration file and the license file on the new appliance.

Open an SSH connection on port 822 to copy the config_card_and_configurations.tgz file

and the license.akl file (e.g. /tmp/configcard-appliance-2011-05-12-122103.tgz and /tmp/

license.akl) into the /tmp directory of the new appliance.

1. Open an SSH connection.

2. Open a root session.

3. Go to the root directory by typing cd / command.

4. Type the following command: configcard-restore /tmp/configcard-

appliance-2011-05-12-122103.tgz /tmp/license/akl.

19.2.3. Restarting the Appliance

The last step consists in restarting the appliance in order to take the new configuration into account.

Therefore, you can:

• Click the Restart icon in the Maintenance/Diagnostics window in  Arkoon Monitoring .

• Type the reboot command (SSH connection).
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19.3. Quick Diagnosis of the Appliance Interfaces in

Console Mode

It is possible to check the status of the network interfaces of a Fast360 Performance appliance in

command line.

1. Establish an SSH connection to the appliance on port 822 or by the serial port.

2. Enter the command: akhw akintf view.

This command enables to display a graphical representation of the front or back view of the appliance

with the interfaces. Connected and working interfaces are displayed in green. Not connected interfaces

are displayed in black.

Example for a P-S4 appliance

Example for a P-XS3 appliance

Example for a P-XL appliance

Example for a P-1808 appliance
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Chapter 20. Managing RAID

20.1. Minarkconf menu for RAID management

The P-80XL, P-150XL and P-250XL appliances support hard drives management in RAID 1 (Redundant

Array of Independent Disks). This management is possible via minarkconf (only with Performance XL

appliances) via minarkconf > Maintenance > RAID utility.

The following submenus are available:

• View RAID status: to see the detailed state of the RAID status of the appliance

• View RAID recovery in real-time: to see the progress of the reconstruction of a disk in real time.

This submenu appears only if a disk is being reconstructed.

• Deactivate hard disk: to deactivate a disk to swap it. This allows to swap a hot disk without

switching off the appliance. This submenu is available only if both disks were detected. It is

inaccessible when the RAID reconstruction operation on one disk is in progess.

• Activate hard disk: to activate a disk. This function is used to swap a hot disk without switching

off the appliance. Once activated, the RAID reconstruction begins. This submenu is only available if

a disk has been detected.

Warning

Reconstructing a disk may take more than an hour. If the appliance has started with a single

disk, adding a second drive requires a restart of the appliance for it to be taken into account,

despite its activation. If the appliance has started with two disks, a restart is not necessary.

• Back: to leave the RAID menu.

When a hard drive is removed or added to the appliance (after minarkconf > Maintenance > RAID

utility > (de)activate), error or warning messages are sent from the Linux kernel to specify the

hardware changes. These messages appear in a disorderly manner on the screen but this does not

indicate a problem. To find a clean screen, simply connect (if not already) and run the command: clear.

20.2. Using RAID

In this section, we will call a "clean" disk , a disk that has the following characteristics:

• A brand new disk

• A disk already used but not part of a RAID

• A disk already used and part of a RAID but correctly swapped (on a Performance XL appliance:

Minarkconf >Maintenance >RAID utility > Deactivate hard disk)

• Any other type of disk cannot be used on a P-80XL, P-150XL or P-250XL appliance.

• Deleting a hot disk is removing a disk without switching off the appliance.

• Deleting a cold disk is removing a disk when the appliance is switched off and then switched on.

• Adding a hot disk is adding a disk without switching off the appliance.
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• Adding a cold disk is adding a disk when the appliance is switched off and then switching it on.

The following procedures list the various processes that you can do or are not supported with RAID on

a Performance XL appliance.

Warning

It is not supported to physically remove a hot disk without first deactivating it via the menu

minarkconf >Maintenance >RAID utility > Deactivate hard disk.

Hot removal and hot addition

1. To delete the disk, go to Minarkconf > Maintenance > RAID utility > Deactivate hard disk

and remove the disk.

2. To add the disk, it needs to be clean: add the disk and go to Minarkconf > Maintenance > RAID

utility > Activate hard disk.

Cold removal and hot addition

Case not supported.

Hot removal and cold addition

1. To delete the disk, go to Minarkconf > Maintenance > RAID utility > Deactivate hard disk

and remove the disk.

2. To add the disk, it needs to be clean: add the disk and start the appliance.

3. Go to Minarkconf > Maintenance > RAID utility > Activate hard disk.

Cold removal and cold addition

1. Remove the disk.

2. To add the disk, it needs to be clean: add the disk and start the appliance.

3. Go to Minarkconf > Maintenance > RAID utility > Activate hard disk.

20.3. Reconstructing a disk in RAID

There is a disk reconstruction when:

• the RAID is created during the appliance initialization.

• a new disk is activated on the appliance.

A reconstruction operation is activated successively on different partitions of the new hard disk. It takes

place in the background and does not impact the use of the appliance. This will completely synchronize

the partitions of the two discs. Depending on the size and type of disks, the operation lasts about an hour

for all file system partitions of the appliance. It is possible to follow this operation from minarkconf >

RAID Utility > View RAID recovery in real-time. The estimated duration of the operation is also

indicated.

The reconstruction is performed only on a partition at a time. Other non-synchronized partitions are

marked with the label "DELAYED" to plan the operation. When a RAID reconstruction operation is in

progress:
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• It is possible to restart the appliance. The operation restarts when booting the appliance.

• It is impossible to deactivate a disk from RAID with minarkconf. You must wait for the end of the

operation.

20.4. System monitoring related to RAID

The addition of RAID implies a new system monitoring. There is a "SOFT-RAID" type of monitoring per

partition (named raid1, raid2, raid3 and raid4):

root@localhost:/root> sysmon client LIST
CPU load         CPU-LOAD         RDY GRE CPU load below 75�
Memory usage     MEM-USAGE        RDY GRE Memory usage below 75�
/var usage       DISK-USAGE       RDY GRE Filesystem is 0� full
/tmp usage       DISK-USAGE       RDY GRE Filesystem is 0� full
/config_card usa DISK-USAGE       RDY GRE Filesystem is 1� full
license          LICENSE          RDY RED No license installed!
config           CONFIG           RDY GRE Configuration is valid
logs db          LOGS-MEDIA       RDY GRE Database OK
log queues       LOGS-QUEUE       RDY GRE Log queues OK
services         SERV             RDY GRE All services are OK
disk0            DISKS            RDY GRE SATA - S:clean, H:ok, M:ok, T°C<50, P<30000h
config-slave     CONFIG-SLAVE     RDY GRE Configuration installed by server
logs size        LOGS-SIZE        RDY GRE 
link:eth0        LINK             RDY GRE eth0 Link is up
disk1            DISKS            RDY GRE SATA - S:clean, H:ok, M:ok, T°C<50, P<30000h
raid1            SOFT-RAID        RDY GRE /dev/md1 switched to state OK
raid2            SOFT-RAID        RDY GRE /dev/md2 switched to state OK
kraid3            SOFT-RAID        RDY GRE /dev/md3 switched to state OK
raid4            SOFT-RAID        RDY GRE /dev/md4 switched to state OK

This system monitoring is checked every 10 minutes. For more information on the RAID status system

monitoring, refer to the Section 16.1, “Monitoring RAID status”.
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Chapter 21. IPMI management interface

21.1. Introduction

Performance XL models of Fast360 appliances have an interface named IPMI (Intelligent Platform

Management Interface). This interface can remotely control the appliance, restart it (either soft or hard

restart), have a remote console, monitor the appliance (temperature, speed of fans, etc.).

IPMI is a generic technology of Intel present in the servers machines. For detailed information on the

IPMI standard, refer to the Intel website: http://www.intel.com/design/servers/ipmi/ipmi.htm.

This interface uses its own integrated circuit and its own mini-processor. It is completely detached

from the rest of the appliance and has a complete autonomy, allowing to switch on or off the appliance

electrically from the interface. IPMI allows you to control all aspects of the hardware appliance without

installing any additional agent.

21.2. Use and Connection

Use

The following IPMI features are useful on Fast360 appliances and have been validated by Arkoon:

• Soft or electrical switching on / off and soft reboot (soft or electric) of the appliance

• Hardware events monitoring

• Use of minarkconf via the remote console

• Diagnostic procedures described

• Debug of the appliance in case of failure, via the remote console

Important

All the features useless to Fast360 appliances have not been validated: Arkoon makes no implied

warranty or support for changes in this part and accepts no liability for the use of these features.

The interface is activated by default in the appliance BIOS and its default addressing is

• IP address: 192.168.1.100

• Default mask: 255.255.255.0 (/24)

• Default gateway: none

The use of the IPMI interface can be:

• from a Web browser (Interne Explorer 7 as a minimum or Firefox 3 as a minimum), entering the interface

address: http://192.168.1.100

• from a workstation, by using utilities like IPMItool.

Only the use of IPMI via its web interface is presented in this section.

http://www.intel.com/design/servers/ipmi/ipmi.htm
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Connection

To connect to the IPMI interface, launch a web browser and enter the following address:

http://192.168.1.100.

Note

The default login / password is: ADMIN/ADMIN. For safety, we recommend that you change the

password (via Configuration > Users. It is also possible to create other users.

The following page displays the status of the VGA output of your appliance:

21.3. Menus overview

For more details on the various menus that are presented below, see the full documentation of the

manufacturer, available in Fast360 documentation package.

Server Health Menu

This menu allows you to obtain information on the various sensors of the appliance (fans, temperature, ...)

and view the various events (logs) related to the appliance hardware (loss of power supply, opening the

appliance, ...).
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Configuration Menu

This menu allows you to configure various parameters directly related to the use of the IPMI protocol.

Arkoon makes no implied warranty or support for changes to this part and accepts no liability for the use

of this menu. From this menu, you can change the default IP address of the IPMI, thanks to the submenu

Network.

Remote Control Menu

This menu provides the following submenus:

• Console Redirection to open a console on the appliance. This console is the equivalent of a VGA

console (keyboard + screen).

Note

The remote console is not operational by default. The grub is configured to send data to the

COM port whereas the IPMI interface receives the VGA/keyboard information only.

In order to change this, choose the menu Arkoon Fast360 VGA (P-XL series only) when the

appliance is booting. In this case, the console is no longer accessible via the COM port but

only via the VGA console or the IPMI Remote Control.

• Power Control to switch on and off the appliance remotely. Power off (lectrical and soft) can be

operated from this menu.
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Virtual Media Menu

This menu allows you to mount a virtualized CD or a virtualized floppy drive. Arkoon makes no implied

warranty or support for changes to this part and accepts no liability for the use of this menu.

Maintenance Menu

This menu allows you to perform maintenance on the IPMI interface. Arkoon makes no implied warranty

or support for changes to this part and accepts no liability for the use of this menu.

Miscellaneous Menu

This menu provides access to various functions. Arkoon makes no implied warranty or support for

changes to this part and accepts no liability for the use of this menu.
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Appendix A. Migration and Update Procedures

A.1. Migration and Update Procedures

The migration or update procedure corresponding to your case can be generated on the Arkoon Customer

area thanks to the Update and Migration Help : http://client.arkoon.net/.

A.2. Specific Update Procedures

In the following cases, specific update procedures need to be applied and are detailed in the mentioned

Release Notes:

• Cluster in pre-5.0/9 version: refer to Release Notes 5.0/9.

• Passive node of an HA cluster in version 5.0/11: refer to Release Notes 5.0/12.

• NPA or XLarge appliance in version 5.0/11 getting updated via an update relay: refer to Release Notes

5.0/12.
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Appendix B. Migrating a CA with an imminent

expiration

B.1. Migrating a CA with an Imminent Expiration

For technical reasons (the certificate of the Certification Authority is included in all user certificates)

and security reasons (the lifespan of a private key), it is impossible to extend the life of the Certification

Authority. You must then recreate it.

Prerequisite

• SSH connection on each of the Fast360 appliances

• SSH connection on B nodes (in HA or cluster cases). If necessary, create a flow rule to bounce back

from the master node on the slave node

• Back up all the config_card and all Fast360 appliances of the architecture

Warning

During the application of this procedure, it is impossible to install configurations and VPN or

multi-appliances connections are unavailable. In general, all the services based on a certificate

are available.

To clarify the configuration, it is recommended to delete unused objects before starting the procedure.

To do this in Arkoon Manager configuration, click on Find > Find unused items....

Identifying certificates

1. Identify the administration certificates (ADMIN) still in use by opening the basic roles and inventory

the existing administrators in the roles database still active.

2. Identify the appliances certificates (FIREWALL) still in use by opening the configuration and

inventory all the appliances of the architecture included in the configuration file still in production.

Important

In the case of a cluster appliance, it takes one certificate per node plus a certificate if the

cluster mounts VPNs with certificates.

3. Identify the users certificates (USER) still in use by opening the configuration and inventory all the

certificates objects used by hosts / users included in the flow rules / VPN communities.

Renewing the Certification Authority

1. SSH — Delete the existing Certification Authority: go to minarkconf > Certificates > Delete

certificate authority and confirm.

2. SSH — Create the new Certification Authority: go to minarkconf > Certificates > Initialize a

certificate authority (CA) and fill in the various parameters of the Certification Authority.



Appendix B. Migrating a CA with an imminent expiration

492 | Renewing the Certification Authority

3. SSH — Create a new instance certificate (AMC case) or FIREWALL (Fast360 case): minarkconf >

Certificates > Create this Arkoon certificate.

4. SSH — Create a new ADMIN certificate: minarkconf > Certificates > New Certificate, then initialize

the roles database with this certificate via minarkconf > Access Control  > Reset Access Control

Database, then retrieve the .p12 file of the certificate.

5. Arkoon Manager — Log on the AMC appliance / instance with the created certificate and go to

section Certification Authority and create all the necessary appliances (FIREWALL) certificates.

6. SSH — Copy the certificates on the appliances in SCP and install them by logging on appliances

via SSH, then minarkconf > Certificates > Import new Fast360 certificate. For a cluster solution,

install on each node the specific VPN certificate of the cluster via minarkconf > Certificates > Import

external certificate for VPN: the master / slave relationship is restored. It is possible to install new

configurations, and the VPNs between Fast360 appliances are functional.

7. Arkoon Manager — Create all the administration certificates (ADMIN) and the administrators

associated to the roles database and associate the appropriate certificates and roles.

8. Install the roles database, then install the architecture configuration.

9. Distribute the certificates to the administrators: all the administrators can now log on via Arkoon

Manager or Arkoon Monitoring.

10. Arkoon Manager — Create the users certificates (USER) then go to the Configuration part.

11. Accept the system synchronization, then modify the certificates referenced in the Certificats

objects, then install the configuration.

12. Distribute the certificates to the users and ask them to modify the configuration of the VPN client

in order to use the new certificate: the mobile VPNs with certificate authentication can now be put

into production.

13. If VPNs with certificates were mounted with remote third-party VPNs gateways, you can provide

the certificate to the gateways administrators: all the VPNs with authentication are functional.

The migration is finished and all the features related to certificates are now operational.
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Appendix C. Reference Documents

 

C.1. Standards Documents

C.1.1. FAST DNS Module

The DNS protocol is described in the following documents:

• RFC 1034 - Domain Names - Concept and facilities - November 1987

• RFC 1035 - Domain Names - Implementation and specification - November 1987

• RFC 2671 - Extension Mechanisms for DNS (EDNS0) - August 1999

C.1.2. FAST FTP Module

The FTP protocol, its extensions and use are described in the following documents:

• RFC 765 - File Transfer Protocol (FTP) - June 1980

• RFC 959 - File Transfer Protocol (FTP) - October 1985

• RFC 2577 - FTP Security Considerations - May 1999

• draft-ietf-ftpext-mlst-xx.txt: Extensions to FTP

C.1.3. FAST HTTP Module

The different versions of the HTTP protocol are described in the following documents:

• RFC 1945 - Hypertext Transfer Protocol -- HTTP/1.0 - May 1996

• RFC 2068 - Hypertext Transfer Protocol -- HTTP/1.1 - January 1997

• RFC 2616 - Hypertext Transfer Protocol -- HTTP/1.1 - June 1999

C.1.4. FAST SMTP Module

The SMTP protocol and its extensions are described in the following documents:

• RFC 821 - Simple Mail Transfer Protocol - August 1982

• RFC 1869 - SMTP Service Extensions - November 1995

• RFC 1985 - SMTP Service Extensions - ETRN - August 1996

• RFC 2487 - SMTP Service Extensions for Secure SMTP over TLS - January 1999

• RFC 2554 - SMTP Service Extensions for Authentication - March 1999
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• RFC 2821 - Simple Mail Transfer Protocol - April 2001

C.1.5. FAST SNMP Module

The above versions of the SNMP protocol and their extensions are described in the following documents:

SNMPv1

• RFC 1157 - A Simple Network Management Protocol (SNMP) - May 1990

SNMPv2c

RFC 1901 - Introduction to Community-based SNMPv2 - January 1996

RFC 1905 - Protocol Operations for Version 2 of the Simple Network Management Protocol (SNMPv2) -

January 1996

Other relevant documents (for both versions) are:

• RFC 3416 - Version 2 of the Protocol Operations for the Simple Network Management Protocol (SNMP)

- December 2002

• RFC 3584 - Coexistence between Version 1, Version 2, and Version 3 of the Internet-standard Network

Management Framework - August 2003

C.1.6. FAST SQLNET Module

The FAST SQLNET module applies to security functions applied to exchanges of SQL requests that

conform to the SQL*NET/Net9 protocol.

C.1.7. FAST SIP Module

The SIP protocol is defined in the following documents:

• RFC3261 - SIP: Session Initiation Protocol - June 2002

• RFC3265 - Session Initiation Protocol (SIP) - Specific Event Notification - June 2002

• RFC3853 - S/MIME Advanced Encryption Standard (AES) Requirement for the Session Initiation

Protocol (SIP) - July 2004

• RFC4320 - Actions Addressing Identified Issues with the Session Initiation Protocol's (SIP) Non-INVITE

Transaction - January 2006
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C.1.8. FAST MGCP Module

The MGCP protocol is defined in the following documents:

• RFC3435 - Media Gateway Control Protocol (MGCP) Version 1.0 - January 2003

• RFC3661 - Media Gateway Control Protocol (MGCP) Return Code Usage - December 2003

C.1.9. FAST RTP/RTCP Module

The RTP and RTCP protocols are defined in the following documents:

• RFC3550/STD0064 - RTP: A Transport Protocol for Real-Time Applications - July 2003

• RFC3611 - RTP Control Protocol Extended Reports (RTCP XR) - November 2003

C.1.10. FAST TFTP module

TFTP protocol is defined in the following document:

• RFC 1350 - The TFTP protocol - July 1992

C.2.  ICMP Types and Codes

C.2.1. Error Messages

• type 3: destination unreachable

code 0 net unreachable

code 1 host unreachable

code 2 protocol unreachable

code 3 port unreachable

code 4 fragmentation needed and DF set

code 5 source route failed

code 6 destination network unknown

code 7 destination host unknown

code 8 source host isolated

code 9 communication with destination network is administratively prohibited

code 10 communication with destination host is administratively prohibited

code 11 destination network unreachable for type of service

code 12 destination host unreachable for type of service

code 13 communication administratively prohibited

code 14 host precedence violation
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code 15 precedence cutoff in effect

• type 4: source quench

code 0 source quench

• type 5: redirect

code 0 redirect for network error

code 1 redirect for host error

code 2 redirect for type of service and network error

code 3 redirect for type of service and host error

• type 11: time exceeded

code 0 time to live exceeded in transit

code 1 fragment reassembly time exceeded

• type 12: parameter problem

code 0 pointer indicates the error

code 1 a required option is missing

code 2 bad length

C.2.2. Information Messages

The code of all the messages listed below is 0.

type 0 echo reply

type 8 echo request

type 9 router advertisement

type 10 router solicitation

type 13 timestamp request

type 14 timestamp reply

type 16 information request

type 17 information reply
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Appendix D. URL Filtering Categories

 The following is a list and brief description of the URL filtering categories available in the Fast360

configuration and a correlation table between Arkoon/Advanced categories and SmartWeb categories.

D.1. Arkoon URL Filtering Categories

ads Advertizing servers and banned URLs

aggressive Similar to violence but more promoting than depicting

audio-vidéo Sites with audio or video downloads

drugs Drug-related sites

gambling Gambling sites including stocks ans shares

hacking Hacking/cracking information

mail Webmail and email sites

porn Pornography

proxy Sites with proxies to bypass filters

radio Non-news related radio

tv Non-news related television

violence Sites containing violence

warez Sites with illegal pirate software

D.2. Advanced URL Filtering Categories

ADVANCED_URL_ads Advertizing servers and banned URLs

ADVANCED_URL_adult Sites containing adult material such as swearing but not porn

ADVANCED_URL_aggressive Similar to violence but more promoting than depicting

ADVANCED_URL_antispyware Sites to prevent spyware

ADVANCED_URL_artnudes Art sites containing artistic nudity

ADVANCED_URL_astrology Sites about astrology

ADVANCED_URL_audio_video Sites with audio or video downloads

ADVANCED_URL_banking Sites about banks

ADVANCED_URL_beerliquorinfo Sites with information only on beer or liquors

ADVANCED_URL_beerliquorsale Sites selling alcohol

ADVANCED_URL_blog Sites hosting blogs

ADVANCED_URL_cellphones Stuff for mobile/cell phones

ADVANCED_URL_chat Sites with chat rooms

ADVANCED_URL_childcare Sites to do with childcare
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ADVANCED_URL_cleaning Sites dealing with cleaning software

ADVANCED_URL_clothing Sites about and selling clothing

ADVANCED_URL_culinary Sites about cooking/food

ADVANCED_URL_dating Sites about daintg

ADVANCED_URL_desktopsillies Sites with desktop sillies

ADVANCED_URL_dialers Sites with dialers such as those for pornography or trojans

ADVANCED_URL_drugs Drug related sites

ADVANCED_URL_ecommerce Sites that provide online shopping

ADVANCED_URL_entertainment Sites that promote movies, books, magazines, etc.

ADVANCED_URL_filehosting Sites hosting files

ADVANCED_URL_financial Sites on finances

ADVANCED_URL_frencheducation Sites to do with French education

ADVANCED_URL_gambling Gambling sites including stocks ans shares

ADVANCED_URL_games Games sites

ADVANCED_URL_gardening Gardening sites

ADVANCED_URL_government Military sites and schools

ADVANCED_URL_guns Sites about guns

ADVANCED_URL_hacking Hacking/cracking information

ADVANCED_URL_homerepair Sites about home repair

ADVANCED_URL_hygiene Sites about hygiene and other personal grooming-related stuff

ADVANCED_URL_instantmessaging Sites that contain messenger client download and web-based

messaging

ADVANCED_URL_jewelry Sites about and selling jewelry

ADVANCED_URL_jobsearch Sites for finding jobs

ADVANCED_URL_kidstimewasting Sites kids often waste time on

ADVANCED_URL_mail Webmail and email sites

ADVANCED_URL_marketingware Sites about marketingware

ADVANCED_URL_medical Sites about medical issues

ADVANCED_URL_mixed_adult Sites for adults

ADVANCED_URL_mobile_phone Sites about mobile phones

ADVANCED_URL_naturism Sites about naturism

ADVANCED_URL_news News sites

ADVANCED_URL_onlineauctions Online auctions

ADVANCED_URL_onlinegames Online games sites

ADVANCED_URL_onlinepayment Online payment

ADVANCED_URL_personalfinance Personal finance sites

ADVANCED_URL_pets Pet sites

ADVANCED_URL_phishing Sites attempting to trick people into giving out private information

ADVANCED_URL_porn Pornography
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ADVANCED_URL_proxy Sites with proxies to bypass filters

ADVANCED_URL_radio Non-news related radio and television

ADVANCED_URL_reaffected Reaffected sites

ADVANCED_URL_religion Sites promoting religion

ADVANCED_URL_ringtones Sites containing ring tones, games, pictures and other

ADVANCED_URL_searchengines Search engines such as Google

ADVANCED_URL_sect Sites about sects

ADVANCED_URL_sexual_education Site about sexual education

ADVANCED_URL_sexuality Sites dedicated to sexuality, possibly including adult material

ADVANCED_URL_shopping Shopping sites

ADVANCED_URL_socialnetworking Social networking sites

ADVANCED_URL_sportnews Sport news sites

ADVANCED_URL_sports All sports sites

ADVANCED_URL_spyware Sites which download or run spyware or have software available

for download

ADVANCED_URL_updatesites Sites where software updates are available for download,

including virus signatures

ADVANCED_URL_vacation Holiday/vacation/travel information

ADVANCED_URL_verisign Verisign

ADVANCED_URL_violence Sites containing violence

ADVANCED_URL_virusinfected Siteshosting virus-infected files

ADVANCED_URL_warez Sites with illegal pirate software

ADVANCED_URL_weapons Sites detailing or selling weapons

ADVANCED_URL_weather Weather news sites and weather related

ADVANCED_URL_webmail Just webmai lsites

ADVANCED_URL_whitelist Contains sites specifically 100% suitable for kids

D.3. SmartWeb URL Filtering Categories

SMART_WEB_administrative Military, schools and governmental websites

SMART_WEB_ads Advert servers

SMART_WEB_aggressive Websites containing violence and aggressive contents

SMART_WEB_alcohol_tobacco Websites with contents about alcohol or tobacco

SMART_WEB_antispyware Websites that remove spyware

SMART_WEB_astrology Astrology websites

SMART_WEB_audio_video Websites containing audio and video contents

SMART_WEB_blog Blog websites

SMART_WEB_books Websites about books

SMART_WEB_celebrity Websites about celebrity, people
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SMART_WEB_chat Websites with chat rooms or/and instant messaging

SMART_WEB_cheating Websites about cheating on exams

SMART_WEB_child Websites with safe content for childs

SMART_WEB_cleaning Websites about softwares for cleaning / desinfection

SMART_WEB_clothing Clothing and jewelry websites

SMART_WEB_computer_add_ons Websites containing screen savers, backgrounds, cursers,

pointers, desktop themes

SMART_WEB_culture Cultural, educational, dictionnaries and translation websites

SMART_WEB_dating Websites about dating

SMART_WEB_drugs Drugs related websites

SMART_WEB_ecommerce Shopping and ecommerces websites

SMART_WEB_file_sharing Websites to do with file hosting, file sharing

SMART_WEB_finances Websites about finance : banking, personal finance, auctions

SMART_WEB_forums Discussion websites and explicit forum websites

SMART_WEB_gambling Gambling websites including stocks and shares

SMART_WEB_games Games related websites

SMART_WEB_home_stuff Websites about home repair, gardening and culinary

SMART_WEB_humor Humorous websites

SMART_WEB_image_sharing Sites to do with image hosting, image sharing

SMART_WEB_job Websites for finding jobs

SMART_WEB_mail Webmail and mail websites

SMART_WEB_marketingware Websites about marketing products

SMART_WEB_medical Medical websites

SMART_WEB_online_games Online games websites

SMART_WEB_pets Pet websites

SMART_WEB_phone Websites with contents about mobile/cell phones

SMART_WEB_politics Websites of political parties, political organizations and

associations

SMART_WEB_porn_sex Sites containing adult material : sexuality, pornography, naturism

SMART_WEB_press News and press websites

SMART_WEB_professional Sites used in professional environment such as governement,

logistics, banks, help desk websites, applications

SMART_WEB_proxy Websites with proxy to bypass filters

SMART_WEB_radio Radio and television websites

SMART_WEB_religion Websites promoting religion

SMART_WEB_remote_control Websites allowing remote control

SMART_WEB_ringtones Websites containing ringtones, games and others for phones

SMART_WEB_search_engines Search engines such as Google, Bing

SMART_WEB_sect Websites about religious groups

SMART_WEB_social_networks Social networking websites
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SMART_WEB_sports All sports websites

SMART_WEB_suspicious Domains that often match and which we cannot be classified

SMART_WEB_tech_internal Websites in relation with other websites : URL shorteners,

redirectors, content delivery networks

SMART_WEB_technology Websites with information about computers, softwares,

hardwares and IT news

SMART_WEB_transport Websites that provide travel and tourism information

SMART_WEB_update_sites Websites where software updates are downloaded

SMART_WEB_vacation Websites about going on holidays

SMART_WEB_weapons Weapons/guns related websites

SMART_WEB_weather Weather news websites and weather related

D.4. URL filtering category groups

GROUP_SMART_WEB_adult_and_violent
Group including categories in relation with adult or violent

contents

GROUP_SMART_WEB_bandwidth
Group including categories in relation with bandwidth

consumption

GROUP_SMART_WEB_entertainment
Group including categories in relation with entertainment

GROUP_SMART_WEB_technology
Group including categories in relation with technology

GROUP_SMART_WEB_trade_and_economy
Group including categories in relation with trade and economy

GROUP_SMART_WEB_white_list_general
Group including categories which may be considered as general

white lists

GROUP_SMART_WEB_white_list_more_restrictive
Group including categories which may be considered as very

restrictive white lists

GROUP_SMART_WEB_white_list_restrictive
Group including categories which may be considered as

restrictive white lists

D.5. Correlation table between Arkoon/Advanced

categories and SmartWeb categories

If you need to replace Arkoon or Advanced categories in your applicative rules by SmartWeb categories,

the following table indicates the correlation for each category between the different URL filtering

systems.
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Arkoon/Advanced categories SmartWeb categories

ADVANCED_URL_frencheducation

ADVANCED_URL_government

SMART_WEB_administrative

ADVANCED_URL_ads

ads

SMART_WEB_ads

ADVANCED_URL_aggressive

ADVANCED_URL_violence

aggressive

violence

SMART_WEB_aggressive

ADVANCED_URL_beerliquorinfo

ADVANCED_URL_beerliquorsale

SMART_WEB_alcohol_tobacco

ADVANCED_URL_antispyware SMART_WEB_antispyware

ADVANCED_URL_astrology SMART_WEB_astrology

ADVANCED_URL_audio_video

audio_video

tv

SMART_WEB_audio_video

ADVANCED_URL_blog SMART_WEB_blog

ADVANCED_URL_entertainment SMART_WEB_celebrity

ADVANCED_URL_chat

ADVANCED_URL_instantmessaging

SMART_WEB_chat

ADVANCED_URL_childcare SMART_WEB_child

ADVANCED_URL_cleaning SMART_WEB_cleaning

ADVANCED_URL_clothing

ADVANCED_URL_jewelry

SMART_WEB_clothing

ADVANCED_URL_desktopsillies SMART_WEB_computer_add_ons

ADVANCED_URL_dating SMART_WEB_dating

ADVANCED_URL_drugs

drugs

SMART_WEB_drugs

ADVANCED_URL_shopping

ADVANCED_URL_ecommerce

SMART_WEB_ecommerce
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Arkoon/Advanced categories SmartWeb categories

ADVANCED_URL_filehosting SMART_WEB_file_sharing

ADVANCED_URL_onlinepayment

ADVANCED_URL_onlineauctions

ADVANCED_URL_banking

ADVANCED_URL_financial

ADVANCED_URL_personalfinance

SMART_WEB_finances

ADVANCED_URL_gambling

gambling

SMART_WEB_gambling

ADVANCED_URL_games

ADVANCED_URL_kidstimewasting

SMART_WEB_games

ADVANCED_URL_homerepair

ADVANCED_URL_gardening

ADVANCED_URL_culinary

SMART_WEB_home_stuff

ADVANCED_URL_jobsearch SMART_WEB_job

ADVANCED_URL_webmail

ADVANCED_URL_mail

mail

SMART_WEB_mail

ADVANCED_URL_marketingware SMART_WEB_marketingware

ADVANCED_URL_medical SMART_WEB_medical

ADVANCED_URL_onlinegames SMART_WEB_online_games

ADVANCED_URL_pets SMART_WEB_pets

ADVANCED_URL_cellphones

ADVANCED_URL_mobile_phone

SMART_WEB_phone

ADVANCED_URL_adult

ADVANCED_URL_porn

ADVANCED_URL_mixed_adult

ADVANCED_URL_hygiene

SMART_WEB_porn_sex
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Arkoon/Advanced categories SmartWeb categories

ADVANCED_URL_sexuality

ADVANCED_URL_artnudes

ADVANCED_URL_naturism

porn

ADVANCED_URL_news SMART_WEB_press

ADVANCED_URL_dialers

ADVANCED_URL_proxy

proxy

SMART_WEB_proxy

ADVANCED_URL_radio

radio

SMART_WEB_radio

ADVANCED_URL_religion SMART_WEB_religion

ADVANCED_URL_ringtones SMART_WEB_ringtones

ADVANCED_URL_searchengines SMART_WEB_search_engines

ADVANCED_URL_sect SMART_WEB_sect

ADVANCED_URL_socialnetworking SMART_WEB_social_networks

ADVANCED_URL_sports

ADVANCED_URL_sportnews

SMART_WEB_sports

ADVANCED_URL_verisign SMART_WEB_tech_internal

ADVANCED_URL_updatesites SMART_WEB_update_sites

ADVANCED_URL_vacation SMART_WEB_vacation

ADVANCED_URL_weapons

ADVANCED_URL_guns

SMART_WEB_weapons

ADVANCED_URL_weather SMART_WEB_weather

URL classified in the following Advanced categories are not available in SmartWeb categories because

there are automatically taken into account by the SmartWeb antivirus:

• ADVANCED_URL_spyware

• ADVANCED_URL_virusinfected

• ADVANCED_URL_phishing

• ADVANCED_URL_hacking

• ADVANCED_URL_warez

• ADVANCED_URL_whitelist
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The following additional SmartWeb categories are proposed:

• SMART_WEB_books

• SMART_WEB_cheating

• SMART_WEB_culture

• SMART_WEB_forums

• SMART_WEB_humor

• SMART_WEB_image_sharing

• SMART_WEB_politics

• SMART_WEB_professional

• SMART_WEB_remote_control

• SMART_WEB_suspicious

• SMART_WEB_technology

• SMART_WEB_transport
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Appendix E. Implicit Filtering Rules

E.1. Default Antispoofing Rules

The notations used in this appendix are the following:

• ethx: name of the Ethernet interface (eth0, eth1, etc.)

• any: designates any object of this type.

Note

In the case of a source or destination, the object “any” does not include the Fast360 appliance.

• Fast360 appliance: the Arkoon object is selected as a source or destination.

Name: ethx antispoofing (IN)

Exception: this antispoofing blocking rule is not applied to flows whose destination is one of the addresses

of the Fast360 appliance and whose service is the one selected in a filtering rule with PAT. It is not apply

either to the connections from a VPN.

Input interface: not ethx

Source: any

Destination: ethx addresses

Service: any

Action: block

Logging: standard

Name: ethx antispoofing (FW)

Input interface: not ethx

Source: networks directly connected to ethx or specified in the Authorized networks of the interface in

Arkoon Manager

Destination: networks directly connected to ethx or specified in the Authorized networks of the interface

in  Arkoon Manager

Service: any

Action: block

Logging: standard

Name: lo antispoofing (IN)
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Input interface: not lo

Source: any

Destination: 127.0.0.0/8

Service: any

Action: block

Logging: standard

Name: lo antispoofing (FW)

Input interface: not lo

Source: 127.0.0.0/8

Destination: any

Service: any

Action: block

Logging: standard

E.2. Default Administration Rules

Name: Admin-From

Input interface: the interfaces specified in the admin from parameter of  minarkconf

Source: the addresses specified in the admin from parameter of  minarkconf

Destination: Arkoon

Service: TCP 1750, 1751, 822 (it is possible to remove some of these ports in  minarkconf )

Action: accept

Logging: standard

Name: Akslave-From

Input interface: the interfaces specified in the allow from parameter of master/slave(config) of

minarkconf

Source: the addresses specified in the allow from parameter of master/slave(config) of  minarkconf

Destination: Arkoon

Service: TCP 1754Action: accept

Logging: Standard
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E.3. Various Implicit Filtering Rules

Input interface: any

Source:  Fast360

Destination: any

Service: TCP 25 (with the FAST analysis)

Action: accept

Logging: none

Name: myArkoon: Proxy HTTP allow_from

Input interface: the interfaces specified in Monitoring interfaces of HTTP/FTP proxy of  Arkoon Manager

Source: the addresses specified in Authorized networks of HTTP/FTP proxy of  Arkoon Manager

Destination: Fast360

Service: well-known port specified in the characteristics of the proxy (with the FAST analysis)

Action: accept

Logging: none

Name: myArkoon: Proxy HTTP Access

Input interface: any

Source: Fast360

Destination: any

Service: TCP ports defined in the HTTP/FTP proxy of  Arkoon Manager  (with the FAST analysis if the port

is specified in the HTTP or FTP window)

Action: accept

Logging: none

Name: myArkoon: IKE Access

Input interface: any

Source: the addresses specified in Authorized VPN servers of VPN module of  Arkoon Manager

Destination: Fast360

Service: UDP 500 UDP 4500 if NAT-T is activated

Action: accept
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Logging: none

Name: myArkoon: IKE Output

Input interface: any

Source: Fast360

Destination: any

Service: source port and destination port:UDP 500UDP 4500 if NAT-T is activated

Action: connection acceptation

Logging: none

Name: myArkoon: DNS Access

Input interface: any

Source: Fast360

Destination: the addresses specified in DNS of  Arkoon Manager

Service: TCP and UDP 53 (with the FAST analysis)

Action: accept

Logging: none

Name: myArkoon: SNMP Traps Access

Input interface: any

Source: Fast360

Destination: the addresses specified in Traps SNMP of Alerts and logs in  Arkoon Manager

Service: UDP 162

Action: accept

Logging: none

Name: myArkoon: Syslog Access

Input interface: any

Source: Fast360

Destination: the addresses specified in Syslog servers of Alerts and logs in  Arkoon Manager

Service: UDP 514

Action: accept

Logging: none
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Name: myArkoon: Authentication queries

Input interface: any

Source: Fast360

Destination: any

Service: UDP 9271

Action: accept

Logging: none

Name: myArkoon: Proxy POP3 Access

Input interface: any

Source: any

Destination: any

Service: TCP 110 (with the FAST analysis)

Action: accept

Logging: none

Name: HA-NTP-To Rule installed on the passive appliance.

Input interface: any

Source: Fast360

Destination: IP address of the other appliance specified in the master/slave(HA) parameter of

minarkconf .

Service: UDP 123

Action: accept

Logging: standard

Name: HA-Update-To Rule installed on the passive appliance.

Input interface: any

Source: Fast360

Destination: IP address of the other appliance specified in the master/slave(HA) parameter of

minarkconf .

Service: TCP 1752

Action: accept

Logging: standard
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Name: Sync Protocol Unicast In

Source: Real IP of another Fast360 appliance declared in the interface

Destination: My real IP declared in this interface.

Destination port: UDP 1760

Name: Sync Protocol Unicast Out

Source: Real IP declared in this interface

Destination: Real IP of another Fast360 appliance declared in the interface.

Destination port: UDP 1760

Name: VRRP In

Input interface: any

Destination: 224.0.0.18

Source port: Protocol IP 112

Destination port: Protocol IP 112

Name: VRRP Out

Source: Local IP

Destination: 224.0.0.18

Source port: Protocol IP 112

Destination port: Protocol IP 112

Name: Akha Input rule

Source: Network of the admin-syncaddress interface

Destination: Local IP

Destination port: TCP 1756

Name: Akha Output rule

Source: Local IP

Destination: Real IP address of the 'admin-syncaddress' interface.

Destination port: TCP 1756

Name: Akauth Input Rule

Source: All sources of all filtering rules which use the Arkoon Authentication agent as authentication

mode.
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Destination: Fast360 appliance

Service: TCP 1755

Action: accept

Logging: none

E.4. Default Blocking Rules

Name: Default deny on input

Input interface: any

Source: any

Destination: Fast360

Service: any

Action: block

Logging: complete

Name: Default deny on forward

Input interface: any

Source: any

Destination: any

Service: any

Action: block

Logging: complete

Name: Default deny on output

Input interface: any

Source: Fast360

Destination: any

Service: any

Action: refuse

Logging: complete
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Appendix F. Types of logs

This section describes the different types of Arkoon Fast360 appliances logs.

The following types of logs can be generated with an Fast360 appliance, depending on the features and

configuration :

• Alerts: general logs related to security functions.

• IP: filtering policy logs (flow rules, IP/TCP/UDP controls and Fast360 applicative controls).

• IDPS: logs specific to IDPS (Intrusion Detection and Prevention System) feature.

• HTTP: HTTP relay logs.

• SMTP: SMTP relay logs.

F.1. General description

F.1.1. Alerts logs

AKLOG - id=firewall time="2004-02-25 17:38:51" pri=4 fw=myArkoon aktype=ALERT gmtime=1077727131

alert_type="Blocked by application control" user="userName" alert_level="Low" alert_desc="TCP from

10.10.192.61:33027 to 10.10.192.156:25 [default rule]"

F.1.2. IP logs

AKLOG-id=firewall time="2004-02-25 17:38:57" fw=myArkoon aktype=IP gmtime=1077727137

ip_log_type=ENDCONN src=10.10.192.61 dst=10.10.192.255 proto="137/udp" protocol=17 port_src=137

port_dest=137 intf_in=eth0 intf_out= pkt_len=78 nat=NO snat_addr=0 snat_port=0 dnat_addr=0

dnat_port=0 user="userName" pri=3 rule="myRule" action=DENY reason="Blocked by filter"

description="dst addr received from Internet is private"

F.1.3. IDPS logs

AKLOG-id=firewall time="2004-02-25 17:38:57" fw=myArkoon aktype=IDPSMATCH gmtime=1077727137

src=10.10.192.61 dst=10.10.192.255 proto="137/udp" protocol=17 port_src=137 port_dest=137 profile=1

sid=123 score=50

AKLOG-id=firewall time="2004-02-25 17:38:57" fw=myArkoon aktype=IDPSALERT gmtime=1077727137

src=10.10.192.61 dst=10.10.192.255 proto="137/udp" protocol=17 port_src=137 port_dest=137 profile=1

endcnx_score=100 ch=1 reaction=0

F.1.4. HTTP logs

AKLOG-id=firewall time="2004-02-25 17:42:54" fw=myArkoon pri=6 aktype=HTTP gmtime=1077727374

src=10.10.192.61 proto=http user="userName" op="GET" dstname=www arg="http://www/ HTTP/1.1" ref=""

agent="Mozilla/5.0 (X11; U; Linux i686; en-US; rv:1.0.0) Gecko/20020623 Debian/1.0.0-0.woody.1" rcvd=355

result=407
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F.1.5. SMTP logs

AKLOG-id=firewall time="2004-02-25 18:01:46" fw=myArkoon pri=6 aktype=SMTP gmtime=1077728506

proto=smtp id_mail=nPhgMW src=10.10.192.61 sent=5 srcname="source@arkoon.dev"

dstname="dest@arkoon.dev" subject="Subject" result="Received OK" reason="" rule="Smtp relay"

F.2. Fields

F.2.1. Fields present in all logs

There are four fields required for each record:

• Record identifier (id=)

• Date/time (time=)

• Firewall IP address or name (fw=)

• Priority of the record (pri=)

The first two fields for each record are (after “AKLOG - “) id= and time= in that order.

• id=

This field identifies the type of record. For Fast360 logs, the type is always firewall to respect the

compatibility with Webtrends Welf format.

id=firewall

• time=

The date/time field shows the date and time of the event, local time. The form of the date/time field is

(enclosed in double quotes):

time=”yyyy-mm-dd hh:mm:ss”
yyyy: year (always 4 digits)
mm: number between 1 and 12 (inclusive) to represent the month (1 or 2 digits)
dd: day of the month, (1 or 2 digits)
hh: hour, based on 24-hour clock (1 or 2 digits)
mm: minute (1 or 2 digits)
ss: second (1 or 2 digits)

For example, 8:00 am on January 1, 2004 is represented as:

time=”2004-01-01 06:00:00”

8:00 pm on the same day is represented as:

time=”2004-01-01 20:00:00”

• gmtime=

The time is also represented in Utime-unix time, that is to say in number of seconds since1970-01-01

00:00:00

gmtime=1077727131

• fw=
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This field identifies the firewall which generated the log record. This is most often represented as an

IP address or a machine name. If the firewall is logged, the IP address is always the IP address of the

internal network interface or the IP address of the external network interface, not a mixture of the two.

fw=10.10.192.162  fw=myArkoon 

• pri=

Event priority. Possible values are:

0 - emergency  
1 - alert  
2 - critical  
3 - error  
4 - warning  
5 - notice  
6 - information  
7 - debug    

pri=0  
pri=5

• aktype=

Type of log which can be one of the following:

ALERT – for alerts logs  
IP – for IP firewall logs  
IDPSMATCH – for IDPS matches logs  
IDPSALERT – for IDPS alerts logs  
HTTP- for HTTP proxy logs  
SMTP – for SMTP proxy logs    

aktype=HTTP 

F.2.2. Fields specific to alerts logs

• alert_type=

This field identifies the type of alert which can be one of the following (alert_type ID, alert_type name)
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0      None  
1      Bad packet  
2      Blocked by filter  
3      Blocked by application control  
4      Unsequenced packet  
5      Bad SPI (VPN)  
6      No license  
7      Portscan detected  
8      Virus found  
9      Upgrade  
10    Interface Up  
11    Interface Down  
12    Service restarted  
13    Interface disconnected  
14    Interface reconnected  
15    HA Active  
16    HA Passive  
17    HA Link Up  
18    HA Link Down  
19    Admin Connection  
20    Config file installed  
21    IKE Alert  
22    Arkoon Up  
23    Arkoon Down  
24    Mail Quarantine FULL  
25    Outconn UP  
26    Outconn DOWN  
27    New mail in quarantine  
28    Rule denied mail  
29    Encrypted file in mail  
30    Analyze error in mail  
31    Authentication failure  
32    Patch kernel Arkoon  
33    Automatic Flush and Backup  
34    DoS Attack Detection  
35    Service started  
36    Service stopped  
37    Date/Time modification  
38    Certificate created  
39    Certificate revoked
40    DB Table flushed 
41    Admin user added/removed 
42    Automatic Flush and Backup (Table full) 
43    AdminFrom value modification 
44    Warning on log queue 
45    Warning on /var 
46    Warning on /config_card 
47    Network traffic blocked due to Aklog 
48    Network traffic unblocked 
49    System Monitoring alert 
50    Flush database 
51    NTP (de)synchronization 
52    IDPS alert 
53    Routing alert 
54    Mail Disclaimer fail 
55    FireConverge blacklist alert 
56    Media alert 
57    DHCP Relay 
58    DHCP Server 
59    Admin unauthorized access 
60    Real Time Antispam 
61    Cluster state changed
62    Node state change request
63   Appliance activation
64  Number of connections
65  Datacenter license
66  Domain junction
67  Master/Slave
68  Cluster initialization
69  CRL
70  Smart URL filtering
Unknown (�u) (where �u is an unsigned long integer)

alert_type="Blocked by filter" 

• user=

Name of user who generated this particular alert.

user=”userName”

• alert_level=
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This field identifies the alert level, which can be one of the following: None (Information), Low, Medium

or High (alert_level ID, alert_level name)

0   None (Information)  
1   Low  
2   Medium  
3   High    

alert_level=”Low” 

• alert_desc=

This is the alert description which can be one of the following:

TCP from ipS:portS to ipD:portD [desc] 
UDP from ipS:portS to ipD:portD [desc]
ICMP:portD.portS from ipS to ipD [desc] 
PROTO:protocol from ipS to ipD [desc] 
Unsequenced packet on non-TCP proto from ipS:portS 
Unsequenced TCP packet from ipS:portS to ipD:portD 
ACK unsequenced packet on non-TCP proto from ipS:portS 
ACK unsequenced TCP packet from ipS:portS to ipD:portD 
Bad flags on non-TCP proto from ipS:portS 
Bad TCP flags (�s) from ipS:portS to ipD:portD 
Bad packet from ipS:portS to ipD:portD [desc] 
Land attack from ipS to ipD 
New value: ipS/Mask [ports] 
No license installed 

with

ipS: IP address of the source of the event 
portS: Port number of the source of the event 
ipD: IP address of the destination of the event 
portD: Port number of the destination of the event 
Mask: network Mask 
ports: List of authorized ports separated by a space 
desc: Description 
protocol: see below for a description of protocol 

Example:

alert_desc="TCP from 10.10.192.61:33027 to 10.10.192.156:25  [default rule]"

F.2.3. Fields specific to IP logs

• ip_log_type=

This field identifies the type of IP log. The possible values are NEWCONN, ENDCONN, BADPACKET,

APPVIOLATION or an empty string value.

ip_log_type=NEWCONN 
ip_log_type= 

• src=

Src is the IP address that generated the event.

src=10.10.192.155

• dst=

Dst is the IP address that received the event.

dst=10.10.192.61

• proto=

The protocol used by the event formatted like this “destination port number/name of protocol”.

proto=”631/udp”  
proto=”1751/tcp”
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• protocol=

Id of the protocol. Example of esp protocol:

protocol=50 

• port_src=

Port number of the event source.

port_src=137 

• port_dest=

Port number of the event destination.

port_dest=137

• intf_in=

This field identifies the name of the incoming interface. It can be empty.

intf_in=eth0  
intf_in=

• intf_out=

This field identifies the name of the outcoming interface. It can be empty.

 intf_out=eth0  
intf_out=

• pkt_len=

Identifies the length (in bytes) of the packet that triggered the event.

pkt_len=78

• nat=

This field identifies the type of NAT (Network address Translation) used. Values can be NO, HIDE, PAT

or STATIC.

nat=STATIC 

• snat_addr=

Address of the nat-ed source or “0” if Network Address Translation is not used.

snat_addr=194.3.2.1  snat_addr=0

• snat_port=

Port number of the nat-ed source or “0” if Network Address Translation is not used.

snat_port=4378  snat_port=0

• dnat_addr=

Address of the nat-ed destination or “0” if Network Address Translation is not used.

dnat_addr=196.5.4.8  dnat_addr=0

• dnat_port=

Port number of the nat-ed destination or “0” if Network Address Translation is not used.

 dnat_port=80  dnat_port=0 

• user=
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The name of the user who generated the event (if known).

user=”userName”  user=”” 

• vpn-src=

For a packet which was encrypted in an IPSec tunnel, this is an ID of the tunnel (either the login name

or the IPSec-ID used to negociate the IPSec SA).

vpn-src=”C=fr,..., CN=John Doe”  vpn-src=”jdoe”  vpn-src=““ 

• rule=

This field identifies the name of the rule that produced the event.

rule="myRule"

• action=

Three types of action are possible: ACCEPT, DENY or REJECT

action=ACCEPT

• reason=

Reason of this event log which can be one of the following messages:

Blocked by filter / Unsequenced packet / ACK unsequenced packet / Bad Flags packet / Blocked by

application control / Bad packet / Bad SPI / Land Attack / Bad License / Bad encryption source / Bad

encryption destination / Maximum waiting connections reached / Maximum established connections

reached / No module found / Ident Hack

reason="Blocked by filter" 

• description=

This is a description of the event which can also be an empty string. Possibles values are:

src addr received from Internet is private / dst addr received from Internet is private / src addr to be

sent to Internet is private / dest addr to be sent to Internet is private / Oversized IP packet / Bad IP

Options / IP Options not allowed by config

description="dst addr received from Internet is private" 
description=”” 

• sent=

This field only exists into exported logs and not into logs sent to a Syslog server. It identifies the number

of bytes sent to the connection corresponding to this packet.

sent=655

• rcvd=

The number of bytes transferred from the destination to the source.

 rcvd=655

• end_reason=

Description or reason of the end of connection.

end_reason=”Closed by Client”  
end_reason=”Reset by Server” 
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F.2.4. Fields present in all IDPS logs

These fields can be found in IDPSMATCH or IDPSALERT:

• src=

Source IP address which generated the event.

src=194.3.2.1  

• dst=

Dst is the IP address that received the event.

dst=10.10.192.61

• proto=

The protocol used by the event formatted the following way: “destination port number/name of

protocol”.

proto=”631/udp”  
proto=”1751/tcp”

• protocol=

Id of the protocol. Example of esp protocol:

protocol=50

• port_src=

Port number of the event source.

port_src=137

• port_dest=

Port number of the event destination.

port_dest=137

• profile=

This field identifies the id of the IDPS profile with the following correspondence (07/01/04):
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1   FTP_BADFILES        Suspicious filenames in commands                  
2   FTP_SCAN              Scanning attempts                                 
3   FTP                        General FTP signatures                            
4   HTTP                     General HTTP signatures                           
5   HTTP_BADURL        URLs of known attacks and vulnerabilities in CGIs 
6   HTTP_COLDFUSION Vulnerabilities in ColdFusion applications        
7   HTTP_FRONTPAGE   Vulnerabilities in Microsoft Frontpage   applications 
8   HTTP_IIS                Vulnerabilities in Microsoft IIS                  
9   HTTP_PHP              Vulnerabilities in PHP applications               
10  HTTP_NETSCAPE    Vulnerabilities in Netscape Enterprise httpd      
11  HTTP_TOMCAT       Vulnerabilities in Apache Tomcat                  
12  HTTP_APACHE        Vulnerabilities in Apache httpd               
13  HTTP_WINDOWS    Vulnerabilites in HTTP applications specific to 
Microsoft Windows 
14  HTTP_ORACLE        Vulnerabilities in Oracle                         
15  HTTP_TALENTSOFT  Vulnerabilities in Talentsoft applications        
16  HTTP_LOTUS            Vulnerabilities in Lotus applications             
17  HTTP_UNIX              HTTP attacks specific to Unix-like systems        
18  HTTP_CISCO            HTTP attacks against Cisco products               
19  HTTP_WEBLOGIC      HTTP attacks against Weblogic applications        
20  HTTP_MYSQL           HTTP attacks related to the MySQL database 
server 
21  HTTP_MACOS           HTTP attacks specific to MacOS systems            
22  HTTP_VIRUSWALL    HTTP attacks against Viruswall products           
23  SMTP                      SMTP attacks                                      
24  IMAP4                     IMAP attacks                                      
25  POP3                       POP3 attacks                                      
26  DNS                        DNS attacks   
 
Example: 
profile=23 

F.2.5. Fields specific to IDPS matchs logs (IDPSMATCH)

• sid=

Id of the ARKOON IDPS signature that generated the match.

sid=125

• score=

Numeric field which identifies the score of the ARKOON IDPS match.

score=80

F.2.6. Fields specific to IDPS alert logs (IDPSALERT)

• endcnx_score=

Numeric field providing the score value when the connection ends.

endcnx_score=125  Product Eng

• ch=

Boolean indicating if the connection was for a host seen as jeopardized by the IDPS (e.g. a host to

which there has already been an IDPS power connection ).

ch=0 (if the host is a compromised one)  
ch=1 (if it is not)

• reaction=

Numeric field which identifies the type of reaction the IDPS had.

reaction=0 (for a RESET)  
reaction=1 (for a DROP)  
reaction=2 (for a HALF/DROP)
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F.2.7. Fields specific to HTTP logs

• src=

Source IP address which produced the event.

src=194.3.2.1

• proto=

This field identifies the protocol of the event.

proto=https  proto=http

• user=

This is the name of the user who generated the event (if known).

user=”myName”

• op=

For HTTP and FTP requests, it is an operation such as GET, POST, HEAD, etc.

op=”GET”

• dstname=

The IP address or URL that received the event and the port.

dstname=www.arkoon.net:80  
dstname=195.167.226.90:80

• arg=

For HTTP and FTP requests, it is the accessed URL .

arg=”http://www.arkoon.net:80 HTTP/1.1”  
arg=”http://195.167.226.90:80 HTTP/1.0” 

• ref=

For incoming web records, this field contains the referring site.

arg=”http://www.securityfocus.com”

• agent=

For incoming or outgoing web records, this field contains the agent (usually the browser).

agent="Mozilla/5.0 (X11; U; Linux i686; en-US; rv:1.0.0  
Gecko/20020623 Debian/1.0.0-0.woody.1"  
agent="Microsoft Internet Explorer/4.40.308 (Windows 95)" 

• rcvd=

The number of bytes transferred from the destination to the source.

rcvd=355

• result=

For HTTP requests, this is the standard result code, such as 200 for success, 304 for returned from

cache, etc.

result=407
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F.2.8. Fields specific to SMTP logs

• proto=

This field identifies the event protocol.

proto=smtp

• id_mail=

The id of the mail.

id_mail=nPhgMW

• src=

Source IP address which produced the event.

src=194.3.2.1

• sent=

Number of bytes transferred from the source to the destination.

sent=5

• srcname=

Mail source name.

srcname="source@arkoon.dev"

• dstname=

Mail destination name.

dstname="dest@arkoon.dev"

• subject=

Mail subject

subject="Subject of my message"

• result=

Result message, which can be:

Content OK / Virus found in message / Message denied by rule / Mail denied / File repaired / File

removed / File encrypted / Received OK / Message too big / Relaying denied / Mail put in quarantine /

Mail sent without analyze / Mail removed from quarantine / Analyze file error

result=”Received OK”

• reason=

This field identifies the reason of the event.

Virus / Virus virusName found in file/ Name File fileName encrypted / File fileName : analyze error /

Quarantine full! / Denied by rule ruleName / Denied by rule ruleName, put mail in quarantine.

with: virusName: name of the virus

fileName: name of the file
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example: 
reason="File document.pif encrypted" 
reason=”Virus found in document.pif” 

• rule=

The name of the rule which created the event.

rule=”Smtp Relay” 

F.3. IDPS signatures

ID       Name
1        FTP_CWD_C_COLON
2        FTP_SITE_ZIPCHK
3        FTP_SITE_NEWER
4        FTP_SITE_EXEC
5        FTP_STAT_STAR
6        FTP_STAT_QUESTION
7        FTP_TAR_PARAMETERS
8        FTP_CWD_ROOT
9        FTP_CWD_DOTS
10      FTP_CWD_NEWLINE
11      FTP_CWD_CR_NEWLINE
12      FTP_SERVU_TRAVERSAL
13      FTP_FORMAT_STRING
14      FTP_RNFR
15      FTP_DOT_FORWARD
16      FTP_DOT_RHOSTS
17      FTP_DOT_AUTHKEYS
18      FTP_PASSWD
19      FTP_SHADOW
20      FTP_ADMWORM
21      FTP_ADMSCAN
22      FTP_ISS_SCAN
23      FTP_PASS_WHOOT
24      FTP_PISS_SCAN
25      FTP_SAINT_SCAN
26      FTP_SATAN_SCAN
27      HTTP_BIN_PS
29      HTTP_BIN_WGET
30      HTTP_BIN_UNAME
31      HTTP_BIN_ID
32      HTTP_BIN_ID_2
33      HTTP_BIN_ECHO
34      HTTP_BIN_KILL
35      HTTP_BIN_CHMOD
36      HTTP_BIN_CHGRP
37      HTTP_BIN_CHOWN
38      HTTP_BIN_CHSH
39      HTTP_BIN_TFTP
40      HTTP_BIN_GCC
41      HTTP_BIN_GCC_2
42      HTTP_BIN_CC
43      HTTP_BIN_CC_2
44      HTTP_BIN_CPP
45      HTTP_BIN_CPP_2
46      HTTP_BIN_GPP
47      HTTP_BIN_GPP_2
48      HTTP_BIN_PYTHON
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49      HTTP_BIN_PYTHON_2
50      HTTP_BIN_TCLSH
51      HTTP_BIN_TCLSH_2
52      HTTP_BIN_NASM
53      HTTP_BIN_NASM_2
54      HTTP_BIN_PERL
55      HTTP_BIN_PERL_2
56      HTTP_WIN_NT_ADM
57      HTTP_BIN_TRACEROUTE
58      HTTP_BIN_PING
59      HTTP_BIN_NETCAT
60      HTTP_BIN_NMAP
61      HTTP_BIN_XTERM
62      HTTP_X_DISPLAY
63      HTTP_BIN_LSOF
64      HTTP_BIN_RM
65      HTTP_BIN_MAIL
66      HTTP_BIN_MAIL_2
67      HTTP_BIN_LS
69      HTTP_INETD
70      HTTP_MOTD
71      HTTP_ETC_SHADOW
72      HTTP_HTTPD_DOT_CONF
73      HTTP_HTGROUP
74      HTTP_OUTLOOK_DOT_EML
75      HTTP_XMLHTTPREQUEST
76      HTTP_README_DOT_EML
77      HTTP_README_DOT_EML_2
78      HTTP_JAVASCRIPT_DOC_DOMAIN
79      HTTP_URL_SPOOFING
80      HTTP_CGI_HYPERSEEK
81      HTTP_YABB_ACCESS
82      HTTP_CGI_WWWBOARD_PASSWD
83      HTTP_CGI_WEBDRIVER
85      HTTP_CGI_WHOIS_RAW_2
86      HTTP_CGI_WEBPLUS_ABOUT
87      HTTP_CGI_WEBSENDMAIL
88      HTTP_CGI_DCFORUM
89      HTTP_CGI_DCBOARD
90      HTTP_CGI_MMSTDOD
92      HTTP_CGI_IMAGEMAP_2
93      HTTP_CGI_CVSWEB
94      HTTP_CGI_GLIMPSE
95      HTTP_CGI_HTMLSCRIPT
96      HTTP_CGI_INFO2WWW
97      HTTP_CGI_MAILLIST
98      HTTP_CGI_NPH_TEST
99      HTTP_CGI_NPH_PUBLISH
100    HTTP_CGI_NPH_PUBLISH_2
101    HTTP_CGI_RGUEST
102    HTTP_CGI_RWWWSHELL
104    HTTP_CGI_TEST_CGI
105    HTTP_CGI_TEST_CGI_2
106    HTTP_CGI_TEST_CGI_3
107    HTTP_CGI_TESTCOUNTER
108    HTTP_CGI_UPLOADER
109    HTTP_CGI_WEBGAIS
110    HTTP_CGI_FINGER
111    HTTP_CGI_PERLSHOP
112    HTTP_CGI_PFDISPLAY
113    HTTP_CGI_AGLIMPSE
114    HTTP_CGI_ANFORME2
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115    HTTP_CGI_ARGS_BAT
116    HTTP_CGI_ARGS_CMD
117    HTTP_CGI_AT_ADMIN
118    HTTP_CGI_AT_GENERATED
119    HTTP_CGI_BNBFORM
120    HTTP_CGI_CAMPAS
122    HTTP_CGI_VIEW_SOURCE
123    HTTP_CGI_WAIS
124    HTTP_CGI_WWWWAIS
125    HTTP_CGI_FILES_PL
126    HTTP_CGI_WGUEST
127    HTTP_CGI_WRAP
128    HTTP_CGI_CLASSIFIEDS
129    HTTP_CGI_ENVIRON
130    HTTP_CGI_FAXSURVEY
132    HTTP_CGI_MAN
133    HTTP_CGI_SNORK
134    HTTP_CGI_W3MSQL
135    HTTP_CGI_DAY5DATACOPIER
136    HTTP_CGI_POST_QUERY
137    HTTP_CGI_VISADMIN
138    HTTP_CGI_DUMPENV
140    HTTP_CGI_CALENDAR
142    HTTP_CGI_CALENDER
143    HTTP_CGI_USER_UPDATE
144    HTTP_CGI_SURVEY
145    HTTP_CGI_WIN_C_SAMPLE
146    HTTP_CGI_W3TVARS
147    HTTP_CGI_ADMIN
148    HTTP_CGI_LWGATE
149    HTTP_CGI_ARCHIE
150    HTTP_CGI_FLEXFORM
152    HTTP_CGI_PHF
153    HTTP_CGI_WWW_SQL
154    HTTP_CGI_WWWADMIN
155    HTTP_CGI_PPDSCGI
156    HTTP_CGI_SENDFORM
157    HTTP_CGI_UPLOAD
158    HTTP_CGI_ANYFORM2
160    HTTP_CGI_BBHIST
161    HTTP_CGI_BBHISTLOG
162    HTTP_CGI_HISTSVC
163    HTTP_CGI_BBREP
164    HTTP_CGI_BBREPLOG
165    HTTP_CGI_REDIRECT
167    HTTP_CGI_PALSCGI
168    HTTP_CGI_COMMERCE
169    HTTP_CGI_AMAYA_TEMPLATE
171    HTTP_CGI_TSTISAPI
172    HTTP_CGI_SENDMESSAGE
173    HTTP_CGI_LASTLINES
176    HTTP_CGI_AGORA
177    HTTP_CGI_RKSH
178    HTTP_CGI_BACH
179    HTTP_CGI_PERLEXE
180    HTTP_CGI_PERLCOMMAND
181    HTTP_CGI_ZSH
182    HTTP_CGI_CSH
183    HTTP_CGI_RSH
184    HTTP_CGI_KSH
186    HTTP_CGI_CGIFORUM
187    HTTP_CGI_DIRECTORYPRO



Appendix F. Types of logs

IDPS signatures | 529

189    HTTP_CGI_LISTREC
190    HTTP_CGI_MAILNEWS
191    HTTP_CGI_BOOK
192    HTTP_CGI_NEWSDESK
193    HTTP_CGI_CALMAKE
194    HTTP_CGI_MAILIT
195    HTTP_CGI_SDBSEARCH
196    HTTP_CGI_SWC
197    HTTP_CGI_TTAWEBTOP
198    HTTP_CGI_UPLOAD_2
199    HTTP_CGI_VIEWSOURCE
200    HTTP_CGI_USTOREKEEPER
201    HTTP_CGI_ICAT
202    HTTP_CGI_BUGZILLA_EDITVOTES
203    HTTP_CGI_HTSEARCH
204    HTTP_CGI_A1STATS
205    HTTP_CGI_ALCHEMY
206    HTTP_CGI_ALIBABA
207    HTTP_CGI_TEST_BAT
208    HTTP_CGI_INPUT_BAT
209    HTTP_CGI_INPUT2_BAT
210    HTTP_CGI_ENVOUT_BAT
211    HTTP_CGI_ECHO_BAT
212    HTTP_CGI_HELLO_BAT
213    HTTP_CGI_TST_BAT
215    HTTP_CGI_CGIMAIL
217    HTTP_CGI_CART
218    HTTP_CGI_DBMAN
219    HTTP_CGI_DCSHOP
220    HTTP_CGI_ESHOP
223    HTTP_CGI_ECHO_EXE
225    HTTP_CGI_GUESTBOOK
226    HTTP_CGI_SEARCH
227    HTTP_CGI_ENIVRON
228    HTTP_CGI_CAMPUS
229    HTTP_CGI_CART32
231    HTTP_CGI_AD
232    HTTP_CGI_BBS_FORUM
233    HTTP_CGI_BSGUEST
234    HTTP_CGI_BSLIST
235    HTTP_CGI_CGFORUM
236    HTTP_CGI_NEWDESK
237    HTTP_CGI_REGISTER
238    HTTP_CGI_GBOOK
239    HTTP_CGI_SIMPLEGUEST
240    HTTP_CGI_STATUSCONFIG
242    HTTP_CGI_ADCYCLE
243    HTTP_CGI_MACHINEINFO
245    HTTP_CGI_DOCUMENT_D2W
246    HTTP_CGI_DB2WWW
248    HTTP_CGIDOS
249    HTTP_CGI_WEBSTOE
251    HTTP_CGI_CACHEDFEED
252    HTTP_CGI_TALENTSOFT
253    HTTP_CGI_POLLIT
254    HTTP_CGI_COUNT
256    HTTP_CGI_BIGCONF
257    HTTP_CGI_JJ
258    HTTP_CGI_BIZDBSEARCH
261    HTTP_CGI_AX_ADMIN
262    HTTP_CGI_CACHEMGR
263    HTTP_CGI_RESPONDER
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264    HTTP_CGI_WEBMAP
265    HTTP_CGI_MINISTATS
266    HTTP_CGI_DFIRE
267    HTTP_CGI_TXT2HTML
268    HTTP_CGI_STORE
270    HTTP_CGI_SPINCLIENT
271    HTTP_CGI_CSPASSWORD
272    HTTP_CGI_NORTEL
275    HTTP_CGI_STORY
276    HTTP_CGI_USERMOD
277    HTTP_CGI_CGICSO
279    HTTP_CGI_PRINTENV
280    HTTP_CGI_RPC_NLOG
281    HTTP_CGI_RPC_SMB
282    HTTP_CGI_VPASSWD
283    HTTP_CGI_ALYA
284    HTTP_CGI_VIRALATOR
285    HTTP_CGI_SMARTSEARCH
287    HTTP_CGI_OVERFLOW
288    HTTP_CGI_WAYBOARD
289    HTTP_CGI_PROCESSBUG
291    HTTP_CGI_PARSEXML
292    HTTP_CGI_CHIPCFG
293    HTTP_CGI_IKONBOARD
294    HTTP_CGI_SRSRV
295    HTTP_CFM_CFCACHE
296    HTTP_CFM_EXAMPLEAP
297    HTTP_CFM_APPLICATION
298    HTTP_CFM_GETFILE
299    HTTP_CFM_ADDCONTENT
300    HTTP_CFM_ADMINACCESS
301    HTTP_CFM_DATASOURCE
302    HTTP_CFM_FILEXISTS
304    HTTP_CFM_PARKS
305    HTTP_CFM_APPMAN
306    HTTP_CFM_BEANINFO
307    HTTP_CFM_EVALUATE
308    HTTP_CFM_GETODBCDSN
309    HTTP_CFM_DBCONNECT
310    HTTP_CFM_EXPEVAL
311    HTTP_CFM_DATASOURCE_3
312    HTTP_CFM_ADMINENCRYPT
314    HTTP_CFM_GETODBCIN
315    HTTP_CFM_ADMINDECRYPT
316    HTTP_CFM_MAINFRAMESET
317    HTTP_CFM_SETODBCINI
318    HTTP_CFM_REFRESH
319    HTTP_CFM_CFUSION_VERIFYMAIL
321    HTTP_CFM_CFMLSYNTAXCHECK
322    HTTP_CFM_ONREQUESTEND
323    HTTP_CFM_STARTSTOP
324    HTTP_CFM_GETTEMPDIR
325    HTTP_CFM_SENDMAIL
326    HTTP_CFM_MODEDEBUG
327    HTTP_FRONTPAGE_RAD_FP30REG
328    HTTP_FRONTPAGE_RAD_FP4AREG
329    HTTP_FRONTPAGE_VTI_RPC
331    HTTP_FRONTPAGE_SHTML_DLL
332    HTTP_FRONTPAGE_CONTENTS
333    HTTP_FRONTPAGE_ORDERS
334    HTTP_FRONTPAGE_FPSRVADM
335    HTTP_FRONTPAGE_FPREMADM
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336    HTTP_FRONTPAGE_FPADMIN
337    HTTP_FRONTPAGE_FPADMCGI
338    HTTP_FRONTPAGE_ORDERS_TXT
339    HTTP_FRONTPAGE_FORM_RESULTS
340    HTTP_FRONTPAGE_REGISTRATIONS
341    HTTP_FRONTPAGE_CFGWIZ
342    HTTP_FRONTPAGE_AUTHORS_PWD
343    HTTP_FRONTPAGE_AUTHOR_EXE
344    HTTP_FRONTPAGE_ADMINISTRATORS_PWD
345    HTTP_FRONTPAGE_FORM_RESULTS_2
346    HTTP_FRONTPAGE_ACCESS_CNF
347    HTTP_FRONTPAGE_REGISTER_TXT
348    HTTP_FRONTPAGE_REGISTRATIONS_TXT
349    HTTP_FRONTPAGE_SERVICE_CNF
350    HTTP_FRONTPAGE_SERVICE_PWD
351    HTTP_FRONTPAGE_SERVICE_STP
352    HTTP_FRONTPAGE_SERVICES_CNF
353    HTTP_FRONTPAGE_SHTML_EXE
354    HTTP_FRONTPAGE_SVCACL_CNF
355    HTTP_FRONTPAGE_USERS_PWD
356    HTTP_FRONTPAGE_WRITETO
357    HTTP_FRONTPAGE_FOURDOTS
358    HTTP_FRONTPAGE_REGISTER
360    HTTP_FRONTPAGE_DVWSSR
361    HTTP_IIS_REPOST
362    HTTP_IIS_HTR
364    HTTP_IIS_STORECVS
365    HTTP_IIS_USERS_XML
366    HTTP_IIS_AS_WEB
367    HTTP_IIS_AS_WEB4
368    HTTP_IIS_PBSERVER
369    HTTP_IIS_TRACE_AXD
370    HTTP_IIS_TSTISAPI
371    HTTP_IIS_MKILOG
372    HTTP_IIS_CTSS
374    HTTP_IIS_WEBDAV_LOCK
375    HTTP_IIS_PRINTER
376    HTTP_IIS_PCT2E
377    HTTP_IIS_DATAACCESS
378    HTTP_IIS_BATACCESS
379    HTTP_IIS_CNFACCESS
382    HTTP_IIS_CGIMAIL
383    HTTP_IIS_UNICODE_TRAVERSAL
384    HTTP_IIS_UNICODE_TRAVERSAL_2
385    HTTP_IIS_UNICODE_TRAVERSAL_3
386    HTTP_IIS_UNICODE_TRAVERSAL_4
387    HTTP_IIS_MSPROXY
388    HTTP_IIS_CODEFRAGMENT
389    HTTP_IIS_SAMCONTENT
390    HTTP_IIS_SENSEPOST
391    HTTP_IIS_VTI_INF
392    HTTP_IIS_ACHG
393    HTTP_IIS_ISM_DLL
394    HTTP_IIS_ANOT_HTR
395    HTTP_IIS_ASPDOT
396    HTTP_IIS_ASPSRCH
397    HTTP_IIS_CMD32
398    HTTP_IIS_CMD
399    HTTP_IIS_CROSSSCRIPTING
400    HTTP_IIS_CROSSSCRIPTING_2
401    HTTP_IIS_DEL
402    HTTP_IIS_DIRLISTING
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403    HTTP_IIS_ENCODING_ACCESS
404    HTTP_IIS_EXEC_SRC
405    HTTP_IIS_FPCOUNT
406    HTTP_IIS_GETDRVS
407    HTTP_IIS_GLOBAL_ASA
408    HTTP_IIS_IDC_SRCH
409    HTTP_IIS_IISADMPWD_AEXP
410    HTTP_IIS_ISC_DATA
411    HTTP_IIS_ISM
412    HTTP_IIS_JET_VBA
413    HTTP_IIS_MSADCS
414    HTTP_IIS_NEWDSN
415    HTTP_IIS_PERL
416    HTTP_IIS_SEARCH97
417    HTTP_IIS_SHOWCODE
418    HTTP_IIS_SITE_CONFIG
419    HTTP_IIS_SRCH_HTM
420    HTTP_IIS_SRCHADM
421    HTTP_IIS_UPLOADN
422    HTTP_IIS_VIEW_SOURCE
423    HTTP_IIS_VIEWCODE
424    HTTP_IIS_WEBHITS
425    HTTP_IIS_DOCTODEP
426    HTTP_IIS_IISAMPLES
427    HTTP_IIS_CODERED_V2
428    HTTP_IIS_SCRIPTS_SAMPLES
429    HTTP_IIS_MSADC_SAMPLES
430    HTTP_IIS_SAMPLES
431    HTTP_IIS_IISADMIN
433    HTTP_IIS_MEMBIN
434    HTTP_IIS_HTIMAGE
435    HTTP_IIS_SITESERVER
436    HTTP_IIS_POSTINFO
437    HTTP_IIS_EXCHANGE_ROOT
439    HTTP_IIS_BATTLEAXE_FORUM
440    HTTP_IIS_NSIISLOG
441    HTTP_IIS_IISPROTECT
442    HTTP_IIS_IISPROTECT_2
443    HTTP_IIS_SYNCHROLOGIC
444    HTTP_IIS_BIZTALK
445    HTTP_IIS_REGISTER
446    HTTP_PHP_BBSMILIES
451    HTTP_PHP_BLAHZDNS
452    HTTP_PHP_PHP_EXE
454    HTTP_PHP_PASSWD
455    HTTP_PHP_PHORUM_CODE
456    HTTP_PHP_PHORUM_AUTHENTIFICATION
457    HTTP_PHP_STRING_OVERFLOW
458    HTTP_PHP_STRING_OVERFLOW_2
459    HTTP_PHP_REMOTE_COMMAND
460    HTTP_PHP_PHPLIB_INCLUDE
461    HTTP_PHP_BLNEWS_OBJECTS
462    HTTP_PHP_TURBA_STATUS
463    HTTP_PHP_TTCMS
464    HTTP_PHP_AUTOHTML
465    HTTP_NETSCAPE_ENTERPRISE_DOS
466    HTTP_NETSCAPE_ENTERPRISE_DIRLISTING
467    HTTP_IPLANET_GETPROPERTIES
468    HTTP_WEBLOGIC_VIEWSOURCE
469    HTTP_TOMCAT_TRAVERSAL
470    HTTP_TOMCAT_VIEWSOURCE
471    HTTP_FTP_ACCESS
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472    HTTP_XP_ENUMDSN
473    HTTP_XPFILELIST
474    HTTP_XPAVAILABLEMEDIA
475    HTTP_XPCMDSHELL
476    HTTP_NETCAT_EXE
477    HTTP_WSH_EXE
478    HTTP_RCMD_EXE
479    HTTP_TELNET_EXE
480    HTTP_NET_EXE
481    HTTP_TFTP_EXE
482    HTTP_XPREGREAD
483    HTTP_XPREGWRITE
484    HTTP_XPREGDELETEKEY
485    HTTP_WEBDAV_SEARCH
486    HTTP_HTPASSWD
487    HTTP_QUERYHIT
488    HTTP_COUNTER_EXE
489    HTTP_WEBDAV_PROPFIND
490    HTTP_EWAVE_SERVLET
491    HTTP_NETSCAPE_SERVERSSUITE_DOS
493    HTTP_ICQ_WEB_DOS
494    HTTP_TALENTSOFT_SOURCE_VIEW
495    HTTP_TALENTSOFT_IP_DISCLOSURE
496    HTTP_SMARTWIN_CYBEROFFICE
497    HTTP_CYBERCOP
500    HTTP_NESSUS_PROBE
501    HTTP_NETSCAPE_ADMIN_PASSWD
503    HTTP_FTP_PERL
505    HTTP_ROXEN_DIRLISTING
506    HTTP_SOURCE_ASP
507    HTTP_TOMCAT_EXPLOIT
508    HTTP_LOTUS_DELETEDOC
509    HTTP_LOTUS_EDITDOC
510    HTTP_LS_L
511    HTTP_PHP_MLOG
512    HTTP_ETC_PASSWD
513    HTTP_PAGESERVICES
517    HTTP_CONVERT_BAS
518    HTTP_CPSHOST
519    HTTP_HTACCESS
521    HTTP_TILDE_ROOT
522    HTTP_TILDE_FTP
525    HTTP_DOMINO_CATALOG_NSF
526    HTTP_DOMINO_DOMCFG_NSF
527    HTTP_DOMINO_DOMLOG_NSF
528    HTTP_DOMINO_LOG_NSF
529    HTTP_DOMINO_NAMES_NSF
530    HTTP_DOMINO_MAN_NSF
531    HTTP_DOMINO_CERSVR_NSF
532    HTTP_DOMINO_SETUP_NSF
533    HTTP_DOMINO_STATREP_NSF
534    HTTP_DOMINO_WEBADMIN_NSF
535    HTTP_DOMINO_EVENTS4_NSF
536    HTTP_DOMINO_NTSYNC4_NSF
537    HTTP_DOMINO_COLLECT4_NSF
538    HTTP_DOMINO_MAILW46_NSF
539    HTTP_DOMINO_BOOKMARK_NSF
540    HTTP_DOMINO_AGENTRUNNER_NSF
541    HTTP_DOMINO_MAILBOX
543    HTTP_APACHE_DOS
544    HTTP_NETSCAPE_PUBLISHING_XPERT
545    HTTP_WINDMAIL
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546    HTTP_WEBPLUS
547    HTTP_NETSCAPE_DIRLISTING
548    HTTP_CART32_ADMINPWD
549    HTTP_SHOPPING_CART_ACCESS
551    HTTP_NOVELL_GROUPWISE_2
552    HTTP_WSFTP_INI
553    HTTP_RPMQUERY
556    HTTP_WWWBOARD
559    HTTP_GET32_EXE
560    HTTP_ANNEX_TERMINAL
561    HTTP_CGITEST_EXE
562    HTTP_SALESLOGIX_EVIEWER_CMD
563    HTTP_ORACLE_WEBAPP_ACCESS
565    HTTP_HTGREP_ACCESS
566    HTTP_NSCONFIG_ACCESS
567    HTTP_ADMIN_FILES_ACCESS
568    HTTP_BACKUP_ACCESS
569    HTTP_INTRANET_ACCESS
570    HTTP_FILEMAIL_ACCESS
571    HTTP_PLUSMAIL_ACCESS
572    HTTP_ADMINLOGIN_ACCESS
573    HTTP_ULTRABOARD_ACCESS
575    HTTP_MUSICAT_EMPOWER_ACCESS
577    HTTP_VIRUSWALL_FTPSAVE
578    HTTP_TOMCAT_SOURCEVIEW
579    HTTP_HP_OPENVIEW_DOS
580    HTTP_CARBO_DLL_ACCESS
581    HTTP_CONSOLE_EXE_ACCESS
582    HTTP_CS_EXE_ACCESS
583    HTTP_SADMIND_WORM
584    HTTP_DOT_HISTORY
585    HTTP_DOT_BASH_HISTORY
586    HTTP_TILDE_NOBODY
588    HTTP_MKPLOG_EXE_ACCESS
590    HTTP_PCCS_MYSQL_ADMIN_ACCESS
591    HTTP_DS_STORE
592    HTTP_FBCINDEX
593    HTTP_EXAIR_ACCESS
594    HTTP_APACHE_SERVER_INFO_ACCESS
595    HTTP_APACHE_SERVER_STATUS_ACCESS
596    HTTP_AXISSTORPOINT_CD
597    HTTP_BASILIX_SENDMAIL_ACCESS
598    HTTP_BASILIX_MYSQL_ACCESS
599    HTTP_BBOARD_ACCESS
600    HTTP_CISCO_CATALYST_CMD
601    HTTP_CISCO_DOS_ATTEMPT
602    HTTP_CVS_ENTRIES_ACCESS
603    HTTP_CVSWEB_VERSION_ACCESS
606    HTTP_HOME_FTP_ACCESS
607    HTTP_HOME_WWW_ACCESS
608    HTTP_GLOBAL_INC_ACCESS
609    HTTP_SECURESITE_AUTH_BYPASS
611    HTTP_NETSCAPE_UNIXWARE_OVERFLOW
612    HTTP_VIRUSWALL_CATINFO
613    HTTP_APACHE_CHUNKED_ENCODING_WORM
614    HTTP_CISCO_VOIP_DOS
615    HTTP_IBM_NETCOMMERCE_ORDERDSPC
616    HTTP_WEBINF_ACCESS
617    HTTP_XSS
618    HTTP_JIGSAW_DOS_ATTEMPT
619    HTTP_WEBALIZER_ACCESS
620    HTTP_WEBFIND_EXE
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621    HTTP_ACTIVE_LOG_ACCESS
622    HTTP_ROBOTS_TXT_ACCESS
623    HTTP_ROBOT_TXT_ACCESS
624    HTTP_CISCO_FIX_DIR_TRAVERSAL
626    HTTP_LINKSYS_ROUTER_DEFAULT_LOGIN
627    HTTP_ORACLE_XSQL_CONFIG_ACCESS
628    HTTP_ORACLE_DMS_ACCESS
629    HTTP_GLOBALS_JSA_ACCESS
630    HTTP_ORACLE_JAVA_PROCESS_ACCESS
631    HTTP_APACHE_CHUNKED_ENC_EXPLOIT
632    HTTP_CARELLO_ADD_ACCESS
633    HTTP_ECWARE_ACCESS
634    HTTP_IONP_ACCESS
635    HTTP_SITESCOPE_ACCESS
636    HTTP_ANSWERBOOK2_ADMIN_ATTEMPT
638    HTTP_MSMMASK_EXE_ACCESS
639    HTTP_DB4WEB_ACCESS
640    HTTP_TOMCAT_NULL_BYTE_DIR
641    HTTP_IPLANET_PERF_ACCESS
642    HTTP_CHIP_INI_ACCESS
643    HTTP_POST32_EXE_ACCESS
644    HTTP_LYRIS_PL_ACCESS
645    HTTP_GLOBALS_PL_ACCESS
646    HTTP_PHILBOARD_MDB
647    HTTP_PHILBOARD_ADMIN_ACCESS
648    HTTP_LOGICWORKS_INI_ACCESS
649    HTTP_STAR_SHTML
650    HTTP_APACHE_MOD_GZIP_STATUS_ACCESS
652    SMTP_EXCHANGE_MIME_DOS
653    SMTP_EXPN_DECODE
654    SMTP_EXPN_ROOT
655    SMTP_EXPN_STAR_AT
656    SMTP_MAJORDOMO_IFS
657    SMTP_SENDMAIL_5_5_5_EXPLOIT
658    SMTP_RCPT_TO_SED
659    SMTP_RCPT_TO_DECODE
660    SMTP_SENDMAIL_5_6_5_EXPLOIT
661    SMTP_SENDMAIL_8_6_10_EXPLOIT
666    SMTP_VRFY_DECODE
667    SMTP_VRFY_ROOT
668    SMTP_EHLO_CYBERCOP
669    SMTP_EXPN_CYBERCOP
670    SMTP_FROM_OVERFLOW
671    IMAP_LOGIN_LITERAL_OVERFLOW
672    IMAP_AUTHENTICATE_LITERAL_OVERFLOW
673    IMAP_AUTH_OVERFLOW_ATTEMPT
674    IMAP_LSUB_OVERFLOW_ATTEMPT
675    IMAP_LIST_LITERAL_OVERFLOW_ATTEMPT
676    IMAP_RENAME_LITERAL_OVERFLOW
679    IMAP_CREATE_LITERAL_OVERFLOW
682    POP3_BSD_EXPLOIT
683    POP3_BSD_EXPLOIT_2
684    POP3_LINUX_EXPLOIT
685    POP3_SCO_EXPLOIT
686    POP3_QPOPPER_EXPLOIT
690    HTTP_SQL_INSERT_INTO
691    DNS_EXPLOIT_NAMED
692    DNS_EXPLOIT_NAMED_TSIG
693    DNS_EXPLOIT_NAMED_TSIG_2
694    DNS_EXPLOIT_NAMED_OVERFLOW
695    DNS_EXPLOIT_NAMED_OVERFLOW_2
696    DNS_EXPLOIT_NAMED_OVERFLOW_3
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697    DNS_EXPLOIT_X86_OVERFLOW
698    DNS_EXPLOIT_X86_OVERFLOW_2
699    DNS_EXPLOIT_X86_OVERFLOW_3
700    DNS_EXPLOIT_FREEBSD_OVERFLOW
701    DNS_EXPLOIT_SPARC_OVERFLOW
702    HTTP_IIS_CHUNKED_ENCODING
703    HTTP_FRONTPAGE_VTI_ADM
704    HTTP_WEBDAV_SEARCH_EXPLOIT
705    HTTP_SQL_COMMENTS_DASH
706    HTTP_SQL_COMMENTS_C_1
707    HTTP_SQL_COMMENTS_C_2
708    HTTP_SQL_OR
709    HTTP_SQL_OR_2
710    HTTP_SQL_ONE_EQ_ONE
711    HTTP_SQL_ONE_EQ_ONE_2
712    HTTP_SQL_AND
713    HTTP_USERAGENT_KAZAA
714    HTTP_GNUTELLA_1
715    HTTP_GNUTELLA_2
716    HTTP_GNUTELLA_3
717    HTTP_GNUTELLA_4
718    FTP_EXPLOIT_OPENBSD
719    FTP_EXPLOIT_OVERFLOW
720    FTP_EXPLOIT_WUFTPD_SOLARIS
721    FTP_EXPLOIT_WUFTPD_FREEBSD
722    FTP_EXPLOIT_WUFTPD_LINUX
724    FTP_WUFTPD_FORMAT_STRING
725    FTP_WUFTPD_EXPLOIT
726    FTP_EXPLOIT_MKD_OVERFLOW
727    HTTP_IIS_NTLMASN1
728    HTTP_IIS_ISAPI_IDQ
729    HTTP_IIS_MSDAC
730    HTTP_EWAVE_SERVLET_2
731    HTTP_NESSUS_PROBE_2
732    HTTP_NESSUS_PROBE_3
733    HTTP_RBS_ISP
734    HTTP_WEBDAV_DELETE
735    HTTP_ORDER_LOG
736    HTTP_CGI_NPH_EXPLOITSCAN
737    HTTP_EMUMAIL_INIT
738    HTTP_EMUMAIL_FCGI
739    HTTP_CGI_ENVIRON_PL
740    HTTP_CGI_STATSCONFIG
741    HTTP_IIS_PING_ASP
742    SMTP_SENDMAIL_8_6_10_EXPLOIT_2
743    FTP_SERVU_LIST_OVERFLOW_EXPLOIT
744    IMAP_COURIER_LOGIN_FORMAT_STRING_ATTEMPT_1
745    IMAP_COURIER_LOGIN_FORMAT_STRING_ATTEMPT_2
746    IMAP_COURIER_LOGIN_FORMAT_STRING_ATTEMPT_3
747    IMAP_COURIER_LOGIN_FORMAT_STRING_ATTEMPT_SM00NY
748    HTTP_XSS_2
749    HTTP_P2P_ARES_1
750    HTTP_P2P_ARES_2
751    HTTP_CFM_JRUN_SOURCE_DISCLOSURE_1
752    HTTP_CFM_JRUN_SOURCE_DISCLOSURE_2
753    HTTP_CFM_JRUN_SOURCE_DISCLOSURE_3
754    HTTP_CFM_JRUN_SOURCE_DISCLOSURE_4
755    HTTP_IIS_NTFS_SOURCE_DISCLOSURE_1
756    HTTP_IIS_NTFS_SOURCE_DISCLOSURE_2
757    HTTP_IIS_NTFS_SOURCE_DISCLOSURE_3
758    HTTP_IIS_NTFS_SOURCE_DISCLOSURE_4
759    HTTP_IIS_NTFS_SOURCE_DISCLOSURE_5
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760    HTTP_IIS_NTFS_SOURCE_DISCLOSURE_6
761    HTTP_IIS_NTFS_SOURCE_DISCLOSURE_7
762    HTTP_IIS_NTFS_SOURCE_DISCLOSURE_8
763    HTTP_IIS_NTFS_SOURCE_DISCLOSURE_9
764    HTTP_IIS_NTFS_SOURCE_DISCLOSURE_10
765    HTTP_IIS_NTFS_SOURCE_DISCLOSURE_11
766    HTTP_IIS_NTFS_SOURCE_DISCLOSURE_12
767    HTTP_IIS_NTFS_SOURCE_DISCLOSURE_13
768    HTTP_IIS_NTFS_SOURCE_DISCLOSURE_14
769    HTTP_MAC_HFSPLUS
770    HTTP_PHP_BB_HIGHLIGHTING_CODE_EXEC
771    HTTP_PHP_BB_HIGHLIGHTING_SQL_INJECT
772    HTTP_PHP_BB_HIGHLIGHTING_FILE_XFER
773    HTTP_PHP_BB_HIGHLIGHTING_SYSTEM_1
774    HTTP_PHP_BB_HIGHLIGHTING_SYSTEM_2
775    HTTP_PHP_BB_HIGHLIGHTING_SYSTEM_3
776    HTTP_PHP_BB_HIGHLIGHTING_SYSTEM_4
777    HTTP_PHP_BB_HIGHLIGHTING_EXEC_1
778    HTTP_PHP_BB_HIGHLIGHTING_EXEC_2
779    HTTP_PHP_BB_HIGHLIGHTING_EXEC_3
780    HTTP_PHP_BB_HIGHLIGHTING_EXEC_4
781    HTTP_PHP_BB_HIGHLIGHTING_PASSTHRU_1
782    HTTP_PHP_BB_HIGHLIGHTING_PASSTHRU_2
783    HTTP_PHP_BB_HIGHLIGHTING_PASSTHRU_3
784    HTTP_PHP_BB_HIGHLIGHTING_PASSTHRU_4
785    HTTP_PHP_BB_HIGHLIGHTING_POPEN_1
786    HTTP_PHP_BB_HIGHLIGHTING_POPEN_2
787    HTTP_PHP_BB_HIGHLIGHTING_POPEN_3
789    HTTP_PHP_BB_HIGHLIGHTING_POPEN_4
790    HTTP_PHP_BB_HIGHLIGHTING_SHELL_EXEC_1
791    HTTP_PHP_BB_HIGHLIGHTING_SHELL_EXEC_2
792    HTTP_PHP_BB_HIGHLIGHTING_SHELL_EXEC_3
793    HTTP_PHP_BB_HIGHLIGHTING_SHELL_EXEC_4
794    HTTP_PHP_BB_HIGHLIGHTING_PROC_OPEN_1
795    HTTP_PHP_BB_HIGHLIGHTING_PROC_OPEN_2
796    HTTP_PHP_BB_HIGHLIGHTING_PROC_OPEN_3
797    HTTP_PHP_BB_HIGHLIGHTING_PROC_OPEN_4
798    HTTP_PHP_BB_HIGHLIGHTING_FOPEN_1
799    HTTP_PHP_BB_HIGHLIGHTING_FOPEN_2
800    HTTP_PHP_BB_HIGHLIGHTING_FOPEN_3
801    HTTP_PHP_BB_HIGHLIGHTING_FOPEN_4
802    HTTP_PHP_BB_HIGHLIGHTING_FWRITE_1
803    HTTP_PHP_BB_HIGHLIGHTING_FWRITE_2
804    HTTP_PHP_BB_HIGHLIGHTING_FWRITE_3
805    HTTP_PHP_BB_HIGHLIGHTING_FWRITE_4
806    HTTP_PHP_BB_HIGHLIGHTING_MYSQL_QUERY_1
807    HTTP_PHP_BB_HIGHLIGHTING_MYSQL_QUERY_2
808    HTTP_PHP_BB_HIGHLIGHTING_MYSQL_QUERY_3
810    HTTP_PHP_BB_HIGHLIGHTING_MYSQL_QUERY_4
811    HTTP_USERAGENT_SKYPE
812    HTTP_CGI_AWSTATS_PL_1
813    HTTP_CGI_AWSTATS_PL_2
814    HTTP_WINDOWS_SYSTEM_INI
815    HTTP_SQL_SELECT
816    HTTP_SQL_UPDATE
817    HTTP_SQL_FROM
818    HTTP_SQL_WHERE
819    HTTP_CGI_AWSTATS_PL_3
820    HTTP_CGI_EASYMSG_BOARD_PRINT
821    HTTP_IIS_KILL_BILL_EXPLOIT
822    HTTP_XMLRPC_CODE_EXEC
823    IMAP_MAILUTILS_FORMAT_STRING_ATTEMPT_1
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824    IMAP_MAILUTILS_FORMAT_STRING_ATTEMPT_2
825    IMAP_MAILUTILS_FORMAT_STRING_ATTEMPT_3
826    HTTP_SUSPICIOUS_ECHO_IFS
827    HTTP_OPENVIEW_CONNECTEDNODE_PIPE_1
828    HTTP_OPENVIEW_CONNECTEDNODE_SCOLON_1
829    HTTP_OPENVIEW_CONNECTEDNODE_PIPE_2
830    HTTP_OPENVIEW_CONNECTEDNODE_SCOLON_2
831    HTTP_OPENVIEW_CONNECTEDNODE_PIPE_3
832    HTTP_OPENVIEW_CONNECTEDNODE_SCOLON_3
833    HTTP_OPENVIEW_CONNECTEDNODE_PIPE_4
834    HTTP_OPENVIEW_CONNECTEDNODE_SCOLON_4
835    FTP_SITE_PIPE
836    HTTP_URL_SC_DEC_PEXFNSTENV
837    HTTP_URL_SC_DEC_COUNTDOWN
838    HTTP_URL_SC_DEC_PEX
839    HTTP_URL_SC_DEC_JMPCALLADDITIVE
840    HTTP_URL_SC_DEC_ALPHA_WIN32
841    HTTP_URL_SC_DEC_ALPHA_WIN32UP
842    HTTP_URL_SC_DEC_ALPHA_DEFAULT
843    HTTP_URL_SC_DEC_ALPHA_RESTRIC
844    HTTP_URL_SC_DEC_OSXPPCLONGXOR
845    HTTP_URL_SC_DEC_OSXPPCLONGXORTAG
846    HTTP_URL_SC_DEC_QUACKQUACK
847    HTTP_URL_SC_DEC_SPARC
848    HTTP_URL_SC_DEC_SIMPLEFNSTENV
849    HTTP_URL_SC_DEC_BYTEXORRANDTAG
850    HTTP_URL_SC_DEC_SIMPLEBYTEXOR
851    HTTP_HEADER_SC_DEC_PEXFNSTENV
852    HTTP_HEADER_SC_DEC_COUNTDOWN
853    HTTP_HEADER_SC_DEC_PEX
854    HTTP_HEADER_SC_DEC_JMPCALLADDITIVE
855    HTTP_HEADER_SC_DEC_ALPHA_WIN32
856    HTTP_HEADER_SC_DEC_ALPHA_WIN32UP
857    HTTP_HEADER_SC_DEC_ALPHA_DEFAULT
858    HTTP_HEADER_SC_DEC_ALPHA_RESTRIC
859    HTTP_HEADER_SC_DEC_OSXPPCLONGXOR
860    HTTP_HEADER_SC_DEC_OSXPPCLONGXORTAG
861    HTTP_HEADER_SC_DEC_QUACKQUACK
862    HTTP_HEADER_SC_DEC_SPARC
863    HTTP_HEADER_SC_DEC_SIMPLEFNSTENV
864    HTTP_HEADER_SC_DEC_BYTEXORRANDTAG
865    HTTP_HEADER_SC_DEC_SIMPLEBYTEXOR
866    FTP_PARAMETER_SC_DEC_PEXFNSTENV
867    FTP_PARAMETER_SC_DEC_COUNTDOWN
868    FTP_PARAMETER_SC_DEC_PEX
869    FTP_PARAMETER_SC_DEC_JMPCALLADDITIVE
870    FTP_PARAMETER_SC_DEC_ALPHA_WIN32
871    FTP_PARAMETER_SC_DEC_ALPHA_WIN32UP
872    FTP_PARAMETER_SC_DEC_ALPHA_DEFAULT
873    FTP_PARAMETER_SC_DEC_ALPHA_RESTRIC
874    FTP_PARAMETER_SC_DEC_OSXPPCLONGXOR
875    FTP_PARAMETER_SC_DEC_OSXPPCLONGXORTAG
876    FTP_PARAMETER_SC_DEC_QUACKQUACK
877    FTP_PARAMETER_SC_DEC_SPARC
878    FTP_PARAMETER_SC_DEC_SIMPLEFNSTENV
879    FTP_PARAMETER_SC_DEC_BYTEXORRANDTAG
880    FTP_PARAMETER_SC_DEC_SIMPLEBYTEXOR
881    SMTP_PARAMETER_SC_DEC_PEXFNSTENV
882    SMTP_PARAMETER_SC_DEC_COUNTDOWN
883    SMTP_PARAMETER_SC_DEC_PEX
884    SMTP_PARAMETER_SC_DEC_JMPCALLADDITIVE
885    SMTP_PARAMETER_SC_DEC_ALPHA_WIN32
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886    SMTP_PARAMETER_SC_DEC_ALPHA_WIN32UP
887    SMTP_PARAMETER_SC_DEC_ALPHA_DEFAULT
888    SMTP_PARAMETER_SC_DEC_ALPHA_RESTRIC
889    SMTP_PARAMETER_SC_DEC_OSXPPCLONGXOR
890    SMTP_PARAMETER_SC_DEC_OSXPPCLONGXORTAG
891    SMTP_PARAMETER_SC_DEC_QUACKQUACK
892    SMTP_PARAMETER_SC_DEC_SPARC
893    SMTP_PARAMETER_SC_DEC_SIMPLEFNSTENV
894    SMTP_PARAMETER_SC_DEC_BYTEXORRANDTAG
895    SMTP_PARAMETER_SC_DEC_SIMPLEBYTEXOR
896    POP3_PARAMETER_SC_DEC_PEXFNSTENV
897    POP3_PARAMETER_SC_DEC_COUNTDOWN
898    POP3_PARAMETER_SC_DEC_PEX
899    POP3_PARAMETER_SC_DEC_JMPCALLADDITIVE
900    POP3_PARAMETER_SC_DEC_ALPHA_WIN32
901    POP3_PARAMETER_SC_DEC_ALPHA_WIN32UP
902    POP3_PARAMETER_SC_DEC_ALPHA_DEFAULT
903    POP3_PARAMETER_SC_DEC_ALPHA_RESTRIC
904    POP3_PARAMETER_SC_DEC_OSXPPCLONGXOR
905    POP3_PARAMETER_SC_DEC_OSXPPCLONGXORTAG
906    POP3_PARAMETER_SC_DEC_QUACKQUACK
907    POP3_PARAMETER_SC_DEC_SPARC
908    POP3_PARAMETER_SC_DEC_SIMPLEFNSTENV
909    POP3_PARAMETER_SC_DEC_BYTEXORRANDTAG
910    POP3_PARAMETER_SC_DEC_SIMPLEBYTEXOR
911    IMAP4_PARAMETER_SC_DEC_PEXFNSTENV
912    IMAP4_PARAMETER_SC_DEC_COUNTDOWN
913    IMAP4_PARAMETER_SC_DEC_PEX
914    IMAP4_PARAMETER_SC_DEC_JMPCALLADDITIVE
915    IMAP4_PARAMETER_SC_DEC_ALPHA_WIN32
916    IMAP4_PARAMETER_SC_DEC_ALPHA_WIN32UP
917    IMAP4_PARAMETER_SC_DEC_ALPHA_DEFAULT
918    IMAP4_PARAMETER_SC_DEC_ALPHA_RESTRIC
919    IMAP4_PARAMETER_SC_DEC_OSXPPCLONGXOR
920    IMAP4_PARAMETER_SC_DEC_OSXPPCLONGXORTAG
921    IMAP4_PARAMETER_SC_DEC_QUACKQUACK
922    IMAP4_PARAMETER_SC_DEC_SPARC
923    IMAP4_PARAMETER_SC_DEC_SIMPLEFNSTENV
924    IMAP4_PARAMETER_SC_DEC_BYTEXORRANDTAG
925    IMAP4_PARAMETER_SC_DEC_SIMPLEBYTEXOR
926    SIP_REQUEST_SC_DEC_PEXFNSTENV
927    SIP_REQUEST_SC_DEC_COUNTDOWN
928    SIP_REQUEST_SC_DEC_PEX
929    SIP_REQUEST_SC_DEC_JMPCALLADDITIVE
930    SIP_REQUEST_SC_DEC_ALPHA_WIN32
931    SIP_REQUEST_SC_DEC_ALPHA_WIN32UP
932    SIP_REQUEST_SC_DEC_ALPHA_DEFAULT
933    SIP_REQUEST_SC_DEC_ALPHA_RESTRIC
934    SIP_REQUEST_SC_DEC_OSXPPCLONGXOR
935    SIP_REQUEST_SC_DEC_OSXPPCLONGXORTAG
936    SIP_REQUEST_SC_DEC_QUACKQUACK
937    SIP_REQUEST_SC_DEC_SPARC
938    SIP_REQUEST_SC_DEC_SIMPLEFNSTENV
939    SIP_REQUEST_SC_DEC_BYTEXORRANDTAG
940    SIP_REQUEST_SC_DEC_SIMPLEBYTEXOR
941    SIP_HEADER_SC_DEC_PEXFNSTENV
942    SIP_HEADER_SC_DEC_COUNTDOWN
943    SIP_HEADER_SC_DEC_PEX
944    SIP_HEADER_SC_DEC_JMPCALLADDITIVE
945    SIP_HEADER_SC_DEC_ALPHA_WIN32
946    SIP_HEADER_SC_DEC_ALPHA_WIN32UP
947    SIP_HEADER_SC_DEC_ALPHA_DEFAULT
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948    SIP_HEADER_SC_DEC_ALPHA_RESTRIC
949    SIP_HEADER_SC_DEC_OSXPPCLONGXOR
950    SIP_HEADER_SC_DEC_OSXPPCLONGXORTAG
951    SIP_HEADER_SC_DEC_QUACKQUACK
952    SIP_HEADER_SC_DEC_SPARC
953    SIP_HEADER_SC_DEC_SIMPLEFNSTENV
954    SIP_HEADER_SC_DEC_BYTEXORRANDTAG
955    SIP_HEADER_SC_DEC_SIMPLEBYTEXOR
956    SDP_LINE_SC_DEC_PEXFNSTENV
957    SDP_LINE_SC_DEC_COUNTDOWN
958    SDP_LINE_SC_DEC_PEX
959    SDP_LINE_SC_DEC_JMPCALLADDITIVE
960    SDP_LINE_SC_DEC_ALPHA_WIN32
961    SDP_LINE_SC_DEC_ALPHA_WIN32UP
962    SDP_LINE_SC_DEC_ALPHA_DEFAULT
963    SDP_LINE_SC_DEC_ALPHA_RESTRIC
964    SDP_LINE_SC_DEC_OSXPPCLONGXOR
965    SDP_LINE_SC_DEC_OSXPPCLONGXORTAG
966    SDP_LINE_SC_DEC_QUACKQUACK
967    SDP_LINE_SC_DEC_SPARC
968    SDP_LINE_SC_DEC_SIMPLEFNSTENV
969    SDP_LINE_SC_DEC_BYTEXORRANDTAG
970    SDP_LINE_SC_DEC_SIMPLEBYTEXOR
971    HTTP_PHP_HORDE_HELP
972    TCP_SKYPE_OVER_HTTPS
973    HTTP_PHP_GLOBALS_OVERWRITE_1
974    HTTP_PHP_GLOBALS_OVERWRITE_2
975    HTTP_SUPER_PROXY_SCANNER_1
976    HTTP_SUPER_PROXY_SCANNER_2
977    HTTP_AWSTATS_MIGRATE_CMDEXEC_1
978    HTTP_AWSTATS_MIGRATE_CMDEXEC_2
979    HTTP_MOD_REWRITE_LDAP_OFFBYONE
980    HTTP_APACHE_CGIBIN_CASE_1
981    HTTP_APACHE_CGIBIN_CASE_2
982    HTTP_APACHE_CGIBIN_CASE_3
983    HTTP_APACHE_CGIBIN_CASE_4
984    HTTP_APACHE_CGIBIN_CASE_5
985    HTTP_APACHE_CGIBIN_CASE_6
986    HTTP_APACHE_CGIBIN_CASE_7
987    HTTP_APACHE_CGIBIN_CASE_8
988    HTTP_APACHE_CGIBIN_CASE_9
989    HTTP_APACHE_CGIBIN_CASE_10
990    HTTP_APACHE_CGIBIN_CASE_11
991    HTTP_APACHE_CGIBIN_CASE_12
992    HTTP_APACHE_CGIBIN_CASE_13
993    HTTP_APACHE_CGIBIN_CASE_14
994    HTTP_APACHE_CGIBIN_CASE_15
995    HTTP_APACHE_CGIBIN_CASE_16
996    HTTP_APACHE_CGIBIN_CASE_17
997    HTTP_APACHE_CGIBIN_CASE_18
998    HTTP_APACHE_CGIBIN_CASE_19
999    HTTP_APACHE_CGIBIN_CASE_20
1000   HTTP_APACHE_CGIBIN_CASE_21
1001   HTTP_APACHE_CGIBIN_CASE_22
1002   HTTP_APACHE_CGIBIN_CASE_23
1003   HTTP_APACHE_CGIBIN_CASE_24
1004   HTTP_APACHE_CGIBIN_CASE_25
1005   HTTP_APACHE_CGIBIN_CASE_26
1006   HTTP_APACHE_CGIBIN_CASE_27
1007   HTTP_APACHE_CGIBIN_CASE_28
1008   HTTP_APACHE_CGIBIN_CASE_29
1009   HTTP_APACHE_CGIBIN_CASE_30
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1010   HTTP_APACHE_CGIBIN_CASE_31
1011   HTTP_APACHE_CGIBIN_CASE_32
1012   HTTP_APACHE_CGIBIN_CASE_33
1013   HTTP_APACHE_CGIBIN_CASE_34
1014   HTTP_APACHE_CGIBIN_CASE_35
1015   HTTP_APACHE_CGIBIN_CASE_36
1016   HTTP_APACHE_CGIBIN_CASE_37
1017   HTTP_APACHE_CGIBIN_CASE_38
1018   HTTP_APACHE_CGIBIN_CASE_39
1019   HTTP_APACHE_CGIBIN_CASE_40
1020   HTTP_APACHE_CGIBIN_CASE_41
1021   HTTP_APACHE_CGIBIN_CASE_42
1022   HTTP_APACHE_CGIBIN_CASE_43
1023   HTTP_APACHE_CGIBIN_CASE_44
1024   HTTP_APACHE_CGIBIN_CASE_45
1025   HTTP_APACHE_CGIBIN_CASE_46
1026   HTTP_APACHE_CGIBIN_CASE_47
1027   HTTP_APACHE_CGIBIN_CASE_48
1028   HTTP_APACHE_CGIBIN_CASE_49
1029   HTTP_APACHE_CGIBIN_CASE_50
1030   HTTP_APACHE_CGIBIN_CASE_51
1031   HTTP_APACHE_CGIBIN_CASE_52
1032   HTTP_APACHE_CGIBIN_CASE_53
1033   HTTP_APACHE_CGIBIN_CASE_54
1034   HTTP_APACHE_CGIBIN_CASE_55
1035   HTTP_APACHE_CGIBIN_CASE_56
1036   HTTP_APACHE_CGIBIN_CASE_57
1037   HTTP_APACHE_CGIBIN_CASE_58
1038   HTTP_APACHE_CGIBIN_CASE_59
1039   HTTP_APACHE_CGIBIN_CASE_60
1040   HTTP_APACHE_CGIBIN_CASE_61
1041   HTTP_APACHE_CGIBIN_CASE_62
1042   HTTP_APACHE_CGIBIN_CASE_63
1043   HTTP_UTF7_XSS_1
1044   HTTP_UTF7_XSS_2
1045   HTTP_UTF7_XSS_3
1046   HTTP_UTF7_XSS_4
1047   DNS_EXPLOIT_WIN_NAT_HELPER
1048   HTTP_IM_MSN_SERVER
1049   HTTP_IM_WEBMESSENGER_SERVER
1050   HTTP_IM_WEBMESSENGER_HOST
1051   HTTP_IM_GOOGLETALK_UA
1052   HTTP_IM_GOOGLETALK_HOST
1053   HTTP_IM_YAHOO_SHTTP_HOST
1054   HTTP_IM_AIM_KDC_UAS_HOST
1055   HTTP_IM_AIM_MY_SCREENNAME_HOST
1056   HTTP_IM_AIM_EXPRESS_HOST
1057   HTTP_IM_ICQ_PROXY_HOST
1058   HTTP_IM_ICQ_SERVER_AIM
1059   HTTP_IM_ICQ_CTYPE_AIM
1060   TLS_IM_AIM_KDC_UAS_DN
1061   TLS_IM_AIM_MY_SCREENNAME_DN
1062   TLS_IM_ICQ_DN
1063   HTTP_RANGE_HDR_ABUSE
1064   HTTP_JS_ABOUT_CACHE_ENTRY
1065   HTTP_XSS_VB
1066   HTTP_XSS_VB_HTML
1067   HTTP_XSS_VB_UTF7_1
1068   HTTP_XSS_VB_UTF7_2
1069   HTTP_XSS_VB_UTF7_3
1070   HTTP_XSS_VB_UTF7_4
1071   HTTP_XSS_JAVASCRIPT
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1072   HTTP_XSS_JAVASCRIPT_HTML
1073   HTTP_XSS_JAVASCRIPT_UTF7_1
1074   HTTP_XSS_JAVASCRIPT_UTF7_2
1075   HTTP_XSS_JAVASCRIPT_UTF7_3
1076   HTTP_XSS_JAVASCRIPT_UTF7_4
1077   HTTP_VLC_CONNECTION
1078   HTTP_SQL_DECLARE
1079   HTTP_SQL_FETCH_NEXT_FROM
1080   HTTP_SQL_CLOSE
1081   HTTP_SQL_DEALLOCATE
1082   HTTP_SQL_VARCHAR
1083   HTTP_SQL_HAVING
1084   HTTP_SQL_GROUPBY
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